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Table C-9 ONS 15454 Transponder/Muxponder Port Service State Transitions C-12

Table D-1 MXP-2.5G-10E Card Default Settings (ANSI) D-3

Table D-2 MXP-2.5G-10G Card Default Settings (ANSI) D-7

Table D-3 MXP-MR-2.5G Card Default Settings (ANSI) D-11

Table D-4 MXPP-MR-2.5G Card Default Settings (ANSI) D-13

Table D-5 TXP-MR-10E Card Default Settings (ANSI) D-16

Table D-6 TXP_MR_10G Card Default Settings (ANSI) D-20

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) D-24

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) D-30

Table D-9 OSCM Card Default Settings (ANSI) D-37

Table D-10 OSC-CSM Card Default Settings (ANSI) D-38

Table D-11 Node Default Settings (ANSI) D-39

Table D-12 CTC Default Settings (ANSI) D-43

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) D-44

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI) D-48

Table D-15 MXP_MR_2.5G Card Default Settings (ETSI) D-52

Table D-16 MXPP_MR_2.5G Card Default Settings (ETSI) D-55

Table D-17 TXP_MR_10E Card Default Settings (ETSI) D-57
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Table D-18 TXP_MR_10G Card Default Settings (ETSI) D-62

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) D-67

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) D-73

Table D-21 OSCM Card Default Settings (ETSI) D-79

Table D-22 OSC-CSM Card Default Settings (ETSI) D-80

Table D-23 Node Default Settings (ETSI) D-82

Table D-24 CTC Default Settings (ETSI) D-85
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P R O C E D U R E S
NTP-G1 Unpack and Inspect the Shelf Assembly 1-6

NTP-G2 Install the Shelf Assembly 1-8

NTP-G3 Open and Remove the Front Door 1-20

NTP-G4 Open and Remove the FMEC Cover (ETSI Only) 1-23

NTP-G5 Remove the Backplane Covers (ANSI Only) 1-26

NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only) 1-28

NTP-G7 Install the Power and Ground 1-30

NTP-G8 Install the Fan-Tray Assembly 1-40

NTP-G9 Install the Alarm Expansion Panel (ANSI Only) 1-43

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections 1-46

NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only) 1-57

NTP-G12 Install and Close the FMEC Cover (ETSI Only) 1-61

NTP-G13 Install the Rear Cover (ANSI Only) 1-62

NTP-G14 Install DWDM Equipment 1-64

NTP-G15 Install the Common Control Cards 1-69

NTP-G16 Perform the Shelf Installation Acceptance Test 1-74

NTP-G17 Set Up Computer for CTC 2-1

NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454 2-9

NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454 2-21

NTP-G20 Set Up a Remote Access Connection to the ONS 15454 2-23

NTP-G21 Log into the ONS 15454 GUI 2-24

NTP-G139 Verify Cisco MetroPlanner Reports and Files 3-2

NTP-G22 Verify Common Card Installation 3-4

NTP-G23 Create Users and Assign Security 3-5

NTP-G24 Set Up Name, Date, Time, and Contact Information 3-8

NTP-G25 Set Power Monitor Thresholds 3-9

NTP-G26 Set Up CTC Network Access 3-10

NTP-G27 Set Up the ONS 15454 for Firewall Access 3-21

NTP-G28 Set Up SNMP 3-24

NTP-G29 Preprovision a Slot 3-26

NTP-G30 Install the DWDM Cards 3-27
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Procedures
NTP-G31 Install the DWDM Dispersion Compensating Units 3-30

NTP-G32 Install the Transponder and Muxponder Cards 3-31

NTP-G123 Install the Filler Cards 3-35

NTP-G33 Create a Y-Cable Protection Group 3-36

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs 3-39

NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, or ROADM Node and the Transponder 
Cards 3-63

NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules 3-69

NTP-G36 Calculate Cable Connections 3-70

NTP-G138 Import a Cisco MetroPlanner Configuration File 3-72

NTP-G37 Run Automatic Node Setup 3-73

NTP-G38 Provision OSC Terminations and Ring ID 3-74

NTP-G39 Verify OSCM and OSC-CSM Transmit Power 3-76

NTP-G41 Perform the Terminal and Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test 4-2

NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test 4-5

NTP-G43 Perform the ROADM Node Acceptance Test 4-8

NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test 4-20

NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test 4-23

NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test 4-26

NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test 4-30

NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards 4-33

NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM Cards 4-35

NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM Cards 4-37

NTP-G128 Manage Pluggable Port Modules 5-2

NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards 5-8

NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E 
Cards 5-25

NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_MR_2.5G 
Cards 5-39

NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G 
Cards 5-53

NTP-G51 Verify DWDM Node Turn Up 6-1

NTP-G52 Verify Node-to-Node Connections 6-3

NTP-G53 Set Up Timing 6-3

NTP-G54 Provision and Verify a DWDM Network 6-7

NTP-G56 Verify the OSNR 6-11

NTP-G142 Perform a Protection Switch Test 6-12
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Procedures
NTP-G57 Create a Logical Network Map 6-14

NTP-G58 Locate and View Optical Channel Network Connections 7-2

NTP-G59 Create and Delete Optical Channel Network Connections 7-9

NTP-G60 Create Overhead Circuits 7-13

NTP-G61 Modify and Delete Overhead Circuits 7-20

NTP-G62 Create a J0 Section Trace 7-22

NTP-G63 Document Existing Provisioning 8-2

NTP-G64 View Alarms, History, Events, and Conditions 8-5

NTP-G65 Delete Cleared Alarms from Display 8-13

NTP-G66 View Alarm-Affected Circuits 8-14

NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port 8-14

NTP-G68 Create, Download, and Assign Alarm Severity Profiles 8-16

NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering 8-24

NTP-G70 Suppress Alarms or Discontinue Alarm Suppression 8-28

NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card 8-31

NTP-G73 Change the PM Display 9-2

NTP-G74 Monitor DWDM Card Performance 9-8

NTP-G75 Monitor Transponder and Muxponder Performance 9-18

NTP-G76 Verify Span Loss 10-2

NTP-G77 Manage Automatic Power Control 10-3

NTP-G78 View ROADM Node Power Equalization 10-5

NTP-G80 Change Node Management Information 10-6

NTP-G81 Change CTC Network Access 10-9

NTP-G82 Customize the CTC Network View 10-16

NTP-G83 Modify or Delete Card Protection Settings 10-21

NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands 10-24

NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords 10-28

NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection 10-32

NTP-G87 Change Node Timing Parameters 10-33

NTP-G88 Modify Users and Change Security 10-35

NTP-G131 Convert DWDM Nodes to Hybrid Nodes 10-43

NTP-G89 Change SNMP Settings 10-46

NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds 11-2

NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds 11-11

NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds 11-22
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Procedures
NTP-G93 Modify the 32WSS Thresholds and Settings 11-31

NTP-G101 Modify Alarm Interface Controller–International Settings 11-41

NTP-G102 Change Card Service State 11-44

NTP-G103 Back Up the Database 12-2

NTP-G104 Restore the Database 12-3

NTP-G105 Restore the Node to Factory Configuration 12-4

NTP-G106 Reset Cards Using CTC 12-9

NTP-G108 Viewing the Audit Trail Records 12-11

NTP-G109 Off-Load the Audit Trail Record 12-13

NTP-G110 Off-Load the Diagnostics File 12-13

NTP-G112 Change the Node Timing Reference 12-14

NTP-G113 View the ONS 15454 Timing Report 12-16

NTP-G114 Inspect, Clean, and Replace the Air Filter 12-19

NTP-G115 Clean Fiber Connectors 12-22

NTP-G40 Replace the Front Door 12-25

NTP-G116 Replace the Fan-Tray Assembly 12-27

NTP-G117 Replace the ANSI Shelf Alarm Interface Panel 12-32

NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover 12-36

NTP-G135 Edit Network Element Defaults 12-38

NTP-G136 Import Network Element Defaults 12-39

NTP-G137 Export Network Element Defaults 12-40

NTP-G119 Power Down the Node 13-1
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T A S K S
DLP-G1 Unpack and Verify the Shelf Assembly 1-6

DLP-G2 Inspect the Shelf Assembly 1-7

DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only) 1-10

DLP-G4 Install the External Brackets and Air Filter (ANSI Only) 1-11

DLP-G5 Mount the Shelf Assembly in a Rack (One Person) 1-13

DLP-G6 Mount the Shelf Assembly in a Rack (Two People) 1-15

DLP-G7 Mount Multiple Shelf Assemblies in a Rack 1-16

DLP-G8 Install the Air Ramp 1-19

DLP-G9 Open the Front Cabinet Compartment (Door) 1-20

DLP-G10 Remove the Front Door 1-21

DLP-G11 Open the FMEC Cover 1-24

DLP-G12 Remove the FMEC Cover 1-25

DLP-G13 Remove the Lower Backplane Cover 1-26

DLP-G14 Remove the Backplane Sheet Metal Cover 1-27

DLP-G15 Connect the Office Ground to the ONS 15454 ETSI 1-32

DLP-G16 Connect the Office Ground to the ONS 15454 ANSI 1-33

DLP-G17 Connect Office Power to the ONS 15454 ETSI 1-35

DLP-G18 Connect Office Power to the ONS 15454 ANSI 1-36

DLP-G19 Turn On and Verify Office Power 1-39

DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only) 1-47

DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only) 1-50

DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only) 1-51

DLP-G23 Install Alarm Wires on the Backplane (ANSI Only) 1-52

DLP-G24 Install Timing Wires on the Backplane (ANSI Only) 1-54

DLP-G25 Install LAN Wires on the Backplane (ANSI Only) 1-55

DLP-G26 Install the TL1 Craft Interface (ANSI Only) 1-56

DLP-G27 Install the DCU Shelf Assembly 1-65

DLP-G28 Install the Fiber Patch-Panel Tray 1-65

DLP-G29 Install the Fiber-Storage Tray 1-66

DLP-G30 Install the FlexLayer Shelf 1-66

DLP-G31 Install the FlexLayer Modules 1-67
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Tasks
DLP-G32 Install the Y-Cable Protection Modules 1-69

DLP-G33 Install the TCC2 or TCC2P Card 1-70

DLP-G34 Install the AIC-I Card 1-73

DLP-G35 Inspect the Shelf Installation and Connections 1-75

DLP-G36 Measure Voltage 1-76

DLP-G37 Run the CTC Installation Wizard for Windows 2-3

DLP-G38 Run the CTC Installation Wizard for UNIX 2-6

DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP 
Addresses 2-11

DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration 
Protocol 2-13

DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection 2-16

DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454 2-19

DLP-G43 Disable Proxy Service Using Internet Explorer (Windows) 2-22

DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX) 2-22

DLP-G46 Log into CTC 2-24

DLP-G47 Install Public-Key Security Certificate 2-27

DLP-G48 Create Login Node Groups 2-28

DLP-G49 Add a Node to the Current Session or Login Group 2-29

DLP-G50 Delete a Node from the Current Session or Login Group 2-30

DLP-G51 Delete a Node from a Specified Login Node Group 2-30

DLP-G52 Change the JRE Version 2-31

DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup 2-32

DLP-G54 Create a New User on a Single Node 3-6

DLP-G55 Create a New User on Multiple Nodes 3-6

DLP-G56 Provision IP Settings 3-11

DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD 3-14

DLP-G264 Enable Node Security Mode 3-16

DLP-G58 Create a Static Route 3-17

DLP-G59 Set Up or Change Open Shortest Path First Protocol 3-18

DLP-G60 Set Up or Change Routing Information Protocol 3-20

DLP-G61 Provision the IIOP Listener Port on the ONS 15454 3-23

DLP-G62 Provision the IIOP Listener Port on the CTC Computer 3-23

DLP-G273 Preprovision an SFP or XFP Slot 3-33

DLP-G63 Install an SFP or XFP 3-34

DLP-G64 Remove an SFP or XFP 3-34
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Tasks
DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two Adjacent Nodes 3-42

DLP-G66 Install Fiber-Optic Cables for a Hub Node 3-45

DLP-G67 Install Fiber-Optic Cables for a Terminal Node 3-47

DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node 3-49

DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node 3-51

DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node 3-54

DLP-G71 Install Fiber-Optic Cables for an ROADM Node 3-59

DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Patch 
Panel 3-64

DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel 3-68

DLP-G72 Create a DWDM Connection 3-71

DLP-G73 Delete a DWDM Connection 3-72

DLP-G313 Verify OSC-CSM Transmit Power 3-77

DLP-G314 Verify OSCM Transmit Power 3-78

DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing 4-4

DLP-G310 Verify ROADM Node Pass-Through Channels 4-12

DLP-G311 Verify the East ROADM Add/Drop Channels 4-16

DLP-G312 Verify the West ROADM Add/Drop Channels 4-18

DLP-G78 Verify the 32MUX-O Power 4-39

DLP-G79 Verify the OPT-BST Amplifier Laser and Power 4-39

DLP-G80 Verify the OPT-PRE Amplifier Laser and Power 4-40

DLP-G269 Verify the 32DMX-O Power 4-40

DLP-G270 Verify the 32DMX Power 4-41

DLP-G82 Verify the OSC-CSM Power 4-41

DLP-G83 Verify the OSC-CSM Power on OADM Nodes 4-42

DLP-G84 Verify the OSC-CSM Incoming Power 4-42

DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM Cards 4-43

DLP-G86 Verify Express Channel Connections on an OADM Node with OSC-CSM Cards 4-44

DLP-G87 Verify the AD-xB-xx.x Output Express Power 4-45

DLP-G88 Verify the AD-xC-xx.x Output Express Power 4-46

DLP-G271 Verify the AD-xC-xx.x Output Common Power 4-46

DLP-G272 Verify the AD-xB-xx.x Output Common Power 4-46

DLP-G89 Verify OADM Node Pass-Through Channel Connections 4-47

DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power 4-48

DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection 4-49

DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power 4-50
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DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards 4-51

DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Cards 4-54

DLP-G277 Provision a Multirate PPM 5-3

DLP-G278 Provision the Optical Line Rate 5-3

DLP-G274 Verify Topologies for ETR_CLO and ISC Services 5-6

DLP-G280 Delete a PPM 5-7

DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards 5-9

DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards 5-10

DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards 5-13

DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads 5-15

DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy 5-16

DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds 5-19

DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA Thresholds 5-20

DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards 5-22

DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-26

DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-28

DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-30

DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-31

DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-33

DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds 5-34

DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA Thresholds 5-35

DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-36

DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-40

DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-42

DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-43

DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH 
Payloads 5-45

DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON 
Payloads 5-46

DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-47

DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA 
Thresholds 5-48

DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-51

DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-54

DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-55

DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-57
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DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-58

DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-60

DLP-G240 Change MXP_MR_2.5G and MXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH 
Payloads 5-61

DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G 
FC/FICON Payloads 5-62

DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-64

DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds 5-65

DLP-G95 Set Up External or Line Timing 6-4

DLP-G96 Set Up Internal Timing 6-6

DLP-G99 Create a Provisionable Patchcord 6-10

DLP-G100 Search for Optical Channel Network Connections 7-2

DLP-G101 View Optical Channel Network Connection Information 7-3

DLP-G102 Filter the Display of Optical Channel Network Connections 7-6

DLP-G103 View Optical Channel Network Connections on a Span 7-8

DLP-G104 Assign a Name to a Port 7-9

DLP-G105 Provision DWDM Optical Channel Network Connections 7-10

DLP-G106 Delete Optical Channel Network Connections 7-12

DLP-G76 Provision GCC Terminations 7-13

DLP-G97 Provision a Proxy Tunnel 7-14

DLP-G98 Provision a Firewall Tunnel 7-15

DLP-G107 Create an IP-Encapsulated Tunnel 7-16

DLP-G108 Change the Service State for a Port 7-17

DLP-G109 Provision Orderwire 7-18

DLP-G110 Create a User Data Channel Circuit 7-19

DLP-G111 Repair an IP Tunnel 7-21

DLP-G112 Delete Overhead Circuits 7-21

DLP-G113 Print CTC Data 8-2

DLP-G114 Export CTC Data 8-4

DLP-G115 View Alarms 8-6

DLP-G116 View Alarm or Event History 8-8

DLP-G117 Change the Maximum Number of Session Entries for Alarm History 8-9

DLP-G118 Display Alarms and Conditions Using Time Zone 8-10

DLP-G119 Synchronize Alarms 8-11

DLP-G120 View Conditions 8-11

DLP-G121 Create a New or Cloned Alarm Severity Profile 8-16
lvii
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Tasks
DLP-G122 Download an Alarm Severity Profile 8-19

DLP-G123 Apply Alarm Profiles to Ports 8-20

DLP-G124 Apply Alarm Profiles to Cards and Nodes 8-22

DLP-G125 Delete Alarm Severity Profiles 8-22

DLP-G126 Enable Alarm Filtering 8-25

DLP-G127 Modify Alarm, Condition, and History Filtering Parameters 8-25

DLP-G128 Disable Alarm Filtering 8-27

DLP-G129 Suppress Alarm Reporting 8-28

DLP-G130 Discontinue Alarm Suppression 8-30

DLP-G131 Refresh PM Counts at 15-Minute Intervals 9-2

DLP-G132 Refresh PM Counts at One-Day Intervals 9-3

DLP-G133 View Near-End PM Counts 9-4

DLP-G134 View Far-End PM Counts 9-5

DLP-G135 Reset Current PM Counts 9-5

DLP-G136 Clear Selected PM Counts 9-6

DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts 9-7

DLP-G138 Refresh PM Counts for a Different Port 9-8

DLP-G139 View Optical Service Channel PM Parameters 9-9

DLP-G140 View Optical Amplifier Power Statistics 9-11

DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards 9-12

DLP-G276 View 4-Channel Multiplexer/Demultiplexer Optical Power Statistics 9-14

DLP-G142 View Channel Optical Add/Drop Multiplexer Power Statistics 9-15

DLP-G143 View Band Optical Add/Drop Multiplexer Power Statistics 9-17

DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring 9-19

DLP-G145 Enable/Disable OTN FEC Performance Monitoring 9-20

DLP-G146 View Optics PM Parameters 9-21

DLP-G147 View Payload PM Parameters 9-22

DLP-G148 View OTN PM Parameters 9-24

DLP-G149 View Payload Statistics PM Parameters 9-26

DLP-G150 View Payload Utilization PM Parameters 9-27

DLP-G151 View Payload History PM Parameters 9-29

DLP-G152 View Payload SONET PM Parameters 9-30

DLP-G153 Create RMON Alarm Thresholds 9-32
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About this Guide

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information.

Revision History

This section provides the following information:

• Document Objectives

• Audience

• Document Organization

• Related Documentation

• Document Conventions

• Where to Find Safety and Warning Information

• Obtaining Documentation

• Documentation Feedback

• Obtaining Technical Assistance

• Obtaining Additional Publications and Information

Date Notes

03/28/2007 Revision History Table added for the first time

09/06/2007 Updated the About this Guide chapter
lxiii
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



About this Guide
Document Objectives
Document Objectives
This document explains installation, turn up, provisioning, and maintenance for Cisco ONS 15454 dense 
wavelength division (DWDM) systems. Use this document in conjunction with the appropriate 
publications listed in the Related Documentation section.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware 
and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and 
preferably have experience as a telecommunications technician.

Document Organization
The Cisco ONS 15454 DWDM Installation and Operations Guide, Release 4.7 is organized into the 
following chapters:

• Chapter 1, “Install the Shelf and Common Control Cards” provides procedures for installing Cisco 
ONS 15454 ANSI and ETSI shelves and common control cards including the TCC2 and AIC/AIC-I.

• Chapter 2, “Connect the PC and Log into the GUI” includes procedures to install the Cisco 
Transport Controller (CTC), set up a computer for different connection types, and log into the 
Cisco ONS 15454.

• Chapter 3, “Turn Up a Node”provides procedures for node turn up and DWDM card installation.

• Chapter 4, “Perform Node Acceptance Tests” provides acceptance tests for each DWDM node type.

• Chapter 5, “Provision Transponder and Muxponder Cards” provides procedures for provisioning the 
transponder and muxponder cards.

• Chapter 6, “Turn Up Network” explains how to turn up and test a DWDM network.

• Chapter 7, “Create Channels and Circuits” explains how to create DWDM optical channel network 
connections (OCHNCs) and overhead circuits.

• Chapter 8, “Manage Alarms”explains how to document existing node data, view and delete alarms, 
view alarm-affected circuits and LCD alarm counts, manage alarm profiles, filter alarms, suppress 
alarms, and provision external alarms.

• Chapter 9, “Monitor Performance” provides procedures to change the performance monitoring (PM) 
display, monitor performance, and manage remote monitoring (RMON) thresholds.

• Chapter 10, “Manage the Node” explains how to modify node provisioning for the Cisco ONS 
15454 and perform common management tasks such as monitoring the DWDM automatic power 
control and span loss values.

• Chapter 11, “Change DWDM Card Settings” explains how to change line, performance monitoring 
(PM), and threshold settings on Cisco ONS 15454 cards.

• Chapter 12, “Maintain the Node” provides hardware and software maintenance procedures for the 
Cisco ONS 15454, including procedures for editing, importing, and exporting network element 
defaults. 

• Chapter 13, “Power Down a Node” expains how to shut down an ONS 15454.
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Related Documentation
• Chapter 14, “Shelf Hardware Reference” includes descriptions of the rack, backplane, FMECs, 
ferrites, power and ground, fan-tray assembly, air filter, card slots, cables, cable connectors, and 
cable routing.

• Chapter 15, “Card Reference” provides descriptions of the common control, 
transponder/muxponder, and DWDM cards as well as small-form factor pluggables (SFPs).

• Chapter 16, “Node Reference” explains the ONS 15454DWDM node types that are available for the 
ONS 15454. The chapter also explains the DWDM automatic power control, ROADM power 
equalization, span loss verification, and automatic node setup functions. 

• Chapter 17, “Network Reference” explains the ONS 15454 DWDM network applications and 
topologies.

• Chapter 18, “CTC Operation Reference” includes information about CTC installation, the CTC 
window, computer requirements, software versions, and database reset and revert.

• Chapter 19, “Security and Timing Reference” describes user security and node/network timing.

• Chapter 20, “CTC Connectivity Reference” includes IP addressing scenarios and information about 
provisionable patchcords, open GNE, and external firewalls..

• Chapter 21, “Alarm Management Reference” describes Cisco Transport Controller (CTC) alarm 
management.

• Appendix A, “CTC Information and Shortcuts” describes the CTC views, menus options, tool 
options, shortcuts, table display options, and shelf inventory data.

• Appendix B, “Hardware Specifications” contains hardware and software specifications for the ONS 
15454 ANSI and ETSI shelf assemblies and cards.

• Appendix C, “DWDM Administrative and Service States” describes the state model for Cisco ONS 
15454 DWDM cards, optical payload ports, out-of-band optical supervision channel (OSC) ports, 
optical channel network connections (OCHNC), and transponder/muxponder cards and ports.

• Appendix D, “Network Element Defaults” describes and lists card, node, and CTC level network 
element (NE) defaults. To edit, import, or export NE defaults, see Chapter 12, “Maintain the Node.”

Related Documentation
Use the Cisco ONS 15454 DWDM Installation and Operations Guide in conjunction with the following 
referenced publications:

• Cisco ONS 15454 Troubleshooting Guide

• Cisco ONS 15454 SDH Troubleshooting Guide, Release 5.0

• Cisco ONS SONET TL1 Command Guide, Release 5.0

• Cisco ONS SDH TL1 Command Guide, Release 5.0

• Release Notes for Cisco ONS 15454 Release 5.0

• Release Notes for Cisco ONS 15454 SDH Release 5.0

Document Conventions
This publication uses the following conventions:
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Document Conventions
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.
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Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this 
device. Statement 1071

SAVE THESE INSTRUCTIONS

Waarschuwing BELANGRIJKE VEILIGHEIDSINSTRUCTIES

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan 
veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij 
elektrische schakelingen betrokken risico's en dient u op de hoogte te zijn van de standaard 
praktijken om ongelukken te voorkomen. Gebruik het nummer van de verklaring onderaan de 
waarschuwing als u een vertaling van de waarschuwing die bij het apparaat wordt geleverd, wilt 
raadplegen.

BEWAAR DEZE INSTRUCTIES

Varoitus TÄRKEITÄ TURVALLISUUSOHJEITA

Tämä varoitusmerkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia vammoja. Ennen kuin 
käsittelet laitteistoa, huomioi sähköpiirien käsittelemiseen liittyvät riskit ja tutustu 
onnettomuuksien yleisiin ehkäisytapoihin. Turvallisuusvaroitusten käännökset löytyvät laitteen 
mukana toimitettujen käännettyjen turvallisuusvaroitusten joukosta varoitusten lopussa näkyvien 
lausuntonumeroiden avulla.

SÄILYTÄ NÄMÄ OHJEET

Attention IMPORTANTES INFORMATIONS DE SÉCURITÉ 

Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une situation pouvant 
entraîner des blessures ou des dommages corporels. Avant de travailler sur un équipement, soyez 
conscient des dangers liés aux circuits électriques et familiarisez-vous avec les procédures 
couramment utilisées pour éviter les accidents. Pour prendre connaissance des traductions des 
avertissements figurant dans les consignes de sécurité traduites qui accompagnent cet appareil, 
référez-vous au numéro de l'instruction situé à la fin de chaque avertissement.

CONSERVEZ CES INFORMATIONS

Warnung WICHTIGE SICHERHEITSHINWEISE

Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu Verletzungen führen 
kann. Machen Sie sich vor der Arbeit mit Geräten mit den Gefahren elektrischer Schaltungen und 
den üblichen Verfahren zur Vorbeugung vor Unfällen vertraut. Suchen Sie mit der am Ende jeder 
Warnung angegebenen Anweisungsnummer nach der jeweiligen Übersetzung in den übersetzten 
Sicherheitshinweisen, die zusammen mit diesem Gerät ausgeliefert wurden.

BEWAHREN SIE DIESE HINWEISE GUT AUF.
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Avvertenza IMPORTANTI ISTRUZIONI SULLA SICUREZZA 

Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe causare infortuni alle 
persone. Prima di intervenire su qualsiasi apparecchiatura, occorre essere al corrente dei pericoli 
relativi ai circuiti elettrici e conoscere le procedure standard per la prevenzione di incidenti. 
Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza  per individuare le 
traduzioni delle avvertenze riportate in questo documento. 

CONSERVARE QUESTE ISTRUZIONI

Advarsel VIKTIGE SIKKERHETSINSTRUKSJONER

Dette advarselssymbolet betyr fare. Du er i en situasjon som kan føre til skade på person. Før du 
begynner å arbeide med noe av utstyret, må du være oppmerksom på farene forbundet med 
elektriske kretser, og kjenne til standardprosedyrer for å forhindre ulykker. Bruk nummeret i slutten 
av hver advarsel for å finne oversettelsen i de oversatte sikkerhetsadvarslene som fulgte med denne 
enheten.

TA VARE PÅ DISSE INSTRUKSJONENE

Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA 

Este símbolo de aviso significa perigo. Você está em uma situação que poderá ser causadora de 
lesões corporais. Antes de iniciar a utilização de qualquer equipamento, tenha conhecimento dos 
perigos envolvidos no manuseio de circuitos elétricos e familiarize-se com as práticas habituais de 
prevenção de acidentes. Utilize o número da instrução fornecido ao final de cada aviso para 
localizar sua tradução nos avisos de segurança traduzidos que acompanham este dispositivo.

GUARDE ESTAS INSTRUÇÕES 

¡Advertencia! INSTRUCCIONES IMPORTANTES DE SEGURIDAD

Este símbolo de aviso indica peligro. Existe riesgo para su integridad física. Antes de manipular 
cualquier equipo, considere los riesgos de la corriente eléctrica y familiarícese con los 
procedimientos estándar de prevención de accidentes. Al final de cada advertencia encontrará el 
número que le ayudará a encontrar el texto traducido en el apartado de traducciones que acompaña 
a este dispositivo. 

GUARDE ESTAS INSTRUCCIONES

Varning! VIKTIGA SÄKERHETSANVISNINGAR

Denna varningssignal signalerar fara. Du befinner dig i en situation som kan leda till personskada. 
Innan du utför arbete på någon utrustning måste du vara medveten om farorna med elkretsar och 
känna till vanliga förfaranden för att förebygga olyckor. Använd det nummer som finns i slutet av 
varje varning för att hitta dess översättning i de översatta säkerhetsvarningar som medföljer denna 
anordning.

SPARA DESSA ANVISNINGAR
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Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você se encontra em uma situação em que há risco de lesões 
corporais. Antes de trabalhar com qualquer equipamento, esteja ciente dos riscos que envolvem os 
circuitos elétricos e familiarize-se com as práticas padrão de prevenção de acidentes. Use o 
número da declaração fornecido ao final de cada aviso para localizar sua tradução nos avisos de 
segurança traduzidos que acompanham o dispositivo.

GUARDE ESTAS INSTRUÇÕES

Advarsel VIGTIGE SIKKERHEDSANVISNINGER

Dette advarselssymbol betyder fare. Du befinder dig i en situation med risiko for 
legemesbeskadigelse. Før du begynder arbejde på udstyr, skal du være opmærksom på de 
involverede risici, der er ved elektriske kredsløb, og du skal sætte dig ind i standardprocedurer til 
undgåelse af ulykker. Brug erklæringsnummeret efter hver advarsel for at finde oversættelsen i de 
oversatte advarsler, der fulgte med denne enhed.

GEM DISSE ANVISNINGER
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Where to Find Safety and Warning Information
Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15xxx systems. It also 
includes translations of the safety warnings that appear in the ONS 15xxx system documentation.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product Documentation DVD package, 
which may have shipped with your product. The Product Documentation DVD is updated regularly and 
may be more current than printed documentation.

The Product Documentation DVD is a comprehensive library of technical product documentation on 
portable media. The DVD enables you to access multiple versions of hardware and software installation, 
configuration, and command guides for Cisco products and to view technical documentation in HTML. 
With the DVD, you have access to the same documentation that is found on the Cisco website without 
being connected to the Internet. Certain products also have .pdf versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace.

Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

Cisco Marketplace:

http://www.cisco.com/go/marketplace/
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Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco documentation at the Product 
Documentation Store in the Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Cisco will continue to support documentation orders using the Ordering tool:

• Registered Cisco.com users (Cisco direct customers) can order documentation from the 
Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

• Instructions for ordering documentation using the Ordering tool are at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
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Obtaining Technical Assistance
From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product 
Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you might have identified a 
vulnerability in a Cisco product, contact PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

• Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive 
information that you send to Cisco. PSIRT can work from encrypted information that is compatible with 
PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.htm

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.
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Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose 
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by 
product ID or model name; by tree view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the information before placing a 
service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.
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Obtaining Additional Publications and Information
Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html
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Obtaining Additional Publications and Information
• Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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Cisco ONS 15454 DWDM
September 2005
C H A P T E R 1

Install the Shelf and Common Control Cards

This chapter explains how to install the Cisco ONS 15454 ETSI and Cisco ONS 15454 ANSI shelf 
assemblies. Where procedures differ for the two shelf types, the procedure will indicate “ANSI only” or 
“ETSI only.” For a summary of the tools and equipment required for installation, see the “Required Tools 
and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” section on 
page 1-3.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). Read 
the installation procedures and precautions before you install the ONS 15454 ANSI or ONS 15454 ETSI 
and connect the power source. 

1. NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6—Complete this procedure before 
continuing with the “NTP-G2 Install the Shelf Assembly” procedure on page 1-8.

2. NTP-G2 Install the Shelf Assembly, page 1-8—Complete this procedure to install the shelf 
assembly in a rack.

3. NTP-G3 Open and Remove the Front Door, page 1-20—Complete this procedure to access the 
equipment before continuing with other procedures in this chapter.

4. NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23—Complete this procedure to 
access the electrical facility connection assembly (EFCA) for the front mount electrical connections 
(FMECs) before continuing with other procedures in this chapter.

5. NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26— Complete this procedure to 
access the backplane before continuing with other procedures.

6. NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28—Complete this 
procedure to install the MIC-A/P and MIC-T/C/P FMECs, which are required for power supply as 
well as alarm, timing, and LAN connections. 

7. NTP-G7 Install the Power and Ground, page 1-30—Complete this procedure before continuing with 
the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.

8. NTP-G8 Install the Fan-Tray Assembly, page 1-40—Complete this procedure to install the fan-tray 
assembly in the shelf.
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Before You Begin
9. NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-43—Complete this procedure if 
you are planning to install the Alarm Interface Controller–International (AIC-I) card and want to 
increase the number of alarm contacts provided by the AIC-I card. 

10. NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-46—Complete 
as needed to set up wire-wrap pin connections.

11. NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-57 —Complete this 
procedure to connect an external wire-wrap panel to the alarm expansion panel (AEP).

12. NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-61—Complete this procedure to 
install the FMEC cover.

13. NTP-G13 Install the Rear Cover (ANSI Only), page 1-62—Complete this procedure as needed to 
install the rear cover after you have finished servicing the backplane. 

14. NTP-G14 Install DWDM Equipment, page 1-64—Complete this procedure as needed to install 
equipment needed for DWDM networks.

15. NTP-G15 Install the Common Control Cards, page 1-69—Complete this procedure to install the 
TCC2/TCC2P card and the AIC-I card. 

16. NTP-G16 Perform the Shelf Installation Acceptance Test, page 1-74—Complete this procedure to 
determine if you have correctly completed all other procedures in the chapter.

Warning Installation of the equipment must comply with local and national electrical codes. Statement 1074

Warning This equipment must be installed and maintained by service personnel as defined by AS/NZS 3260. 
Incorrectly connecting this equipment to a general-purpose outlet could be hazardous. The 
telecommunications lines must be disconnected 1) before unplugging the main power connector or 2) 
while the housing is open, or both. Statement 1043

Warning This unit is intended for installation in restricted access areas. A restricted access area can be 
accessed only through the use of a special tool, lock and key, or other means of security. 
Statement 1017

Warning Ultimate disposal of this product should be handled according to all national laws and regulations. 
Statement 1040

Warning A readily accessible two-poled disconnect device must be incorporated in the fixed wiring. Statement 
1022

Note The ONS 15454 is suitable for mounting on concrete or other noncombustible surfaces only. 

Note In this chapter, “shelf assembly” refers to the steel enclosure that holds cards and connects power, and 
“node” refers to the entire hardware and software system.
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ANSI)
Required Tools and Equipment (ANSI)
You need the following tools and equipment to install and test the ONS 15454 ANSI shelf assembly.

Cisco-Supplied Materials (ANSI)
The following materials are required and are shipped with the ONS 15454 ANSI shelf (wrapped in 
plastic). The number in parentheses gives the quantity of the item included in the package.

• #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX) (8)

• #12 -24 x 3/4 socket set screws (48-1003-XX) (2)

• T-handle #12-24 hex tool for set screws (1)

• ESD wrist strap with 1.8 m (6 ft) coil cable (1)

• Tie wraps (10)

• Pinned hex (Allen) key for front door (1)

• Spacers (50-1193-XX) (4)

• Spacer mounting brackets (2)

• Sheet metal backplane cover (installed) (1)

• External (bottom) brackets for the fan-tray air filter

• Standoff kit (53-0795-XX):

– Plastic fiber management guides (2)

– Fan filter bracket screws (53-48-0003) (6)

User-Supplied Materials (ANSI)
The following materials and tools are required but are not supplied with the ONS 15454 ANSI:

• One or more of the following equipment racks: 

– 19-inch ANSI Standard (Telcordia GR-63-CORE) (482.6 mm) rack; total width 22 inches 
(558.8 mm)

– 23-inch ANSI Standard (Telcordia GR-63-CORE) (584.2 mm) rack; total width 26 inches 
(660.4 mm)

• Fuse panel

• Power cable (from fuse and alarm panel to assembly), #10AWG, copper conductors, 
194 degrees Fahrenheit (90 degrees Celsius)

• Ground cable #6AWG stranded

• Alarm cable pairs for all alarm connections, #22 or #24 AWG (0.51 mm² or 0.64 mm²), solid tinned

• 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair 
T1-type

• Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical (OC-N) cards

• Shielded coaxial cable terminated with SMB or BNC connectors for DS-3 cards
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Required Tools and Equipment (ETSI)
• Shielded ABAM cable terminated with AMP Champ connectors or unterminated for DS1N-14 cards 
with #22 or #24 AWG (0.51 mm² or 0.64 mm²) ground wire (typically about two ft [61 cm] in length)

• 6-pair #29 AWG double-shielded cable

• Tie wraps and/or lacing cord 

• Labels

• Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for 
#10 AWG copper conductors

Tools Needed (ANSI)

The following tools are needed to install an ONS 15454 ANSI:

• #2 Phillips screwdriver

• Medium slot-head screwdriver 

• Small slot-head screwdriver 

• Wire wrapper

• Wire cutters

• Wire strippers

• Crimp tool

• BNC insertion tool

Test Equipment (ANSI)

The following test equipment is needed to install an ONS 15454:

• Voltmeter

• Optical power meter (for use with fiber optics only)

• BER tester, DS-1 and DS-3

Required Tools and Equipment (ETSI)
You need the following tools and equipment to install and test the ONS 15454 ETSI shelf assembly.

Cisco-Supplied Equipment (ETSI)
These materials are required for installation and are supplied with the ONS 15454 ETSI. The shipped 
quantity of each item is in parentheses.

• Double-hole grounding lug for ground connection with a wire receptacle to accommodate the 
recommended 13.3 mm² (#6 AWG) multistrand copper wire (1)

• M4 x 8 mm pan-head Phillips screws (2)

• M6 x 20 mm socket set screws (2)

• M6 x 20 mm pan-head Phillips screws (8)

• Tie wraps 0.125-inch (3.2 mm) W x 6.0-inch (152 mm) L (24)
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Required Tools and Equipment (ETSI)
• ESD wrist strap (disposable) (1)

• Pinned Allen key for front door (1)

• Hex key 3-mm long arm (1)

• Bottom brackets for the fan-tray air filter

• Cable assembly, Ethernet, RJ-45 (1)

• Power cable (from fuse and alarm panel to MIC-A/P and MIC-C/T/P) (2)

Caution Only use the power cables that are designed to be used with ONS 15454 ETSI. They are sold separately.

User-Supplied Equipment (ETSI)
The following materials and tools are required for installation but are not supplied with the 
ONS 15454 ETSI:

• Equipment rack (ETSI rack, 2200 mm [86.6 inch] H x 600 mm [23.6 inch] W 
x 300 mm [11.8 inch] D)

• Fuse and alarm panel

• Copper ground cable 13.3-mm² (#6 AWG) stranded, specified for up to 90 degrees Celsius 
(194 degrees Fahrenheit)

• Alarm cable pairs for all alarm connections, 0.51 mm² or 0.64 mm² (#22 or #24 AWG), solid-tinned

• Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical cards

• Coaxial cable terminated with 1.0/2.3 miniature coax connectors for FMEC cards

• DB-37 cable

• Shielded building integrated timing supply (BITS) clock coaxial cable terminated with 
1.0/2.3 miniature coax connectors

• Labels

Note Ring runs are not provided by Cisco and can hinder side-by-side shelf installation where space is limited. 

Tools Needed (ETSI)

To install the ONS 15454 ETSI, you need the following tools. 

• #2 Phillips screwdriver

• Medium slot-head screwdriver

• Small slot-head screwdriver

• Video fiber connector inspection instrument

• CLETOP cleaning cassette

• Crimping tool—This tool must be large enough to accommodate the girth of the grounding lug when 
you crimp the grounding cable into the lug.

• Wire stripping tool
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Required Tools and Equipment (ETSI)
Test Equipment (ETSI)

To install the ONS 15454 ETSI, you need the following test equipment. 

• Voltmeter

• Power meter (only for use with fiber optics)

• Bit error rate (BER) tester for E1-N-14, E1-42, E3-12, DS3i-N-12, STM1E-12, and FMEC cards

NTP-G1 Unpack and Inspect the Shelf Assembly 

Step 1 Complete the “DLP-G1 Unpack and Verify the Shelf Assembly” task on page 1-6.

Step 2 Complete the “DLP-G2 Inspect the Shelf Assembly” task on page 1-7.

Step 3 Continue with the “NTP-G1 Unpack and Inspect the Shelf Assembly” procedure on page 1-6.

Stop. You have completed this procedure.

DLP-G1 Unpack and Verify the Shelf Assembly 

Step 1 When you receive the ONS 15454 system equipment at the installation site, open the top of the box. The 
Cisco Systems logo designates the top of the box.

Step 2 Remove the foam inserts from the box. The box contains the ONS 15454  shelf (wrapped in plastic) and 
a smaller box of items needed for installation.

Step 3 To remove the shelf, grasp both rings of the shelf removal strap and slowly lift the shelf out of the box. 

Step 4 Open the smaller box of installation materials, and verify that you have all items listed in the “Required 
Tools and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” 
section on page 1-3. 

Purpose This procedure explains how to unpack the ONS 15454 shelf assemblies 
and verify their contents.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the shelf assembly from the package.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Required Tools and Equipment (ETSI)
Note The fan-tray assembly is shipped separately.

Step 5 Return to your originating procedure (NTP).

DLP-G2 Inspect the Shelf Assembly 

Step 1 Open the shelf using the pinned hex key. For more information, see the “DLP-G9 Open the Front Cabinet 
Compartment (Door)” task on page 1-20.

Step 2 Verify the following:

• The pins are not bent or broken.

• The frame is not bent.

Step 3 If the pins are bent or broken, or the frame is bent, call your Cisco sales engineer for a replacement.

Step 4 Close the front door before installing.

Step 5 Return to your originating procedure (NTP).

Purpose This task verifies that all parts of the shelf assembly are in good condition.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures DLP-G1 Unpack and Verify the Shelf Assembly, page 1-6

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Required Tools and Equipment (ETSI)
NTP-G2 Install the Shelf Assembly 
 

Warning Stability hazard. The rack stabilizing mechanism must be in place, or the rack must be bolted to the 
floor before you slide the unit out for servicing. Failure to stabilize the rack can cause the rack to tip 
over. Statement 1048

Warning This product requires short-circuit (overcurrent) protection, to be provided as part of the building 
installation. Install only in accordance with national and local wiring regulations. Statement 1045

Warning To prevent the system from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of:
45°C (113°F). Statement 1047

Warning Take care when connecting units to the supply circuit so that wiring is not overloaded. Statement 1018

Purpose This procedure reverses the mounting bracket and mounts shelf assemblies 
in a rack.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Pinned hex tool

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Warning To prevent airflow restriction, allow at least 1 inch (25.4 mm) of clearance around the ventilation 
openings.

Warning The ONS 15454 must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to allow air 
flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) 
provides this spacing and should not be modified in any way. 

Note The shelf, the air ramp, and the E1-75/120 conversion panel ship with the ETSI mounting brackets 
installed as needed for installation in an ETSI rack. If you want to install the node in a 19-inch 
(482.6-mm) rack, the ETSI mounting brackets of the shelf and the air ramp need to be replaced with the 
19-inch (482.6-mm) mounting brackets that shipped in the ship kit. 

Step 1 (ANSI shelves only.) Complete the “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) 
Rack (ANSI Only)” task on page 1-10 if you need to convert from a 23-inch (584.2 mm) to a 19-inch 
(482.6 mm) rack.

Step 2 (ANSI shelves only.) To install the air filter on the bottom of the shelf rather than below the fan-tray 
assembly, complete the “DLP-G4 Install the External Brackets and Air Filter (ANSI Only)” task on 
page 1-11.

Step 3 Complete the necessary rack mount task as applicable:

• DLP-G5 Mount the Shelf Assembly in a Rack (One Person), page 1-13

• DLP-G6 Mount the Shelf Assembly in a Rack (Two People), page 1-15

• DLP-G7 Mount Multiple Shelf Assemblies in a Rack, page 1-16

• DLP-G8 Install the Air Ramp, page 1-19

Step 4 Continue with the “NTP-G3 Open and Remove the Front Door” procedure on page 1-20.

Stop. You have completed this procedure.

Warning To prevent bodily injury when mounting or servicing this unit in a rack, you must take special 
precautions to ensure that the system remains stable. The following guidelines are provided to 
ensure your safety:

• This unit should be mounted at the bottom of the rack if it is the only unit in the rack.

• When mounting this unit in a partially filled rack, load the rack from the bottom to the top with the heaviest 
component at the bottom of the rack.

• If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in 
the rack. Statement 1006
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DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack 
(ANSI Only)

Caution Use only the fastening hardware provided with the ONS 15454 ANSI to prevent loosening, deterioration, 
and electromechanical corrosion of the hardware and joined material.

Caution When mounting the ONS 15454 in a frame with a nonconductive coating (such as paint, lacquer, or 
enamel) either use the thread-forming screws provided with the ONS 15454 ANSI ship kit, or remove 
the coating from the threads to ensure electrical continuity.

Step 1 Remove the screws that attach the mounting bracket to the side of the shelf assembly.

Step 2 Flip the detached mounting bracket upside down. 

Text imprinted on the mounting bracket will now also be upside down.

Step 3 Place the widest side of the mounting bracket flush against the shelf assembly (see Figure 1-1).

The narrow side of the mounting bracket should be towards the front of the shelf assembly. Text 
imprinted on the mounting bracket should be visible and upside down.

Step 4 Align the mounting bracket screw holes against the shelf assembly screw holes.

Step 5 Insert the screws that were removed in Step 1 and tighten them.

Step 6 Repeat the task for the mounting bracket on the opposite side.

Purpose This task installs the mounting bracket to convert a 23-inch (584.2 mm) 
rack to a 19-inch (482.6-mm) rack. This task applies to ONS 15454 ANSI 
shelves only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-1 Reversing the Mounting Brackets (23-inch [584.2-mm] Position to 19-inch [482.6-mm] Position

Step 7 Return to your originating procedure (NTP).

DLP-G4 Install the External Brackets and Air Filter (ANSI Only)

Note If you choose not to install the brackets, install the air filter by sliding it into the compartment at the 
bottom of the shelf assembly. Each time you remove and reinstall the air filter in the future, you must 
first remove the fan-tray assembly. Do not install an air filter in both filter locations on any shelf 
assembly.

Purpose This task installs the external brackets and air filter on the bottom of the 
shelf rather than below the fan-tray assembly. Installing the external 
brackets and air filter on the bottom of the shelf enables access to the air 
filter without removing the fan-tray assembly. This task applies to the 
ONS 15454 ANSI shelf only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack 
(ANSI Only), page 1-10, if applicable

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Top of unit Side of unit

Top of unit

19 in. (482.6 mm) position 23 in. (584.2 mm)
mounting holes

23 in. (584.2 mm) position

47
86

9

Mounting
L brackets

Front

Mounting
L brackets

Rear

Front

Rear

Rear Front

19 in. (482.6 mm)
mounting holes
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Step 1 With the fan-tray assembly removed, place the ONS 15454 facedown on a flat surface. 

Note Although the filter will work if it is installed with either side facing up, Cisco recommends that 
you install it with the metal bracing facing up to preserve the surface of the filter. 

Step 2 Locate the three screw holes that run along the left and right sides of the bottom of the shelf assembly. 

Step 3 Secure each bracket to the bottom of the shelf assembly using the screws (48-0003) provided in the 
backplane standoff kit (53-0795-XX).

Each bracket has a filter stopper and a flange on one end. Make sure to attach the brackets with the 
stoppers and flanges facing the rear of the shelf assembly (the top, if the ONS 15454 is facedown during 
installation). 

Figure 1-2 illustrates bottom bracket installation. If you do not use the brackets, in the future you must 
remove the fan-tray assembly before removing the air filter. The brackets enable you to clean and replace 
the air filter without removing the fan-tray assembly. 

Figure 1-2 Installing the External Brackets

Step 4 Slide the air filter into the shelf assembly.

Step 5 Return to your originating procedure (NTP).
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
DLP-G5 Mount the Shelf Assembly in a Rack (One Person) 

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of 
the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in 
the rack.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer instructions:

• (ETSI only) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]). 

Purpose This task allows one person to mount the shelf assembly in a rack.

Tools/Equipment Pinned hex tool 

# 2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-3 shows the rack-mounting position for the ONS 15454 ETSI.

Figure 1-3 Mounting an ONS 15454 ETSI in a Rack

Step 3 Using the hex tool that shipped with the assembly, install the two temporary set screws into the holes 
that will not be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting 
brackets.

Step 4 Lift the shelf assembly to the desired position in the rack and set it on the screws.

Step 5 Align the screw holes on the mounting brackets with the mounting holes in the rack.

Step 6 Using the Phillips screwdriver, install one mounting screw in each side of the assembly.

Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws.

Note Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

Step 8 Using the hex tool, remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
DLP-G6 Mount the Shelf Assembly in a Rack (Two People) 

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of 
the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in 
the rack.

Note The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air 
ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is 
installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) 
between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment 
must not vent heat upward into the ONS 15454.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]).

Step 3 Using the hex tool that shipped with the assembly, install the two set screws into the holes that will not 
be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting brackets. 

Purpose This task allows two people to mount the shelf assembly in a rack.

Tools/Equipment Pinned hex tool

# 2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Step 4 Lift the shelf assembly to the desired position in the rack.

Step 5 Align the screw holes on the mounting brackets with the mounting holes in the rack.

Step 6 Have one person hold the shelf assembly in place while the other person uses the Phillips screwdriver to 
install one mounting screw in each side of the assembly.

Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws. 

Note Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

Step 8 Use the hex tool to remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).

DLP-G7 Mount Multiple Shelf Assemblies in a Rack 

Note A standard ETSI rack can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When 
mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the 
heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the 
stabilizers before mounting or servicing the unit in the rack.

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. When using third-party equipment above the ONS 15454 ETSI, provide a minimum of 
25 mm (1 inch) between the third-party unit and the bottom of the ONS 15454 ETSI. The third-party 
equipment must not vent heat upward into the ONS 15454 ETSI. 

Purpose This task installs multiple shelves in a rack.

Tools/Equipment Pinned hex tool

#2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws (per shelf)

Eight M6 x 20 pan-head Phillips mounting screws (per shelf)

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX) (per shelf)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX) (per shelf)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Note The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air 
ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is 
installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) 
between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment 
must not vent heat upward into the ONS 15454.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Mount the first shelf assembly in the bottom of the rack using the “DLP-G5 Mount the Shelf Assembly 
in a Rack (One Person)” task on page 1-13 or the “DLP-G6 Mount the Shelf Assembly in a Rack (Two 
People)” task on page 1-15.
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-4 shows a three-shelf ONS 15454 ETSI bay assembly.

Figure 1-4 Three-Shelf ONS 15454 ETSI (15454 SDH) Bay Assembly

Step 3 (ETSI only.) Mount the air ramp above the ONS 15454 ETSI. 

The air ramp is needed if you install more than one ONS 15454 ETSI shelf in a rack. To ensure that the 
air ramp is secure, use one or two M6 mounting screws for each side of the shelf assembly. Figure 1-5 
shows how to mount an air ramp in the rack. 
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-5 Mounting the Air Ramp in a Rack

Step 4 Repeat this task for every shelf assembly you need to install.

Step 5 Return to your originating procedure (NTP).

DLP-G8 Install the Air Ramp

Step 1 The air ramp requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the 
RMU space specified in your site plan. See the “14.5 Typical DWDM Rack Layouts” section on 
page 14-16 for more information about air ramp placement.

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete the 
“DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on 
page 1-10 as required.

Step 3 Align the chassis with the rack mounting screw holes; insert and tighten the four screws.

Purpose Use this task to install the air ramp.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Step 4 Return to your originating procedure (NTP).

NTP-G3 Open and Remove the Front Door 

Step 1 Complete the “DLP-G9 Open the Front Cabinet Compartment (Door)” task on page 1-20.

Step 2 Complete the “DLP-G10 Remove the Front Door” task on page 1-21.

Step 3 If you are using an ETSI shelf, continue with the “NTP-G4 Open and Remove the FMEC Cover (ETSI 
Only)” procedure on page 1-23. If you are using an ANSI shelf, continue with the “NTP-G5 Remove the 
Backplane Covers (ANSI Only)” procedure on page 1-26.

Stop. You have completed this procedure. 

DLP-G9 Open the Front Cabinet Compartment (Door) 

Note The ONS 15454 shelf assembly has an ESD plug input and is shipped with an ESD wrist strap. The ESD 
plug input is located on the outside of the shelf assembly on the right side. It is labeled “ESD” on the 
top and bottom. Always wear an ESD wrist strap and connect the strap to the ESD plug when working 
on the ONS 15454.

Step 1 Open the front door lock. 

The ONS 15454 shelf assembly comes with a pinned hex key for locking and unlocking the front door. 
Turn the key counterclockwise to unlock the door and clockwise to lock it. Figure 1-6 illustrates the front 
door of the ANSI shelf. 

Purpose This procedure opens and removes the front door to access the equipment.

Tools/Equipment Open-end wrench

Pinned hex (Allen) key 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task opens the front door.

Tools/Equipment Pinned hex (Allen) key 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-6 Cisco ONS 15454 ANSI Front Door

Step 2 Press the door button to release the latch. A button on the right side of the shelf assembly releases the 
door.

Step 3 Swing the door open.

Step 4 Return to your originating procedure (NTP).

DLP-G10 Remove the Front Door 

Step 1 For ONS 15454 ETSI shelves:

a. Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer. 

Purpose This task removes the front cabinet compartment door.

Tools/Equipment Open-end wrench

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Door lock Door button

Viewholes for Critical, Major and Minor alarm LEDs
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
b. Remove the ground wire from the shelf. 

c. Hold the door at the top left corner and remove the door from its hinges (Figure 1-7).

Figure 1-7 Removing the ONS 15454 ETSI Front Door

Step 2 For ONS 15454 ANSI shelves: 

a. To remove the door ground strap, perform the following:

• To detach the ground strap from the front door, loosen the #6 Kepnut (49-0600-01) using the 
open-end wrench. Detach the end of the ground strap terminal lug (72-3622-01) from the male 
stud on the inside of the door. 

• To detach the other end of the ground strap from the longer screw on the fiber guide, loosen the 
#4 Kepnut (49-0337-01) on the terminal lug using the open-end wrench. Remove the terminal 
lug and lock washer. 

b. Lift the door from its hinges at the top left corner of the door (Figure 1-8).
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-8 Removing the ONS 15454 ANSI Front Door

Step 3 Return to your originating procedure (NTP).

NTP-G4 Open and Remove the FMEC Cover (ETSI Only)

Step 1 Complete the “DLP-G11 Open the FMEC Cover” task on page 1-24.

Step 2 Complete the “DLP-G12 Remove the FMEC Cover” task on page 1-25.

Step 3 Continue with the “NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)” procedure on 
page 1-28. 

Purpose This procedure opens and removes the FMEC cover on the ONS 
15454 ETSI. The ONS 15454 ETSI has a screw-in panel over the EFCA. 
The FMEC cover protects the FMEC cards. 

Tools/Equipment Medium slot-head screwdriver

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Stop. You have completed this procedure. 

DLP-G11 Open the FMEC Cover 

Step 1 Unscrew the screws on the FMEC cover (Figure 1-9).

Figure 1-9 Unscrewing the FMEC Cover 

Step 2 Use the handles to pull the cover forward.

Step 3 Return to your originating procedure (NTP).

Purpose This task opens the FMEC cover. The FMEC cover must be opened to 
install the MIC-A/P and the MIC-C/T/P. 

Tools/Equipment Medium slot-head screwdriver 

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
DLP-G12 Remove the FMEC Cover 

Step 1 Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer. 

Step 2 Remove the ground wire from the left side of the shelf. 

Step 3 Pull the right side of the hinge-locking spring (Figure 1-10).

Figure 1-10 Removing the ONS 15454 FMEC Cover 

Step 4 Detach the cover from the pin of the hinge.

Step 5 Remove the cover carefully from the left pin of the hinge.

Step 6 Return to your originating procedure (NTP).

Purpose This task removes the FMEC cover in order to install the MIC-A/P and the 
MIC-C/T/P.

Tools/Equipment Medium slot-head screwdriver 

Prerequisite Procedures DLP-G11 Open the FMEC Cover, page 1-24 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

71
08

7

FAN FAIL
CRIT

MAJ
MIN

Pin hinge

FMEC cover

Hinge-locking
spring
1-25
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
NTP-G5 Remove the Backplane Covers (ANSI Only)

Step 1 Complete the “DLP-G13 Remove the Lower Backplane Cover” task on page 1-26.

Step 2 Complete the “DLP-G14 Remove the Backplane Sheet Metal Cover” task on page 1-27.

Step 3 Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure. 

DLP-G13 Remove the Lower Backplane Cover 

Step 1 Unscrew the five retaining screws that hold the cover in place (Figure 1-11).

Purpose This procedure describes how to access the ONS 15454 ANSI backplane 
by removing the covers. The backplane has two sheet metal covers (one 
on either side) and a lower backplane cover at the bottom. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the lower backplane cover of the ONS 15454 ANSI shelf 
assembly.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-11 Backplane Covers on the 15454 ANSI Shelf

Step 2 Grasp the cover on each side.

Step 3 Gently pull the cover away from the backplane.

Step 4 Return to your originating procedure (NTP).

DLP-G14 Remove the Backplane Sheet Metal Cover 

Step 1 To remove the backplane sheet metal cover, loosen the five screws that secure it to the ONS 15454 ANSI 
shelf and pull it away from the shelf assembly (Figure 1-11 on page 1-27).

Step 2 Loosen the nine perimeter screws that hold the backplane sheet metal cover(s) in place.

Step 3 Lift the panel by the bottom to remove it from the shelf assembly.

Purpose This task removes the backplane sheet metal cover that is installed on the 
rear of the 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Step 4 Store the panel for later use. Attach the backplane cover(s) whenever electrical interface assemblies 
(EIAs) are not installed.

Step 5 Return to your originating procedure (NTP).

NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)

Caution Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the 
wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Warning Voltage is present on the backplane when the system is operating. To reduce risk of an electric shock, 
keep hands and fingers out of the power supply bays and backplane areas. Statement 166

Note The ONS 15454 ETSI EFCA has 12 FMEC slots numbered sequentially from left to right beginning with 
Slot 18. Slots 18 to 22 and 25 to 29 provide electrical connections for the corresponding slots, so they 
are unnecessary in dense wave division multiplexing (DWDM) applications. 

Step 1 Ensure you are installing the FMECs in the correct slot:

• FMEC Slot 23 supports the MIC-A/P.

The MIC-A/P card provides connection for the BATTERY B input, one of the two possible 
redundant power supply inputs. It also provides connection for eight alarm outputs (coming from 
the TCC2/TCC2P card), sixteen alarm inputs, and four configurable alarm inputs/outputs.

• FMEC Slot 24 supports the MIC-C/T/P.

The MIC-C/T/P card provides connection for the BATTERY A input, one of the two possible 
redundant power supply inputs. It also provides connection for system management serial port, 
system management LAN port, and system timing inputs and outputs.

Purpose This procedure installs the MIC-A/P and the MIC-T/C/P, which are a type 
of FMEC installed in the EFCA. The EFCA is located at the top of the 
ONS 15454 ETSI shelf. It provides connection for installing power, 
external alarms, timing input and output, and craft interface terminals.This 
procedure applies to the ETSI shelf only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

FMEC cards (the MIC-A/P and MIC-T/C/P)

Prerequisite Procedures NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Step 2 Hold the FMEC by the faceplate.

Step 3 Slide the FMEC along the guide rails into the desired FMEC slot or slots.

Step 4 Push the FMEC gently into the connector. The ONS 15454 ETSI FMECs plug into electrical connectors 
on the back panel of the shelf assembly when the screws are tightened. Figure 1-12 shows FMEC 
installation. 

Figure 1-12 Installing FMECs on the ONS 15454 ETSI

Step 5 Tighten the screws.

Step 6 Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure. 
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
NTP-G7 Install the Power and Ground 

Warning Before performing any of the following procedures, ensure that power is removed from the DC circuit. 
Statement 1003

Warning This equipment is intended to be grounded. Ensure that the host is connected to earth ground during 
normal use. Statement 39

Warning Use copper conductors only. Statement 1025

Warning Connect the unit only to DC power source that complies with the safety extra-low voltage (SELV) 
requirements in IEC 60950 based safety standards. Statement 1033

Purpose This procedure installs power feeds and grounds the ONS 15454.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

(ETSI only.) Power cable (from fuse panel to MIC-A/P and to MIC-C/T/P), 
shipped with the ONS 15454 ETSI

(ANSI only.) Power cable (from fuse and alarm panel to assembly), #10 
AWG, copper conductors, 194 degrees F [90 degrees C])

Ground cable 13.3-mm² (#6 AWG) stranded

(ETSI only.) Two-hole grounding lug, shipped with the ONS 15454 ETSI

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for 5.26-mm² (#10 AWG) copper conductors

(ANSI only.) Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Prerequisite Procedures (ETSI) NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 
1-23

(ETSI) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), 
page 1-28 

(ANSI) NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Warning This product requires short-circuit (overcurrent) protection, to be provided as part of the building 
installation. Install only in accordance with national and local wiring regulations. Statement 1045

Warning A readily accessible two-poled disconnect device must be incorporated in the fixed wiring. Statement 
1022

Warning This unit might have more than one power supply connection. All connections must be removed to 
de-energize the unit. Statement 1028

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Step 1 Verify that the correct fuse and alarm panel is installed in the top mounting space:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed. If not, install 
one according to manufacturer’s instructions.

• (ANSI only.) If you have the 15454-SA-ANSI or 15454-SA-HD shelf, a 100-A fuse panel (30-A fuse 
per shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.

• (ANSI only.) If you have the 15454-SA-NEBS3 shelf, a standard 80-A fuse panel (20-A fuse per 
shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.

Step 2 Depending on your type of shelf, complete the “DLP-G15 Connect the Office Ground to the 
ONS 15454 ETSI” task on page 1-32 or the “DLP-G16 Connect the Office Ground to the 
ONS 15454 ANSI” task on page 1-33.

Step 3 Depending on your shelf, complete the “DLP-G17 Connect Office Power to the ONS 15454 ETSI” task 
on page 1-35 or the “DLP-G18 Connect Office Power to the ONS 15454 ANSI” task on page 1-36.

Step 4 Complete the “DLP-G19 Turn On and Verify Office Power” task on page 1-39.

Step 5 Continue with the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.

Stop. You have completed this procedure. 
1-31
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
DLP-G15 Connect the Office Ground to the ONS 15454 ETSI

Warning This equipment must be grounded. Never defeat the ground conductor or operate the equipment in the 
absence of a suitably installed ground conductor. Contact the appropriate electrical inspection 
authority or an electrician if you are uncertain that suitable grounding is available. Statement 1024

Step 1 Use a wire-stripping tool to remove approximately 0.75 inch (19 mm) of the covering from the end of 
the grounding wire. 

Step 2 Insert the stripped end of the grounding wire into the open-end of the grounding lug. 

Step 3 Use the crimping tool to secure the grounding wire in two different places in the grounding lug.

Step 4 Locate the grounding receptacle on the side panel of the shelf (Figure 1-13).

Step 5 Place the grounding lug against the grounding receptacle on the side panel of the shelf.

Step 6 Insert one of the screws through the locking washer and through the hole in the grounding lug. Insert the 
screw into the threaded holes on the right side of the shelf. Ensure that the grounding lug does not 
interfere with other system hardware or rack equipment.

Step 7 Repeat Step 6 with the second screw. 

Step 8 Prepare the other end of the grounding wire and connect it to an appropriate grounding point in your site 
to ensure adequate earth ground for the shelf.

Purpose This task connects ground to the ONS 15454 ETSI shelf.

Tools/Equipment  2-hole grounding lug, included in the installation kit

2 Phillips head, M6 (metric) machine screws with locking washers, 
included in the installation kit

Grounding wire—Use 13.3-mm² (#6 AWG) copper wire.

#2 Phillips screwdriver

Crimping tool—This tool must be large enough to accommodate the girth 
of the grounding lug when you crimp the grounding cable into the lug.

Wire stripping tool

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Figure 1-13 Grounding the ONS 15454 ETSI

Step 9 Return to your originating procedure (NTP).

DLP-G16 Connect the Office Ground to the ONS 15454 ANSI

Purpose This task connects ground to the ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194 degrees F [90 degrees C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Step 1 Verify that the office ground cable (#6 AWG stranded) is connected to the top of the bay according to 
local site practice.

Step 2 Attach one end of the shelf ground cable (#10 AWG) to the right side of the backplane ground nut. See 
Figure 1-14 for the location of the ground on the backplane.

Note When terminating a frame ground, use the Kepnut provided with the ONS 15454 and tighten it 
to a torque specification of 31 in-lb. The Kepnut provides a frame ground connection that 
minimizes the possibility of loosening caused by rotation during installation and maintenance 
activity. The type of prevention the kep nut provides for the frame ground connection is 
inherently provided by the terminal block for battery and battery return connections.

Figure 1-14 Ground Location on the Backplane

Step 3 Attach the other end of the shelf ground cable to the bay. 

Step 4 Return to your originating procedure (NTP).

FRAME GROUND 61
85

2
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DLP-G17 Connect Office Power to the ONS 15454 ETSI 

Warning When installing or replacing the unit, the ground connection must always be made first and 
disconnected last. Statement 1046

Caution Do not apply power to the ONS 15454 ETSI until you complete all installation steps and check the 
continuity of the –48 VDC battery and battery return. 

Note No more than 2 m (7 ft) of the power supply cable should be exposed between the equipment and the 
fiber-storage tray. 

Note Only use listed compression-type connectors when terminating the battery, battery return, and ground 
conductors. Connectors must be suitable for copper conductors.

Caution When terminating power, return, and frame ground, do not use soldering lug connectors, screwless 
(push-in) connectors, quick-connect connectors, or other friction-fit connectors.

Purpose This task connects power to the ONS 15454 ETSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Power cable (from fuse and alarm panel to assembly), 5.26-mm² 
(#10 AWG), copper conductors, 194°F [90°C])

Ground cable 13.3-mm² (#6 AWG) stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for 5.26-mm² (#10 AWG) copper conductors

Prerequisite Procedures DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note If the system loses power or if both TCC2/TCC2P cards are reset, you must reset the ONS 15454 ETSI 
clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the clock, see the 
“NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8. 

Step 1 Verify that the MIC-A/P FMEC is installed in Slot 23 and the MIC-C/T/P FMEC is installed in Slot 24 of the 
EFCA.

Step 2 Attach the connector on the end of the power cable to the power FMEC.

Step 3 Tighten the screws of the connector on the power cable.

Step 4 Connect the power cable to the fuse panel or power source. Use the pin connections in Table 1-1. The 
conductor (green with yellow stripes) is used for secondary grounding such as grounding to the rack.

Step 5 Return to your originating procedure (NTP).

DLP-G18 Connect Office Power to the ONS 15454 ANSI 

Table 1-1 Pin Connection of the Power FMECs

Pin Function Cable Color

A1 Battery return Black

A2 –48 V battery Red

A3 Ground Green with yellow stripes

Purpose This task connects power to the ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194 degrees F [90 degrees C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-33

Required/As Needed Required
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Warning When installing or replacing the unit, the ground connection must always be made first and 
disconnected last. Statement 1046

Note The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE Issue 3.

Note If the system loses power or both TCC2/TCC2P cards are reset and the system is not provisioned to get 
the time from a Network Time Protocol/Simple Network Time Protocol (NTP/SNTP) server, you must 
reset the ONS 15454 clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset 
the clock, see the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on 
page 3-8.
If you are using the TCC2/TCC2P cards, the system clock will run for up to three hours. In this case, no 
action would be required. 

Step 1 Connect the office power according to the fuse panel engineering specifications.

Step 2 Measure and cut the cables as needed to reach the ONS 15454 from the fuse panel. Figure 1-15 shows 
the ONS 15454 power terminals.

Step 3 Dress the power according to local site practice. 

Figure 1-15 Cisco ONS 15454 Power Terminals

Onsite/Remote Onsite

Security Level None

33
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1

RET  1

CAUTION: Remove power from both
the BAT1 and terminal blocks
prior to servicing

SUITABLE FOR MOUNTING ON
A NON-COMBUSTIBLE SURFACE.
PLEASE REFER TO INSTALLATION
INSTRUCTIONS.

-42 V      24 A

BAT  1 RET  2 BAT  2

Battery leads (red)
Return leads (black)
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Step 4 Remove or loosen the #8 power terminal screws on the ONS 15454. To avoid confusion, label the cables 
connected to the BAT1/RET1 (A) power terminals as 1, and the cables connected to the BAT2/RET2 (B) 
power terminals as 2. 

Note Use only pressure terminal connectors, such as ring and fork types, when terminating the battery, 
battery return, and frame ground conductors.

Caution Before you make any crimp connections, coat all bare conductors (battery, battery return, and frame 
ground) with an appropriate antioxidant compound. Bring all unplated connectors, braided strap, and bus 
bars to a bright finish, then coat with an antioxidant before you connect them. You do not need to prepare 
tinned, solder-plated, or silver-plated connectors and other plated connection surfaces, but always keep 
them clean and free of contaminants.

Caution When terminating power, return, and frame ground, do not use soldering lug, screwless (push-in) 
connectors, quick-connect, or other friction-fit connectors.

Step 5 Strip 1/2 inch (12.7 mm) of insulation from all power cables that you will use.

Step 6 Crimp the lugs onto the ends of all power leads. 

Note When terminating battery and battery return connections as shown in Figure 1-15, follow a 
torque specification of 10 in-lb. 

Step 7 Terminate the return 1 lead to the RET1 backplane terminal. Use oxidation-prevention grease to keep the 
connections noncorrosive.

Step 8 Terminate the negative 1 lead to the negative BAT1 backplane power terminal. Use oxidation prevention 
grease to keep connections noncorrosive.

Step 9 If you use redundant power leads, terminate the return 2 lead to the positive RET2 terminal on the 
ONS 15454. Terminate the negative 2 lead to the negative BAT2 terminal on the ONS 15454. Use 
oxidation-preventative grease to keep connections noncorrosive.

Step 10 Route the cables out below the power terminals using the plastic cable clamp, as shown in Figure 1-15 
on page 1-37.

Step 11 Return to your originating procedure (NTP).
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DLP-G19 Turn On and Verify Office Power 

Caution Do not apply power to the shelf assembly until you complete all installation steps. 

Step 1 Using a voltmeter, verify the office battery and ground at the following points on the fuse and alarm 
panel:

a. To verify the power, place the black test lead of the voltmeter to the frame ground. Place the red test 
lead on the A-side connection and verify that it is between –40.5 VDC and –57 VDC. Place the red 
test lead on the B-side connection and verify that it is between –40.5 VDC and –57 VDC. 

Note The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum 
voltages required to power the chassis. 

b. To verify the ground, place the black test lead of the voltmeter to the frame ground. Place the red 
test lead on the A-side return ground and verify that no voltage is present. Place the red test lead on 
the B-side return ground and verify that no voltage is present. 

Step 2 Complete one of the following to power up the node:

• If you are using a 80-A fuse panel, insert a 20-A fuse into the fuse position according to site practice.

• If you are using a 100-A fuse panel, insert a 30-A fuse into the fuse position according to site 
practice.

Step 3 Using a voltmeter, verify the ONS 15454 shelf for –48 VDC battery and ground:

a. To verify the A-side of the shelf, place the black lead of the voltmeter to the frame ground. Place the 
red test lead to the BAT1 (A-side battery connection) red cable. Verify that it reads between 
–40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET1 (A-side return 
ground) black cable and verify that no voltage is present.

Note The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum 
voltages required to power the chassis. 

Purpose This task measures the power to verify correct power and returns for the 
ONS 15454 shelf.

Tools/Equipment Voltmeter

Prerequisite Procedures DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32

DLP-G17 Connect Office Power to the ONS 15454 ETSI, page 1-35

DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-33

DLP-G18 Connect Office Power to the ONS 15454 ANSI, page 1-36

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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b. To verify the B-side of the shelf, place the black test lead of the voltmeter to the frame ground. Place 
the red test lead to the BAT2 (B-side battery connection) red cable. Verify that it reads between 
–40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET2 (B-side return 
ground) black cable and verify that no voltage is present.

Step 4 Return to your originating procedure (NTP).

NTP-G8 Install the Fan-Tray Assembly 

Caution Do not operate an ONS 15454 without a fan-tray air filter. A fan-tray air filter is mandatory, except for 
ONS 15454 ANSI applications in an outside plant cabinet.

Note Error messages appear on the TCC2/TCC2P card, the fan-tray LED, and in Cisco Transport Controller 
(CTC) when the fan-tray assembly is removed from the shelf or when one fan is not working.

Note If you are installing the ONS 15454 in an outside plant cabinet, remove the air filter to provide maximum 
cooling capabilities and to comply with Telcordia GR-487-CORE.

Caution You must place the edge of the air filter flush against the front of the fan-tray assembly compartment 
when installing the fan tray on top of the filter. Failure to do so could result in damage to the filter, the 
fan tray, or both.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the back panel of the shelf assembly. 

Note To install the fan-tray assembly, it is not necessary to move any of the fiber-storage facilities. 

Purpose This procedure installs the fan-tray assembly.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G7 Install the Power and Ground, page 1-30

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Step 1 Install the air filter. The air filter can be installed internally between the fan tray and shelf assembly, or 
externally by mounting the air filter bracket on the bottom of the shelf assembly. Slide the air filter into 
the bracket.

Step 2 Install the fan-tray assembly. Figure 1-16 shows the fan-tray assembly location on the ONS 15454 ETSI. 
Figure 1-17 shows the fan-tray assembly location on the ONS 15454 ANSI.

• For the ONS 15454 ETSI shelf, press and hold the locks on the outer edges as you slide the fan-tray 
assembly into the shelf assembly. 

• For the ONS 15454 ANSI shelf, slide the fan-tray assembly into the shelf. 

The electrical plug at the rear of the tray should plug into the corresponding receptacle on the assembly.

Caution Do not force a fan-tray assembly into place. This can damage the connectors on the fan-tray assembly 
and/or the connectors on the back panel of the shelf assembly. 

Figure 1-16 Installing the Fan-Tray Assembly on the ONS 15454 ETSI

61
23

6

FAN FAIL
CRIT

MAJ
MIN

Fan tray
assembly

LCD
1-41
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 1      Install the Shelf and Common Control Cards
Required Tools and Equipment (ETSI)
Figure 1-17 Installing the Fan-Tray Assembly on the ONS 15454 ANSI

Step 3 To verify that the tray has plugged into the assembly, look at the fan tray and listen to determine that the 
fans are running. 

Step 4 If you want to install an alarm expansion panel on the ONS 15454 ANSI shelf, continue with the 
“NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-43. Otherwise, continue 
with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on 
page 1-46.

Stop. You have completed this procedure. 
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NTP-G9 Install the Alarm Expansion Panel (ANSI Only)

Note The AIC-I card provides direct alarm contacts (external alarm inputs and external control outputs). In 
the ANSI shelf, these AIC-I alarm contacts are routed through the backplane to wire-wrap pins 
accessible from the back of the shelf. When you install an AEP, the direct AIC-I alarm contacts cannot 
be used. Only the AEP alarm contacts can be used. 

Step 1 Remove the two backplane screws. Replace the two screws with standoffs. Insert the longer standoff on 
the left, and the shorter standoff on the right (Figure 1-18). 

Purpose This procedure installs an AEP onto the 15454-SA-ANSI or 15454-SA-HD 
shelf backplane. The AEP provides alarm contacts (32 inputs, 16 outputs) 
in addition to the 16 provided by the AIC-I card. Typically, the AEP is 
preinstalled when ordered with the ONS 15454; however, the AEP can be 
ordered separately. The AIC-I card must be installed before you can 
provision the alarm contacts enabled by the AEP. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

6-pair #29 AWG double-shielded cable

Standoffs (4)

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-18 Replace Backplane Screws with Standoffs

Step 2 Attach the remaining two standoffs on either side of the backplane (Figure 1-19). 

Step 3 Position the AEP board over the standoffs.
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Figure 1-19 Installing Standoffs and the AEP

Step 4 Insert and tighten three screws to secure the AEP to the backplane.

Step 5 Connect the AEP cable to the backplane and AEP:

a. Connect the 10 colored wires to the wire-wrap pins on the backplane. Figure 1-20 shows where the 
cable wires are connected. Table 1-2 shows AEP and AIC-I signals that each wire carries

b. Plug the other end of the AEP cable into AEP connector port. The brown pin is on the top.

Figure 1-20 AEP Wire-Wrap Connections to Backplane Pins
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Step 6 Continue with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” 
procedure on page 1-46.

Stop. You have completed this procedure. 

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin 
Connections 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the 
wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Table 1-2 Pin Assignments for the AEP

AEP Cable Wire Backplane Pin AIC-I Signal AEP Signal

Black A1 GND AEP_GND

White A2 AE_+5 AEP_+5

Slate A3 VBAT– VBAT–

Violet A4 VB+ VB+

Blue A5 AE_CLK_P AE_CLK_P

Green A6 AE_CLK_N AE_CLK_N

Yellow A7 AE_DIN_P AE_DOUT_P

Orange A8 AE_DIN_N AE_DOUT_N

Red A9 AE_DOUT_P AE_DIN_P

Brown A10 AE_DOUT_N AE_DIN_N

Purpose This procedure installs alarm, timing, LAN, and craft wires on the 
ONS 15454 shelf. These wires are attached to the MIC FMECs on the ETSI 
shelf and attached to the backplane on the ANSI shelf.

Tools/Equipment Connectors according to function

Twisted 0.51 mm² or 0.64 mm² (#22 or #24 AWG) shielded wires for LAN 
or craft

75-ohm coaxial cable with 1.0/2.3 miniature coax connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) alarm wires

Prerequisite Procedures (ETSI only.) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI 
Only), page 1-28

(ANSI only.) NTP-G5 Remove the Backplane Covers (ANSI Only), page 
1-26

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None
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Step 1 For an ONS 15454 ETSI shelf, complete the following tasks as necessary:

• Complete the “DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-47 if 
you want to provision external alarms and/or controls with the AIC-I card.

• Complete the “DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)” task on page 1-50 if 
you are provisioning external timing.

• Complete the “DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)” task on page 1-51 to 
create an external LAN connection. LAN wires or the LAN port on the TCC2/TCC2P card are 
necessary to create an external LAN connection.

Step 2 For an ONS 15454 ANSI shelf, complete the following tasks as necessary:

• Complete the “DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-52 if 
you are using an AIC or AIC-I card and are not using an AEP.

• Complete the “DLP-G24 Install Timing Wires on the Backplane (ANSI Only)” task on page 1-54 if 
you are provisioning external timing.

• Complete the “DLP-G25 Install LAN Wires on the Backplane (ANSI Only)” task on page 1-55 to 
create an external LAN connection. LAN wires or the LAN port on the TCC2/TCC2P card are 
necessary to create an external LAN connection.

• Complete the “DLP-G26 Install the TL1 Craft Interface (ANSI Only)” task on page 1-56 to access 
TL1 using the craft interface. Craft wires or the EIA/TIA-232 port on the TCC2/TCC2P card are 
required to access TL1.

Stop. You have completed this procedure. 

DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)

Step 1 Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires, connect the alarm and control wires on the 
appropriate pins of the DB-62 connector. The pin connectors, signal names, and functions are listed in 
Table 1-3. 

Purpose This task installs alarm cables on the MIC-A/P on the ONS 15454 ETSI so 
that you can provision external (environmental) alarms and controls with 
the AIC-I card.

Tools/Equipment DB-62 connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-28

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Table 1-3 Alarm Pin Assignments

DB-62 Pin Connector Signal Name Function

1 ALMCUTOFF– Alarm cutoff

2 ALMCUTOFF+ Alarm cutoff

3 ALMINP0– Alarm input pair number 1

4 ALMINP0+ Alarm input pair number 1

5 ALMINP1– Alarm input pair number 2

6 ALMINP1+ Alarm input pair number 2

7 ALMINP2– Alarm input pair number 3

8 ALMINP2+ Alarm input pair number 3

9 ALMINP3– Alarm input pair number 4

10 ALMINP3+ Alarm input pair number 4

11 EXALM0– Extra alarm 0

12 EXALM0+ Extra alarm 0

13 FGND Ground

14 EXALM1– Extra alarm 1

15 EXALM1+ Extra alarm 1

16 EXALM2– Extra alarm 2

17 EXALM2+ Extra alarm 2

18 EXALM3– Extra alarm 3

19 EXALM3+ Extra alarm 3

20 EXALM4– Extra alarm 4

21 EXALM4+ Extra alarm 4

22 EXALM5– Extra alarm 5

23 EXALM5+ Extra alarm 5

24 EXALM6– Extra alarm 6

25 EXALM6+ Extra alarm 6

26 FGND Ground

27 EXALM7– Extra alarm 7

28 EXALM7+ Extra alarm 7

29 EXALM8– Extra alarm 8

30 EXALM8+ Extra alarm 8

31 EXALM9– Extra alarm 9

32 EXALM9+ Extra alarm 9

33 EXALM10– Extra alarm 10

34 EXALM10+ Extra alarm 10

35 EXALM11– Extra alarm 11

36 EXALM11+ Extra alarm 11
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Step 2 Connect the other end of the alarm and control wires according to local site practice. 

Step 3 Connect the DB-62 connector to the ALARM IN/OUT connector on the MIC-A/P faceplate.

Step 4 Tighten the screws of the connector on the alarm cable.

Step 5 Return to your originating procedure (NTP).

37 ALMOUP0– Normally open output pair number 1

38 ALMOUP0+ Normally open output pair number 1

39 FGND Ground

40 ALMOUP1– Normally open output pair number 2

41 ALMOUP1+ Normally open output pair number 2

42 ALMOUP2– Normally open output pair number 3

43 ALMOUP2+ Normally open output pair number 3

44 ALMOUP3– Normally open output pair number 4

45 ALMOUP3+ Normally open output pair number 4

46 AUDALM0– Normally open minor audible alarm

47 AUDALM0+ Normally open minor audible alarm

48 AUDALM1– Normally open major audible alarm

49 AUDALM1+ Normally open major audible alarm

50 AUDALM2– Normally open critical audible alarm

51 AUDALM2+ Normally open critical audible alarm

52 FGND Ground

53 AUDALM3– Normally open remote audible alarm

54 AUDALM3+ Normally open remote audible alarm

55 VISALM0– Normally open minor visible alarm

56 VISALM0+ Normally open minor visible alarm

57 VISALM1– Normally open major visible alarm

58 VISALM1+ Normally open major visible alarm

59 VISALM2– Normally open minor visible alarm

50 VISALM2+ Normally open minor visible alarm

61 VISALM3– Normally open minor visible alarm

62 VISALM3+ Normally open minor visible alarm

Table 1-3 Alarm Pin Assignments (continued)

DB-62 Pin Connector Signal Name Function
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DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)

Step 1 Using coaxial cable with 1.0/2.3 miniature coax connectors, connect the clock cable to the appropriate 
connector on the faceplate of the MIC-C/T/P.

Step 2 Gently push the cable with the 1.0/2.3 miniature coax connector down until the cable connector slides 
into the 1.0/2.3 miniature coax connector on the faceplate with a click.

The MIC-C/T/P provides 1.0/2.3 miniature coax connectors that are used for timing input and output. 
The top connectors are for “A” (BITS-1) timing, and the bottom connectors are for “B” (BITS-2) timing. 
In each case, the left connector is the input and the right connector is the output. The input connectors 
for timing provide a 75-ohm termination. System cables are available that can convert timing clocks 
from 75 ohms to 100/120 ohms. Table 1-4 shows MIC-C/T/P pin assignments. 

A high-impedance option (> 3 kilo-ohms or greater) is possible through a jumper on the MIC-C/T/P 
FMEC. You can change the top timing input to high impedance by removing the jumper on P3 of the 
MIC-C/T/P FMEC. You can change the bottom timing input to high impedance by removing the jumper 
on P2 on the MIC-C/T/P FMEC. 

Note Refer to ITU-T G.813 for rules about provisioning timing references.

Step 3 Connect the other end of the cable to the external source of the timing signal according to Table 1-4.

Step 4 Repeat Step 3 for each cable that is required.

Step 5 Return to your originating procedure (NTP).

Purpose This task installs the timing cables on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment 75-ohm coaxial cable with a 1.0/2.3 miniature coax connector on the 
MIC-C/T/P side

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-28

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-4 MIC-C/T/P Clock Connector Pin Assignment

Pin Function

IN 1 Input from external device

OUT 1 Output to external device

IN 2 Input from external device

OUT 2 Output to external device
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DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)

Note Rather than using the LAN connection port on the MIC-C/T/P, you can use the LAN connection port on 
the TCC2/TCC2P card if preferred. Use either the MIC-C/T/P connection or the TCC2/TCC2P card 
connection. You cannot use the LAN connection port on the MIC-C/T/P and the LAN connection port 
on the TCC2/TCC2P card simultaneously; however, it is possible for you to make a direct connection 
from a computer to the LAN connection port on the TCC2/TCC2P card while the LAN connection port 
on the MIC-C/T/P is in use as long as the computer connected directly to the TCC2/TCC2P card is not 
connected to a LAN.

Step 1 Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire or CAT-5 UTP Ethernet cable, connect the wires 
to the RJ-45 connector according to Table 1-5. 

Purpose This task installs the LAN wires on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment Standard CAT-5 UTP Ethernet cable (straight-through for data terminating 
equipment [DTE] or cross-over for data circuit-terminating equipment 
[DCE])

or

RJ-45 connector

Crimping tool for RJ-45 connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire, preferably CAT-5 UTP

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-28

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-5 LAN Pin Assignments

LAN RJ-45 Pin RJ-45 Pin Function

LAN 1 
Connecting to DCE1

(a hub or switch)

Cross-over Ethernet cable

1 3 PNMSRX+
white/green

2 6 PNMSRX–
green

3 1 PNMSTX
white/orange

4 4 —

5 5 —

6 2 PNMSTX–
orange

7 7 —

8 8 —
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Step 2 Return to your originating procedure (NTP).

DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)

Step 1 Using 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²) twisted-pair 
T1-type wires, wrap the alarm wires on the appropriate wire-wrap pins according to local site practice. 
Ground the shield of the BITS Input cable at the BITS end. For BITS Output, wrap the ground shield of 
the BITS cable to the frame ground pin (FG1) located below the column of BITS pins.

Figure 1-21 shows alarm pin assignments for the AIC-I in the Release 3.4 or higher ONS 15454 
backplane, and Figure 1-22 calls out the external alarm pins on that backplane.

LAN 1
Connecting to DTE
(a PC/workstation or 
router)

Straight-through Ethernet 
cable

1 1 PNMSRX+
white/green

2 2 PNMSRX–
green

3 3 PNMSTX+
white/orange

4 4 —

5 5 —

6 6 PNMSTX–
orange

7 7 —

8 8 —

1. The Cisco ONS 15454 ETSI is DCE.

Purpose This task installs alarm wires on the backplane so that you can provision 
external (environmental) alarms and controls with the AIC or AIC-I card. 
If you are using the AEP, do not perform this task.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) wires

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-5 LAN Pin Assignments (continued)

LAN RJ-45 Pin RJ-45 Pin Function
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Figure 1-21 Cisco ONS 15454 Backplane Pinouts (Release 3.4 or Later)
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Field Pin Function Field Pin Function

BITS A1 BITS Output 2 negative (–)   ENVIR
 ALARMS 
IN/OUT

N/O

A1/A13 Normally open output pair number 1

B1 BITS Output 2 positive (+) B1/B13

A2 BITS Input 2 negative (–) A2/A14 Normally open output pair number 2

B2 BITS Input 2 positive (+) B2/B14

A3 BITS Output 1 negative (–) A3/A15 Normally open output pair number 3

B3 BITS Output 1 positive (+) B3/B15

A4 BITS Input 1 negative (–) A4/A16 Normally open output pair number 4

B4 BITS Input 1 positive (+) B4/B16

LAN Connecting to a hub, or switch  ACO A1 Normally open ACO pair

A1 B1

B1 CRAFT A1 Receive (PC pin #2)

A2 A2  Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)

  LOCAL
ALARMS 

AUD
(Audible)

N/O

N/O

A1 Alarm output pair number 1: Remote 
audible alarm.B1 B1

 ENVIR
ALARMS 

IN

A2 Alarm output pair number 2: Critical 
audible alarm.B2

A3 Alarm output pair number 3: Major 
audible alarm.

A1

B3B1

A4 Alarm output pair number 4: Minor 
audible alarm.

A2

B4B2

 LOCAL
ALARMS 

VIS
(Visual)

A1 Alarm output pair number 1: Remote
visual alarm.

A3

B1

A2 Alarm output pair number 2:  Critical
visual alarm.B2

A3  Alarm output pair number 3: Major
visual alarm.B3

A4  Alarm output pair number 4: Minor 
visual alarm.B4

A1

A2

B3

A4

B4

RJ-45 pin 2 TX–

RJ-45 pin 1 TX+

RJ-45 pin 2 RX–

RJ-45 pin 1 RX+

RJ-45 pin 6 TX–

Alarm input pair number 1: Reports 
closure on connected wires.

Alarm input pair number 2: Reports 
closure on connected wires.

Alarm input pair number 3: Reports 
closure on connected wires.

Alarm input pair number 4: Reports
closure on connected wires.

A5

B5

Alarm input pair number 5: Reports
closure on connected wires.

A6

B6

Alarm input pair number 6: Reports
closure on connected wires.

A7

B7

Alarm input pair number 7: Reports
closure on connected wires.

A8

B8

Alarm input pair number 8: Reports
closure on connected wires.

A9

B9

Alarm input pair number 9: Reports
closure on connected wires.

A10

B10

Alarm input pair number 10: Reports
closure on connected wires.

A11

B11

Alarm input pair number 11: Reports
closure on connected wires.

A12

B12

Alarm input pair number 12: Reports
closure on connected wires.

Connecting to a PC/Workstation or router

RJ-45 pin 3 TX+B2

RJ-45 pin 3 RX+

RJ-45 pin 6 RX–

If you are using an 
AIC-I card, contacts 
provisioned as OUT 
are 1-4. Contacts 
provisioned as IN 
are 13-16.
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Figure 1-22 Highlighted Environmental Alarms

Note The X.25, Modem, and TBOS pin fields are not active on either pin field.

Step 2 Return to your originating procedure (NTP).

DLP-G24 Install Timing Wires on the Backplane (ANSI Only)

Step 1 Using 100-ohm shielded BITS clock cable #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair 
T1-type, wrap the clock wires on the appropriate wire-wrap pins according to local site practice.

Ground the shield of the BITS input cable at the BITS end. For BITS output, wrap the ground shield of 
the BITS cable to the frame ground pin (FG1) located beneath the column of BITS pins. Table 1-6 lists 
the pin assignments for the BITS timing pin fields.
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Purpose This task installs the BITS timing wires on the ONS 15454 ANSI 
backplane.

Tools/Equipment Wire wrapper

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-6 External Timing Pin Assignments for BITS

BITS Pin Tip/Ring CTC/TL1 Name Function

A4 ring BITS-1 Input from BITS device 1

B4 tip BITS-1 Input from BITS device 1

A3 ring BITS-1 Output to external device 1

B3 tip BITS-1 Output to external device 1

A2 ring BITS-2 Input from BITS device 2

B2 tip BITS-2 Input from BITS device 2
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Note For more detailed information about timing, see Chapter 19, “Security and Timing Reference.” 
To set up system timing, see the “NTP-G53 Set Up Timing” procedure on page 6-3.

Step 2 Return to your originating procedure (NTP).

DLP-G25 Install LAN Wires on the Backplane (ANSI Only)

Note Rather than using the LAN wires, you can use the LAN connection port on the TCC2/TCC2P if 
preferred. Use either the backplane connection or the TCC2/TCC2P front connection. You cannot use 
the LAN backplane pins and the LAN connection port on the TCC2/TCC2P simultaneously; however, it 
is possible for you to make a direct connection from a computer to the LAN connection port on the 
TCC2/TCC2P while the LAN backplane pins are in use as long as the computer that is connected directly 
to the TCC2/TCC2P is not connected to a LAN.

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire or CAT-5 UTP Ethernet cable, wrap the wires on 
the appropriate wire-wrap pins according to local site practice. 

Caution Cross talk might result if both receive (Rx) and transmit (Tx) pins connect on the same twisted pair of 
wires from the CAT-5 cable. The two Tx pins need to be on one twisted pair, and the two Rx pins need 
to be on another twisted pair.

A frame ground pin is located beneath each pin field (FG2 for the LAN pin field). Wrap the ground shield 
of the LAN interface cable to the frame ground pin. Table 1-7 shows the LAN pin assignments.

A1 ring BITS-2 Output to external device 2

B1 tip BITS-2 Output to external device 2

Table 1-6 External Timing Pin Assignments for BITS (continued)

BITS Pin Tip/Ring CTC/TL1 Name Function

Purpose This task installs the LAN wires on the ONS 15454 ANSI backplane.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, preferably CAT-5 UTP

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note The TCC2/TCC2P does not support Ethernet polarity detection. If your Ethernet connection has 
incorrect polarity (this can only occur with cables that have the receive wire pairs flipped), a 
“Lan Connection Polarity Reversed” condition is raised. This condition usually occurs during an 
upgrade or initial node deployment. To correct the situation, ensure that your Ethernet cable has 
the correct mapping of the wire-wrap pins. 

Step 2 Return to your originating procedure (NTP).

DLP-G26 Install the TL1 Craft Interface (ANSI Only)

Note Rather than using the craft pins, you can use a LAN cable connected to the TCC2/TCC2P EIA/TIA-232 
port to access a TL1 craft interface. 

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, wrap the craft interface wires on the appropriate 
wire-wrap pins according to local site practice. 

Step 2 Wrap the ground shield of the craft interface cable to the frame-ground pin. 

Table 1-7 LAN Pin Assignments for the ONS 15454 ANSI Shelf

Pin Field Backplane Pins RJ-45 Pins Function/Color

LAN 1 
Connecting to data 
circuit-terminating 
equipment (DCE) (a hub or 
switch); the ONS 15454 is a 
DCE

B2 1 TX+ white/green

A2 2 TX– green

B1 3 RX+ white/orange

A1 6 RX– orange

LAN 1
Connecting to data terminal 
equipment (DTE) (a 
PC/workstation or router)

B1 1 RX+ white/green

A1 2 RX– green

B2 3 TX+ white/orange

A2 6 TX– orange

Purpose This task installs the TL1 craft interface on the ONS 15454 ANSI shelf 
using the craft backplane pins. You can also use a LAN cable connected to 
the TCC2/TCC2P EIA/TIA-232 port to access a TL1 craft interface.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) alarm wires

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Wrap the ground wire of your computer cable to pin A3 on the craft pin field. Table 1-8 shows the pin 
assignments for the CRAFT pin field.

Note You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2/TCC2P card 
simultaneously. Using a combination prevents access to the node or causes a loss in connectivity.

Step 3 Return to your originating procedure (NTP).

NTP-G11 Install an External Wire-Wrap Panel on the AEP 
(ANSI Only)

Step 1 Position the lower cover over the AEP. Make sure that the AEP AMP Champ connectors protrude 
through the cutouts in the lower cover (Figure 1-23). 

Table 1-8 Craft Interface Pin Assignments

Pin Field Contact Function

Craft A1 Receive

A2 Transmit

A3 Ground

A4 DTR

Purpose This procedure connects an external wire-wrap panel to the ONS 15454 
ANSI AEP to provide the physical alarm contacts for the AEP. 

Tools/Equipment External wire-wrap panel

Prerequisite Procedures NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-43

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-23 Installing the AEP Cover

Step 2 Insert and tighten the eight screws to secure the AEP cover to the AEP. 

Step 3 Connect the cables from the external wire-wrap panel to the AMP Champ connectors on the AEP. 
Table 1-9 lists the alarm input pin assignments. 

Table 1-9 Alarm Input Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 ALARM_IN_1– 27 GND

2 GND 28 ALARM_IN_2–

3 ALARM_IN_3– 29 ALARM_IN_4–

4 ALARM_IN_5– 30 GND

5 GND 31 ALARM_IN_6–

6 ALARM_IN_7– 32 ALARM_IN_8–

7 ALARM_IN_9– 33 GND

8 GND 34 ALARM_IN_10–

9 ALARM_IN_11– 35 ALARM_IN_12–

10 ALARM_IN_13– 36 GND

11 GND 37 ALARM_IN_14–

12 ALARM_IN_15– 38 ALARM_IN_16–

7
8

4
0

4
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Table 1-10 lists the alarm output (external control) pin assignments. 

13 ALARM_IN_17– 39 GND

14 GND 40 ALARM_IN_18–

15 ALARM_IN_19– 41 ALARM_IN_20–

16 ALARM_IN_21– 42 GND

17 GND 43 ALARM_IN_22–

18 ALARM_IN_23– 44 ALARM_IN_24–

19 ALARM_IN_25– 45 GND

20 GND 46 ALARM_IN_26–

21 ALARM_IN_27– 47 ALARM_IN_28–

22 ALARM_IN_29– 48 GND

23 GND 49 ALARM_IN_30–

24 ALARM_IN_31– 50 —

25 ALARM_IN_+ 51 GND1

26 ALARM_IN_0- 52 GND2

Table 1-9 Alarm Input Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

Table 1-10 Alarm Output Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 — 27 COM_0

2 COM_1 28 —

3 NO_1 29 NO_2

4 — 30 COM_2

5 COM_3 31 —

6 NO_3 32 NO_4

7 — 33 COM_4

8 COM_5 34 —

9 NO_5 35 NO_6

10 — 36 COM_6

11 COM_7 37 —

12 NO_7 38 NO_8

13 — 39 COM_8

14 COM_9 40 —

15 NO_9 41 NO_10

16 — 42 COM_10

17 COM_11 43 —
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Figure 1-24 illustrates the alarm input connectors. 

Figure 1-24 Alarm Input Connector

18 NO_11 44 NO_12

19 — 45 COM_12

20 COM_13 46 —

21 NO_13 47 NO_14

22 — 48 COM_14

23 COM_15 49 —

24 NO_15 50 —

25 — 51 GND1

26 NO_0 52 GND2

Table 1-10 Alarm Output Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

ALARM_IN_8-
XREF=5

Connector
Alarm Input

GND

ALARM_IN_0-XREF=5

XREF=5 ALARM_IN_2-XREF=5ALARM_IN_3-
XREF=5 ALARM_IN_4-XREF=5

ALARM_IN_5-

ALARM_IN_6-
XREF=5

ALARM_IN_7-
XREF=5
XREF=5ALARM_IN_9-

XREF=5
ALARM_IN_10-

XREF=5ALARM_IN_11-
XREF=5

ALARM_IN_12-
XREF=5ALARM_IN_13-

XREF=5
ALARM_IN_14-

XREF=5ALARM_IN_15-
XREF=6

ALARM_IN_16-
XREF=6

ALARM_IN_17-

XREF=6
ALARM_IN_18-

XREF=6
ALARM_IN_19- XREF=6 ALARM_IN_20-ALARM_IN_21- XREF=6

XREF=6 ALARM_IN_22-
XREF=6

ALARM_IN_24-
XREF=6

ALARM_IN_25-

XREF=6
ALARM_IN_26-

XREF=6
ALARM_IN_27- XREF=6 ALARM_IN_28-XREF=6
ALARM_IN_29-

XREF=6
ALARM_IN_30-

XREF=6ALARM_IN_31-
XREF=5ALARM_IN_+

GND

GND1

GND252

51

9
8
7
6

50

5

49
48
47
46
45
44
43
42
41
40

4

39
38
37
36
35
34
33
32
31
30

3
29
28
27
26

25
24
23
22
21
20

2

19
18
17
16
15
14
13
12
11
10

1

P3

XREF=6ALARM_IN_23-

ALARM_IN_1- XREF=5

79
87

5
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Figure 1-25 illustrates the alarm output connectors. 

Figure 1-25 Alarm Output Connector

Step 4 Continue with the “NTP-G12 Install and Close the FMEC Cover (ETSI Only)” procedure on page 1-61 
as needed.

Stop. You have completed this procedure. 

NTP-G12 Install and Close the FMEC Cover (ETSI Only)

NO_5 XREF=7
COM_5 XREF=7

NO_3 XREF=7
COM_3 XREF=7

COM_14XREF=7
NO_14XREF=7

XREF=7 COM_12
NO_12XREF=7

COM_10XREF=7
NO_10XREF=7

COM_8XREF=7
NO_8XREF=7

COM_6XREF=7
NO_6XREF=7

COM_4XREF=7
NO_4XREF=7

COM_2XREF=7

NO_1 XREF=7

NO_2XREF=7

COM_0XREF=7
NO_0XREF=7

NO_15 XREF=7
COM_15

XREF=7

NO_13 XREF=7
COM_13 XREF=7

COM_1 XREF=7

NO_11 XREF=7
COM_11

XREF=7

NO_9 XREF=7
COM_9 XREF=7

NO_7 XREF=7
COM_7 XREF=7

Connector
Alarm Output

GND1

GND2

1

10
11
12
13
14
15
16
17
18
19

2

20
21
22
23
24
25

26
27
28
29

3

30
31
32
33
34
35
36
37
38
39

4

40
41
42
43
44
45
46
47
48
49

5

50

6
7
8
9

51

52

P4

79
87

6

Purpose This procedure installs and closes the ONS 15454 ETSI FMEC cover.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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Step 1 Insert the cover carefully onto the left pin of the hinge (Figure 1-26).

Step 2 Move the cover to the right side towards the right pin of the hinge.

Step 3 Pull the right side of the hinge-locking spring (Figure 1-26). Push the cover onto the right pin until the 
spring snaps into place. 

Figure 1-26 ONS 15454 ETSI FMEC Cover 

Step 4 Attach the ground wire to the shelf. 

Step 5 Attach the washer and nut.

Step 6 Attach the cover to the shelf using the screws on the top of the cover. 

Step 7 Continue with the “NTP-G14 Install DWDM Equipment” procedure on page 1-64.

Stop. You have completed this procedure. 

NTP-G13 Install the Rear Cover (ANSI Only)

71
08

7

FAN FAIL
CRIT

MAJ
MIN

Pin hinge

FMEC cover

Hinge-locking
spring

Purpose The following procedure explains how to install the rear cover on an 
ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 
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Step 1 Locate the three screws that run vertically along on each side of the backplane (Figure 1-27). 

Figure 1-27 Backplane Attachment for the Rear Cover

Tip Only six screws (three on each side) line up with the screw slots on the mounting brackets, 
making the screws easy to locate.

Step 2 Loosen the top and bottom screws on one edge of the backplane to provide room to slide the mounting 
brackets into place using the U-shaped screw slots on each end.

Step 3 Slide one of the mounting brackets into place and tighten the screws. 

Step 4 Repeat Steps 2 and 3 for the second mounting bracket.

Step 5 Attach the cover by hanging it from the mounting screws on the back of the mounting brackets and 
pulling it down until it fits snugly into place.

Figure 1-28 shows rear cover installation using spacers.

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None

32
07

3

Screw locations
for attaching the

rear cover
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Figure 1-28 Installing the Rear Cover with Spacers

Step 6 Continue with the “NTP-G14 Install DWDM Equipment” procedure on page 1-64.

Stop. You have completed this procedure. 

NTP-G14 Install DWDM Equipment

Step 1 Complete the “DLP-G27 Install the DCU Shelf Assembly” task on page 1-65 as needed. 

Step 2 Complete the “DLP-G28 Install the Fiber Patch-Panel Tray” task on page 1-65 as needed.

Step 3 Complete the “DLP-G29 Install the Fiber-Storage Tray” task on page 1-66 as needed.

Step 4 Complete the “DLP-G8 Install the Air Ramp” task on page 1-19 as needed.

Step 5 Complete the “DLP-G30 Install the FlexLayer Shelf” task on page 1-66 as needed. 
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Purpose This procedure installs the optional DWDM assemblies. 

Tools/Equipment #2 Phillips screwdriver

Crimping tool (large enough for #10 to #14 AWG)

#14 AWG wire

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note Procedures for installing FlexLayer hardware in this chapter require that you have a network 
plan calculated for your DWDM network with Cisco MetroPlanner, Release 2.5. MetroPlanner 
is a DWDM planning tool that is available your Cisco account representative. MetroPlanner 
prepares a shelf plan for each network node and calculates the power and attenuation levels for 
the DWDM cards installed in the node. For information about Cisco MetroPlanner, refer to the 
Cisco MetroPlanner DWDM Operations Guide, Release 2.5.

Step 6 Complete the “DLP-G31 Install the FlexLayer Modules” task on page 1-67 as needed.

Step 7 Complete the “DLP-G32 Install the Y-Cable Protection Modules” task on page 1-69 as needed.

Stop. You have completed this procedure.

DLP-G27 Install the DCU Shelf Assembly

Step 1 The DCU chassis requires 1 rack unit (RU) in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) 
rack. Locate the RMU space specified in your site plan. See the “14.5 Typical DWDM Rack Layouts” 
section on page 14-16 for common site layout plans.

Step 2 Two sets of mounting brackets are included with the DCU mounting kit, one set each for 19-inch 
(482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of 
brackets for your rack. Change the brackets as required.

Step 3 Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the four screws.

Step 4 Connect a frame ground to the ground terminal provided on either side of the chassis. Use minimum 
#14 AWG wire.

Step 5 Return to your originating procedure (NTP).

DLP-G28 Install the Fiber Patch-Panel Tray

Purpose If you are installing dispersion compensation modules, use this task to 
install the Dispersion Compensation Unit (DCU) chassis.

Tools/Equipment #2 Phillips screwdriver

Crimping tool

#14 AWG wire and lug

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the fiber patch-panel tray.

Tools/Equipment #2 Phillips screwdriver
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Step 1 The fiber patch-panel tray requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. See the “14.5 Typical DWDM Rack Layouts” section 
on page 14-16 for common site configurations.

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 
Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as 
required.

Step 3 Align the chassis with the rack mounting screw holes, then insert and tighten the four screws.

Step 4 Return to your originating procedure (NTP).

DLP-G29 Install the Fiber-Storage Tray

Step 1 The fiber-storage tray requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. See the “14.5 Typical DWDM Rack Layouts” section 
on page 14-16 for common site configurations. 

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 
Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as 
required.

Step 3 Align the chassis with the rack mounting screw holes, insert the screws (4), and tighten.

Step 4 Return to your originating procedure (NTP).

DLP-G30 Install the FlexLayer Shelf

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the fiber-storage tray. The fiber-storage tray stores slack 
fiber-optic cable.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the FlexLayer shelf. Perform this task if you are 
installing any FlexLayer modules.

Tools/Equipment #2 Phillips screwdriver

FlexLayer shelf assembly (15216-FL-SA)
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Step 1 The FlexLayer shelf requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. Refer to Chapter 14, “Shelf Hardware Reference” for 
typical DWDM site layout plans.

Step 2 A set of mounting brackets are included with the FlexLayer mounting kit, one set each for 19-inch 
(482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of 
brackets for your rack. Change the brackets as required.

Step 3 Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the three screws.

Step 4 Repeat this task as necessary for each FlexLayer shelf assembly you want to install.

Step 5 Return to your originating procedure (NTP).

DLP-G31 Install the FlexLayer Modules

Step 1 Determine the FlexLayer modules that you want to install in the FlexLayer shelf. The FlexLayer shelf 
can house up to four Add/Drop FlexLayer modules or four Y-cable splitter modules. Table 1-11 lists the 
two-channel FlexLayer modules and part numbers. Refer to Chapter 14, “Shelf Hardware Reference” for 
more information about FlexLayer modules.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the FlexLayer modules in the FlexLayer shelf assembly. 
You can only install two-channel FlexLayer modules.

Tools/Equipment #2 Phillips screwdriver

FlexLayer modules

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-11 ONS 15xxx FlexLayer Hardware Part Numbers

Part Number Description

2 Channel Add/Drop FlexLayer Modules

15216-FLB-2-31.1= ITU-100 GHz 2 Ch, FlexMod - 1530.33 and 1531.12

15216-FLB-2-32.6= ITU-100 GHz 2 Ch, FlexMod - 1531.90 and 1532.68

15216-FLB-2-35.0= ITU-100 GHz 2 Ch, FlexMod - 1534.25 and 1535.04

15216-FLB-2-36.6= ITU-100 GHz 2 Ch, FlexMod - 1535.82 and 1536.61

15216-FLB-2-38.9= ITU-100 GHz 2 Ch, FlexMod - 1538.19 and 1538.98

15216-FLB-2-40.5= ITU-100 GHz 2 Ch, FlexMod - 1539.77 and 1540.56
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Step 2 Insert the appropriate module into the FlexLayer shelf assembly. 

Note FlexLayer modules are not listed in generated Cisco MetroPlanner 2.5 site plans.

Step 3 Use a Phillips screwdriver to install the two accompanying screws.

Figure 1-29 shows the FlexLayer shelf assembly and how the FlexLayer modules can be installed. 

Figure 1-29 ONS 15xxx FlexLayer Shelf Assembly

Step 4 Repeat this task as necessary for each FlexLayer module you want to install.

Step 5 Return to your originating procedure (NTP).

15216-FLB-2-42.9= ITU-100 GHz 2 Ch, FlexMod - 1542.14 and 1542.94

15216-FLB-2-44.5= ITU-100 GHz 2 Ch, FlexMod - 1543.73 and 1544.53

15216-FLB-2-46.9= ITU-100 GHz 2 Ch, FlexMod - 1546.12 and 1546.92

15216-FLB-2-48.5= ITU-100 GHz 2 Ch, FlexMod - 1547.72 and 1548.51

15216-FLB-2-50.9= ITU-100 GHz 2 Ch, FlexMod - 1550.12 and 1550.92

15216-FLB-2-52.5= ITU-100 GHz 2 Ch, FlexMod - 1551.72 and 1552.52

15216-FLB-2-54.9= ITU-100 GHz 2 Ch, FlexMod - 1554.13 and 1554.94

15216-FLB-2-56.5= ITU-100 GHz 2 Ch, FlexMod - 1555.75 and 1556.55

15216-FLB-2-58.9= ITU-100 GHz 2 Ch, FlexMod - 1558.17 and 1558.98

15216-FLB-2-60.6= ITU-100 GHz 2 Ch, FlexMod - 1559.79 and 1560.61

Table 1-11 ONS 15xxx FlexLayer Hardware Part Numbers (continued)

Part Number Description

90
91

6

Add/Drop Modules, 
Splitter/Coupler Modules, and/or

Protection Modules

VOA Module

Shelf assembly

Fiber Management Tray

Frame Ground Terminal
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DLP-G32 Install the Y-Cable Protection Modules

Step 1 Determine the Y-cable modules that you want to install in the FlexLayer shelf. 

Step 2 Insert the appropriate Y-cable module into the FlexLayer shelf assembly. Use a Phillips screwdriver to 
install the two accompanying screws.

Step 3 Repeat this task as necessary for each Y-cable module you want to install (Figure 14-12 on page 14-14).

Step 4 Return to your originating procedure (NTP).

NTP-G15 Install the Common Control Cards

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside to edge of the shelf assembly.

Purpose This task installs the Y-cable protection modules in the FlexLayer shelf 
assembly. 

Tools/Equipment #2 Phillips screwdriver

Y-Cable modules:

• Multi-Mode Y Cable Protection FlexMod: 15216-CS-MM-Y=

• Single-Mode Y Cable Protection FlexMod: 15216-CS-SM-Y=

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This procedure describes how to install the common control cards. 

Tools/Equipment Redundant TCC2/TCC2P cards

AIC-I card (optional)

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G14 Install DWDM Equipment, page 1-64

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Complete the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-70.

Step 2 Complete the “DLP-G34 Install the AIC-I Card” task on page 1-73, if necessary.

Step 3 Continue with the “NTP-G16 Perform the Shelf Installation Acceptance Test” procedure on page 1-74.

DLP-G33 Install the TCC2 or TCC2P Card 

Caution Do not remove a TCC2/TCC2P card during the software transfer process, which is indicated by alternate 
flashing FAIL and ACT/STBY LEDs. Removing a TCC2/TCC2P during the software transfer process 
will corrupt the system memory. 

Note Do not install the second TCC2/TCC2P until the first TCC2/TCC2P is installed and is fully initialized.

Step 1 Open the latches/ejectors of the first TCC2/TCC2P card that you will install. 

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Note In Step 4 you will be instructed to watch the LED activity (sequence) on the front of the 
TCC2/TCC2P card. This activity begins immediately after you close the latches in Step 3.

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the back 
panel of the shelf assembly. Ensure that you cannot insert the card any farther. 

Purpose This task installs redundant TCC2/TCC2P cards. The first card you install 
in the ONS 15454  must be a TCC2/TCC2P card, and it must initialize 
before you install any cross-connect or traffic cards. 

Tools/Equipment Two TCC2/TCC2P cards

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Step 4 As needed, go to Step a to verify the LED activity on the TCC2 card. For the TCC2P card, go to Step b.

a. For the TCC2 card:

• All LEDs turn on for about 5 seconds. The red FAIL LED, the yellow ACT/STBY LED, the red REM 
LED, the green SYNC LED, and the green ACO LED turn on for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds. 

• The red FAIL LED blinks for about 10 seconds. (If both TCC2 cards are installed, this LED blinks 
on the other TCC2 card, as well.)

• The red FAIL LED turns on for about 5 seconds.

• Both green PWR LEDs turn on for 5 seconds. The PWR LEDs then turn red for 2 to 3 minutes before 
going to steady green.

• While the PWR LEDs are red, the ACT/STBY, MJ, and MN LEDs turn on, followed by the SNYC 
LED.

• The boot up process is complete when the PWR LEDs turn green and the ACT/STBY remains on. 
(The ACT/STBY LED will be green if this is the first TCC2 card installed, and amber if this is the 
second TCC2 card installed.)

Note It might take up to 4 minutes for the A and B power alarms to clear.

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Note If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while 
the TCC2 card initializes. The alarm should clear after the card completely boots.

Note If the FAIL LED is on continuously, see the tip below about the TCC2 card automatic upload.

b. For the TCC2P card:

• All LEDs turn on briefly. The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the 
green SYNC LED, and the green ACO LED turn on for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds. 

• The red FAIL LED blinks for about 10 seconds. (If both TCC2 cards are installed, this LED blinks 
on the other TCC2 card as well.)

• The red FAIL LED turns on for about 5 seconds.

• The red FAIL LED blinks for about 5 seconds and then becomes solid.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for about 10 seconds.

• Both green PWR LEDs turn on for 5 seconds. The PWR LEDs then turn red for 2 to 3 minutes before 
going to steady green.
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• The yellow ACT/STBY turns on and the PWR LEDs turn red for 2 to 3 minutes. (The Sync LED 
may be green at this time.)

• The yellow ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to turn on 
while the DCC processor boots.) 

Note It might take up to 3 minutes for the A and B power alarms to clear.

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Note If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while 
the TCC2P card initializes. The alarm should clear after the card completely boots.

Note If the FAIL LED is on continuously, see the tip in Step 8 about the TCC2P card automatic 
upload.

Step 5 Verify that the ACT/STBY LED is green if this is the first powered-up TCC2/TCC2P card installed, or 
yellow for standby if this is the second powered-up TCC2/TCC2P. The IP address, temperature of the 
node, and time of day appear on the LCD. The default time and date is 12:00 AM, January 1, 1970. 

Step 6 The LCD cycles through the IP address, node name, and software version. Verify that the correct 
software version displays on the LCD. 

Step 7 If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the 
correct software version, refer to your next level of technical support, upgrade the software, or remove 
the TCC2/TCC2P card and install a replacement card. 

Refer to the release-specific software upgrade document to replace the software. To exchange the 
TCC2/TCC2P card, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

Step 8 Repeat Steps 1 through 7 for the redundant TCC2/TCC2P card If both TCC2/TCC2P cards are already 
installed, proceed to Step 9. 

Tip If you install a standby TCC2/TCC2P card that has a different software version than the active 
TCC card, the newly installed standby TCC2/TCC2P card automatically copies the software 
version from the active TCC2/TCC2P card. You do not need to do anything in this situation. 
However, the loading TCC2/TCC2P card does not boot up in the normal manner. When the 
standby card is first inserted, the LEDs follow most of then normal bootup sequence. After the 
red FAIL LED turns on for about 5 seconds, the FAIL LED and the ACT/STBY LED begin to 
flash alternately for up to 30 minutes while the new software loads onto the active TCC2/TCC2P 
card. After loading the new software, the upgraded TCC2/TCC2P card’s LEDs repeat the 
appropriate bootup sequence, and the amber ACT/STBY LED turns on.

Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 
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Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Step 9 Return to your originating procedure (NTP).

DLP-G34 Install the AIC-I Card

Note When installing cards, allow each card to boot completely before installing the next card.

Step 1 Open the latches/ejectors on the card.

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails in Slot 9 until the card plugs into 
the receptacle at the back of the slot. 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 4 Verify the following:

• The red FAIL LED turns on for 1 second, then blinks for up to 5 seconds.

• The PWR A and PWR B LEDs become red and the two INPUT/OUTPUT LEDs become green for 
approximately 3 seconds.

• The PWR A LED turns green, the INPUT/OUTPUT LEDs turn off, and the ACT LED turns on.

Note It might take up to 3 minutes for the PWR A and PWR B LEDs to update.

Note If the red FAIL LED does not turn on, check the power. 

Note If you insert a card into a slot provisioned for a different card, no LEDs turn on. 

Purpose This task installs the AIC-I card. The AIC-I card provides connections for 
external alarms and controls (environmental alarms). 

Tools/Equipment AIC-I card

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-70

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note If the red FAIL LED is on continuously or the LEDs act erratically, the card is not installed 
properly. Remove the card and repeat Steps 1 to 4. 

Step 5 Return to your originating procedure (NTP).

NTP-G16 Perform the Shelf Installation Acceptance Test 

Step 1 If you installed an ONS 15454 ETSI shelf, complete Table 1-12 by verifying that each applicable 
procedure was completed. 

Step 2 If you installed an ONS 15454 ANSI shelf, complete Table 1-13 by verifying that each applicable 
procedure was completed. 

Purpose Use this procedure to perform a shelf installation acceptance test for the 
ONS 15454 ETSI and ONS 15454 ANSI.

Tools/Equipment Voltmeter

Oval and/or block ferrites

Prerequisite Procedures Applicable procedures in Chapter 1, “Install the Shelf and Common 
Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Table 1-12 ONS 15454 ETSI Shelf Installation Task Summary

Description Completed

NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28

NTP-G7 Install the Power and Ground, page 1-30

NTP-G8 Install the Fan-Tray Assembly, page 1-40

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 
1-46

NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-61

NTP-G14 Install DWDM Equipment, page 1-64

NTP-G15 Install the Common Control Cards, page 1-69
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Step 3 Complete the “DLP-G35 Inspect the Shelf Installation and Connections” task on page 1-75.

Step 4 Complete the “DLP-G36 Measure Voltage” task on page 1-76.

Step 5 Continue with Chapter 2, “Connect the PC and Log into the GUI.”

Stop. You have completed this procedure. 

DLP-G35 Inspect the Shelf Installation and Connections 

Step 1 Make sure all external wiring connections on the backplane (i.e. power, ground, alarms, etc.) are secure. 
If a wire or cable is loose, return to the appropriate procedure in this chapter to correct it.

Step 2 (ETSI only) To check that the FMEC cover is seated correctly, verify that it can be easily closed without 
disturbing cables.

Step 3 Return to your originating procedure (NTP).

Table 1-13 ONS 15454 ANSI Shelf Installation Task Summary

Description Completed

NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

NTP-G7 Install the Power and Ground, page 1-30

NTP-G8 Install the Fan-Tray Assembly, page 1-40

NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-43

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 
1-46

NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-57

NTP-G13 Install the Rear Cover (ANSI Only), page 1-62

NTP-G14 Install DWDM Equipment, page 1-64

NTP-G15 Install the Common Control Cards, page 1-69

Purpose Use this task to inspect the shelf installation and connections and verify that 
everything is installed and connected properly.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Required Tools and Equipment (ETSI)
DLP-G36 Measure Voltage 

Step 1 Using a voltmeter, verify the office ground and power:

a. Place the black lead (positive) on the frame ground on the bay. Hold it there while completing Step b.

b. Place the red lead (negative) on the fuse power points on the third-party power distribution panel to 
verify that they read between –40.5 VDC and –57 VDC (power) and 0 (return ground).

Step 2 Using a voltmeter, verify the shelf ground and power wiring:

a. Place the black lead (positive) on the RET1 and the red lead on the BAT1 point. Verify a reading 
between –40.5 VDC and –57 VDC. If there is no voltage, check the following and correct if 
necessary:

• Battery and ground are reversed to the shelf.

• Battery is open or missing.

• Return is open or missing.

Step 3 Repeat Step 1 and Step 2 for the RET2 and BAT2 of the redundant power supply input.

Step 4 Return to your originating procedure (NTP).

Purpose Use this task to measure the power to verify correct power and returns. 
Perform this task as needed. (You should already have checked the voltage 
during the “DLP-G19 Turn On and Verify Office Power” task on 
page 1-39.)

Tools/Equipment Voltmeter

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Cisco ONS 15454 DWDM
September 2005
C H A P T E R 2

Connect the PC and Log into the GUI

This chapter explains how to connect PCs and workstations to the Cisco ONS 15454 and how to log into 
Cisco Transport Controller (CTC) software, which is the ONS 15454 Operation, Administration, 
Maintenance and Provisioning (OAM&P) user interface. Procedures for connecting to the ONS 15454 
ANSI using TL1 are provided in the Cisco ONS SONET TL1 Command Guide or for ETSI using the 
Cisco ONS 15454 SDH TL1 Command Guide.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G17 Set Up Computer for CTC, page 2-1—Complete this procedure if your PC or workstation 
has never been connected to an ONS 15454.

2. NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 
2-9—Complete this procedure to set up your computer for an onsite craft connection to the 
ONS 15454.

3. NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 
2-21—Complete this procedure to set up your computer to connect to the ONS 15454 using a 
corporate LAN.

4. NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23—Complete this 
procedure to set up your computer for remote modem access to the ONS 15454.

5. NTP-G21 Log into the ONS 15454 GUI, page 2-24—Complete this procedure to log into CTC.

NTP-G17 Set Up Computer for CTC

Purpose This procedure configures your PC or UNIX workstation to run CTC. 

Tools/Equipment Cisco ONS 15454 Release 5.0 software or documentation CD

Prerequisite Procedures Chapter 14, “Shelf Hardware Reference”

Required/As Needed Required
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Before You Begin
Note If you will log into nodes running CTC software earlier than Software Release 4.6, uninstall JRE 1.4.2 
and reinstall JRE 1.3.1_2. To run Software R4.7 or R5.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Step 1 If your computer does not have an appropriate browser installed, complete the following:

• To install Netscape 7.x, download the browser at the following site: 
http://channels.netscape.com/ns/browsers/default.jsp

• To install Internet Explorer 6.x on a PC, download the browser at the following site: 
http://www.microsoft.com

Step 2 If your computer is a Windows PC, complete the “DLP-G37 Run the CTC Installation Wizard for 
Windows” task on page 2-3, then go to Step 4.

Step 3 If your computer is a UNIX workstation, complete the “DLP-G38 Run the CTC Installation Wizard for 
UNIX” task on page 2-6.

Step 4 When your PC or workstation is set up, continue with the setup procedure appropriate to your network: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23

Note Cisco recommends that you configure your browser to disable the caching of user IDs/passwords on 
computers used to access Cisco optical equipment. 

In Internet Explorer, choose Tools > Internet Options > Content. Click Auto Complete and uncheck 
the User names and passwords on forms option. 

In Netscape 7.0, choose Edit > Preferences > Privacy & Security > Forms and uncheck the option to 
save form data. For passwords, choose Edit > Preferences > Privacy & Security > Passwords and 
uncheck the option to remember passwords. Note that passwords can be stored in an encrypted format. 
Netscape versions earlier than 6.0 do not cache user IDs and passwords.

Stop. You have completed this procedure.

Onsite/Remote Onsite or remote

Security Level None
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Before You Begin
DLP-G37 Run the CTC Installation Wizard for Windows

Note If you will log into nodes running CTC software earlier than Software Release 4.6, uninstall JRE 1.4.2 
and reinstall JRE 1.3.1_2. To run Software R4.7 or R5.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Note JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x

Step 1 Verify that your computer has the following:

• Processor—Pentium III, 700 Mhz or faster

• RAM—384 MB recommended, 512 MB optimum

• Hard drive—20 GB hard drive recommended with at least 50 MB of space available

• Operating system—Windows 98 (1st and 2nd editions), Windows NT 4.0 (with Service Pack 6a), 
Windows 2000 (with Service Pack 3), or Windows XP Home

If your operating system is Windows NT 4.0, verify that Service Pack 6a or later is installed. From 
the Start menu, choose Programs > Administrative Tools > Windows NT Diagnostics and check 
the service pack on the Version tab of the Windows NT Diagnostics dialog box. If Service Pack 6a 
or later is not installed, do not continue. Install Service Pack 6a following the computer upgrade 
procedures for your site.

Note Processor and RAM requirements are guidelines. CTC performance is faster if your 
computer has a faster processor and more RAM. 

Step 2 Insert the Cisco ONS 15454 Release 5.0 software CD into your computer CD drive. The installation 
program begins running automatically. If it does not start, navigate to the CD directory and double-click 
setup.exe.

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer:

Purpose This task installs the CTC online user manuals, Acrobat Reader 6.0.1, 
JRE 1.4.2, and the CTC JAR files. JRE 1.4.2 is required to run Release 5.0. 
Pre-installing the CTC JAR files saves time at initial login. If the JAR files 
are not installed, they are downloaded from the TCC2/TCC2P card the first 
time you login.

Tools/Equipment Cisco ONS 15454 Release 5.0 software CD

Prerequisite Procedures None

Required/As Needed This task is required if you will use a Windows computer to run CTC and 
if any one of the following is true: 

• JRE 1.4.2 is not installed.

• CTC online user manuals are not installed and are needed.

• CTC JAR files are not installed and needed.

Onsite/Remote Onsite or remote

Security Level None
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Chapter 2      Connect the PC and Log into the GUI
Before You Begin
• Java Runtime Environment 1.4.2

• Acrobat Reader 6.0.1

• Online User Manuals

• CTC JAR files

Step 3 Click Next.

Step 4 Complete one of the following:

• Click Typical to install both the Java Runtime Environment and online user manuals. If you already 
have JRE 1.4.2 installed on your computer, choose Custom.

• Click Custom if you want to install either the JRE or the online user manuals. By default, Acrobat 
Reader and the online user manuals are selected.

Step 5 Click Next. 

Step 6 Complete the following, as applicable:

• If you selected Typical in Step 4, skip this step and continue with Step 7.

• If you selected Custom in Step 4, check the CTC component that you want to install and click Next. 

– If you selected Online User Manuals, continue with Step 7. 

– If you did not select Online User Manuals, continue with Step 9.

Step 7 The directory where the installation wizard will install the CTC online user manuals appears. The default 
is C:\Program Files\Cisco\CTC\Documentation. 

• If you want to change the CTC online user manuals directory, type the new directory path in the 
Directory Name field, or click Browse to navigate to the directory. 

• If you do not want to change the directory, skip this step.

Step 8 Click Next.

Step 9 Review the components that will be installed. If you want to change the components, complete one of 
the following. If not, proceed to Step 10.

• If you selected Typical in Step 4, click Back twice to return to the installation setup type panel. 
Choose Custom and repeat Steps 5 through 8. 

• If you selected Custom in Step 4, click Back once or twice (depending on the components selected) 
until the component selection panel appears. Repeat Steps 6 through 8.

Step 10 Click Next. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom 
in Step 4 and did not check Java Runtime Environment 1.4.2, continue with Step 12.

Step 11 To install the JRE, complete the following:

a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and 
choose one of the following:

• I accept the terms of the license agreement—Accepts the license agreement. Continue with 
Step b.

• I do not accept the terms of the license agreement—Disables the Next button on the Java 2 
Runtime Environment License Agreement dialog box. Click Cancel to return to the CTC 
installation wizard. CTC will not install the JRE. Continue with Step 12.
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Chapter 2      Connect the PC and Log into the GUI
Before You Begin
Note If JRE 1.4.2 is already installed on your computer, the License Agreement panel does 
not appear. You must click Next and then choose Modify to change the JRE installation 
or Remove to uninstall the JRE. If you choose Modify and click Next, continue with 
Step e. If you choose Remove and click Next, continue with Step i.

b. Click Next.

c. Choose one of the following:

• Click Typical to install all JRE features. If you select Typical, the JRE version installed will 
automatically become the default JRE version for your browsers.

• Click Custom if you want to select the components to install and select the browsers that will 
use the JRE version.

d. Click Next.

e. If you selected Typical, continue with Step h. If you selected Custom, click the drop-down list for 
each program feature that you want to install and choose the desired setting. The program features 
include:

• Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European 
languages. 

• Support for Additional Languages—Adds support for non-European languages.

• Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management 
capabilities.

The drop-down list options for each program feature include:

• This feature will be installed on the local hard drive—Installs the selected feature.

• This feature and all subfeatures will be installed on the local hard drive—Installs the selected 
feature and all subfeatures.

• Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime 
Environment).

To modify the directory where the JRE version is installed, click Change, navigate to the desired 
directory, and click OK..

f. Click Next.

g. In the Browser Registration dialog box, check the browsers that you want to register with the Java 
Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both 
browser check boxes unchecked.

Note Setting the JRE as the default for these browsers might cause problems with these browsers.

h. Click Next. 

i. Click Finish.

Note If you are uninstalling the JRE, click Remove.

Step 12 In the Cisco Transport Controller Installation Wizard, click Next. The online user manuals are installed.

Step 13 Click Finish.
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Chapter 2      Connect the PC and Log into the GUI
Before You Begin
Step 14 Return to your originating procedure (NTP).

DLP-G38 Run the CTC Installation Wizard for UNIX

Note If you will log into nodes running CTC software earlier than Software R4.6, uninstall JRE 1.4.2 and 
reinstall JRE 1.3.1_2. To run Software R4.7 or R5.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Note JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x.

Step 1 Verify that your computer has the following:

• RAM—384 MB recommended, 512 MB optimum

• Hard drive—20 GB hard drive recommended with at least 50 MB of space available

• Operating system—Solaris 8 or 9

Note These requirements are guidelines. CTC performance is faster if your computer has a faster 
processor and more RAM. 

Step 2 Change the directory; type:

cd /cdrom/cdrom0/

Step 3 From the techdoc454 CD directory, type:

./setup.bat

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer:

• Java Runtime Environment 1.4.2 

• Acrobat Reader 6.0.1

• Online User Manuals

Purpose This task installs the CTC online user manuals, Acrobat 6.0.1, and 
JRE 1.4.2 on UNIX workstations, as necessary. JRE 1.4.2 is required to run 
Release 5.0.

Tools/Equipment Cisco ONS 15454 Release 5.0 software CD

Prerequisite Procedures None

Required/As Needed This task is required if you will use a UNIX workstation to run CTC and 
any of the following are true: 

• JRE 1.4.2 is not installed.

• CTC online user manuals are not installed and are needed.

Onsite/Remote Onsite or remote

Security Level None
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Before You Begin
• CTC JAR files

Step 4 Click Next.

Step 5 Complete one of the following:

• Click Typical to install both the Java Runtime Environment and online user manuals. If you already 
have JRE 1.4.2 installed on your computer, choose Custom.

• Click Custom if you want to install either the JRE or the online user manuals. 

Step 6 Click Next. 

Step 7 Complete the following, as applicable:

• If you selected Typical in Step 5, continue with Step 8.

• If you selected Custom in Step 5, check the CTC component that you want to install and click Next. 

– If you selected Online User Manuals, continue with Step 8. 

– If you did not select Online User Manuals, continue with Step 10. 

Step 8 The directory where the installation wizard will install the CTC online user manuals appears. The default 
is /usr/doc/ctc. 

• If you want to change the CTC online user manuals directory, type the new directory path in the 
Directory Name field, or click Browse to navigate to the directory.

• If you do not want to change the CTC online user manuals directory, skip this step.

Step 9 Click Next.

Step 10 Review the components that will be installed.

• If you selected Typical in Step 5, click Back twice to return to the installation setup type panel. 
Choose Custom and repeat Steps 6 through 9.

• If you selected Custom in Step 5, click Back once or twice (depending on the components selected) 
you reach the component selection panel and check the desired components. Repeat Steps 7 
through 9.

Step 11 Click Next. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom 
in Step 4 and did not check Java Runtime Environment 1.4.2, continue with Step 13.

Step 12 To install the JRE, complete the following:

a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and 
choose one of the following:

• I accept the terms of the license agreement—Accepts the license agreement. Continue with 
Step b.

• I do not accept the terms of the license agreement—Disables the Next button on the Java 2 
Runtime Environment License Agreement dialog box. Click Cancel to return to the CTC 
installation wizard. CTC will not install the JRE. Continue with Step 13.

Note If JRE 1.4.2 is already installed on your computer, the License Agreement panel does 
not appear. You must click Next and then choose Modify to change the JRE installation 
or Remove to uninstall the JRE. If you choose Modify and click Next, continue with 
Step e. If you choose Remove and click Next, continue with Step i.

b. Click Next.

c. Choose one of the following:
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Before You Begin
• Click Typical to install all JRE features. If you select Typical, the JRE version installed will 
automatically become the default JRE version for your browsers. 

• Click Custom if you want to select the components to install and select the browsers that will 
use the JRE version.

d. Click Next.

e. If you selected Typical, continue with Step i. If you selected Custom, click the drop-down list for 
each program feature that you want to install and choose the desired setting. The program features 
include:

• Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European 
languages. 

• Support for Additional Languages—Adds support for non-European languages.

• Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management 
capabilities.

The drop-down list options for each program feature include:

• This feature will be installed on the local hard drive—Installs the selected feature.

• This feature and all subfeatures will be installed on the local hard drive—Installs the selected 
feature and all subfeatures.

• Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime 
Environment).

To modify the directory where the JRE version is installed, click Change, navigate to the desired 
directory, and click OK.

f. Click Next.

g. In the Browser Registration dialog box, check the browsers that you want to register with the Java 
Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both 
browser check boxes unchecked.

Note Setting the JRE version as the default for these browsers might cause problems with these 
browsers. 

h. Click Next. 

i. Click Finish.

Note If you are uninstalling the JRE, click Remove.

Step 13 In the Cisco Transport Controller Installation Wizard, click Next. The online user manuals are installed.

Step 14 Click Finish.

Note Be sure to record the names of the directories you choose for JRE and the online user manuals.

Step 15 Return to your originating procedure (NTP).
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Before You Begin
NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454

Step 1 Complete one of the CTC computer setup tasks shown in Table 2-1 based your CTC connection 
environment.

Purpose This procedure explains how to set up a PC running Windows or a Solaris 
workstation for an onsite local craft connection to the ONS 15454. 

Tools/Equipment Network interface card (NIC), also referred to as an Ethernet card

Straight-through (CAT 5) LAN cable

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None

Table 2-1 CTC Computer Setup for Local Craft Connections to the ONS 15454

CTC Connection Environment CTC Computer Setup Task

• You are connecting from a Windows PC.

• All nodes that you will access run software earlier 
than Release 3.3.

• You will connect to one ONS 15454. 

• You need to access non-ONS 15454 applications 
such as ping and tracert (trace route).

1. Complete the “DLP-G39 Set Up a 
Windows PC for Craft Connection to an 
ONS 15454 on the Same Subnet Using 
Static IP Addresses” task on page 2-11.

2. Continue with Step 2.

• You are connecting from a Windows PC.

• The CTC computer is provisioned for Dynamic 
Host Configuration Protocol (DHCP).

• The ONS 15454 has DHCP forwarding enabled.

• The ONS 15454 is connected to a DHCP server.

Note The ONS 15454 does not provide IP addresses. 
If DHCP is enabled, it passes DCHP requests to 
an external DHCP server.

1. Complete the “DLP-G40 Set Up a 
Windows PC for Craft Connection to an 
ONS 15454 Using Dynamic Host 
Configuration Protocol” task on 
page 2-13.

2. Continue with Step 2.

Note Do not use this task for initial node 
turn-up. Use the task only if DHCP 
forwarding is enabled on the 
ONS 15454. By default, DHCP is not 
enabled. To enable it, see the 
“NTP-G26 Set Up CTC Network 
Access” procedure on page 3-10.
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Before You Begin
Step 2 Connect a straight-through CAT-5 LAN cable from the PC or Solaris workstation NIC to one of the 
following:

• RJ-45 (LAN) port on the active or standby TCC2/TCC2P card

• RJ-45 (LAN) port on a hub or switch to which the ONS 15454 is physically connected

Note For instructions on crimping your own straight-through (CAT-5) LAN cables, refer to the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide.

Note For initial shelf turn-up, you should connect your PC directly to the LAN port on the 
TCC2/TCC2P card of the ONS 15454. 

Step 3 After setting up your CTC computer, continue with the “NTP-G21 Log into the ONS 15454 GUI” 
procedure on page 2-24 as needed.

Stop. You have completed this procedure.

• You are connecting from a Windows PC.

• All nodes that you will access run software 
Release 3.3 or later.

• You will connect to ONS 15454s at different 
locations and times and do not wish to reconfigure 
your PC’s IP settings each time.

• You will not access or use non-ONS 15454 
applications such as ping and tracert (trace route).

• If you are using an ANSI shelf, you will connect to 
the TCC2/TCC2P Ethernet port or backplane LAN 
pins either directly or through a hub.

• If you are using an ETSI shelf, you will connect to 
the ONS 15454 Ethernet port or the RJ-45 jack on 
the MIC-C/T/P FMEC either directly or through a 
hub.

1. Complete the “DLP-G41 Set Up a 
Windows PC for Craft Connection to an 
ONS 15454 Using Automatic Host 
Detection” task on page 2-16.

2. Continue with Step 2.

• You are connecting from a Solaris workstation.

• You will connect to one ONS 15454.

• You need to access non-ONS 15454 applications 
such as ping and tracert (trace route).

1. Complete the “DLP-G42 Set Up a Solaris 
Workstation for a Craft Connection to an 
ONS 15454” task on page 2-19.

2. Continue with Step 2.

Table 2-1 CTC Computer Setup for Local Craft Connections to the ONS 15454 (continued)

CTC Connection Environment CTC Computer Setup Task (continued)
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Before You Begin
DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the 
Same Subnet Using Static IP Addresses

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, choose TCP/IP for your NIC card, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

h. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address except for 
the last octet. The last octet must be 1 or 3 through 254. This IP address appears on the LCD unless 
its display is suppressed during node provisioning. 

Purpose This task sets up your computer for a local craft connection to the 
ONS 15454 when: 

• You will access nodes running software releases earlier than Software 
Release 3.3.

• You will connect to one ONS 15454; if you will connect to multiple 
ONS 15454s, you might need to reconfigure your computer’s IP 
settings each time you connect to an ONS 15454.

• You need to use non-ONS 15454 applications such as ping and tracert 
(trace route).

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the ONS 15454 IP address. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

n. When the prompt to restart your PC appears, click Yes.

o. Proceed to Step 7.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

g. In the Subnet Mask field, type 255.255.255.0.

h. Click Advanced.

i. In the Gateways List, click Add. The TCP/IP Gateway Address dialog box appears.

j. Type the ONS 15454 IP address in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.

n. In some cases, Windows NT 4.0 prompts you to reboot your PC. If you receive this prompt, click 
Yes.

o. Proceed to Step 7.

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

f. In the Subnet Mask field, type 255.255.255.0.

g. In the Default Gateway field, type the ONS 15454 IP address. 

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.
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j. In the Local Area Connection Status dialog box, click Close.

k. Proceed to Step 7.

Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon.

c. From the Local Area Connection Properties dialog box, choose Internet Protocol (TCP/IP), then 
click Properties.

d. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

e. In the Subnet Mask field, type 255.255.255.0.

f. In the Default Gateway field, type the ONS 15454 IP address. 

g. Click OK.

h. In the Local Area Connection Properties dialog box, click OK.

i. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).

DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Dynamic Host Configuration Protocol

Note Do not use this task for initial node turn-up. Use the task only if DHCP forwarding is enabled on the 
ONS 15454. By default, DHCP is not enabled. To enable it, see the “NTP-G26 Set Up CTC Network 
Access” procedure on page 3-10.

Note The ONS 15454 does not provide the IP addresses. If DHCP forwarding is enabled, it passes DCHP 
requests to an external DHCP server.

Purpose This task sets up your computer for craft connection to the ONS 15454 
using DHCP. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

NTP-G26 Set Up CTC Network Access, page 3-10

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your NIC, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Obtain an IP address automatically. 

h. Click OK.

i. When the prompt to restart your PC appears, click Yes.

j. Proceed to Step 7.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Obtain an IP address from a DHCP server.

f. Click OK.

g. Click Apply.

h. If Windows prompts you to restart your PC, click Yes.

i. Proceed to Step 7.

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.
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c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Obtain an IP address from a DHCP server.

e. Click OK.

f. In the Local Area Connection Properties dialog box, click OK.

g. In the Local Area Connection Status dialog box, click Close.

h. Proceed to Step 7.

Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. In the Network Connections dialog box, click Local Area Connection.

c. In the Local Area Connection Status dialog box, click Properties.

d. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

e. Click Obtain an IP address from a DHCP server.

f. Click OK.

g. In the Local Area Connection Properties dialog box, click OK.

h. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).
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DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Automatic Host Detection 

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel. 

Note In Windows XP, you can select Control Panel directly from the Start menu. Make sure you 
are in Classic View before continuing with this procedure.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

Purpose This task sets up your computer for local craft connection to the 
ONS 15454 when:

• If you are using an ANSI shelf, you will connect to the ONS 15454 
Ethernet port or backplane LAN pins either directly or through a hub.

• If you are using an ETSI shelf, you will connect to the ONS 15454 
Ethernet port or the RJ-45 jack on the MIC-C/T/P FMEC either 
directly or through a hub.

• All nodes that you will access are running Software Release 3.3 or 
later.

• You will connect to multiple ONS 15454s and do not want to 
reconfigure your IP address each time.

• You do not need to access non-ONS 15454 applications such as ping 
and tracert (trace route).

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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c. In the Network dialog box, select TCP/IP for your NIC, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

h. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 10-10.

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the address entered in Step h. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

n. When the prompt to restart your PC appears, click Yes.

o. Proceed to Step 7.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 10-10.

g. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

h. Click Advanced.

i. In the Gateways List, click Add. The TCP/IP Gateway Address dialog box appears.

j. Type the IP address entered in Step f in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.
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n. Reboot your PC. 

o. Proceed to Step 7.

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 10-10.

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

g. Type the IP address entered in Step e in the Gateway Address field.

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.

k. Proceed to Step 7.

Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon to select it. 
Right-click and select Properties.

c. From the Local Area Connection Properties dialog box, click on Internet Protocol (TCP/IP) to 
select it, then click Properties.

d. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

e. Select the Use the Following IP Address: radio button.

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 10-10.

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

g. Type the IP address entered in Step d in the Gateway Address field.
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h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).

DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454

Step 1 Log into the workstation as the root user.

Step 2 Check to see if the interface is plumbed by typing:

# ifconfig device 

For example:

# ifconfig hme1

If the interface is plumbed, a message similar to the following appears:

hme1:flags=1000842<BROADCAST,RUNNING,MULTICAST,IPv4>mtu 1500 index 2 inet 0.0.0.0 
netmask 0

If a message similar to this one appears, go to Step 4.

If the interface is not plumbed, a message similar to the following appears: 

ifconfig: status: SIOCGLIFFLAGS: hme1: no such interface. 

If a message similar to this one appears, go to Step 3.

Step 3 Plumb the interface by typing:

# ifconfig device plumb 

For example: 

# ifconfig hme1 plumb

Step 4 Configure the IP address on the interface by typing:

# ifconfig interface ip-address netmask netmask up

For example: 

# ifconfig hme0 192.1.0.3 netmask 255.255.255.0 up

Purpose This task sets up a Solaris workstation for a craft connection to the 
ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note Enter an IP address that is identical to the ONS 15454 IP address except for the last octet. The 
last octet must be 1 or 3 through 254. 

Step 5 In the Subnet Mask field, type 255.255.255.0. Skip this step if you checked Craft Access Only on the 
Provisioning > Network > General > Gateway Settings tab.

Step 6 Test the connection:

a. Start Netscape Navigator.

b. Enter the ONS 15454 IP address in the web address (URL) field. If the connection is established, a 
Java Console window, CTC caching messages, and the Cisco Transport Controller Login dialog box 
appear. If this occurs, go to Step 2 of the “DLP-G46 Log into CTC” task on page 2-24 to complete 
the login. If the Login dialog box does not appear, complete Steps c and d.

c. At the prompt, type: 

ping ONS-15454-IP-address

For example, to connect to an ONS 15454 with a default IP address of 192.1.0.2, type:

ping 192.1.0.2

If your workstation is connected to the ONS 15454, the following message appears:

IP-address is alive

Note Skip this step if you checked the Craft Access Only check box at Provisioning > Network > 
General > Gateway Settings. 

d. If CTC is not responding, a “no answer from x.x.x.x” message appears. Verify the IP and subnet 
mask information. Check that the cables connecting the workstation to the ONS 15454 are securely 
attached. Check the link status by typing:

# ndd -set /dev/device instance 0

# ndd -get /dev/device link_status

For example:

# ndd -set /dev/hme instance 0

# ndd -get /dev/hme link_status

A result of “1” means the link is up. A result of “0” means the link is down.

Note Check the man page for ndd. For example, type: # man ndd.

Step 7 Return to your originating procedure (NTP).
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NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454

Step 1 If your computer is already connected to the corporate LAN, go to Step 3. If you changed your 
computer’s network settings for craft access to the ONS 15454, change the settings back to the corporate 
LAN access settings. This generally means:

• Set the IP Address on the TCP/IP dialog box back to Obtain an IP address automatically 
(Windows 98) or Obtain an IP address from a DHCP server (Windows NT 4.0, 2000, or XP). 

• If your LAN requires that Domain Name System (DNS) or Windows Internet Naming Service 
(WINS) be enabled, change the setting on the DNS Configuration or WINS Configuration tab of the 
TCP/IP dialog box. 

Step 2 Connect a straight-through (CAT-5) LAN cable from the PC or Solaris workstation NIC card to a 
corporate LAN port.

Step 3 If your computer is connected to a proxy server, disable proxy service or add the ONS 15454 nodes as 
exceptions. To disable proxy service, complete one of the following tasks, depending on the web browser 
that you use:

• DLP-G43 Disable Proxy Service Using Internet Explorer (Windows), page 2-22

• DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX), page 2-22

Step 4 Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-24.

Stop. You have completed this procedure.

Purpose This procedure sets up your computer to access the ONS 15454 through a 
corporate LAN. 

Tools/Equipment Network interface card (NIC), also referred to as an Ethernet card

Straight-through (CAT 5) LAN cable

Prerequisite Procedures • NTP-G17 Set Up Computer for CTC, page 2-1

• The ONS 15454 must be provisioned for LAN connectivity, including 
IP address, subnet mask, default gateway.

• The ONS 15454 must be physically connected to the corporate LAN.

• The CTC computer must be connected to the corporate LAN that has 
connectivity to the ONS 15454.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None
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DLP-G43 Disable Proxy Service Using Internet Explorer (Windows) 

Step 1 From the Start menu, select Settings > Control Panel.

Note If your computer is running Windows XP, you can select Control Panel directly from the Start 
menu. Make sure that you are in Classic View before continuing with this procedure.

Step 2 In the Control Panel window, choose Internet Options.

Step 3 In the Internet Properties dialog box, click Connections > LAN Settings.

Step 4 In the LAN Settings dialog box, complete one of the following tasks:

• Uncheck Use a proxy server to disable the service.

• Leave Use a proxy server selected and click Advanced. In the Proxy Setting dialog box under 
Exceptions, enter the IP addresses of ONS 15454 nodes that you will access. Separate each address 
with a semicolon. You can insert an asterisk (*) for the host number to include all the ONS 15454s 
on your network. Click OK to close each open dialog box.

Step 5 Return to your originating procedure (NTP).

DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX) 

Step 1 Open Netscape.

Step 2 From the Edit menu, choose Preferences.

Step 3 In the Preferences dialog box under Category, choose Advanced > Proxies.

Purpose This task disables proxy service for PCs running Internet Explorer. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed Required if your computer is connected to a network computer proxy 
server and your browser is Internet Explorer. 

Onsite/Remote Onsite or remote

Security Level None

Purpose This task disables proxy service for PCs and UNIX workstations running 
Netscape. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed Required if your computer is connected to a network computer proxy server 
and your browser is Netscape.

Onsite/Remote Onsite or remote

Security Level None
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Step 4 On the right side of the Preferences dialog box under Proxies, perform one of the following options:

• Choose Direct connection to the Internet to bypass the proxy server.

• Choose Manual proxy configuration to add exceptions to the proxy server, then click View. In the 
Manual Proxy Configuration dialog box under Exceptions, enter the IP addresses of the ONS 15454 
nodes that you will access. Separate each address with a comma. Click OK to close each open dialog 
box.

Step 5 Return to your originating procedure (NTP).

NTP-G20 Set Up a Remote Access Connection to the ONS 15454

Step 1 Connect the modem to the RJ-45 (LAN) port on the TCC2/TCC2P card or to the LAN pins on the 
ONS 15454 backplane (ANSI only) or the RJ-45 jack on the MIC-C/T/P FMEC (ETSI only).

Step 2 While referring to the modem documentation, complete the following tasks to provision the modem for 
the ONS 15454: 

• For CTC access, set the modem for Ethernet access.

• Assign an IP address to the modem that is on the same subnet as the ONS 15454.

• The IP address the modem assigns to the CTC computer must be on the same subnet as the modem 
and the ONS 15454.

Note For assistance on provisioning specific modems, contact the Cisco Technical Assistance Center 
(Cisco TAC). See the “Obtaining Technical Assistance” section on page lxxiv as needed.

Step 3 Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-24.

Stop. You have completed this procedure.

Purpose This procedure connects the CTC computer to an ONS 15454 using a LAN 
modem. To complete this procedure:

• A modem must be connected to the ONS 15454.

• The modem must be provisioned for ONS 15454. To run CTC, the 
modem must be provisioned for Ethernet access.

Tools/Equipment Modem and modem documentation

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-G21 Log into the ONS 15454 GUI

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. 

Note For information about navigating in CTC, see Appendix A, “CTC Information and Shortcuts.”

Step 2 As needed, complete the “DLP-G48 Create Login Node Groups” task on page 2-28. Login node groups 
allow you to manage nodes that are not connected to the login node through a data communications 
channel (DCC).

Step 3 As needed, complete the “DLP-G49 Add a Node to the Current Session or Login Group” task on 
page 2-29.

Step 4 As needed, complete the “DLP-G50 Delete a Node from the Current Session or Login Group” task on 
page 2-30.

Step 5 As needed, complete the “DLP-G51 Delete a Node from a Specified Login Node Group” task on 
page 2-30.

Step 6 As needed, complete the “DLP-G52 Change the JRE Version” task on page 2-31.

Step 7 As needed, complete the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task 
on page 2-32.

Stop. You have completed this procedure.

DLP-G46 Log into CTC

Purpose This procedure logs into CTC, the graphical user interface software used to 
manage the ONS 15454. This procedure includes optional node login tasks.

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

One of the following procedures:

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection 
to the ONS 15454, page 2-21

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, 
page 2-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task logs into CTC. 

Tools/Equipment None
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Note For information about CTC views and navigation, see Appendix A, “CTC Information and Shortcuts.”

Step 1 From the computer connected to the ONS 15454, start Netscape (PC or UNIX) or Internet Explorer (PC 
only):

• If you are using a PC, launch Netscape or Internet Explorer from the Windows Start menu or a 
shortcut icon.

• If you are using UNIX, launch Netscape from the command line by typing one of the following:

– To install Netscape colors for Netscape use, type:

# netscape -install

– To limit Netscape to 32 colors so that if the requested color is not available, Netscape chooses 
the closest color option, type:

netscape -ncols 32

Note CTC requires a full 24-color palette to run properly. When using color-intensive applications 
such as Netscape in UNIX, it is possible that UNIX might run out of colors to use for CTC. 
The -install and -ncols 32 command line options limit the number of colors that Netscape 
uses. 

Step 2 In the Netscape or Internet Explorer web address (URL) field, enter the ONS 15454 IP address. For 
initial setup, this is the default IP address, 192.1.0.2. (This IP address appears on the LCD. You can 
suppress the LCD IP address display using CTC after you log in. For more information, see the 
“DLP-G162 Change IP Settings” task on page 10-10.) 

Step 3 Press Enter.

Note If you are logging into ONS 15454 nodes in an operation network that are running different 
releases of CTC software, log into the node running the most recent release. If you log into a 
node running an older release, you will receive an INCOMPATIBLE-SW alarm for each node in 
the network running a new release, and CTC will not be able to manage these nodes. To check 
the software version of a node, select About CTC from the CTC Help menu. This will display 
the ONS 15454 software version for each node visible on the network view. If the node is not 
visible, the software version can be read from the LCD display. To resolve an alarm, refer to the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-1

One of the following procedures:

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection 
to the ONS 15454, page 2-21

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, 
page 2-23

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
2-25
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 2      Connect the PC and Log into the GUI
Before You Begin
Step 4 If a Java Plug-in Security Warning dialog box appears, complete the “DLP-G47 Install Public-Key 
Security Certificate” task on page 2-27 to install the public-key security certificate required by Software 
Release 4.1 and later.

After you complete the security certificate dialog box (or if the certificate is already installed), a Java 
Console window displays the CTC file download status. The web browser displays information about 
your Java and system environments. If this is the first login, CTC caching messages appear while CTC 
files are downloaded to your computer. The first time you connect to an ONS 15454, this process can 
take several minutes. After the download, the CTC Login dialog box appears (Figure 2-1).

Figure 2-1 Logging into CTC

Note When the CTC Login dialog box appears, it might be minimized.

Step 5 In the Login dialog box, type a user name and password (both are case sensitive). For initial setup, type 
the user name CISCO15 and the password otbu+1.

Note The CISCO15 user is provided with every ONS 15454. CISCO15 has Superuser privileges, so 
you can create other users. You must create another Superuser before you can delete the 
CISCO15 user. CISCO15 is delivered with the otbu+1 password. To change the password for 
CISCO15, click the Provisioning > Security tabs after you log in and change the password. To 
set up ONS 15454 users and assign security, go to the “NTP-G23 Create Users and Assign 
Security” procedure on page 3-5. Additional information about security is provided in the 
“19.1 Users and Security” section on page 19-1.

Step 6 Each time you log into an ONS 15454, you can make selections on the following login options:

• Node Name—Displays the IP address entered in the web browser and a drop-down list of previously 
entered ONS 15454 IP addresses. You can select any ONS 15454 on the list for the login, or you can 
enter the IP address (or node name) of any new node where you want to log in.
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• Additional Nodes—Displays a list of current login node groups. To create a login node group or add 
additional groups, see the “DLP-G48 Create Login Node Groups” task on page 2-28.

• Disable Network Discovery—Check this box to view only the ONS 15454 (and login node group 
members, if any) entered in the Node Name field. Nodes linked to this node through DCCs are not 
discovered and will not appear in CTC network view. Using this option can decrease the CTC startup 
time in networks with many DCC-connected nodes, and can reduce memory consumption. 

• Disable Circuit Management—Check this box to disable discovery of existing circuits. Using this 
option can decrease the CTC initialization time in networks with many existing circuits and reduce 
memory consumption. This option does not prevent the creation and management of new circuits.

Step 7 Click Login.

If the login is successful, the CTC window appears. From here, you can navigate to other CTC views to 
provision and manage the ONS 15454. If you need to turn up the shelf for the first time, see Chapter 3, 
“Turn Up a Node.” If login problems occur, refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide.

Step 8 Return to your originating procedure (NTP).

DLP-G47 Install Public-Key Security Certificate

Step 1 If the Java Plug-in Security Warning dialog box appears, choose one of the following options:

Note The Java Plug-in Security Warning dialog box options that appear depend on the JRE version 
you are using. If you installed JRE 1.4.2, you will see the following options: Yes, No, Always, 
and More Details. If you are using JRE 1.3.1_02, you will see the following options (noted below 
in parentheses): Grant This Session, Deny, Grant Always, and View Certificate.

• Yes (Grant This Session)—Installs the public-key certificate to your PC only for the current session. 
After the session is ended, the certificate is deleted. This dialog box will appear the next time you 
log into the ONS 15454.

• No (Deny)—Denies permission to install the certificate. If you choose this option, you cannot log 
into the ONS 15454. 

• Always (Grant Always)—Installs the public-key certificate and does not delete it after the session 
is over. Cisco recommends this option.

• More Details (View Certificate)—Allows you to view the public-key security certificate.

Purpose This task installs the ITU Recommendation X.509 public-key security 
certificate. The public-key certificate is required to run Software 
Release 4.1 or later.

Tools/Equipment None

Prerequisite Procedures This task is performed during the “DLP-G46 Log into CTC” task on 
page 2-24. You cannot perform it outside of this task.

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Return to your originating procedure (NTP).

DLP-G48 Create Login Node Groups

Step 1 From the Edit menu in node view, choose Preferences.

Step 2 Click Login Node Group and Create Group.

Step 3 Enter a name for the group in the Create Login Group Name dialog box. Click OK.

Step 4 In the Members area, type the IP address (or node name) of a node you want to add to the group. Click 
Add. Repeat this step for each node that you want to add to the group.

Step 5 Click OK. 

The next time you log into an ONS 15454, the login node group will be available in the Additional Nodes 
list of the Login dialog box. For example, in Figure 2-2, a login node group is created that contains the 
IP addresses for Nodes 1, 4, and 5. During login, if you choose this group from the Additional Nodes 
list and Disable Network Discovery is not selected, all nodes in the figure appear. If the login group and 
Disable Network Discovery are both selected, only Nodes 1, 4, and 5 appear. You can create as many 
login groups as you need. The groups are stored in the CTC preferences file and are not visible to other 
users.

Purpose This task creates a login node group to display ONS 15454s that have an IP 
connection but not a DCC connection to the login node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 2-2 Login Node Group 

Step 6 Return to your originating procedure (NTP).

DLP-G49 Add a Node to the Current Session or Login Group

Step 1 From the CTC File menu, click Add Node.

Step 2 In the Add Node dialog box, enter the node name (or IP address).

Step 3 If you want to add the node to the current login group, check Add to current login node group. 
Otherwise, leave it unchecked.

Note This check box is active only if you selected a login group when you logged into CTC. 

Step 4 Click OK. 

Purpose This task adds a node to the current CTC session or login node group.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

LAN/WAN (Ethernet)

Three node ring Single

Laptop PC

Node 1
IP Address

192.168.106.143

Node 4
IP Address

192.168.105.119

Node 5
IP Address

192.168.104.109

Node 6
IP Address

192.168.103.199

Node 3Node 2

IP Address
192.168.106.100

55
02

9

Two node ring
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After a few seconds, the new node appears on the network view map.

Step 5 Return to your originating procedure (NTP).

DLP-G50 Delete a Node from the Current Session or Login Group

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the node that you want to delete. 

Step 3 From the CTC File menu, click Delete Selected Node.

After a few seconds, the node disappears from the network view map.

Step 4 Return to your originating procedure (NTP).

DLP-G51 Delete a Node from a Specified Login Node Group

Step 1 From the CTC Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Login Node Groups tab.

Step 3 Click the login node group tab containing the node you want to remove. 

Step 4 Click the node you want to remove, then click Remove.

Step 5 Click OK.

Purpose This task removes a node from the current CTC session or login node 
group. To remove a node from a login node group that is not the current 
one, see “DLP-G51 Delete a Node from a Specified Login Node Group” 
task on page 2-30.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task removes a node from a specified login node group. To remove a 
node from the current login node group, see the “DLP-G50 Delete a Node 
from the Current Session or Login Group” task on page 2-30.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Return to your originating procedure (NTP).

DLP-G52 Change the JRE Version

Note This task is not used in Release 5.0 because only one JRE version is supported. This task is used in CTC 
releases that support multiple JRE versions.

Step 1 From the Edit menu, choose Preferences.

Step 2 Click the JRE tab. The JRE tab shows the current JRE version and the recommended version.

Step 3 Click the Browse button and navigate to the JRE directory on your computer.

Step 4 Choose the JRE version.

Step 5 Click OK. 

Step 6 From the File menu, choose Exit. 

Step 7 In the confirmation dialog box, click Yes.

Step 8 Return to your originating procedure (NTP).

Purpose This task changes the JRE version, which is useful if you would like to 
upgrade to a later JRE version from an earlier one without using the 
software or documentation CD. This does not affect the browser default 
version. After selecting the desired JRE version, you must exit CTC. The 
next time you log into a node, the new JRE version will be used.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup

Step 1 Click the CTC Alerts toolbar icon. 

Step 2 In the CTC Alerts dialog box, choose one of the following:

• All alerts—Sets the CTC Alerts dialog box to open automatically for all notifications.

• Error alerts only—Sets the CTC Alerts dialog box to open automatically for circuit deletion errors 
only.

• Never—Sets the CTC Alerts dialog box to never open automatically.

Step 3 Click Close.

Step 4 Return to your originating procedure (NTP).

Purpose This task sets up the CTC Alerts dialog box to open for all alerts, for circuit 
deletion errors only, or never. The CTC Alerts dialog box displays network 
disconnection, Send-PDIP inconsistency, circuit deletion status, condition 
retrieval errors, and software download failure.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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C H A P T E R 3

Turn Up a Node

This chapter explains how to provision a single Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) node and turn it up for service, including node name, date and time, timing 
references, network attributes such as IP address and default router, users and user security, card 
installation, and DWDM connections.

Note Procedures in this chapter require that you have a network plan calculated for your DWDM network with 
Cisco MetroPlanner, Release 2.5. Cisco MetroPlanner is a DWDM planning tool that is available from 
your Cisco account representative. Cisco MetroPlanner prepares a shelf plan for each network node and 
calculates the power and attenuation levels for the DWDM cards installed in the node. For information 
about Cisco MetroPlanner, contact your Cisco account representative. For more information about 
MetroPlanner, refer to the Cisco MetroPlanner DWDM Installation and Operations Guide, Release 2.5.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI (ONS 15454) and ETSI 
(ONS 15454 SDH) shelf assemblies.

Note Procedures in the chapter must be completed at every shelf (node) at your site.

Before You Begin
This section lists the non-trouble procedures (NTPs) that you need to complete to turn up a DWDM node. 
Turn to a procedure for applicable detailed level procedures (DLPs).

1. NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2—Complete this procedure first.

1. NTP-G22 Verify Common Card Installation, page 3-4—Complete this procedure next.

2. NTP-G23 Create Users and Assign Security, page 3-5—Complete this procedure to create Cisco 
Transport Controller (CTC) users and assign their security levels.

3. NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-8—Continue with this 
procedure to set the node name, date, time, location, and contact information.

4. NTP-G25 Set Power Monitor Thresholds, page 3-9—Continue with this procedure to set the node 
battery power thresholds.
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5. NTP-G26 Set Up CTC Network Access, page 3-10—Continue with this procedure to provision the 
IP address, default router, subnet mask, and network configuration settings.

6. NTP-G27 Set Up the ONS 15454 for Firewall Access, page 3-21—Continue with this procedure to 
provision the IP address, default router, subnet mask, and network configuration settings.

7. NTP-G28 Set Up SNMP, page 3-24—Complete this procedure if simple network management 
protocol (SNMP) will be used for network monitoring.

8. NTP-G29 Preprovision a Slot, page 3-26—Complete this procedure to preprovision the ONS 15454 
slots. 

9. NTP-G30 Install the DWDM Cards, page 3-27—Complete this procedure to install the DWDM 
cards, including the OSCM, OSC-CSM, 32WSS, OPT-BST, OPT-PRE, 32-MUX-O, 32-DMX-O, 
and 32DMX.

10. NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-30—Complete this procedure 
to install a dispersion compensating unit.

11. NTP-G32 Install the Transponder and Muxponder Cards, page 3-31—Complete this procedure to 
install TXP and MXP cards.

12. NTP-G123 Install the Filler Cards, page 3-35—Complete this procedure to install ONS 15454 filler 
cards.

13. NTP-G33 Create a Y-Cable Protection Group, page 3-36—Complete this procedure, as needed, for 
TXP and MXP cards that will be protected with Y-cable protection.

14. NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-39—Complete this 
procedure, as needed, to install the fiber-optic cables on the DWDM cards.

15. NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, or ROADM Node and the 
Transponder Cards, page 3-63—Complete this procedure, as needed, to connect TXP cards to a 
terminal, hub, or ROADM node.

16. NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules, page 3-69—Complete this 
procedure, as needed, to connect fiber-optic cables to Y-Cable modules from TXP cards and the 
client signal.

17. NTP-G36 Calculate Cable Connections, page 3-70—Complete this procedure to calculate the 
DWDM cable connections.

18. NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-72—Complete this procedure 
next.

19. NTP-G37 Run Automatic Node Setup, page 3-73—Complete this procedure next.

20. NTP-G39 Verify OSCM and OSC-CSM Transmit Power, page 3-76—Complete this procedure next.

NTP-G139 Verify Cisco MetroPlanner Reports and Files

Purpose This procedure verifies that you have the Cisco MetroPlanner reports and 
files needed to turn up the node.

Tools/Equipment None

Prerequisite Procedures Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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Step 1 Verify that you have the Cisco MetroPlanner reports and files shown in Table 3-1 for the node you will 
provision. The reports and files can be provided in one of the following options:

• If you have Cisco MetroPlanner, verify that you have the electronic network design plan from which 
you can generate the reports in MetroPlanner. For information about generating the reports, refer to 
the Cisco MetroPlanner DWDM Operations Guide. 

• If you do not have Cisco MetroPlanner, you must have printouts of the reports listed in Table 3-1 
except the Assisted Configuration Setup file. Assisted Configuration Setup is an electronic file that 
will be imported into CTC. You must be able to access it from the CTC computer used to provision 
the node.

Table 3-1 Cisco MetroPlanner Node Setup Information and Files 

Source Format Description Yes No

Shelf layout Table or JPG 
file

Cisco MetroPlanner provides a shelf layout (Figure 3-1) showing 
the cards that should be installed in each ONS 15454 slot. Cisco 
MetroPlanner can export this as a table, “Layout Table [site 
name],” or as a JPG file with a user-defined name. 

Installation Parameters Table Provides the target reference values for the variable optical 
attenuators (VOAs) and output power, optical thresholds and 
amplifier configuration parameters.

Internal Connections Table Identifies the patch cords that must be installed within the shelf.

Assisted Configuration 
Setup

TXT file This is an electronic file with a TXT extension and a name 
corresponding to the node you are setting up. The file is imported 
into CTC where it configures the node parameters based on the 
network calculated by Cisco MetroPlanner.

Traffic Matrix Table Shows the traffic flow within the node. During node turnup, this 
report is used to identify the location of Y-cable protection groups

Cable list Table or list A list of cables needed to provision the node. The list can be 
derived from the Internal Connections table or from the Bill of 
Materials report prepared by Cisco MetroPlanner.
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Figure 3-1 Cisco MetroPlanner Shelf Layout

If you not do not have all the reports and files listed in Table 3-1, do not continue. See your site or 
network planner for the required information and files.

Step 2 Print Table 3-1 for reference. You will need information from the reports during node turnup.

Stop. You have completed this procedure.

NTP-G22 Verify Common Card Installation

Step 1 Verify that two TCC2/TCC2P cards are installed in Slots 7 and 11.

Step 2 Verify that the green ACT (active) LED is illuminated on one TCC2/TCC2P and the amber STBY 
(standby) LED is illuminated on the second TCC2/TCC2P. 

Purpose This procedure verifies that the ONS 15454 node has two TCC2/TCC2P 
cards installed and is ready for turn up.

Tools/Equipment

Prerequisite Procedures Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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Note If the TCC2/TCC2P cards are not installed, or if their LEDs are not operating as described, do 
not continue. Repeat the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-70 or refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide to resolve installation problems before proceeding to Step 3.

Step 3 If Alarm Interface Controller-International (AIC-I) card is installed, verify that it is installed in Slot 9 
and its ACT (active) LED displays a solid green light.

Step 4 Verify that the software release shown on the LCD matches the software release indicated in your site 
plan. If the release does not match, perform one of the following procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD. Refer to the release-specific 
software upgrade document.

• Replace the TCC2/TCC2P cards with cards containing the correct release.

Stop. You have completed this procedure.

NTP-G23 Create Users and Assign Security

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you need to create users. 
If you are already logged in, continue with Step 2.

Note You must log in as a Superuser to create additional users. The CISCO15 user provided with each 
ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one 
ONS 15454.

Step 2 Complete the “DLP-G54 Create a New User on a Single Node” task on page 3-6 or the “DLP-G55 Create 
a New User on Multiple Nodes” task on page 3-6 as needed.

Note You must add the same user name and password to each node a user will access.

Step 3 If you want to modify the security policy settings, including password aging and idle user timeout 
policies, complete the “NTP-G88 Modify Users and Change Security” procedure on page 10-35.

Stop. You have completed this procedure.

Purpose This procedure creates ONS 15454 users and assigns their security levels.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G54 Create a New User on a Single Node

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 In the Users window, click Create.

Step 3 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 6 to 10 
characters.

• Password—Type the user password. The password must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) and special (+, #,%) characters, where at least two characters are non 
alphabetic and at least one character is a special character. For TL1 compatibility, the password must 
be 6 to 10 characters. 

Note The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. See the “19.1 Users and Security” section on page 19-1 for 
information about the capabilities provided with each level.

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before the password must be reentered. The defaults are: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. 
To change the idle times, see the “NTP-G88 Modify Users and Change Security” procedure on 
page 10-35.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-G55 Create a New User on Multiple Nodes

Purpose This task creates a new user for one ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task adds a new user to multiple ONS 15454 nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24 
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Note All nodes where you want to add users must be accessible in network view.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Users tabs.

Step 3 In the Users window, click Create.

Step 4 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must 
6 to 10 characters.

• Password—Type the user password. The password must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) and special (+, #, %) characters, where at least two characters are 
non alphabetic and at least one character is a special character. For TL1 compatibility, the password 
must be 6 to 10 characters. The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. Refer to the “19.1 Users and Security” section on page 19-1 
for information about the capabilities provided with each level.

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before it locks up and the password must be reentered. The defaults are: Retrieve 
user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and 
Superuser = 15 minutes. To change the idle times, refer to the “NTP-G88 Modify Users and 
Change Security” procedure on page 10-35.

Step 5 Under “Select applicable nodes,” deselect any nodes where you do not want to add the user (all network 
nodes are selected by default).

Step 6 Click OK.

Step 7 In the User Creation Results dialog box, verify that the user was added to all the nodes chosen in Step 5. 
If not, click OK and repeat Steps 2 through 6. If the user was added to all nodes, click OK and continue 
with the next step.

Step 8 Return to your originating procedure (NTP).

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-G24 Set Up Name, Date, Time, and Contact Information

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 for the node you will turn up. If you are 
already logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > General tabs.

Step 3 Enter the following information in the fields listed:

• Node Name—Type a name for the node. For TL1 compliance, names must begin with an alpha 
character and have no more than 20 alphanumeric (a-z, A-Z, 0-9) characters.

Note To avoid errors when you import the Cisco MetroPlanner configuration file in the 
“NTP-G138 Import a Cisco MetroPlanner Configuration File” procedure on page 3-72, the 
CTC node name and the MetroPlanner site name should be the same or at least easy to 
identify.

• Contact—Type the name of the node contact person and the phone number, up to 255 characters 
(optional).

• Latitude—Enter the node latitude: N (north) or S (south), degrees, and minutes (optional).

• Longitude—Enter the node longitude: E (east) or W (west), degrees, and minutes (optional).

CTC uses the latitude and longitude to position ONS 15454 icons on the network view map. To 
convert a coordinate in degrees to degrees and minutes, multiply the number after the decimal by 
60. For example, the latitude 38.250739 converts to 38 degrees, 15 minutes (0.250739 x 60 = 
15.0443, rounded to the nearest whole number).

• Description—Type a description of the node. The description can be a maximum of 255 characters. 

• Use NTP/SNTP Server—When checked, CTC uses a Network Time Protocol (NTP) or Simple 
Network Time Protocol (SNTP) server to set the date and time of the node. 

If you do not use an SNTP or NTP server, complete the Date and Time fields. The ONS 15454 will 
use these fields for alarm dates and times. By default, CTC displays all alarms in the CTC computer 
time zone for consistency. To change the display to the node time zone, complete the “DLP-G118 
Display Alarms and Conditions Using Time Zone” task on page 8-10

Note Using an NTP or SNTP server ensures that all ONS 15454 network nodes use the same date 
and time reference. The server synchronizes the node’s time after power outages or software 
upgrades.

If you check the Use NTP/SNTP Server check box, type the IP address of one of the following:

Purpose This procedure provisions identification information for the node, 
including the node name, a contact name and phone number, the location 
of the node, and the date, time, and time zone. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– An NTP/SNTP server connected to the ONS 15454

– Another ONS 15454 with NTP/SNTP enabled that is connected to the ONS 15454

If you check gateway network element (GNE) for the ONS 15454 SOCKS proxy server (see 
“DLP-G56 Provision IP Settings” task on page 3-11), external ONS 15454 nodes must reference the 
gateway ONS 15454 for NTP/SNTP timing. For more information about the ONS 15454 gateway 
settings, see Chapter 20, “CTC Connectivity Reference.”

Caution If you reference another ONS 15454 for the NTP/SNTP server, make sure the second ONS 15454 
references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing 
loop by having two ONS 15454 nodes reference each other).

• Date—If Use NTP/SNTP Server is not checked, type the current date in the format m/d/yyyy, for 
example, September 24, 2002 is 9/24/2002.

• Time—If Use NTP/SNTP Server is not checked, type the current time in the format hh:mm:ss, for 
example, 11:24:58. The ONS 15454 uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.

• Time Zone—Click the field and choose a city within your time zone from the drop-down list. The 
menu displays the 80 World Time Zones from –11 through 0 (GMT) to +14. Continental United 
States time zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07:00 (Mountain), and 
GMT-08:00 (Pacific).

• Use Daylight Savings Time—Check this check box if the time zone that you chose is using Daylight 
Savings Time.

• Insert AIS-V on STS-1 SD-P—Not used in DWDM networks.

• SD-P BER—Not used in DWDM networks.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Review the node information. If you need to make corrections, repeat Steps 3 through 5 to enter the 
corrections. If the information is correct, continue with the “NTP-G25 Set Power Monitor Thresholds” 
procedure on page 3-9.

Stop. You have completed this procedure.

NTP-G25 Set Power Monitor Thresholds

Purpose This procedure provisions extreme high, extreme low, and low input 
battery power thresholds within a –48 volts direct current (VDC) 
environment. When the thresholds are crossed, the TCC2/TCC2P 
generates warning alarms in CTC. For ONS 15454 power specifications, 
see Appendix B, “Hardware Specifications.”

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution The default battery power thresholds are normally not changed. Threshold changes should only be 
performed at the direction of your site administrator.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 for the node you will set up. If you are already 
logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > General > Power Monitor tabs.

Step 3 To change the extreme low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
ELWBATVGVdc drop-down list.

Step 4 To change the low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
LWBATVGVdc drop-down list.

Step 5 To change the high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
HIBATVGVdc drop-down list.

Step 6 To change the extreme high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
EHIBATVGVdc drop-down list.

Step 7 Click Apply.

Stop. You have completed this procedure.

NTP-G26 Set Up CTC Network Access

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G56 Provision IP Settings” task on page 3-11 to provision the ONS 15454 IP 
address, subnet mask, default router, DHCP server, IIOP listener port, and SOCKS proxy server settings.

Tip If you cannot log into the node, you can change its IP address, default router, and network mask 
by using the LCD on the ONS 15454 fan-tray assembly (unless LCD provisioning is 
suppressed). See the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using 
the LCD” task on page 3-14 for instructions. However, you cannot use the LCD to provision any 
other network settings.

Purpose This procedure provisions network access for a node, including its subnet 
mask, default router, Dynamic Host Configuration Protocol (DHCP) 
server, IIOP (Internet Inter-Orb Protocol) listener port, gateway settings, 
static routes, Open Shortest Path First (OSPF) protocol, and Routing 
Information Protocol (RIP).

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 3 If TCC2P cards are installed and you want to turn on the ONS 15454 secure mode, which allows two IP 
addresses to be provisioned for the node, complete the “DLP-G264 Enable Node Security Mode” task 
on page 3-16.

Note Secure mode is not available if TCC2 cards are installed.

Step 4 If static routes are needed, complete the “DLP-G58 Create a Static Route” task on page 3-17. For more 
information about static routes, see Chapter 20, “CTC Connectivity Reference.” 

Step 5 If the ONS 15454 is connected to a LAN or WAN that uses OSPF and you want to share routing 
information between the LAN/WAN and the ONS network, complete the “DLP-G59 Set Up or Change 
Open Shortest Path First Protocol” task on page 3-18.

Step 6 If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-G60 Set Up or 
Change Routing Information Protocol” task on page 3-20.

Stop. You have completed this procedure.

DLP-G56 Provision IP Settings

Caution All network changes should be approved by your network (or LAN) administrator.

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 Complete the following information in the fields listed:

• IP Address—Type the IP address assigned to the ONS 15454 node.

• Suppress CTC IP Display—Check this check box if you want to prevent the node IP address from 
being displayed in CTC to users with Provisioning, Maintenance, or Retrieve security levels. (The 
IP address suppression is not applied to users with Superuser security level.)

• LCD IP Display—Choose one of the following:

– Allow Configuration—Displays the node IP address on the LCD and allows users to change the 
IP settings using the LCD. This option enables the “DLP-G57 Set the IP Address, Default 
Router, and Network Mask Using the LCD” task on page 3-14.

– Display Only—Displays the node IP address on the LCD but does not allow users to change the 
IP address using the LCD.

– Suppress Display—Suppresses the node IP address display on the LCD.

Purpose This task provisions IP settings, which includes the IP address, default 
router, DHCP access, firewall access, and SOCKS proxy server settings for 
an ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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• Default Router—If the ONS 15454 is connected to a LAN, enter the IP address of the default router. 
The default router forwards packets to network devices that the ONS 15454 cannot directly access. 
This field is ignored if any of the following are true:

– The ONS 15454 is not connected to a LAN.

– SOCKS proxy server is enabled and the ONS 15454 is provisioned as an ENE.

– OSPF is enabled on both the ONS 15454 and the LAN where the ONS 15454 is connected.

• Forward DHCP Request To—Check this check box to enable DHCP. Also, enter the DHCP server 
IP address in the Request To field. Unchecked is the default. If you will enable any of the gateway 
settings to implement the ONS 15454 SOCKS proxy server features, leave this field blank.

Note If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP 
addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it 
does not act as a DHCP server.

• MAC Address—(Display only) Displays the ONS 15454 IEEE 802 MAC address.

• Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet 
mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is 
the same for all ONS 15454 nodes in the same subnet.

• TCC CORBA (IIOP) Listener Port—Sets the ONS 15454 IIOP (Internet Inter-Orb Protocol) listener 
port used for communication between the ONS 15454 and CTC computers. This field is generally 
not changed unless the ONS 15454 resides behind a firewall that requires a different port. See the 
“NTP-G27 Set Up the ONS 15454 for Firewall Access” procedure on page 3-21 for more 
information.

• Gateway Settings—Provisions the ONS 15454 SOCKS proxy server features. (SOCKS is a standard 
proxy protocol for IP-based applications.) Do not change these options until you review the 
“20.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server” section on page 20-12. In SOCKS 
proxy server networks, the ONS 15454 is either an external network element (ENE), a gateway 
network element (GNE), or a proxy-only server. Provisioning must be consistent for each NE type.

• Enable SOCKS proxy server on port—If checked, the ONS 15454 serves as a proxy for connections 
between CTC clients and ONS 15454 nodes that are connected by data communications channels 
(DCCs) to the proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes 
through the proxy node. The CTC client does not require IP connectivity to the DCC-connected 
nodes, only to the proxy ONS 15454. If Enable SOCKS proxy server on port is off, the node does 
not proxy for any CTC clients. When this box is checked, you can provision one of the following 
options:

– External Network Element (ENE)—Choose this option when the ONS 15454 is not connected 
to a LAN but has DCC connections to other ONS nodes. A CTC computer connected to the ENE 
through the TCC2/TCC2P TCP/IP (craft) port can manage nodes that have DCC connections to 
the ENE. However, the CTC computer does not have direct IP connectivity to these nodes or to 
any LAN/WAN that those nodes might be connected to.

– Gateway Network Element (GNE)—Choose this option when the ONS 15454 is connected to a 
LAN and has DCC connections to other nodes. A CTC computer connected to the LAN can 
manage all nodes that have DCC connections to the GNE, but the CTC computer does not have 
direct IP connectivity to them. The GNE option isolates the LAN from the DCC network so that 
IP traffic originating from the DCC-connected nodes and any CTC computers connected to 
them is prevented from reaching the LAN.
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– SOCKS Proxy-Only—Choose this option when the ONS 15454 is connected to a LAN and the 
LAN is separated from the node by a firewall. The SOCKS Proxy Only is the same as the GNE 
option, except the SOCKS Proxy Only option does not isolate the DCC network from the LAN.

Step 3 Click Apply.

Step 4 Click Yes in the confirmation dialog box.

Both TCC2/TCC2P cards reboot, one at a time. During this time (approximately 5 minutes), the active 
and standby TCC2/TCC2P card LEDs go through the cycle shown in Table 3-2. Eventually, a “Lost node 
connection, switching to network view” message appears.

Table 3-2 LED Behavior During TCC2/TCC2P Reboot

Reboot Activity Active TCC2/TCC2P LEDs Standby TCC2/TCC2P LEDs

Standby TCC2/TCC2P card updated 
with new network information.

Memory test (1 to 2 minutes).

If an AIC or AIC-I card is installed, 
AIC FAIL and alarm LEDs light up 
briefly when the AIC is updated. 

The standby TCC2/TCC2P becomes 
the active TCC2/TCC2P.

ACT/STBY: Flashing green. 1. ACT/STBY: Flashing yellow.

2. FAIL LED: Solid red.

3. All LEDs on except ACT/STBY.

4. CRIT turns off.

5. MAJ and MIN turn off.

6. REM, SYNC, and ACO turn off.

7. All LEDs (except A&B PWR) 
turn off (1 to 2 minutes).

8. ACT/STBY: Solid yellow.

9. Alarm LEDs: Flash once.

10. ACT/STBY: Solid green.

Memory test (1 to 2 minutes).

TCC2/TCC2P updated with new 
network information.

The active TCC2/TCC2P becomes the 
standby TCC2/TCC2P.

1. All LEDs: Turn off (1 to 2 minutes). 
CTC displays “Lost node connection, 
switching to network view” message.

2. FAIL LED: Solid red.

3. FAIL LED: Flashing red.

4. All LEDs on except ACT/STBY.

5. CRIT turns off.

6. MAJ and MIN turn off.

7. REM, SYNC, and ACO turn off; all 
LEDs are off.

8. ACT/STBY: Solid yellow.

9. ACT/STBY: Flashing yellow.

10. ACT/STBY: Solid yellow.

ACT/STBY: Solid green.
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Step 5 Click OK. The network view appears. The node icon appears in gray, during which time you cannot 
access the node.

Step 6 Double-click the node icon when it becomes green. 

Step 7 Return to your originating procedure (NTP). 

DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD

Note You cannot perform this task if the LCD IP Display on the node view Provisioning > Network tab is set 
to Display Only or Suppress Display. See the “DLP-G56 Provision IP Settings” task on page 3-11 to 
view or change the LCD IP Display field.

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until Node appears on the LCD.

Step 2 Repeatedly press the Port button until the following displays:

• To change the node IP address, Status=IpAddress (Figure 3-2)

• To change the node network mask, Status=Net Mask

• To change the default router IP address, Status=Default Rtr

Figure 3-2 Selecting the IP Address Option

Step 3 Press the Status button to display the node IP address (Figure 3-3), the node subnet mask length, or the 
default router IP address.

Purpose This task changes the ONS 15454 IP address, default router, and network 
mask using the LCD on the fan-tray assembly. Use this task if you cannot 
log into CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-70

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

FAN FAIL

Slot

Slot-0
Status=IpAddress

44
08

9CRIT MAJ MIN

Status Port
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Figure 3-3 Changing the IP Address

Step 4 Push the Slot button to move to the IP address or subnet mask digit you need to change. The selected 
digit flashes.

Tip The Slot, Status, and Port button positions correspond to the command position on the LCD. For 
example, in Figure 3-3, you press the Slot button to invoke the Next command and the Port 
button to invoke the Done command.

Step 5 Press the Port button to cycle the IP address or subnet mask to the correct digit.

Step 6 When the change is complete, press the Status button to return to the Node menu.

Step 7 Repeatedly press the Port button until the Save Configuration option appears (Figure 3-4).

Figure 3-4 Selecting the Save Configuration Option 

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 3-5).

Figure 3-5 Saving and Rebooting the TCC2/TCC2P

Step 9 Press the Slot button to apply the new IP address configuration or press Port to cancel the configuration.

Saving the new configuration causes the TCC2/TCC2P cards to reboot. During the reboot, a “Saving 
Changes - TCC Reset” message displays on the LCD. The LCD returns to the normal alternating display 
after the TCC2/TCC2P reboot is complete.

Note The IP address and default router must be on the same subnet. If not, you cannot apply the 
configuration. 

FAN FAIL

Slot

172.020.214.107
<Next   Done      Mod>

44
09

0CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Slot-0
Status=Save Cfg.

44
09

1CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Save and REBOOT?
<Apply            Revert>

44
09

2CRIT MAJ MIN

Status Port
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Step 10 Return to your originating procedure (NTP).

DLP-G264 Enable Node Security Mode

Note This task requires TCC2P cards. The security mode options described in this task will not appear in CTC 
if TCC2 cards are installed.

Caution The IP address assigned to the TCC2P LAN port must reside on a different subnet from the backplane 
LAN port and the ONS 15454 default router. Verify that the new TCC2P IP address meets this 
requirement and is compatible with ONE 15454 network IP addresses.

Note The node will reboot after you complete this task, causing a temporary disconnection between the CTC 
computer and the node.

Step 1 Click the Provisioning > Security > Data Comm tabs. 

Step 2 Click Change Mode.

Step 3 Review the information on the Change Secure Mode wizard page, then click Next.

Step 4 On the TCC Ethernet Port page, enter the IP address and subnet mask for the TCC2P LAN (TCP/IP) port. 
The IP address cannot reside on the same subnet as the backplane LAN port, nor the ONS 15454 default 
router.

Step 5 Click Next.

Step 6 On the Backplane Ethernet Port page, modify the backplane IP address, subnet mask, and default router, 
if needed. (You normally do not modify these fields if no ONS 15454 network changes have occurred.)

Step 7 Click Next. 

Step 8 On the SOCKS Proxy Server Settings page, choose one of the following options:

Purpose This task enables the ONS 15454 security mode. When security mode is 
enabled, two IP addresses are assigned to the node. One address is assigned 
to the backplane LAN port and the other to the TCC2P RJ-45 TCP/IP 
(LAN) port. 

Tools/Equipment TCC2P cards must be installed.

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• External Network Element (ENE)—If selected, the CTC computer is only visible to the ONS 15454 
to which the CTC computer is connected. The computer is not visible to the DCC-connected nodes. 
In addition, firewall is enabled, which means that the node prevents IP traffic from being routed 
between the DCC and the LAN port. 

• Gateway Network Element (GNE)—If selected, the CTC computer is visible to other 
DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the 
LAN port. 

Note The SOCKS proxy server is automatically enabled when you enable secure mode.

Step 9 Click Finish.

Within the next 30-40 seconds, the TCC2Ps reboot. CTC switches to network view, and the CTC Alerts 
dialog box appears. In network view, the node changes to grey and a DISCONNECTED condition 
appears. 

Step 10 On the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This may take several minutes.) 

Step 11 After the DISCONNECTED condition clears, complete the following steps to suppress the backplane IP 
address from display in CTC and the LCD. If you do not want to suppress the backplane IP address 
display, continue with Step 12

a. Display the node in node view.

b. Click the Provisioning > Security > Data Comm tabs. 

c. On the LCD IP Setting field, choose Suppress Display. This removes the IP address from display 
on the ONS 15454 LCD.

d. Check the Suppress CTC IP Address check box. This removes the IP address from display in the 
CTC information area and from the Provisioning > Security > Data Comm tab.

e. Click Apply.

Note After you turn on secure mode, the TCC2P IP address becomes the node IP address.

Step 12 Return to your originating procedure (NTP).

DLP-G58 Create a Static Route

Purpose This task creates a static route to establish CTC connectivity to a computer 
on another network. This task is performed when:

• CTC computers on one subnet need to connect to ONS 15454 nodes 
that are connected by a router to ONS 15454 nodes residing on another 
subnet. OSPF is not enabled and the External Network Element 
gateway setting is not checked.

• You need to enable multiple CTC sessions among ONS 15454 nodes 
residing on the same subnet and the External Network Element 
gateway setting is not enabled.

Tools/Equipment None
3-17
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 3      Turn Up a Node
Before You Begin
Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Click the Static Routing tab. Click Create.

Step 3 In the Create Static Route dialog box, enter the following: 

• Destination—Enter the IP address of the computer running CTC. To limit access to one computer, 
enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on 
the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a 
destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

• Mask—Enter a subnet mask. If the destination is a host route (that is, one CTC computer), enter a 
32-bit subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask 
accordingly, for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a 
subnet mask of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

• Next Hop—Enter the IP address of the router port or the node IP address if the CTC computer is 
connected to the node directly.

• Cost—Enter the number of hops between the ONS 15454 and the computer. 

Step 4 Click OK. Verify that the static route appears in the Static Route window.

Note Static route networking examples are provided in Chapter 20, “CTC Connectivity Reference.”

Step 5 Return to your originating procedure (NTP).

DLP-G59 Set Up or Change Open Shortest Path First Protocol

Step 1 In node view, click the Provisioning > Network > OSPF tabs.

Step 2 On the top left side of the OSPF pane, complete the following:

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables the Open Shortest Path First (OSPF) routing protocol on 
the ONS 15454. Perform this task if you want to include the ONS 15454 in 
OSPF-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

You will need the OSPF Area ID, Hello and Dead intervals, and 
authentication key (if OSPF authentication is enabled) provisioned on the 
router to which the ONS 15454 is connected.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DCC/GCC OSPF Area ID Table—In dotted decimal format, enter the number that identifies the 
ONS 15454 nodes as a unique OSPF area ID. The Area ID can be any number between 
000.000.000.000 and 255.255.255.255, but must be unique to the LAN OSPF area.

• SDCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
Section DCC, which is used by OSPF routers to calculate the shortest path. This value should always 
be higher than the LAN metric. The default SDCC metric is 100. 

• LDCC Metric—Sets a cost for sending packets across the Line DCC. This value should always be 
lower than the SDCC metric. The default LDCC metric is 33. It is usually not changed.

Step 3 In the OSPF on LAN area, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to 
OSPF routers on the LAN. Enable this field on ONS 15454 nodes that directly connect to OSPF 
routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the 
ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the 
following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings.

The OSPF priority and interval defaults are the defaults most commonly used by OSPF routers. Verify 
that these defaults match the ones used by the OSPF router where the ONS 15454 is connected.

• Router Priority—Selects the designated router for a subnet.

• Hello Interval (sec)—Sets the number of seconds between OSPF hello packet advertisements sent 
by OSPF routers. Ten seconds is the default.

• Dead Interval—Sets the number of seconds that will pass while an OSPF router’s packets are not 
visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Indicates the service speed. One second is the default.

• Retransmit Interval (sec)—Sets the time that will elapse before a packet is resent. Five seconds is 
the default.

• LAN Metric—Sets a cost for sending packets across the LAN. This value should always be lower 
than the SDCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note Area range tables consolidate the information that is outside an OSPF area border. One 
ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table 
on this node points the router to the other nodes that reside within the ONS 15454 OSPF area. 

a. Under OSPF Area Range Table, click Create.
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b. In the Create Area Range dialog box, enter the following:

• Range Address—Enter the area IP address for the ONS 15454 nodes that reside within the OSPF 
area. For example, if the ONS 15454 OSPF area includes nodes with IP addresses 10.10.20.100, 
10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 10.10.0.0.

• Range Area ID—Enter the OSPF area ID for the ONS 15454 nodes. This is either the ID in the 
DCC OSPF Area ID field or the ID in the Area ID for LAN Port field.

• Mask Length—Enter the subnet mask length. In the Range Address example, this is 16. 

• Advertise—Check if you want to advertise the OSPF range table.

c. Click OK.

Step 7 All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected 
to Area 0, use the following steps to create a virtual link table that will provide the disconnected area 
with a logical path to Area 0:

a. Under OSPF Virtual Link Table, click Create.

b. In the Create Virtual Link dialog box, complete the following fields. OSPF settings must match 
OSPF settings for the ONS 15454 OSPF area:

• Neighbor—The router ID of the Area 0 router.

• Transit Delay (sec)—The service speed. One second is the default.

• Hello Int (sec)—The number of seconds between OSPF hello packet advertisements sent by 
OSPF routers. Ten seconds is the default.

• Auth Type—If the router where the ONS 15454 is connected uses authentication, choose 
Simple Password. Otherwise, choose No Authentication.

• Retransmit Int (sec)—Sets the time that will elapse before a packet is resent. Five seconds is the 
default.

• Dead Int (sec)—Sets the number of seconds that will pass while an OSPF router’s packets are 
not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click OK.

Step 8 After entering ONS 15454 OSPF area data, click Apply.

If you changed the Area ID, the TCC2/TCC2P cards reset, one at a time. The reset takes approximately 
10 to 15 minutes. Table 3-2 on page 3-13 shows the LED behavior during the TCC2/TCC2P reset. 

Step 9 Return to your originating procedure (NTP).

DLP-G60 Set Up or Change Routing Information Protocol

Purpose This task enables Routing Information Protocol (RIP) on the ONS 15454. 
Perform this task if you want to include the ONS 15454 in RIP-enabled 
networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

You need to create a static route to the router adjacent to the ONS 15454 
for the ONS 15454 to communicate its routing information to 
non-DCC-connected nodes.
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Step 1 In node view, click the Provisioning > Network > RIP tabs. 

Step 2 Check the RIP Active check box if you are activating RIP. 

Step 3 Choose either RIP Version 1 or RIP Version 2 from the drop-down list, depending on which version is 
supported in your network. 

Step 4 Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number 
of hops. 

Step 5 By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires 
authentication, complete the following steps. If not, continue with Step 6.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 6 If you want to complete an address summary, complete the following steps. If not, continue with Step 7. 
Complete the address summary only if the ONS 15454 is a gateway NE with multiple external 
ONS 15454 NEs attached with IP addresses in different subnets.

a. In the RIP Address Summary area, click Create.

b. In the Create Address Summary dialog box, complete the following:

• Summary Address—Enter the summary IP address.

• Mask Length—Enter the subnet mask length using the up and down arrows.

• Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.

c. Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-G27 Set Up the ONS 15454 for Firewall Access

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure provisions ONS 15454 nodes and CTC computers for 
access through firewalls.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed As needed
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Step 1 Log into a node that is behind the firewall. See the “DLP-G46 Log into CTC” task on page 2-24 for 
instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 3-23.

Figure 3-6 shows ONS 15454 nodes in a protected network and the CTC computer in an external 
network. For the computer to access the ONS 15454 nodes, you must provision the IIOP listener port 
specified by your firewall administrator on the ONS 15454. 

Figure 3-6 Nodes Behind a Firewall

Step 3 If the CTC computer resides behind a firewall, complete the “DLP-G62 Provision the IIOP Listener Port 
on the CTC Computer” task on page 3-23.

Figure 3-7 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the 
ONS 15454, you must provision the IIOP port on the CTC computer and on the ONS 15454. 

Figure 3-7 CTC Computer and ONS 15454 nodes Residing Behind Firewalls

Stop. You have completed this procedure.
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Security Level Provisioning or higher
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DLP-G61 Provision the IIOP Listener Port on the ONS 15454

Note If the Enable SOCKS proxy server on port 1080 check box is checked, CTC will use port 1080 and ignore 
the configured IIOP port setting. If Enable SOCKS proxy server is subsequently unchecked, the 
configured IIOP listener port will be used.

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 In the TCC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454 nodes on the same side of the 
firewall or if no firewall is used (default). This option can be used for access through a firewall if 
Port 57790 is open.

• Standard Constant—Uses Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall administrator. 

Step 3 Click Apply.

Step 4 When the Change Network Configuration message appears, click Yes. 

Both ONS 15454 TCC2/TCC2P cards reboot, one at a time. The reboot takes approximately 15 minutes. 

Step 5 Return to your originating procedure (NTP).

DLP-G62 Provision the IIOP Listener Port on the CTC Computer

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Firewall tab.

Purpose This task sets the IIOP listener port on the ONS 15454, which enables you 
to access ONS 15454 nodes that reside behind a firewall.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task selects the IIOP listener port on CTC and must be completed if 
the computer running CTC resides behind a firewall.

Tools/Equipment IIOP listener port number from LAN or firewall administrator.

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

DLP-G46 Log into CTC, page 2-24 

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 In the CTC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - Variable—Use to connect to ONS 15454 nodes from within a firewall or if no firewall is 
used (default).

• Standard Constant—Use Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator.

Step 4 Click Apply. A warning appears telling you that the port change will apply during the next CTC login.

Step 5 Click OK. 

Step 6 In the Preferences dialog box, click OK.

Step 7 To access the ONS 15454 using the IIOP port, log out of CTC then log back in. (To log out, choose Exit 
from the File menu).

Step 8 Return to your originating procedure (NTP).

NTP-G28 Set Up SNMP

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to set up SNMP. 
If you are already logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > SNMP tabs.

Step 3 In the Trap Destinations area, click Create.

Step 4 Complete the following in the Create SNMP Trap Destination dialog box (Figure 3-8):

• Destination IP Address—Type the IP address of your network management system. If the node you 
are logged into is an ENE, set the destination address to the GNE. 

• Community—Type the SNMP community name. For a description of SNMP community names, 
refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide. 

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the 
network management system (NMS).

• UDP Port—The default User Datagram Protocol (UDP) port for SNMP is 162. If the node is an ENE 
in a SOCKS proxy server network, the UDP port must be set to the GNE’s SNMP relay port, which 
is 391. 

Purpose This procedure provisions the SNMP parameters so that you can use 
SNMP management software with the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed Required if SNMP is used at your installation.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Trap Version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine 
whether to use SNMP v1 or v2.

Figure 3-8 Creating an SNMP Trap

Step 5 Click OK. The node IP address of the node where you provisioned the new trap destination appears in 
the Trap Destinations area.

Step 6 Click the node IP address in the Trap Destinations area. Verify the SNMP information that appears in 
the Selected Destination list.

Step 7 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 8 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistic retrieval across ONS firewalls, click the Enable SNMP Proxy check box located 
on the SNMP tab.

Note The ONS firewall proxy feature only operates on nodes running Software Release 4.6 or later. 
Using this feature effectively breaches the ONS firewall to exchange management information.

For more information about the SNMP proxy feature, refer to the Cisco ONS 15454 Troubleshooting 
Guide or the Cisco ONS 15454 SDH Troubleshooting Guide. 

Step 9 Click Apply.

Step 10 If you are setting up SNMP proxies, for each trap destination address you can set up to three relays that 
send SNMP trap error counts back to NE:

a. Click the first trap destination IP address. The address and its community name appear in the 
Destination fields.

b. Enter up to three SNMP Proxy relay addresses and community names in the fields for Relay A, 
Relay B, and Relay C.

Note The community names specified for each relay node must match one of the provisioned 
SNMP community names in the NE. 

Note The SNMP proxy directs SNMP traps from this node through IpA to IpB to IpC to the trap 
destination. Ensure that you enter the IP addresses in the correct order so that this sequence 
runs correctly.

Step 11 Click Apply.
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Stop. You have completed this procedure.

NTP-G29 Preprovision a Slot

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you will preprovision the 
slots. If you are already logged in, continue with Step 2.

Step 2 In CTC node view, right-click an empty slot where you will install a card.

Step 3 From the Add Card popup menu, choose the card type that will be installed based on the Cisco 
MetroPlanner shelf layout (see Table 3-1 on page 3-3). Only cards that can be installed in the slot appear 
in the Add Card popup menu. The 32WSS, 32-MUX-O and 32-DMX-O require two vacant slots, or they 
will not appear in the menu. Table 3-3 shows the Add Card menu and cards. 

Purpose This procedure preprovisions the ONS 15454 slots in CTC based upon the 
Cisco MetroPlanner shelf layout prepared for your site. Preprovisioning the 
slots ensures that the physical cards are installed in the slots anticipated by 
the parameters contained in the Cisco MetroPlanner Assisted Configuration 
Setup that will be imported into CTC.

Tools/Equipment Cisco MetroPlanner shelf layout or JPG file.

Prerequisite Procedures Chapter 2, “Connect the PC and Log into the GUI”

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 3-3 CTC Add Card Menu for DWDM Cards

Category Option Card

nXP MXPP_MR_10E MXPP_MR_10E

MXP_MR_10E MXP_MR_10E

MXP_MR_10G MXP_MR_10G

MXP_MR_2.5G MXP_MR_2.5G

TXPP_MR_2.5G TXPP_MR_2.5G

TXP_MR_10E TXP_MR_10E

TXP_MR_10G TXP_MR_10G

TXP_MR_2.5G TXP_MR_2,5G

MD 32 DMX 32DMX

32 DMXO 32 DMX-O

32 MUXO 32 MUX-O

32 WSS 32WSS

4MD 4MD-xx.x
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Note When you preprovision a slot, the card appears purple in the CTC shelf graphic, rather than 
white when a card is installed in the slot. NP (not present) on the card graphic indicates that the 
card is not physically installed.

Step 4 Repeat Step 3 until all the cards shown in the Cisco MetroPlanner shelf layout are provisioned in CTC.

Stop. You have completed this procedure.

NTP-G30 Install the DWDM Cards

OADM OADM 1 band AD-1B-xx.x

OADM 1 Channel AD-1C-xx.x

OADM 2 Channels AD-2C-xx.x

OADM 4 Bands AD-4B-xx.x

OADM 4 Channels AD-4C-xx.x

Ampli Optical booster OPT-BST

Optical booster ENH OPT-BST-E

Optical preamplifier OPT-PRE

OSC + Combiner/Separator OSC-CSM

Table 3-3 CTC Add Card Menu for DWDM Cards (continued)

Category Option Card

Purpose This procedure describes how to install DWDM cards (OPT-PRE, 
OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 4MD-xx.x, 
AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, 
OSCM, and OSC-CSM). 

Tools/Equipment • Cisco MetroPlanner shelf layout 

• The following cards, as required by your site plan: OPT-PRE, 
OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 4MD-xx.x, 
AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, 
OSCM, or OSC-CSM cards (as applicable)

• The ONS 15454 NE defaults file if the node will use custom NE 
defaults.

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-69

NTP-G14 Install DWDM Equipment, page 1-64

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 If the node requires a custom network element (NE) defaults settings to be installed on the node, 
complete the “NTP-G136 Import Network Element Defaults” procedure on page 12-39. If not, continue 
with Step 2.

Caution Custom NE defaults, if required, must be installed before you install the DWDM cards.

Step 2 Display the Cisco MetroPlanner shelf layout (see Table 3-1 on page 3-3).

Step 3 Remove the DWDM card from its packaging, then remove the protective caps from the backplane 
connectors.

Step 4 Open the card latches/ejectors. 

Step 5 Use the latches/ejectors to firmly slide the card along the slot guide rails until the card plugs into the 
receptacle at the back of the slot. 

Step 6 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.
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The following LED activity will occur:

• The FAIL LED turns on for approximately 35 seconds. During this time, the ACT LED will cycle 
through various states, and then extinguish.

• The FAIL LED blinks for approximately 40 seconds.

• All LEDs turn on and then turn off within 5 seconds.

• If new software is being downloaded to the card, the ACT and SF LEDs blink for 20 seconds to 
3 to 5 minutes, depending on the card type.

• The ACT LED turns on.

• The signal fail (SF) LED might persist until all card ports connect to their far-end counterparts and 
a signal is present.

Step 7 If the card does not boot up properly, or the LED activity does not mirror the activity in Step 6, check 
the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a DWDM card does not boot, open CTC and ensure that the slot is not provisioned 
for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed. 
Remove the card and repeat Steps 3 to 6. If the card does not boot up properly the second time, it 
may be defective. Contact your next level of support.

Note The DWDM node type is determined by the cards that are installed. For example, if two 
32DMX-O and two 32MUX-O cards are installed but no AD-xC or AD-xB cards are installed, 
CTC considers the node a hub node. However, if one 32DMX-O and one 32MUX-O card are 
installed with no AD-xC or AD-xB cards, CTC considers the node a terminal node. For more 
information, refer to Chapter 15, “Card Reference.”

Step 8 Repeat Steps 3 through 7 until all the DWDM cards are installed in the node.

Step 9 If OPT-PRE cards are installed, complete one of the following steps for each OPT-PRE card based upon 
the Cisco MetroPlanner shelf layout. If OPT-PRE cards are not installed, you have completed this 
procedure.

• If the Cisco MetroPlanner shelf layout does not include DCUs, install a 4-dB attenuator with a 
tolerance of +/– 1 dB between the OPT-PRE DC TX and RX ports for each OPT-PRE installed in 
the shelf.

• If the shelf layout includes DCUs, complete the “NTP-G31 Install the DWDM Dispersion 
Compensating Units” procedure on page 3-30 for each side of the shelf that requires a DCU.

Stop. You have completed this procedure. 
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NTP-G31 Install the DWDM Dispersion Compensating Units

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the DCUs, remove the clips before 
installing the units.

Step 1 Pull the DCU latch inward with your finger.

Step 2 Firmly slide the DCU along the guide rails until the card plugs into the receptacle at the back of the 
horizontal dispersion compensating card slot at the top of the shelf.

Note The west DCU is commonly installed on the left side and the east DCU is commonly installed 
on the right side.

Note Double check the placement of the DCU(s) with your Cisco MetroPlanner shelf layout. If you 
install the wrong DCU in a slot, remove the DCU and install the correct one. 

Purpose This procedure describes how to install the dispersion compensating units 
(DCU-xx.x) for DWDM shelves.

Tools/Equipment DCU-xx.x cards

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-69

NTP-G14 Install DWDM Equipment, page 1-64

NTP-G30 Install the DWDM Cards, page 3-27

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 3 Release the finger latch.

Note It is possible to close the latch when the DCU is not completely plugged into the backplane. 
Ensure that you cannot insert the DCU any further.

Step 4 Verify that the DCU is engaged with the backplane by grasping and gently pulling the card handle. If the 
card does not move, it is fully installed. If it moves, repeat Steps 2 and 3.

Stop. You have completed this procedure. 

NTP-G32 Install the Transponder and Muxponder Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Class 1 laser product. Statement 1008

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Purpose This procedure describes how to install the ONS 15454 transponder (TXP) 
and muxponder (MXP) cards.

Tools/Equipment TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, and 
MXPP_MR_2.5G cards (as applicable)

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-69

NTP-G14 Install DWDM Equipment, page 1-64

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Display Cisco MetroPlanner shelf layout (see Table 3-1 on page 3-3) for the node where you will install 
the TXP and MXP cards.

Step 2 Remove the TXP or MXP card from its packaging, then remove the protective clips from the backplane 
connectors.

Step 3 Open the card latches/ejectors. 

Step 4 Use the latches/ejectors to firmly slide the TXP or MXP card along the guide rails until the card plugs 
into the receptacle at the back of the slot designated by the Cisco MetroPlanner shelf layout.

Step 5 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches and ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

The following LED activity will occur:

• The red FAIL LED turns on for approximately 30 seconds. During this time, the ACT LED will cycle 
through various states, and then extinguish.

• The red FAIL LED blinks for approximately 45 seconds.

• All LEDs blink once and turn off for approximately 10 seconds while the ACT and SF LEDs cycle 
through various stages.

• The ACT or ACT/STBY LED turns on. The SF LED might persist until all card ports connect to 
their far-end counterparts and a signal is present. 

Step 6 If the card does not boot up properly, or the LED activity does not mirror Step 5, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a TXP or MXP card does not boot, open CTC and ensure that the slot is not 
provisioned for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed 
properly. Remove the card and repeat Steps 3 to 5. 

Step 7 If the TXP or MXP requires a small-form pluggable (SFP or XFP) connector, complete one of the 
following tasks:

• DLP-G63 Install an SFP or XFP, page 3-34—complete this task to install the physical SFP or XFP 
into the TXP or MXP.
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• DLP-G273 Preprovision an SFP or XFP Slot, page 3-33—(optional) complete this task if you do not 
have the physical SFP or XFP and wish to preprovision the SFP or XFP slot. If you preprovision a 
multirate SFP or XFP, complete the “DLP-G278 Provision the Optical Line Rate” task on page 5-3.

Note Provisionable port modules (PPMs) determine how the SFPs and XFPs are used in CTC. PPM 
provisioning procedures are provided in Chapter 5, “Provision Transponder and Muxponder 
Cards.”

Step 8 If you need to remove an SFP or XFP, complete the “DLP-G64 Remove an SFP or XFP” task on 
page 3-34.

Note You will provision the TXP and MXP cards after you complete all node turnup procedures. TXP and 
MXP provisioning procedures are provided in Chapter 5, “Provision Transponder and Muxponder 
Cards.”

Stop. You have completed this procedure. 

DLP-G273 Preprovision an SFP or XFP Slot

Step 1 In node view, double-click the TXP or MXP card where you want to provision PPM settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Port Modules pane, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the slot number where the SFP/XFP is installed from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP/XFP from the drop-down list. The 
drop-down list displays the number of PPMs that are available for provisioning. If only one port is 
supported, PPM (1 port) is the only menu option. 

Step 5 Click OK. The newly created port appears on the Pluggable Port Modules pane. The row on the 
Pluggable Port Modules pane turns light blue. The Actual Equipment Type column remains blank until 
the actual SFP/XFP is installed. After the SFP/XFP is installed, the row on the pane turns white and the 
Actual Equipment Type column shows the equipment name.

Step 6 Verify that the PPM appears in the list on the Pluggable Port Modules pane. If it does not, repeat Steps 
3 through 5. 

Purpose This procedure provisions small form-factor pluggables (SFP/XFPs), 
which connect fiber to TXP and MXP cards. SFP/XFPs are referred to as 
pluggable port modules (PPMs) in CTC. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
3-33
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 3      Turn Up a Node
Before You Begin
Step 7 Repeat the task to provision a second PPM, if needed. If not, continue with Step 8.

Step 8 Return to your originating procedure (NTP). 

DLP-G63 Install an SFP or XFP

Note SFPs and XFPs are generically called PPMs (Pluggable-Port Modules) in CTC. After installing the SFP 
or XFP, multirate PPMs (PPMs that provide OC-3 or OC-12 line rates) must be provisioned in CTC. See 
the “DLP-G277 Provision a Multirate PPM” task on page 5-3. 

Step 1 Verify that the SFP is correct for your network and TXP or MXP card (see Table 15-69 on page 15-118). 
Check that you are installing compatible SFPs, for example, SX to SX or LX/LH to LX/LH. 

Step 2 Install the SFP:

• For a mylar tab SFP/XFP: slide the SFP/XFP into the slot.

• For an actuator/button SFP/XFP: slide the SFP/XFP all the way into the slot until you hear a click.

• For a bail clasp SFP/XFP: latch (flip upwards) the bail clasp before inserting into the slot then slide 
into the slot. 

Note SFP/XFPs are keyed to prevent incorrect installation.

Step 3 Do not remove the protective caps from the SFP/XFP until you are ready to attach the network fiber-optic 
cable. 

Step 4 Return to your originating procedure (NTP).

DLP-G64 Remove an SFP or XFP

Purpose This task installs SFPs or XFPs into TXP and MXP cards. SFP/XFPs 
provide a fiber interface to the card. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

DLP-G273 Preprovision an SFP or XFP Slot, page 3-33

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose This task removes SFP/XFPs from TXP and MXP cards.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

Required/As Needed As needed
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Note This task removes the SFP/XFP hardware. To delete the provisioning for an SFP/XFP, see the 
“DLP-G280 Delete a PPM” procedure on page 5-7.

Step 1 If a fiber is connected, disconnect the network fiber cable from the GBIC SC-type connector or SFP/XFP 
LC-type connector.

Step 2 Release the SFP/XFP from the slot by performing one of the following actions (depending which latch 
is on the SFP/XFP): 

• For a mylar tab SFP/XFP: pull out the mylar tab. 

• For an actuator/button SFP/XFP: press the actuator/button.

• For a bail clasp SFP/XFP: unlatch the bail clasp and swing it downward.

Step 3 Slide the SFP/XFP out of the slot.

Step 4 Return to your originating procedure (NTP).

NTP-G123 Install the Filler Cards

Warning Blank faceplates (filler panels) serve three important functions: they prevent exposure to hazardous 
voltages and currents inside the chassis; they contain electromagnetic interference (EMI) that might 
disrupt other equipment; and they direct the flow of cooling air through the chassis. Do not operate 
the system unless all cards and faceplates are in place. Statement 156

Caution Always use the supplied electrostatic discharge (ESD) wristband when working with a powered 
ONS 15454. Plug the wristband cable into the ESD jack located on the lower right outside edge of the 
shelf assembly and ensure the shelf assembly is properly grounded.

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose This procedure explains how to install the filler cards (blank faceplates) in 
any unused traffic or AIC-I card slots (Slots 1 through 6, 9, and 11 through 
17). The filler card aids in maintaining proper air flow and EMI 
requirements and is detected by CTC in Software Release 6.0 and higher.

Tools/Equipment Filler cards (Cisco P/N 15454-FILLER)

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-30

NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
3-35
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 3      Turn Up a Node
Before You Begin
Step 1 Open the card ejectors. 

Step 2 Slide the card along the guide rails into the correct slot.

Step 3 Close the ejectors.

Step 4 Repeat for any remaining unused card slots. 

Stop. You have completed this procedure. 

NTP-G33 Create a Y-Cable Protection Group

Note Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the ports are not in a Y-cable protection 
group.

Step 1 View the Cisco MetroPlanner Traffic Matrix (see Table 3-1 on page 3-3) for your site. Verify the TXP 
or MXP cards that need Y-cable protection groups. (Cards requiring Y-cable protection are indicated 
with “Y-Cable” in the Traffic Matrix table Protection Type column. Refer to the Cisco MetroPlanner 
DWDM Operations Guide for more information.)

Step 2 Verify that the TXP or MXP cards are installed according to the requirements specified in Table 3-4. This 
table describes the protection types available in the ONS 15454 for DWDM client cards. 

Purpose This procedure creates a Y-cable protection group between the client ports 
of two transponder (TXP_MR_10G, TXP_MR_10E, or TXP_MR_2.5G) 
or two muxponder (MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, 
MXPP_MR_2.5G) cards. For additional information about Y-cable 
protection, see the “15.9.1 Y-Cable Protection” section on page 15-114.

Tools/Equipment Installed TXP or MXP cards.

Cisco MetroPlanner Traffic Matrix

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-69

NTP-G14 Install DWDM Equipment, page 1-64

DLP-G46 Log into CTC, page 2-24

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Verify that pluggable port modules (PPM) are provisioned for the same payload and payload rate on the 
TXP and MXP cards where you will create the Y-cable protection group. You can use either of the 
following methods:

• In node view, move your mouse over the TXP or MXP client port. If a PPM is provisioned, two dots 
appear in the port graphic, and the port and PPM payload and rate appear when you move the mouse 
over the port.

• Display the TXP or MXP card in card view. Click the Provisioning > Pluggable Port Module tabs. 
Verify that a PPM is provisioned in the Pluggable Port Module area, and the payload type and rate 
is provisioned for it in the Selected PPM area.

The PPM payload and payload rate must be the same for both TXP or MXP cards. If they are not the 
same, for example, if the PPM payload and payload rate are not the same, you must either change the 
provisioned payload rate to match, or replace the PPM (SFP or XFP).

Step 4 In node view, click the Provisioning > Protection tabs.

Step 5 In the Protection Groups area, click Create.

Step 6 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 
0-9) characters. Special characters are permitted. For TL1 compatibility, do not use question mark 
(?), backslash (\), or double quote (“) characters.

• Type—Choose Y Cable from the drop-down list.

• Protect Port—From the drop-down list, choose the port that will be the standby or protection port to 
the active port. The menu displays the available transponder or muxponder ports. If transponder or 
muxponder cards are not installed, no ports appear in the drop-down list. 

After you choose the protect port, a list of available working ports appear in the Available Ports list, as 
shown in Figure 3-9. If no cards are available, no ports appear. If this occurs, you can not complete this 
task until you install the physical cards or preprovision the ONS 15454 slots using the “NTP-G29 
Preprovision a Slot” procedure on page 3-26.

Table 3-4 Protection Types

Type Cards Description and Installation Requirements

Y Cable MXP_2.5_10G

MXP_2.5_10E

TXP_MR_10G

TXP_MR_10E

TXP_MR_2.5G

MXP_MR_2.5G

Pairs a working transponder or muxponder card/port with a 
protect transponder or muxponder card/port. The protect port 
must be on a different card than the working port and it must be 
the same card type as the working port. The working and protect 
port numbers must be the same, that is, Port 1 can only protect 
Port 1, Port 2 can only protect Port 2, etc.

Splitter TXPP_MR_2.5G

MXPP_MR_2.5G

A splitter protection group is automatically created when a 
TXPP_MR_2.5G or MXPP_MR_2.5G card is installed. You can 
edit the splitter protection group name.
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Figure 3-9 Creating a Y-Cable Protection Group

Step 7 From the Available Ports list, choose the port that will be protected by the port you selected in 
Protect Ports. Click the top arrow button to move the port to the Working Ports list.

Step 8 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range 
is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will 
elapse before the traffic reverts to the working card. The reversion timer starts after conditions 
causing the switch are cleared.

Step 9 Click OK.

Step 10 Repeat this procedure for every protection indicated in the Cisco MetroPlanner Traffic Matrix.

Stop. You have completed this procedure. 
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NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Note In this procedure, you will generally connect fibers in an east-to-west or west-to-east pattern. “West” 
refers to cards and ports in Slots 1 through 8. “East” refers to cards and ports installed in Slots 10 
through 17. 

Step 1 View the Cisco MetroPlanner Internal Connections table. Figure 3-10 shows an example.

Purpose This procedure installs the fiber-optic cables to DWDM cards and 
dispersion compensating units. 

Tools/Equipment Fiber-optic cables

Cisco MetroPlanner Internal Connections table

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-30 
(as applicable)

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-10 Cisco MetroPlanner Internal Connections Table

Step 2 Review the Cisco MetroPlanner Internal Connections table for the node you are provisioning. The table 
identifies the patch cord that you must cable by their end points. Position 1 identifies the fiber start point; 
Position 2 indicates the fiber end point. The patch cord end points are identified by site, slot, and port. 
Information provided by the Internal Connections table includes:

• Site—The DWDM network site number for the node where you are provisioning the internal 
connections.

• IP Address—The node IP address.

• Position-1—The first position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to 
Slot 2 in the Main Shelf of Rack #1. Refer to the Cisco MetroPlanner Site Dialog window for rack 
and shelf names and locations. 

• Unit-1—The ONS 15454 DWDM card (unit) that is installed in the first position slot.

• Port#-1—The port identifier shown in the CTC for the first Position-1 connection.

• Port ID-1—The port identifier shown in TL1 for the Position-1 connection.

• Port Label-1—The name of the physical port printed on the card’s front plate and shown in CTC 
card view for the Position-1 connection.

• Attenuator—Indicates whether attenuation is required.

• Patchcord Type—Indicates the level of attenuation that is required, if needed.

• Position-2—The second position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to 
Slot 2 in the Main Shelf of Rack #1. Refer to the Cisco MetroPlanner Site Dialog window for rack 
and shelf names and locations.

• Unit-2—The ONS 15454 DWDM card (unit) that is installed in the Position-2 slot.

• Port #2—The port identifier shown in CTC for the first Position-2 connection.

• Port ID-2—The port identifier shown in TL1 for the Position-2 connection.

Site Position-1 Port#-1
IP Address Unit-1

Port Label-1 Patchcord Type
Port ID-1 Attenuator Position-2
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• Port Label-2—The name of the physical port printed on the card’s front plate and shown in CTC 
card view for the Position-2 connection.

• Manually Set—Indicates whether you must create the connection manually in CTC. A Yes 
appearing in this column means you must create the connection manually.

Caution Failure to create the required manual connections will prevent the node from turning up properly.

Step 3 Verify that fibers are available to complete the connections shown in the Internal Connections table.

Step 4 Complete the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 for all fiber connections, 
even new fiber. Dust particles can degrade performance. Put caps on any fiber connectors that are not 
used.

Step 5 If you will not perform node acceptance tests for this site, complete the “DLP-G65 Install Fiber-Optic 
Cables for OSC Link Terminations Between Two Adjacent Nodes” task on page 3-42. Otherwise, 
continue with Step 6.

Step 6 On the front of the fiber-storage tray (usually installed below the node you are fibering), push the tabs 
on the left and right sides inward to release the lock on the tray. 

Step 7 Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 8 Open the fold-down door that at the bottom of the shelf assembly to expose the cable-routing channel 
(Figure 14-35 on page 14-37).

Step 9 Using the Cisco MetroPlanner Internal Connection table, install the fiber-optic cables. Steps provided in 
the following tasks can be used as general guidelines; however, the fiber-optic cabling at your site will 
probably differ from the examples shown in the tasks.

• DLP-G66 Install Fiber-Optic Cables for a Hub Node, page 3-45

• DLP-G67 Install Fiber-Optic Cables for a Terminal Node, page 3-47

• DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node, page 3-49

• DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node, page 3-51

• DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node, page 3-54

• DLP-G71 Install Fiber-Optic Cables for an ROADM Node, page 3-59

Step 10 To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure. 
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DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two 
Adjacent Nodes

Note If you are performing the node acceptance tests in Chapter 4, “Perform Node Acceptance Tests,” you 
can perform this task after node acceptance testing is complete.

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing OSC connections. Before you begin the OSC connections, read the following rules:

• The OPT-BST and the OSC-CSM are the only cards that directly interface with the line (span) fiber.

• The OSCM only carries optical service channels, not DWDM channels.

• The OSCM and the OSC-CSM cannot both be installed on the same side of the shelf (east or west). 
You can have different cards on each side, for example an OSCM on the west side and an OSC-CSM 
on the east side.

• When an OPT-BST and an OSC-CSM are both used on the same side of the node, the OPT-BST 
combines the supervision channel with the DWDM channels and the OSC-CSM acts as an OSCM; 
it does not carry DWDM traffic.

• If an OPT-BST and OSCM card are installed on the east side, the east OPT-BST OSC RX port is 
connected to the east OSCM TX port, and the east OPT-BST OSC TX port is connected to the east 
OSCM RX port.

• If you have an OPT-BST and OSC-CSM card are installed on the east side, the east OPT-BST OSC 
RX port is connected to the east OSC-CSM LINE TX port, and the east OPT-BST OSC TX port is 
connected to the east OSC-CSM LINE RX port.

• If an OPT-BST and OSCM card are installed on the west side, The west OPT-BST OSC TX port is 
connected to the west OSCM RX port, and the west OPT-BST OSC RX port is connected to the west 
OSCM TX port.

• If you have an OPT-BST and OSC-CSM card are installed on the west side, the west OPT-BST OSC 
TX port is connected to the west OSC-CSM LINE RX port, and the west OPT-BST OSC RX port is 
connected to the west OSC-CSM LINE TX port.

Figure 3-11 shows an example of OSC fibering for a hub node with OSCM cards installed.

Purpose This task explains how to install fiber-optic cables for optical to enable the 
Optical Service Channel (OSC) link termination between two adjacent 
DWDM Nodes.

Tools Fiber-optic cables

Cisco MetroPlanner Internal Connections table

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note Install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your 
site.

Figure 3-11 Fibering OSC Terminations—Hub Node with OSCM Cards
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Step 2 Plug one end of a fiber into the west OPT-BST or OSC-CSM LINE TX connector.

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST 
cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 5 Plug the other end of the fiber cable into the adjacent node east OPT-BST or OSC-CSM LINE RX 
connector. Repeat in the other direction (east to west, TX to RX). Always connect the west line ports to 
the adjacent node east line ports. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 6 If OSCM cards are not installed, continue with Step 7. If OSCM cards are installed on both sides of the 
shelf, complete Steps a through d. If an OSCM is installed on the west side of the shelf, but not the east 
side, complete Steps a and b only. If the OSCM is installed on the east side of the shelf but not the west, 
complete Steps c and d only. 

a. Plug one end of a fiber into the west OPT-BST OSC RX connector and the other end into west 
OSCM OSC TX connector. 

b. Plug another fiber into the west OSCM OSC RX connector and the other end to the west OPT-BST 
OSC TX connector.

c. plug one end of a fiber into the east OPT-BST OSC RX connector and the other end into the east 
OSCM TX connector. 

d. Plug another fiber into the east OSCM OSC RX connector and the other end to the east OPT-BST 
OSC TX connector. 

Step 7 Repeat Steps 2 and 6 at each node in the network. If this is the final node, continue with Step 8.

1 West OPT-BST LINE RX to east OPT-BST or OSC-CSM 
LINE TX on adjacent node

5 East OSCM TX to east OPT-BST OSC RX

2 West OPT-BST LINE TX to east OPT-BST or OSC-CSM 
LINE RX on adjacent node

6 East OSCM RX to east OPT-BST OSC TX

3 West OPT-BST OSC TX to west OSCM RX 7 East OPT-BST LINE TX to west OPT-BST or 

OSC-CSM LINE RX on adjacent node

4 West OPT-BST OSC RX to west OSCM TX 8 East OPT-BST LINE RX to west OPT-BST or 
OSC-CSM LINE TX on adjacent node
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Step 8 Return to your originating procedure (NTP). 

DLP-G66 Install Fiber-Optic Cables for a Hub Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin hub node connections, read the following rules:

• The west OPT-BST or OSC-CSM card common (COM) TX port is connected to the west 
OPT-PRE COM RX port or the west 32DMX-O COM RX port.

• The west OPT-PRE COM TX port is connected to the west 32DMX-O COM RX port.

• The west 32MUX-O COM TX port is connected to the west OPT-BST or west OSC-CSM COM RX 
port.

• The east 32MUX-O COM TX port is connected to the east OPT-BST or east OSC-CSM COM RX 
port.

• The east OPT-BST or east OSC-CSM COM TX port is connected to the east OPT-PRE COM RX 
port or the east 32DMX-O COM RX port.

• The east OPT-PRE COM TX port is connected to the east 32DMX-O COM RX port.

Figure 3-12 shows an example of a hub node with cabling. In the example, OSCM cards are installed. If 
OSC-CSM are installed, they are usually installed in Slots 1 and 17.

Note Figure 3-12 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.

Purpose This task installs fiber-optic cables on a hub node DWDM shelf.

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-12 Fibering a Hub Node
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Step 2 Plug one end of the fiber cable into the desired RX port. 

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST 
cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 7 Plug the other end of the cable into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 8 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 9 Return to your originating procedure (NTP). 

DLP-G67 Install Fiber-Optic Cables for a Terminal Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin terminal node connections, read the following rules:

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB must be installed between the OPT-PRE DC ports.

Purpose This task installs fiber-optic cables on a terminal node DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
3-47
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 3      Turn Up a Node
Before You Begin
• A terminal site has only one side (as compared to a hub node, which has two sides). The terminal 
side can be either east or west.

• The terminal side OPT-BST or OSC-CSM card common (COM) TX port is connected to the terminal 
side OPT-PRE COM RX port or the 32DMX-O COM RX port.

• The terminal side OPT-PRE COM TX port is connected to the terminal side 32DMX-O COM RX 
port.

• The terminal side 32MUX-O COM TX port is connected to the terminal side OPT-BST or 
OSC-CSM COM RX port.

Step 2 Plug one fiber cable end into the desired RX port.

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST 
cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 7 Plug the other end of the cable into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 8 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 9 Return to your originating procedure (NTP). 
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DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin the line amplifier node connections, read the following 
rules:

• Line amplifier node layout allows all combinations of OPT-PRE and OPT-BST and allows you to 
use asymmetrical card choices in west-to-east and east-to-west configurations. For a given line 
direction, you can configure the four following possibilities:

– Only preamplification (OPT-PRE)

– Only booster amplification (OPT-BST)

– Both preamplification and booster amplification (where a line amplifier node has amplification 
in at least one direction)

– Neither preamplification nor booster amplification

• If a west OPT-PRE card is installed:

– The west OSC-CSM or OPT-BST COM TX is connected to the west OPT-PRE COM RX port.

– The west OPT-PRE COM TX port is connected to the east OSC-CSM or OPT-BST COM RX 
port.

• If a west OPT-PRE card is not installed, the west OSC-CSM or the OPT-BST COM TX port is 
connected to the east OSC-CSM or OPT-BST COM RX port.

• If an east OPT-PRE card is installed:

– The east OSC-CSM or OPT-BST COM TX port is connected to the east OPT-PRE COM RX 
port.

– The east OPT-PRE COM TX port is connected to the west OSC-CSM or OPT-BST COM RX 
port.

• If an east OPT-PRE card is not installed, the east OSC-CSM or OPT-BST COM TX port is connected 
to the west OSC-CSM or OPT-BST COM RX port.

Figure 3-13 shows an example of a line amplifier node with cabling.

Note Figure 3-13 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.

Purpose This task installs fiber-optic cables on a line amplifier node in a DWDM 
shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-13 Fibering a Line Amplifier Node

1 West DCU TX to west OPT-PRE DC RX1 

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB must be installed between the OPT-PRE DC ports.

5 West OPT-BST COM RX to east OPT-PRE COM TX

2 West DCU RX to west OPT-PRE DC TX1 6 West OPT-BST COM RX to east OPT-PRE COM TX

3 West OPT-BST COM TX to west OPT-PRE COM RX 7 East DCU TX to east OPT-PRE DC RX1

4 West OPT-PRE COM TX to east OPT-BST COM RX 8 East DCU RX to east OPT-PRE DC TX1
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Step 2 Plug one end of the fiber cable into the desired RX port. 

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of OSCM, OPT-PRE, and OPT-BST cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 7 Plug the other end of the cable into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 8 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 9 Return to your originating procedure (NTP). 

DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin OSC regeneration node connections, read the following 
rules:

• The west OSC-CSM COM TX port connects to the east OSC-CSM COM RX port.

• The west OSC-CSM COM RX port connects to the east OSC-CSM COM TX port.

Purpose This task installs fiber-optic cables on an OSC regeneration node in a 
DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• Slots 2 through 5 and 12 through 16 can be used for TXP/MXP cards.

Figure 3-14 shows an example of an OSC regeneration node with cabling.

Note Figure 3-14 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.

Figure 3-14 Fibering an OSC Regeneration Node
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Step 2 Plug one end of the fiber cable into the desired RX port.

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of OSCM, OPT-PRE, and OPT-BST cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 7 Plug the other end of the cable into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 8 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 9 Return to your originating procedure (NTP). 

1 West OSC-CSM LINE RX to east OSC-CSM 
or OPT-BST LINE TX on adjacent node

4 West OSC-CSM COM RX to east OSC-CSM COM TX 

2 West OSC-CSM LINE TX to east OSC-CSM 
or OPT-BST LINE RX on adjacent node

5 East OSC-CSM LINE RX to west OSC-CSM or 
OPT-BST LINE TX on adjacent node

3 West OSC-CSM COM TX to east OSC-CSM 
COM RX 

6 East OSC-CSM LINE TX to west OSC-CSM or 
OPT-BST LINE RX on adjacent node
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DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Note Amplified OADM nodes contain OPT-PRE cards and/or OPT-BST cards. Passive OADM nodes do not. 
Both contain add/drop channel or band cards.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin connecting fiber-optic cabling for amplified or passive 
OADM nodes, read the following rules for all OADM connections:

• The two sides of the OADM node do not need to be symmetrical. On each side, Cisco MetroPlanner 
can create one of the following four configurations:

– OPT-BST and OPT-PRE

– OSC-CSM and OPT-PRE

– Only OSC-CSM

– Only OPT-BST

Step 2 Consult the following rules for OADM node express path cabled connections:

• TX ports should only be connected to RX ports.

• EXP ports are connected only to COM ports in between AD-xC or AD-xB cards that all belong to 
the east side (that is, they are daisy-chained).

• EXP ports are connected only to COM ports in between AD-xC or AD-xB cards that all belong to 
the west side (that is, they are daisy-chained).

• The EXP port of the last AD-xC or AD-xB card on the west side is connected to the EXP port of the 
first AD-xC or AD-xB card on the east side.

• The OPT-BST COM RX port is connected to the nearest (in slot position) AD-xC or AD-xB 
COM TX port.

• The OPT-PRE COM TX port is connected to the nearest (in slot position) AD-xC or AD-xB 
COM RX port.

• If OADM cards are located in adjacent slots, the TCC2/TCC2P card assumes they are connected in 
a daisy-chain between the EXP ports and COM ports as noted previously.

Purpose This task gives instructions, rules, and examples to install fiber-optic cables 
on an amplified or passive optical add/drop multiplexing (OADM) node in 
a DWDM shelf.

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• The first west AD-xC or AD-xB card COM RX port is connected to the west OPT-PRE or 
OSC-CSM COM TX port.

• The first west AD-xC or AD-xB card COM TX port is connected to the west OPT-BST or 
OSC-CSM COM RX port.

• The first east AD-xC or AD-xB card COM RX port is connected to the east OPT-PRE or 
OSC-CSM COM TX port.

• The first east AD-xC or AD-xB card COM TX port is connected to the east OPT-BST or 
OSC-CSM RX port.

• If a west OPT-PRE is present, the west OPT-BST or OSC-CSM COM TX port is connected to the 
west OPT-PRE COM RX port.

• If an east OPT-PRE is present, the east OPT-BST or OSC-CSM COM TX port is connected to the 
east OPT-PRE COM RX port.

Step 3 Consult the following rules for OADM node add/drop path cabled connections:

• AD-xB add/drop (RX or TX) ports are only connected to the following ports:

– 4MD COM TX or 4MD COM RX ports

– Another AD-xB add/drop port (a pass-through configuration)

• An AD-xB add/drop band port is only connected to a 4MD card belonging to the same band.

• For each specific AD-xB, the add and drop ports for that band card are connected to the COM TX 
and COM RX ports of the same 4MD card.

• The AD-xB and 4MD cards are located in the same side (the connected ports will all have the same 
line direction).

Step 4 Consult the following rules for OADM node pass-through path cabled connections:

• Pass-through connections are only established between add and drop ports on the same band or 
channel and same line direction.

• Only connect AD-xC or AD-xB add/drop ports to other AD-xC or AD-xB add/drop ports (as 
pass-through configurations).

• An add (RX) port is only connected to a drop (TX) port.

• Only connect 4MD client input/output ports to other 4MD client input/output ports.

• A west AD-xB drop (TX) port is connected to the corresponding west 4MD COM RX port.

• A west AD-xB add (RX) port is connected to the corresponding west 4MD COM TX port.

• An east AD-xB drop (TX) port is connected to the corresponding east 4MD COM RX port.

• An east AD-xB add (RX) port is connected to the corresponding east 4MD COM TX port.

Figure 3-15 shows an example of an amplified OADM node with AD-1C-xx.x cards installed. 

Note Figure 3-15 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.
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Figure 3-15 Fibering an Amplified OADM Node

1 West DCU TX to west OPT-PRE DC RX1 9 West AD-1C-xx.x EXP RX to east AD-1C-xx.x EXP 
TX

2 West DCU RX to west OPT-PRE DC TX1 10 East TXP_MR_2.5G DWDM RX to east 
AD-1C-xx.x(15xx.xx) TX

3 West OPT-BST COM TX to west OPT-PRE COM RX 11 East TXP_MR_2.5G DWDM TX to east AD-1C-xx.x 
(15xx.xx) RX
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Figure 3-16 shows an example of a passive OADM node with two AD-1C-xx.x cards installed.

Note Figure 3-16 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.

4 West OPT-BST COM RX to west AD-1C-xx.x COM 
TX

12 East AD-1C-xx.x COM RX to OPT-PRE COM TX

5 West OPT-PRE COM TX to west AD-1C-xx.x COM 
RX

13 East AD-1C-xx.x COM TX to OPT-BST COM RX

6 West AD-1C-xx.x (15xx.xx) RX to west 
TXP_MR_2.5G DWDM TX

14 East OPT-PRE COM RX to east OPT-BST COM TX

7 West AD-1C-xx.x (15xx.xx) TX to west 
TXP_MR_2.5G DWDM RX

15 East DCU TX to east OPT-PRE DC RX1

8 West AD-1C-xx.x EXP TX to east AD-1C-xx.x EXP 
RX

16 East DCU RX to east OPT-PRE DC TX1

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB must be installed between the OPT-PRE DC ports.
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Figure 3-16 Fibering a Passive OADM Node

Step 5 Plug one end of the fiber cable into the RX port.

Step 6 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST 
cards.)

1 West OSC-CSM COM TX to west AD-1C-xx.x COM 
RX

4 West OSC-CSM EXP RX to east AD-1C-xx.x EXP TX

2 West OSC-CSM COM RX to west AD-1C-xx.x COM 
TX

5 East AD-1C-xx.x COM TX to east OSC-CSM COM RX

3 West OSC-CSM EXP TX to east AD-1C-xx.x EXP RX 6 East AD-1C-xx.x COM RX to east OSC-CSM COM TX 
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Step 7 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 8 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 9 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 10 Plug the other end of the cable into the TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 11 Repeat Step 5 until you have connected the nodes according to the site plan.

Step 12 Return to your originating procedure (NTP). 

DLP-G71 Install Fiber-Optic Cables for an ROADM Node

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Note To avoid errors, connect fiber-optic cable in fiber connections so that the farthest slot to the right 
represents the east port, and the farthest slot to the left represents the west port. Inter-shelf, line side 
connections (connections that span between adjacent sites), should be made such that fiber connected to 
an east port on one node connects into the west port on an adjacent node. 

Purpose This task gives instructions, rules, and examples to install fiber-optic cables 
on an reconfigurable optical add/drop multiplexing (ROADM) node in a 
DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 12-22

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site 
when completing connections. Before you begin connecting fiber-optic cabling for ROADM nodes, read 
and understand the following rules:

• The west OPT-BST or OSC-CSM COM TX port is connected to the west OPT-PRE COM RX port.

• The west OPT-PRE COM TX port is connected to the west 32WSS COM RX port.

• The west OPT-BST or OSC-CSM COM RX port is connected to the west 32WSS COM TX port.

• The west OPT-BST (if installed) OSC TX port is connected to the west OSCM RX port.

• The west OPT-BST (if installed) OSC RX port is connected to the west OSCM TX port.

• The west 32WSS EXP TX port is connected to the east 32WSS EXP RX port.

• The west 32WSS EXP RX port is connected to the east 32WSS EXP TX port.

• The west 32WSS DROP TX port is connected to the west 32DMX COM RX port.

• The east OPT-BST or OSC-CSM COM TX port is connected to the east OPT-PRE COM RX port.

• The east OPT-PRE COM TX port is connected to the east 32WSS COM RX port.

• The east OPT-BST or OSC-CSM COM RX port is connected to the east 32WSS COM TX port.

• The east OPT-BST (if installed) OSC TX port is connected to the east OSCM RX port.

• The east OPT-BST (if installed) OSC RX port is connected to the east OSCM TX port.

• The east 32WSS DROP TX port is connected to the east 32DMX COM RX port.

Figure 3-17 shows an example of an amplified ROADM node with cabling. 

Note Figure 3-17 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner 
Internal Connections table for your site.
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Figure 3-17 Fibering an ROADM Node

1 West DCU TX to west OPT-PRE DC RX1 8 West 32WSS EXP RX to east 32WSS EXP TX

2 West DCU RX to west OPT-PRE DC TX1 9 East 32DMX COM RX to east 32WSS DROP TX

3 West OPT-BST COM TX to west OPT-PRE COM RX 10 East 32WSS COM RX to east OPT-PRE COM TX

4 West 32WSS COM TX to west OPT-BST COM RX 11 East 32WSS COM TX to east OPT-BST COM RX
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Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations and Ring ID” procedure on page 3-74) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 2 Plug one end of the fiber into the desired RX port.

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32WSS, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary (Figure 14-35 on page 14-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 7 Plug the other end of the cable into the correct TX port.

Step 8 Repeat Step 2 until you have connected the node(s) according to the site plan.

Step 9 Return to your originating procedure (NTP). 

5 West 32WSS COM RX to west OPT-PRE COM TX 12 East OPT-BST COM TX to east OPT-PRE COM RX 

6 West 32DMX COM RX to west 32WSS DROP TX 13 East DCU RX to east OPT-PRE DC TX1

7 West 32WSS EXP TX to east 32WSS EXP RX 14 East DCU TX to east OPT-PRE DC RX1

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB must be installed between the OPT-PRE DC ports.
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NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, 
or ROADM Node and the Transponder Cards

Step 1 On the front of the patch-panel tray, push the tabs on the left and right sides inward to release the lock 
on the tray. 

Step 2 Pull the patch-panel tray away from the shelf until it is fully opened.To install fiber-optic cables between 
a hub, terminal, or ROADM node and the transponder (TXP) cards, perform the following tasks:

Purpose This procedure routes fiber-optic cables to the patch panel from 32MUX-O, 
32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM 
node; and from the patch panel to TXP/MXP cards.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Terminal node:

• 32DMX-O card (1)

• 32MUX-O card (1)

• Patch panel (1)

• Fiber-optic cables, terminated on one end with one multifiber push-on 
(MPO) connector and 8 LC-type connectors on the other end (8)

Hub node:

• 32DMX-O card (2)

• 32MUX-O card (2)

• Patch panel (2)

• Fiber-optic cables, terminated on one end with one (MPO) connector 
and 8 LC-type connectors on the other end (16)

ROADM node:

• 32WSS card (2)

• 32DMX card (2)

• Patch panel (2)

• Fiber-optic cables, terminated on one end with one (MPO) connector 
and 8 LC-type connectors on the other end (16)

Fiber-optic cables

Prerequisite Procedures DLP-G28 Install the Fiber Patch-Panel Tray, page 1-65

DLP-G29 Install the Fiber-Storage Tray, page 1-66

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-39

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Patch Panel, page 3-64

• DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel, page 3-68

Step 3 To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure.

DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Patch Panel

Note For a ROADM or hub node, two patch panels will be used, one for the east side and one for the west. 
The east side 32WSS/32DMX card will connect to the east patch panel. The west side 32WSS/32DMX 
card will connect to the west patch panel.

Purpose This task describes how to route fiber-optic cables to the patch panel from 
32MUX-O, 32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or 
ROADM node.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Terminal node:

• 32DMX-O card (1)

• 32MUX-O card (1)

• Patch panel (1)

• Multifiber push-on (MPO) cables (8)

Hub node:

• 32DMX-O card (2)

• 32MUX-O card (2)

• Patch panel (2)

• MPO cables (16)

ROADM node:

• 32WSS card (2)

• 32DMX card (2)

• Patch panel (2)

• MPO cables (16)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-39

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 4 Choose either the east or west-side of the shelf to cable the 32WSS and 32DMX cards, or 32MUX-O 
and 32DMX-O cards.

Step 5 On the patch panel, pull up firmly on the two latches and use them to slide the patch panel up until it 
snaps in place above the tray (Figure 3-18).

Figure 3-18 Using the Patch-Panel Latches to Slide the Patch Panel Away from the Tray

Step 6 At the 32WSS or 32MUX-O card in the node, plug the MPO connector of an MPO cable (Figure 3-19) 
into the top Add RX port (30.3 -36.6) of the card. If you are connecting to the next MPO cable, plug it 
into the MPO connector below the previous MPO cable.
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Figure 3-19 MPO Cable
.

Step 7 Route the MPO cable slack through the patch-panel tray as necessary.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure adequate cable slack remains.

Step 8 While facing the front of the patch panel, at the rear of the patch panel plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the bottom row of the patch 
panel. You should plug the fan-out cables from left to right (as you face the patch panel), following the 
numbers tagged (1 through 8) on the cables. 

Figure 3-20 shows the patch-panel connectors from the rear of the patch-panel tray. Figure 3-21 shows 
the assigned wavelengths for each port on the patch panel, as indicated at the top of the patch-panel bar. 
The numbers on the patch-panel bar correspond to a 15xx.xx wavelength on the ITU grid.
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Figure 3-20 Rear View of the Patch Panel
.

Figure 3-21 Top View of the Patch-Panel Bar

Step 9 As necessary, repeat Steps 6 through 8 for the remaining three Add Rx ports on the 32WSS or 
MUX-O card, until all 32 connectors on the bottom row of the rear of the patch panel are connected. 

Step 10 At the adjacent 32DMX or DMX-O card in that side of the shelf, plug the MPO connector of an MPO 
cable into the top ADD RX port (30.3 -36.6) of the 32DMX or DMX-O card. If you are connecting to 
the next MPO cable, plug it into the MPO connector below the previous MPO cable.

Step 11 Route the MPO cable slack through the patch-panel tray as necessary.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure adequate cable slack remains.

Step 12 While facing the front of the patch panel, at the rear of the patch panel plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the top row of the patch panel. 
You should plug the fan-out cables from left to right (as you face the patch panel), following the numbers 
tagged (1 through 8) on the cables.

Step 13 As necessary, repeat Steps 10 through 12 for the remaining three Add Rx ports on the 32DMX card, until 
all 24 connectors on the top row of the rear of the patch panel are connected.

Step 14 For a hub or ROADM node, repeat Steps 6 through 13 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 15.

Step 15 Return to your originating procedure (NTP).
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DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel

Step 1 At the appropriate TXP/MXP card, plug a fiber-optic cable into the TX port of the DWDM connector. 

Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-38 on page 14-40).

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

Step 3 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
bottom row that corresponds to the wavelength to which the TXP/MXP port is tuned. (See Figure 3-21 
on page 3-67 for a view of the wavelengths assigned to the patch-panel connectors). 

Figure 3-22 shows the patch-panel connectors from the front of the patch-panel tray. 

Figure 3-22 Front View of the Patch Panel
.

Step 4 Plug a fiber-optic cable into the RX port of the DWDM connector on that TXP/MXP card.

Step 5 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
top row that corresponds to the wavelength to which the TXP/MXP port is tuned.

Step 6 Repeat Steps 1 through 5 for all of the TXP/MXP cards you want to connect to this patch panel.

Purpose This task describes how to route fiber-optic cables from the patch panel to 
TXP/MXP cards in a transponder/muxponder shelf.

Tools/Equipment TXP/MXP card(s)

Fiber-optic cable(s)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-39

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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3-68
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 3      Turn Up a Node
Before You Begin
Step 7 Return to your originating procedure (NTP).

.

NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection 
Modules

Note See the “14.4 FlexLayer and Y-Cable Protection” section on page 14-9 for more information about 
Y-cable protection.

Step 1 Install fiber-optic cables between the TXP/MXP cards and Y-cable module, and between the client 
device(s) and Y-cable module. As needed, route slack fiber-optic cable around the round cable retainers 
in the fiber-storage tray as you install cables between the Y-cable module and TXP/MXP cards 
(Figure 14-38 on page 14-40). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure adequate cable slack remains.

To protect one client signal, connect the fiber-optic cables according to either Table 3-5 or Table 3-6. To 
protect two client signals using a single Y-cable module, connect the cables according to both Table 3-5 
and Table 3-6.

Purpose This procedure installs and routes fiber-optic cables from the client signal 
to the Y-cable protection module (single mode or multimode), and from the 
Y-cable module to the transponder node. Using one Y-cable protection 
module, you can protect one client signal with two TXP/MXP cards, and 
two client signals with four TXP/MXP cards.

Tools/Equipment Fiber-optic cables

Prerequisite Procedures DLP-G32 Install the Y-Cable Protection Modules, page 1-69

NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 3-5 Cable Connections for Y-Cable Protection of One Client Signal

From To (Y-Cable Port Number)

Client 1 TX port 10

Client 1 RX port 5

TXP/MXP 1 TX port 1

TXP/MXP 1 RX port 2
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Stop. You have completed this procedure.

NTP-G36 Calculate Cable Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to provision the 
DWDM cable connections. If you are already logged in, continue with Step 2.

Step 2 Click the Provisioning > WDM-ANS > Connections tabs.

Step 3 Click Calculate Connections. 

CTC verifies that the cards installed in the ONS 15454 shelf are compatible and will operate together as 
a valid DWDM node configuration. Furthermore, based on the cards installed or pre-provisioned, CTC 
calculates the intra-shelf patch cords that are expected to be installed. If the cards are not compatible or 
missing, for example, if an OPT-BST is installed but an OSCM card is not installed, the calculate 
connections function generates an error.

TXP/MXP 2TX port 6

TXP/MXP 2RX port 7

Table 3-6 Cable Connections for Y-Cable Protection of a Second Client Signal

From To (Y-Cable Port Number)

Client 2 TX port 12

Client 2 RX port 11

TXP/MXP 3 TX port 3

TXP/MXP 3 RX port 4

TXP/MXP 4 TX port 8

TXP/MXP 4 RX port 9

Table 3-5 Cable Connections for Y-Cable Protection of One Client Signal (continued)

From To (Y-Cable Port Number)

Purpose This procedure verifies the cards that are installed in the shelf and 
calculates the connections that should be provisioned for them.

Tools/Equipment Cisco MetroPlanner shelf layout

Cisco MetroPlanner Internal Connections table

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-4

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Note The connections calculation is not based on the Cisco MetroPlanner shelf layout. Calculations 
are based on the cards that are physically installed. If the Cisco MetroPlanner shelf layout calls 
for a hub node but OADM cards are installed, CTC calculates connections based on the cards 
expected for an OADM node.

Step 4 If no errors were generated, continue with Step 5. If errors appear, verify that the cards installed in the 
shelf match the Cisco MetroPlanner shelf layout. If the wrong cards are installed or are missing, install 
the correct cards following the “NTP-G30 Install the DWDM Cards” procedure on page 3-27. 

Step 5 Verify that the connections in the CTC Connections tab match the connections in the Cisco MetroPlanner 
Internal Connections table. The CTC Connections tab will not show OPT-PRE dispersion compensation 
units (DCUs), connections, span connections, or connections between TXP and MXP cards and the 
DWDM cards.

Step 6 Complete the “DLP-G72 Create a DWDM Connection” task on page 3-71 for any connections that 
require manual provisioning. (Connections that require manual creation are indicated by a “Yes” in the 
Cisco MetroPlanner Internal Connections table Manually Set column.) If you need to delete a 
connection, complete the “DLP-G73 Delete a DWDM Connection” task on page 3-72.

Note Although CTC calculates most DWDM connections automatically, some connections cannot be 
calculated because of the DWDM card type and position. You must create these connections 
manually. For example, connections related to optical bypass circuits must be manually 
provisioned. 

Stop. You have completed this procedure.

DLP-G72 Create a DWDM Connection

Step 1 In node view, click the Provisioning > WDM-ANS > Connections tabs.

Step 2 Click Create.

Step 3 In the Create Optical Link dialog box, choose the From and To slots and ports from the drop-down lists.

Step 4 If the connection is unidirectional, uncheck the bidirectional check box.

Step 5 Click OK. The new connection appears in the Connections table, but its State is “Uncommitted.”

Step 6 Click the new connection in the table. Click Commit. The connection state changes to “Connected.”

Purpose This task creates a DWDM connection manually when CTC is unable to 
calculate the connections automatically.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 7 If you need to create additional connections, repeat Steps 2 through 6 for each new connection. If not, 
continue with Step 8.

Step 8 Return to your originating procedure (NTP).

DLP-G73 Delete a DWDM Connection

Step 1 In node view, click the Provisioning > WDM-ANS > Connection tabs.

Step 2 Click the connection you want to delete.

Step 3 Click Delete, then click Yes.

Step 4 Return to your originating procedure (NTP).

NTP-G138 Import a Cisco MetroPlanner Configuration File

Caution Importing the correct Cisco MetroPlanner configuration file is very important. Verify that have the 
correct MetroPlanner configuration file for your node before you begin this task. The file will have the 
same name as the node name in Cisco MetroPlanner.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to run automatic 
node setup. If you are already logged in, continue with Step 3.

Step 2 In CTC node view, click the Provisioning > WDM-ANS > Provisioning tabs.

Step 3 Click Import. The Import NE Update From File dialog box opens.

Purpose This task deletes a DWDM connection.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task imports the Cisco MetroPlanner Assisted Configuration Setup 
file into a node to configure the node automatically.

Tools/Equipment A Cisco MetroPlanner Assisted Configuration Setup file prepared for the 
node must be available on a local or network drive

Cisco MetroPlanner Installation Parameters

Prerequisite Procedures NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 4 Enter the path to the Assisted Configuration Setup file (see Table 3-1 on page 3-3), or click Browse and 
navigate to the configuration file using the Open dialog box. Click Open.

Step 5 Click OK. 

Step 6 Click OK on the import confirmation. 

The Import NE Update From File dialog box closes, and the MetroPlanner configuration settings are 
imported.

Step 7 Verify that the imported parameters are correct according to the printout of the MetroPlanner parameters 
file.

Stop. You have completed this procedure.

NTP-G37 Run Automatic Node Setup

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to run automatic 
node setup. If you are already logged in, continue with Step 2.

Step 2 Referring to the Cisco MetroPlanner Installation Parameters (see Table 3-1 on page 3-3), identify the 
parameters that have a Yes in the Manually Set column. If there are no parameters that have a Yes in the 
Manually Set column, continue with Step 6.

Step 3 In CTC, display the card where the parameter is to be provisioned in card view.

Step 4 Enter the specified Calibration parameter from the Cisco MetroPlanner Installation Parameters table. 
Click Apply.

Step 5 Repeat Steps 2 through 4 for all parameters in the Cisco MetroPlanner Installation Parameters table that 
display Yes in the Manually Set field.

Step 6 Change to node view.

Step 7 Click the Provisioning > WDM-ANS > Port Status tab. 

Step 8 Click Launch ANS. 

Step 9 In the Apply Launch ANS dialog box, click Yes. 

Step 10 In the Launch ANS confirmation dialog box, click OK. 

Step 11 Verify that one of the following statuses appears in the Link Status column for all ports. 

Purpose This procedure runs the CTC DWDM automatic node setup (ANS) 
function. ANS adjusts the values of the variable optical attenuators to 
equalize the per-channel power at the amplifier level.

Tools/Equipment The Cisco MetroPlanner Installation Parameters file

Prerequisite Procedures NTP-G36 Calculate Cable Connections, page 3-70

NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-72

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not Applicable—The parameter setpoint does not apply to this node type.

If one of the following statuses is shown, complete the provided instructions:

• Fail - Out of Range—The calculated setpoint is outside the expected range. Repeat the “NTP-G36 
Calculate Cable Connections” procedure on page 3-70 to verify that all connections were 
provisioned correctly, paying attention to connections that require manual provisioning.

Note The Fail - Out of Range condition must be cleared before proceeding. Contact your next 
level of support if you are unable to clear this status.

• Fail - Port in IS State—The parameter could not be calculated because the port is in-service. This 
status should normally not appear at this point in node turnup. If it does, display the card in card 
view, change the port admin state to OOS,DSLB (ANSI) or Locked,disabled (ETSI) and repeat 
Steps 6 through 11. 

Stop. You have completed this procedure.

NTP-G38 Provision OSC Terminations and Ring ID

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to provision the 
OSC Terminations. If you are already logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > Comm Channels > OSC tabs.

Step 3 In the OSC Terminations pane, click Create (Figure 3-23).

Purpose This procedure provisions the OSC terminations and Ring ID.

Tools/Equipment None

Prerequisite Procedures NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-72

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Figure 3-23 OSC Terminations Pane

Step 4 In the Create OSC Terminations dialog box, choose the ports where you want to create the OSC 
termination. To select more than one port, press the Shift key (to select a range of ports) or the Ctrl key 
(to select multiple individual ports), and click OK.

Note OSC on the DWDM node uses a separate OC3/STM1 channel to transport the section data 
communications channel (SDCC), which is used for ONS 15454 DCC terminations. 

Ports are automatically placed in service. Until network OSC connections between adjacent nodes are 
created. The following alarms might appear: 

• SDCC Termination Failure alarm on the OSCM or OSC-CSM card

• LOS-P alarm on the OC-3 port (port #1) on the OSCM or OSC-CSM card

• OPWR-LFAIL alarm on the OPT-BST or OSC-CSM card

Note After the OSC termination is created, the line ports are placed in service and span power levels 
are checked.

Step 5 In node view, click the Provisioning > Comm Channels > OSC tabs.

Step 6 Click the OSC tab.

Step 7 In the DWDM Ring ID area, click Create.

Step 8 In the DWDM Ring ID dialog box, enter the following information: 

11
57

98

Comm Channels
tab

Provisioning
tab

Create OSC Terminations
dialog box
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• Ring ID—Enter the same ID for all nodes on the ring. Choose a number from 1 to 255. The default 
value to be applied is 1. This applies to all nodes in the network.

• West Line—Select a card from the drop-down list. Selectable cards are OSCM or OSC-CSM. 
Slots 1 through 8 represent the west side of the node.

• East Line—Select a card from the drop-down list. Selectable cards are OSCM or OSC-CSM. 
Slots 10 through 17 represent the east side of the node.

Step 9 Click OK. 

Stop. You have completed this procedure.

NTP-G39 Verify OSCM and OSC-CSM Transmit Power

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to verify the 
OSCM or OSC-CSM transmit power. If you are already logged in, continue with Step 2.

Step 2 In the node view shelf graphic, double-click the west OSCM or OSC-CSM card.

Step 3 Click the Maintenance > ALS tabs.

Step 4 Click the table cell under ALS Mode and choose Disable from the drop-down list. Click Apply.

Step 5 If a second OSC-CSM or OSCM card is installed, repeat Steps 2 through 4 on the second card. If not, or 
if you have completed the steps, continue with Step 6.

Step 6 Complete one of the following tasks, depending on whether you are checking an OSC-CSM or OSCM 
card:

• DLP-G313 Verify OSC-CSM Transmit Power, page 3-77

• DLP-G314 Verify OSCM Transmit Power, page 3-78

Step 7 Display the OSC-CSM or OSCM in card view.

Step 8 Click the Maintenance > ALS tabs.

Step 9 From the ALS Mode drop-down list, choose AutoRestart. Click Apply.

Step 10 If a second OSC-CSM or OSCM card is installed, repeat Steps 7 through 9 on the second card. 

Stop. You have completed this procedure.

Purpose This procedure verifies the transmit power of the ONS 15454 Optical 
Service Channel Module (OSCM) and the Optical Service Channel + 
Combiner Separator Module (OSC-CSM).

Tools/Equipment None

Prerequisite Procedures NTP-G37 Run Automatic Node Setup, page 3-73

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G313 Verify OSC-CSM Transmit Power

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17. 

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Locate the Power parameter for Port 7, then record the value_______. If an OPT-PRE card is installed 
in the same side of the shelf as the OSC-CSM, continue with Step 4. If not, continue with Step 7.

Step 4 Change to node view, then click the Provisioning > WDM-ANS tabs. 

Step 5 Record the amplifier working mode value from one of the following:

For OSC-CSM cards installed on the east side:

a. In the Selector window on the left, expand the East Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight Working Mode.

d. Record the EastSide.Rx.Amplifier.Working Mode parameter displayed on the right side of the pane.

For OSC-CSM cards installed on the west side:

a. In the Selector window on the left, expand the West Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight Working Mode.

d. Record the WestSide.Rx.Amplifier.Working Mode parameter displayed on the right side of the pane.

Step 6 If the value recorded in Step 5 is Control Gain, continue with Step 7. If the value recorded in Step 5 is 
Control Power, verify that the value recorded in Step 3 is equal to –1.5 dBm, +/- .5 dBm. If so, continue 
with Step 9. If not, complete the following steps:

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI off. If so, continue 
with Step b. If not, click the cell and choose Off from the drop-down list. Click Apply, then click 
Yes.

b. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

c. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

d. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

e. Repeat Steps 3 through 8. If the power level is still not within the specified range, contact your next 
level of support.

Purpose This procedure verifies the transmit power of the OSC_CSM card.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 7 In node view, click the Provisioning > WDM-ANS tabs. Record the Add&Drop - Output Power value 
for the following:

a. If an OSC-CSM is not installed on the east side, continue with Step e. If an OSC-CSM card is 
installed on the east side, in the Selector window on the left, expand the East Side parameters tree 
view.

b. Expand the TX category.

c. Expand the Power category, then highlight Add&Drop - Output Power.

d. Record the EastSide.Tx.Power.Add&Drop - Output Power parameter displayed on the right side of 
the pane.

e. An OSC-CSM is not installed on the west side, continue with Step 8. OSC-CSM is installed on the 
west side, in the Selector window on the left, expand the West Side parameters tree view.

f. Expand the TX category.

g. Expand the Power category, then highlight Add&Drop - Output Power

h. View the WestSide.Tx.Power.Add&Drop - Output Power parameter displayed on the right side of 
the pane.

Step 8 Verify that the power value recorded in Step 3 is equal to the value recorded in Step 7 or –6.5 dBm, 
whichever is less, +/– .5 dBm. If the power level is not within this range, complete the following steps. 
Otherwise, continue with Step 9.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI off. If not, click 
the cell and choose Off from the drop-down list. Click Apply, then click Yes.

b. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on 
page 12-22.

c. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

d. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

e. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

f. Repeat Steps 3 through 8. If the power level is still not within the specified range, contact your next 
level of support.

Step 9 Return to your originating procedure.

DLP-G314 Verify OSCM Transmit Power

Purpose This procedure verifies the transmit power of the OSCM card.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17. 

Step 1 Display the OSCM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Record the Port 3 Power value _____. If an OPT-PRE card is installed in the same side of the shelf as 
the OSCM, continue with Step 4. If not, verify that the value is equal to –5 dBm +/– .5 dBm. If so, 
continue with Step 7. If not, continue with Step 6, Substep a. 

Step 4 Change to node view, then click the Provisioning > WDM-ANS tabs.

Step 5 Record the amplifier working mode value from one of the following:

For OSCM cards installed on the east side:

a. In the Selector window on the left, expand the East Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight Working Mode.

d. Record the EastSide.Rx.Amplifier.Working Mode parameter displayed on the right side of the pane.

For OCSM cards installed on the west side:

a. In the Selector window on the left, expand the West Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight Working Mode.

d. Record the WestSide.Rx.Amplifier.Working Mode parameter displayed on the right side of the pane.

Step 6 If the working mode recorded in Step 5 is Control Gain, verify that the value recorded in Step 3 is equal 
to –5 dBm +/– .5 dBm. If the value recorded in Step 5 is Control Power, verify that the value recorded 
in Step 3 is equal to 0.5 dBm, +/– .5 dBm. If the power level is not within this range, complete the 
following steps. Otherwise, continue with Step 7.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI off. If not, click 
the cell and choose Off from the drop-down list. Click Apply, then click Yes.

b. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on 
page 12-22.

c. Complete the following procedures:

– Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

– Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

– Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” 
procedure on page 3-74.

d. Repeat Steps 3 through 8. If the power level is still not within the specified range, contact your next 
level of support.

Step 7 Return to your originating procedure.
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C H A P T E R 4

Perform Node Acceptance Tests

This chapter provides test procedures to verify the cards installed in the ONS 15454 are performing 
correctly. The procedures are optional.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI (SONET) and ETSI (SDH) shelf 
assemblies.

Before You Begin
This section lists the non-trouble procedures (NTPs) that you need to complete to validate a DWDM 
node. Turn to a procedure for applicable detailed level procedures (DLPs).

1. NTP-G41 Perform the Terminal and Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test, page 4-2—Complete this procedure to test terminal and hub nodes with 32MUX-O and 
32DMX-O cards installed.

2. NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test, page 
4-5—Complete this procedure to test terminal nodes with 32WSS and 32DMX cards installed.

3. NTP-G43 Perform the ROADM Node Acceptance Test, page 4-8—Complete this procedure to test 
ROADM nodes.

4. NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test, page 4-20—Complete this procedure 
to test anti-ASE hub nodes.

5. NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test, page 
4-23—Complete this procedure to test line amplifier nodes with OSCM cards installed on both the 
east and west sides of the shelf.

6. NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test, page 
4-26—Complete this procedure to test line amplifier nodes with OSC-CSM cards installed on both 
the east and west sides of the shelf.

7. NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test, 
page 4-30—Complete this procedure to test line amplifier nodes with OSCM and OSC-CSM cards 
installed.

8. NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards, page 
4-33—Complete this procedure to test OADM nodes with OSCM cards installed on both the east 
and west sides of the shelf.
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9. NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 4-35—Complete this procedure to test OADM nodes with OSC-CSM and OPT-BST 
cards installed on both the east and west sides of the shelf.

10. NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 4-37—Complete this procedure to test OADM nodes with OSC-CSM cards installed on 
both the east and west sides of the shelf and no OPT-BST cards.

NTP-G41 Perform the Terminal and Hub Node with 32MUX-O 
and 32DMX-O Cards Acceptance Test

Note This procedure tests the west side of hub nodes first, then the east side. If you are testing a terminal node, 
apply instructions for the west side of the hub node to the terminal side (east or west) of the terminal 
node.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the hub or terminal node that you want to 
test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Note If OSC terminations are created, there will be two alarms, one for low power on the Optical 
Booster (OPT-BST) card, and the other an OSC channel alarm.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73. 

Purpose This procedure tests a DWDM terminal or hub node with 32MUX-O and 
32DMX-O cards. 

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

An optical power meter or optical spectrum analyzer

2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 5 Create a physical loopback on the west or terminal OPT-BST amplifier by using a patch cord with 10-dB 
bulk attenuators to connect the LINE TX port to the LINE RX port.

Note An “SDCC Termination Failure” alarm will appear due to the OSC signal loopback.

Step 6 Verify that the OSC link becomes active on the west Optical Service Channel Module (OSCM) or Optical 
Service Channel and Combiner/Separator Module (OSC-CSM). (The OSC termination must already be 
provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.)

Step 7 Set the tunable laser or the TXP_MR_2.5G card to the first wavelength (1530.33 nm) of the 100-GHz 
ITU-T grid. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision 
TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 8 Connect the tunable laser transmitter or TXP_MR_2.5G card DWDM TX port to the CHAN RX 01 port 
on the west (or terminal) 32-Channel Multiplexer (32MUX-O) card using the available patch panel. 

Step 9 Display the west (or terminal) 32MUX-O card in card view.

Step 10 Click the Provisioning > Optical Chn > Parameters tabs.

Step 11 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 12 Verify that the Port 1 power level reaches the provisioned VOA (variable optical attenuator) Power Ref 
setpoint. 

Note The tunable laser minimum output optical power (Pout) must be 6 dBm. If the output power is 
lower than the specified value, the 32MUX-O card might not reach the provisioned setpoint.

Step 13 If an OPT-BST card is installed, complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and 
Power” task on page 4-39 on the west (or terminal side) OPT-BST to ensure that the amplifier is working 
properly.

Step 14 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 on the west 
(or terminal) OPT-PRE to ensure that the amplifier is working properly.

Step 15 Restore the default IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) admin state to the 
32MUX-O port that was changed to OOS,MT (ANSI) or Locked,maintenance (ETSI) in Step 11.

Step 16 Repeat Steps 7 through 15 for the remaining 32 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all VOAs inside the 32MUX-O card.

Step 17 Remove the loopback created in Step 5.

Step 18 If the node is a hub node, repeat Steps 5 through 17 for the east side cards. 

Step 19 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 20 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.
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Stop. You have completed this procedure.

DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing

Step 1 If you have installed and verified the TXP_MR-2.5G cards, continue with Step 3. If you have not 
installed the TXP cards, verify that you have TXP_MR_2.5G cards for every wavelength that you will 
test. Table 4-1 lists the TXP_MR_2.5G part numbers and wavelengths.

Step 2 Install each TXP card using the “NTP-G32 Install the Transponder and Muxponder Cards” procedure on 
page 3-31. If there are not enough open slots to install all the cards at one time, you can perform the 
acceptance tests one TXP at a time. However, you will need to uninstall and install the TXP cards for 
the wavelengths being tested.

Step 3 Display the TXP_MR_2.5G for the first wavelength you are testing (see Table 4-1) in card view.

Step 4 Click the Provisioning > Line > [Service Type] subtabs where [Service Type] is either SONET (ANSI) 
or SDH (ETSI).

Step 5 Click the Admin State column for the trunk port and choose OOS,Disable (ANSI) or Unlocked,disable 
(ETSI) from the drop-down list.

Step 6 Click Apply, then click Yes.

Purpose This procedure provisions a TXP_MR_2.5G card for acceptance testing 
when a tunable laser is not available.

Tools/Equipment Eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see 
Table 4-1)

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-39

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser

Table 4-1 TXP_MR_2.5G Card Wavelengths and Part Numbers

Part Number Wavelengths

15454-MR-L1-30.3 1530.33 – 1532.68

15454-MR-L1-34.2 1534.25 –1536.61

15454-MR-L1-38.1 1538.19 – 1540.56

15454-MR-L1-42.1 1542.14 – 1544.53

15454-MR-L1-46.1 1546.12 – 1548.51

15454-MR-L1-50.1 1550.12 – 1552.52

15454-MR-L1-54.1 1554.13 – 1556.55

15454-MR-L1-58.1 1558.17 – 1560.61
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Step 7 Click the Provisioning > Card subtabs.

Step 8 In the Wavelength field, choose the first wavelength required by the acceptance test.

Step 9 Click Apply.

Step 10 Click the Provisioning > Line > [Service Type] subtabs.

Step 11 Click the Admin State column for the trunk port and choose OOS,Maintenance (ANSI) or 
Unlocked,Maintenance (ETSI) from the drop-down list.

Step 12 Click Apply, then click Yes.

Step 13 Connect a power meter to the DWDM TX port. Verify that the output power falls within –4.5 dBm and 
1 dBm. If it does not fall within this range, replace the card or contact your next level of support.

Step 14 Repeat Steps 3 through 13 for all the installed TXP cards. 

Step 15 Return to the originating procedure (NTP).

NTP-G42 Perform the Terminal Node with 32WSS and 32DMX 
Cards Acceptance Test

Note This procedure creates an optical loopback on the OPT-BST line. An optical signal is sent from the 
32WSS input (add) to the OPT-BST common RX and back out the OPT-BST TX line. The OPT-BST line 
receives the looped signal from the OPT-BST TX. It then passes the signal to the OPT-BST common TX 
and into the OPT-PRE common RX. The OPT-PRE sends the signal to the 32DMX. The optical signal 
from the tunable laser or TXP_MR_2.5G must pass successfully through the 32WSS and out the 
32DMX.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the hub or terminal node that you want to 
test. If you are already logged in, continue with Step 2.

Step 2 Display the terminal node in node view.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

Purpose This procedure tests a DWDM terminal node with 32WSS and 32DMX 
cards installed. 

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

• An optical power meter or optical spectrum analyzer

• 1 bulk attenuator (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Note If OSC terminations are created, an OSC channel alarm will appear.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, or 
if errors (indicated in red) appear, delete the OSC channels and complete the “NTP-G37 Run Automatic 
Node Setup” procedure on page 3-73. Provision the OSC channels when complete.

Step 5 Create a physical loopback on the OPT-BST or OCSM or OSC-CSM amplifier by using a patch cord with 
10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note An “SDCC Termination Failure” alarm will appear due to the OSC signal loopback. This is 
observed as an alarm on Port 1 of the OSCM or OSC-CSM card.

Step 6 Wait 90 seconds, then verify that the OSC link is active on the west Optical Service Channel Module 
(OSCM) or Optical Service Channel and Combiner/Separator Module (OSC-CSM) by observing 
whether or not the LOS alarm on the OSCM or OSC-CSM and the OPT-BST card (if present) clears. 
(The OSC Termination must already be provisioned. If not, complete the “NTP-G38 Provision OSC 
Terminations and Ring ID” procedure on page 3-74.)

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 8.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 9.

Step 8 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1, if needed.

Step 9 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the CHAN RX 01 
port on the 32-Channel Wavelength Selective Switch (32WSS) card using the available patch panel. 

Note The tunable laser minimum output optical power (Pout) must be –6 dBm. If the output power is 
lower than –6 dBm, the 32WSS card might not reach the provisioned set point.

Step 10 Display the 32WSS card in card view.

Step 11 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 4-2 on page 4-9, if needed.

Step 12 Click the Admin State table cell for the Add port carrying the tested wavelength, then choose OOS,MT 
(for ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the tested 
wavelength is 1530.33 (shown as 1530.3), you would click the Port 1 Admin State field and choose 
OOS,MT or Locked,maintenance from the drop-down list. 

Step 13 Change the Admin State of the pass-through (PT) port corresponding to the port in Step 8 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 (shown as 
1530.3), you would click the Port 33 Admin State field and choose OOS,MT or Locked,maintenance 
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from the drop-down list. Refer to Table 4-2 on page 4-9, if needed.Click the Provisioning > Optical 
Chn Optical Connector [n] > Parameters tabs, where n = the optical connector number that carries the 
wavelength under test.

Step 14 Click Apply, then click Yes.

Step 15 Click the Maintenance tab.

Step 16 For Channel #1, change Operating Mode to Add Drop.

Step 17 Click Apply, then click Yes.

Step 18 Click the Provisioning > Optical Chn > Parameters tabs.

Step 19 Verify that the actual power coming from the tunable laser or TXP-MR-2.5G card shown under the 
Power column is equal to the specified VOA Power Ref power shown in the same row.

Step 20 Click the Optical Line tab.

Step 21 Verify that the TX COM port (#67) has the same power as the VOA Power Ref set point in Step19. This 
verifies that the optical signal is traveling correctly through the WSS card.

Step 22 Verify that the Port 1 power level reaches the provisioned VOA Power Ref setpoint.

Step 23 If an OPT-BST card is installed, complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and 
Power” task on page 4-39 on the OPT-BST to ensure that the amplifier is working properly.

Step 24 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 on the 
OPT-PRE to ensure that the amplifier is working properly.

Step 25 Complete the “DLP-G269 Verify the 32DMX-O Power” task on page 4-40 or “DLP-G270 Verify the 
32DMX Power” task on page 4-41 to verify the 32DMX-O or 32DMX card is powered correctly.

Step 26 Display the 32WSS in card view.

Step 27 Click the Maintenance tab.

Step 28 For the circuit (channel) under test, click the Operating Mode table cell and choose Not Assigned from 
the drop-down list.

Step 29 Click Apply, then Yes.

Step 30 Click the Provisioning > Optical Chn: Optical Connector tabs.

Step 31 Click the Admin State table cell then choose IS,AINS (for ANSI) or Unlocked,AutomaticInService 
(ETSI) from the drop-down list for all ports that were changed to OOS,MT or Locked,Maintenance.

Step 32 Repeat Steps 7 through 31 for the remaining 31 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all variable optical attenuators (VOAs) inside the 32WSS card.

Step 33 Restore the default admin states to the OPT-BST, OPT-PRE, and 32DMX ports that were changed to 
OOS,MT (ANSI) or Locked,maintenance (ETSI) in Steps 12. Remove the loopback created in Step 5.

Step 34 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 35 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.
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Stop. You have completed this procedure.

NTP-G43 Perform the ROADM Node Acceptance Test

Note Because the node is isolated and no line-side fibers are connected during the test, the power levels going 
into the line-side components will not be the same as a real network setup. Therefore, if the ROADM 
shelf does not contain OPT-BST and OPT-PRE amplifiers on both the east and west sides, you must 
lower the OPT-PRE power thresholds so it turns on properly. At the end of the test, you will run 
automatic node setup to configure the node with the correct parameters for the network acceptance test.

Step 1 Make a copy of Table 4-2 and place it in a convenient location for reference throughout this procedure. 
The table shows the 32WSS ports and wavelengths assigned to them. The 32 wavelengths are divided 
among four physical MPO connectors on the 32WSS card. Each MPO connector is assigned eight 
wavelengths. In CTC, the MPO connector appears in the card view Provisioning > Optical Connector 
subtab. Each Optical Connector subtab represents an MPO connector. Ports 1 through 32 are the receive 
(RX) ports; Ports 33 through 64 are the pass-through (PT) ports. 

Purpose The ROADM node acceptance test verifies that the node is operating 
properly before you connect it to the network. The test verifies that each 
add/drop and pass-through port on the 32WSS and 32DMX card operates 
properly and verifies the operation of the amplifiers. The test also checks 
the power levels at each transmit and receive port to ensure that power loss 
in the cabling is within tolerance.

Tools/Equipment • A tunable laser or eight TXP cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
4-8
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 4      Perform Node Acceptance Tests
Before You Begin
Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the ROADM node that you want to test. If 
you are already logged in, continue with Step 3.

Table 4-2 32WSS Ports and Wavelengths Test Checklist

32WSS Provisioning 
Subtab Port # Wavelength

Tested 
PT

Tested 
Add/Drop 
West

Tested 
Add/Drop 
East

Optical Chn: 

Optical Connector 1

RX 1, PT 33 1530.33

RX 2, PT 34 1531.12

RX 3, PT 35 1531.90

RX 4, PT 36 1532.68

RX 5, PT 37 1534.25

RX 6, PT 38 1535.04

RX 7, PT 39 1535.82

RX 8, PT 40 1536.61

Optical Chn: 

Optical Connector 2

RX 9, PT 41 1538.19

RX 10, PT 42 1538.98

RX 11, PT 43 1539.77

RX 12, PT 44 1540.56

RX 13, PT 45 1542.14

RX 14, PT 46 1542.94

RX 15, PT 47 1543.73

RX 16, PT 48 1544.53

Optical Chn: 

Optical Connector 3

RX 17, PT 49 1546.12

RX 18, PT 50 1546.92

RX 19, PT 51 1547.72

RX 20, PT 52 1548.51

RX 21, PT 53 1550.12

RX 22, PT 54 1550.92

RX 23, PT 55 1551.72

RX 24, PT 56 1552.52

Optical Chn: 

Optical Connector 4

RX 25, PT 57 1554.13

RX 26, PT 58 1554.94

RX 27, PT 59 1555.75

RX 28, PT 60 1556.55

RX 29, PT 61 1558.17

RX 30, PT 62 1558.98

RX 31, PT 63 1559.79

RX 32, PT 64 1560.61
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Step 3 Display the ROADM node in node view. 

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Note The OSC terminations created during node turnup will generate two alarms for each side of the 
shelf, one for loss of signal on the Optical Booster (OPT-BST) card, and the other an LOS alarm 
on the OSC_CSM or OSCM card.

Step 5 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 6 Display the east 32WSS in card view.

Step 7 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 4-2 on page 4-9, if needed.

Step 8 Click the Admin State table cell for the Add port carrying the tested wavelength, then choose OOS,MT 
(for ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the tested 
wavelength is 1530.33 (shown as 1530.3), you would click the Port 1 Admin State field and choose 
OOS,MT or Locked,maintenance from the drop-down list. 

Step 9 Change the Admin State of the pass-through (PT) port corresponding to the port in Step 8 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 (shown as 
1530.3), you would click the Port 33 Admin State field and choose OOS,MT or Locked,maintenance 
from the drop-down list. Refer to Table 4-2 on page 4-9, if needed.

Step 10 Click Apply, then click Yes to confirm. 

Step 11 Repeat Steps 7 through 10 for all wavelengths that you will test. 

Step 12 Display the west 32WSS in card view.

Step 13 Repeat Steps 7 through 10 for the west 32WSS card.

Step 14 Display the east 32DMX or 32-DMX-O in card view and complete the steps below:

For a 32-DMX:

a. Choose the Provisioning > Optical Line > Parameters tabs.

b. For Port 33, click the Admin State table cell and choose OOS,MT (ANSI) or Locked,maintenance 
(ETSI) from the drop-down list.

c. Click Apply, then click Yes to confirm. 
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For a 32DMX-O:

a. Choose Provisioning > Optical Chn > Parameters tabs.

b. For each wavelength being tested, click the Admin State table cell and choose OOS,MT (ANSI) or 
Locked,maintenance (ETSI) from the drop-down list.

c. Click Apply, then click Yes to confirm. 

Step 15 Repeat Step 14 for the west 32DMX or 32DMX-O card.

Step 16 Complete the “DLP-G310 Verify ROADM Node Pass-Through Channels” task on page 4-12. 

Step 17 Complete the following tasks for channels that will be added or dropped on the node.

• DLP-G311 Verify the East ROADM Add/Drop Channels, page 4-16. 

• DLP-G312 Verify the West ROADM Add/Drop Channels, page 4-18

Step 18 Display the east 32WSS in card view.

Step 19 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you tested. 

Step 20 Click the Admin State table cell then choose IS,AINS (for ANSI) or Unlocked,AutomaticInService 
(ETSI) from the drop-down list for all ports that were changed to OOS,MT or Locked,Maintenance.

Step 21 Click Apply.

Step 22 Repeat Steps 19 and 21 for all the ports that are OOS,MT or Locked,maintenance on the east 32WSS 
card. 

Step 23 Display the west 32WSS in card view. 

Step 24 Repeat Steps 19 through 21 for all ports on the west 32WSS card. 

Step 25 Display the east 32DMX in card view.

Step 26 Choose the Provisioning > Optical Line > Parameters tabs.

Step 27 For Port 33, click the Admin State table cell and choose IS,AINS (ANSI) or 
Unlocked,AutomaticInService (ETSI) from the drop-down list.

Step 28 Click Apply.

Step 29 Display the west 32DMX card in card view.

Step 30 Repeat Steps 26 through 28 for the west 32DMX card.

Step 31 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-30.

Step 32 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

Step 33 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 34 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment failure alarms appear on the node. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Stop. You have completed this procedure.
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DLP-G310 Verify ROADM Node Pass-Through Channels

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17. 

Step 1 Create a physical loopback on the west OPT-BST or OSC-CSM by connecting the LINE TX port to its 
LINE RX port. For OPT-BST cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM cards do 
not require attenuation.)

Caution Failure to use proper attenuation may damage equipment.

Step 2 If an OPT-PRE amplifier is installed on the west side (where the physical loopback was created), perform 
the following steps. If not, continue with Step 3.

a. Display the OPT-PRE card in card view, then click the Provisioning > Optical Line > Optics 
Thresholds tabs.

b. Under Types, click Alarm, then click Refresh. The alarm thresholds for the OPT-PRE will appear. 

c. Double click the Power Failure Low table cell for Port 1 (1-Line-2-1 RX) and delete current value.

d. Type a new value of –30, then press Enter on your computer, then click Apply in the CTC window.

e. If an OPT-PRE is installed on the east side, complete Steps a through d for the east OPT-PRE. If an 
OPT-PRE is not installed on the east side, continue with Step 3.

Step 3 Wait 2-3 minutes, then in node view click the Alarms tab. Verify that the LOS alarm on the west OSCM 
or OSC-CSM, and the OPT-BST cards have cleared. The clearing of the LOS alarms indicates the OSC 
link is active on the west side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4 Display the west 32WSS card in card view.

Step 5 Click the Maintenance tab.

Purpose This procedure verifies the signal flow through a ROADM node for 
pass-through channels. Configuring a channel pass-through mode means 
the channel passes through both 32WSS cards. The channel passes through 
the first 32WSS from the COM RX port to the EXP TX port. In the second 
32WSS, the channel goes from the EXP RX port to the COM TX port. The 
channel is not terminated inside the node.

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-24

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 6 For each wavelength that you will test, click the table cell under Operating Mode and choose Pass 
Through from the drop-down list.

Step 7 Click Apply, then click Yes to confirm.

Step 8 Display the east 32WSS card in card view.

Step 9 Repeat Steps 5 through 7 for the east 32WSS card.

Step 10 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 11.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 12.

Step 11 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1, if needed.

Step 12 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OPT-BST 
or OSC-CSM LINE RX port. If an east OPT-PRE is installed, insert a 10 dB attenuator on the fiber 
coming from the TXP_MR_2.5G card.

Caution Failure to use proper attenuation may damage equipment.

Step 13 If an east OPT-PRE card is installed, complete the following steps. If not, continue with Step 14.

a. Display the east OPT-PRE in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1. Record the value.

d. Display the east OPT-BST or OSC-CSM in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 2 (if an OPT-BST) or Port 3 (if an OSC-CSM). Verify that the value 
matches the power recorded in Step c, +/– 1.5 dB. If not, use the “NTP-G115 Clean Fiber 
Connectors” procedure on page 12-22 to clean the fiber connection between the OPT-PRE and 
OPT-BST or OSC-CSM.

g. Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40.

Step 14 Verify the east 32WSS to OPT-BST, OPT-PRE or OSC-CSM cable connection:

a. Display the east 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 Power parameter. Record the value.

d. If an east OPT-PRE is installed, display it in card view, and complete the step below. If not, continue 
with Step e. 

– Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2, then continue with Step g.

e. If an east OPT-BST is installed, display it in card view, and complete the step below. If not, 
continue with Step f.

– Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 
3, then continue with Step g.
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f. Display the east OSC-CSM in card view, click the Provisioning > Optical Line > Parameters tabs 
and read the Power value for Port 2, then continue with Step g.

g. Verify that the value in Step d, e, or f matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the fiber connection 
between the 32WSS and the OPT-PRE, OPT-BST or OSC-CSM cards.

Step 15 Verify the EXPRESS cable connection between the two 32WSS cards:

a. Display the east 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 Power parameter. Record the value.

a. Display the west 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power value for Port 66. Verify that the value matches the power recorded in Step c., 
+/– 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the 
fiber connection between the 32WSS cards

Step 16 Display the west 32WSS card in card view.

Step 17 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the 
connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 18 Wait approximately 60 seconds, then locate the Power and VOA Power Ref parameters for the tested 
pass-through port. Verify that the Power value is equal to the VOA Power Ref value, +/– 1.5 dBm.

Step 19 If an OPT-BST is installed on the east side, complete the following steps. If not, continue with Step 20.

a. Display the east OPT-BST in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 Power parameter. Record the value.

d. Display the east 32WSS in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 67. Verify that the value matches the power recorded in Step c., 
+/– 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the 
fiber connection between the OPT-BST and 32WSS cards.

g. Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39.

Step 20 If an west OPT-PRE card is installed, complete the following steps. If not, continue with Step 14.

a. Display the west OPT-PRE in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1. Record the value.

d. Display the west OPT-BST or OSC-CSM in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 2 (if an OPT-BST) or Port 3 (if an OSC-CSM). Verify that the value 
matches the power recorded in Step c, +/– 1.5 dB. If not, use the “NTP-G115 Clean Fiber 
Connectors” procedure on page 12-22 to clean the fiber connection between the OPT-PRE and 
OPT-BST or OSC-CSM.

g. Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40.
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Step 21 Verify the west 32WSS to OPT-BST, OPT-PRE or OSC-CSM cable connection:

a. Display the west 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 Power parameter. Record the value.

d. If an west OPT-PRE is installed, display it in card view, and complete the step below. If not, continue 
with Step e. 

– Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2, then continue with Step g.

e. If an west OPT-BST is installed, display it in card view, and complete the step below. If not, 
continue with Step f.

– Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 
3, then continue with Step g.

f. Display the west OSC-CSM in card view, click the Provisioning > Opt.Ampli.Line > Parameters 
tabs and read the Power value for Port 2, then continue with Step g.

g. Verify that the value in Step d, e, or f matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the fiber connection 
between the 32WSS and the OPT-PRE, OPT-BST or OSC-CSM cards.

Step 22 Verify the EXPRESS cable connection between the two 32WSS cards:

a. Display the west 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 Power parameter. Record the value.

a. Display the east 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power value for Port 66. Verify that the value matches the power recorded in Step c., 
+/– 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the 
fiber connection between the 32WSS cards

Step 23 Display the east 32WSS card in card view.

Step 24 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the 
connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 25 Wait approximately 60 seconds, then locate the Power and VOA Power Ref parameters for the tested 
pass-through port. Verify that the Power value is equal to the VOA Power Ref value, +/– 1.5 dBm. If the 
power value is not equal to the VOA Power Ref value, +/– 1.5 dBm, check your connections and clean 
the fibers from the 32WSS to the patch panel and from the patch panel to the TXP card using the 
“NTP-G115 Clean Fiber Connectors” procedure on page 12-22, then repeat Step 24. If this does not 
change the power value, consult your next level of support.

Step 26 If an OPT-BST is installed on the east side, complete the following steps. If not, continue with Step 27.

a. Display the east OPT-BST in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 Power parameter. Record the value.

d. Display the east 32WSS in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.
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f. Locate the Power value for Port 67. Verify that the value matches the power recorded in Step c., 
+/– 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22 to clean the 
fiber connection between the OPT-BST and 32WSS cards.

g. Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39.

Step 27 Repeat Steps 10 through 26 for the remaining wavelengths to be tested. If you have tested all the 
wavelengths, continue with Step 28.

Step 28 Display the east 32WSS card in card view.

Step 29 Click the Maintenance tab.

Step 30 Under Operating Mode, click the table cell and choose Not Assigned from the drop-down list for all 
wavelengths.

Step 31 Click Apply, then click Yes to confirm.

Step 32 Display the west 32WSS in card view.

Step 33 Repeat Steps 29 through 31 for the west 32WSS card.

Step 34 Remove the TXP or tunable laser from the east OPT-BST or OSC-CSM line side TX and RX ports.

Step 35 Remove the loopback fiber from the line RX and TX in the west OPT-BST or OSC-CSM card.

Step 36 Return to your originating procedure.

DLP-G311 Verify the East ROADM Add/Drop Channels

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17. 

Step 1 In node view, display the Alarms tab.

Step 2 Create a physical loopback on the east OPT-BST or OSC-CSM by connecting the LINE TX port to its 
LINE RX port. For OPT-BST cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM cards do 
not require attenuation.)

Caution Failure to use proper attenuation may damage equipment.

Purpose This procedure verifies the signal flow through the east side of a ROADM 
node for add/drop channels.

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-24

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 3 Wait 2-3 minutes, then click the Alarms tab. Verify that the LOS alarm on the east OSCM or OSC-CSM, 
and the OPT-BST cards have cleared. The clearing of the LOS alarm indicates the OSC link is active on 
the east side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 5.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength you are testing, then continue with Step 7.

Step 5 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 6 If you are using a TXP_MR_2.5G, connect the TX port to a power meter and record the output power.

Step 7 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east side fiber 
patch panel MUX port that corresponds to the east 32WSS card port carrying the tested wavelength.

Step 8 Connect the TXP_MR_2.5G DWDM RX port or the power meter RX port to the east side fiber patch 
panel DMX port that corresponds to the east 32DMX card port carrying the tested wavelength.

Step 9 Display the east 32WSS in card view.

Step 10 Click the Maintenance tab.

Step 11 For each wavelength that you will test, click the table cell under Operating Mode and choose Add Drop 
from the drop-down list.

Step 12 Click Apply, then click Yes to confirm.

Step 13 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the 
connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 14 Scroll to the right until you see the Power Add parameter. Verify that the Power Add value for the tested 
port is equal to the output power level of the tunable laser or TXP_MR_2.5G card (measured in Step 6). 
+/– 1 dBm.

Step 15 Display the east 32DMX card in card view.

Step 16 Click the Provisioning > Optical Chn > Parameters tab. Record the value under the Power parameter 
for the wavelength under test.

Step 17 Verify that the power value from Step 16 reaches the EastSide.Rx.Power.Add&Drop - Drop Power 
setpoint +/– 1 dBm. To view this setpoint: 

a. Go to node view and click the Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the East Side parameters tree view.

c. Expand the RX category.

d. Expand the Power category, then highlight Add&Drop - Drop Power

e. View the EastSide.Rx.Power.Add&Drop - Drop Power parameter on the right side of the pane.

If the power values do not match, +/– 2 dBm, remove, clean and replace each cable on the east side of 
the shelf. See the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22.

Step 18 Display the TXP_MR_2.5G in card view. 

Step 19 Click the Performance > Optics PM > Current Values tabs. 
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Step 20 Under the Port 2 (Trunk) column, locate the RX Optical Power value. Verify that the value matches the 
power in Step 16 +/– 2 dBm. If the power values do not match, +/– 2 dBm, remove, clean and replace 
the cable connecting the TXP_MR_2.5G RX port to the east fiber patch panel DMX port for the tested 
wavelength. See the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. Repeat this step. If 
the power values still do not match, +/– 2 dBm, contact your next level of support. 

Step 21 Repeat Steps 4 through 20 for the remaining wavelengths. 

Step 22 Display the east 32WSS in card view.

Step 23 Click the Maintenance tab.

Step 24 Click the table cell under Operating Mode and choose Not Assigned from the drop-down list for all 
wavelengths.

Step 25 Click Apply, then click Yes to confirm.

Step 26 Disconnect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port from the east side 
fiber patch panel MUX port that corresponds to the east 32WSS card port carrying the tested wavelength.

Step 27 Disconnect the TXP_MR_2.5G DWDM RX port or the power meter RX port from the east side fiber 
patch panel DMX port that corresponds to the east 32DMX card port carrying the tested wavelength.

Step 28 Unplug the physical loopback fiber from the line TX and RX in the OPT-BST or OSC-CSM card.

Step 29 Return to your originating procedure.

DLP-G312 Verify the West ROADM Add/Drop Channels

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17. 

Step 1 In node view, display the Alarms tab.

Step 2 Create a physical loopback on the west OPT-BST or OSC-CSM by connecting a fiber with 10-dB bulk 
attenuator from the OPT-BST LINE TX port to its LINE RX port. For OPT-BST cards, connect a 10-dB 
bulk attenuator to the fiber. (OSC-CSM cards do not require attenuation.)

Caution Failure to use proper attenuation may damage equipment.

Purpose This procedure verifies the signal flow through the west side of a ROADM 
node for add/drop channels.

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-24

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 3 Wait 90 seconds, then click the Alarms tab. Verify that the LOS alarms on the west OSCM or OSC-CSM, 
and the OPT-BST cards have cleared. The clearing of the LOS alarms indicates the OSC link is active 
on the west side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 5.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength you are testing, then continue with Step 7.

Step 5 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1, if needed.

Step 6 If you are using a TXP_MR_2.5G, connect the TX port to a power meter and record the output power.

Step 7 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the west side fiber 
patch panel MUX port that corresponds to the west 32WSS card port carrying the tested wavelength.

Step 8 Connect the TXP_MR_2.5G DWDM RX port to the west side fiber patch panel DMX port that 
corresponds to the west 32DMX card port carrying the tested wavelength.

Step 9 Display the west 32WSS in card view.

Step 10 Click the Maintenance tab.

Step 11 For each wavelength that you will test, click the table cell under Operating Mode and choose Add Drop 
from the drop-down list.

Step 12 Click Apply, then click Yes to confirm.

Step 13 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the 
connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 14 Scroll to the right until you see the Power Add parameter. Verify that the Power Add value for the tested 
port is equal to the output power level of the tunable laser or TXP_MR_2.5G card (measured in Step 6). 
+/– 1 dBm.

Step 15 Display the west 32DMX card in card view.

Step 16 Click the Provisioning > Optical Chn > Parameters tab. Record the value under the Power parameter 
for the wavelength under test.

Step 17 Verify that the power value from Step 16 reaches the WestSide.Rx.Power.Add&Drop - Drop Power 
setpoint +/– 2 dBm. To view this setpoint: 

a. Go to node view and click the Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the West Side parameters tree view.

c. Expand the RX category.

d. Expand the Power category, then highlight Add&Drop - Drop Power

e. View the WestSide.Rx.Power.Add&Drop parameter on the right side of the pane.

If the power values do not match, +/– 2 dBm, remove, clean and replace each cable on the west side of 
the shelf. See the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. 

Step 18 Display the TXP_MR_2.5G in card view. 

Step 19 Click the Performance > Optics PM > Current Values tabs
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Step 20 Under the Port 2 (Trunk) column, locate the RX Optical Power value. Verify that the value matches the 
power in Step 16 +/– 2 dBm. If the power values do not match, +/– 2 dBm, remove, clean and replace 
the cable connecting the TXP_MR_2.5G RX port to the west fiber patch panel DMX port for the tested 
wavelength. See the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. Repeat this step. If 
the power values still do not match, +/– 2 dBm, contact your next level of support. 

Step 21 Repeat Steps 4 through 20 for the remaining wavelengths.

Step 22 Display the west 32WSS in card view.

Step 23 Click the Maintenance tab.

Step 24 Click the table cell under Operating Mode and choose Not Assigned from the drop-down list for all 
wavelengths.

Step 25 Click Apply, then click Yes to confirm.

Step 26 Remove the TXP or tunable laser from the west side patch panel.

Step 27 Unplug the physical loopback fiber from the line TX and RX in the OPT-BST or OSC-CSM card.

Step 28 Return to your originating procedure.

NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 
15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note The OSC terminations created during node turnup will generate two alarms for each side of the 
shelf, one for loss of signal on the Optical Booster (OPT-BST) card, and the other an LOS alarm 
on the OSC_CSM or OSCM card.

Purpose This procedure tests an anti-ASE hub node. 

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete 
the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 5 From your Cisco MetroPlanner site configuration file, identify the dropped and added channels that are 
configured in pass-through mode in both directions. 

Note Configuring a channel pass-through mode means that the channel is dropped along one direction 
by a 32DMX-O (15xx.xx TX port) located on one side (west or east) of the shelf, and then added 
by another 32MUX-O (1522.22 RX port) on the opposite side of the shelf but in the same 
direction. The channel is not terminated inside the site.

Step 6 Create a loopback on the west OPT-BST amplifier by connecting a patch cord from the LINE TX port 
to the LINE RX port with a 10-dB bulk attenuator.

Step 7 Verify that the OSC link becomes active on the west OSCM or OSC-CSM card. (The OSC Termination 
must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” 
procedure on page 3-74.)

Step 8 For pass-through channels, continue with Step 9. For add and drop channels, continue with Step 18.

Step 9 Verify the first channel connection configured in pass-through mode in both directions:

a. If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If you are 
using a TXP_MR_2.5G card, continue with Step b.

b. Set the tunable laser or TXP_MR_2.5G card to a corresponding wavelength on the 100-GHz ITU-T 
grid. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision 
TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

c. Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX 
port of the east OPT-BST using a 10-dB bulk attenuator.

Step 10 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 for the east 
OPT-PRE amplifier.

Step 11 Complete the “DLP-G269 Verify the 32DMX-O Power” task on page 4-40 for the west 32MUX-O and 
32DMX-O cards.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
west OPT-BST amplifier.

Step 13 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 for the 
west OPT-PRE amplifier.

Step 14 Complete the “DLP-G269 Verify the 32DMX-O Power” task on page 4-40 for the west 32MUX-O and 
32DMX-O cards.

Step 15 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the east 
OPT-BST amplifier.

Step 16 Repeat Steps 9 through 15 for the remaining wavelengths on the 100-GHz grid that are pass-through 
wavelengths. 
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Step 17 If you have add and drop channels, continue with Step 18 to verify the channels. If not, continue with 
Step 29.

Step 18 Set the tunable laser or TXP_MR_1.5G card to the first wavelength of the 100-GHz ITU-T grid that is 
not a pass-through wavelength. Refer to the tunable laser manufacturer’s documentation or the 
“DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 19 Connect the tunable laser or TXP_MR_1.5G card to the CHAN RX nn port on the west 32MUX-O, 
where nn is the first add or drop channel.

Step 20 Display the west 32MUX-O in card view.

Step 21 Click the Provisioning > Optical Chn > Parameters tabs.

Step 22 Change the Admin State of Port nn to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23 Check that the power value on Port nn reaches the provisioned setpoint (VOA Power Ref).

Step 24 Display the west 32DMX-O in card view.

Step 25 Click the Provisioning > Optical Chn > Parameters tabs.

Step 26 Change the Admin State of Port nn to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 27 Check that the power value on Port nn reaches the provisioned setpoint (VOA Power Ref).

Step 28 (Optional) Connect a power meter to the CHAN TX nn port through the patch panel and verify that the 
physical optical power coming out of drop Port nn on the west 32DMX-O is consistent with the value 
read on the meter within 0.5 dB.

Step 29 Repeat Steps 18 through 28 for the remaining wavelengths on the 100-GHz grid that are not pass-through 
wavelengths. 

Step 30 Remove the loopback connection on the west OPT-BST.

Step 31 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 32 Create a loopback on the east OPT-BST amplifier by connecting a patch cord from the LINE TX port to 
the LINE RX port with 10-dB bulk attenuator.

Step 33 Verify that the OSC link becomes active on the east OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.)

Step 34 Repeat 18 through 33 for the east side cards.

Step 35 Remove the loopback on the east OPT-BST.

Step 36 Restore the default admin state (IS,AINS/Unlocked,automaticInService) on all the ports previously set 
to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Stop. You have completed this procedure.
4-22
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 4      Perform Node Acceptance Tests
Before You Begin
NTP-G45 Perform the Line Amplifier Node with OSCM Cards 
Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 3.

Step 2 If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Node View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 
15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note The OSC terminations created during node turnup will generate two alarms for each side of the 
shelf, one for loss of signal on the Optical Booster (OPT-BST) card, and the other an LOS alarm 
on the OSC_CSM or OSCM card.

Step 5 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 6 Create a loopback on the west OPT-BST by using a fiber with a 10-dB bulk attenuator to connect the 
LINE TX port to the LINE RX port.

Purpose This procedure tests a line amplifier node with OSCM cards installed on 
both the east and west sides of the shelf by looping a single wavelength 
through the shelf.

Tools/Equipment • A tunable laser or one TXP_MR_2.5G card

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 8.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 9.

Step 8 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 9 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port 
of the east OPT-BST using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 10 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the west 
OPT-BST and OSCM cards have cleared. The clearing of the LOS alarms indicates the OSC link is active 
on the west side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, an 
LOS-O alarm appears on the east OPT-BST card, and an LOS on the east OCSM.

If the alarms clear, continue with Step 11. If not, perform the following steps:

a. Display the west OPT-BST card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. Under Types, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the west 
OPT-BST card has cleared. If so, continue with Step 11. If not, disconnect the OSCM card from the 
OPT-BST.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC 
RX port using a 10-dB bulk attenuator.

i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the west 
OSCM card has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See 
the“NTP-G30 Install the DWDM Cards” procedure on page 3-27.

Step 11 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-40 for it. If not, continue with Step 12.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
west OPT-BST amplifier.

Step 13 If an OPT-PRE amplifier is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 4-40. It not, continue with continue with Step 14.

Step 14 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the east 
OPT-BST amplifier.
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Step 15 Disconnect the TXP or tunable laser from the east OPT-BST card.

Step 16 Remove the loopback on the west OPT-BST created in Step 6.

Step 17 Create a loopback on the east OPT-BST by connecting a patch cord from the LINE TX port to the LINE 
RX port with a 10-dB bulk attenuator.

Step 18 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 19.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 20.

Step 19 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 20 Connect tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port of 
the west OPT-BST using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 21 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east 
OPT-BST and OSCM cards have cleared. The clearing of the LOS alarms indicates the OSC link is active 
on the east side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, an 
LOS-O alarm appears on the west OPT-BST card, and an LOS on the west OCSM. 

If the alarms clear, continue with Step 22. If not, perform the following steps:

a. Display the east OPT-BST card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. Under Types, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east 
OPT-BST card has cleared. If so, continue with Step 22. If not, disconnect the OSCM card from the 
OPT-BST.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC 
RX port using a 10-dB bulk attenuator.

i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east 
OSCM card has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See 
the“NTP-G30 Install the DWDM Cards” procedure on page 3-27.

Step 22 If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-40 for it. If not, continue with Step 23.
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Step 23 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the east 
OPT-BST amplifier.

Step 24 If an OPT-PRE amplifier is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 4-40. It not, continue with continue with Step 25.

Step 25 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
west OPT-BST amplifier.

Step 26 Disconnect the TXP or tunable laser from the west OPT-BST card.

Step 27 Remove the loopback on the west OPT-BST amplifier created in Step 6.

Step 28 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-30.

Step 29 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 30 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Stop. You have completed this procedure.

NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards 
Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 3.

Step 2 If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Node View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 
15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Purpose This procedure tests a line amplifier node with OSC-CSM cards installed 
on both the east and west sides of the shelf by looping a single wavelength 
through the shelf.

Tools/Equipment • A tunable laser or TXP_MR_2.5G card

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Note The OSC terminations created during node turnup will generate LOS alarm on the OSC-CSM 
card.

Step 5 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 6 Create a physical loopback on the west OSC-CSM by connecting the LINE TX port to the LINE RX port 
with a fiber and 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 7 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the west 
OSC-CSM card has cleared. The clearing of the LOS alarm indicates the OSC link is active on the west 
side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, 
and an LOS alarm will appear for the east OSC-CSM, Port 1 (OSC).

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patch cord. 

b. In node view, click the Alarms tab. If the LOS alarm on the west OSC-CSM card clears, continue 
with Step 8. If not, continue with Step c.

c. Display the OSC-CSM in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. Under Types, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view, Click the Alarms tab. If the LOS alarm on the west OSC-CSM card clears, continue 
with Step 8. If not, replace the OSC-CSM card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 9.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 10.
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Step 9 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 10 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OSC-CSM 
LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 11 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-40 for it. If not, continue with Step 12.

Step 12 Display the west OSC-CSM card in card view. 

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. If this does 
not change the power value, consult your next level of support.

Step 14 If an OPT-PRE is installed on the west side of the shelf, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 4-40. If not, continue with Step 15.

Step 15 Display the east OSC-CSM card in card view. 

Step 16 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 2 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. If this does 
not change the power value, consult your next level of support.

Step 17 Disconnect the TXP or tunable laser from the east OSC-CSM card.

Step 18 Remove the physical loopback created on the west OSC-CSM in Step 6. 

Step 19 Create a loopback on the east OSC-CSM by connecting the LINE TX port with LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 20 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the east 
OSC-CSM card has cleared. The clearing of the LOS alarm indicates the OSC link is active on the east 
side. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, 
and an LOS alarm will appear for the west OSC-CSM, Port 1 (OSC).

If the alarm clears, continue with Step 21. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patch cord. 

b. Wait 90 seconds then, in node view, click the Alarms tab. If the LOS alarm on the east OSC-CSM 
card clears, continue with Step 21. If not, continue with Step c.

c. Display the OSC-CSM in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. Under Types, click Alarm, then click Refresh.
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f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view, Click the Alarms tab. If the LOS alarm on the east OSC-CSM card clears, continue 
with Step 21. If not, replace the OSC-CSM card.

Step 21 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 22.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 23.

Step 22 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 23 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the west OSC-CSM 
LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 24 If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-40 for it. If not, continue with Step 25.

Step 25 Display the east OSC-CSM card in card view. 

Step 26 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. If this does 
not change the power value, consult your next level of support.

Step 27 If an OPT-PRE is installed on the east side of the shelf, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 4-40 for the east OPT-PRE amplifier. If not, continue with 
Step 28.

Step 28 Display the west OSC-CSM card in card view. 

Step 29 Click the Provisioning > Optical Line > Parameters tabs and locate the Power value for Port 2. Verify 
that the value is higher than –30 dBm. If the power value is not higher than –30dBm, check your 
connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on 
page 12-22. If this does not change the power value, consult your next level of support.

Step 30 Disconnect the TXP or tunable laser from the west OSC-CSM card.

Step 31 Remove the loopback created on the east OSC-CSM in Step 6. 

Step 32 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-30.

Step 33 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 34 Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.

Stop. You have completed this procedure.
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NTP-G47 Perform the Line Amplifier Node with OSCM and 
OSC-CSM Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Node View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 
15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note The OSC terminations created during node turnup will generate two alarms for each side of the 
shelf, one for loss of signal on the Optical Booster (OPT-BST) card, and the other an LOS alarm 
on the OSC_CSM or OSCM card.

Step 5 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure 
on page 3-74.

Step 6 Create a loopback on the OSC-CSM card by connecting the LINE TX port to the LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Purpose This procedure tests a line amplifier node with an OSC-CSM card installed 
on one side of the shelf and an OSCM card installed on the other.

Tools/Equipment • A tunable laser or TXP_MR_2.5G card

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 7 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the OSC-CSM 
card has cleared. The clearing of the LOS alarm indicates the OSC link is active for this side of the shelf. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patch cord. 

b. In node view, click the Alarms tab. If the LOS alarm on the OSC-CSM card clears, continue with 
Step 8. If not, continue with Step c.

c. Display the OSC-CSM in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. Under Types, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view, Click the Alarms tab. If the LOS alarm on the OSC-CSM card clears, continue with 
Step 21. If not, replace the OSC-CSM card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_2.5G card, continue with Step 9.

a. Set the output power to a nominal values, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 11.

Step 9 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to 
Table 4-1 on page 4-4, if needed.

Step 10 Measure the TXP output power by connecting the TXP DWDM TX port to a test meter. Record the 
results for future reference.

Step 11 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the OPT-BST 
LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation may damage equipment.

Step 12 Display the OPT-BST in card view.

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 2 
(Out Com) is equal to the optical power from the tunable laser or TXP_MR_2.5G card (measured in 
Step 10) +/– 1 dBm.

Step 14 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-40 for it. If not, continue with Step 15.

Step 15 Display the OSC-CSM card in card view. 
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Step 16 Click the Provisioning > Optical Line > Parameters tabs and locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. If this does 
not change the power value, consult your next level of support.

Step 17 If an OPT-PRE card is installed on the same side as the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-40 for it. If not, continue with Step 18.

Step 18 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
OPT-BST card.

Step 19 Disconnect the TXP or tunable laser from the OPT-BST card.

Step 20 Remove the loopback fiber on the OSC-CSM card.

Step 21 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-30.

Step 22 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 23 Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.

Step 24 Create a loopback on the OPT-BST card by connecting the LINE TX port with LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Step 25 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the OPT-BST 
and OSCM cards have cleared. The clearing of the LOS alarms indicates the OSC link is active for this 
side of the shelf. 

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

If the alarms clear, continue with Step 26. If not, perform the following steps:

a. Display the OPT-BST card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. Under Types, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the 
OPT-BST card has cleared. If so, continue with Step 25. If not, disconnect the OSCM card from the 
OPT-BST.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC 
RX port using a 10-dB bulk attenuator.

i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on OSCM card 
has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See the“NTP-G30 
Install the DWDM Cards” procedure on page 3-27.

Step 26 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the OSC-CSM 
LINE RX port using a 10-dB bulk attenuator.

Step 27 If an OPT-PRE is installed on the same side of the shelf as the OSC-CSM, complete the “DLP-G80 
Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40. If not, continue with Step 27.
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Step 28 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
OPT-BST card.

Step 29 Display the OSC-CSM card in card view.

Step 30 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 3 
(Out Com) is equal to the optical power from the tunable laser or TXP_MR_2.5G card (measured in 
Step 10 +/– 1 dBm.

Step 31 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-40 for it. If not, continue with Step 32.

Step 32 Disconnect the TXP or tunable laser from the OSC-CSM card.

Step 33 Remove the loopback fiber on the OPT-BST amplifier card.

Step 34 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-30.

Step 35 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-73 to restore the original 
configuration.

Step 36 Create the OSC channels using the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.

Stop. You have completed this procedure.

NTP-G48 Perform the OADM Node Acceptance Test on a 
Symmetric Node with OSCM Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Purpose This procedure checks the integrity of all the optical connections inside an 
OADM node with OSCM cards installed on both the east and west sides of 
the shelf. Three connection types are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-73. 

Step 5 Check your Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands 
(including four channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OPT-BST by connecting the LINE TX port to the LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.) If the OSC link becomes active, continue with Step 11. If the OSC link does not turn up, 
complete the following steps:

a. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 4 opwrMin (minimum power) to –40 dBm.

b. Modify the COM TX Fail Low Threshold. Change the Port 2 opwrMin (minimum power) to 
–30 dBm.

c. If the OSC link turns up, continue with Step 11. If the OSC link is still down, disconnect the OSCM 
card from the OPT-BST.

d. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

e. If the OSC link turns up, replace the OPT-BST card. If the OSC link does not turn up, replace the 
OSCM card.
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Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11 If the node has express bands or channels, complete the “DLP-G85 Verify Express Channel Connections 
on an OADM Node with OSCM Cards” task on page 4-43. If the node does not have express bands or 
channels, continue with Step 12.

Step 12 If connections configured in pass-through mode are present (noted inSteps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-47. If not, continue 
with Step 13.

Step 13 If connections have add/drop connections, complete the “DLP-G93 Verify Add and Drop Connections 
on an OADM Node with OSCM Cards” task on page 4-51.

Stop. You have completed this procedure.

NTP-G49 Perform the OADM Active Node Acceptance Test on a 
Symmetric Node with OSC-CSM Cards 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

Purpose This procedure checks the integrity of all the optical connections inside an 
OADM node with OSC-CSM and OPT-BST cards installed on both the east 
and west sides of the shelf. Three connection types are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-73. 

Step 5 Check the Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands 
(including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patch cord and a 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” 
procedure on page 3-74.)

Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 11. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card. 
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Step 12 If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections 
on an OADM Node with OSC-CSM Cards” task on page 4-44. If the node does not have express bands 
or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-47. If not, continue 
with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on OADM Node with OSC-CSM Cards” task on page 4-54.

Stop. You have completed this procedure.

NTP-G50 Perform the OADM Passive Node Acceptance Test on 
a Symmetric Node with OSC-CSM Cards 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware 
problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer 
to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide for procedures.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-73. 

Purpose This procedure checks the integrity of all the optical connections inside an 
OADM node with OSC-CSM and no OPT-BST cards installed on the east 
and west sides of the shelf.Three connection types are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment • A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1)

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 5 Check the Cisco MetroPlanner site configuration file to verify the presence of a dropped/added bands 
(including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patch cord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” 
procedure on page 3-74.)

Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 13. If it does not turn up, replace the OSC-CSM card. 

Step 12 If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections 
on an OADM Node with OSC-CSM Cards” task on page 4-44. If the node does not have express bands 
or channels, continue with Step 12.

Step 13 If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-47. If not, continue 
with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on OADM Node with OSC-CSM Cards” task on page 4-54.
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Stop. You have completed this procedure.

DLP-G78 Verify the 32MUX-O Power

Step 1 Display the 32MUX-O in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the Admin State of the correspondent port to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 4 Check that the power value on the port reaches the provisioned setpoint (VOA Power Ref).

Step 5 Return to your originating procedure (NTP).

DLP-G79 Verify the OPT-BST Amplifier Laser and Power

Step 1 In node view, double-click the OPT-BST amplifier to display the card view. 

Step 2 Click the Maintenance > ALS tabs. If the value in the Currently Shutdown field is NO, continue with 
Step 3. If not, complete the following steps:

a. Check the OSRI setting. If it is set to On, change it to Off and click Apply.

b. Check the Currently Shutdown field. If it changes to NO, continue with Step 3. If not, contact your 
next level of support. The amplifier might need to be replaced.

Step 3 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 4 Click Reset.

Step 5 Scroll to the right and locate the Signal Output Power parameter for Port 6. Verify that the Signal Output 
Power value is greater than or equal to 1.5 dBm.

Purpose This task verifies 32MUX-O power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies that the OPT-BST amplifier laser is on and provisioned 
to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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If the Signal Output Power is not greater than or equal to 1.5 dBm, do not continue. Begin 
troubleshooting or contact your next level of support.

Step 6 Return to your originating procedure (NTP).

DLP-G80 Verify the OPT-PRE Amplifier Laser and Power

Step 1 In node view, double-click the OPT-PRE amplifier to display the card view. 

Step 2 Click the Maintenance > ALS tabs.

Step 3 If the value shown in the Currently Shutdown field is NO, continue with Step 4. If not, complete the 
following steps:

a. If the OSRI setting is set to ON, click the table cell and choose OFF from the drop-down list. 

b. Click Apply.

Step 4 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 5 Locate the Signal Output Power parameter for Port 2. Verify that the Signal Output Power value is 
greater than or equal to 1.5 dBm. If the optical power is greater than or equal to 1.5 dBm, continue with 
Step 6. If the the optical power is less than 1.5 dBm, check your connections and clean the fibers using 
the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22. If this does not change the power 
value, consult your next level of support.

Step 6 Scroll to the right to locate the DCU Insertion Loss parameter. Verify that the DCU Insertion Loss value 
is less than or equal to 10 dB.

If the optical power is not greater than or equal to 10 dB, do not continue. Begin troubleshooting or 
contact your next level of support.

Step 7 Return to your originating procedure (NTP) or task (DLP).

DLP-G269 Verify the 32DMX-O Power

Purpose This task verifies that the OPT-PRE amplifier laser is on and provisioned 
to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies that the 32DMX-O card is provisioned to the correct 
power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24
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Step 1 Display the 32DMX-O card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the Admin State for the appropriate port to OOS,DSLB (ANSI) or Locked,disabled (ETSI).

Step 4 Verify that the VOA Power Ref reaches the provisioned set point.

Step 5 (Optional.) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the 
physical optical power value coming from drop Port 1 on the west 32DMX-O card is consistent with the 
value read (the maximum allowed error is +/– 0.5 dBm).

Step 6 Return to your originating procedure (NTP).

DLP-G270 Verify the 32DMX Power

Step 1 Display the 32DMX card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the Admin State for Port 33 to OOS,MT (ANSI) or Locked,maintenance (ETSI)

Step 4 Verify that the VOA Power Ref reaches the provisioned set point.

Step 5 (Optional.) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the 
physical optical power value coming from drop Port 1 on the west 32DMX card is consistent with the 
value read (the maximum allowed error is +/– 1 dBm).

Step 6 Change the Admin State for Port 1 to OOS,DSLB (ANSI) or Locked,disabled (ETSI).

Step 7 Return to your originating procedure (NTP).

DLP-G82 Verify the OSC-CSM Power 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies that the 32DMX card is provisioned to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies OSC-CSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24
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Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 If an OPT-PRE is not installed on the same side of the shelf as the OSC-CSM, verify the Port 3 Power 
value is higher than the default no-power value of –30 dBm. If the power is not higher than –30dBm, 
contact your next level of support.

Step 4 Return to your originating procedure (NTP).

DLP-G83 Verify the OSC-CSM Power on OADM Nodes

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Power value for Port 3 is higher than the default no-power value of –30 dBm. The 
calculated expected power value for Port 3 is:

Pout COM TX of last AD-xy-xx.x – IL02 OSC-CSM (COM RX > LINE TX) – 10 dB (bulk attenuator)

Step 4 Double-check the value.

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 5 Return to your originating procedure (NTP).

DLP-G84 Verify the OSC-CSM Incoming Power

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies OSC-CSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies OSC-CSM card incoming power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24
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Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Power value for Port 2 is higher than the default no-power value of –30 dBm. The 
calculated expected power value for Port 2 is:

Pout COM TX of OPT-PRE (this normally is + 2 dBm) 

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 4 Return to your originating procedure (NTP).

DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM 
Cards

Step 1 If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue 
with Step 2.

Step 2 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OPT-BST 
LINE RX port.

Step 3 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser of TXP_MR_2.5G card 
to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and 
AD-xC-xx.x cards on the east-to-west and west-to-east directions. Refer to the tunable laser 
manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance 
Testing” task on page 4-4.

Step 4 If an OPT-PRE card is installed on the east side, insert a 10-dB bulk attenuator on the COM RX port and 
complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40. If an 
OPT-PRE card is not installed on the east side, continue with Step 5.

Step 5 If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-45 for each east side card. If not, continue with Step 6.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies the express channel connections during an OADM node 
acceptance.

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Note If AD-xB-xx.x and AD-xC-xx.x cards are both installed in one direction, the received express 
channels will run into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 6 If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-46 for each east side card. If not, continue with Step 7.

Step 7 If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G271 Verify the AD-xC-xx.x 
Output Common Power” task on page 4-46 for each west side card. If not, continue with Step 8.

Step 8 If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G272 Verify the AD-xB-xx.x 
Output Common Power” task on page 4-46 for each west side card. If not, continue with Step 9.

Step 9 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
OPT-BST installed on the east side.

Step 10 If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-40. If an OPT-PRE card is not installed, continue with Step 11.

Step 11 Repeat Steps 5 through 8 to the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 for the 
OPT-BST installed on the east side.

Step 13 Return to the originating procedure (NTP).

DLP-G86 Verify Express Channel Connections on an OADM Node with 
OSC-CSM Cards

Step 1 If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue 
with Step 2.

Step 2 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port 
of the east OSC-CSM card.

Step 3 If an OPT-PRE amplifier card is installed on the east side, install a 10-dB bulk attenuator on the 
COM RX port.

Step 4 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card 
to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and 
AD-xC-xx.x cards on the east-to-west and west-to-east directions. Refer to the tunable laser 
manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance 
Testing” task on page 4-4.

Purpose This task verifies the express channel connections during an OADM node 
acceptance.

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Step 5 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 for the 
OPT-PRE amplifier card installed on the west side.

Step 6 If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-45 for each east side card. If not, continue with Step 7.

Note If Ad-xB-xx.xand AD-xC cards are both installed in one direction, the received express channels 
will run into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 7 If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-46 for each east side card. If not, continue with Step 8.

Step 8 If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G271 Verify the AD-xC-xx.x 
Output Common Power” task on page 4-46 for each west side card. If not, continue with Step 9.

Step 9 If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G272 Verify the AD-xB-xx.x 
Output Common Power” task on page 4-46 for each west side card. If not, continue with Step 10.

Step 10 Complete the “DLP-G83 Verify the OSC-CSM Power on OADM Nodes” task on page 4-42 for the 
OSC-CSM installed on the west side.

Step 11 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 for the 
OPT-PRE card installed on the east side.

Step 12 Repeat Steps 6 through 9 for the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.

Step 13 Complete the “DLP-G83 Verify the OSC-CSM Power on OADM Nodes” task on page 4-42 for the 
OSC-CSM installed on the west side.

Step 14 Return to the originating procedures (NTPs).

DLP-G87 Verify the AD-xB-xx.x Output Express Power

Step 1 Display the AD-xB-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI). 
Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –28 dBm.

Step 5 Return to your originating procedure (NTP).

Purpose This task verifies the output express power of Band OADM (AD-xB-xx.x) 
cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G88 Verify the AD-xC-xx.x Output Express Power

Step 1 Display the AD-xC-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI). 
Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –30 dBm.

Step 5 Return to your originating procedure (NTP).

DLP-G271 Verify the AD-xC-xx.x Output Common Power

Step 1 Display the AD-xC-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Output Com port Power value is greater than the default no-power value of –30 dBm.

Step 4 Return to your originating procedure (NTP).

DLP-G272 Verify the AD-xB-xx.x Output Common Power

Purpose This task verifies the output express power of the Channel OADM 
(AD-xC-xx.x) cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies the common power of the Channel OADM (AD-xC-xx.x) 
cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies the output common power of the Channel OADM 
(AD-xB-xx.x) cards.

Tools/Equipment None
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Step 1 Display the AD-xB-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Output Com port Power value is greater than the default no-power value of –28 dBm.

Step 4 Return to your originating procedure (NTP).

DLP-G89 Verify OADM Node Pass-Through Channel Connections

Step 1 Identify the first band connection configured in pass-through mode in both directions.

Step 2 Set the tunable laser or TXP_MR_2.5G card to the wavelength of the band to be tested. Refer to the 
tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4.

Step 3 Complete the “DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power” task on page 4-48 for 
the first pass-through connection.

Step 4 (Optional.) Complete one of the following:

• If OSCM cards are installed, connect a power meter to the east OPT-BST LINE TX port and verify 
that the east amplifier is turned on by the pass-through wavelength.

• If OSC-CSM cards are installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-42 for the east OSC-CSM card.

Step 5 Complete Steps 2 through 4 for all band connections configured in pass-through mode in both directions.

Step 6 If channel pass-through connections are not present, continue with Step 15. If channel pass-through 
connections are present, continue with one of the following steps: 

• If the pass-through channel connections use an AD-xC-xx.x card, continue with Step 7.

• If the pass-through channel connections use a 4MD-xx.x card, continue with Step 11.

Step 7 Tune the tunable laser on a wavelength (1 of 4) belonging to the channel to be tested.

Step 8 Complete the “DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection” task on page 4-49 for the 
first pass-through connection.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies the pass-through channel connections during an OADM 
node acceptance test. 

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Step 9 (Optional.) Complete one of the following:

• If an OSCM card is installed, connect a power meter to LINE TX port on the front-pane and verify 
that the east OPT-BST amplifier is turned on by the pass-through wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-42 for the east OSC-CSM card.

Step 10 If the pass-through connections use a 4-channel multiplexer/demultiplexer (4MD-xx.x), continue with 
Step 11. If not, continue with Step 15.

Step 11 Identify the first channel connection that is configured in pass-through mode using the 4MD-xx.x cards 
in both directions.

Step 12 Tune the tunable laser on the corresponding wavelength.

Step 13 Complete the “DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power” task on page 4-50.

Step 14 (Optional.) Perform one of the following:

• If an OSCM card is installed, connect a power meter to LINE TX port on the card front panel and 
verify that the east OPT-BST amplifier is turned on by the pass-through wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-42 for the east OSC-CSM card.

Step 15 Return to your originating procedure (NTP).

DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power

Step 1 Verify the east AD-xB-xx.x band TX power:

a. Display the east AD-xB-xx.x in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX (east-to-west) port related to the wavelength selected on 
the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

d. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the west AD-xB-xx.x card RX and TX power:

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the Power value of the BAND RX (east-to-west) port is higher than the default no-power 
value of –30 dBm.

Purpose This task verifies an AD-xB-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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d. Change the Admin State of the BAND TX (west-to-east) port related to the wavelength selected on 
the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

e. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 3 Verify the band RX port on the east AD-xB-xx.x card:

a. Display the east AD-xB-xx.x in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the Power value of the BAND RX (West to East) port is higher than the default no-power 
value of –30 dBm.

Step 4 Return to your originating procedure (NTP).

DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection

Step 1 Verify the east AD-xC-xx.x channel TX power:

a. Display the east AD-xC-xx.x in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated in Step e.

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

f. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 2 Verify the channel power for the corresponding west AD-xC-xx.x card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

Purpose This task verifies an AD-xC-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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f. If the AD-xC-xx.x is an AD-4C-W card, a VOA (applying to all four channels) is installed along the 
drop path and needs to be activated in Step g.

g. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

h. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 3 Verify the east AD-xC-xx.x channel RX power:

a. Display the east AD-xC-xx.x in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Return to your originating procedure (NTP).

DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power

Step 1 Verify the TX band power on the related east AD-xB-xx.x card: 

a. Display the east AD-xB-xx.x card in card view. 

b. Click the Provisioning > Optical Band > Parameters tabs. 

c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) 
for the channel related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the TX power on the related east 4MD-xx.x (east-to-west) card:

a. Display the east 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 3 Verify the RX band power on the west AD-xB-xx.x card (east-to-west):

a. Display the west Ad-xB-xx.x card in card view

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the BAND RX Power value is higher than the default no-power values of –30 dBm.

Purpose This task verifies 4MD-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 4 Verify the west 4MD-xx.x (east-to-west):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 5 Verify the TX band power on the west AD-xB-xx.x (west-to-east):

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) 
for the channel related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 6 Verify the west 4MD-xx.x (west-to-east):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 7 Verify the east 4MD-xx.x (west-to-east):

a. Display the east 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 8 Return to your originating procedure (NTP).

DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSCM cards installed.

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Note In this task, you will verify add and drop connections in the following order: east-to-west add and 
west-to-east drop, Steps 1 through 15; west-to-east add and east-to-west drop, Steps 16 through 17.

Step 1 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card 
to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of 
the first west AD-xC-xx.x or west 4MD-xx.x card on the east-to-west direction. Refer to the tunable laser 
manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance 
Testing” task on page 4-4.

Step 2 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the corresponding 
15xx.x RX port (on the card front panel) of the west AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):

a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength chosen on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-39 on the west 
OPT-BST amplifier to verify that the added wavelength turns on the laser.

Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the RX band port on the west AD-xB-xx.x card:

a. Display the west Ad-xB-xx.x card in card view

b. Click the Provisioning > Optical Band > Parameters tabs.

Step 7 Verify that the BAND RX Power value is higher than the default no-power values of –30 dBm

Step 8 Verify band TX port on the west AD-xB-xx.x (west to east):

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) 
for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 9 Verify the west 4MD-xx.x card (west to east):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–30 dBm.

Step 10 Verify the west AD-xC-xx.x (west-to-east) card:

a. Display the west AD-xC-xx.x card in card view.

b. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated according to Step g.
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c. Click the Provisioning > Optical Chn > Parameters tabs.

d. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

e. Display the east AD-xC-xx.x in card view.

f. Click the Provisioning > Optical Chn > Parameters tabs.

g. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser or TXP_MR_2.5G card to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

h. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

i. Perform the output power check.

Step 11 (Optional.) Connect a power meter to the proper 15xx.x TX port on the front panel (the dual port 
compared with the port where the tunable laser or TXP_MR_2.5G card is connected). Verify that the 
physical optical power value from that port is consistent with the value displayed on the Provisioning > 
Optical Chn > Parameters tab for the proper CHAN TX power value +/– 0.5 dB.

Step 12 Repeat Steps 8 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the 
east-to-west direction.

Step 13 Remove the loopback on the west OPT-BST amplifier and create a loopback on the east OPT-BST 
amplifier. 

Step 14 Verify that the OSC link becomes active on the east OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on 
page 3-74.) If the OSC link becomes active, continue with Step 15. If the OSC link does not become 
active, perform the following steps:

a. Modify the OSC Fail Low thresholds by clicking the Provisioning > Optical Line > Optics 
Thresholds tabs and changing the Port 2 opwrMin (minimum power) to –40 dBm.

b. If the OSC link turns up, continue with Step 15. If the OSC link remains down, disconnect the 
OSCM card from the OPT-BST.

c. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the OSC 
RX port using a 10-dB bulk attenuator.

d. If the OSC link turns up, replace the OPT-BST card. If the OSC link does not turn up, replace the 
OSCM card. See the“NTP-G30 Install the DWDM Cards” procedure on page 3-27.

Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 15 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card 
to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of 
the first add path of the first AD-xC-xx.x-E or 4MD-xx.x-E card on the west-to-east direction. Refer to 
the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for 
Acceptance Testing” task on page 4-4.

Step 16 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the correspondent 
15xx.x RX port (on the card front panel) of the east AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 17 Repeat Steps 3 through 15, applying the steps to the west-to-east direction.

Step 18 Remove the loopback connection and Restore the default admin state (IS,AINS or 
Unlocked,automaticInService) on all the ports previously set to OOS,MT (ANSI) or 
Locked,maintenance (ETSI).
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Step 19 Launch ANS to recover the correct Node Configuration.

Step 20 Return to your originating procedure (NTP).

DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM 
Cards

Note In this task, you will verify add and drop connections in the following order: east-to-west and 
west-to-east drop: Steps 1 through 15; west-to-east add and east-to-west drop: Steps 16 through 17.

Step 1 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card 
to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of 
the first west AD-xC-xx.x or west 4MD-xx.x card on the east-to-west direction. Refer to the tunable laser 
manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance 
Testing” task on page 4-4.

Step 2 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the corresponding 
15xx.x RX port (on the card front panel) of the west AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):

a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-40 on the west 
OPT-PRE amplifier to verify that the added wavelength turns on the laser.

Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the west AD-xB-xx.x:

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSC-CSM cards installed.

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band 
wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) 
for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 7 Display the related AD-xB-xx.x card (west-to-east direction) in card view.

Step 8 Change the admin state of the drop BAND TX port related to the wavelength selected on the tunable 
laser to OOS,MT.

Step 9 (Optional.) Connect a power meter to the proper 15xx.xs TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value displayed on the Provisioning > Optical Chn > 
Parameters tab for the proper CHAN TX power value +/– 0.5 dB.

Step 10 Verify the west AD-xC-xx.x (west-to-east) card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Display the east AD-xC-xx.x in card view.

e. Click the Provisioning > Optical Chn > Parameters tabs.

f. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

g. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated in Step h.

h. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

i. Perform the output power check.

Step 11 (Optional.) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value on Provisioning > Optical Chn > Parameters tab for the 
proper CHAN TX power value +/– 0.5 dB.

Step 12 Repeat Steps 8 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the 
east-to-west direction.

Step 13 Remove the loopback on the west OSC-CSM. 

Step 14 In node view, click the Provisioning > WDM-ANS > Port Status tabs.

Step 15 Click Launch ANS.

Step 16 Create a loopback on the east OSC-CSM card by connecting the OSC-CSM LINE RX and LINE TX 
ports using a patch cord and 10-dB bulk attenuator.

Step 17 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations and Ring ID” 
procedure on page 3-74.)

Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.
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Step 18 If the OSC link becomes active, continue with Step 19. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 19. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 19. If it does not turn up, replace the OSC-CSM card. 

Step 19 Check the site configuration file from Cisco MetroPlanner and identify the wavelength (belonging to the 
100 Ghz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x-E or 
4MD-xx.x-E card on the west-to-east direction.

Step 20 Connect the tunable laser to the correspondent 15xx.x RX port (on the card front panel) of the east 
AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 21 Repeat Steps 3 through 20, applying the steps to the west-to-east direction.

Step 22 Restore the default admin state (IS,AINS/Unlocked,automaticInService) on all the ports previously set 
to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23 Launch ANS to recover the correct node configuration.

Step 24 Return to your originating procedure (NTP).
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September 2005
C H A P T E R 5

Provision Transponder and Muxponder Cards

This chapter explains how to provision transponder (TXP) and muxponder (MXP) cards. The 
provisioning must be performed before you provision the DWDM network and create circuits.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide as necessary.

Caution Provisioning TXPs and MXPs can be service affecting. You should make all changes during a scheduled 
maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G128 Manage Pluggable Port Modules, page 5-2—Complete this procedure to provision a 
multirate pluggable port module (PPM), provision or change the optical line rate of a PPM, or delete 
a PPM. PPMs provide the fiber interface to the TXP and MXP cards. Only the TXP_MR_10G does 
not accept PPMs.

2. NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and 
TXP_MR_10E Cards, page 5-8—As needed, complete this procedure to change the transmission 
settings for TXP_MR_10G and TXP_MR_10E cards.

3. NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and 
MXP_2.5G_10E Cards, page 5-25—As needed, complete this procedure to change the transmission 
settings for MXP_2.5G_10G and MXP_2.5G_10E cards.

4. NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards, page 5-39—As needed, complete this procedure to change the transmission 
settings for TXP_MR_2.5G and TXPP_MR_2.5G cards.

5. NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards, page 5-53—As needed, complete this procedure to change the 
transmission settings for MXP_MR_2.5G and MXPP_MR_2.5G cards.
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NTP-G128 Manage Pluggable Port Modules

Note A small-form factor pluggable (SFP) is the hardware device that plugs into a TXP or MXP card faceplate 
to provide a fiber interface to the card. In CTC, SFPs are called pluggable port modules (PPMs).

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 to log into an ONS 15454 on the network. If 
you are already logged in, continue with Step 2. 

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 8-27 as necessary.

b. Verify that no unexplained conditions appear on the network. If unexplained conditions appear, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide.

c. Complete the “DLP-G114 Export CTC Data” task on page 8-4 to export alarm and condition 
information.

Step 3 Complete the “DLP-G277 Provision a Multirate PPM” task on page 5-3. If you preprovisioned a 
multirate PPM (DLP-G273 Preprovision an SFP or XFP Slot, page 3-33), skip this step and continue 
with Step 5. Single-rate PPMs do not require provisioning.

Step 4 If you are provisioning an IBM ETR_CLO (External Time Reference – Control Link Oscillator) or 
InterSystem Coupling link (ISC) service on the PPM, complete “DLP-G274 Verify Topologies for 
ETR_CLO and ISC Services” task on page 5-6. Otherwise, continue with Step 5.

Step 5 Complete the “DLP-G278 Provision the Optical Line Rate” task on page 5-3 to assign a line rate to a 
TXP or MXP port. 

Step 6 Complete the “DLP-G280 Delete a PPM” task on page 5-7 as needed. 

Stop. You have completed this procedure.

Purpose Complete this procedure to provision a multirate PPM, provision or change 
the optical line rate of a multirate PPM, or delete a PPM. If a single-rate 
PPM is installed, the PPM screen will autoprovision and no further steps 
are necessary.

Tools/Equipment None

Prerequisite Procedures DLP-G63 Install an SFP or XFP, page 3-34

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
5-2
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
DLP-G277 Provision a Multirate PPM

Step 1 In node view, double-click the TXP or MXP card where you want to provision PPM settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Port Modules pane, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Click the slot number where the SFP is installed from the drop-down list.

• PPM Type—Click the number of ports supported by your SFP from the drop-down list. If only one 
port is supported, PPM (1 port) is the only menu option. 

Note The first port can be created only if the trunk is in the 
OOS-MA,DSBLD (ANSI)/Locked-enabled,disabled (ETSI) service state.

Step 5 Click OK. The newly created port appears on the Pluggable Port Modules pane. The row on the 
Pluggable Port Modules pane turns white and the Actual Equipment Type column lists the equipment 
name.

Step 6 Verify that the PPM appears in the list on the Pluggable Port Modules pane. If it does not, repeat 
Steps 3 through 5. 

Step 7 Repeat the task to provision a second PPM.

Step 8 Return to your originating procedure (NTP).

DLP-G278 Provision the Optical Line Rate

Purpose This task provisions a multirate PPM in CTC. If the PPM was 
preprovisioned using the “DLP-G273 Preprovision an SFP or XFP Slot” 
task on page 3-33, or the SFP or XFP is physically installed, this task is 
unnecessary unless the PPM has an OOS-AUMA,UAS service state.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions the line rate on a multirate pluggable port module 
(PPM). Single-rate PPMs do not need to be provisioned. 

Tools/Equipment None

Prerequisite Procedures DLP-G277 Provision a Multirate PPM, page 5-3

DLP-G274 Verify Topologies for ETR_CLO and ISC Services, page 5-6, 
if you are provisioning an ETR_CLO service.

DLP-G46 Log into CTC, page 2-24
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Step 1 In node view, double-click the TXP or MXP card where you want to provision PPM ports. If the data 
rate you are provisioning is DV-6000, HDTV, ESCON, SDI/D1 Video, ISC-3, or ETR_CLO, complete 
the following steps. Otherwise, continue with Step 2.

a. Click the Provisioning > OTN > OTN Lines tabs.

b. In the G.709 OTN field, choose Disable.

c. In the FEC field, choose Disable.

d. Click Apply.

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Ports pane, click Create. The Create Port dialog box appears.

Step 4 In the Create Port dialog box, complete the following:

• Port—Click the PPM number and port number from the drop-down list. The first number indicates 
the PPM and the second number indicates the port number on the PPM. For example, the first PPM 
with one port displays as 1-1 and the second PPM with one port displays as 2-1. The PPM number 
can be 1 to 4, but the port number is always 1. 

• Port Type—Click the type of port from the drop-down list. The port type menu displays the 
supported port rates on your PPM. See Table 5-1 for definitions of the supported rates on the TXP 
or MXP card. 

Step 5 Click OK. The row on the Pluggable Ports pane turns light blue until the actual SFP is installed, and then 
the row turns white.

Step 6 Repeat Steps 3 through 5 to configure the port rates as needed.

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The TXP_MR_10G is the only TXP or MXP card that does not accept PPMs.

Step 7 Return to your originating procedure (NTP).

Table 5-1 PPM Port Types

Card Port Type

TXP_MR_2.5G and 
TXPP_MR_2.5G

• OC-3/STM1—155 Mbps

• OC-12/STM4—622 Mbps

• OC-48/STM16—2.48 Gbps

• ONE_GE—One Gigabit Ethernet 1.125 Gbps

• ESCON—Enterprise System Connection (IBM signal)

• DV6000—Proprietary signal from video vendor

• SDI_D1_VIDEO—Serial Digital Interface and Digital Video 
signal type 1

• HDTV—High Definition Television

• PASS-THRU—Not specified

• FC1G—Fiber Channel 1.06 Gbps

• FC2G—Fiber Channel 2.125 Gbps

• FICON1G—Fiber CON 1.06 Gbps (IBM signal)

• FICON2G—Fiber CON 2.125 Gbps (IBM signal)

• ETR_CLO—External Time Reference – Control Link 
Oscillator

• ISC compat—InterSystem Coupling Link 1 (ISC1)

• ISC peer—InterSystem Coupling Link 3 (ISC3)

MXP_2.5G_10G and 
MXP_2.5G_10E

• OC-48/STM16—2.48 Gbps

TXP_MR_10E • OC-192/STM-64—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fiber Channel—10 Gbps Fiber Channel

MXP_MR_2.5G and 
MXPP_MR_2.5G

• FC1G—Fiber Channel 1.06 Gbps

• FC2G—Fiber Channel 2.125 Gbps

• FICON1G—Fiber CON 1.06 Gbps (IBM signal)

• FICON2G—Fiber CON 2.125 Gbps (IBM signal)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps
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DLP-G274 Verify Topologies for ETR_CLO and ISC Services

Step 1 Display your site plan in Cisco MetroPlanner.

Step 2 Verify that the topology where you plan to run the ETR_CLO or ISC service is one of the topologies that 
supports these services:

• Single span—Two terminal sites with 32MUX-O and 32DMX-O, or 32WSS and32DMX or 
32-DMX-O cards installed and no intermediate sites in between. Figure 5-1 shows a single-span 
topology as displayed in Cisco MetroPlanner.

Figure 5-1 Single-Span Topology

• Point-to-Point—Two terminal sites with 32MUX-O and 32DMX-O or 32WSS and32DMX or 
32-DMX-O cards installed. Line amplifiers can be installed between the terminal sites, but 
intermediate (traffic terminating) sites cannot be installed. Figure 5-2 shows a point-to-point 
topology as shown in Cisco MetroPlanner.

Figure 5-2 Point-to-Point Topology

• Two hubs—Two hub nodes in a ring with 32MUX-O and 32DMX-O 32WSS and32DMX or 
32-DMX-O cards installed. Line amplifiers can be installed between the hubs. 

Figure 5-3 shows two hub nodes with no line amplifier nodes installed. Figure 5-4 shows two hub nodes 
line amplifier nodes installed.

Purpose This task verifies that the DWDM network topology can support the IBM 
ETR_CLO and ISC services. These services cannot be provisioned on all 
DWDM topologies.

Tools/Equipment Cisco MetroPlanner site plan.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Site 1 Site 4

W E

13
43
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Site 1 Site 4

Site 2

E W

E
W
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E
W
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Figure 5-3 Hubs with No Line Amplifiers

Figure 5-4 Hubs with Line Amplifiers

Step 3 Return to your originating procedure.

DLP-G280 Delete a PPM

Note This task does not apply to the TXP_MR_10G card.

Site 1

Site 2

W

E

E

W

13
43

58

Purpose This task deletes PPM provisioning for SFPs or XFPs installed on TXP or 
MXP cards.

Tools/Equipment None

Prerequisite Procedures DLP-G63 Install an SFP or XFP, page 3-34 or

DLP-G273 Preprovision an SFP or XFP Slot, page 3-33

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

13
43

59

Site 1 Site 2

Site 2

W

E

E

W

EW

WE

Site 4
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Step 1 In node view, double-click the TXP or MXP card where you want to delete PPM settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 To delete a PPM and the associated ports:

Note You cannot delete a port if the client is in the IS-NR (ANSI)/Unlocked-enabled (ETSI) service 
state, is part of a protection group, has a GCC or DCC in use, is used as a timing source, has 
circuits, or has overhead circuits. You can delete a port if the trunk is in service and the client is 
in the OOS-MA,DSBLD (ANSI)/Locked-enabled,disabled (ETSI) service state, with the 
exception of the last port. You can delete the last port only if the trunk is in a 
OOS-MA,DSBLD (ANSI)/Locked-enabled,disabled (ETSI) service state.

a. Click the PPM line that you want to delete that appears in the Pluggable Port Modules pane. The 
highlight changes to dark blue.

b. Click Delete. The Delete PPM dialog box appears.

c. Click Yes. The PPM provisioning is removed from the Pluggable Port Modules pane and the 
Pluggable Ports pane.

Step 4 Verify that the PPM provisioning is deleted. CTC shows an empty slot after the PPM is deleted. 

Step 5 If you need to remove the PPM hardware (the SFP or XFP), complete the “DLP-G64 Remove an SFP or 
XFP” task on page 3-34. 

Step 6 Return to your originating procedure (NTP). 

NTP-G96 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_10G and TXP_MR_10E Cards

Note The TXP_MR_10G card does not support PPMs.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
transponder card settings. If you are already logged in, continue with Step 2.

Purpose This procedure changes the line and threshold settings for TXP_MR_10G 
and TXP_MR_10E cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

DLP-G63 Install an SFP or XFP, page 3-34

DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary) 

DLP-G278 Provision the Optical Line Rate, page 5-3 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 12-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards, page 5-9

• DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards, page 5-10

• DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH 
Payloads, page 5-15

• DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet 
LAN Phy, page 5-16

• DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA 
Thresholds, page 5-19

• DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA 
Thresholds, page 5-20

• DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards, page 
5-13

• DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards, page 5-22

Stop. You have completed this procedure.

DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the card 
settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 5-2. 

Purpose This task changes the card settings for TXP_MR_10G and TXP_MR_10E 
multirate (10 Gbps) transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the line 
settings.

Step 2 Click the Provisioning > Line > SONET (including 10G Ethernet WAN phy) tabs. 

Step 3 Modify any of the settings described in Table 5-3. 

Table 5-2 TXP_MR-10G and TXP_MR_10E Card Settings

Parameter Description Options – ONS 15454 Options – ONS 15454 SDH

Termination 
Mode

Sets the mode of operation. See the 
“15.12 Termination Modes” 
section on page 15-117 for more 
details.

• Transparent

• Section (TXP_MR_10E only)

• Line

• Transparent

• Regeneration Section 
(TXP_MR_10E only)

• Multiplex Section

AIS/Squelch 
Configuration 

(TXP_MR_10E only) Sets the 
transparent termination mode 
configuration.

• Squelch

• AIS

• Squelch

• AIS

Wavelength Sets the wavelength of the DWDM 
side optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 
100-GHz ITU spacing

• Supported wavelengths are in 
white and marked by asterisks 
(**); unsupported 
wavelengths are gray.

Note The four available 
wavelengths are listed in 
the Card Parameters 
section of the window and 
also in the Maintenance > 
Info subtab. 

• First Tunable Wavelength

• Further wavelengths in 
100-GHz ITU spacing

• Supported wavelengths are in 
white and marked by asterisks 
(**); unsupported 
wavelengths are gray.

Note The four available 
wavelengths are listed in 
the Card Parameters 
section of the window and 
also in the Maintenance > 
Info subtab. 

Purpose This task changes the line settings for TXP_MR_10G and TXP_MR_10E 
transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note In Table 5-3, some parameter tabs do not always apply to both the TXP_MR_10G and 
TXP_MR_10E cards. If a tab does not apply, it will not appear in CTC.

Table 5-3 TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings

Parameter Description Options – ONS 15454 Options – ONS 15454 SDH

Port (Display only) Displays the port 
number.

• 1-1 (OC192)

• 2 (Trunk)

• 1-1 (STM64)

• 2 (Trunk)

Port Name Provides the ability to assign the 
specified port a name.

User-defined. Name can be up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on page 7-9.

User-defined. Name can be up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on page 7-9.

Admin State Sets the port service state. For more 
information about administrative 
states, see Appendix C, “DWDM 
Administrative and Service 
States.”

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

Service State (Display only) Identifies the 
autonomously generated state that 
gives the overall condition of the 
port. Service states appear in the 
format: Primary State-Primary 
State Qualifier, Secondary State. 
For more information about service 
states, see Appendix C, “DWDM 
Administrative and Service 
States.”

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

SF BER (SONET [ANSI] or SDH [ETSI] 
including 10G Ethernet WAN Phy 
only) Sets the signal fail bit error 
rate.

• 1E-3

• 1E-4 

• 1E-5

• 1E-3

• 1E-4 

• 1E-5

SD BER (SONET [ANSI] or SDH [ETSI] 
including 10G Ethernet WAN Phy 
only) Sets the signal degrade bit 
error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak (SONET [ANSI] or SDH [ETSI] 
including 10G Ethernet WAN Phy 
only) Sets the automatic in-service 
soak period. Double click the time 
and use the up and down arrows to 
change settings.

• Duration of valid input signal, 
in hh.mm format, after which 
the card becomes in service 
(IS) automatically

• 0 to 48 hours, 15-minute 
increments 

• Duration of valid input signal, 
in hh.mm format, after which 
the card becomes in service 
(IS) automatically

• 0 to 48 hours, 15-minute 
increments 
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Type (SONET [ANSI] or SDH [ETSI] 
including 10G Ethernet WAN Phy 
only) The optical transport type.

• SONET

• SDH

• SONET

• SDH

ALS Mode Sets the automatic laser shutdown 
function mode. The DWDM 
transmitter supports ALS 
according to ITU-T G.644 (06/99). 
ALS can be disabled or be set for 
three mode options.

• Disable (default): ALS is off; 
the laser is not automatically 
shut down when traffic 
outages (LOS) occur.

• Auto Restart: ALS is on; the 
laser automatically shuts 
down when traffic outages 
(LOS) occur. It automatically 
restarts when the conditions 
that caused the outage are 
resolved.

•  Manual Restart: ALS is on; 
the laser automatically shuts 
down when traffic outages 
(LOS) occur. However, the 
laser must be manually 
restarted when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the laser for 
testing.

• Disable (default): ALS is off; 
the laser is not automatically 
shut down when traffic 
outages (LOS) occur.

• Auto Restart: ALS is on; the 
laser automatically shuts 
down when traffic outages 
(LOS) occur. It automatically 
restarts when the conditions 
that caused the outage are 
resolved.

•  Manual Restart: ALS is on; 
the laser automatically shuts 
down when traffic outages 
(LOS) occur. However, the 
laser must be manually 
restarted when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the laser for 
testing.

ProvidesSync (TXP_MR_10E, OC192 only) Sets 
the ProvidesSync card parameter. If 
checked, the card is provisioned as 
a network element timing 
reference.

Checked or unchecked Checked or unchecked

SyncMsgIn (TXP_MR_10E, OC192 only) Sets 
the EnableSync card parameter. 
Enables synchronization status 
messages (S1 byte), which allow 
the node to choose the best timing 
source.

Checked or unchecked Checked or unchecked

Send 
DoNotUse

(TXP_MR_10E, OC192 only) Sets 
the Send DoNotUse card state. 
When checked, sends a DUS (do 
not use) message on the S1 byte.

Checked or unchecked Checked or unchecked

Max Size (TXP_MR_10E, 10_GE LAN Phy 
only) Sets the maximum Ethernet 
packet size.

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

Incoming 
MAC Address

(TXP_MR_10E, 10_GE LAN Phy 
only) Sets the incoming MAC 
address.

Value of MAC address. 6 bytes in 
hexadecimal format.

Value of MAC address. 6 bytes in 
hexadecimal format.

Table 5-3 TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings (continued)

Parameter Description Options – ONS 15454 Options – ONS 15454 SDH
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Step 5 Return to your originating procedure (NTP).

DLP-G218 Change Section Trace Settings for the TXP_MR_10G and 
TXP_MR_10E Cards

Note The Section Trace tab is available for the TXP_MR_10G and TXP_MR_10E cards only if no 
PPM or an OC192 PPM has been provisioned. The tab is not available if a TEN_GE LAN Phy 
or FC10G PPM has been provisioned.

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.

Step 3 Modify any of the settings described in Table 5-4. 

Purpose This task changes the section trace settings for the TXP_MR_10G and 
TXP_MR_10E transponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-4 TXP_MR_10G and TXP_MR_10E Transponder Card Section Trace Settings

Parameter Description Options – ONS 15454 Options — ONS 15454 SDH

Port Sets the port number. • 1-1 (OC192)

• 2—Trunk

• 1-1 (STM64)

• 2—Trunk

Trace Mode Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

• 1 byte

• 16 byte
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Transmit Displays the current 
expected string; sets a new 
expected string. You can 
click the button on the right 
to change the display. Its 
title changes, based on the 
current display mode. Click 
Hex to change the display to 
hexadecimal (button 
changes to ASCII); click 
ASCII to change the display 
to ASCII (button changes to 
Hex).

String of trace string size String of trace string size

Expected Displays the current 
expected string; sets a new 
expected string. You can 
click the button on the right 
to change the display. Its 
title changes, based on the 
current display mode. Click 
Hex to change the display to 
hexadecimal (button 
changes to ASCII); click 
ASCII to change the display 
to ASCII (button changes to 
Hex).

String of trace string size String of trace string size

Received (Display only) Displays the 
current received string. You 
can click Refresh to 
manually refresh this 
display, or select the 
Auto-refresh every 5 sec 
check box to keep this panel 
updated.

String of trace string size String of trace string size

Table 5-4 TXP_MR_10G and TXP_MR_10E Transponder Card Section Trace Settings (continued)

Parameter Description Options – ONS 15454 Options — ONS 15454 SDH
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DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 
SONET or SDH Payloads

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the line 
threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds tabs. 

Step 3 Modify any of the settings described in Table 5-5. 

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; Line 
and Section independently. To do so choose the appropriate radio button and click Refresh.

Purpose This task changes the line threshold settings for TXP_MR_10G and 
TXP_MR_10E transponder cards carrying SONET or SDH payloads, 
including the physical 10G Ethernet WAN payload. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-5 TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings

Parameter Description Options – ONS 15454 Options – ONS 15454 SDH

Port (Display only) 
Port number

• 1-1 (OC192)

• 2 (Trunk)

• 1-1 (STM64)

• 2 (Trunk)

CV Coding 
violations

Numeric. Can be set for Near End or Far End, 
for 15-minute or one-day intervals, or for Line 
(Far End only), Line, or Section. Select a bullet 
and click Refresh. 

Numeric. Can be set for Nea
for 15-minute or one-day int
multiplex section (Far End o
Section, or Regeneration Se
bullet and click Refresh. 

ES Errored 
seconds

Numeric. Can be set for Near End or Far End, 
for 15-minute or one-day intervals, or for Line 
(Far End only), Line, or Section. Select a bullet 
and click Refresh.

Numeric. Can be set for Nea
for 15-minute or one-day int
multiplex section (Far End o
Section, or Regeneration Se
bullet and click Refresh.

SES Severely 
errored 
seconds

Numeric. Can be set for Near End or Far End, 
for 15-minute or one-day intervals, or for Line 
(Far End only), Line, or Section. Select a bullet 
and click Refresh.

Numeric. Can be set for Nea
for 15-minute or one-day int
multiplex section (Far End o
Section, or Regeneration Se
bullet and click Refresh.
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 
10G Ethernet LAN Phy

Step 1 Display the TXP_MR_10G or TXP_MR_10E card where you want to change the line threshold settings 
in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 5-6 for a list of available 
Ethernet thresholds.

FC Failure count Numeric. Can be set for Near End or Far End, 
for 15-minute or one-day intervals, or for Line 
(Far End only), Line, or Section. Select a bullet 
and click Refresh.

Numeric. Can be set for Nea
for 15-minute or one-day int
Regeneration Section Select
Refresh.

UAS Unavailable 
seconds

Numeric. Can be set for Near End or Far End, 
for 15-minute or one-day intervals, or for Line 
(Far End only), Line, or Section. Select a bullet 
and click Refresh.

Numeric. Can be set for Nea
for 15-minute or one-day int
Regeneration Section. Select
Refresh.

Purpose This task changes the line threshold settings for TXP_MR_10G and 
TXP_MR_10E transponder cards carrying the physical 10G Ethernet LAN 
payload.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-6 TXP_MR_10G and TXP_MR 10GE LAN Phy Variables

Variable Description

ifInOctets Total number of octets received on the interface, including framing 
characters.

rxTotalPkts Total number of received packets.

ifInMulticastPkts Number of multicast frames received error free.

Table 5-5 TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings (continued)

Parameter Description Options – ONS 15454 Options – ONS 15454 SDH
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ifInBroadcastPkts Number of packets, delivered by a sub-layer to an higher sub-layer, 
which were addressed to a broadcast address at this sub-layer.

ifInErrors Number of inbound packets that contained errors preventing them 
from being delivered to a higher-layer protocol.

ifInErrorBytePkts Number of receive error bytes.

ifInFramingErrorPkts Number of receive framing error counters. 

ifInJunkInterPkts Number of receive interpacket junk counters.

ifOutOctets Total number of octets transmitted out of the interface, including 
framing characters.

txTotalPkts Total number of transmit packets.

ifOutMulticastPkts Number of multicast frames transmitted error free.

ifOutBroadcastPkts Total number of packets that higher-level protocols requested be 
transmitted, and which were addressed to a broadcast address at 
this sub-layer, including those that were discarded or not sent.

dot3StatsFCSErrors Number of frames with frame check errors, that is, there is an 
integral number of octets, but an incorrect Frame Check Sequence 
(FCS).

dot3StatsFrameTooLong Number of received frames that were larger than the maximum size 
permitted.

etherStatsUndersizePkts Total number of packets received that were less than 64 octets long 
(excluding framing bits, but including FCS octets) and were 
otherwise well formed.

etherStatsFragments Total number of packets received that were less than 64 octets in 
length (excluding framing bits but including

FCS octets) and had either a bad Frame Check Sequence (FCS) 
with an integral number of octets (FCS Error) or a bad FCS with a 
non-integral number of octets (Alignment Error). Note that it is 
entirely normal for etherStatsFragments to increment. This is 
because it counts both runts (which are normal occurrences due to 
collisions) and noise hits.

etherStatsPkts64Octets Total number of packets (including bad packets) received that were 
64 octets in length (excluding framing bits but including FCS 
octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) received that were 
between 65 and 127 octets in length inclusive

(excluding framing bits but including FCS octets).

etherStatsPkts128to255Octets The total number of packets (including bad packets) received that 
were between 128 and 255 octets in length inclusive (excluding 
framing bits but including FCS octets).

Table 5-6 TXP_MR_10G and TXP_MR 10GE LAN Phy Variables (continued)
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

etherStatsPkts256to511Octets Total number of packets (including bad packets) received that were 
between 256 and 511 octets in length inclusive

(excluding framing bits but including FCS octets).

etherStatsPkts512to1023Octets Total number of packets (including bad packets) received that were 
between 512 and 1023 octets in length inclusive (excluding framing 
bits but including FCS octets).

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) received that were 
between 1024 and 1518 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsBroadcastPkts Total number of good packets received that were directed to the 
broadcast address. Note that this does not include multicast 
packets.

etherStatsMulticastPkts Total number of good packets received that were directed to a 
multicast address. Note that this number does not include packets 
directed to the broadcast address.

etherStatsOversizePkts Total number of packets received that were longer than 1518 octets 
(excluding framing bits, but including FCS octets) and were 
otherwise well formed.

etherStatsJabbers Total number of packets received that were longer than 1518 octets 
(excluding framing bits, but including FCS octets), and had either 
a bad Frame Check Sequence (FCS) with an integral number of 
octets (FCS Error) or a bad FCS with a non-integral number of 
octets (Alignment Error).

etherStatsOctets Total number of octets of data (including those in bad packets) 
received on the network (excluding framing bits but including FCS 
octets).

etherStatsCRCAlignErrors Total number of packets received that had a length (excluding 
framing bits, but including FCS octets) of between 64 and 1518 
octets, inclusive, but had either a bad Frame Check Sequence (FCS) 
with an integral number of octets (FCS Error) or a bad FCS with

a non-integral number of octets (Alignment Error).

rxPauseFrames Number of received 802.x pause frames

rxControlFrames Number of MAC control frames passed by the MAC sub-layer to 
the MAC control sub-layer.

rxUnknownOpcodeFrames Number of MAC control frames received that contain an opcode 
that is not supported by the device. 

Table 5-6 TXP_MR_10G and TXP_MR 10GE LAN Phy Variables (continued)
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Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 minutes subsides and creates only 
799 collisions in 15 minutes, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-minute period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK to complete the procedure.

Step 12 Return to your originating procedure (NTP).

DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and 
TCA Thresholds

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the 
trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Referring to Table 5-7, provision the trunk port (Port 2) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 4 Click Apply.

Purpose This task provisions the TXP_MR_10G and TXP_MR_10E trunk port 
alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
5-19
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 5-7, provision the trunk port (Port 2) Alarm thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 7 Click Apply. 

Step 8 Return to your originating procedure (NTP).

DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and 
TCA Thresholds

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the 
client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 5-8, provision the Port 1 (Client) TCA thresholds for RX Power High, RX Power Low, 
TX Power High, and TX Power Low based on the client interface at the other end. For additional 
information about client SFP and XFP interfaces, also known as Pluggable Port Modules (PPMs), refer 
to the Hardware Specifications chapter in the Cisco ONS 15454 Reference Manual.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Table 5-7 TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds

Card
Alarm RX
Power Low

Alarm RX
Power High

TCA RX
Power Low

TCA RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

TCA TX
Power Low

TCA TX
Power High

TXP_MR_10G –24 dBm –8 dBm –22 dBm –8 dBm 2 dBm 4 dBm –1 dBm 7 dBm

TXP_MR_10E –20 dBm –8 dBm –18 dBm –9 dBm 3 dBm 7 dBm 0 dBm 9 dBm

Purpose This task provisions the client port alarm and threshold cross alert (TCA) 
thresholds for the TXP_MR_10G and TXP_MR_10E Cards

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 5-3

DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Do not modify the Laser Bias parameters.

Step 4 Click Apply.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 5-8, provision the Port 1 (Client) Alarm thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 7 Click Apply.

Step 8 Return to your originating procedure.

Table 5-8 Client Interfaces Alarm and TCA Thresholds: TXP_MR_10E and TXP_MR_10G Cards 

Port Type 
(by CTC)

Pluggable Port 
Module (XFP)

Alarm RX
Power 
Low

Alarm RX
Power 
High

Alarm TX
Power 
Low

Alarm TX
Power 
High

TCA RX
Power 
Low

TCA RX
Power 
High

TCA TX
Power 
Low

TCA TX
Power 
High

SONET (or 
SDH)

TXP_MR_10E uses
ONS-XC-10G-S1

–14 2 –9 2 –11 –1 –12 5

TXP_MR_10G
(XFP not present)

–14 2 –9 2 –11 –1 –12 5

10G 
Ethernet 
LAN Phy

TXP_MR_10E uses
ONS-XC-10G-S1

–17 4 –9 2 –14 1 –12 5

TXP_MR_10G
(XFP not present)

–17 4 –9 2 –14 1 –12 5

10G 
Ethernet 
WAN PHY

TXP_MR_10E uses
ONS-XC-10G-S1

–17 4 –9 2 –14 1 –12 5

TXP_MR_10G
(XFP not present)

–17 4 –9 2 –14 1 –12 5
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DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the OTN 
settings.

Step 2 Click one of the Provisioning > OTN tabs: OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail 
Trace Identifier. 

Step 3 Modify any of the settings described in Tables 5-9 through 5-12. 

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; SM 
and PM independently. To do so choose the appropriate radio button and click Refresh.

Table 5-9 describes the values on the Provisioning > OTN > OTN Lines tab.

Purpose This task changes the line optical transport network (OTN) settings for 
TXP_MR_10G and TXP_MR_10E transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-9 TXP_MR_10G and TXP_MR_10E Transponder Card OTN Settings

Parameter Description Options

Port # (Display only) Port number. 2

G.709 OTN Sets the OTN lines according to ITU-T 
G.709. Check box to enable.

• Enabled

• Disabled

FEC Sets the OTN lines FEC mode. FEC mode 
can be Disabled, Enabled or Enhanced 
FEC mode can be enabled (to provide 
greater range and lower bit error rate).

• Enabled—(TXP_MR_10G only) 
FEC is on 

• Disabled—FEC is off

• Standard—(TXP_MR_10E only) 
Standard FEC is on.

• Enhanced—(TXP_MR_10E only) 
Enhanced FEC is on 
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Table 5-10 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 5-11 describes the values on the Provisioning > OTN > FEC Thresholds tab.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

(TXP_MR_10E only) The card can 
perform multiplexing per ITU-T G.709. 
The ODUk (client SONET/SDH payload) 
can be mapped to the Optical Channel 
(OTUk) either asynchronously or 
synchronously with this setting.

• Asynch mapping

• Synch mapping

Table 5-9 TXP_MR_10G and TXP_MR_10E Transponder Card OTN Settings (continued)

Parameter Description Options

Table 5-10 TXP_MR_10G and TXP_MR_10E Transponder Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Port number. 2

ES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC and 
overhead management and performance 
monitoring using OTUk. Selecting the 
PM radio button selects path performance 
monitoring using ODUk.

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 
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Table 5-12 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Step 4 Click Apply. 

Table 5-11 TXP_MR_10G and TXP_MR_10E Transponder Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

2

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Table 5-12 TXP_MR_10G and TXP_MR_10E Transponder Card Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

Level Sets the level. • Section

• Path

Trace Mode Sets the trace mode. • Off/None

• Auto

• Manual

Transmit Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or select 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size
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Step 5 Return to your originating procedure (NTP).

NTP-G97 Modify Line Settings and PM Parameter Thresholds for 
MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
muxponder card settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 12-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-26

• DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-28

• DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 
5-30

• DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-31

• DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 
5-33

• DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA 
Thresholds, page 5-34

• DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA 
Thresholds, page 5-35

• DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-36

Step 4 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for 
MXP_2.5G_10G and MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31.

DLP-G63 Install an SFP or XFP, page 3-34

DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)

DLP-G278 Provision the Optical Line Rate, page 5-3 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or and MXP_2.5G_10E card where you want to change 
the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 5-13. 

Purpose This task changes the card settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards, including payload type, termination 
mode, and wavelength. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 5-13 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation. Options that 
do not apply to a card do not display.

The MXP_2.5G_10G card is based on 
SONET/SDH multiplexing. The 
transparent mode terminates and rebuilds 
the B1 byte (as well as other bytes) of the 
incoming OC-48/STM-16 signal. The B2 
byte is not touched.

The MXP_2.5G_10E card is fully 
transparent in transparent mode based on 
the OTN/G.709 multiplexing scheme. It 
does not terminate the B1 byte or other 
bytes. 

It encapsulates OC-48/STM-16 bytes into 
ODU1 first, then multiplexes them into an 
OTU2.

See the “15.12 Termination Modes” 
section on page 15-117 for more 
information.

For ANSI platforms:

• Transparent

• Section (MXP_2.5G_10E only)

• Line (MXP_2.5g_10E only)

For ETSI platforms:

• Transparent

• Multiplex Section (MXP_2.5G_10E 
only)

• Regeneration Section 
(MXP_2.5g_10E only)

Wavelength Set the wavelength of the DWDM side 
optical transmitter. You can set the 
wavelength to the First Tunable 
Wavelength or to further wavelengths in 
100 GHz ITU spacing. 

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
grid specification

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray 

Note The four available wavelengths 
are listed in the Card Parameters 
section of the window and also in 
the Maintenance > Info subtab.

AIS/Squelch (MXP_2.5G_10E only) Sets the 
transparent termination mode 
configuration.

• Ais

• Squelch

Card 
Parameters

Displays the settings for the card. Information only
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DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 Double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the line settings.

Step 2 Click the Provisioning > Line > SONET [ANSI] or SDH [ETSI] tabs. 

Note The SONET tab appears only if you have created a PPM for a given port.

Step 3 Modify any of the settings described in Table 5-14. 

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; Line 
and Section independently. To do so choose the appropriate radio button and click Refresh.

Purpose This task changes the line settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-14 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings

Parameter Description Options

Port # (Display only) Port number. Ports 1 to 4 are client 
ports (OC-48/STM-16). Port 5 (TXP_2.5G_10G) is 
the DWDM trunk (OC-192/STM-64) that provides 
wavelength services.

• 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and Service 
States.”

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS(ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD(ANSI) or Locked,disabled (ETSI)

• OOS,MT(ANSI) or Locked,maintenance (ETSI)
5-28
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Administrative and Service States.”

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or be 
set for three mode options.

• Disable (default): ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted 
when conditions that caused the outage are 
resolved.

• Manual Restart for Test: Manually restarts the 
laser for testing.

SF BER Sets the signal fail bit error rate. • 1E-3

• 1E-4

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

AINS Soak Sets the automatic in-service soak period. Double 
click the time and use the up and down arrows to 
change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type • SONET

• SDH

ProvidesSync Sets the ProvidesSync card parameter. If checked, 
the card is provisioned as a network element timing 
reference. (This parameter does not appear for the 
MXP_2.5G_10E trunk port.)

Checked or unchecked

Table 5-14 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards

Note The Section Trace tab appears only if you have created a PPM for the card.

Step 6 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
section trace settings.

Step 7 Click the Provisioning > Line > Section Trace tabs. 

Step 8 Modify any of the settings described in Table 5-15. 

SyncMsgIn Enables synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source. (This parameter does not appear for the 
MXP_2.5G_10E trunk port.)

Checked or unchecked

Send 
DoNotUse

When checked, sends a DUS (do not use) message 
on the S1 byte. (This parameter does not appear for 
the MXP_2.5G_10E trunk port.)

Checked or unchecked

Purpose This task changes the section trace settings for MXP_2.5G_10G and 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-14 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings (continued)

Parameter Description Options

Table 5-15 TXP_MR_10G and MXP_MR_10E Card Section Trace Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

• 3

• 4

Trace Mode Sets the trace mode. • Off/None

• Manual
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Step 9 Click Apply. 

Step 10 Return to your originating procedure (NTP).

DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Trunk tab. 

Step 3 Modify any of the settings described in Table 5-16. 

Section Trace 
String Size

Sets the trace string size. Select either 
radio button.

• 1 byte

• 16 byte

Transmit Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or select 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Purpose This task provisions the trunk settings for MXP_2.5G_10G and 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-15 TXP_MR_10G and MXP_MR_10E Card Section Trace Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Table 5-16 MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trunk Settings

Parameter Description Options

Port # (Display only) Displays the port number. Port 5 is 
the DWDM trunk (OC-192/STM-64) that provides 
wavelength services. 

5

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 7-9.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS(ANSI) or 
Unlocked,automaticInService (ETSI)

• OOS,DSBLD(ANSI) or Locked,disabled 
(ETSI)

• OOS,MT(ANSI) or Locked,maintenance 
(ETSI)

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or be set 
for three mode options.

• Disable (default): ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser 
automatically shuts down when traffic outages 
(LOS) occur. However, the laser must be 
manually restarted when conditions that caused 
the outage are resolved.

• Manual Restart for Test: Manually restarts the 
laser for testing.

AINS Soak (OC-N and STM-N payloads only) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 
5-32
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
Step 5 Return to your originating procedure (NTP).

DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 5-17. 

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; Line 
and Section independently. To do so choose the appropriate radio button and click Refresh.

Note In Table 5-17, some parameter tabs or selections do not always apply to both the MXP_2.5G_10G and 
MXP_2.5G_10E cards. If the tabs or selections do not apply, they do not appear in CTC.

Purpose This task changes the line threshold settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-17 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Threshold Settings

Parameter Description Options

Port (Display only) Port number • 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select a bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm 
and TCA Thresholds

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Select a 15 Min or 1 Day performance monitoring interval radio button and then click Refresh.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 4 Referring to Table 5-18, provision the trunk port (Port 5) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low.

Note Do not modify the Laser Bias parameters.

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

FC (Line only) Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh. 

UAS (Line only) Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Purpose This task changes the MXP_2.5G_10G and MXP_2.5G_10E trunk port 
alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-17 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Threshold Settings 

Parameter Description Options
5-34
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 5-18, provision the trunk port (Port 5) Alarm thresholds for RX Power High, RX 
Power Low, TX Power High, and TX Power Low.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply.

Step 9 Return to your originating procedure (NTP).

DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm 
and TCA Thresholds

Step 1 In node view, double-click the MXP_2.5G_10G and MXP_2.5G_10E card where you want to change the 
client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 5-19, provision the Port N (where N = 1 through 4) TCA thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
For additional information about client SFP and XFP interfaces, also known as Pluggable Port Modules 
(PPMs), refer to the Hardware Specifications chapter in the Cisco ONS 15454 Reference Manual.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Table 5-18 MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds

Card
Alarm RX
Power Low

Alarm RX
Power High

TCA RX
Power Low

TCA RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

TCA TX
Power Low

TCA TX
Power High

MXP_2.5G_10G –24 dBm –8 dBm –22 dBm –8 dBm 2 dBm 4 dBm –1 dBm 7 dBm

MXP_2.5G_10E –20 dBm –8 dBm –18 dBm –9 dBm 3 dBm 7 dBm 0 dBm 9 dBm

Purpose This task provisions the client port alarm and threshold cross alert (TCA) 
thresholds for the MXP_2.5G_10G and MXP_2.5G_10E Cards

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 5-3

DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 5-19, provision the Port N (where N = 1 through 4) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. Otherwise, continue with Step 10.

Step 10 Return to your originating procedure.

DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E 
Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
line OTN settings.

Step 2 Click one of the Provisioning > OTN tabs: OTN Lines, OTN G.709 Thresholds, FEC Thresholds, or 
Trail Trace Identifier. 

Step 3 Modify any of the settings described in Tables 5-20 through 5-23. 

Table 5-19 Client Interfaces Alarm and TCA Thresholds: MXP_2.5G_10G and MXP_2.5G_10E Cards 

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power 
Low

Alarm RX
Power 
High

Alarm TX
Power 
Low

Alarm TX
Power 
High

TCA RX
Power 
Low

TCA RX
Power 
High

TCA TX
Power 
Low

TCA TX
Power 
High

OC-48 ONS-SE-2G-S1 -21 0 -13 0 -18 -3 -16 3

15454-SFP-OC48-IR -21 3 -8 3 -18 0 -11 6

STM-16 ONS-SE-2G-S1 -21 0 -13 0 -18 -3 -16 3

15454E-SFP-L.16.1 -21 3 -8 3 -18 0 -11 6

Purpose This task changes the line OTN settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; SM 
and PM independently. To do so choose the appropriate radio button and click Refresh.

Table 5-20 describes the values on the Provisioning > OTN > OTN Lines tab.

Note In Table 5-20, some parameter tabs or values do not always apply to both the MXP_2.5G_10G 
and MXP_2.5G_10E cards. When the tabs or values do not apply, they do not appear to the user.

Table 5-21 describes the values on the Provisioning > OTN > OTN G.709 Thresholds tab.

Table 5-20 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line OTN Settings

Parameter Description Options

Port # (Display only) Displays the port number. 5

G.709 OTN Sets the OTN lines according to ITU-T 
G.709.

• Enabled

• Disabled

FEC Sets the OTN line FEC mode. FEC mode 
can be Disabled or Enabled. Enhanced 
FEC mode can be enabled (to provide 
greater range and lower bit error rate). 
E-FEC applies only to the 
MXP_2.5G_10E card.

• Enabled—(MXP_2.5G_10G only) 
FEC is on

• Disabled—FEC is off

• Standard—(MXP_2.5G_10E only) 
FEC is on

• Enhanced—(MXP_2.5G_10E only) 
Enhanced FEC is on

SF BER Sets the signal fail bit error rate. • 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

The MXP_2.5G_10E can perform 
standard ODU multiplexing according to 
ITU-T G.709. The card uses this to 
aggregate the four OC-48 client signals.

• ODU Multiplex

Table 5-21 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card G.709 Threshold Settings

Parameter Description Options

Port (Display only) Port number 5

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 
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Table 5-22 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 5-23 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

SES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC and 
overhead management and performance 
monitoring using OTUk. Selecting the 
PM radio button selects path performance 
monitoring using ODUk.

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

Table 5-21 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card G.709 Threshold Settings 

Parameter Description Options

Table 5-22 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. 5

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the interval selected. 
The interval can be set for 15 minutes or 
one day.

Numeric

Uncorrectable 
Words

Displays the number of uncorrectable 
words during the interval selected. The 
interval can be set for 15 minutes or one 
day.

Numeric 

Table 5-23 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. The trail trace 
identifier is applicable only to the trunk 
interface, which handles G.709 frames.

• 5

Level Sets the level. • Section

• Path
5-38
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 5      Provision Transponder and Muxponder Cards
Before You Begin
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G98 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_2.5G and TXPP_MR_2.5G Cards

Trace Mode Sets the trace mode. • Off/None

• Manual

Transmit Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or select 
the Auto-refresh every 5 sec box to keep 
this panel updated.

String of trace string size

Purpose This procedure changes the line and threshold settings for TXP_MR_2.5G 
and TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

DLP-G63 Install an SFP or XFP, page 3-34

DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)

DLP-G278 Provision the Optical Line Rate, page 5-3 (if necessary)

Required/As Needed As needed

Table 5-23 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings 

Parameter Description Options
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
transponder card settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 12-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-40

• DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-42

• DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 
5-43

• DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for 
SONET or SDH Payloads, page 5-45

• DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet 
or 1G FC/FICON Payloads, page 5-46

• DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA 
Thresholds, page 5-47

• DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA 
Thresholds, page 5-48

• DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-51

Stop. You have completed this procedure.

DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 5-24. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the card settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 5-24 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation (option only 
supported for SONET/SDH payloads). 
See the “15.12 Termination Modes” 
section on page 15-117 for more 
information.

• Transparent

• Section

• Line

Wavelength Sets the wavelength of the DWDM side 
optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray.

Note The four available wavelengths 
are listed in the Card Parameters 
section of the window and also in 
the Maintenance > Info subtab. 

Regeneration 
Peer Slot

Sets the slot containing another 
TXP_MR_2.5G or TXPP_MR_2.5G card 
to create a regeneration peer group. A 
regeneration peer group facilitates 
management of two TXP_MR_2.5G or 
TXPP_MR_2.5G cards that are needed to 
perform a complete signal regeneration.

The regeneration peer group 
synchronizes provisioning of the two 
cards. Payload type and G.709 OTN 
changes made on one TXP_MR_2.5G or 
TXPP_MR_2.5G card are reflected on the 
peer TXP_MR_2.5G or TXPP_MR_2.5G 
card.

Note: Y-cable protection groups cannot 
be created on TXP_MR_2.5G or 
TXPP_MR_2.5G cards that are in a 
regeneration peer group.

• None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Regeneration 
Group Name

Sets the regeneration peer group name. User defined.
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DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
line settings.

Step 2 Click the Provisioning > Line tabs and any additional PPM tabs depending on the client interface. Tabs 
and parameter selections vary according to PPM provisioning.

Step 3 Modify any of the settings described in Table 5-25. 

Purpose This task changes the line settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-25 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings

Parameter Description Options

Port # (Display only) Displays the port number. • 1

• 2 

• 3 (TXPP_MR_2.5G card only)

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 7-9.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS(ANSI) or 
Unlocked,automaticInService (ETSI)

• OOS,DSBLD(ANSI) or Locked,disabled 
(ETSI)

• OOS,MT(ANSI) or Locked,maintenance 
(ETSI)

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards

Note This task only applies to SONET services.

ALS Mode Sets the automatic laser shutdown function. • Disabled (default)

• Auto Restart

• Manual Restart

• Manual Restart for Test

SF BER (OC-N and STM-N payloads only) Sets the signal 
fail bit error rate.

• 1E-3

• 1E-4

• 1E-5

SD BER (OC-N and STM-N payloads only) Sets the signal 
degrade bit error rat.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak (OC-N and STM-N payloads only) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type. (OC-N and STM-N 
payloads only)

• SONET

• SDH

Purpose This task changes the section trace settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-25 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings (continued)

Parameter Description Options
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Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. 

Step 3 Modify any of the settings described in Table 5-26. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 5-26 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace Settings

Parameter Description Options

Port (Display only) Port number. • 1

• 2

• 3 (TXPP_MR_2.5G only)

Trace Mode Sets the trace mode. • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or choose 
Auto-refresh every 5 sec box to keep this 
display updated automatically.

String of trace string size
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DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold 
Settings for SONET or SDH Payloads

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs,

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; Line 
and Section independently. To do so choose the appropriate radio button and click Refresh.

Step 3 Modify any of the settings in Table 5-27. 

Purpose This task changes the line threshold settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards carrying OC-3/STM-1, 
OC-12/STM-4, and OC-48/STM-16 payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-27 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads

Parameter Description Options

Port (Display only) Port number • 1

• 2

• 3 (TXPP_MR_2.5G card only)

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SEFS (Section only) Severely errored framing 
seconds 

Numeric. Can be set for Far End, for 
15-minute or one-day intervals for 
Section only. Select the bullet and click 
Refresh. 
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Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds 
for 1G Ethernet or 1G FC/FICON Payloads

Step 1 Display the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line threshold 
settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 5-28 for a list of available 
Ethernet thresholds.

FC (Line only) Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals 
for Line only. Select the bullet and click 
Refresh. 

UAS (Line only) Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Purpose This task changes the line threshold settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards carrying the 1G Ethernet, 1G 
FC/FICON payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-28 TXP_MR_2.5G and TXPP_MR_2.5G 1G Ethernet, 1G FC/FICON

Variable Description

ifInErrors Number of inbound packets that contained errors preventing 
them from being deliverable to a higher-layer protocol.

rxTotalPkts Total number of received packets.

Table 5-27 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads (continued)

Parameter Description Options
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 minutes subsides and creates only 
799 collisions in 15 minutes, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-minute period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK to complete the procedure.

Step 12 Return to your originating procedure (NTP).

DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm 
and TCA Thresholds

8b10bStatsEncodingDispErrors Number of 8b10b disparity violations on the Fiber Channel line 
side.

8b10bIdleOrderedSets Number of received packets containing idle ordered sets.

8b10bNonIdleOrderedSets Number of received packets containing non-idle ordered sets.

8b10bDataOrderedSets Number of received packets containing data ordered sets.

Table 5-28 TXP_MR_2.5G and TXPP_MR_2.5G 1G Ethernet, 1G FC/FICON

Purpose This task changes the TXP_MR_2.5G and TXPP_MR_2.5G trunk port 
alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
trunk port alarm and TCA settings.

Step 2 Click the Pluggable Port Modules tab. Under Pluggable Ports, record the Rate that is provisioned. 

Step 3 Look up the rate in Table 15-54 on page 15-89 and determine whether it is 2R or 3R.

Step 4 Click the Provisioning > Optics Thresholds tabs. 

Step 5 Click the 15 Min performance monitoring interval radio button and click Refresh.

Step 6 Referring to Table 5-29, provision the trunk port (Port 2) TCA thresholds for RX Power High and RX 
Power Low depending on whether the rate is 2R or 3R.

Note Do not modify the Laser Bias parameters.

Step 7 Click Apply.

Step 8 Under Types, click the Alarm radio button and click Refresh.

Step 9 Provision the trunk port (Port 2) Alarm thresholds for RX Power High to –7 dBm and the RX Power Low 
to –26 dBm.

Step 10 Click Apply. 

Step 11 Click the 1 Day performance monitoring interval radio button, click Refresh, then repeat Steps 6 
through 10. If you have completed both intervals, continue with Step 12.

Step 12 Return to your originating procedure (NTP).

DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port 
Alarm and TCA Thresholds

Table 5-29 TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port TCA Thresholds

Signal TCA RX Power Low TCA RX Power High

3R –23 dBm –9 dBm

2R –24 dBm –9 dBm

Purpose This task provisions the client port alarm and threshold cross alert (TCA) 
thresholds for the TXP_MR_2.5G and TXPP_MR_2.5G cards

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 5-3

DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the TXP_MR_2.5G and TXPP_MR_2.5G card where you want to change the 
client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 5-30, provision the Port 1 (client) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low based on the client interface at the other end. For additional 
information about client SFP and XFP interfaces, also known as Pluggable Port Modules (PPMs), refer 
to the Hardware Specifications chapter in the Cisco ONS 15454 Reference Manual.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 4 Click Apply.

Table 5-30 Client Interfaces Alarm and TCA Thresholds: TXP_MR_2.5G and TXPP_MR_2.5G Cards 

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power 
Low

Alarm RX
Power 
High

Alarm TX
Power 
Low

Alarm TX
Power 
High

TCA RX
Power 
Low

TCA RX
Power 
High

TCA TX
Power 
Low

TCA TX
Power 
High

OC-3 15454-SFP3-1-IR –26 –5 –18 –5 –23 –8 –21 –2

STM-1 15454E-SFP-L.1.1 –27 –7 –18 –5 –24 –10 –21 –2

OC-12 15454-SFP12-4-IR –31 –4 –18 –5 –28 –7 –21 –2

STM-4 15454E-SFP-L.4.1 –31 –5 –18 –5 –28 –8 –21 –2

OC-48 ONS-SE-2G-S1 –21 0 –13 0 –18 –3 –16 3

15454-SFP-OC48-IR –21 3 –8 3 –18 0 –11 6

STM-16 ONS-SE-2G-S1 –21 0 –13 0 –18 –3 –16 3

15454E-SFP-L.16.1 –21 3 –8 3 –18 0 –11 6

ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

ESCON 15454-SFP-200
15454E-SFP-200

–24 –11 –32 –11 –21 –14 –35 –8

DV6000 15454-SFP-OC48-IR –31 –4 –18 –5 –28 –7 –21 –2

15454E-SFP-L.16.1 –21 3 –8 3 –18 0 –11 6

SDI_D1_ 
VIDEO

15454-SFP12-4-IR –31 –4 –18 –5 –28 –7 –21 –2

15454E-SFP-L.4.1 –31 –5 –18 –5 –28 –8 –21 –2

HDTV 15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

PASS-THR
U

2R MODE 
(not specified)

Service Dependent
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Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 5-30, provision the Alarm thresholds for RX Power High, RX Power Low, TX Power 
High, and TX Power Low based on the client interface that is provisioned.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 7 Click Apply.

Step 8 Return to your originating procedure.

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–18 3 –13 –1 –15 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

ETR_CLO 15454-SFP-200
15454E-SFP-200

–20 3 –13 –1 –17 0 –16 3

ISC compat 15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

ISC peer 15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

Table 5-30 Client Interfaces Alarm and TCA Thresholds: TXP_MR_2.5G and TXPP_MR_2.5G Cards  (continued)

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power 
Low

Alarm RX
Power 
High

Alarm TX
Power 
Low

Alarm TX
Power 
High

TCA RX
Power 
Low

TCA RX
Power 
High

TCA TX
Power 
Low

TCA TX
Power 
High
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DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
OTN settings.

Step 2 Click one of the Provisioning > OTN subtabs: OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail 
Trace Identifier.

Step 3 Modify any of the settings described in Tables 5-31 through 5-34. 

Note You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To 
do so choose the appropriate radio button and click Refresh.

Table 5-31 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 5-32 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Purpose This task changes the OTN settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-31 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card OTN Line Settings

Parameter Description Options

Port # (Display only) Displays the port number. 2

G.709 OTN Sets the OTN lines according to ITU-T 
G.709.

• Enabled

• Disabled

FEC Sets the OTN lines to FEC. • Enabled

• Disabled

SF BER Sets the signal fail bit error rate. • 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9
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Table 5-33 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 5-34 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 5-32 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port1 

1. Latency for 1G-FC payload without ITU-T G.709 is 4 microseconds, with ITU-T G.709 is 40 microseconds. Latency for 
2G-FC payload without ITU-T G.709 is 2 microseconds, with ITU-T G.709 is 20 microseconds. Consider these values when 
planning a FC network that is sensitive to latency.

(Display only) Port number. 2

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

Table 5-33 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Port number. 2

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 5-34 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier Settings

Parameter Description Options

Port (Display only) Port number. 2

Level Sets the level. • Section

• Path

Trace Mode Sets the trace mode. • Off/None

• Manual
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G99 Modify Line Settings and PM Parameter Thresholds for 
MXP_MR_2.5G and MXPP_MR_2.5G Cards

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or select 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Purpose This procedure changes the line and threshold settings for MXP_MR_2.5G 
and MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

DLP-G63 Install an SFP or XFP, page 3-34

DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)

DLP-G278 Provision the Optical Line Rate, page 5-3 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-34 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier Settings 

Parameter Description Options
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
muxponder card settings. If you are already logged in, proceed to Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 12-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-54

• DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 
5-55

• DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, 
page 5-57

• DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 
5-58

• DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 
5-60

• DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet 
or 1G FC/FICON Payloads, page 5-62

• DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet 
or 1G FC/FICON Payloads, page 5-46

• DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA 
Thresholds, page 5-64

• DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA 
Thresholds, page 5-65

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see 
Chapter 8, “Manage Alarms.”

Stop. You have completed this procedure.

DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Note Card settings can be changed only if the facilities are out-of-service (OOS).

Purpose This task changes the card settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 5-35. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G 
Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
line settings.

Step 2 Click the Provisioning > Line > [client service] tabs. Tabs and parameter selections vary according to 
PPM provisioning.

Table 5-35 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Settings

Parameter Description Options

Card Mode Sets the mode of operation (option only 
supported for SONET/SDH payloads). 

Note: this setting is not currently 
supported. The only option available 
currently is FC-GE.

• FC-GE

Wavelength Sets the wavelength of the DWDM side 
optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray.

Note The four available wavelengths 
are listed in the Card Parameters 
section of the window and also in 
the Maintenance > Info subtab. 

Purpose This task changes the line settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Modify any of the settings for the Client tab as described in Table 5-36. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 5-36 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Client Tab Settings

Parameter Description Options

Port # (Display only) Port number. • 1

• 2 

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and Service 
States.”

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS(ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD(ANSI) or Locked,disabled (ETSI)

• OOS,MT(ANSI) or Locked,maintenance (ETSI)

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Administrative and Service States.”

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

ALS Mode Sets the automatic laser shutdown function. • Disabled (default)

• Auto Restart

• Manual Restart

• Manual Restart for Test
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DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards

Note Distance extension settings can be changed only if the facilities are out-of-service (OOS).

Note The distance extension parameters only apply to client ports (1 to 8) and not to the trunk ports (Port 9 
for MXP_MR_2.5G card or Ports 9 and 10 for the MXPP_MR_2.5G card).

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
distance extension settings.

Step 2 Click the Provisioning > Line > Distance Extension tabs. Tabs and parameter selections vary according 
to PPM provisioning.

Step 3 Modify any of the settings for the Distance Extension tab as described in Table 5-37. 

Purpose This task changes the distance extension settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-37 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension 

Settings

Parameter Description Options

Port # (Display only) Port number. • 1

• 2 

Enable 
Distance 
Extension

Allows end-to-end distances of up to 
1600 km for FC1G and up to 800 km for 
FC2G. If Distance Extension is enabled, 
set the connected Fibre Channel switches 
to Interop or Open Fabric mode, 
depending on the Fibre Channel switch. 
By default, the MXP_MR_2.5G and 
MXPP_MR_2.5G card will interoperate 
with the Cisco MDS storage products.

Checked or unchecked

Auto Detect 
Credits

Allows automatic detection of buffer 
credits for FC flow control.

Checked or unchecked

Credits 
Available

(Display only) Displays the number of 
buffer credits available.

Numeric (range depends on the client 
equipment attached to the card)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards

Note OC-48/STM-16 settings apply only to the trunk ports (Port 9 for the MXP_MR_2.5G card and Ports 9 
and 10 for the MXPP_MR_2.5G card.)

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
OC-48/STM-64 settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameter selections vary 
according to PPM provisioning.

Step 3 Modify any of the settings for the SONET or SDH tab as described in Table 5-38. 

Autoadjust 
GFP Buffer 
Threshold

This parameter allows the threshold of the 
GFP buffer between two MXP_MR_2.5G 
or two MXPP_MR_2.5G cards to be 
automatically adjust ed.

Checked or unchecked

GFP Buffers 
Available

Displays the number of GFP buffers 
available between two MXP_MR_2.5G 
or two MXPP_MR_2.5G cards.

Numeric

Purpose This task changes the OC-48/STM-16 settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-37 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension 

Settings (continued) (continued)

Parameter Description Options
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Table 5-38 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line SONET or SDH Tab Settings

Parameter Description Options

Port # (Display only) Port number. 9 (trunk for MXP_MR_2.5G) or 9-10 (trunk for 
MXPP_MR_2.5G)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and 
Service States.”

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS(ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD(ANSI) or Locked,disabled (ETSI)

• OOS,MT(ANSI) or Locked,maintenance (ETSI)

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. 
For more information about service states, see 
Appendix C, “DWDM Administrative and 
Service States.”

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER1 Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5

SD BER1 Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak Sets the automatic in-service soak period. Double 
click the time and use the up and down arrows to 
change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type. • SONET (ANSI)

• SDH (ETSI)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
section trace settings.

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according 
to ITU-T G.644 (06/99). ALS can be disabled or 
be set for three mode options.

• Disable (default): ALS is off; the laser is not 
automatically shut down when traffic outages (LOS) 
occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser 
for testing.

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a network 
element timing reference.

Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), which 
allow the node to choose the best timing source.

Checked or unchecked

Send 
DoNotUse

Sets the Send DoNotUse card state. When 
checked, sends a DUS (do not use) message on 
the S1 byte.

Checked or unchecked

1. BER and SD thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for MXPP_MR_2.5G).

Purpose This task changes the section trace settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-38 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line SONET or SDH Tab Settings (continued)

Parameter Description Options
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Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
PPM provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 5-39. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G240 Change MXP_MR_2.5G and MXPP_MR_2.5G Cards Line Threshold 
Settings for SONET or SDH Payloads

Table 5-39 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Section Trace Tab Settings

Parameter Description Options

Port (Display only) Port number. • 9 (trunk for MXP_M
and 10 (trunk for M

Trace Mode Sets the trace mode. • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; sets a new transmit string. 
You can click the button on the right to change the display. Its 
title changes, based on the current display mode. Click Hex to 
change the display to hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII (button changes to 
Hex).

String of trace string siz

Expected Displays the current expected string; sets a new expected string. 
You can click the button on the right to change the display. Its 
title changes, based on the current display mode. Click Hex to 
change the display to hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII (button changes to 
Hex).

String of trace string siz

Received (Display only) Displays the current received string. You can 
click Refresh to manually refresh this display, or select the 
Auto-refresh every 5 sec check box to keep this panel updated.

String of trace string siz

Purpose This task changes the line threshold settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards for SONET or SDH payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET (or SDH) Thresholds tabs. 

Step 3 Modify any of the settings as shown in Table 5-40.

Note You must modify Near End, and Far End independently; 15 Min and 1 Day independently; Line 
and Section independently. To do so choose the appropriate radio button and click Refresh.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds 
for 1G Ethernet or 1G FC/FICON Payloads

Table 5-40 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings

Field Description Options

Port (Display only) Port number. • 9 (trunk for MXP_MR_2.5G)

• 9-10 (trunk for MXPP_MR_2.5G)

CV Coding violations. Numeric. Can be set for Near End or Far End, f
one-day intervals, or for Line (Far End only), S
Select the bullet and click Refresh. 

ES Errored seconds. Numeric. Can be set for Near End or Far End, f
one-day intervals, or for Line (Far End only), S
Select the bullet and click Refresh. 

SES Severely errored seconds. Numeric. Can be set for Near End or Far End, f
one-day intervals, or for Line (Far End only), S
Select the bullet and click Refresh. 

FC (Line only) Failure count. Numeric. Can be set for Near End or Far End, f
one-day intervals for Line only. Select the bulle
Refresh. 

UAS (Line only) Unavailable seconds. Numeric. Can be set for Near End or Far End, f
one-day intervals, for Line only. Select the bull
Refresh.

Purpose This task changes the line threshold settings for MXP_MR_10G and 
MXPP_MR_10E transponder cards carrying the 1G Ethernet, 1G 
FC/FICON payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
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Step 1 Display the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the line threshold 
settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 5-41 for a list of available 
Ethernet thresholds.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 5-41 MXP_MR_2.5G and MXPP_MR 2.5G 1G Ethernet, 1G FC/FICON Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of Receive packets.

ifInDiscards Number of inbound packets that were chosen to be discarded 
even though no errors had been detected to prevent their being 
deliverable to a higher-layer protocol.

ifInErrors Total number of receive errors.

ifOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of Transmitted packets.

ifOutDiscards Number of outbound packets that were chosen to be discarded 
even though no errors had been detected to prevent their being 
transmitted.

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong Number of received frames that exceed the MTU. This value 
is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesBadCRC Number of receive data frames with payload CRC errors when 
HDLC framing is used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC errors 
when HDLC framing is used.

fcStatsLinkRecoveries Number of link recoveries.

fcStatsZeroTxCredits Number of transmit attempts that failed because of 
unavailable credits.

8b10bInvalidOrderedSets Number of 8b10b disparity violations on the Fibre Channel 
line side.

8b10bStatsEncodingDispErrors Number of 8b10b disparity violations on the Fibre Channel 
line side.
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 minutes subsides and creates only 
799 collisions in 15 minutes, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-minute period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK to complete the procedure.

Step 12 Return to your originating procedure (NTP).

DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm 
and TCA Thresholds

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Purpose This task changes the MXP_MR_2.5G and MXPP_MR_2.5G trunk port 
alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Provision the trunk port (Port 9) TCA thresholds for RX Power High to –9 dBm and the RX Power Low 
to –23 dBm.

Step 4 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 5 Provision the trunk port (Port 9) Alarm thresholds for RX Power High to –7 dBm and the RX Power Low 
to –26 dBm.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 6 Click Apply. 

Step 7 Return to your originating procedure (NTP).

DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm 
and TCA Thresholds

Step 1 In node view, double-click the MXP_MR_2.5G and MXPP_MR_2.5G card where you want to change 
the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 5-19, provision the client ports (Ports 1 through 8) TCA thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
For additional information about client SFP and XFP interfaces, also known as Pluggable Port Modules 
(PPMs), refer to the Hardware Specifications chapter in the Cisco ONS 15454 Reference Manual.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Purpose This task provisions the client port alarm and threshold cross alert (TCA) 
thresholds for the MXP_MR_2.5G and MXPP_MR_2.5G Cards

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 5-3

DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 5-19, provision the client ports (Ports 1 through 8) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned.

Note You must modify 15 Min and 1 Day independently. To do so choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. Otherwise, continue with Step 10.

Step 10 Return to your originating procedure.

Table 5-42 Client Interfaces Alarm and TCA Thresholds: MXP_MR_2.5G and MXPP_MR_2.5G Cards 

Port Type
(by CTC)

Pluggable Port 
Module 
(XFP)

Alarm RX
Power 
Low

Alarm RX
Power 
High

Alarm TX
Power 
Low

Alarm TX
Power 
High

TCA RX
Power 
Low

TCA RX
Power 
High

TCA TX
Power 
Low

TCA TX
Power 
High

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–18 3 –13 –1 –15 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3

ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S

–20 3 –13 –1 –17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX

–23 0 –13 0 –20 –3 –16 3
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C H A P T E R 6

Turn Up Network

This chapter explains how to turn up and test a Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) network. For DWDM topology reference information and span loss tables, see 
Chapter 17, “Network Reference.”

There are two main DWDM network types, metro core, where the channel power is equalized and 
dispersion compensation is applied, and metro access, where the channels are not equalized and 
dispersion compensation is not applied. The DWDM network topologies supported are hubbed rings, 
multihubbed rings, meshed rings, linear configurations, and single-span links. The DWDM node types 
supported are hub, terminal, optical add/drop multiplexing (OADM), reconfigurable optical add/drop 
multiplexing (ROADM) anti-amplified spontaneous emissions (ASE), and line amplifier. For DWDM 
and hybrid node turn up procedures, see Chapter 3, “Turn Up a Node.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G51 Verify DWDM Node Turn Up, page 6-1—Complete this procedure before beginning 
network turn up.

2. NTP-G52 Verify Node-to-Node Connections, page 6-3—Complete this procedure next.

3. NTP-G53 Set Up Timing, page 6-3—Complete this procedure next.

4. NTP-G54 Provision and Verify a DWDM Network, page 6-7—Complete this procedure next.

5. NTP-G56 Verify the OSNR, page 6-11—Complete as needed.

6. NTP-G57 Create a Logical Network Map, page 6-14—Complete as needed.

NTP-G51 Verify DWDM Node Turn Up

Purpose This procedure verifies that each ONS 15454 is ready for DWDM network 
turn up before adding nodes to a network. This procedure applies to all 
ROADM, OADM, or line amplifier locations.

Tools/Equipment None
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Step 1 Log into an ONS 15454 on the network that you will test. See the “DLP-G46 Log into CTC” task on 
page 2-24. If you are already logged in, proceed to Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 8-27 as necessary.

b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 3 Verify that the software version shown in the node view status area matches your site plan. (The status 
area is located to the left of the shelf graphic.) If the software is not the correct version, install the correct 
version from the ONS 15454 software CD. Upgrade procedures are located in the release-specific 
software upgrade document. Follow the upgrade procedures appropriate to the software currently 
installed on the node. TCC2/TCC2P cards can also be ordered with the latest software release.

Step 4 Click the Provisioning > General tabs. Verify that all general node information settings are correct 
according to documentation provided by the network administrator. If not, see the “NTP-G80 Change 
Node Management Information” procedure on page 10-6.

Step 5 Click the Provisioning > Network tabs. Ensure that the IP settings and other Cisco Transport Controller 
(CTC) network access information is correct according to documentation provided by the network 
administrator. If not, see the “NTP-G81 Change CTC Network Access” procedure on page 10-9.

Step 6 Click the Provisioning > Protection tabs. Verify that all required protection groups have been created 
according to documentation provided by the network administrator. If not, see the“NTP-G33 Create a 
Y-Cable Protection Group” procedure on page 3-36 or the “NTP-G83 Modify or Delete Card Protection 
Settings” procedure on page 10-21.

Step 7 Click the Provisioning > Security tabs. Verify that all users have been created and that their security 
levels are correct according to documentation provided by the network administrator. If not, see the 
“NTP-G88 Modify Users and Change Security” procedure on page 10-35.

Step 8 If Simple Network Management Protocol (SNMP) is provisioned on the node, click the Provisioning > 
SNMP tabs. Verify that all SNMP settings are correct according to documentation provided by the 
network administrator. If not, see the “NTP-G89 Change SNMP Settings” procedure on page 10-46.

Step 9 Repeat this procedure at each node in the network.

Stop. You have completed this procedure.

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G52 Verify Node-to-Node Connections

Step 1 Check to see if fiber is connected to the OPT-BST or OSC-CSM LINE RX and TX ports. If yes, continue 
with Step 2. If not, complete the following tasks:

a. Clean the fiber using the “NTP-G115 Clean Fiber Connectors” procedure on page 12-22.

b. Install the fiber using the “DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between 
Two Adjacent Nodes” task on page 3-42.

Step 2 Verify the network fiber connections:

• The east Line TX and Line RX ports connect to the west Line RX and TX ports of the adjacent node.

• The west Line TX and Line RX ports connect to the east Line RX and TX ports of the adjacent node.

Step 3 Complete the “DLP-G46 Log into CTC” task on page 2-24 at a network node.

Step 4 Click the Provisioning > Comm Channels > OSC tab. Verify that OSC terminations were created for 
the east and west OSC-CSM or OSCM cards and the port state is In-Service and Normal (IS-NR 
[ANSI])/Unlocked-enabled (ETSI). If so, continue with Step 5. If OSC terminations are not created, 
complete the “NTP-G38 Provision OSC Terminations and Ring ID” procedure on page 3-74.

Step 5 Complete the “DLP-G155 Verify Optical Span Loss Using CTC” task on page 10-2. If the measured span 
loss is within the minimum and maximum expected span loss values, continue with Step 6. If not, clean 
the fiber connected to the OPT-BST or OSC-CSM on both ends of the span, then repeat the “DLP-G155 
Verify Optical Span Loss Using CTC” task on page 10-2. If the span loss is within the minimum and 
maximum expected span loss values, continue with Step 6. If not, contact your next level of support. 

Step 6 Repeat Steps 2 through 5 at each network node.

Stop. You have completed this procedure.

NTP-G53 Set Up Timing

Purpose This procedure verifies OSC terminations between nodes and checks span 
attenuation. This procedure applies to all ROADM, OADM, or line 
amplifier locations.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-1

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure provisions the ONS 15454 timing.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-1

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you will set up timing. If 
you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G95 Set Up External or Line Timing” task on page 6-4 if an external building 
integrated timing supply (BITS) source is available. This is the common ONS 15454 timing setup 
procedure. 

Step 3 If an external BITS source is not available, complete the “DLP-G96 Set Up Internal Timing” task on 
page 6-6. This task can only provide Stratum 3 timing. 

Step 4 Repeat this procedure at each node in the network.

Stop. You have completed this procedure.

DLP-G95 Set Up External or Line Timing

Step 1 In node view, click the Provisioning > Timing > General tabs.

Step 2 In the General Timing area, complete the following information:

• Timing Mode—Choose External if the ONS 15454 derives its timing from a BITS source wired to 
the backplane pins (ANSI) or a MIC-C/T/P FMEC (ETSI); choose Line if timing is derived from an 
OSC-CSM or OSCM card that is optically connected to the timing node. A third option, Mixed, 
allows you to set external and line timing references.

Note Because Mixed timing might cause timing loops, Cisco does not recommend its use. Use this 
mode with care.

• SSM Message Set—For DWDM nodes, choose the Generation 2 synchronization status messaging 
(SSM) option. Generation 1 is used only by SONET or SDH ONS 15454s that are connected to 
equipment that does not support Generation 2. 

• Quality of RES—If your timing source supports the reserved S1 byte, set the timing quality here. 
(Most timing sources do not use RES.) Qualities are displayed in descending quality order as ranges. 
For example, ST3<RES<ST2 means the timing reference is higher than a Stratum 3 and lower than 
a Stratum 2. See Chapter 19, “Security and Timing Reference” for more information about SSM, 
including definitions of the SONET timing levels.

• Revertive—Select this check box if you want the ONS 15454 to revert to a primary reference source 
after the conditions that caused it to switch to a secondary timing reference are corrected. 

• Revertive Time—If Revertive is checked, choose the amount of time the ONS 15454 will wait before 
reverting to its primary timing source. Five minutes is the default.

Purpose This task defines the ONS 15454 timing source (external or line).

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 In the Reference Lists area, complete the following information:

Note Reference Lists defines up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane (ANSI) or FMEC (ETSI). If you attach 
equipment to BITS Out pins, you normally attach it to a node with Line mode because equipment 
near the external timing reference can be directly wired to the reference. 

• NE Reference—Allows you to define three timing references (Ref 1, Ref 2, Ref 3). The node uses 
Reference 1 unless a failure occurs to that reference, in which case the node uses Reference 2. If 
Reference 2 fails, the node uses Reference 3, which is typically set to Internal Clock. Reference 3 
is the Stratum 3 clock provided on the TCC2/TCC2P card. The options displayed depend on the 
Timing Mode setting. 

– If the Timing Mode is set to External, your options are BITS-1, BITS-2, and Internal Clock.

– If the Timing Mode is set to Line, your options are the node’s working OSCM, OSC-CSM, or 
MXP cards and Internal Clock. Choose the cards/ports that are directly or indirectly connected 
to the node wired to the BITS source. Set Reference 1 to the card that is closest to the BITS 
source. For example, if Slot 5 is connected to the node wired to the BITS source, choose Slot 5 
as Reference 1.

– If the Timing Mode is set to Mixed, both BITS and OSC or MXP cards are available, allowing 
you to set a mixture of external BITS and OSC or MXP cards as timing references.

• BITS-1 Out/BITS-2 Out—Sets the timing references for equipment wired to the BITS Out 
backplane (ANSI) or FMEC (ETSI) pins. BITS-1 Out and BITS-2 Out are enabled when BITS-1 Out 
and BITS-2 Out facilities are put in service. If Timing Mode is set to external, choose the OSC or 
MXP card used to set the timing. If Timing Mode is set to Line, you can choose an OSC or MXP 
card or choose NE Reference to have the BITS-1 Out and/or BITS-2 Out follow the same timing 
references as the NE.

Note All MXP card client ports are available for timing regardless of the card’s termination mode. 
MXP trunk ports can be a timing reference when G.709 is set to OFF and the Termination 
Mode is set to LINE.

Step 4 Click Apply.

Step 5 Click the BITS Facilities tab.

Step 6 In the BITS Facilities area, complete the following information:

Note The BITS Facilities section sets the parameters for your BITS-1 and BITS-2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• BITS In State—If Timing Mode is set to External or Mixed, set the BITS In State for BITS-1 and/or 
BITS-2 to IS (in service) depending whether one or both BITS input pin pairs on the backplane 
(ANSI) or FMEC (ETSI) are connected to the external timing source. If Timing Mode is set to Line, 
set the BITS In State to OOS (out of service). 
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• BITS Out State—If equipment is connected to the node’s BITS output pins on the backplane (ANSI) 
or FMEC (ETSI) and you want to time the equipment from a node reference, set the BITS Out State 
for BITS-1 and/or BITS-2 to IS, depending on which BITS Out pins are used for the external 
equipment. If equipment is not attached to the BITS output pins, set the BITS Out State to OOS. 

Step 7 If the BITS In State for BITS-1 and BITS-2 is set to OOS, continue with Step 3. If the BITS In State is 
set to IS for either BITS-1 or BITS-2, complete the following information:

• Coding—Set to the coding used by your BITS reference, either B8ZS (binary 8-zero substitution) 
or AMI (alternate mark inversion).

• Framing—Set to the framing used by your BITS reference, either ESF (Extended Super Frame) or 
SF (D4) (Super Frame). 

• Sync Messaging—Check to enable SSM. SSM is not available if Framing is set to SF (D4).

• AIS Threshold—If SSM is disabled or SF (D4) is used, set the quality level where a node sends an 
alarm indication signal (AIS) from the BITS-1 Out and BITS-2 Out backplane (ANSI) or FMEC 
(ETSI) pins. An AIS is raised when the optical source for the BITS reference falls to or below the 
SSM quality level defined in this field.

• LBO—If you are timing an external device connected to the BITS Out pins, set the distance between 
the device and the ONS 15454. Options are: 0-134 ft. (default), 124-266 ft., 267-399 ft., 400-533 ft., 
and 534-655 ft. Line build out (LBO) relates to the BITS cable length.

Step 8 Click Apply.

Note Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide for timing-related alarms. 

Step 9 Return to your originating procedure (NTP).

DLP-G96 Set Up Internal Timing

Caution Internal timing is Stratum 3 and not intended for permanent use. All ONS 15454 SONET or SDH nodes 
should be timed to a Stratum 2 or better primary reference source. Internal timing is appropriate for 
DWDM nodes.

Step 1 In node view, click the Provisioning > Timing > General tabs.

Step 2 In the General Timing area, enter the following:

• Timing Mode—Set to External.

Purpose This task sets up internal timing (Stratum 3) for an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed (use only if a BITS source is not available) 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• SSM Message Set—Set to Generation 1.

• Quality of RES—Does not apply to internal timing.

• Revertive—Does not apply to internal timing.

• Revertive Time—Does not apply to internal timing.

Step 3 In the Reference Lists area, enter the following information:

• NE Reference 

– Ref 1—Set to Internal Clock.

– Ref 2—Set to Internal Clock.

– Ref 3—Set to Internal Clock.

• BITS-1 Out/BITS-2 Out—Set to None.

Step 4 Click Apply.

Step 5 Click the BITS Facilities tab.

Step 6 In the BITS Facilities area, change the BITS In State and BITS Out State to OOS for BITS 1 and BITS 2 
Disregard the other BITS Facilities settings; they are not relevant to internal timing.

Step 7 Click Apply.

Step 8 Return to your originating procedure (NTP).

NTP-G54 Provision and Verify a DWDM Network

Purpose This procedure verifies the performance of all cable connections and cards 
in a network topology. You can also use this procedure to troubleshoot any 
problems with DWDM network setup. 

Tools/Equipment Test set or protocol analyzer

Cisco MetroPlanner Traffic Matrix

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G277 Provision a Multirate PPM, page 5-3

DLP-G278 Provision the Optical Line Rate, page 5-3

NTP-G96 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_10G and TXP_MR_10E Cards, page 5-8

NTP-G97 Modify Line Settings and PM Parameter Thresholds for 
MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-25

NTP-G98 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-39

NTP-G99 Modify Line Settings and PM Parameter Thresholds for 
MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-53

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 to log into an ONS 15454 on the network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 8-27 as necessary.

b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 3 Using the Cisco MetroPlanner Traffic Matrix (see Table 3-1 on page 3-3) for your site, identify the first 
channel (ITU wavelength) to be provisioned. Use the transponder, muxponder, or line card that 
corresponds to the selected wavelength.

Step 4 As needed, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 6-10. This is an 
optional step requiring DCC connectivity between the node and subtended client shelf or GCC 
connectivity between the transponders.

Step 5 Create the optical channels at all sites according to the Cisco MetroPlanner Traffic Matrix. Complete the 
“DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10.

Note The amplifiers automatically calculate the optical output power to maintain a constant power 
level on each channel every time a channel is created on the DWDM network. Automatic power 
control (APC) also starts every 60 minutes. If the span length changes, APC modifies amplifier 
gains and express variable optical attenuation (VOA). For more information about APC, see the 
“17.4 Automatic Power Control” section on page 17-17.

Step 6 Select one of the nodes and go to node view.

Step 7 If an OPT-PRE is installed, complete the following steps. If not, continue with Step 8.

a. Display the OPT-PRE card in card view.

b. Click the Provisioning > Opt.Ampli.Line > Parameters tabs.

c. Locate the Port 2 Signal Output Power. Verify that this value is equal to or higher than the Channel 
Power Ref value, which you can view by scrolling to the right. If so, continue with Step d. If the 
value is lower, contact your next level of support.

Note If the OPT-PRE is not carrying traffic, the values will not match.

d. Repeat Steps a through c for the second OPT-PRE, if one is installed. If not, continue with Step 8.

Step 8 If an OPT-BST is installed, complete the following steps. If not, continue with Step 9. 

a. Display the OPT-BST card in card view.

b. Click the Provisioning > Opt.Ampli.Line > Parameters tabs.

c. Locate the Port 6 Signal Output Power. Verify that this value is equal to or higher than the Channel 
Power Ref value, which you can view by scrolling to the right. If so, continue with Step d. If the 
value is lower, contact your next level of support.

Note If the OPT-BST is not carrying traffic, the values will not match.

d. Repeat Steps a through c for the second OPT-BST, if one is installed. If not, continue with Step 9.
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Step 9 If the node is a fixed OADM with AD-xC-xx.x or AD-xB-xx.x cards installed with a new circuit carrying 
traffic for the first time, complete one of the procedures. If not, continue with Step 10.

• If the circuit is terminated inside the node, change to node view and click the Provisioning > 
WDM-ANS > Provisioning tabs. In the Selector area, click West Pin field and then Pin AD Stage. 
Verify that the value matches the value for the first OADM card in your circuit heading west to east 
shown in the COM RX port, ±2 dB. If the values are outside of the error margins, contact your next 
level of support.

• If the circuit passes through the node, change to node view and click the Provisioning > WDM-ANS 
> Provisioning tabs. Click West Pin field and then Pin AD Stage. Verify that the value matches the 
value for the first OADM card in your circuit heading west to east shown in the COM RX port, ±2 
dB. Click East Pin and Pout AD Stage. Verify the value matches the value for the first OADM card 
in your circuit heading west to east shown in the COM TX port, ±1 dB. If the values are outside of 
the error margins, contact your next level of support.

• If the circuit starts from the node, change to node view and click the Provisioning > WDM-ANS > 
Provisioning tabs. Click East Pin field and then Pin AD Stage. Verify the value matches the value 
for the first OADM card in your circuit heading west to east shown in the COM TX port, ±1 dB. If 
the values are outside of the error margins, contact your next level of support.

Step 10 Check the received power range:

a. Navigate to the node where the first TXP, MXP, or line card is installed

b. Display the TXP, MXP, or line card in card view.

c. Complete the “DLP-G136 Clear Selected PM Counts” task on page 9-6.

d. Click the Performance > Optics PM tab. 

e. Record the values shown in the RX Optical Pwr field. 

f. Click the Provisioning > Optics Thresholds tabs. 

g. Verify that the value in Step e falls between the values shown for the RX Power High and RX Power 
Low. If so, continue with Step 11. If not, complete one of the following. 

– Power lower than range—clean the trunk fiber at the patch panel and on the TXP or MXP and 
repeat Steps e through g. If the power is still too low, contact your next level of support.

– Power higher than range—add attenuation to the fiber and repeat Steps e through g.

Step 11 Perform a short-term bit error rate (BER) test:

a. Complete the “DLP-G136 Clear Selected PM Counts” task on page 9-6 for the transponder, 
muxponder, or line card.

b. Display the TXP, MXP, or line card in card view.

c. Click the Performance > Payload PM tabs, or, if OTN is provisioned, the Performance > OTN 
PM tabs. 

d. Perform a short-term BER test using a test signal from a test set or protocol analyzer.

e. Monitor the payload PM for at least 10 minutes for errors.

Note To see an accurate performance monitoring count, the BER test results must be consistent with 
the transmitted bit rate for at least 10 minutes.
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Note For information about using a test set or protocol analyzer, refer to the test set or protocol 
analyzer user guide.

Step 12 Repeat Steps 7 through 11 for all sites that have add/drop traffic.

Step 13 If a node fails any test, repeat the test after verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service.

Stop. You have completed this procedure.

DLP-G99 Create a Provisionable Patchcord

Note This task requires DCC connectivity between the node and subtended client shelves or GCC connectivity 
between the transponders. To provision DCC/GCC, perform the “DLP-G76 Provision GCC 
Terminations” task on page 7-13.

Note An optical port requires two patchcords when the remote end is Y-cable protected or is an add/drop 
multiplexer or multiplexer/demultiplexer port.

Step 1 In node view, click the Provisioning > Comm Channels > PPC tabs. If you are in network view, click 
the Provisioning > Provisionable Patchcords tabs.

Step 2 Click Create. The Provisionable Patchcord dialog box appears.

Step 3 In the Origination Node area, complete the following:

a. If you are in node view, the Origination Node defaults to the current node. If you are in network 
view, click the desired origination node from the drop-down list. 

b. Type a patchcord identifier (0 through 32767) in the TX and RX ID fields.

c. Click the desired origination slot/port from the list of available slots/ports. 

Purpose This task creates a provisionable patchcord, also called a virtual link. They 
appear as dashed lines in CTC network view. 

For the specific situations in which a patchcord is necessary, see the 
“20.3 Provisionable Patchcords” section on page 20-22.

Tools/Equipment OC-N, transponder/muxponder, optical add/drop multiplexer, and 
multiplexer/demultiplexer cards

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 In the Termination Node area, complete the following:

a. Click the desired termination node from the drop-down list. If the remote node has not previously 
been discovered by CTC but is accessible by CTC, type the name of the remote node.

b. Type a patchcord identifier (0 through 32767) in the TX and RX ID fields. The origination and 
termination IDs must be different if the patchcord is set up between two cards on the same node. 

c. Click the desired termination slot/port from the list of available slots/ports. The origination port and 
the termination port must be different.

Step 5 If you need to provision transmit and receive separately for multiplexer/demultiplexer cards, check the 
Separate Tx/Rx check box. If not, continue with Step 6. The origination and termination TX ports are 
already provisioned. Complete the following to provision the RX ports:

a. In the Origination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The 
origination Tx and Rx and termination Tx and Rx IDs must be different.

b. Click the desired origination slot/port from the list of available slots/ports. 

c. In the Termination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The 
origination Tx and Rx and termination Tx and Rx IDs must be different.

d. Click the desired termination slot/port from the list of available slots/ports. 

Step 6 Click OK. 

Step 7 If you provisioned a patchcord on a port in a 1+1 protection group, a dialog box appears to ask if you 
would like to provision the peer patchcord. Click Yes. Repeat Steps 3 through 6. 

Step 8 Return to your originating procedure (NTP).

NTP-G56 Verify the OSNR

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at an ONS 15454 on the network.

Step 2 Using an optical spectrum analyzer, check the received OSNR for each transmitted channel on both ends 
of the span. Identify the last OSC-CSM, OPT-PRE, or OPT-BST MON port before the channel is 
dropped. If OPT-PRE cards are installed with an OPT-BST or OSC-CSM card, use the OPT-PRE MON 
port.

Note For OSNR values for each card class, refer to Chapter 15, “Card Reference.”

Step 3 If the OSNR is too low, check the following, depending on your node configuration:

Purpose This procedure verifies the OSNR. The OSNR is the ratio between the signal 
power level and the noise power level.

Tools/Equipment Optical spectrum analyzer

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note The purpose of this step is not to improve the signal-to-noise ratio (SNR), but to match the 
per-channel power level within the receive (RX) port power range.

• Check the fiber connections between the OPT-BST amplifier or the OSC-CSM and the OPT-PRE 
amplifier and if needed, clean the connectors. See the “NTP-G115 Clean Fiber Connectors” 
procedure on page 12-22.

• On the near-end OPT-BST amplifier, check the equalization of the added channels at the monitor 
output.

• On the OPT-PRE amplifier, check the output power on both COM TX and DC TX ports.

• On the far-end OPT-PRE amplifier, check the amplifier gain tilt at the monitor output.

If the OSNR is still too low, contact your next level of support.

Step 4 Repeat Steps 2 and 3 for all traffic in the network.

Stop. You have completed this procedure.

NTP-G142 Perform a Protection Switch Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at an ONS 15454 on the network.

Step 2 Identify the Y-cable circuit to be tested by viewing the Traffic Matrix for your site. Locate the 
transponders in the ONS 15454 node that will be used for the protection group.

Step 3 Verify that the Y-cable protection group is provisioned:

a. In node view, click the Provisioning > Protection tabs.

b. In the Protect and Working column headings area, confirm the correct transponders are in the 
Y-cable protection group by viewing the slot number and card type.

c. If the required protection group is not provisioned, stop and perform “NTP-G33 Create a Y-Cable 
Protection Group” procedure on page 3-36. Otherwise continue with Step 4.

Purpose This procedure tests the optical path, client transponders, and Y-cable 
protection groups in your system for proper operation.   The test signals 
might be generated by either the actual client device or a test set, whichever 
is available. Cisco recommends that you repeat this test at each node in the 
network where protection group traffic is dropped.

Tools/Equipment A list of protection groups. This information is provided in the Cisco 
MetroPlanner Traffic Matrix

A test set or actual client device that provides the required payload for the 
circuits that are provisioned.

Prerequisite Procedures

Required/As Needed As needed

Onsite/Remote Onsite; personnel are required onsite at each end of the circuit under test.

Security Level Provisioning or higher
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Step 4 Repeat Step 3 for each Y-cable protection group at this node. When all protection groups are verified, 
proceed to Step 5.

Step 5 Physically connect the transmitter of the client or test set to either Port 10 or Port 12 of the Y-cable 
module protecting the circuit under test. (See Table 3-5 on page 3-69 and Table 3-6 on page 3-70.)

Step 6 If you connected the transmitter to Port 10, connect the client or test set receiver to Port 5 on the Y-cable 
module. If not, connect the client or test set receiver to Port 11 of the Y-cable module.

Step 7 At the far-end site for the circuit under test, physically loop the Y-cable module as follows:

a. If this is the first client on the Y-cable module, loop Port 10 to Port 5 on the far end Y-cable module. 

b. If this is the second client on the Y-cable module, loop Ports 11 and 12 on the far end Y-cable 
module.

Step 8 At the near-end site for the circuit under test, place the client device or test set into service and begin 
transmitting the required payload.

Step 9 In CTC, display the near-end site in node view.

Step 10 Click the Maintenance > Protection tabs (Figure 6-1).

Figure 6-1 Maintenance > Protection Tabs

Step 11 In the Protection Groups area, highlight the protection group to be tested.

Step 12 In the Selected Group area, identify the slot that is Active and the slot that is Standby.

Step 13 Verify the LED display on the physical cards in the shelf match the following:

a. For the Active TXP card, record the slot number_____. Verify the port LEDs below:

– DWDM port is green.

– Client port is green.

13
49

60

Protection Group area Selected Group area
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b. For the Standby TXP card, record the slot number_____. Verify port LEDs below:

– DWDM Port is green.

– Client Port is not illuminated.

Step 14 In the Selected Group area highlight the Active transponder slot.

Step 15 From the Switch Commands area below the selected group area, click Manual, then click YES.

Step 16 From the Selected Group area, record the following information and verify the active and standby 
transponder slots are the opposite of Step 13.

• Active TXP card slot number_____

• Standby TXP card slot number_____

Step 17 Verify the LED display on the physical cards in the shelf match the following:

a. Active transponder slot LEDs:

– DWDM port is green.

– Client port is green.

b. For the Standby transponder slot LEDs:

– DWDM Port is green.

– Client Port is not illuminated.

Step 18 Confirm the client or test set at the local site is operating normally with no alarms. If the test set is 
reporting active alarms, contact your next level of support. (Note: It is normal to see a traffic hit on the 
test set during a protection switch)

Step 19 From the Switch Commands area below the selected group area, click Clear, then click YES to return 
the protection group to the original state.

Step 20 Repeat Steps 5 through 19, for each protection group at your site.

Stop. You have completed this procedure.

NTP-G57 Create a Logical Network Map

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at a node on the network where you want to 
create the network map. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Purpose This procedure allows a Superuser to create a consistent network view for 
all nodes on the network.

Tools None

Prerequisite Procedures This procedure assumes that network turn up is complete.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 3 Change the position of the nodes in the network view according to your site plan.

a. Click a node to select it, then press the Ctrl key while you drag and drop a node icon to a new 
location. 

b. Repeat Step a for each node you need to position.

Step 4 On the network view map, right-click and choose Save Node Position.

Step 5 Click Yes in the Save Node Position dialog box.

CTC opens a progress bar and saves the new node positions.

Note Retrieve, Provisioning, and Maintenance users can move nodes on the network map, but only 
Superusers can save new network map configurations. To restore the view to a previously saved 
version of the network map, right-click on the network view map and choose Reset Node 
Position.

Stop. You have completed this procedure.
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Cisco ONS 15454 DWDM
September 2005
C H A P T E R 7

Create Channels and Circuits

This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM) 
optical channel network connections (OCHNCs) and overhead circuits. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide and the Cisco ONS 15454 SDH 
Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G58 Locate and View Optical Channel Network Connections, page 7-2—Complete as needed 
to find, view, and filter OCHNCs.

2. NTP-G59 Create and Delete Optical Channel Network Connections, page 7-9—Complete as 
needed.

3. NTP-G60 Create Overhead Circuits, page 7-13—Complete as needed to create IP-encapsulated 
tunnels, provision orderwire, or user data channel (UDC) circuits.

4. NTP-G61 Modify and Delete Overhead Circuits, page 7-20—Complete as needed to repair IP 
circuits and delete overhead circuits.

5. NTP-G62 Create a J0 Section Trace, page 7-22—Complete as needed to monitor interruptions or 
changes to traffic between two nodes.
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NTP-G58 Locate and View Optical Channel Network 
Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at a node on the network where you want to 
view the circuits. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-G100 Search for Optical Channel Network Connections” task on 
page 7-2.

Step 3 As needed, complete the “DLP-G101 View Optical Channel Network Connection Information” task on 
page 7-3.

Step 4 As needed, complete the “DLP-G102 Filter the Display of Optical Channel Network Connections” task 
on page 7-6.

Step 5 As needed, complete the “DLP-G103 View Optical Channel Network Connections on a Span” task on 
page 7-8.

Stop. You have completed this procedure.

DLP-G100 Search for Optical Channel Network Connections

Step 1 Navigate to the appropriate Cisco Transport Controller (CTC) view:

• To search the entire network, choose View > Go to Network View.

Purpose This procedure allows you to locate and view DWDM OCHNCs. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision DWDM Optical Channel Network Connections, page 
7-10

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task searches for DWDM OCHNCs and ONS 15454 circuits at the 
network, node, or card level. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• To search for circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

• To search for circuits that originate, terminate, or pass through a specific card, double-click the card 
on the shelf graphic in node view to open the card in card view. 

Step 2 Click the Circuits tab.

Step 3 If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope 
drop-down list located at the bottom right side of the screen. Choose Node to see all of the circuits on 
that node, or Network (All) to see all circuits in the network.

Step 4 Click Search if you need to search through the list of circuits.

Step 5 In the Circuit Name Search dialog box, complete the following:

• Find What—Enter the text of the circuit name you want to find.

• Match whole word only—Check this check box to instruct CTC to select circuits only if the entire 
word matches the text in the Find What field. 

• Match case—Check this check box to instruct CTC to select circuits only when the capitalization 
matches the capitalization entered in the Find What field.

• Direction—Choose the direction for the search. Searches are conducted up or down from the 
currently selected circuit.

Step 6 Click Find Next. If a match is found the circuit will be highlighted. To contine the search, click Find 
Next again to find the next circuit.

Step 7 Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8 Return to your originating procedure (NTP).

DLP-G101 View Optical Channel Network Connection Information

Step 1 Navigate to the appropriate CTC view:

Note The following order is the default column sequence, the order may be different on your 
screen, depending on your individual CTC setup. 

• To view circuits for an entire network, choose View > Go to Network View.

• To view circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

Purpose This task provides information about DWDM OCHNCs and ONS 15454 
circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• To view circuits that originate, terminate, or pass through a specific card, in node view, double-click 
the card containing the circuits you want to view.

Note In node or card view, you can change the scope of the circuits that appear by choosing Card 
(in card view), Node, or Network from the Scope drop-down list in the bottom right corner 
of the Circuits window.

Step 2 Click the Circuits tab. The Circuits tab shows the following information:

• Circuit Name—Name of the circuit. The circuit name can be manually assigned or automatically 
generated.

• Type—Circuit types are OCHNC. 

Note The following circuit types are not applicable to DWDM nodes: STS, VT, VTT (VT tunnel), 
VAP (VT aggregation point), STS-v (STS VCAT circuit),  VT-v (VT VCAT circuit), HOP 
(high-order circuit), LOP (low-order circuit), VCT (VC low-order tunnel), VCA (VC LOP_v 
(low-order VCAT circuit)>

• Size—Circuit size. OCHNC sizes are Equipped not specific, Multi-rate, 2.5 Gbps No FEC (forward 
error correction), 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC. 

Note The following circuit types under the circuit size column are not applicable to DWDM 
nodes: STS, VT, VCAT, VC12, VC11, VC3, VC4. 

• OCHNC Wlen—For OCHNCs, the wavelength provisioned for the optical channel network 
connection. See Table 7-3 on page 7-10 for a list of channels and wavelengths.

• Direction—The circuit direction, either two-way or one-way.

• OCHNC Dir—The line direction of the OCHNC, either East to West or West to East. If the direction 
is West to East, the channel exits from the node through the LINE-TX port of the OSC-CSM-E or 
OPT-BST-E named the East Side Card by MetroPlanner (typically these cards are hosted by Slot 17). 
If the direction is East to West, the channel exits from the node through the LINE-TX port of 
OSC-CSM-W or OPT-BST-W named as West Side Card by MetroPlanner (typically these cards are 
hosted by Slot 1).

• Protection—The type of circuit protection. See Table 7-1 for a list of protection types.

• Status—The circuit status. Table 7-2 lists the circuit statuses that can appear.

• Source—The circuit source in the format: node/slot/port “port name” (if a port name has been 
assigned by the user, the name will appear in quotes). 

Note The user can assign a specific “port name” to every port of any DWDM card after completing 
the “DLP-G104 Assign a Name to a Port” task on page 7-9.

• Destination—The circuit destination in same format as the circuit source. STSs, VTs, VCs, and 
tributary units are not applicable to DWDM nodes.

• # of VLANS—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to 
DWDM nodes.

• # of Spans—The number of internode links that constitute the circuit. 
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• State—The circuit service state, which is an aggregate of its cross-connects. For ANSI, the service 
states are IS, OOS, or OOS-PARTIAL. For ETSI, the service states are Unlocked, Locked, or 
Locked-partial. For more information about ANSI and ETSI service states, see the Appendix C, 
“DWDM Administrative and Service States.”

– IS/Unlocked—All cross-connects are in service and operational.

– OOS/Locked—All cross-connects are Out-of-Service and Management, Maintenance 
(OOS-MA,MT) and/or Out-of-Service and Management, Disabled (OOS-MA,DSBLD) for 
ANSI or Locked-enabled,maintenance and/or Locked-enabled,disabled for ETSI.

– OOS-PARTIAL/Locked-partial—At least one cross-connect is In-Service and Normal (IS-NR 
[ANSI]) or Unlocked-enabled (ETSI) and others are out-of-service.

Note Right-clicking a column title (Circuit name, Type, etc.) opens a menu that allows you to 
show or hide the desired circuit details.

Table 7-1 Circuit Protection Types

Protection Type Description

Y-Cable The circuit is protected by a transponder or muxponder card Y-cable 
protection group.

Splitter The circuit is protected by the protect transponder splitter protection.

Unprot A circuit with a source and destination on different nodes is not protected. 

N/A A circuit with connections on the same node is not protected. 

Unknown A circuit has a source and destination on different nodes and communication 
is down between the nodes. This protection type appears if not all circuit 
components are known.

Table 7-2 Cisco ONS 15454 Circuit Status

Status Definition/Activity

CREATING CTC is creating a circuit.

DISCOVERED CTC created a circuit. All components are in place and a complete path exists 
from the circuit source to the circuit destination.

DELETING CTC is deleting a circuit.
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Step 3 Return to your originating procedure (NTP).

DLP-G102 Filter the Display of Optical Channel Network Connections

PARTIAL A CTC-created circuit is missing a cross-connect or network span, a complete 
path from source to destination(s) does not exist, or an alarm interface panel 
(AIP) change occurred on one of the circuit nodes and the circuit is in need 
of repair. (AIPs store the node MAC address.)

In CTC, circuits are represented using cross-connects and network spans. If a 
network span is missing from a circuit, the circuit status is PARTIAL. 
However, a PARTIAL status does not necessarily mean a circuit traffic failure 
has occurred, because traffic might flow on a protect path. 

Network spans are in one of two states: up or down. On CTC circuit and 
network maps, up spans are shown as green lines, and down spans are shown 
as gray lines. If a failure occurs on a network span during a CTC session, the 
span remains on the network map but its color changes to gray to indicate the 
span is down. If you restart your CTC session while the failure is active, the 
new CTC session cannot discover the span and its span line will not appear 
on the network map. 

Subsequently, circuits routed on a network span that goes down will appear 
as DISCOVERED during the current CTC session, but they will appear as 
PARTIAL to users who log in after the span failure. 

The PARTIAL status does not appear for OCHNC circuit types.

DISCOVERED_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is complete. A 
complete path from source to destination(s) exists. 

This status does not appear for OCHNC circuit types.

PARTIAL_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is missing a 
cross-connect, and a complete path from source to destination(s) does not 
exist. 

This status does not appear for OCHNC circuit types.

Purpose This task filters the display of OCHNCs and circuits in the Circuits 
window. You can filter the circuits in network, node, or card view based on 
circuit or OCHNC name, size, type, direction, and other attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 7-2 Cisco ONS 15454 Circuit Status (continued)

Status Definition/Activity
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Step 1 Navigate to the appropriate CTC view:

• To filter network circuits, choose View > Go to Network View.

• To filter circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

• To filter circuits that originate, terminate, or pass through a specific card, double-click the card on 
the shelf graphic in node view to open the card in card view. 

Step 2 Click the Circuits tab.

Step 3 Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. In the Circuit Filter dialog box, set the filter attributes by choosing one or more of the following:

• Name—Enter a complete or partial circuit name to filter circuits based on the circuit name; 
otherwise leave the field blank.

• Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way 
circuits), or 2-way (display only two-way circuits).

• OCHNC Dir—(DWDM optical channel network connections only.) Choose one: East to West 
(displays only east-to-west circuits); West to East (displays only west-to-east circuits).

• OCHNC Wlen—(DWDM optical channel network connections only.) Choose an OCHNC 
wavelength to filter the circuits. For example, choosing 1530.33 will display channels 
provisioned on the 1530.33-nm wavelength.

• Status—Choose one: Any (status not used to filter circuits) or Discovered (display only 
discovered circuits). Other statuses do not apply to OCHNCs. 

• State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits; IS 
(ANSI) or Unlocked (ETSI) to display only in-service circuits (optical channel network 
connections have IS/Unlocked states only); or OOS-PARTIAL (ANSI) or 
Locked-partial (ETSI) to display only circuits with cross-connects in mixed service states.

• Slot—Enter a slot number to filter circuits based on the source or destination slot; otherwise 
leave the field blank.

• Port—Enter a port number to filter circuits based on the source or destination port; otherwise 
leave the field blank.

• Type—Choose one: Any (type not used to filter circuits) or OCHNC (displays only optical 
channel network connections). 

Note The following circuit types are not applicable to DWDM nodes: STS (displays only STS 
circuits), VT (displays only VT circuits), VT Tunnel (displays only VT tunnels), STS-V 
(displays STS VCAT circuits), VT-V (displays VT VCAT circuits), and VT Aggregation 
Point (displays only VT aggregation points), VC_HO_PATH_CIRCUIT (displays VC4 and 
VC4-Nc circuits), VC_LO_PATH_CIRCUIT (displays only VC3 and VC12 circuits), 
VC_LO_PATH_TUNNEL (displays only low-order tunnels), 
VC_LO_PATH_AGGREGATION (displays only log-order aggregation points), 
VC_HO_PATH_VCAT_CIRCUIT (displays high-order VCAT circuits), 
VC_LO_PATH_VCAT_CIRCUIT (displays low-order VCAT circuits).

• Size—Click the appropriate check boxes to filter circuits based on size: Multi-rate, 
Equipment non specific, 2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, or 10 Gbps No FEC. 
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VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not 
applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, 
VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.

The check boxes shown depend on the Type field selection. If you chose Any, all sizes are 
available. If you chose OCHNC as the circuit type, Multi-rate, Equipment non specific, 
2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear. 

Step 4 Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits 
window.

Step 5 To turn filtering off, click the Filter icon in the lower right corner of the Circuits window. Click the icon 
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 6 Return to your originating procedure (NTP).

DLP-G103 View Optical Channel Network Connections on a Span

Step 1 In node view, choose View > Go to Network View. If you are already in network view, continue with 
Step 2.

Step 2 Right-click the green line containing the circuits you want to view and choose Circuits to view DWDM 
OCHNCs or unprotected circuits on the span.

In the Circuits on Span dialog box, you can view information about the circuits that traverse the span. 
The information that appears depends on the circuit type. For DWDM OCHNCs, the following 
information appears:

• OCHNC Wavelength—The wavelength provisioned for the OCHNC.

• DIR—2-way, or 1-way

• OCHNC Dir—The direction provisioned for the OCHNC, either east-to-west or west-to-east.

• Circuit—The OCHNC circuit name.

Step 3 Return to your originating procedure (NTP).

Purpose This task allows you to view OCHNCs and circuits on an ONS 15454 span. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision DWDM Optical Channel Network Connections, page 
7-10

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-G59 Create and Delete Optical Channel Network 
Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at a node on the network where you want to 
create and delete OCHNCs. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the OCHNC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 7-9. If not, continue with the next step.

Step 3 Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10 
as needed.

Step 4 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 as needed.

Stop. You have completed this procedure.

DLP-G104 Assign a Name to a Port

Step 1 Double-click the card that has the port you want to provision. This can be any port on a traffic carring 
card.

Step 2 Click the Provisioning tab.

Step 3 Click the Port Name column for the port number to which you are assigning a name.

Step 4 Type the port name. 

The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This procedure creates and deletes DWDM OCHNCs.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task assigns a name to a port on any ONS 15454 card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G105 Provision DWDM Optical Channel Network Connections

Step 1 Choose View > Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 Define the circuit attributes:

• Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Equipped non specific is the default. You cannot change it.

• OCHNC Channel—Choose the wavelength you want to provision. Table 7-3 lists the thirty-two 
available wavelengths.

Purpose This task creates an OCHNC between ONS 15454s that are provisioned for 
DWDM. 

Tools/Equipment An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength are required.

DLP-G46 Log into CTC, page 2-24

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node” and Chapter 5, “Provision 
Transponder and Muxponder Cards” must be completed at all nodes within 
the OCHNC route.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Table 7-3 OCHNC Channels

Channel No. Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56
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• OCHNC Direction—Choose the OCHNC direction, either East to West or West to East. If you 
choose West to East, the channel will exit the node through the LINE-TX port of the OSC-CSM-E 
or OPT-BST-E named as East Side Card by MetroPlanner (typically these cards are hosted by 
Slot 17). If you choose East to West, the channel will exit the node through the LINE-TX port of the 
OSC-CSM-W or OPT-BST-W named as West Side Card by MetroPlanner (typically these cards are 
hosted by Slot 1).

• Bidirectional—Check this check box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC.

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list. 

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list. 

Step 10 Click Finish. The circuit may take a few minutes to come up, depending on the size of the network. If 
problems persist, refer to the Cisco ONS 15454 DWDM  Troubleshooting Guideas necessary.

Step 11 Return to your originating procedure (NTP).

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1544.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

Table 7-3 OCHNC Channels (continued)

Channel No. Channel ID Frequency (GHz) Wavelength (nm)
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DLP-G106 Delete Optical Channel Network Connections

Step 1 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2, or record the circuit 
information if it will be recreated.

Step 2 Consult your  network operations center, or other appropriate personel, to verify that the OCHNC can 
be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion. 

Step 4 Choose View > Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Choose the OCHNCs you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, check Notify when completed, as needed. 

If checked, the CTC Alerts confirmation dialog box indicates when the OCHNC is deleted. During this 
time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for 
confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-32. 
If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

• If you checked “Notify when completed,” the CTC Alerts dialog box appears. If you want to save 
the information, continue with Step 9. If you do not want to save the information, continue with 
Step 10.

• If you did not check “Notify when completed,” the Circuits window appears. Continue with Step 11.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 10.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a .txt file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2 if you require a backup of 
your changes.

Purpose This task deletes circuits and DWDM OCHNCs. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 12 Return to your originating procedure (NTP).

NTP-G60 Create Overhead Circuits

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you will create the 
overhead circuit. If you are already logged in, continue with Step 2.

Step 2 Choose View > Go to Network View.

Step 3 Complete the “DLP-G76 Provision GCC Terminations” task on page 7-13.

Step 4 Complete the “DLP-G97 Provision a Proxy Tunnel” task on page 7-14.

Step 5 Complete the “DLP-G98 Provision a Firewall Tunnel” task on page 7-15.

Step 6 As needed, complete the “DLP-G107 Create an IP-Encapsulated Tunnel” task on page 7-16, then 
continue with the next step.

Step 7 After creating an IP-encapsulated tunnel, put the ports that are hosting the IP-encapsulated tunnel in 
service. See the “DLP-G108 Change the Service State for a Port” task on page 7-17.

Step 8 As needed, complete the “DLP-G109 Provision Orderwire” task on page 7-18.

Step 9 As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 7-19.

Stop. You have completed this procedure.

DLP-G76 Provision GCC Terminations

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include GCC, IP-encapsulated tunnels, the Alarm 
Interface Controller (AIC) and Alarm Interface Controller–International 
(AIC-I) card orderwire, and the AIC-I card user data channel (UDC).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates the DWDM GCC terminations required for network setup 
when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and 
MXP_2.5G_10G cards. Perform this task before you create circuits for 
these cards. In this task, you can also set up the node so that it has direct 
IP access to a far-end non-ONS node over the GCC network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
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Step 1 In node view click the Provisioning > Comm Channels > GCC tabs.

Step 2 In the GCC Terminations pane, click Create.

Step 3 In the Create optical transport network (OTN) GCC Terminations dialog box, click the ports where you 
want to create the GCC termination. To select more than one port, press the Shift key or the Ctrl key.

Note GCC refers to the general communications channel, which is used for ONS 15454 transponders 
and muxponders in DWDM applications. 

Step 4 (Optional) From the GCC Rate drop-down list, choose from two options:

• 192k is the line rate of Section DCC (SDCC)—This is the default option.

• 576k is the line rate of Line DCC (LDCC)—This option will be supported in a future software 
release.

Step 5 Click Set to IS if you want to put ports in service.

Step 6 If the SDCC termination is to include a non-ONS node, check the Far End is Foreign check box. This 
automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified 
by the far end. To change the default to a specific the IP address, see the “DLP-G184 Change a GCC 
Termination” task on page 10-29.

Step 7 Select Disable OSPF on link to turn off OSPF.

Step 8 Click OK. Until the Far End GCC terminations are created and the ports are in service, GCC-EOC 
alarms appear.

Step 9 Return to your originating procedure (NTP).

DLP-G97 Provision a Proxy Tunnel

Note If the proxy server is disabled, you cannot set up a proxy tunnel. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task sets up a proxy tunnel to communicate with a non-ONS far-end 
node. Proxy tunnels are only necessary when the proxy server is enabled 
and a foreign GCC termination exists, or if static routes exist so that the 
GCC network is used to access remote networks or devices. You can 
provision a maximum of 12 proxy server tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G76 Provision GCC Terminations, page 7-13 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note This task does not apply if secure mode is enabled.

Step 1 In Node view, click the Provisioning > Network > Proxy subtabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following:

• Source Address—Type the IP address of the source node (32 bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32 bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

DLP-G98 Provision a Firewall Tunnel

Note If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel. 

Note This task does not apply if secure mode is enabled.

Step 1 In Node view, click the Provisioning > Network > Firewall subtabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following:

• Source Address—Type the IP address of the source node (32 bit length) or source subnet (any other 
length).

Purpose This task provisions destinations that will not be blocked by the firewall. 
Firewall tunnels are only necessary when the proxy server is enabled and a 
foreign GCC termination exists, or if static routes exist so that the GCC 
network is used to access remote networks or devices. You can provision a 
maximum of 12 firewall tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G76 Provision GCC Terminations, page 7-13 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32 bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

DLP-G107 Create an IP-Encapsulated Tunnel

Note Each ONS 15454 can have up to ten IP-encapsulated tunnel connections. Terminated Section DCCs 
(SDCCs) used by the ONS 15454 cannot be used as a tunnel endpoint, and an SDCC that is used as a 
tunnel endpoint cannot be terminated. All tunnel connections are bidirectional. 

Step 1 Verify that IP addresses are provisioned at both the source and destination nodes of the planned tunnel. 
For more information, see the “DLP-G56 Provision IP Settings” task on page 3-11.

Step 2 In network view, click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create.

Step 4 In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:

• Name—Type the tunnel name.

• Type—Choose IP Tunnel-D1-D3.

• Maximum Bandwidth—Type the percentage of total SDCC bandwidth used in the IP tunnel (the 
minimum percentage is 10 percent). 

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

• Channel—Displays IPT (D1-D3).

Purpose This task creates an IP-encapsulated tunnel to transport traffic from 
third-party SONET/SDH equipment across ONS 15454 networks. 
IP-encapsulated tunnels are created on the Section DCC channel (D1-D3) 
(if not used by the ONS 15454 as a terminated data communications 
channel [DCC]). 

Tools/Equipment An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

• Channel—Displays IPT (D1-D3).

Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP).

DLP-G108 Change the Service State for a Port

Step 1 In node view on the shelf graphic, double-click the card with the port(s) you want to put in or out of 
service. The card view appears.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Admin State column for the desired port, choose one of the following from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)—Puts the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI) 
service state. 

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Puts the port in the OOS-MA,DSBLD (ANSI) 
or Locked-enabled,disabled (ETSI) service state. 

For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR; 
OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For 
ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled; 
Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

• OOS,MT (ANSI) or Locked,maintenance (ETSI)—Puts the port in the 
OOS-MA,MT/Locked-enabled,maintenance service state. This service state does not interrupt 
traffic flow, but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, 
whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the 
TL1 RTRV-COND command. Use the OOS-MA,MT/Locked-enabled,maintenance service state for 
testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or 
OOS-AU,AINS/Unlocked-disabled,automaticInService service states when testing is complete.

Purpose This task puts a port in service or removes a port from service. After 
creating an IP-encapsulated tunnel, put the ports that are hosting the 
IP-encapsulated tunnel in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this service state, alarm 
reporting is suppressed, but traffic is carried and loopbacks are allowed. After the soak period 
passes, the port changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms 
are reported or not, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND 
command.

For more information about service states, see Appendix C, “DWDM Administrative and Service 
States.”

Step 4 If you set the Admin State to IS-AINS/Unlocked, automaticInService, set the soak period time in the 
AINS Soak field. This is the amount of time that the port will stay in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state after a signal is continuously 
received. When the soak period elapses, the port changes to the IS-NR/Unlocked-enabled service state.

Step 5 Click Apply. The new port service state appears in the Service State column.

Step 6 As needed, repeat this task for each port.

Step 7 Return to your originating procedure (NTP).

DLP-G109 Provision Orderwire

Step 1 In the network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create. 

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire 
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use 
either local or express orderwire channels. If regenerators exist, use the express orderwire channel. 
You can provision up to four ONS 15454 OC-N ports for each orderwire path.

• PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law 
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both 
types of orderwire.

Purpose This task provisions orderwire on the AIC or the AIC-I card. 

Tools/Equipment An AIC or AIC-I card must be installed in Slot 9.

An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

Step 8 Click Finish.

Step 9 Return to your originating procedure (NTP).

DLP-G110 Create a User Data Channel Circuit

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list. 
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

Purpose This task creates a user data channel (UDC) circuit on the ONS 15454. A 
UDC circuit allows you to create a dedicated data channel between nodes. 

Tools/Equipment OSCM, OSC-CSM, MXPP_MR_2.5G, or MXP_MR_2.5G must be 
installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

Step 8 Click Finish.

Step 9 Return to your originating procedure (NTP). 

NTP-G61 Modify and Delete Overhead Circuits

Caution Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 for a node on the network where you want 
to repair or delete a circuit. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G111 Repair an IP Tunnel” task on page 7-21.

Step 3 As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 7-21.

Stop. You have completed this procedure.

Purpose This procedure repairs IP circuits and deletes overhead circuits.

Tools/Equipment None

Prerequisite Procedures NTP-G60 Create Overhead Circuits, page 7-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G111 Repair an IP Tunnel

Step 1 Obtain the original IP address of the node in question.

Step 2 From the View menu, choose Go to Network View.

Step 3 From the Tools menu, choose Overhead Circuits > Repair IP Circuits.

Step 4 Review the text in the IP Repair wizard and click Next.

Step 5 In the Node IP address area, complete the following:

• Node—Choose the node that has a PARTIAL circuit.

• Old IP Address—Type the node’s original IP address.

Step 6 Click Next.

Step 7 Click Finish.

Step 8 Return to your originating procedure (NTP).

DLP-G112 Delete Overhead Circuits

Caution Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of 
service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 7-17.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated 
tunnel, or DCC tunnel.

Purpose This task repairs circuits that have a PARTIAL status as a result of node 
IP address changes.

Tools/Equipment None

Prerequisite Procedures DLP-G107 Create an IP-Encapsulated Tunnel, page 7-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes overhead circuits. Overhead circuits include 
IP-encapsulated tunnels, AIC and AIC-I card orderwire, and user data 
channels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Delete.

Step 5 In the confirmation dialog box, click Yes to continue.

Step 6 Return to your originating procedure (NTP).

NTP-G62 Create a J0 Section Trace 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at a node on the network where you will 
create the section trace. If you are already logged in, continue with Step 2.

Step 2 In node view, double-click the MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, 
MXP_2.5G_10E, TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G card.

Step 3 Click the Provisioning > Line > Section Trace tabs.

Step 4 From the Port drop-down list, choose the port for the section trace.

Step 5 From the Trace Mode drop-down list, enable the section trace expected string by choosing Manual:

• Off/None

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is raised 
when a string that differs from the Current Expected String is received.

Step 6 In the Section Trace String Size area, click 1 byte, or 16 byte . The 1 byte option allows you to enter one 
character; the 16 byte option allows a 15 character string. 

Step 7 In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the 
destination port easy to identify, such as the node IP address, node name, or another string. If the 
New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8 If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive 
from the source port in the New Expected String field. If you set Section Trace Mode to Auto, skip this 
step.

Step 9 Click the Disable AIS/RDI on TIM-S is detected check box if you want to suppress the alarm indication 
signal (AIS) and remote defect indication (RDI) when the STS Section Trace Identifier Mismatch Path 
(TIM-S) alarm appears. Refer to the Cisco ONS 15454 Troubleshooting Guide and the Cisco ONS 15454 
SDH Troubleshooting Guide for descriptions of alarms and conditions.

Step 10 Click Apply.

Step 11 After you set up the section trace, the received string appears in the Received field. The following 
options are available:

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to traffic between nodes. 

Tools/Equipment At least one of the following cards must be installed: MXP_MR_2.5G, 
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10E, 
TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G.

Prerequisite Procedures None

Required/As Needed As needed (optional if path trace is set)

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII 
Mode. Click it to return the section trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Section Trace Mode field is set to 
Auto or Manual.

Stop. You have completed this procedure.
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C H A P T E R 8

Manage Alarms

This chapter contains the procedures for viewing and managing the alarms and conditions on a 
Cisco ONS 15454. 

Cisco Transport Controller (CTC) detects and reports alarms generated by the Cisco ONS 15454 and the 
Optical Networking System (ONS) network. You can use CTC to monitor and manage alarms at a card, 
node, or network level. You can also view alarm counts on the LCD front panel.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G63 Document Existing Provisioning, page 8-2—Complete this procedure as needed to print 
or export node data.

2. NTP-G64 View Alarms, History, Events, and Conditions, page 8-5—Complete this procedure as 
needed to see alarms and conditions occurring on the node and a complete history of alarm and 
condition messages.

3. NTP-G65 Delete Cleared Alarms from Display, page 8-13—Complete this procedure as needed to 
delete cleared alarm information.

4. NTP-G66 View Alarm-Affected Circuits, page 8-14—Complete this procedure as needed to find 
circuits that are affected by a particular alarm or condition.

5. NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port, page 8-14—Complete this 
procedure as needed to see a statistical count of alarms that have occurred for a slot or port.

6. NTP-G68 Create, Download, and Assign Alarm Severity Profiles, page 8-16—Complete this 
procedure as needed to change the default severity for certain alarms, to assign the new severities to 
a port, card, or node, and to delete alarm profiles.

7. NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering, page 8-24—Complete this 
procedure as needed to enable, disable, or modify alarm severity filtering in the Conditions, Alarms, 
or History screens at the node or network level.

8. NTP-G70 Suppress Alarms or Discontinue Alarm Suppression, page 8-28—Complete this 
procedure as needed to suppress reported alarms at the port, card, or node level and to disable the 
suppress command to resume normal alarm reporting.
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9. NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International 
Card, page 8-31—Complete this procedure as needed to provision external alarms and controls on 
the Alarm Interface Controller-International (AIC-I) card.

NTP-G63 Document Existing Provisioning

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to print or export 
data. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G113 Print CTC Data” task on page 8-2.

Step 3 As needed, complete the “DLP-G114 Export CTC Data” task on page 8-4.

Stop. You have completed this procedure.

DLP-G113 Print CTC Data

Step 1 Click the tab (and subtab, if present) containing the information you want to print. For example, click 
the Alarms tab to print Alarms window data.

The print operation is available for all network, node, and card view windows.

Step 2 From the File menu choose Print. The Print dialog box opens (Figure 8-1). 

Purpose Use this procedure to document existing provisioning by printing card, 
node, or network CTC information or exporting card, node, or network 
information as delineated text files to other applications. This procedure 
is useful for network record keeping and troubleshooting.

Tools/Equipment A printer connected to the CTC computer by a direct or network 
connection

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 

Purpose This task prints CTC card, node, or network data in graphical or tabular 
format on a Windows-provisioned printer.

Tools/Equipment Printer connected to the CTC computer by a direct or network connection

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 8-1 Selecting CTC Data For Print

Step 3 In the Print dialog box, click a printing option:

• Entire Frame—Prints the entire CTC window including the graphical view of the card, node, or 
network. This option is available for all windows.

• Tabbed View—Prints the lower half of the CTC window containing tabs and data. The printout 
includes the selected tab (on top) and the data shown in the tab window. For example, if you print 
the History window Tabbed View, you print only history items appearing in the window. This option 
is available for all windows.

• Table Contents—Prints CTC data in table format without graphical representations of shelves, 
cards, or tabs. This option applies to all windows except:

– Provisioning > General > General and Power Monitor windows

– Provisioning > Network > General windows

– Provisioning > Security > Policy, Access, and Legal Disclaimer windows

– Provisioning > SNMP window

– Provisioning > Timing window > General and BITS Facilities windows

– Maintenance > Cross-Connect > Cards window

– Maintenance > Database window

– Maintenance > Diagnostic window

– Maintenance > Protection window

– Maintenance > Timing > Source window

The Table Contents option prints all the data contained in a table and the table column headings. For 
example, if you print the History window Table Contents view, you print all data included in the 
table whether or not items appear in the window.

Tip When you print using the Tabbed View option, it can be difficult to distinguish whether the 
printout applies to the network, node, or card view. To determine the view, compare the tabs on 
the printout. The network, node, and card views are identical except that network view does not 
contain an Inventory tab or Performance tab.

Step 4 Click OK.

Step 5 In the Windows Print dialog box, click a printer and click OK.

Step 6 Repeat this task for each window that you want to print.

Step 7 Return to your originating procedure (NTP).
8-3
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 8      Manage Alarms
Before You Begin
DLP-G114 Export CTC Data

Step 1 Click the tab containing the information you want to export (for example, the Alarms tab or the Circuits 
tab).

Step 2 Choose Export from the File menu. The Export dialog box appears (Figure 8-2).

Figure 8-2 Selecting CTC Data For Export

Step 3 In the Export dialog box, click a data format:

• As HTML—Saves data as a simple HTML table file without graphics. The file must be viewed or 
edited with applications such as Netscape Navigator, Microsoft Internet Explorer, or other 
applications capable of opening HTML files.

Purpose This task exports CTC table data as delineated text to view or edit the data 
in text editor, word processing, spreadsheet, database management, or web 
browser applications. The export operation applies to all tabular data 
except:

• Provisioning > General > General and Power Monitor windows

• Provisioning > Network > General windows

• Provisioning > Security > Policy, Access, and Legal Disclaimer 
windows

• Provisioning > SNMP window

• Provisioning > Timing window

• Maintenance > Cross-Connect > Cards windows

• Maintenance > Database window

• Maintenance > Diagnostic window

• Maintenance > Protection window

• Maintenance > Timing > Source windows

• Maintenance > DWDM > ROADM Power Monitoring window [ETSI 
only]

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
8-4
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 8      Manage Alarms
Before You Begin
• As CSV—Saves the CTC table as comma-separated values (CSV). This option does not apply to the 
Maintenance > Timing > Report window.

• As TSV—Saves the CTC table as tab-separated values (TSV).

Step 4 Click OK.

Step 5 In the Save dialog box, enter a name in the File name field.

Step 6 Navigate to a directory where you want to store the file.

Step 7 Click Save.

Step 8 Repeat the task for each window that you want to export.

Note If you want to open a file in a text editor or word processor application, procedures will vary. 
Typically you can use the File > Open command to view the CTC data, or you can double-click 
the file name and choose an application such as Notepad. Text editor and word processor 
applications format the data exactly as it is exported, including comma or tab separators. All 
applications that open the data files allow you to format the data.

If you want to open the file in spreadsheet and database management applications, procedures 
will vary. Typically you need to open the application and choose File > Import, then choose a 
delimited file to format the data in cells.

Spreadsheet and database management programs also allow you to manage the exported data. 
An exported file cannot be opened in CTC. 

Step 9 Return to your originating procedure (NTP).

NTP-G64 View Alarms, History, Events, and Conditions

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24.

Step 2 Complete the “DLP-G115 View Alarms” task on page 8-6 as needed.

Step 3 Complete the “DLP-G116 View Alarm or Event History” task on page 8-8 as needed.

Step 4 Complete the “DLP-G117 Change the Maximum Number of Session Entries for Alarm History” task on 
page 8-9 as needed.

Step 5 Complete the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-10 as 
needed.

Purpose Use this procedure to view current or historical alarms and conditions for 
a card, node, or network. This information is useful for monitoring and 
troubleshooting hardware and software events.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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Step 6 Complete the “DLP-G119 Synchronize Alarms” task on page 8-11 as needed.

Step 7 Complete the “DLP-G120 View Conditions” task on page 8-11 as needed.

Stop. You have completed this procedure. 

DLP-G115 View Alarms

Step 1 In the card, node, or network view, click the Alarms tab to view the alarms for that card, node, or 
network.

Table 8-1 describes the columns in the Alarms window.

Note Unless otherwise indicated, each column appears in card, node, and network view.

Purpose Use this task to view current alarms on a card, node, or network. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 

Table 8-1 Alarm Column Descriptions

Column Information Recorded

Num Sequence number of the original alarm. (This tab displays in node and card views 
only.)

Ref Reference number of the original alarm. (This tab displays in node and card views 
only.)

New Indicates a new alarm; to change this status, click either the Synchronize button or 
the Delete Cleared Alarms button. 

Date Date and time of the alarm.

Node The name of the node where the alarm occurred. (This tab display only in network 
view.)

Object TL1 access identifier (AID) for the alarmed object; for an STSmon or VTmon, this is 
the monitored STS or VT.

Eqpt Type If an alarm is raised on a card, the card type in this slot.

Slot If an alarm is raised on a card, the slot where the alarm occurred (appears only in 
network and node view).

Port If an alarm is raised on a card, the port where the alarm is raised; for STSTerm and 
VTTerm, the port refers to the upstream card it is partnered with.
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Table 8-2 lists the color codes for alarm and condition severities.

Step 2 If alarms are present, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide for information and troubleshooting procedures.

Step 3 Return to your originating procedure (NTP). 

Path Width Indicates how many STSs are contained in the alarmed path. This information 
complements the alarm object notation, which is explained in the 
Cisco ONS 15454 Troubleshooting Guide and the Cisco ONS 15454 SDH 
Troubleshooting Guide.

Sev Severity level: CR (Critical), MJ (Major), MN (minor), NA (Not Alarmed), NR 
(Not Reported).

ST Status: R (raised), C (clear), T (transient).

SA When checked, indicates a service-affecting alarm.

Cond The error message/alarm name; these names are alphabetically defined in the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

Description Description of the alarm.

Shelf When checked, indicates a multi-shelf alarm.

Table 8-1 Alarm Column Descriptions (continued)

Column Information Recorded

Table 8-2 Color Codes for Alarms and Condition Severities

Color Description

Red Raised Critical (CR) alarm

Orange Raised Major (MJ) alarm

Yellow Raised Minor (MN) alarm

Magenta (pink) Raised Not Alarmed (NA) condition

Blue Raised Not Reported (NR) condition

White Cleared (C) alarm or condition
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DLP-G116 View Alarm or Event History

Step 1 Decide whether you want to view the alarm message history at the node, network, or card level.

Step 2 To view node alarm history:

a. In node view, click the History > Session tabs to view the alarms and conditions (events) raised 
during the current session.

b. Click the History > Node tabs. 

If you check the Alarms check box, the node’s alarm history appears. If you check the Events check 
box, the node’s Not Alarmed and transient event history appears. If you check both check boxes, you 
will retrieve node history for alarms and events. 

c. Click Retrieve to view all available messages for the History > Node tabs.

Note Alarms can be unreported when they are filtered out of the display using the Filter button in 
either tab. See the “DLP-G126 Enable Alarm Filtering” task on page 8-25 for information.

Tip Double-click an alarm in the alarm table or an event (condition) message in the history table to 
display the view that corresponds to the alarm message. For example, double-clicking a card 
alarm takes you to card view. In network view, double-clicking a node alarm takes you to node 
view.

Step 3 To view network alarm history:

a. From the View menu choose Go to Network View.

b. Click the History tab.

Alarms and conditions (events) raised during the current session appear.

Step 4 To view card alarm history:

a. From the View menu choose Go to Previous View.

b. Double-click a card on the shelf graphic to open the card-level view. TCC2/TCC2P cards do not have 
a card view.

c. Click the History > Session tab to view the alarm messages raised during the current session.

d. Click the History > Card tab to retrieve all available alarm messages for the card and click 
Retrieve.

Purpose This task is used to view past cleared and uncleared ONS 15454 alarm 
messages at the card, node, or network level. This task is useful for 
troubleshooting configuration, traffic, or connectivity issues that are 
indicated by alarms.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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If you check the Alarms check box, the node’s alarm history appears. If you check the Events check 
box, the Not Alarmed and transient event history appears. If you check both boxes, node history for 
both alarms and events appears. 

Note The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 
640 minor alarm messages, and 640 condition messages. When any of these limits is 
reached, the ONS 15454 discards the oldest events in that category.

Raised and cleared alarm messages (and events, if selected) appear.

Step 5 Return to your originating procedure (NTP).

DLP-G117 Change the Maximum Number of Session Entries for Alarm History

Step 1 From the Edit menu, choose Preferences.

The CTC Preferences dialog box appears (Figure 8-3).

Purpose This task changes the maximum number of session entries included in the 
alarm history. Use this task to expand the history list to save information 
for future reference or troubleshooting.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher 
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Figure 8-3 CTC Preferences Dialog Box

Step 2 Click the up or down arrow buttons next to the Maximum History Entries field to change the entry.

Step 3 Click Apply and OK.

Note Setting the Maximum History Entries value to the high end of the range uses more CTC memory 
and could impair CTC performance.

Note This task changes the maximum history entries recorded for CTC sessions. It does not affect the 
maximum number of history entries viewable for a network, node, or card.

Step 4 Return to your originating procedure (NTP).

DLP-G118 Display Alarms and Conditions Using Time Zone

Purpose This task changes the timestamp for events to the timezone of the ONS 
node reporting the alarm. By default, the events timestamp is set to the 
timezone for the CTC workstation.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher 
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Step 1 From the Edit menu, choose Preferences.

The CTC Preferences dialog box appears (Figure 8-3 on page 8-10).

Step 2 Check the Display Events Using Each Node’s Timezone check box. The Apply button is enabled.

Step 3 Click Apply and OK.

Step 4 Return to your originating procedure (NTP).

DLP-G119 Synchronize Alarms

Step 1 At the card, node, or network view, click the Alarms tab.

Step 2 Click Synchronize.

This button causes CTC to retrieve a current alarm summary for the card, node, or network. This step is 
optional because CTC updates the Alarms window automatically as raise/clear messages arrive from the 
node. 

Note Alarms that have been raised during the session will have a check mark in the Alarms window 
New column. When you click Synchronize, the check mark disappears.

Step 3 Return to your originating procedure (NTP).

DLP-G120 View Conditions

Purpose This task is used to view ONS 15454 events at the card, node, or network 
level and to refresh the alarm listing so that you can check for new and 
cleared alarms and conditions.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task is used to view conditions (events with a Not Reported [NR] 
severity) at the card, node, or network level. Conditions give you a clear 
record of changes or events that do not result in alarms.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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Step 1 From the card, node, or network view, click the Conditions tab.

Step 2 Click Retrieve.

The Retrieve button requests the current set of fault conditions from the node, card, or network. The 
window is not updated when events change on the node. You must click Retrieve to see any changes.

Conditions include all fault conditions raised on the node, whether or not they are reported.

Note Alarms can be unreported if they are filtered out of the display. See the “DLP-G126 Enable 
Alarm Filtering” task on page 8-25 for information.

Events that are reported as Major (MJ), Minor (MN), or Critical (CR) severities are alarms. Events that 
are reported as Not-Alarmed (NA) are conditions. Conditions that are not reported at all are marked 
Not-Reported (NR) in the Conditions window severity column.

Conditions that have a default severity of Critical (CR), Major (MJ), Minor (MN), or Not-Alarmed (NA) 
but are not reported due to exclusion or suppression are shown as NR in the Conditions window. 

Note For more information about alarm suppression, see the “DLP-G129 Suppress Alarm Reporting” 
task on page 8-28.

Current conditions are shown with the severity chosen in the alarm profile, if used. For more information 
about alarm profiles, see the “NTP-G68 Create, Download, and Assign Alarm Severity Profiles” 
procedure on page 8-16.

Note When a port is placed in the Out-of-Service and Management, Maintenance 
(OOS-MA,MT) (ANSI) or Locked-enabled, maintenance (ETSI) service state, it raises an 
Alarms Suppressed for Maintenance (AS-MT) condition. For information about alarm and 
condition troubleshooting, refer to the Cisco ONS 15454 Troubleshooting Guide and the 
Cisco ONS 15454 SDH Troubleshooting Guide.

Step 3 If you want to apply exclusion rules, check the Exclude Same Root Cause check box at the node or 
network view, but do not check the Exclude Same Root Cause check box in card view.

An exclusion rule eliminates all lower-level alarms or conditions that originate from the same cause. For 
example, a fiber break may cause an LOS alarm, an AIS condition, and an SF condition. If you check 
the Exclude Same Root Cause check box, only the LOS alarm will appear. According to Telcordia, 
exclusion rules apply to a query of “all conditions from a node.”

Step 4 Return to your originating procedure (NTP).
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NTP-G65 Delete Cleared Alarms from Display

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 To delete cleared node-level alarms:

a. In the node view, click the Alarms tab.

b. Click Delete Cleared Alarms.

• If the Autodelete Cleared Alarms check box is checked, an alarm disappears from the window when 
it is cleared.

• If the Autodelete Cleared Alarms check box is not checked, an alarm remains in the window when 
it is cleared. The alarm appears white in the window and has a Clear (CL) severity. The alarm can 
be removed by clicking the Delete Cleared Alarms button.

This action removes any cleared ONS 15454 alarms from the Alarms tab. The rows of cleared alarms 
turn white and have a C in their status (ST) column.

Step 3 To delete cleared card-level alarms:

a. In node view, double-click the card graphic for the card you want to open.

b. Click the Alarms tab and then click Delete Cleared Alarms, referring to the note in 
Step 2.

Step 4 To delete cleared network-level alarms:

a. In node view, click View > Go to Network View.

b. Click the Alarms tab and then click Delete Cleared Alarms, referring to the note in 
Step 2.

Step 5 To remove the transient messages from the History window, click Delete Cleared Alarms. Transient 
messages are single messages, not raise-and-clear pairs (that is, they do not have companion messages 
stating they are cleared). 

Stop. You have completed this procedure.

Purpose Use this procedure to delete Cleared (C) status alarms from the Alarms 
window or transient messages from the CTC History window.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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NTP-G66 View Alarm-Affected Circuits

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 In the network, node, or card view, click the Alarms tab or Conditions tab and then right-click anywhere 
in the row of an active alarm or condition.

Note The node view is the default, but you can also navigate to the Alarms tab in the network view or 
card view to perform Step 2.

The Select Affected Circuit option appears on the shortcut menu.

Step 3 Left-click or right-click Select Affected Circuits.

The Circuits window appears with the affected Optical Channel Network Connection (OCHNC) 
highlighted.

Stop. You have completed this procedure.

NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port

Step 1 If you want to view the entire alarm summary for the node, press either the Slot button or Port button 
on the LCD panel until “Node” appears on the LCD. You will also see the direction, “Status=Alm Ct.” 
This means that if you press the Status button at this time, as directed in Step 2, you will see an alarm 
count for the node.

Purpose Use this procedure to view all Optical Channel Network Connections 
(OCHNCs) and ONS 15454 circuits, if any, that are affected by an alarm 
or condition.

Tools/Equipment None

Prerequisite Procedures NTP-G64 View Alarms, History, Events, and Conditions, page 8-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 

Purpose Use this procedure to view an alarm summary for a node, slot, or port 
without using CTC.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 2 Press the Status button to see a summary of alarms and severities for the node. You will see a message 
similar to “Alm Ct: 2: MJ:2 MN:2,” meaning that there are two critical alarms, two major alarms, and 
two minor alarms.

Step 3 If you want to see alarm counts for a particular slot, such as the alarms for an OC-3 card in Slot 3, press 
the Slot button until you see “Slot-3” on the LCD. You will see the direction, “Status=Alm Ct Sum.”

Step 4 Press the Status button to see a summary of alarms and severities against the slot. For example, you 
might see “Slot-3 Alm Sum:0 MJ:1 MN:2.” This means that there are no critical alarms, one major alarm, 
and two minor alarms against the slot.

Step 5 If you want to view the alarms against a port on the card, such as Port 3 of the OC-3 card you viewed 
previously, press the Port button until you see “Port-3 Status=Alm Ct.”

Step 6 Press Status to view alarm count against the port. You will see a message similar to “Slot-3 Port-0 Ct:0 
MJ:1 MN:0.” This means that there is one major alarm against this port.

Figure 8-4 shows the shelf LCD panel.

Figure 8-4 Shelf LCD Panel

To return to the previous view from the Port screen, continue to press Port until the display cycles 
through all the ports on the slot. 

To return to the node menu from the Slot screen, press Slot until you cycle through all the slots and see 
“Node.”

If you do not press any buttons, the LCD will return to its default display with the node name. However, 
if you did not cycle through the options to return to the node status, you will see the slot or port where 
you last checked status.

Note A blank LCD results when the fuse on the alarm interface panel (AIP) board has blown. If this 
occurs, contact the Cisco Technical Assistance Center (TAC). See the “Obtaining Technical 
Assistance” section on page lxxiv.

Stop. You have completed this procedure.
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NTP-G68 Create, Download, and Assign Alarm Severity Profiles

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to create an alarm 
profile. If you are already logged in, continue with Step 2 to create, clone or modify an alarm profile, or 
go to Step 3 to download an alarm profile.

Step 2 Complete the “DLP-G121 Create a New or Cloned Alarm Severity Profile” task on page 8-16. This task 
clones a current alarm profile, renames the profile, and customizes the new profile.

Step 3 Complete the “DLP-G122 Download an Alarm Severity Profile” task on page 8-19. This task downloads 
an alarm severity profile from a CD or a node.

Note After storing a created or downloaded alarm profile, you must go to the node (either by logging 
into it or clicking on it from the network view) and activate the profile by applying it to the shelf, 
one or more cards, or one or more ports. 

Step 4 As necessary, complete the “DLP-G123 Apply Alarm Profiles to Ports” task on page 8-20 or the 
“DLP-G124 Apply Alarm Profiles to Cards and Nodes” task on page 8-22.

Step 5 As necessary, complete the “DLP-G125 Delete Alarm Severity Profiles” task on page 8-22.

Stop. You have completed this procedure.

DLP-G121 Create a New or Cloned Alarm Severity Profile

Step 1 From the CTC window, View Menu, select Go To Network View.

Step 2 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Purpose Use this procedure to create a customized alarm profile at the network, 
node, or card level. This procedure also provides links to tasks that 
describe how to assign custom severities individually to each port, card, or 
node, and to delete alarm profiles.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates a custom severity profile or clones and modifies the 
default severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note To access the profile editor from node or card view, click the Provisioning > Alarm Profiles > 
Alarm Profile Editor tabs. 

Step 3 If you want to create a new profile based on the default profile in use, click New. Continue with Step 9.

Step 4 If you want to create a profile using an existing profile located on the node, click Load and From Node 
in the Load Profiles dialog box.

a. Click the node name you are logged into in the Node Names list.

b. Click the name of an existing profile in the Profile Names list, such as Default. Continue with 
Step 6.

Step 5 If you want to create a profile using an existing profile located in a file that is stored locally or on a 
network drive, click From File in the Load Profiles dialog box.

a. Click Browse.

b. Navigate to the file location in the Open dialog box.

c. Click Open.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474-CORE. 

Step 6 Click OK.

The alarm severity profile appears in the Alarm Profiles window.The alarm profile list contains a master 
list of alarms that is used for a mixed node network. Some of these alarms might not be used in all ONS 
nodes.

Step 7 Right-click anywhere in the profile column to view the profile editing shortcut menu. (Refer to Step 10 
for further information about the Default profile.)

Step 8 Click Clone in the shortcut menu.

Tip To see the full list of profiles, including those available for loading or cloning, click Available. 
You must load a profile before you can clone it. 

Step 9 In the New Profile dialog box, enter a name in the New Profile Name field.

Profile names must be unique. If you try to import or name a profile that has the same name as another 
profile, CTC adds a suffix to create a new name. Long file names are supported.

Step 10 Click OK.

A new alarm profile (named in Step 9) is created. (If this is the first alarm profile created during 
installation, the default alarm profile settings are displayed in the AlarmType::Condition column on the 
left.) This profile duplicates the default profile severities and appears at the right of the previous profile 
column in the Alarm Profiles window.  You can select it and drag it to a different position.

Note Up to 10 profiles, including the two reserved profiles, Inherited and Default, can be stored in 
CTC.
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The Default profile sets severities to standard Telcordia GR-253-CORE settings. If an alarm has an 
Inherited profile, it inherits (copies) its severity from the same alarm's severity at the higher level. For 
example, if you choose the Inherited profile from the network view, the severities at the lower levels 
(node, card, and port) will be copied from this selection. A card with an Inherited alarm profile copies 
the severities used by the node that contains the card. (If you are creating profiles, you can apply these 
separately at any level. To do this, refer to the “DLP-G124 Apply Alarm Profiles to Cards and Nodes” 
task on page 8-22.)

Step 11 Modify (customize) the new alarm profile:

a. In the new alarm profile column, click the alarm severity you want to change in the custom profile.

b. Choose a severity from the drop-down list.

c. Repeat Steps a and b for each severity you want to customize. Refer to the following guidelines 
when you view the alarms or conditions after making modifications:

• All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia 
GR-474-CORE. 

• Default severities are used for all alarms and conditions until you create and apply a new profile. 

• Changing a severity to inherited (I) or unset (U) does not change the severity of the alarm.

Step 12 After you have customized the new alarm profile, right-click the profile column to highlight it.

Step 13 Click Store.

Step 14 In the Store Profiles dialog box, click To Node(s) and go to Step a below, or click To File and go to 
Step b (Figure 8-5).

Figure 8-5 Store Profiles Dialog Box

a. Choose the node where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click Select All.

• Press the Ctrl key, and simultaneously left-click the node where the profile is to be saved.

• If you do not want to save the profile to any nodes, click Select None.

• If you want to update alarm profile information, click (Synchronize).
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• Click OK to save the profile.

b. Save the profile:

• Click Browse and navigate to the profile save location.

• Enter a name in the File name field.

• Click Select to choose this name and location. Long file names are supported. CTC supplies a 
suffix of *.pfl to stored files.

• Click OK to store the profile.

Step 15 As needed, perform any of the following actions. The following options are located at the bottom of the 
Provision>Alarm Profile window.

• Click the Hide Identical Rows check box to configure the Alarm Profiles window to view rows with 
dissimilar severities.

• Click the Hide Reference Values check box to configure the Alarm Profiles window to view 
severities that do not match the Default profile.

• Click the Only show service-affecting severities check box to configure the Alarm Profiles 
window not to display Minor and some Major alarms that will not affect service.

Step 16 Return to your originating procedure (NTP).

DLP-G122 Download an Alarm Severity Profile

Note You must always store the alarm profile after editing it.  If you edit an alarm profie without saving it, 
changes to the profile will be lost if you change views in CTC.

Step 1 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Note To access the profile editor from node or card view, click the Provisioning > Alarm Profiles > 
Alarm Profile Editor tabs.

Step 2 Click Load.

Step 3 If you want to download a profile that exists on the node, click From Node in the Load Profiles 
dialog box.

a. Click the node name you are logged into in the Node Names list.

b. Click the name of the profile in the Profile Names list, such as Default.

Purpose This task downloads a custom alarm severity profile from a network-drive 
accessible CD-ROM, floppy disk, or hard disk location.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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c. Click OK.

Step 4 If you want to download a profile that is stored locally or on a network drive, click From File in the 
Load Profile dialog box.

a. Click Browse.

b. Navigate to the file location in the Open dialog box.

c. Click Open.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

Step 5 Click OK.

The downloaded profile appears at the right side of the Alarm Profiles window.

Step 6 Right-click anywhere in the downloaded profile column to view the profile editing shortcut menu.

Step 7 Click Store.

Step 8 In the Store Profiles dialog box, click To Node(s).

a. Choose the nodes where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click Select All.

• Press the Ctrl key, and simultaneously left-click the node where the profile is to be saved.

• If you do not want to save the profile to any nodes, click Select None.

• If you want to update alarm profile information, click Synchronize.

b. Click OK.

Step 9 Return to your originating procedure (NTP).

DLP-G123 Apply Alarm Profiles to Ports

Note You can also apply alarm profiles to cards using the “DLP-G124 Apply Alarm Profiles to Cards and 
Nodes” task on page 8-22.

Purpose This task applies a custom or default alarm severity profile to a port or 
ports.

Tools/Equipment None

Prerequisite Procedures DLP-G121 Create a New or Cloned Alarm Severity Profile, page 8-16

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In the node view, double-click the card you want to change to open the card view.

Note The card view is not available for the TCC2/TCC2P card.

Click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Figure 8-6 shows alarm profiles for the AD-1C card, for example. CTC shows Parent Card Profile: 
Inherited.

Figure 8-6 AD-1C Card Alarm Profile

Go to Step 2 to apply profiles to a port. Go to Step 3 to apply profiles to all ports on a card.

Step 2 To apply profiles on a port basis:

a. In card view, click the port row in the Profile column.

b. Choose the new profile from the drop-down list.

c. Click Apply.Confirm the profile updated to the port correctly.

Step 3 To apply profiles to all ports on a card:

a. In card view, click the Force all ports to profile drop-down arrow at the bottom of the window.

b. Choose the new profile from the drop-down list.

c. Click Force (still need to “Apply”).

d. Click Apply. Confirm the profile updated to all ports correctly.

In node view the Port Level Profiles column indicates port-level profiles with a notation such as 
“exist (1)". 

Step 4 To reapply a previous alarm profile after you have applied a new one, select the previous profile and click 
Apply again.
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Step 5 Return to your originating procedure (NTP).

DLP-G124 Apply Alarm Profiles to Cards and Nodes 

Step 1 In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tab.

Step 2 To apply profiles to a card:

a. Click a selection from the Profile column for the card.

b. Choose the new profile from the drop-down list.

c. Click Apply.

Step 3 To apply the profile to an entire node:

a. Click the Force All Ports to Profile drop-down arrow at the bottom of the window.

b. Choose the new alarm profile from the drop-down list.

c. Click Force (still need to apply).

Step 4 Click Apply again.

Step 5 Return to your originating procedure (NTP).

DLP-G125 Delete Alarm Severity Profiles

Step 1 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Purpose This task applies a custom or default alarm profile to cards or nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G121 Create a New or Cloned Alarm Severity Profile, page 8-16

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes a custom or default alarm severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note To access the profile editor from node or card view, click the Provisioning > Alarm Profiles > 
Alarm Profile Editor tabs.

Step 2 Click the profile that you want to delete. (Click in the column that displays the profile name and this 
selects it.)

Step 3 Click Delete.

The Select Node/Profile Combination for Delete dialog box appears (Figure 8-7).

Figure 8-7 Select Node/Profile Combination For Delete Dialog Box

Note You cannot delete the Inherited or Default alarm profiles.

Note A previously created alarm profile cannot be deleted unless it has been stored on the node. If the 
profile is visible on the Alarm Profiles tab but is not listed in the Select Node/Profile 
Combinations to Delete dialog box, continue with Step 8.

Step 4 Click the node names in the Node Names list to highlight the profile location.

Tip If you hold the Shift key down, you can select consecutive node names. If you hold the Ctrl key 
down, you can select any combination of nodes.

Step 5 Click the profile names you want to delete in the Profile Names list.

Step 6 Click OK.

Step 7 Click Yes in the Delete Alarm Profile dialog box.

If you delete a profile from a node, it still appears in the network view
Provisioning > Alarm Profile Editor window unless you remove it using the following step.

Step 8 To remove the alarm profile from the window, right-click the column of the profile you deleted and 
choose Remove from the shortcut menu.
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If a node and profile combination is selected but does not exist, a warning appears: “One or more of the 
profiles selected do not exist on one or more of the node(s) selected.” For example, if node A has only 
profile 1 stored and the user tries to delete both profile 1 and profile 2 from node A, this warning appears. 
However, the operation still removes profile 1 from node A.

The Default and Inherited special profiles cannot be deleted and do not appear in the Select Node/Profile 
Combination for Delete Window.

Step 9 Return to your originating procedure (NTP).

NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to enable alarm 
severity filtering. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G126 Enable Alarm Filtering” task on page 8-25. This task enables 
alarm filtering at the card, node, and network views for all nodes in the network. Alarm filtering can be 
enabled for alarms, conditions, or events.

Step 3 As needed, complete the “DLP-G127 Modify Alarm, Condition, and History Filtering Parameters” task 
on page 8-25 to modify the alarm filtering for network nodes to show or hide particular alarms or 
conditions.

Step 4 As needed, complete the “DLP-G128 Disable Alarm Filtering” task on page 8-27 to disable alarm profile 
filtering for all network nodes.

Stop. You have completed this procedure.

Purpose Use this procedure to start, change, or stop alarm filtering for one or more 
severities in the Alarms, Conditions, and History windows in all network 
nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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DLP-G126 Enable Alarm Filtering

Step 1 At the node, network, or card view, click the Alarms tab.

Step 2 Click the Filter tool icon on the right side of the bottom toolbar.

Note The Filter tool icon differs from the Filter button at the bottom left of the screen.

Alarm filtering is enabled if the tool is selected and disabled if the tool is raised (not selected).

Alarm filtering is enabled in the card, node, and network views of the same window for all nodes in the 
network. For example, if the Filter tool is enabled in the node view Alarms window, the network view 
Alarms window and card view Alarms window also show the tool enabled. 

Step 3 If you want alarm filtering enabled when you view conditions, repeat Steps 1 and 2 using the Conditions 
window.

Step 4 If you want alarm filtering enabled when you view alarm history, repeat Steps 1 and 2 using the History 
window.

Step 5 Return to your originating procedure (NTP).

DLP-G127 Modify Alarm, Condition, and History Filtering Parameters

Step 1 At the node, network, or card view, click the Alarms tab, Conditions tab, or History tab.

Step 2 Click the Filter button on the left side of the bottom toolbar.

The filter dialog box appears, displaying the General tab. Figure 8-8 shows the Alarm Filter dialog box; 
the Conditions and History tabs have similar dialog boxes.

Purpose This task enables alarm filtering for alarms, conditions, or event history in 
all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 

Purpose This task changes alarm and condition reporting in all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G126 Enable Alarm Filtering, page 8-25

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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Figure 8-8 Alarm Filter Dialog Box General Tab

In the General tab Show Severity box, you can choose which alarm severities will show through the 
alarm filter and provision a time period during which filtered alarms show through the filter. To change 
the alarm severities shown in the filter, go to Step 3. To change the time period filter for the alarms, go 
to Step 4.

Step 3 In the Show Severity area, click the check boxes for the severities [Critical (CR), Major (MJ), Minor 
(MN), or Not-Alarmed (NA)] you want to be reported at the network level. Leave severity check boxes 
deselected (unchecked) to prevent those severities from appearing.

When alarm filtering is disabled, all alarms show.

Step 4 In the Time area, click the Show alarms between time limits check box to enable it. Click the up and 
down arrows in the From Date, To Date, and Time fields to modify what period of alarms are shown.

To modify filter parameters for conditions, continue with Step 5. If you do not need to modify them, 
continue with Step 6.

Step 5 Click the filter dialog box Conditions tab (Figure 8-9).

Figure 8-9 Alarm Filter Dialog Box Conditions Tab
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When filtering is enabled, conditions in the Show list are visible and conditions in the Hide list are 
invisible.

• To move conditions individually from the Show list to the Hide list, click the > button.

• To move conditions individually from the Hide list to the Show list, click the < button.

• To move conditions collectively from the Show list to the Hide list, click the >> button.

• To move conditions collectively from the Hide list to the Show list, click the << button.

Note Conditions include alarms.

Step 6 Click Apply and OK.

Alarm and condition filtering parameters are enforced when alarm filtering is enabled (see the 
“DLP-G126 Enable Alarm Filtering” task on page 8-25), and the parameters are not enforced when 
alarm filtering is disabled (see the “DLP-G128 Disable Alarm Filtering” task on page 8-27).

Step 7 Return to your originating procedure (NTP).

DLP-G128 Disable Alarm Filtering

Step 1 At the node, network, or card view, click the Alarms tab.

Step 2 Click the Filter tool icon on the right side of the bottom toolbar.

Note The Filter tool icon differs from the Filter button at the bottom left of the screen.

Alarm filtering is enabled if the tool is indented and disabled if the tool is raised (not selected).

Step 3 If you want alarm filtering disabled when you view conditions, click the Conditions tab and click the 
Filter tool.

Step 4 If you want alarm filtering disabled when you view alarm history, click the History tab and click the 
Filter tool.

Step 5 Return to your originating procedure (NTP).

Purpose This task turns off specialized alarm filtering in all network nodes so that 
all severities are reported in CTC. 

Tools/Equipment None

Prerequisite Procedures DLP-G126 Enable Alarm Filtering, page 8-25

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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NTP-G70 Suppress Alarms or Discontinue Alarm Suppression

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G129 Suppress Alarm Reporting” task on page 8-28 to enable the node to send 
autonomous messages that clear specific raised alarms and cause suppressed alarms to appear in the 
Conditions window.

Suppressing one or more alarms prevents them from appearing in Alarm or History windows or in any 
other clients. The suppress command causes CTC to display them in the Conditions window with their 
severity, their severity color code, and service-affecting status.

Step 3 Complete the “DLP-G130 Discontinue Alarm Suppression” task on page 8-30 to discontinue alarm 
suppression and resume normal alarm reporting.

Stop. You have completed this procedure.

DLP-G129 Suppress Alarm Reporting

Caution If multiple CTC/TL1 sessions are open, suppressing alarms in one session suppresses the alarms in all 
other open sessions.

Purpose Use this procedure to prevent alarms from being reported for a port, card, 
or node in circumstances when an alarm or condition is known to exist but 
you do not want to include it in the display. This procedure also provides a 
link to a task that explains how to resume normal alarm reporting by 
discontinuing the suppression.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 

Purpose This task suppresses the reporting of ONS 15454 alarms at the node, card, 
or port level.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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Note Alarm suppression at the node level does not supersede alarm suppression at the card or port level. 
Suppression can exist independently for all three entities, and each entity will raise separate alarms 
suppressed by the user command (AS-CMD) alarm.

Step 1 If you are in node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step 2 To suppress alarms for the entire node:

a. Check the Suppress Alarms check box.

b. Click Apply.

All raised alarms for the node will change color to white in the Alarms window and their status will 
change to cleared. After suppressing alarms, clicking Synchronize in the Alarms window will remove 
cleared alarms from the window. However, an AS-CMD alarm will show in node or card view to indicate 
that node-level alarms were suppressed, and the word System will appear in the Object column.

Note The only way to suppress BITS, power source, or system alarms is to suppress alarms for the 
entire node. These cannot be suppressed separately.

Step 3 To suppress alarms for individual cards:

a. In the alarm behavior window, locate the card row (using the Location column for the slot number 
or the Eqpt Type column for the equipment name).

b. Check the Suppress Alarms column check box on that row.

Alarms that directly apply to this card will change appearance as described in Step 2. For example, if 
you suppressed raised alarms for an OC-48 card in Slot 16, raised alarms for this card will change in 
node or card view. The AS-CMD alarm will show the slot number in the Object number. For example, 
if you suppressed alarms for a Slot 16 OC-48 card, the AS-CMD object will be “SLOT-16.”

Click Apply.

Step 4 To suppress alarms for individual card ports, double-click the card in node view.

Step 5 Click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step 6 Check the Suppress Alarms column check box for the port row where you want to suppress alarms 
(Figure 8-6 on page 8-21).

Step 7 Click Apply.

Alarms that apply directly to this port will change appearance as described in Step 2. (However, alarms 
raised on the entire card will remain raised.) A raised AS-CMD alarm that shows the port as its object 
will appear in either alarm window. For example, if you suppressed alarms for Port 1 on the Slot 16 
OC-48 card, the alarm object will show “FAC-16-1.”

Step 8 Return to your originating procedure (NTP).
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DLP-G130 Discontinue Alarm Suppression

Caution If multiple CTC sessions are open, discontinuing suppression in one session will discontinue 
suppression in all other open sessions.

Step 1 To discontinue alarm suppression for the entire node:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tab.

b. Uncheck the Suppress Alarms check box. 

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the System object will be cleared 
in all views.

Step 2 To discontinue alarm suppression for individual cards:

a. In the node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

b. Locate the card that was suppressed in the slot list.

c. Uncheck the Suppress Alarms column check box for that slot.

d. Click Apply.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the slot object (for example, 
SLOT-16) will be cleared in all views.

Step 3 To discontinue alarm suppression for ports, click the the Provisioning > Alarm Profiles > Alarm 
Behavior tabs. 

Step 4 Uncheck the Suppress Alarms check box for the port(s) you no longer want to suppress.

Step 5 Click Apply.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the port object (for example, 
FAC-16-1) will be cleared in all views.

Step 6 Return to your originating procedure (NTP). 

Purpose This task discontinues alarm suppression and reenables alarm reporting on 
a port, card, or node.

Tools/Equipment None

Prerequisite Procedures DLP-G129 Suppress Alarm Reporting, page 8-28

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International Card

Note On the ONS 15454 ANSI shelf, the AIC-I card alarm provides direct alarm contacts (external alarm 
inputs and external control outputs) routed through the backplane to wire-wrap pins accessible from the 
back of the shelf. If you install an Alarm Expansion Panel (AEP), the AIC-I alarm contacts cannot be 
used. Only the AEP alarm contacts can be used. For further information about the AEP, see “NTP-G9 
Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-43 and the “NTP-G11 Install an 
External Wire-Wrap Panel on the AEP (ANSI Only)” procedure on page 1-57. The ONS 15454 ETSI 
shelf is not compatible with the AEP.

Note For information about the AIC-I alarms, controls, and virtual wire, refer to the “21.7.3 Virtual Wires” 
section on page 21-13.

Step 1 If you are using an ONS 15454 ANSI shelf, verify the backplane wiring. If you are using the AEP, see 
the “NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-43. Otherwise, see 
the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on 
page 1-46 for information about the ONS 15454 backplane pins.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN 
backplane pins.

b. For external controls, verify that the external device relays are wired to the ENVIR ALARMS OUT 
backplane pins.

Step 2 If you are using an ONS 15454 ETSI shelf, verify the alarm contact wiring. See the “NTP-G10 Attach 
Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-46 for information 
about the ONS 15454 SDH contacts.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN 
connector pins.

b. For external controls, verify the external device relays are wired to the ENVIR ALARMS OUT 
connector pins.

Step 3 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 4 In the node view, double-click the AIC-I card on the shelf graphic. The card view appears.

Step 5 Click the Provisioning > Card tabs. 

Purpose Use this procedure to create external (environmental) alarms and external 
controls for the AIC-I card. 

Tools/Equipment An AIC-I card must be installed in Slot 9.

Prerequisite Procedures DLP-G34 Install the AIC-I Card, page 1-73

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 In the Alarm Contacts area, click the Add Extension radio button if you are using the AEP. Clicking this 
option will choose the External Alarm input/output type and the AEP extension type; it will give you 
access to 16 external alarm contacts.

Step 7 If you did not click Add Extension, in the Input/Output area, choose either External Alarm or External 
Control. (External Alarm will limit your input/output options as explained in Step 6.) Choosing External 
Control will enable both external alarms and external controls. This will convert four of the external 
alarm contacts to external controls, leaving 12 available external control contacts. The extension type for 
both options is AEP.

Step 8 Click Apply.

Step 9 If you are provisioning external alarms, click the External Alarms tab (Figure 8-10). If you are not 
provisioning external alarms, skip Steps 10 through 12 and go to Step 13.

Figure 8-10 Provisioning External Alarms on the AIC-I Card

Step 10 For external alarms, complete the following fields:

• Enabled—Check the check box to activate the fields for the alarm input number.

• Alarm Type—Choose an alarm type from the drop-down list.

• Severity—Choose a severity from the drop-down list.

The severity determines the alarm’s severity in the Alarms and History tabs and determines whether 
the LEDs are activated. Critical (CR), Major (MJ), and Minor (MN) alarms activate the LEDs. Not 
Alarmed (NA) and Not Reported (NR) do not activate LEDs, but do report the information in CTC.

• Virtual Wire—Choose the virtual wire number from the drop-down list to assign the external device 
to a virtual wire. Otherwise, do not change the None default. 

• Raised When—From the drop-down list, choose the contact condition (open or closed) that triggers 
the alarm.

• Description—A default description is provided; enter a different description if needed. 
(Double-click on the cell and highlight the text to change it.)
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Step 11 To provision additional devices, complete Step 10 for each additional device.

Step 12 Click Apply.

When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to the 
external alarm’s number, regardless of the name you assign.

Step 13 For external controls, click the External Controls tab and complete the following fields for each control 
wired to the ONS 15454 backplane (ANSI) or FMEC connector pins (ETSI):

• Enabled—Check this check box to activate the fields for the alarm input number.

• Control Type—Choose the control type from the drop-down list: air conditioner, engine, fan, 
generator, heat, light, sprinkler, or miscellaneous.

• Trigger Type—Choose a trigger type: a local minor, major, or critical alarm; a remote minor, major, 
or critical alarm; or a virtual wire activation.

• Description—Enter a description. (Double-click on the cell and highlight the text to change it.)

Step 14 To provision additional external controls, complete Step 13 for each device.

Step 15 Click Apply.

Note External alarms and controls should be recorded locally for the NE. Both the Alarm name and 
resolution are node-specific.

Stop. You have completed this procedure.
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C H A P T E R 9

Monitor Performance

This chapter explains how to enable and view performance monitoring statistics for the 
Cisco ONS 15454. Performance monitoring (PM) parameters are used by service providers to gather, 
store, and set thresholds and report performance data for early detection of problems. For more PM 
information, details, and definitions, refer to the Cisco ONS 15454 Troubleshooting Guide (for ANSI 
shelves) or the Cisco ONS 15454 SDH Troubleshooting Guide (for ETSI shelves). 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454 SDH 
Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G73 Change the PM Display, page 9-2—Complete as needed to change the displayed PM 
counts.

2. NTP-G74 Monitor DWDM Card Performance, page 9-8—Complete as needed to monitor dense 
wavelength division multiplexing (DWDM) performance.

3. NTP-G75 Monitor Transponder and Muxponder Performance, page 9-18—Complete as needed to 
monitor transponder (TXP) and muxponder (MXP) card performance.

Note For additional information regarding PM parameters, refer to Telcordia’s GR-1230-CORE, 
GR-499-CORE, and GR-253-CORE documents and GR-820-CORE document titled Generic Digital 
Transmission Surveillance, and in the ANSI T1.231 document entitled Digital Hierarchy - Layer 1 
In-Service Digital Transmission Performance Monitoring.
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NTP-G73 Change the PM Display

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node that you want to monitor. If you 
are already logged in, continue with Step 2.

Step 2 In node view, double-click the DWDM, TXP, or MXP card where you want to view PM counts. The card 
view appears.

Step 3 As needed, use the following tasks to change the display of PM counts:

• DLP-G131 Refresh PM Counts at 15-Minute Intervals, page 9-2 

• DLP-G132 Refresh PM Counts at One-Day Intervals, page 9-3

• DLP-G133 View Near-End PM Counts, page 9-4

• DLP-G134 View Far-End PM Counts, page 9-5

• DLP-G135 Reset Current PM Counts, page 9-5

• DLP-G136 Clear Selected PM Counts, page 9-6

• DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts, page 9-7

• DLP-G138 Refresh PM Counts for a Different Port, page 9-8

Stop. You have completed this procedure.

DLP-G131 Refresh PM Counts at 15-Minute Intervals

Purpose This procedure enables you to change the display of PM counts by 
selecting drop-down list or radio button options in the Performance 
window. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 7, “Create Channels 
and Circuits,” Chapter 5, “Provision Transponder and Muxponder 
Cards,” and Chapter 11, “Change DWDM Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task changes the window view to display PM counts in 15-minute 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to change the PM count interval.

Note You cannot change the PM count interval on the TXP or MXP cards’ Current Values tab.

Step 4 Click the 15 min radio button.

Step 5 Click Refresh. Performance monitoring parameters appear in 15-minute intervals synchronized with the 
time of day.

Step 6 View the Curr column to find PM counts for the current 15-minute interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 15-minute interval, a threshold 
crossing alert (TCA) is raised. The number represents the counter value for each specific performance 
monitoring parameter.

Step 7 View the Prev-n columns to find PM counts for the previous 15-minute intervals.

Note If a complete 15-minute interval count is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 
15 minutes after the counter started, changing the node timing settings, changing the time zone 
settings, replacing a card, resetting a card, or changing port service states. When the problem is 
corrected, the subsequent 15-minute interval appears with a white background.

Step 8 Return to your originating procedure (NTP).

DLP-G132 Refresh PM Counts at One-Day Intervals

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the 1 day radio button.

Step 4 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to change the PM count interval.

Purpose This task changes the window view to display PM parameters in 1-day 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note You cannot change the PM count interval on the TXP or MXP cards’ Optics PM > Current Values 
tab.

Step 5 Click Refresh. Performance monitoring appears in 1-day intervals synchronized with the time of day.

Step 6 View the Curr column to find PM counts for the current 1-day interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 1-day interval, a TCA is raised. 
The number represents the counter value for each specific performance monitoring parameter.

Step 7 View the Prev-n columns to find PM counts for the previous 1-day intervals.

Note If a complete count over a 1-day interval is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 
24 hours after the counter started, changing node timing settings, changing the time zone 
settings, replacing a card, resetting a card, or changing port service states. When the problem is 
corrected, the subsequent 1-day interval appears with a white background.

Step 8 Return to your originating procedure (NTP).

DLP-G133 View Near-End PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to view near-end PM counts.

Step 4 Click the Near End radio button, where available. (Viewing near-end PM counts is not available for 
some tabs.)

Step 5 Click Refresh. All PM parameters occurring for the selected card on the incoming signal appear. For 
PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 
Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 6 View the Curr column to find PM counts for the current time interval.

Step 7 View the Prev-n columns to find PM counts for the previous time intervals.

Purpose This task enables you to view near-end PM counts for the selected card 
and port. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 8 Return to your originating procedure (NTP).

DLP-G134 View Far-End PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to view far-end PM counts.

Step 4 Click the Far End radio button, where available. (Viewing far-end PM counts is not available for some 
tabs.)

Step 5 Click Refresh. All PM parameters recorded by the far-end node for the selected card on the outgoing 
signal appear. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 6 View the Curr column to find PM counts for the current time interval.

Step 7 View the Prev-n columns to find PM counts for the previous time intervals.

Step 8 Return to your originating procedure (NTP).

DLP-G135 Reset Current PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Purpose This task enables you to view far-end PM parameters for the selected 
card and port. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task clears the current PM count, but it does not clear the 
cumulative PM count. This task allows you to see how quickly PM 
counts rise.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to reset the current PM counts. 

Note You cannot change the PM count interval on the TXP or MXP cards’ Optics PM > Current Values 
tab.

Step 4 Click Baseline.

Note The Baseline button clears the PM counts displayed in the current time interval but does not clear 
the PM counts on the card. When the current time interval expires or the window view changes, 
the total number of PM counts on the card and on the window appears in the appropriate column. 
The baseline values are discarded if you change views to a different window and then return to 
the Performance window.

Step 5 View the current statistics columns to observe changes to PM counts for the current time interval.

Step 6 Return to your originating procedure (NTP).

DLP-G136 Clear Selected PM Counts

Caution Pressing the Clear button can mask problems if used incorrectly. This button is commonly used for 
testing purposes. After pressing this button, the current bin is marked invalid. Also note that the 
unavailable seconds (UAS) count is not cleared if you were counting UAS; therefore, this count could 
be unreliable when you press Clear.

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to reset the current PM counts. 

Note You cannot clear the PM count interval on the TXP or MXP cards’ Optics PM > Current Values 
tab.

Step 4 Click Clear.

Step 5 From the Clear Statistics dialog box, click one of the following radio buttons:

Purpose This task uses the Clear button to clear specified PM counts depending 
on the option selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Displayed statistics: Clearing displayed statistics erases all PM counts associated with the current 
combination of statistics on the selected port from the card and the window. This means that the 
selected time interval, direction, and signal type counts are erased from the card and the window.

• All statistics for port x: Clearing all statistics for port x erases all PM counts associated with all 
combinations of the statistics on the selected port from the card and the window. This means that all 
time intervals, directions, and signal type counts are erased from the card and the window.

• All statistics for card: Clearing all statistics for card erases all PM counts for all ports from the card 
and the window.

Step 6 From the Clear Statistics dialog box, click OK to clear the selected statistics. Click Yes to confirm the 
change.

Step 7 Verify that the selected PM counts have been cleared.

Step 8 Return to your originating procedure (NTP).

DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to set the auto-refresh interval for displayed PM counts. 

Step 4 From the Auto-refresh drop-down list, choose one of the following options:

• None: This option disables the auto-refresh feature.

• 15 Seconds: This option sets the window auto-refresh to 15-second time intervals.

• 30 Seconds: This option sets the window auto-refresh to 30-second time intervals.

• 1 Minute: This option sets the window auto-refresh to 1-minute time intervals.

• 3 Minutes: This option sets the window auto-refresh to 3-minute time intervals.

• 5 Minutes: This option sets the window auto-refresh to 5-minute time intervals.

Step 5 Click Refresh. The PM counts for the newly selected auto-refresh time interval appear.

Depending on the selected auto-refresh interval, the displayed PM counts automatically update when 
each refresh interval completes. If the auto-refresh interval is set to None, the PM counts that appear are 
not updated unless you click Refresh.

Purpose This task changes the window auto-refresh intervals for updating the 
displayed PM counts.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
9-7
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 9      Monitor Performance
Before You Begin
Step 6 Return to your originating procedure (NTP).

DLP-G138 Refresh PM Counts for a Different Port

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click to any of the tabs or subtabs for that card where you want refresh PM counts. 

Step 4 In the Port drop-down list, choose a port.

Step 5 Click Refresh. The PM counts for the newly selected port appear.

Step 6 Return to your originating procedure (NTP).

NTP-G74 Monitor DWDM Card Performance

Step 1 Complete the “DLP-G46 Log into CTC” procedure on page 2-24 at the node that you want to monitor. 
If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks as needed:

Purpose This task changes the window view to display PM counts for another 
port on a multiport card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This procedure enables you to view, transmit, and receive performance 
information for OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 4MD, 
AD-xC-xx.x, AD-xB-xx.x, 32WSS, OPT-BST, and OPT-PRE cards and 
ports during selected time intervals to detect possible performance 
problems. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 7, “Create Channels 
and Circuits” and Chapter 11, “Change DWDM Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• DLP-G139 View Optical Service Channel PM Parameters, page 9-9.

• DLP-G140 View Optical Amplifier Power Statistics, page 9-11.

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards, 
page 9-12.

• DLP-G276 View 4-Channel Multiplexer/Demultiplexer Optical Power Statistics, page 9-14

• DLP-G142 View Channel Optical Add/Drop Multiplexer Power Statistics, page 9-15.

• DLP-G143 View Band Optical Add/Drop Multiplexer Power Statistics, page 9-17.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure 
on page 9-2.

Stop. You have completed this procedure.

DLP-G139 View Optical Service Channel PM Parameters

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to view PM counts. The card 
view appears.

Step 2 Click the Performance > OC3 Line tabs (Figure 9-1).

Purpose This task enables you to view optical service channel (OSC) PM counts 
at selected time intervals on an Optical Service Channel Module 
(OSCM) or Optical Service Channel and Combiner/Separator Module 
(OSC-CSM) card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-1 OC3 Line Tab in the Optical Service Channel Card View Performance Window

Step 3 Click Refresh. PMs appear for the OC3 (Port 1).

Step 4 Click the Optical Line tab.

Step 5 On the port menu, choose the optical line port whose power statistics you want to view:

• 2—COM RX

• 3—COM TX

• 4—LINE RX (available only on the OSC-CSM card)

• 5—LINE TX (available only on the OSC-CSM card)

• 6—OSC RX (available only on the OSC-CSM card)

• 7—OSC TX (available only on the OSC-CSM card)

Step 6 Click Refresh. The minimum, maximum, and average optical power statistics for the selected line port 
appear.

Step 7 Return to your originating procedure (NTP).
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DLP-G140 View Optical Amplifier Power Statistics

Step 1 In node view, double-click the optical amplifier card where you want to view PM counts. The card view 
appears.

Step 2 Click the Performance > Optical Line tabs (Figure 9-2).

Figure 9-2 Optical Line Tab in the Optical Amplifier Card View Performance Window

Step 3 In the Port field, choose an optical line port whose optical power statistics you want to view: 

• For the OPT-PRE card, the following ports are available to view:

– 1—COM RX

– 3—DC RX

– 4—DC TX

Purpose This task enables you to view the power statistics on an Optical 
Preamplifier (OPT-PRE) or Optical Booster (OPT-BST) amplifier card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• For the OPT-BST card, the following ports are available to view:

– 1—COM RX

– 2—COM TX

– 3—OSC RX

– 4—OSC TX

– 5—Line RX

Step 4 Click Refresh. Optical power statistics for the selected port appear.

Step 5 Click the Opt. Ampli. Line tab.

Step 6 Click Refresh. Optical power statistics for the optical amplifier output port (COM TX, Port 02 for the 
OPT-PRE card, and Line TX, Port 06 for the OPT-BST card) appear.

Step 7 Return to your originating procedure (NTP).

DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 
32DMX Cards

Step 1 In node view, double-click the 32MUX-O, 32-WSS, 32-DMX-O, or 32DMX card where you want to view 
PM counts. The card view appears.

Step 2 Click the Performance > Optical Chn tabs (Figure 9-3 on page 9-13).

Purpose This task enables you to view optical power statistics for a 32MUX-O 
(32-Channel Multiplexer), 32-WSS (32-Channel Wavelength Selective 
Switch), 32-DMX-O, and 32DMX (32-Channel Demultiplexer) card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-3 Optical Channel Tab in the Multiplexer/Demultiplexer Card View Performance 

Window

Step 3 In the Port field, choose an optical channel to view by selecting the port whose optical power statistics 
you want to view. There are 32 available ports for 32MUX-O, 32DMX-O, and 32DMX cards. The 
32WSS has 64 available ports.

Step 4 Click Refresh. Optical channel power statistics (minimum, maximum, average) for the selected port 
appear.

Step 5 Click the Optical Line tab.

Step 6 For a 32WSS card, select the port for which you wish to monitor power statistics (65, 66, 67, 68, or 69). 
For a 32DMX or 32DMX-O card, accept the default port (33).

Step 7 Click Refresh. Optical channel power statistics (minimum, maximum, average) for the selected port 
appear.

Step 8 Return to your originating procedure (NTP).
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DLP-G276 View 4-Channel Multiplexer/Demultiplexer Optical Power Statistics

Step 1 In node view, double-click the 4MD-xxx card where you want to the optical power statistics. The card 
view appears.

Step 2 Click the Performance > Optical Chn tabs (Figure 9-4).

Figure 9-4 Optical Channel Tab in the 4MD Card View Performance Window

Step 3 On the port menu, choose the channel port (1 through 8 for CHAN ports 01 through 08) whose power 
statistics you want to view.

Step 4 Click Refresh. The minimum, maximum, and average optical power for the selected channel port appear.

Purpose This task enables you to view the minimum, maximum, and average 
optical power statistics for a 4-Channel Multiplexer/Demultiplexer 
(4MD-xx.x) card channel and band ports. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 5 To change the auto-refresh interval, click Auto Refresh and choose one of the automatic refresh 
intervals: None, 15 seconds, 30 seconds, 1 minute, 3 minutes, 5 minutes. 

Step 6 Click the Optical Band tab.

Step 7 On the port menu, choose the band port (9 or 10 for COM ports 09 and 10) whose power statistics you 
want to view.

Step 8 Click Refresh. The minimum, maximum, and average optical power for the selected band port appear.

Step 9 To change the auto-refresh interval, click Auto Refresh and choose one of the automatic refresh 
intervals: None, 15 seconds, 30 seconds, 1 minute, 3 minutes, 5 minutes. 

Step 10 Return to your originating procedure (NTP).

DLP-G142 View Channel Optical Add/Drop Multiplexer Power Statistics

Step 1 In node view, double-click the optical AD-xC-xx.x card where you want to view the optical power 
statistics. The card view appears.

Step 2 Click the Performance > Optical Line tabs (Figure 9-5).

Purpose This task enables you to view channel optical add/drop channel 
multiplexer (OADM) minimum, maximum, and average power statistics 
on an 1-Channel OADM (AD-1C-xx.x), 2-Channel OADM 
(AD-2C-xx.x), or 4-Channel OADM (AD-4C-xx.x) card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-5 Optical Line Tab in the Channel Filter OADM Card View Performance Window

Step 3 In the Port field, choose an optical line port (Table 9-1) whose optical power statistics you want to view.

Step 4 Click Refresh. Optical line power statistics for the selected port appear.

Step 5 Click the Optical Chn tab.

Step 6 In the Port field, choose an optical channel port (Table 9-1) whose optical power statistics you want to 
view.

Table 9-1 Channel OADM Optical Line Ports

Port Name

Port Number

AD-1C-xx.x AD-2C-xx.x AD-4C-xx.x

EXP RX 3 5 9

EXP TX 4 6 10

COM RX 5 7 11

COM TX 6 8 12
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Step 7 Click Refresh. Optical channel performance monitoring statistics for the selected port appear.

Step 8 Return to your originating procedure (NTP).

DLP-G143 View Band Optical Add/Drop Multiplexer Power Statistics

Step 1 In node view, double-click the optical AD-xB-xx.x card where you want to view the optical power 
statistics. The card view appears.

Step 2 Click the Performance > Optical Line tabs.

Step 3 In the Port field, choose an optical line port (Table 9-3) whose optical power statistics you want to view.

Table 9-2 Channel OADM Optical Line Ports

Port Name

Port Number

AD-1C-xx.x AD-2C-xx.x AD-4C-xx.x

CHAN RX 1 1 1

CHAN TX 2 2 2

CHAN RX — 3 3

CHAN TX — 4 4

CHAN RX — — 5

CHAN TX — — 6

CHAN RX — — 7

CHAN TX — — 8

Purpose This task enables you to view band optical add/drop channel multiplexer 
minimum, maximum, and average power statistics on an 1-Band OADM 
(AD-1B-xx.x) or the 4-Band OADM (AD-4B-xx.x) card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 9-3 Band OADM Optical Line Ports

Port Name

Port Number

AD-1B-xx.x AD-4B-xx.x

EXP RX 3 9

EXP TX 4 10

COM RX 5 11

COM TX 6 12
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Step 4 Click Refresh. Optical line power statistics for the selected port appear.

Step 5 Click the Optical Band tab.

Step 6 In the Port field, choose an optical band port (Table 9-4) whose optical power statistics you want to view.

Step 7 Click Refresh. Optical channel performance monitoring statistics for the selected port appear.

Step 8 Return to your originating procedure (NTP).

NTP-G75 Monitor Transponder and Muxponder Performance

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node that you want to monitor. If you 
are already logged in, continue with Step 2.

Table 9-4 Band OADM Optical Line Ports

Port Name

Port Number

AD-1B-xx.x AD-4B-xx.x

BAND RX 1 1

BAND TX 2 2

BAND RX — 3

BAND TX — 4

BAND RX — 5

BAND TX — 6

BAND RX — 7

BAND TX — 8

Purpose This procedure enables you to view node near-end or far-end 
performance during selected time intervals on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, 
MXP_2.5G_10G) card and port to detect possible performance 
problems. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 7, “Create Channels 
and Circuits” and Chapter 11, “Change DWDM Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 2 Complete the “DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring” task on 
page 9-19 as needed for any TXP or MXP card, except the TXP_MR_10E and MXP_2.5G_10E cards, 
to enable or disable optical transport network (OTN) ITU-T G.709 monitoring.

Step 3 Complete the “DLP-G145 Enable/Disable OTN FEC Performance Monitoring” task on page 9-20 as 
needed for TXP_MR_10E and MXP_2.5G_10E cards to enable or disable OTN forward error correction 
(FEC) monitoring.

Step 4 Complete the following tasks as needed to view PM parameters:

• DLP-G146 View Optics PM Parameters, page 9-21.

• DLP-G147 View Payload PM Parameters, page 9-22.

• DLP-G148 View OTN PM Parameters, page 9-24.

• DLP-G149 View Payload Statistics PM Parameters, page 9-26.

• DLP-G150 View Payload Utilization PM Parameters, page 9-27.

• DLP-G151 View Payload History PM Parameters, page 9-29.

• DLP-G152 View Payload SONET PM Parameters, page 9-30.

• DLP-G153 Create RMON Alarm Thresholds, page 9-32.

• DLP-G154 Delete RMON Alarm Thresholds, page 9-34.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 9-2.

Stop. You have completed this procedure.

DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring

Step 1 In node view, double-click the card you want to monitor. The card view appears.

Step 2 Determine if the port where you want to enable or disable OTN ITU-T G.709 is in-service (IS). (Click 
the Provisioning > Line tabs, and observe the Service State column for that port.) If it is IS, perform the 
following tasks for that port. If not, go to Step 3.

a. DLP-G108 Change the Service State for a Port, page 7-17 to set the port to OOS,DSBLD.

Purpose This task enables or disables OTN ITU-T G.709 monitoring of near-end 
or far-end performance on a card and port during selected time intervals 
to detect possible problems. This task can be performed for any TXP or 
MXP card except the TXP_MR_10E and MXP_2.5G_10E cards. See the 
“DLP-G145 Enable/Disable OTN FEC Performance Monitoring” task 
on page 9-20 for TXP_MR_10E or MXP_2.5G_10E cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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b. DLP-G185 Delete a GCC Termination, page 10-30, if GCC is provisioned on that port.

Step 3 Click the Provisioning > OTN > OTN Lines tabs.

Step 4 From the G.709 OTN drop-down menu select Enable or Disable to enable or disable ITU-T G.709 for 
that port. (Disable is the default).

Step 5 Click Apply.

Step 6 Click the Performance tab to view PM parameters. For PM parameter definitions, refer to the 
“Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide.

Note If you set the port’s service state to OOS,DSBLD in Step 2, set the port’s service state back to 
IS, and provision GCC for that port according to the “DLP-G76 Provision GCC Terminations” 
procedure on page 7-13.

Step 7 Return to your originating procedure (NTP).

DLP-G145 Enable/Disable OTN FEC Performance Monitoring

Step 1 In node view, double-click the card you want to monitor. The card view appears.

Step 2 Determine if the port where you want to enable or disable FEC is in-service (IS). (Click the Provisioning 
> Line tabs, and observe the Service State column for that port.) If it is IS, perform the following tasks 
for that port. If not, go to Step 3.

a. DLP-G108 Change the Service State for a Port, page 7-17 to set the port to OOS,DSBLD.

b. DLP-G185 Delete a GCC Termination, page 10-30, if GCC is provisioned on that port.

Step 3 Click the Provisioning > OTN > OTN Lines tabs.

Step 4 Make an FEC selection based on the following rules:

• Choose Disable to disable the OTN FEC monitoring.

• Choose Enable to enable standard FEC monitoring for that port (default).

Step 5 Click Apply.

Step 6 Click the Performance tab to view PM parameters. For PM parameter definitions, refer to the 
“Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide.

Purpose This task enables or disables OTN FEC monitoring of node near-end or 
far-end performance on a selected TXP_MR_10E or MXP_2.5G_10E 
card and port during selected time intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
9-20
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 9      Monitor Performance
Before You Begin
Note If you set the port’s service state to OOS,DSBLD in Step 2, set the port’s service state back to 
IS, and provision GCC for that port according to the “DLP-G76 Provision GCC Terminations” 
procedure on page 7-13.

Step 7 Return to your originating procedure (NTP).

DLP-G146 View Optics PM Parameters

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance > Optics PM tabs (Figure 9-6).

Purpose This task enables you to view the optics PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, 
MXP_2.5G_10G) card and port to detect possible performance 
problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-6 Viewing Optics Performance Monitoring Information

Step 3 View the PM parameter names that appear in the Param column of Current Values and History PM tabs. 
The PM parameter values appear in the Curr (current) and Prev-n (previous) columns. For PM parameter 
definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting 
Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 4 Return to your originating procedure (NTP).

DLP-G147 View Payload PM Parameters

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance > Payload PM tabs (Figure 9-7).

Purpose This task enables you to view the payload PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-7 Viewing Payload Performance Monitoring Information 

Step 3 Click to any of the tabs, subtabs, and ports (found in the Ports: drop-down list where available) for that 
card where you want to view the payload PM parameters by clicking on the desired subtab, and choosing 
the port from the Port: drop-down list.

Step 4 View the PM parameter names that appear in the Param column of Current Values and History PM tabs 
The PM parameter values appear in the Curr (current), and Prev-n (previous) columns. For PM parameter 
definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting 
Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note The Payload PMs for data parameters can be viewed only after creating a pluggable port module 
(PPM). See the “NTP-G128 Manage Pluggable Port Modules” procedure on page 5-2 for more 
information about PPMs. 

Note The PM parameters that appear depend on the data payload and framing type provisioned on the 
port. Unframed data payloads such as Enterprise System Connection (ESCON), DV6000, 
DSI/D1 video, and HDTV do not provide payload performance monitoring information. The PM 
parameters that appear also depend on the PPM payload configured. The TXP_MR_10E card 
supports three payloads, the MXP_2.5G_10G and MXP_2.5G_10E cards support the 
OC48/STM16 payload, and the MXP_MR_2.5G and MXPP_MR_2.5G cards support the 1G FC, 
2G FC, 1G FICON, 2G FICON, and 1GE payloads.
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Step 5 Return to your originating procedure (NTP).

DLP-G148 View OTN PM Parameters

Step 1 In node view, double-click the TXP or MXP card where you want to view PM counts. The card view 
appears.

Step 2 Click the Performance > OTN PM > G.709 tabs (Figure 9-8).

Figure 9-8 Viewing OTN ITU-T G.709 Performance Monitoring Information

Purpose This task enables you to view the OTN PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 3 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Curr (current) and Prev-n (previous) columns. For PM parameter definitions, refer to the “Performance 
Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

Step 4 Click the FEC PM tab (Figure 9-9).

Figure 9-9 Viewing OTN FEC Performance Monitoring Information

Step 5 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Curr (current) and Prev-n (previous) columns. For PM parameter definitions, refer to the “Performance 
Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).
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DLP-G149 View Payload Statistics PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > Statistics tabs (Figure 9-10).

Figure 9-10 Statistics Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring statistics appear for each port on the card.

Step 4 View the PM parameter names that appear in the Param column. The current PM parameter values appear 
in the Port # columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in 
the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Purpose This task enables you to view current statistical PM counts on an 
MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 9-2.

Step 5 Return to your originating procedure (NTP).

DLP-G150 View Payload Utilization PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > Utilization tabs (Figure 9-11).

Purpose This task enables you to view line utilization PM counts on an 
MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-11 Utilization Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring utilization values appear for each port on the card.

Step 4 View the Port # column to find the port you want to monitor.

Step 5 The transmit (Tx) and receive (Rx) bandwidth utilization values for the previous time intervals appear 
in the Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in 
the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 9-2.

Step 6 Return to your originating procedure (NTP).
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DLP-G151 View Payload History PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > History tabs (Figure 9-12).

Figure 9-12 History Tab on the Card View Performance Window

Step 3 Select the desired port from the Port: drop-down list.

Step 4 Click Refresh. Performance monitoring statistics appear for the selected port.

Step 5 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Purpose This task enables you to view historical PM counts at selected time 
intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 9-2.

Step 6 Return to your originating procedure (NTP).

DLP-G152 View Payload SONET PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > SONET PM tabs (Figure 9-13).

Purpose This task enables you to view SONET PM counts at selected time 
intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 9-13 SONET PM Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring statistics appear for the selected port.

Step 4 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note The MXP_MR_2.5G and MXPP_MR_2.5G cards support only the OC48/STM16 payload. Each 
payload has a set of PM parameters.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 9-2.

Step 5 Return to your originating procedure (NTP).
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DLP-G153 Create RMON Alarm Thresholds

Step 1 In node view, double-click the card where you want to create the RMON alarm thresholds.

Step 2 In card view, click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Slot menu, choose the appropriate card.

Step 5 From the Port: drop-down list, choose the applicable port on the card you selected.

Step 6 From the Variable drop-down list, choose the variable. See Table 9-5 for a list of the 
MXP_MR_2.5G/MXPP_MR_2.5G threshold variables available in this field.

Purpose This procedure sets up remote monitoring (RMON) to allow network 
management systems to monitor Ethernet and Fibre Channel ports. This 
procedure applies to MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, 
and TXPP_MR_2.5G cards in GE/FC/FICON/ISC compact mode, and 
MXP_2.5G_10G, TXP_MR_10G, MXP_2.5G_10E, and TXP_MR_10E 
cards in Gigabit Ethernet (10GE) mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 9-5 MXP_MR_2.5G/MXPP_MR_2.5G Threshold Variables (MIBs)

Variable Definition

iflnOctets Total number of octets received on the interface, including 
framing octets

 ifInDiscards The number of inbound packets that were chosen to be discarded 
even though no errors had been detected to prevent their being 
deliverable to a higher-layer protocol

iflnErrors Number of inbound packets discarded because they contain 
errors

ifOutOctets Total number of transmitted octets, including framing packets

ifOutDiscards The number of outbound packets that were chosen to be 
discarded even though no errors had been detected to prevent 
their being transmitted

txTotalPkts Total number of transmit packets

rxTotalPkts Total number of receive packets

mediaIndStatsRxFramesTooLong Number of packets transmitted that are greater than 1548 bytes

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes

mediaIndStatsRxFramesBadCRC Total number of frames received with a cyclic redundancy check 
(CRC) error

mediaIndStatsTxFramesBadCRC Total number of frames transmitted with a CRC error
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Step 7 From the Alarm Type drop-down list, indicate whether the rising threshold, falling threshold, or both the 
rising and falling thresholds will trigger the event.

Step 8 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 9 Enter the appropriate number of seconds for the Sample Period.

Step 10 Enter the appropriate number of occurrences for the Rising Threshold.

Note For a rising type of alarm, the measured value must move from below the falling threshold to 
above the rising threshold. For example, if a network is running below a rising threshold of 
1000 collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess 
occurrences trigger an alarm. 

Step 11 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases, a falling 
threshold is set lower than the rising threshold. 

Note A falling threshold is the counterpart to a rising threshold. When the number of occurrences is 
above the rising threshold and then drops below a falling threshold, it resets the rising threshold. 
For example, when the network problem that caused 1001 collisions in 15 minutes subsides and 
creates only 799 collisions in 15 minutes, occurrences fall below a falling threshold of 800 
collisions. This resets the rising threshold so that if network collisions again spike over a 1000 
per 15-minute period, an event again triggers when the rising threshold is crossed. An event is 
triggered only the first time a rising threshold is exceeded (otherwise, a single network problem 
might cause a rising threshold to be exceeded multiple times and cause a flood of events). 

Step 12 Click OK to complete the procedure.

Step 13 Return to your originating procedure (NTP).

8b10bInvalidOrderedSets Total number of ordered sets not complaint to GE/FC (Gigabit 
Ethernet/Fibre Channel) standard

8b10bStatsEncodingDispErrors Total number of code groups that violate GE/FC disparity errors

Table 9-5 MXP_MR_2.5G/MXPP_MR_2.5G Threshold Variables (MIBs) (continued)

Variable Definition
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DLP-G154 Delete RMON Alarm Thresholds

Step 1 In node view, double-click the card where you want to delete the RMON alarm thresholds.

Step 2 In card view, click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Step 3 Click the RMON alarm threshold you want to delete.

Step 4 Click Delete. The Delete Threshold dialog box appears. 

Step 5 Click Yes to delete that threshold.

Step 6 Return to your originating procedure (NTP).

Purpose This task deletes RMON threshold crossing alarms for Ethernet and 
Fibre Channel ports.

Tools/Equipment None

Prerequisite Procedures DLP-G153 Create RMON Alarm Thresholds, page 9-32

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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C H A P T E R 10

Manage the Node

This chapter explains how to modify node provisioning for the Cisco ONS 15454 and perform common 
management tasks such as monitoring the dense wavelength division multiplexing (DWDM) automatic 
power control (APC) and span loss values. To provision a new node, see Chapter 3, “Turn Up a Node.” 
To change default network element settings and to view a list of those settings, refer to the “Network 
Element Defaults” appendix. 

Note Unless otherwise specified, “ONS 15454” refers to both American National Standards Institute (ANSI) 
and European Telecommunications Standards Institute (ETSI) shelf assemblies.

Before You Begin
Before performing the following procedures, investigate all alarms and clear any trouble conditions. 
Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting 
Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G76 Verify Span Loss, page 10-2—Complete this procedure as needed to view or modify the 
DWDM span loss values. 

2. NTP-G77 Manage Automatic Power Control, page 10-3—Complete this procedure as needed to 
manage the DWDM APC.

3. NTP-G78 View ROADM Node Power Equalization, page 10-5—Complete this procedure as needed 
to view and update a reconfigurable optical add/drop multiplexing (ROADM) node’s power 
equalization. 

4. NTP-G80 Change Node Management Information, page 10-6—Complete this procedure as needed 
to change node name, contact information, latitude, longitude, date, time, and login legal disclaimer.

5. NTP-G81 Change CTC Network Access, page 10-9—Complete this procedure as needed to change 
the IP address, default router, subnet mask, network configuration settings, and static routes.

6. NTP-G82 Customize the CTC Network View, page 10-16—Complete this procedure as needed to 
create domains and customize the appearance of the network map, including specifying a different 
default map, creating domains, selecting your own map or image, and changing the background 
color.

7. NTP-G83 Modify or Delete Card Protection Settings, page 10-21—Complete this procedure as 
needed.
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8. NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands, page 
10-24—Complete this procedure as needed.

9. NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords, 
page 10-28—Complete this procedure as needed to modify or delete generic communications 
channel (GCC) and optical service channel (OSC) terminations, and provisionable patchcords.

10. NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection, page 10-32—Complete 
this procedure as needed to convert a pass-through connection to an add/drop connection.

11. NTP-G87 Change Node Timing Parameters, page 10-33—Complete this procedure as needed.

12. NTP-G88 Modify Users and Change Security, page 10-35—Complete this procedure as needed to 
make changes to user settings, including security level and security policies, and to delete users.

13. NTP-G131 Convert DWDM Nodes to Hybrid Nodes, page 10-43—Complete this procedure as 
needed to convert a DWDM node to a hybrid node.

14. NTP-G89 Change SNMP Settings, page 10-46—Complete this procedure as needed.

NTP-G76 Verify Span Loss

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G155 Verify Optical Span Loss Using CTC” task on page 10-2 to check span loss 
using CTC. This task is faster than a span loss measurement using an optical time domain reflectometer 
(OTDR) and does not require fibers to be removed. However, the resolution is not as precise as an OTDR 
measurement.

Stop. You have completed this procedure.

DLP-G155 Verify Optical Span Loss Using CTC

Purpose This procedure verifies the span loss between two DWDM nodes using 
Cisco Transport Controller (CTC). You perform this procedure after a node 
or network modification has occurred and you want to verify that the span 
loss between the nodes have not changed.

Tools/Equipment None

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node” and Chapter 6, “Turn Up 
Network.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies span loss values between two DWDM nodes using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24
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Step 1 In node view, click the Provisioning > Comm Channels > OSC tabs. Verify that two OSC terminations 
are provisioned and have an In-Service and Normal (IS-NR) (ANSI) or Unlocked-enabled (ETSI) 
service state. 

Step 2 Click the Maintenance > DWDM > WDM Span Check tabs. 

Step 3 Click Retrieve Span Loss Values to retrieve the latest span loss data.

Step 4 View the following information:

• Side—Shows the side to which the span loss values apply, either east or west.

• Min Expected Span Loss (dBm)—Shows the expected minimum span loss (in dBm). You can change 
the minimum by entering a new value in the field.

• Meas Span Loss (dBm)—Shows the measured span loss (in dBm).

• Max Expected Span Loss (dBm)—Shows the expected maximum span loss (in dBm). You can 
change the minimum by entering a new value in the field.

Note The minimum and maximum expected span loss values are calculated by 
Cisco MetroPlanner and imported to the node when you perform the “NTP-G138 Import a 
Cisco MetroPlanner Configuration File” task on page 3-72.

• Resolution (dBm)—Shows the resolution of the span loss measurement (in dBm):

– +/– 1.5 dB for measured span losses between 0 and 25 dB

– +/– 2.5 dB for measured span losses between 25 and 38 dB

If the measured span loss is not between the minimum and maximum expected span loss, contact your 
site planner for further instructions.

Step 5 Return to your originating procedure (NTP).

NTP-G77 Manage Automatic Power Control 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This procedure manages the DWDM automatic power control (APC). 

Tools/Equipment None

Prerequisite Procedures All procedures in the following chapters:

Chapter 3, “Turn Up a Node”

Chapter 6, “Turn Up Network”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the following tasks as necessary:

• DLP-G157 Disable Automatic Power Control, page 10-4

• DLP-G158 Enable Automatic Power Control, page 10-4

• DLP-G159 Refresh Automatic Power Control Information, page 10-5

Stop. You have completed this procedure.

DLP-G157 Disable Automatic Power Control 

Caution Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC 
as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1 In node view, click the Maintenance > DWDM > APC tabs. 

Step 2 Click Disable APC.

Step 3 Verify that the APC State in the information window at the top left of the CTC window changes to 
Disable- user.

Step 4 Return to your originating procedure (NTP).

DLP-G158 Enable Automatic Power Control 

Purpose This task disables the DWDM APC. 

Tools/Equipment None

Prerequisite Procedures All procedures in the following chapters:

• Chapter 3, “Turn Up a Node”

• Chapter 6, “Turn Up Network”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task enables the DWDM APC. 

Tools/Equipment None

Prerequisite Procedures All procedures in the following chapters:

Chapter 3, “Turn Up a Node”

Chapter 6, “Turn Up Network”

Required/As Needed As needed
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Caution Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC 
as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1 In node view, click the Maintenance > DWDM > APC tabs. 

Step 2 Click Enable APC. 

Step 3 Verify that the APC State in the information window at the top left of the CTC window changes to 
Enable.

Step 4 Return to your originating procedure (NTP).

DLP-G159 Refresh Automatic Power Control Information

Step 1 In node view, click the Maintenance > DWDM > APC tabs. 

Step 2 Click Refresh.

Step 3 Return to your originating procedure (NTP).

NTP-G78 View ROADM Node Power Equalization

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task refreshes the DWDM APC information. 

Tools/Equipment None

Prerequisite Procedures All procedures in the following chapters:

Chapter 3, “Turn Up a Node”

Chapter 6, “Turn Up Network”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This procedure allows you to view reconfigurable optical add/drop 
multiplexing (ROADM) node power equalization levels. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 In node view, click the Maintenance > DWDM > ROADM Power Monitoring tabs.

Step 3 On the Power Monitoring tab, view the following east-to-west (E > W) and west-to-east (W > E) power 
information:

• Padd—Add power. This power level is represented by the red bar.

• Ppt—Pass-through power. This power level is represented by the yellow bar.

• Pout—Output power. This power level is represented by the blue bar. It shows the per-channel 
(wavelength) power at the 32-WSS output (COM_TX) port.

Note The 32-WSS is designed to handle minor differences in output power. The output power does 
not need to be exactly the same for all wavelengths.

Figure 10-1 shows an example of ROADM node with equalized output power.

Figure 10-1 Equalized ROADM Power Example

Step 4 If needed, click Refresh to update the display.

Stop. You have completed this procedure.

NTP-G80 Change Node Management Information

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Purpose This procedure changes the node name, date, time, contact information, 
and login legal disclaimer.

Tools/Equipment None

Prerequisite Procedures NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-8

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Complete the “DLP-G160 Change the Node Name, Date, Time, and Contact Information” task on 
page 10-7, as needed.

Step 4 Complete the “DLP-G161 Change the Login Legal Disclaimer” task on page 10-8, as needed.

Step 5 After confirming the changes, complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

DLP-G160 Change the Node Name, Date, Time, and Contact Information

Caution Changing the date, time, or time zone might invalidate the node’s performance monitoring counters.

Step 1 In node view, click the Provisioning > General > General tabs.

Step 2 Change any of the following:

• General: Node Name 

• General: Contact 

• Location: Latitude 

• Location: Longitude 

• Location: Description 

Note To see changes to longitude or latitude on the network map, you must go to network view 
and right-click the specified node, then click Reset Node Position.

• Time: Use NTP/SNTP Server

• Time: Date (M/D/Y)

• Time: Time (H:M:S)

• Time: Time Zone

• Time: Use Daylight Saving Time

• AIS-V Insertion On STS-1 Signal Degrade - Path: Insert AIS-V on STS-1 SD-P

• AIS-V Insertion On STS-1 Signal Degrade - Path: SD-P BER 

Purpose This task changes basic information such as node name, date, time, and 
contact information.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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See the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 for 
detailed field descriptions.

Step 3 Click Apply.

Step 4 Return to your originating procedure (NTP).

DLP-G161 Change the Login Legal Disclaimer

Step 1 In node view, click the Provisioning > Security > Legal Disclaimer > HTML tabs.

Step 2 The existing statement is a default, non-customer-specific disclaimer. If you want to edit this statement 
with specifics for your company, you can change the text. Use the HTML commands in Table 10-1 to 
format the text, as needed.

Step 3 If you want to preview your changed statement and formatting, click the Preview subtab.

Step 4 Click Apply.

Purpose This task modifies the legal disclaimer statement shown in the CTC login 
dialog box so that it will display customer-specific information when users 
log into the network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Table 10-1 HTML Commands for the Legal Disclaimer

Command Description

<b> Begins boldface font

</b> Ends boldface font

<center> Aligns type in the center of the window

</center> Ends the center alignment

<font=n> (where n = font point size) Changes the font to the new size

</font> Ends the font size command

<p> Creates a line break

<sub> Begins subscript

</sub> Ends subscript

<sup> Begins superscript

</sup> Ends superscript

<u> Begins underline

</u> Ends underline
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Step 5 Return to your originating procedure (NTP).

NTP-G81 Change CTC Network Access

Note Additional ONS 15454 networking information and procedures, including IP addressing examples, static 
route scenarios, OSPF protocol, and routing information protocol options are provided in Chapter 20, 
“CTC Connectivity Reference.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2. 

Step 3 Perform any of the following tasks as needed:

• DLP-G162 Change IP Settings, page 10-10

• DLP-G265 Lock Node Security, page 10-11

• DLP-G266 Modify Backplane Port IP Settings, page 10-11

• DLP-G267 Disable Node Security Mode, page 10-12

• DLP-G163 Modify a Static Route, page 10-13

• DLP-G164 Delete a Static Route, page 10-14

• DLP-G165 Disable OSPF, page 10-14

• DLP-G59 Set Up or Change Open Shortest Path First Protocol, page 3-18

• DLP-G166 Delete a Proxy Tunnel, page 10-15

• DLP-G167 Delete a Firewall Tunnel, page 10-15

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

Purpose This procedure changes or deletes network information, including IP 
settings, static routes, Open Shortest Path First (OSPF) options, proxy 
tunnels, and firewall tunnels.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 3-10

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G162 Change IP Settings

Caution Changing the node IP address, subnet mask, or IIOP listener port causes the TCC2/TCC2Ps to reboot. If 
Ethernet circuits using Spanning Tree Protocol (STP) originate or terminate on E-Series Ethernet cards 
installed in the node, circuit traffic will be lost for several minutes while the spanning trees reconverge. 
Other circuits are not affected by TCC2/TCC2P reboots.

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 Change any of the following, as required:

• IP Address

• Net/Subnet Mask Length

• Default Router

• LCD IP Setting

• Suppress CTC IP Display

• Forward DHCP Request To

• TCC CORBA (IIOP) Listener Port

• Gateway Settings

See the “DLP-G56 Provision IP Settings” task on page 3-11 for detailed field descriptions.

Step 3 Click Apply.

If you changed a network field that will cause the node to reboot, such as the IP address, subnet mask, 
or TCC Common Object Request Broker Architecture (CORBA) Listener Port, the Change Network 
Configuration confirmation dialog box appears. If you changed a gateway setting, a confirmation 
appropriate to the gateway field appears.

Step 4 If a confirmation dialog box appears, click Yes.

If you changed an IP address, subnet mask length, or TCC CORBA (IIOP) Listener Port, both 
ONS 15454 TCC2/TCC2P cards will reboot, one at a time. A TCC2/TCC2P card reboot causes a 
temporary loss of connectivity to the node, but traffic is unaffected. 

Step 5 Confirm that the changes appear on the Provisioning > Network > General tab. If not, refer to the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide as 
necessary.

Purpose This task changes the IP address, subnet mask, default router, Dynamic 
Host Configuration Protocol (DHCP) access, firewall Internet Inter-Object 
Request Broker Protocol (IIOP) listener port, LCD IP display, and proxy 
server settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G56 Provision IP Settings, page 3-11

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 6 Return to your originating procedure (NTP).

DLP-G265 Lock Node Security

Caution This task is irreversible. Do not proceed unless you want the node to permanently have two IP addresses.

Note The options in this task are available only when using TCC2P cards.

Step 1 In node view, click the Provisioning > Security > Data Comm tabs. 

Step 2 Click Lock.

Step 3 In the Confirm Lock Secure Mode dialog box, click Yes. 

Step 4 Return to your originating procedure (NTP).

DLP-G266 Modify Backplane Port IP Settings

Purpose This task locks the ONS 15454 security mode. When security mode is 
locked, two IP addresses must always be provisioned for the node, one for 
the TCC2P LAN (TCP/IP) port, and one for the backplane LAN port.

Tools/Equipment TCC2P cards must be installed.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G264 Enable Node Security Mode, page 3-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task modifies the ONS 15454 backplane IP address, subnet mask, and 
default router. It also modifies settings that control backplane IP address 
visibility in CTC and the ONS 15454 LCD. To perform this task, secure 
mode must be enabled. 

Tools/Equipment TCC2P cards must be installed.

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

DLP-G46 Log into CTC, page 2-24

DLP-G264 Enable Node Security Mode, page 3-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Caution Provisioning an IP address that is incompatible with the ONS 15454 network might be service affecting.

Note The options in this task are available only when using the TCC2P cards.

Step 1 Click the Provisioning > Security > Data Comm tabs. 

Step 2 Modify the following fields, as necessary:

• IP Address

• Subnet Mask

• Default Router

• LCD IP Setting—choose one of the following:

– Allow Configuration—Displays the backplane IP address on the LCD and allows it to be 
changed using the LCD buttons.

– Display only—Displays the backplane IP address on the LCD but does not allow it to be 
changed using the LCD buttons.

– Suppress Display—Suppresses the display of the IP address on the LCD.

• Suppress CTC IP Address—If checked, suppresses the IP address from display on the Data Comm 
subtab, CTC node view information area, and other locations.

Step 3 Click Apply.

If you changed the IP address, subnet mask, or default router, the node will reboot. This will take 5 to 
10 minutes.

Step 4 Return to your originating procedure (NTP).

DLP-G267 Disable Node Security Mode

Note The node will reboot after you complete this task, causing a temporary disconnection between the CTC 
computer and the node.

Purpose This task disables the ONS 15454 security mode and allows only one IP 
address to be provisioned for the backplane LAN port and the TCC2P LAN 
port. 

Tools/Equipment TCC2P cards must be installed.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G264 Enable Node Security Mode, page 3-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note The options in this task are available only when using TCC2P cards.

Step 1 Click the Provisioning > Security > Data Comm tabs. 

Step 2 Click Change Mode.

Step 3 Review the information on the Change Secure Mode wizard page, then click Next.

Step 4 On the Node IP Address page, choose the address you want to assign to the node:

• Backplane Ethernet Port—Assigns the backplane IP address as the node IP address.

• TCC Ethernet Port—Assigns the TCC2P port IP address as the node IP address.

• New IP Address—Allows you to define a new IP address. If you choose this option, enter the new 
IP address, subnet mask, and default router IP address.

Step 5 Click Next.

Step 6 On the SOCKS Proxy Server Settings page, choose one of the following:

• External Network Element (ENE)—If selected, the CTC computer is only visible to the 
ONS 15454 to which the CTC computer is connected. The computer is not visible to the data 
communications channel (DCC)-connected nodes. In addition, firewall is enabled, which means that 
the node prevents IP traffic from being routed between the DCC and the LAN port. 

• Gateway Network Element (GNE)—If selected, the CTC computer is visible to other 
DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the 
LAN port. 

• Proxy-only—If selected, the ONS 15454 responds to CTC requests with a list of DCC-connected 
nodes for which the node serves as a proxy. The CTC computer is visible to other DCC-connected 
nodes. The node does not prevent traffic from being routed between the DCC and LAN port. 

Step 7 Click Finish.

Within the next 30 to 40 seconds, the TCC2Ps reboot. CTC switches to network view, and the CTC Alerts 
dialog box appears. In network view, the node changes to grey and a DISCONNECTED condition 
appears. 

Step 8 In the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This might take several 
minutes.) 

Step 9 Return to your originating procedure (NTP).

DLP-G163 Modify a Static Route

Purpose This task modifies a static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G58 Create a Static Route, page 3-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Click the Static Routing tab. 

Step 3 Click the static route you want to edit. 

Step 4 Click Edit.

Step 5 In the Edit Selected Static Route dialog box, enter the following: 

• Mask

• Next Hop

• Cost

See the “DLP-G58 Create a Static Route” task on page 3-17 for detailed field descriptions.

Step 6 Click OK.

Step 7 Return to your originating procedure (NTP).

DLP-G164 Delete a Static Route

Step 1 In node view, click the Provisioning > Network > Static Routing tabs.

Step 2 Click the static route that you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. 

Step 5 Return to your originating procedure (NTP).

DLP-G165 Disable OSPF

Purpose This task deletes an existing static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G58 Create a Static Route, page 3-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task disables the OSPF routing protocol process for an ONS 15454 
LAN.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G59 Set Up or Change Open Shortest Path First Protocol, page 3-18
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Step 1 In node view, click the Provisioning > Network > OSPF tabs. The OSPF subtab has several options.

Step 2 In the OSPF on LAN area, uncheck the OSPF active on LAN check box.

Step 3 Click Apply. Confirm that the changes appear.

Step 4 Return to your originating procedure (NTP).

DLP-G166 Delete a Proxy Tunnel

Step 1 Click the Provisioning > Network > Proxy subtabs.

Step 2 Click the proxy tunnel that you want to delete.

Step 3 Click Delete.

Step 4 Continue with your originating procedure (NTP).

DLP-G167 Delete a Firewall Tunnel

Step 1 Click the Provisioning > Network > Firewall subtabs.

Step 2 Click the firewall tunnel that you want to delete.

Step 3 Click Delete.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task removes a proxy tunnel.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G97 Provision a Proxy Tunnel, page 7-14

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task removes a firewall tunnel. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 4 Return to your originating procedure (NTP).

NTP-G82 Customize the CTC Network View

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the following tasks, as needed: 

• DLP-G168 Change the Network View Background Color, page 10-16

• DLP-G169 Change the Default Network View Background Map, page 10-17

• DLP-G170 Apply a Custom Network View Background Map, page 10-18

• DLP-G171 Create Domain Icons, page 10-18

• DLP-G172 Manage Domain Icons, page 10-19

• DLP-G173 Enable Dialog Box Do-Not-Display Option, page 10-20

• DLP-G174 Switch Between TDM and DWDM Network Views, page 10-21

Stop. You have completed this procedure.

DLP-G168 Change the Network View Background Color

Purpose This procedure modifies the CTC network view, including grouping nodes 
into domains for a less-cluttered display, changing the network view 
background color, and using a custom image for the network view 
background.

Tools/Equipment None

Prerequisite Procedures None

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the network view background color or the domain view 
background color (the area displayed when you open a domain). 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note If you modify background colors, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the View menu in CTC, choose Go to Network View.

Step 2 If you want to change a domain background, double-click the domain. If not, continue with Step 3.

Step 3 Right-click the network view or domain map area and choose Set Background Color from the shortcut 
menu. 

Step 4 In the Choose Color dialog box, select a background color.

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

DLP-G169 Change the Default Network View Background Map

Note If you modify the background image, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the Edit menu, choose Preferences > Map and check the Use Default Map check box.

Step 2 Click Apply.

Step 3 Click OK. Verify that the United States map is displayed.

Step 4 In the network view, double-click on any node on the map.

Step 5 In the node view, click the Provisioning > Defaults tabs.

Step 6 In the Defaults Selector area, choose CTC and then network. (You may have to scroll down on the list 
to find “network.”)

Step 7 Click the Default Value field and choose a default map from the drop-down list. Map choices are 
Germany, Japan, Netherlands, South Korea, United Kingdom, and the United States.

Step 8 Click Apply. 

Step 9 Click OK.

Step 10 From the View menu, select Go to Network View. Confirm that the new map is displayed.

Step 11 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat until 
all the ONS 15454 icons are visible. (You can also choose Fit Graph to Window.)

Purpose This task changes the default map of the CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 12 If you need to reposition the node icons, hold down the Ctrl key while you drag and drop them one at a 
time to a new location on the map.

Step 13 If you want to change the magnification of the network view map and icons, right-click the network view 
and choose Zoom In. Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 14 Return to your originating procedure (NTP).

DLP-G170 Apply a Custom Network View Background Map

Note You can replace the network view background image with any JPEG or GIF image that is accessible on 
a local or network drive. If you apply a custom background image, the change is stored in your CTC user 
profile on the computer. The change does not affect other CTC users.

Step 1 From the Edit menu, choose Preferences > Map and uncheck the Use Default Map check box.

Step 2 From the View menu, choose Go to Network View.

Step 3 Right-click the network or domain map and choose Set Background Image.

Step 4 Click Browse. Navigate to the graphic file you want to use as a background.

Step 5 Select the file. Click Open.

Step 6 Click Apply and then click OK.

Step 7 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat this 
step until all the ONS 15454 icons are visible.

Step 8 If you need to reposition the node icons, hold down the Ctrl key while you drag and drop them one at a 
time to a new location on the map.

Step 9 If you want to change the magnification of the network view map and icons, right-click the network view 
and choose Zoom In. Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 10 Return to your originating procedure (NTP).

DLP-G171 Create Domain Icons 

Purpose This task changes the background image or map of the CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task creates a domain, which is an icon that groups ONS 15454 icons 
in CTC network view.

Tools/Equipment None
10-18
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 10      Manage the Node
Before You Begin
Note Domains created by one user are visible to all users who log into the network.

Step 1 From the View menu, choose Go to Network View.

Step 2 Right-click the network map and choose Create New Domain from the shortcut menu. 

Step 3 When the domain icon appears on the map, click the map name and type the domain name.

Step 4 Press Enter.

Step 5 Return to your originating procedure (NTP).

DLP-G172 Manage Domain Icons 

Note All domain changes, such as added or removed nodes, are visible to all users who log into the network.

Step 1 From the View menu, choose Go to Network View.

Step 2 Locate the domain action that you want to perform in Table 10-2 and complete the appropriate steps.

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task manages CTC network view domain icons.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

DLP-G171 Create Domain Icons, page 10-18

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-2 Managing Domains

Domain Action Steps

Move a domain Press Ctrl and drag and drop the domain icon to the new location.

Rename a domain Right-click the domain icon and choose Rename Domain from the shortcut 
menu. Type the new name in the domain name field.

Add a node to a 
domain

Drag and drop the node icon to the domain icon.

Move a node from a 
domain to the 
network map

Open the domain and right-click a node. Choose Move Node Back to Parent 
View.
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Step 3 Return to your originating procedure (NTP).

DLP-G173 Enable Dialog Box Do-Not-Display Option

Note If any user who has rights to perform an operation (for example, creating a circuit) selects the “Do not 
show this message again” check box in a dialog box, the dialog box is not displayed for any other users 
who perform that operation on the network from the same computer unless the command is overridden 
using the following task. (The preference is stored on the computer, not in the node database.)

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the General tab.

The Preferences Management area field lists all dialog boxes where “Do not show this message again” 
is enabled. 

Step 3 Choose one of the following options, or uncheck the individual dialog boxes that you want to appear:

• Don’t Show Any—Hides all do-not-display check boxes.

• Show All—Overrides do-not-display check box selections and displays all dialog boxes.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

Open a domain • Double-click the domain icon, or

• Right-click the domain and choose Open Domain.

Return to network 
view

Right-click the domain view area and choose Go to Parent View from the 
shortcut menu.

Preview domain 
contents

Right-click the domain icon and choose Show Domain Overview. The domain 
icon shows a small preview of the nodes in the domain. To turn off the domain 
overview, right-click the overview and select Show Domain Overview.

Remove domain Right-click the domain icon and choose Remove Domain. Any nodes in the 
domain are returned to the network map.

Purpose This task ensures that a user-selected do-not-display dialog box preference 
is enabled for subsequent sessions or to disable the do-not-display option. 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-2 Managing Domains (continued)

Domain Action Steps
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DLP-G174 Switch Between TDM and DWDM Network Views

Step 1 From the View menu, choose Go to Network View.

Step 2 From the Network Scope drop-down list on the toolbar located in the upper right portion of the CTC 
window, choose one of the following:

• All—Displays both TDM and DWDM nodes.

• TDM—Displays only ONS 15454s with SONET or SDH cards including the transponder and 
muxponder cards.

• DWDM—Displays only ONS 15454s with DWDM cards, including the transponder and muxponder 
cards.

Step 3 Return to your originating procedure (NTP).

NTP-G83 Modify or Delete Card Protection Settings

Caution Modifying and deleting protection groups can be service affecting.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Perform any of the following tasks as needed:

• DLP-G175 Modify a Y-Cable Protection Group, page 10-22

• DLP-G176 Modify a Splitter Protection Group, page 10-23

• DLP-G177 Delete a Y-Cable Protection Group, page 10-23

Step 3 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Purpose Use this task to switch between time division multiplexing (TDM) and 
DWDM network views.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-24

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This procedure modifies and deletes card protection settings.

Tools/Equipment None

Prerequisite Procedures NTP-G33 Create a Y-Cable Protection Group, page 3-36

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Stop. You have completed this procedure.

DLP-G175 Modify a Y-Cable Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the Y-cable protection group that you want to modify. 

Step 3 Click Edit.

Step 4 In the Selected Group area, you can modify the following, as needed:

• Name—Type the changes to the protection group name. The name can have up to 32 alphanumeric 
characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you 
do not want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is 
the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

Step 5 Click OK. Confirm that the changes appear.

Step 6 Return to your originating procedure (NTP).

Purpose This task modifies a Y-cable protection group for any client port on a 
MXP_2.5G_10G, TXP_MR_2.5G, or TXP_MR_10G card.

Tools/Equipment None

Prerequisite Procedures NTP-G33 Create a Y-Cable Protection Group, page 3-36

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G176 Modify a Splitter Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the splitter protection group that you want to modify. 

Step 3 Click Edit.

Step 4 In the Selected Group area, you can modify the following, as needed:

• Name—Type the changes to the protection group name. The name can have up to 32 alphanumeric 
characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you 
do not want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is 
the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

Step 5 Click OK. Confirm that the changes appear.

Step 6 Return to your originating procedure (NTP).

DLP-G177 Delete a Y-Cable Protection Group 

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the protection group you want to delete.

Step 3 Click Delete.

Purpose This task modifies a splitter protection group for any client port on a 
TXPP_MR_2.5G or MXPP_MR_2.5G card. Splitter protection is 
automatically created when the TXPP or MXPP card is installed.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes a Y-cable protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Yes in the Delete Protection Group dialog box. Confirm that the changes appear.

Step 5 Return to your originating procedure (NTP).

NTP-G84 Initiate and Clear Y-Cable and Splitter External 
Switching Commands

Note Splitter protection groups are automatically created when you install a TXPP_MR_2.5G or 
MXPP_MR_2.5G card.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 To perform a Manual protection switch, complete the “DLP-G178 Apply a Manual Y-Cable or Splitter 
Protection Switch” task on page 10-25. 

Step 3 To perform a Force protection switch, complete the “DLP-G179 Apply a Force Y-Cable or Splitter 
Protection Switch” task on page 10-25. 

Step 4 To clear a Force or Manual protection switch, complete the “DLP-G180 Clear a Manual or Force Y-Cable 
or Splitter Protection Switch” task on page 10-26.

Step 5 To prevent traffic on a working or protect card from switching to the other card in the pair, complete the 
“DLP-G181 Apply a Lock-On” task on page 10-26.

Step 6 To prevent traffic from switching to the protect card, complete the “DLP-G182 Apply a Lockout” task 
on page 10-27.

Step 7 To remove a lock-on or lockout and return a protection group to its usual switching method, complete 
the “DLP-G183 Clear a Lock-On or Lockout” task on page 10-28.

Stop. You have completed this procedure.

Purpose This procedure describes how to apply and remove Manual and Force 
protection switches on Y-cable and splitter protection groups. It also 
describes how to apply and remove a Lock On or Lock Out protection 
command to a Y-cable protection group.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

NTP-G33 Create a Y-Cable Protection Group, page 3-36 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch

Caution A Manual switch will move traffic from the active to the standby card only if network conditions permit 
it. If conditions change during the switch, CTC will attempt to place traffic back on the original active 
card. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the 
Manual protection switch.

Step 3 In the Selected Group area, click the active card or port.

Step 4 In the Switch Commands area, click Manual.

Step 5 In the Confirm Manual Operation dialog box, click Yes.

If conditions permit, the Manual switch will be applied. To clear the Manual switch, see the “DLP-G180 
Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-26.

Step 6 Return to your originating procedure (NTP).

DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch

Caution A Force switch will move traffic from the active to the standby card or port immediately, regardless of 
network conditions. The switch will remain in effect until it is cleared. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the 
Force protection switch.

Purpose This task performs a Manual protection switch on a Y-cable or splitter 
protection group. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task performs a Force protection switch on a Y-cable or splitter 
protection group. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 3 In the Selected Group area, click the active card or port.

Step 4 In the Switch Commands drop-down list, click Force.

Step 5 In the Confirm Manual Operation dialog box, click Yes.

The Force switch will be applied. To clear the Force switch, see the “DLP-G180 Clear a Manual or Force 
Y-Cable or Splitter Protection Switch” task on page 10-26.

Step 6 Return to your originating procedure (NTP).

DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group area, click the card that you want to clear.

Step 4 In the Switch Commands drop-down list, click Clear.

Step 5 Click Yes in the confirmation dialog box.

The Manual or Force protection switch is cleared.

Step 6 Return to your originating procedure (NTP).

DLP-G181 Apply a Lock-On

Purpose This task clears a Manual or Force protection switch on a Y-Cable or 
splitter protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch, page 
10-25 or

DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch, page 
10-25

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance or higher

Purpose This task prevents traffic from being switched from the working/active 
card in a Y-cable protection group or port in a splitter protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed
10-26
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 10      Manage the Node
Before You Begin
Note You can apply the Lock On command only to the working/active card or port. If the working card or port 
is standby (traffic is switched), the Lock Out button is grayed.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card (Y-cable) or port (splitter) 
that you want to lock on.

Step 3 In the Selected Group area, click the working/active card.

Step 4 In the Inhibit Switching drop-down list, click Lock On.

Step 5 Click Yes in the confirmation dialog box.

The lock on has been applied. Traffic cannot switch to the protect card. To clear the lock on, see the 
“DLP-G183 Clear a Lock-On or Lockout” task on page 10-28.

Note Provisioning a lock on raises a LOCKON-REQ or an FE-LOCKON condition in CTC. Clearing 
the lockout switch request clears these conditions.

Step 6 Return to your originating procedure (NTP).

DLP-G182 Apply a Lockout

Note You can apply the lockout to the protect/standby card or port. If the protect card or port is active (traffic 
is switched), the lockout task cannot be performed.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card (Y-cable) or port (splitter) 
that you want to lock out.

Step 3 In the Selected Group area, click the protect/standby card.

Step 4 In the Inhibit Switching drop-down list, click Lock Out.

Step 5 Click Yes in the confirmation dialog box.

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task keeps traffic from switching to the protect/standby card or 
port. The Lock Out command overrides the Force and Manual switching 
commands.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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The lockout has been applied. Traffic cannot switch to the protect card. To clear the lockout, see the 
“DLP-G183 Clear a Lock-On or Lockout” task on page 10-28.

Note Provisioning a lockout raises a LOCKOUT-REQ or an FE-LOCKOUT condition in CTC. 
Clearing the lockout switch request clears these conditions.

Step 6 Return to your originating procedure (NTP).

DLP-G183 Clear a Lock-On or Lockout

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group area, click the card you want to clear.

Step 4 In the Inhibit Switching drop-down list, click Unlock.

Step 5 Click Yes in the confirmation dialog box.

The lock on or lockout is cleared.

Step 6 Return to your originating procedure (NTP).

NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, 
and Provisionable Patchcords

Purpose This task clears a lock-on or lockout.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G181 Apply a Lock-On, page 10-26 or

DLP-G182 Apply a Lockout, page 10-27

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance or higher

Purpose This procedure modifies GCC terminations, and deletes provisionable 
patchcords, OSC terminations, and GCC terminations.

Tools/Equipment None

Prerequisite Procedures DLP-G76 Provision GCC Terminations, page 7-13 or

NTP-G38 Provision OSC Terminations and Ring ID, page 3-74

DLP-G99 Create a Provisionable Patchcord, page 6-10
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Caution Deleting an OSC termination can cause you to lose visibility of nodes that do not have other OSCs or 
network connections to the CTC computer.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 In node view, complete the following tasks as needed:

• To modify a GCC termination, complete the “DLP-G184 Change a GCC Termination” task on 
page 10-29.

• To delete a GCC termination, complete the “DLP-G185 Delete a GCC Termination” task on 
page 10-30.

• To delete an OSC termination, complete the “DLP-G186 Delete an OSC Termination” task on 
page 10-30.

• To delete a provisionable patchcord, complete the “DLP-G187 Delete a Provisionable Patchcord” 
task on page 10-31.

Stop. You have completed this procedure.

DLP-G184 Change a GCC Termination

Step 1 Click the Provisioning > Comm Channels > GCC tabs.

Step 2 Click the GCC that you want to change.

Step 3 Click Edit.

Step 4 In the GCC Termination Editor dialog box, complete the following as necessary:

• GCC Rate—(Display only) Indicates the GCC rate. 

• Disable OSPF on SDCC Link—If checked, Open Shortest Path First is disabled on the link. OSPF 
should be disabled only when the slot and port connect to third-party equipment that does not 
support OSPF. 

• Far End is Foreign—Check this box to specify that the GCC termination is a non-ONS node.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task modifies a GCC termination. You can enable or disable OSPF and 
enable or disable the foreign node setting.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Remote

Security Level Provisioning or higher
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• Far end IP—If you checked the Far End is Foreign check box, type the IP address of the far-end node 
or leave the 0.0.0.0 default. An IP address of 0.0.0.0 means that any address can be used by the far 
end. 

Step 5 Click OK.

Step 6 Return to your origination procedure (NTP).

DLP-G185 Delete a GCC Termination

Note Deleting the GCC termination on a port also deletes any provisionable patchcord links that might exist 
on the port. 

Step 1 Determine if the port where you want to delete GCC is in-service (IS). (Click the Provisioning > Line 
tabs, and observe the Service State column for that port.) If it is IS, perform the “DLP-G108 Change the 
Service State for a Port” task on page 7-17 for that port. If not, go to Step 2.

Step 2 Click the Provisioning > Comm Channels > GCC tabs.

Step 3 Click the GCC that you want to delete.

Step 4 Click Delete.

Step 5 Click Yes. GCC-EOC alarms appear until all network GCC terminations are deleted and the ports are 
out of service. 

Step 6 Return to your originating procedure (NTP).

DLP-G186 Delete an OSC Termination

Purpose This task deletes the DWDM GCC terminations required for network setup 
when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and 
MXP_2.5G_10G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes an OSC termination on the ONS 15454. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution Deleting a OSC termination might cause node isolation and loss of visibility to nodes that do not have 
other OSCs or network connections to the CTC computer.

Step 1 Click the Provisioning > Comm Channels > OSC tab.

Step 2 If a Ring ID is created, complete the following steps. Otherwise, continue with Step 3.

a. Select the DWDM Ring ID that you want to delete and click Delete. 

b. In the Delete DWDM Ring ID confirmation box, click Yes. Confirm that the changes appear.

Step 3 Click the OSC termination that you want to delete and click Delete. 

Step 4 In the Delete OSC Termination confirmation box, click Yes. Confirm that the changes appear.

Until all network OSC terminations are deleted, loss of signal (LOS) or power failure alarms on the 
Optical Booster (OPT-BST) amplifier, OSCM card, and OSC-CSM card might appear.

Step 5 Return to your originating procedure (NTP).

DLP-G187 Delete a Provisionable Patchcord

Step 1 In node view, click the Provisioning > Comm Channels > PPC tabs. If you are in network view, click 
Provisioning > Provisionable Patchcords tabs.

Step 2 Click the provisionable patchcord that you want to delete.

Step 3 Click Delete. 

Step 4 In the confirmation dialog box, click Yes.

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes a provisionable patchcord. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

DLP-G99 Create a Provisionable Patchcord, page 6-10

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning and higher
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NTP-G86 Convert a Pass-Through Connection to an Add/Drop 
Connection

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at an ONS 15454 on the network.

Step 2 In node view, click the Circuits tab. Delete the unidirectional or bidirectional pass-through optical 
channel network connection (OCHNC) that applies to the pass-through connection to be removed. 

Step 3 Remove the physical pass-through cabling. Click the Provisioning > WDM-ANS > Connections tabs 
to identify the card ports to be removed. The pass-through connection that you are removing can be 
connected in both OADM and hub nodes. 

• For a hub node—Connect the 32DMX-O or 32DMX output port to the 32MUX-O input port.

• For an OADM node—Connect the AD-xC-xx.x drop (TX) port to the AD-xC-xx.x add (RX) port.

Step 4 Physically connect the proper client interface to the correct add and drop ports. 

Step 5 Delete the filter connections related to the pass-through connection that is being converted to an 
add/drop connection:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Highlight the pass-through connections between ITU channel add and drop ports filters.

c. Click Delete.

Step 6 Create two new unidirectional OCHNCs (one heading east, the other heading west) to support the new 
add/drop channels. See the “DLP-G105 Provision DWDM Optical Channel Network Connections” task 
on page 7-10.

Step 7 As necessary, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 6-10.

Step 8 As necessary, add an optical attenuator between the channel TX port of the OADM, 4MD-xx.x, or 
32DMX-O card and the DWDM RX port on the TXP, MXP, or OC-N line card.

Note If the channel is coming from a 32DMX-O, the optical power can be adjusted in CTC by 
modifying the value of the internal per-channel VOA. 

Purpose This procedure converts a pass-through connection into add/drop 
connections (one on the add side and the other on the drop side). Use this 
procedure during a network upgrade. Pass-through channel connections 
can be provided between channel input and output ports for the Channel 
OADM (AD-xC-xx.x), 4-Channel Multiplexer/Demultiplexer 
(4MD-xx.x), 32-Channel Multiplexer (32MUX-O), and 32-Channel 
Demultiplexer (32DMX-O and 32DMX) cards. You can set up 
pass-through connections in nodes that might require more add or drop 
channel capability or configuration.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 (Optional) The following verification steps might be needed for an intermediate node when a 
pass-through connection is converted: 

a. Verify that the received channels are at the specified power level. See the “NTP-G76 Verify Span 
Loss” procedure on page 10-2 for instructions.

b. Verify that the added channels are equalized with the express channels within +/–1 dB. 

c. If the channels are not equalized with the express channels within +/–1 dB, check the attenuation of 
the VOAs. 

d. Check all the fiber adapters to minimize their insertion losses. See the “NTP-G115 Clean Fiber 
Connectors” procedure on page 12-22 for instructions.

Stop. You have completed this procedure.

NTP-G87 Change Node Timing Parameters

Caution The following procedure might be service affecting and should be performed during a scheduled 
maintenance window.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Click the Provisioning > Timing > General tabs.

Step 4 In the General Timing section, change any of the following information:

• Timing Mode

Note Because mixed timing can cause timing loops, Cisco does not recommend using the 
Mixed Timing option. Use this mode with care.

• SSM Message Set

• Quality of RES

• Revertive

• Revertive Time

See the “NTP-G53 Set Up Timing” task on page 6-3 for field descriptions.

Purpose This procedure changes the timing parameters for the ONS 15454. To 
switch the timing reference, see the “NTP-G112 Change the Node Timing 
Reference” procedure on page 12-14.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 6-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 In the Reference Lists area, you can change the following information:

Note Reference lists define up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane. If you attach equipment to BITS Out 
pins, you normally attach it to a node with Line mode because equipment near the external 
timing reference can be directly wired to the reference. 

• NE Reference

• BITS 1 Out

• BITS 2 Out

Step 6 In the BITS In area on the BITS Facilities tab, you can change the following information:

Note The BITS Facilities section sets the parameters for your BITS1 and BITS2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• BITS In State

• Coding

• Framing

• Sync Messaging

• Admin SSM

Step 7 In the BITS Out area, you can change the following information.

Note If Coding, Framing, or AIS Threshold is set in the BITS In area, it cannot be changed here.

• BITS Out State

• Coding

• Framing

• AIS Threshold

• LBO

Step 8 Click Apply. Confirm that the changes appear.

Caution Internal timing is Stratum 3 and is not intended for permanent use. All ONS 15454s should be timed to 
a Stratum 2 or better primary reference source. 

Step 9 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.
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NTP-G88 Modify Users and Change Security

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G188 Change Security Policy for a Single Node, page 10-35

• DLP-G189 Change Security Policy for Multiple Nodes, page 10-37

• DLP-G190 Change Node Access and PM Clearing Privilege, page 10-38

• DLP-G191 Change User Password and Security Level on a Single Node, page 10-39

• DLP-G192 Change User Password and Security Level for Multiple Nodes, page 10-40

• DLP-G193 Delete a User From a Single Node, page 10-40

• DLP-G194 Delete a User From Multiple Nodes, page 10-41

• DLP-G195 Log Out a User on a Single Node, page 10-42

• DLP-G196 Log Out a User on Multiple Nodes, page 10-42

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

DLP-G188 Change Security Policy for a Single Node

Step 1 In node view, click the Provisioning > Security > Policy tabs.

Purpose This procedure modifies user and security properties for the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G23 Create Users and Assign Security, page 3-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task changes the security policy for a single node, including idle user 
timeouts, user lockouts, password changes, and concurrent login policies. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 2 If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle 
User Timeout area for the security level that you want to provision: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. 
The user is logged out after the idle user timeout period is reached.

Step 3 In the User Lockout area, you can modify the following:

• Failed Logins Before Lockout—The number of failed login attempts a user can make before the user 
is locked out from the node. You can choose a value between 0 and 10.

• Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user 
who has been locked out from a node.

• Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can 
choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Note Manual Unlock by Superuser and Lockout Duration are mutually exclusive.

Step 4 In the Password Change area, you can modify the following:

• Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different 
passwords that the user must create before they can reuse a password.

• Cannot Change New Password for [ ] days—If checked, prevents users from changing their 
password for the specified period. The range is 20 to 95 days.

• Require Password Change on First Login to New Account—If checked, requires users to change 
their password the first time they log into their account.

Step 5 To require users to change their password at periodic intervals, check the Enforce Password Aging check 
box in the Password Aging area. If checked, provision the following parameters: 

• Aging Period—Sets the amount of time that must pass before the user must change his or her 
password for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and 
SUPERUSER. The range is 20 to 95 days.

• Warning Period—Sets the number days the user will be warned to change his or her password for 
each security level. The range is 2 to 20 days.

Step 6 In the Other area, you can provision the following: 

• Single Session Per User—If checked, limits users to one login session at one time.

• Disable Inactive User—If checked, disables users who do not log into the node for the period of time 
specified in the Inactive Duration box. The Inactive Duration range is 1 to 99 days.

Step 7 Click Apply. Confirm that the changes appear.

Step 8 Return to your originating procedure (NTP).
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DLP-G189 Change Security Policy for Multiple Nodes

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Policy tabs. A read-only table of nodes and their policies appears.

Step 3 Click a node on the table that you want to modify, then click Change.

Step 4 If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle 
User Timeout area for the security level that you want to provision: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. 
The user is logged out after the idle user timeout period is reached.

Step 5 In the User Lockout area, you can modify the following:

• Failed Logins Before Lockout—The number of failed login attempts a user can make before the user 
is locked out from the node. You can choose a value between 0 and 10.

• Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user 
who has been locked out from a node.

• Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can 
choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Note Manual Unlock by Superuser and Lockout Duration are mutually exclusive.

Step 6 In the Password Change area, you can modify the following:

• Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different 
passwords that the user must create before they can reuse a password.

• Cannot Change New Password for [ ] days—If checked, prevents users from changing their 
password for the specified period. The range is 20 to 95 days.

• Require Password Change on First Login to New Account—If checked, requires users to change 
their password the first time they log into their account.

Step 7 To require users to change their password at periodic intervals, check the Enforce Password Aging check 
box in the Password Aging area. If checked, provision the following parameters: 

• Aging Period—Sets the amount of time that must pass before the user must change his or her 
password for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and 
SUPERUSER. The range is 20 to 95 days.

• Warning Period—Sets the number days the user will be warned to change his or her password for 
each security level. The range is 2 to 20 days.

Step 8 In the Other area, you can provision the following: 

Purpose This task changes the security policy for multiple nodes including idle user 
timeouts, user lockouts, password change, and concurrent login policies. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Single Session Per User—If checked, limits users to one login session at one time.

• Disable Inactive User—If checked, disables users who do not log into the node for the period of time 
specified in the Inactive Duration box. The Inactive Duration range is 1 to 99 days.

Step 9 In the Select Applicable Nodes area, uncheck any nodes where you do not want to apply the changes.

Step 10 Click OK. 

Step 11 In the Security Policy Change Results dialog box, confirm that the changes are correct, then click OK.

Step 12 Return to your originating procedure (NTP).

DLP-G190 Change Node Access and PM Clearing Privilege

Step 1 In node view, click the Provisioning > Security > Access tabs. 

Step 2 In the Access area, provision the following: 

• LAN access—Choose one of the following options to set the access paths to the node: 

– No LAN Access—Allows access to the node only through data communications channel (DCC) 
connections. Access through the TCC2/TCC2P RJ-45 port and backplane is not permitted.

– Backplane only—Allows access through DCC connections and the backplane. Access through 
the TCC2/TCC2P RJ-45 port is not allowed.

– Front and Backplane—Allows access through DCC, TCC2/TCC2P RJ-45, and backplane 
connections.

• Restore Timeout—Sets a time delay for enabling of front and backplane access when DCC 
connections are lost and “DCC only” is chosen in LAN Access. Front and backplane access is 
enabled after the restore timeout period has passed. Front and backplane access is disabled as soon 
as DCC connections are restored. 

Step 3 In the Shell Access area, set the shell program used to access the node:

• Telnet—If chosen, allows access to the node using Telnet. Telnet is the terminal-remote host Internet 
protocol developed for the Advanced Agency Research Project Network (ARPANET). If chosen, 
choose the Telnet port. Port 23 is the default.

• SSH—If chosen, allows access to the node using the Secure Shell (SSH) program. SSH is a 
terminal-remote host Internet protocol that uses encrypted links. If chosen, Port 22 is the default 
port. It cannot be changed.

Purpose This task provisions the physical access points and shell programs used to 
connect to the ONS 15454 and sets the user security level that can clear 
node performance monitoring (PM) data.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Enable Shell Password—If checked, enables the SSH password. To disable the password, you must 
uncheck the check box and click Apply. You must type the password in the confirmation dialog box 
and click OK to disable it.

Step 4 In the PM Clearing Privilege field, choose the minimum security level that can clear node PM data: 
PROVISIONING or SUPERUSER.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G191 Change User Password and Security Level on a Single Node

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 Click the user whose settings you want to modify, then click Edit.

Step 3 In the Change User dialog box, you can:

• Change a user password.

• Modify the user security level.

• Lock out the user.

• Disable the user.

• Force the user to change password on next login.

See the “DLP-G54 Create a New User on a Single Node” procedure on page 3-6 for field descriptions.

Step 4 Click OK.

Step 5 Click OK in the confirmation dialog box.

Note User settings that you changed during this task will not appear until that user logs off and logs 
back in.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes settings for an existing user at one node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G192 Change User Password and Security Level for Multiple Nodes

Note You must add the same user name and password to each node that the user will access.

Step 1 From the View menu, choose Go to Network View. Verify that you can access all the nodes where you 
want to change the users.

Step 2 Click the Provisioning > Security > Users tabs. Highlight the user’s name whose settings you want to 
change.

Step 3 Click Change. The Change User dialog box appears.

Step 4 In the Change User dialog box, you can:

• Change a user’s password.

• Modify the user’s security level.

• Lock out the user.

See the “DLP-G55 Create a New User on Multiple Nodes” task on page 3-6 for field descriptions.

Step 5 In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s 
settings (all network nodes are selected by default).

Step 6 Click OK. A Change Results confirmation dialog box appears. 

Step 7 Click OK to acknowledge the changes. 

Step 8 Return to your originating procedure (NTP).

DLP-G193 Delete a User From a Single Node

Purpose This task changes settings for an existing user at multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task deletes an existing user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G195 
Log Out a User on a Single Node” task on page 10-42, or you can choose the “Logout before delete” 
option in the Delete User dialog box.

Note CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete 
the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 Choose the user you want to delete.

Step 3 Click Delete.

Step 4 In the Delete User dialog box, verify that the user name displayed is the one you want to delete. Click 
Logout before delete if the user is currently logged in. (You cannot delete users if they are logged in.)

Step 5 Click OK. 

Step 6 In the User Deletion Results box, click OK.

Step 7 Return to your originating procedure (NTP).

DLP-G194 Delete a User From Multiple Nodes

Note You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G196 
Log Out a User on Multiple Nodes” task on page 10-42, or you can choose the “Logout before delete” 
option in the Delete User dialog box.

Note CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete 
the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > Security tabs. Highlight the name of the user you want to delete.

Step 3 Click Delete. The Delete User dialog box appears.

Step 4 In the Select Applicable Nodes area, uncheck any nodes where you do not want to delete this user.

Step 5 Click OK. A User Deletion Results confirmation dialog box appears. 

Purpose This task deletes an existing user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 6 Click OK to acknowledge the changes. Confirm that the changes appear.

Step 7 Return to your originating procedure (NTP).

DLP-G195 Log Out a User on a Single Node

Step 1 In node view, click the Provisioning > Security > Active Logins tabs.

Step 2 Choose the user that you want to log out and click Logout.

Step 3 In the Logout User dialog box, check Lockout before Logout if you want to lock the user out. This 
prevents the user from logging in after logout based on user lockout parameters provisioned in the Policy 
tab. A manual unlock by a Superuser is required, or the user is locked out for the amount of time specified 
in the Lockout Duration field. See the “DLP-G188 Change Security Policy for a Single Node” task on 
page 10-35 for more information.

Step 4 Click OK.

Step 5 Click OK to confirm the logout.

Step 6 Return to your originating procedure (NTP).

DLP-G196 Log Out a User on Multiple Nodes

Step 1 From the View menu, chose Go to Network View. 

Step 2 Click the Provisioning > Security > Active Logins tabs.

Step 3 Choose the user you want to log out.

Step 4 Click Logout.

Step 5 In the Logout User dialog box, check the nodes where you want to log out the user.

Purpose This task logs out a user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task logs out a user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 6 Check Lockout before Logout if you want to lock the user out prior to logout. This prevents the user 
from logging in after logout based on user lockout parameters provisioned in the Policy tab. A manual 
unlock by a Superuser is required, or the user is locked out for the amount of time specified in the 
Lockout Duration field. See the “DLP-G189 Change Security Policy for Multiple Nodes” task on 
page 10-37 for more information.

Step 7 In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s 
settings (all network nodes are selected by default).

Step 8 Click OK.

Step 9 Click OK in the confirmation dialog box.

Step 10 Return to your originating procedure (NTP).

NTP-G131 Convert DWDM Nodes to Hybrid Nodes

Note You cannot perform this upgrade on software released prior to Software Release 4.6. 

Note Downgrade procedures from OSC-CSM cards to OSCM cards are not supported. Contact the 
Cisco Technical Assistance Center (TAC) for more information. See the “Obtaining Technical 
Assistance” section on page lxxiv.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you will perform the 
upgrade. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 If you have timing set up on the OSCM card, delete the timing source:

a. In node view, click the Provisioning > Timing tabs.

b. Scroll to the Reference Lists area.

c. In the NE Reference column, select Internal Clock from the drop-down list for all entries where the 
selected Clock Source is the OSCM that you are removing.

d. Click Apply.

Step 4 If you have overhead circuits on the node, complete the “DLP-G112 Delete Overhead Circuits” task on 
page 7-21.

Purpose This procedure upgrades an OSCM card to an OSC-CSM card. OSCM 
cards use Slots 8 and 10, which are required for cross-connect cards in 
TDM and DWDM hybrid configurations. The OSC-CSM cards use 
Slots 1 to 6 and 12 to 17.

Tools/Equipment Two OSC-CSM cards

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Maintenance or higher
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Step 5 Delete the DWDM ring ID:

a. In node view, click the Provisioning > Comm Channels > OSC tabs.

b. Select the DWDM Ring ID that you want to delete and click Delete. 

c. In the Delete DWDM Ring ID confirmation box, click Yes. Confirm that the changes appear.

Step 6 If you have OSC terminations, refer to the “DLP-G186 Delete an OSC Termination” task on page 10-30 
to delete the OSC termination. 

Step 7 Delete the OSCM card wavelength division multiplexing-automatic node setup (WDM-ANS) 
connections:

a. In node view, click the Provisioning > WDM-ANS > Connections tabs.

b. Select the connection to be deleted.

c. Click Delete.

d. In the Delete Optical Link dialog box, click Yes. 

Step 8 Delete the card from CTC:

a. In node view, right-click the OSCM card.

b. Select Delete Card from the menu.

The card name disappears and the slot turns gray.

Step 9 Remove the cables from the OSCM OSC ports.

Step 10 Physically replace the deleted OSCM card on the ONS 15454 with an OSC-CSM card:

Note The OSCM card and OSC-CSM card do not have the same slot requirements.

a. Open the OSCM card ejectors.

b. Slide the card out of Slot 8 or 10. 

c. Open the ejectors on the OSC-CSM card.

d. Slide the OSC-CSM card into the slot along the guide rails. Use ONS 15454 card Slots 1 to 6 or 12 
to 17, according to your site plan.

e. Close the ejectors.

Note On the OSC-CSM card, the fail LED above the ACT/STBY LED becomes red, blinks for several 
seconds, and turns off. The ACT/STBY LED turns green and remains on. In node view, the 
OSC-CSM appears green.

Step 11 If an OSCM card was removed from Slot 8 and an OSC-CSM card was installed in Slots 12 to 17, modify 
the OSC-CSM line direction from east-to-west to west-to-east. 

Note The Cisco MetroPlanner configuration file labels the OSC-CSM card as west even if it is 
installed in the east side of the node.

a. To modify the OSC-CSM card line direction, double-click the OSC-CSM card in node view. The 
card view appears.

a. Click the Provisioning > Optical Line > Parameter tabs.
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b. In the port number 2 line, click the Line Direction drop-down list and choose West to East.

c. Click Apply.

Step 12 If an OSCM card was removed from Slot 10 and an OSC-CSM card was installed in Slots 1 to 6, modify 
the OSC-CSM line direction from west-to-east to east-to-west.

Note The Cisco MetroPlanner configuration file will label the OSC-CSM card as east even if it is 
installed in the west side of the node.

a. To modify the OSC-CSM card line direction, double-click the OSC-CSM card in node view. The 
card view appears.

b. Click the Provisioning > Optical Line > Parameter tabs.

c. In the port number 2 line, click the Line Direction drop-down list and choose East to West.

d. Click Apply.

Step 13 Calculate default connections using WDM-ANS:

a. Click the CTC up arrow to get back to node view.

a. In node view, click the Provisioning > WDM-ANS > Connections tabs.

b. Click the Calculate Connections button.

Step 14 Connect the cables from the OSC-CSM LINE ports to the OPT-BST amplifier OSC ports. Follow the 
recommended connections that were automatically calculated in the Connections tab as described in 
Step 13.

Step 15 Launch ANS port regulation:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Click the Launch ANS button.

c. In the Link Status column, the ports change to Regulated.

Step 16 Create OSC terminations starting from the OSC-CSM card. See the “NTP-G38 Provision OSC 
Terminations and Ring ID” procedure on page 3-74. 

Step 17 (Optional) If you want to set up timing on the OSC-CSM card, create the timing source:

a. In node view, click the Provisioning > Timing tabs.

b. Scroll down to the Reference Lists area.

c. In the NE Reference column, select Internal Clock from the drop-down list for all entries where the 
selected Clock Source is the OSC-CSM that you are adding. 

d. Click Apply.

Step 18 (Optional) Complete the “NTP-G60 Create Overhead Circuits” procedure on page 7-13. 

Step 19 Repeat Steps 3 through 18 for each OSCM card you are replacing in the node. 

Step 20 If you are installing cross-connect cards, refer to the Cisco ONS 15454 Procedure Guide or the 
Cisco ONS 15454 SDH Procedure Guide for instructions.

Stop. You have completed this procedure. 
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NTP-G89 Change SNMP Settings

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G197 Modify SNMP Trap Destinations, page 10-46

• DLP-G198 Delete SNMP Trap Destinations, page 10-47

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

DLP-G197 Modify SNMP Trap Destinations

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 Select a destination trap from the Trap Destinations area.

For a description of SNMP traps, refer to the Cisco ONS 15454 Troubleshooting Guide or the 
Cisco ONS 15454 SDH Troubleshooting Guide.

Step 3 Highlight the Destination row field entry in the Community column and change the entry to another valid 
community name.

The community name is a form of authentication and access control. The community name assigned to 
the ONS 15454 is case-sensitive and must match the community name of the network management 
system.

Purpose This procedure modifies Simple Network Management Protocol (SNMP) 
settings for the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G28 Set Up SNMP, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task modifies the SNMP trap destinations on an ONS 15454 including 
community name, default User Datagram Protocol (UDP) port, SNMP trap 
version, and maximum traps per second.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 If needed, modify the UDP port in the UDP Port field. The default UDP port for SNMP is 162. 

Step 5 Set the Trap Version field for either SNMPv1 or SNMPv2. 

Refer to your network management system (NMS) documentation to determine whether to use SNMPv1 
or SNMPv2.

Step 6 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 7 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistics retrieval across ONS firewalls, click the Enable SNMP Proxy check box located 
on the SNMP tab.

Step 8 Click Apply.

Step 9 SNMP settings are now modified. To view SNMP information for each node, highlight the node IP 
address in the Trap Destinations area of the Trap Destinations area. Confirm that the changes appear.

Step 10 Return to your originating procedure (NTP).

DLP-G198 Delete SNMP Trap Destinations 

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 In the Trap Destinations area, click the destination trap that you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. Confirm that the changes appear.

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes SNMP trap destinations on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Change DWDM Card Settings

This chapter explains how to change line, performance monitoring (PM), and threshold settings on 
Cisco ONS 15454 optical service, amplifier, multiplexer and demultiplexer, 32WSS, and AIC-I cards. 
To install DWDM cards, see the “NTP-G30 Install the DWDM Cards” procedure on page 3-27.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide as necessary. 

Caution Changing card settings can be service affecting. You should make all changes during a scheduled 
maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds, page 
11-2—As needed, complete this procedure to change the OSCM and OSC-CSM card settings.

2. NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds, page 
11-11—As needed, complete this procedure to change the amplifier card settings.

3. NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds, 
page 11-22—As needed, complete this procedure to change the multiplexer and demultiplexer card 
settings.

4. NTP-G93 Modify the 32WSS Thresholds and Settings, page 11-31—As needed, complete this 
procedure to change the 32WSS card settings.

5. NTP-G101 Modify Alarm Interface Controller–International Settings, page 11-41—As needed, 
complete this procedure to change settings for external alarms, controls, and orderwire for the AIC-I 
card.

6. NTP-G102 Change Card Service State, page 11-44—As needed, complete this procedure to change 
the card service state. 
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NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM 
Parameters and Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
OSCM or OSC-CSM card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G199 Change the OSCM and OSC-CSM Optical Service Channel Settings, page 11-2

• DLP-G200 Change the OSCM and OSC-CSM Optical Service Channel Thresholds, page 11-5

• DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards, page 11-6

• DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings, page 11-8

• DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings, page 11-10

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure. 

DLP-G199 Change the OSCM and OSC-CSM Optical Service Channel Settings

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the OC-3 optical 
line settings.

Step 2 Click the Provisioning > OC3 Line > OC3 Line tabs. 

Step 3 Modify any of the settings described in Table 11-1. The provisionable paramenters are listed in the 
options column in the table.

Purpose This procedure changes the optical service channel (OC-3/STM-1) and PM 
parameters and thresholds for the OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the optical service channel (OC-3/STM-1) optical 
service channel settings for OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-1 OSCM and OSC-CSM Card OC-3 Settings

Parameter Description Options

Port # Displays the port number. Display only

Port Name Provides the ability to assign the specified port 
a name.

User-defined. Name can be up to 32 alphanumeric/special 
characters. Blank by default. 

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

SF BER Sets the signal fail bit error rate. Under the drop-down list choose from the following.

• 1E-3

• 1E-4 

• 1E-5

SD BER Sets the signal degrade bit error rate. Under the drop-down list choose from the following.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Provides 
Synch

(Display only) If checked, the card is 
provisioned as a network element timing 
reference.

• Checked 

• Unchecked

SynMsgIn Enables synchronization status messages (S1 
byte), which allow the node to choose the best 
timing source.

• Checked

• Unchecked

Send Do Not 
Use

When checked, sends a DUS (do not use) 
message on the S1 byte.

• Checked

• Unchecked

PJSTSMon # (Display only) Sets the STS that will be used 
for pointer justification. If set to 0, no STS is 
monitored. Only one STS can be monitored on 
each OC-N port. 

Display only
11-3
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 11      Change DWDM Card Settings
Before You Begin
Admin State (Display only) Sets the port service state 
unless network conditions prevent the change. 
For more information about administrative 
states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS (ANSI) or Unlocked (ETSI)—Puts the port 
in-service. The port service state changes to IS-NR 
(ANSI) or Unlocked-enabled (ETSI).

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI)—Puts the port in 
automatic in-service. The port service state changes to 
OOS-AU,AINS (ANSI) or 
Unlocked-disabled,automaticInService (ETSI).

• OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI)—Removes the port from service and disables it. 
The port service state changes to OOS-MA,DSBLD 
(ANSI) or Locked-enabled,disabled (ETSI).

• OOS,MT (ANSI) or Locked,maintenance 
(ETSI)—Removes the port from service for 
maintenance. The port service state changes to 
OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI).

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition 
of the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see Appendix C, “DWDM 
Administrative and Service States.”

• IS-NR (In-Service and Normal [ANSI]) or 
Unlocked-enabled (ETSI)— The port is fully 
operational and performing as provisioned.

• OOS-AU,AINS (Out-Of-Service and Autonomous, 
Automatic In-Service [ANSI]) or 
Unlocked-disabled,automaticInService (ETSI)— The 
port is out-of-service, but traffic is carried. Alarm 
reporting is suppressed. The ONS node monitors the 
ports for an error-free signal. After an error-free signal 
is detected, the port stays in the 
OOS-AU,AINS/Unlocked-disabled,automaticInService 
state for the duration of the soak period. After the soak 
period ends, the port service state changes to 
IS-NR/Unlocked-enabled. 

• OOS-MA,DSBLD (Out-of-Service and Management, 
Disabled [ANSI]) or Locked-enabled,disabled 
(ETSI)— The port is out-of-service and unable to carry 
traffic. 

• OOS-MA,MT (Out-of-Service and Management, 
Maintenance [ANSI]) or Locked-enabled,maintenance 
(ETSI)— The port is out-of-service for maintenance. 
Alarm reporting is suppressed, but traffic is carried and 
loopbacks are allowed.

Table 11-1 OSCM and OSC-CSM Card OC-3 Settings (continued)

Parameter Description Options
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

DLP-G200 Change the OSCM and OSC-CSM Optical Service Channel 
Thresholds 

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line 
threshold settings.

Step 2 Click the Provisioning > OC3 Line > SONET Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-2. The provisionable paramenters are listed in the 
options column in the table.

AINS Soak (Display only) Sets the automatic in-service 
soak period.

• Duration of valid input signal, in hh.mm format, after 
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments 

Type Defines the port as SONET or SDH. The 
Enable Sync Msg field and the Send Do Not 
Use field must be disabled before the port can 
be set to SDH.

Under the drop-down list choose from the following.

• SONET 

• SDH

Purpose This task changes the OC-3 (STM-1) SONET (SDH) thresholds settings 
for the OSC signal transmitted by the OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-2 OSCM and OSC-CSM Cards SONET Threshold Settings

Parameter Description Options

Port Displays the port number Display only

CV Coding violations Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. Double-click the paramenter, enter a value, and press 
Enter.

ES Errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. Double-click the paramenter, enter a value, and press 
Enter.

Table 11-1 OSCM and OSC-CSM Card OC-3 Settings (continued)

Parameter Description Options
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line 
parameters.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 11-3. The provisionable paramenters are listed in the 
options column in the table.

SES Severely errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. Double-click the paramenter, enter a value, and press 
Enter.

SEFS Severely errored framing 
seconds

Numeric. Can be set for Far End, for 15-minute or one-day 
intervals for Section only. Select the bullet and click Refresh. 
Double-click the paramenter, enter a value, and press Enter.

FC Failure count Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section. Select the bullet and click Refresh or Path 
(Near and Far End). Double-click the paramenter, enter a 
value, and press Enter.

UAS Unavailable seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. Double-click the paramenter, enter a value, and press 
Enter.

Purpose This task changes the optical line parameters for OSCM and OSC-CSM 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-2 OSCM and OSC-CSM Cards SONET Threshold Settings (continued)

Parameter Description Options
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Table 11-3 OSCM and OSC-CSM Card Optical Line Parameter Settings

Parameter Description Options

Port # Displays the port number and TX or RX. Read-only

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 7-9.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Administrative and Service States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. CTC automatically configures the line 
direction during node setup. To change this setting, 
you must change the Cisco MetroPlanner site plan 
and import it to the node.

Under the drop-down list choose from the following.

• East to West

• West to East

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of the 
port. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see 
Appendix C, “DWDM Administrative and Service 
States.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type (Display only) Identifies the type of port. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC

Power (Display only) Shows the current power level per 
port.

—

VOA Mode (Display only) Shows the functional mode of the 
variable optical attenuator (VOA), when present. 

• Constant Attenuation

• Constant Power

VOA Power 
Ref

(Display only) Shows the optical power setpoint that 
must be reached when a VOA is present and VOA 
Mode is set to Constant Power. This parameter can 
only be modified by Automatic Node Setup (ANS).

—

VOA Power 
Calib

Modifies the optical power value of the VOA when 
VOA Mode is set to Constant Power.

Numeric, double-click the paramenter, enter a value, 
and press Enter.
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical channel 
threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-4 shows the thresholds for warnings. 
Table 11-5 shows the thresholds for alarms.

VOA 
Attenuation 
Ref

(Display only) Shows the VOA attenuation value 
when VOA Mode is set to Constant Attenuation. 
This parameter can only be modified by ANS. 

—

VOA 
Attenuation 
Calib

Modifies the attenuation value of the VOA when the 
VOA Mode is set to Constant Attenuation.

Numeric, double-click the paramenter, enter a value, 
and press Enter.

Purpose This task changes the optical line threshold settings for OSCM and 
OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-3 OSCM and OSC-CSM Card Optical Line Parameter Settings (continued)

Parameter Description Options
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Table 11-4  OSCM and OSC-CSM Cards Optical Channel Warning Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. Display only

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: –50 dBm. 
Double-click the paramenter, enter a 
value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: 30 dBm.  
Double-click the paramenter, enter a 
value, and press Enter.

Table 11-5  OSCM and OSC-CSM Cards Optical Channel Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
Automatic Node Setup (ANS). If the 
VOA Mode is Constant Attenuation, you 
can manually change the threshold. The 
value must be within the optical power 
range that is specified for the card. (See 
Appendix B, “Hardware Specifications.”)

If VOA Mode is Constant Power, you 
cannot change the threshold manually 
because it is based on the Power setpoint 
(Optics Thresholds tab). To change the 
threshold, you must change the VOA 
Power Calib value. This adjusts the 
Power setpoint. The threshold is 
automatically set to a value that is 5 dB 
higher than the Power setpoint.

Numeric, double-click the paramenter, 
enter a value, and press Enter.

Power Degrade 
High (dBm)

Shows the power degrade high threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port that is 
associated to a VOA (OSC-VOA). In 
Constant Power mode, the port is always 
active and the threshold is automatically 
linked to the Power Setpoint (VOA Power 
Ref + VOA Power Calib). To change the 
threshold, change the Power Setpoint. 
The threshold will always be 2 dB higher 
than the Power Setpoint. 

Display only

Numeric. 
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Step 7 Return to your originating procedure (NTP).

DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings

Step 1 In node view, double-click the OSC-CSM or OSCM where you want to change the ALS maintenance 
settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 11-6. The provisionable paramenters are listed in the 
options column in the table.

Power Degrade 
Low (dBm)

Shows the power degrade low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

In this case the threshold is automatically 
linked to the Power Setpoint (VOA Power 
Ref + VOA Power Calib) provisioned: 
changing the setpoint will result in 
changing the threshold (always 2dB 
lower). 

Display only

Numeric. 

VOA Degrade 
High (dBm)

Does not apply to OSCM and OSC-CSM 
cards.

—

VOA Degrade 
Low (dBm)

Does not apply to OSCM and OSC-CSM 
cards.

—

Purpose This task changes the automatic laser shutdown (ALS) maintenance 
settings for the OSC-CSM, OSCM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-5  OSCM and OSC-CSM Cards Optical Channel Alarm Thresholds Settings (continued)

Parameter Description Options
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM 
Parameters and Thresholds 

Table 11-6  OSC-CSM or OSCM Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. When set 
to On, the OSC TX output power is shut 
down.

Under the drop-down list choose 
from the following.

On and off

ALS Mode Automatic laser shutdown. For OSCM 
cards ALS provides the ability to shut 
down the OSC TX Laser when the OSC 
RX detects an LOS.

For OSC-CSM cards, ALS provides the 
same functions as the OSCM card and 
also enables an optical safety mechanism 
at DWDM network layer. See the 
“15.8.5.13 Automatic Laser Shutdown” 
section on page 15-105 for more 
information.

Under the drop-down list choose 
from the following.

• Disable—Deactivates ALS.

• Auto Restart (default)—ALS 
is active. The power is 
automatically shut down when 
needed and automatically tries 
to restart using a probe pulse 
until the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays the current status 
of the laser. 

—

Request Laser 
Restart

If checked, allows you to restart the laser, 
for maintenance. 

Checked or unchecked

Purpose This procedure changes the line and threshold settings for the OPT-PRE 
and OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
OPT-PRE or OPT-BST amplifier card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers, page 11-12

• DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers, page 
11-14

• DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers, page 
11-15

• DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers, 
page 11-17

• DLP-G322 Change the OPT-BST ALS Maintenance Settings, page 11-21

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure. 

DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 11-7. The provisionable paramenters are listed in the 
options column in the table.

Purpose This task changes the optical line settings for OPT-PRE and OPT-BST 
amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-7 OPT-PRE and OPT-BST Amplifier Optical Line Settings

Parameter Description Options

Port # (Display only) Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a name. User-defined. Name can be up to 
32 alphanumeric/special characters. Blank by 
default. Double-click, enter the name, and press 
Enter.

See the “DLP-G104 Assign a Name to a Port” task 
on page 7-9.
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Administrative and Service States.”

Under the drop-down list choose from the 
following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. CTC automatically configures the line 
direction during node setup. To change this setting, you 
must change the Cisco MetroPlanner site plan and 
import it to the node.

Under the drop-down list choose from the 
following.

• East to West

• West to East

Service State Identifies the autonomously generated state that gives 
the overall condition of the port. Service states appear 
in the format: Primary State-Primary State Qualifier, 
Secondary State. For more information about service 
states, see Appendix C, “DWDM Administrative and 
Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type (Display only) Identifies the type of port. For OPT-BST cards:

• Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC

For OPT-PRE cards:

• Input Com

• Input DCU

• Output DCU

Power (Display only) Shows the current power level per port. —

AINS Soak (Display only) Shows the soak time. —

Table 11-7 OPT-PRE and OPT-BST Amplifier Optical Line Settings (continued)

Parameter Description Options
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DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST 
Amplifiers

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-8 shows the thresholds for warnings. 
Table 11-9 shows the thresholds for alarms. The provisionable paramenters are listed in the options 
column in the table.

Purpose This task changes the optical line threshold settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-8  OPT-PRE and OPT-BST Cards Optical Channel Warning Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: –50 dBm.  
Double-click, enter the name, and press 
Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: 30 dBm.  
Double-click, enter the name, and press 
Enter.
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 7 Return to your originating procedure (NTP).

DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST 
Amplifiers

Table 11-9  OPT-PRE and OPT-BST Cards Optical Channel Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
Automatic Node Setup (ANS). You can 
manually change the threshold. The value 
must be within the optical power range 
that is specified for the card. (See 
Appendix B, “Hardware Specifications.”) 

For OPT-BST cards, this parameter 
applies to Port 2 (Output COM) and Port 
4 (Output OSC) are related to Optical 
Safety mechanism at DWDM Network 
layer (see Chapter 16: “16.4 Network 
Optical Safety - Automatic Laser 
Shutdown” for a detailed description).

Numeric,  double-click the paramenter, 
enter a value, and press Enter. 

Power Degrade 
High (dBm)

Does not apply to OPT-BST and 
OPT-PRE line parameters.

Numeric. 

Power Degrade 
Low (dBm)

Does not apply to OPT-BST and 
OPT-PRE line parameters.

Numeric. 

VOA Degrade 
High (dBm)

Does not apply to OPT-BST and 
OPT-PRE line parameters.

—

VOA Degrade 
Low (dBm)

Does not apply to OPT-BST and 
OPT-PRE line parameters.

—

Purpose This task changes the optical amplifier line settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
amplifier line settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 11-10. The provisionable paramenters are listed in the 
options column in the table.

Table 11-10 OPT-PRE and OPT-BST Optical Amplifier Line Settings

Parameter Description Options

Port # (Display only) Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and Service 
States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the 
line direction. CTC automatically configures the 
line direction during node setup. To change this 
setting, you must change the Cisco MetroPlanner 
site plan and import it to the node.

Under the drop-down list choose from the following.

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Administrative and Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type (Display only) Identifies the type of port. Output Line

Total Output 
Power

(Display only) Shows the current power level per 
port. 

—

Channel Power 
Ref.

(Display only) Shows the optical per-channel 
signal power setpoint that must be reached at the 
amplifier output when gain control is active.

—

Offset Adjusts the Total Output Power unless network 
conditions prevent the adjustment, for example the 
port is in IS state.

Double-click the paramenter, enter a value, and press 
Enter.

Signal Output 
Power

Shows the current output power leaving the 
amplifier, including the ASE contribution.

—

Channel Power 
Ref

(Display only) Shows the optical power per 
channel leaving the amplifier. 

—

11-16
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 11      Change DWDM Card Settings
Before You Begin
Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and 
OPT-BST Amplifiers

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
channel threshold settings.

Gain (Display only) The current gain of the amplifiers. —

Gain Set Point The value of the gain that the amplifier must 
achieve. Automatic Power Control (APC) can 
modify this value based on the number OCHNC 
circuits that are managed by the amplifier or to 
compensate fiber aging insertion loss. See the 
“17.4 Automatic Power Control” section on 
page 17-17 for more information. 

Display only or numeric depending on mode setting. 
When the system is configured as metro core, this field is 
display only. When the system is configured as metro 
access this field can be changed by the user.

Tilt Reference (Display only) Shows the default value for the 
amplifier tilt. This field can only be modified by 
ANS.

—

Tilt Calibration Allows you to manually change the amplifier tilt. Numeric, double-click the paramenter, enter a value, and 
press Enter.

Working Mode (Display only) Shows the working mode of the 
amplifier. 

Control gain

Control power

DCU Insertion 
Loss

(OPT-PRE cards only; display only) Shows the 
working mode of the amplifier.

Control gain

Control power

Output Power 
Set-point

(Display only) The output power set-point. Numeric

Purpose This task changes the optical channel threshold settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-10 OPT-PRE and OPT-BST Optical Amplifier Line Settings (continued)

Parameter Description Options
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Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-11 shows the amplifier line thresholds 
for warnings. Table 11-12 shows the amplifier line thresholds for alarms. The provisionable paramenters 
are listed in the options column in the table.

Table 11-11  OPT-PRE and OPT-BST Cards Amplifier Line Warning Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: –50 dBm. 
Double-click the paramenter, enter a 
value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: 30 dBm.  
Double-click the paramenter, enter a 
value, and press Enter.

Table 11-12  OPT-PRE and OPT-BST Cards Amplifier Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
Automatic Node Setup (ANS). You can 
manually change the threshold. The value 
must be within the optical power range 
that is specified for the card. (See 
Appendix B, “Hardware Specifications.”)

Numeric, double-click the paramenter, 
enter a value, and press Enter. 
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Power Degrade 
High (dBm)

Shows the current value of the optical 
power degrade high threshold. This 
threshold applies only when the amplifier 
is active and in constant power mode.

Power Degrade High refers to the port’s 
Signal Output Power value and is 
automatically calculated by the 
TCC2/TCC2P  when the amplifier is 
turned up.

The Power Degrade High threshold is 
linked to the Output Power Setpoint on 
the Parameters tab. Changing the setpoint 
changes the Power Degrade High 
threshold. The threshold value is always 2 
dB higher than the Output Power Setpoint 
value.

APC can modify this value based on the 
number of OCHNC circuits the amplifier 
is managing. See the “17.4 Automatic 
Power Control” section on page 17-17 for 
more information.

Display only

Power Degrade 
Low (dBm)

Shows the current value of the optical 
power degrade high threshold configured 
in the card. This threshold applies only 
when the amplifier is active and in 
constant power mode.

Power Degrade Low refers to the port’s 
Signal Output Power value and is 
automatically calculated by the TCC 
when the amplifier is turned up.

The Power Degrade Low threshold is 
automatically linked to the Output Power 
Setpoint on the Parameters tab. Changing 
the setpoint changes the Power Degrade 
Low threshold. The threshold value is 
always 2 dB lower than the Output Power 
Setpoint.

APC can modify this value based on the 
number of OCHNC circuits the amplifier 
is managing. 

Display only

Table 11-12  OPT-PRE and OPT-BST Cards Amplifier Line Alarm Thresholds Settings (continued)

Parameter Description Options
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 7 Return to your originating procedure (NTP).

Gain Degrade 
High (dBm)

Shows the current value of the gain 
degrade high threshold configured in the 
card. This threshold applies only when 
the amplifier is active and in constant 
gain mode.

Gain Degrade High refers to the port’s 
Gain value and is automatically 
calculated by the TCC and when the 
amplifier is turned up.

The Gain Degrade High threshold is 
linked to the Gain setpoint. Changing the 
setpoint changes the Gain Degrade High 
threshold. The threshold value is always 
2 dB higher than the Gain Setpoint value.

APC can modify this value based on the 
number of OCHNC circuits the amplifier 
is managing and to compensate for 
insertion loss due to fiber aging.

—

Gain Degrade 
Low (dBm)

Shows the current value of the gain 
degrade low threshold configured in the 
card. This threshold applies only when 
the amplifier is active and in constant 
gain mode.

Gain Degrade Low refers to the port’s 
Gain value and is automatically 
calculated by the TCC and when the 
amplifier is turned up.

The Gain Degrade Low threshold is 
automatically linked to the Gain Setpoint 
that is provisioned. Changing the setpoint 
changes the Gain Degrade Low threshold. 
The threshold value is always 2 dB lower 
than the Gain Setpoint value.

APC can also modify this value based on 
the number of OCHNC circuits the 
amplifier is managing. 

—

Table 11-12  OPT-PRE and OPT-BST Cards Amplifier Line Alarm Thresholds Settings (continued)

Parameter Description Options
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DLP-G322 Change the OPT-BST ALS Maintenance Settings

Step 1 In node view, double-click the OPT-BST where you want to change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 11-13. The provisionable paramenters are listed in the 
options column in the table.

Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Purpose This task changes the automatic laser shutdown (ALS) maintenance 
settings for the OPT-BST card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-13  OPT-BST Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. When set 
to On, the OPT-BST TX output power is 
shut down.

Under the drop-down list choose 
from the following.

On and off

ALS Mode Automatic laser shutdown. For OPT-BST 
cards ALS provides the ability to shut 
down the OPT-BST TX Laser when the 
OPT-BST RX detects an LOS.

ALS also enables an optical safety 
mechanism at the DWDM network layer. 
See the “15.8.1.2 Automatic Laser 
Shutdown” section on page 15-83 for 
more information.

Under the drop-down list choose 
from the following.

• Disable—Deactivates ALS.

• Auto Restart (default)—ALS 
is active. The power is 
automatically shut down when 
needed and automatically tries 
to restart using a probe pulse 
until the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays the current status 
of the laser. 

—

Request Laser 
Restart

If checked, allows you to restart the laser, 
for maintenance. 

Checked or unchecked
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Step 5 Return to your originating procedure (NTP).

NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line 
Settings and PM Thresholds

Note Complete the “DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 
32DMX Cards” task on page 9-12 to view multiplexer and demultiplexer optical power statistics.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
32MUX-O, 32DMX, or 4MD-xx.x card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards, page 11-23

• DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards, page 
11-25

• DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards, page 11-26

• DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards, 
page 11-29

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure. 

Purpose This procedure changes the line and PM parameter threshold settings for 
the multiplexer and demultiplexer cards. The cards included in this 
category are the 32MUX-O,32DMX-O,32DMX, and 4MD-xx.x cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer 
Cards

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 11-14. In the Options column, the SONET option is 
followed by the SDH option. The provisionable paramenters are listed in the options column in the table.

Purpose This task changes the optical line settings for 32MUX-O, 32DMX-O, 
32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-14 Multiplexer and Demultiplexer Card Optical Line Settings

Parameter Description Options

Port # (Display only) Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and Service 
States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. CTC automatically configures the line 
direction during node setup. To change this setting, 
you must change the Cisco MetroPlanner site plan 
and import it to the node.

Under the drop-down list choose from the following.

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Administrative and Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

Type (Display only) Identifies the type of port. Display only

• Input Com

• Output Com

Power (Display only) Shows the current power level per 
port.

—

VOA Mode (32DMX only; display only) Shows the functional 
mode of the variable optical attenuator (VOA), 
when present. 

Display only

• Constant Attenuation

• Constant Power

VOA Power 
Ref

(32DMX only; display only) Shows the optical 
power setpoint that must be reached when a VOA is 
present and VOA Mode is set to Constant Power. 
This parameter can only be modified by Automatic 
Node Setup (ANS).

—

VOA Power 
Calib

(32DMX only) Modifies the optical power value of 
the VOA when VOA Mode is set to Constant Power.

—

VOA 
ATTenuation 
Ref

(32DMX only; display only) Shows the VOA 
attenuation value when VOA Mode is set to 
Constant Attenuation. This parameter can only be 
modified by ANS. 

—

VOA 
Attenuation 
Calib

(32DMX only) Modifies the attenuation value of 
the VOA when the VOA Mode is set to Constant 
Attenuation.

Numeric, double-click the paramenter, enter a value, 
and press Enter.

AINS Soak (Display only) Sets the automatic in-service soak 
period.

Display only

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Table 11-14 Multiplexer and Demultiplexer Card Optical Line Settings (continued)

Parameter Description Options
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DLP-G209 Change Optical Line Threshold Settings for Multiplexer and 
Demultiplexer Cards

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-15 shows the amplifier line thresholds 
for warnings. The provisionable paramenters are listed in the options column in the table.

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Table 11-16 shows the amplifier line thresholds for alarms.

Purpose This task changes the optical line threshold settings for 32MUX-O, 
32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-15  Multiplexer and Demultiplexer Cards Amplifier Line Warning Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: –50 dBm. 
Double-click the paramenter, enter a 
value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Default: 30 dBm. 
Double-click the paramenter, enter a 
value, and press Enter.
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 7 Return to your originating procedure (NTP).

DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer 
Cards

Step 1 In node view, double-click the multiplexer or demultiplexer card where you want to change the optical 
channel settings.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs. 

Step 3 Modify any of the settings described in Table 11-17.  The provisionable paramenters are listed in the 
options column in the table.

Table 11-16  Multiplexer and Demultiplexer Amplifier Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
Automatic Node Setup (ANS). You can 
manually change the threshold. The value 
must be within the optical power range 
that is specified for the card. (See 
Appendix B, “Hardware Specifications.”)

Numeric, double-click the paramenter, 
enter a value, and press Enter. 

Power Degrade 
High (dBm)

Not applicable to 32MUX-O, 32DMX-O, 
32DMX and 4MD cards.

—

Power Degrade 
Low (dBm)

Not applicable to 32MUX-O, 32DMX-O, 
32DMX and 4MD cards.

—

Power Add 
Failure Low 
(dBm)

Not applicable to 32MUX-O, 32DMX-O, 
32DMX and 4MD cards.

Numeric, double-click the paramenter, 
enter a value, and press Enter. 

Purpose This task changes the optical channel settings for 32MUX-O, 32DMX-O, 
32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-17 Multiplexer and Demultiplexer Card Optical Channel Settings

Parameter Description Options

Port # (Display only) Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and Service 
States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. CTC automatically configures the line 
direction during node setup. To change this setting, 
you must change the Cisco MetroPlanner site plan 
and import it to the node.

Under the drop-down list choose from the following.

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Administrative and Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type Identifies the type of port. Display only

• ADD

• DROP

Power (Display only) Shows the current power level per 
port.

—

VOA Mode (32MUX-O, 32DMX-0, 4MD only) Shows the 
current functional mode of the VOA.

Display only

• Constant Power 

• Constant Attenuation

VOA Power 
Ref.

(32MUX-O, 32DMX-0, 4MD only) Shows the 
Power setpoint that must be reached on the path 
where a VOA is present when the VOA Mode is 
Constant Power. 

Demultiplexers show the reference value of the 
desired optical power going to the client. 
Multiplexers show the reference value of the 
desired per-channel optical power. This parameter 
can only be modified by ANS.

Display only
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

VOA Power 
Calib.

(32MUX-O, 32DMX-0, 4MD only) The user can 
modify the optical output power to the VOA if 
necessary. The VOA power calibration offsets the 
VOA power reference.

For demultplexers, you can modify the optical 
output power to the client if necessary. For 
multiplexers, you can modify the output power per 
channel.

This feature is normally used when the Network 
Type is configured as Access in Provisioning > 
WDM-ANS tabs.

Numeric, double-click the parementer, enter a value 
and press Enter.

VOA 
Attenuation 
Ref.

(Display only; 32MUX-O, 32DMX-0, 4MD only) 
Shows the attenuation value of the VOA when the 
VOA is set in attenuation mode. This parameter can 
only be modified by ANS and APC.

Display only

VOA 
Attenuation 
Calib.

(32MUX-O, 32DMX-0, and 4MD only) Allows the 
user to modify the attenuation value of the VOA if 
necessary when the VOA mode is set for constant 
attenuation.

Numeric, dounle-click the parementer, enter a value 
and press Enter.

Actual 
Wavelength

(Display only) Shows the wavelength specified by 
the manufacturing data. This field cannot be set 
manually.

Display only

Expected 
Wavelength

Shows the preprovisioned wavelength. This field is 
used to preprovsion cards. 

Numeric, double-click the parementer, enter a value 
and press Enter.

AINS Soak (Display only) Sets the automatic in-service soak 
period.

Display only

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Table 11-17 Multiplexer and Demultiplexer Card Optical Channel Settings (continued)

Parameter Description Options
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DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and 
Demultiplexer Cards

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
threshold settings.

Step 2 Click the Provisioning > Optical Chn > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-18 shows the amplifier line thresholds 
for warnings. 

Table 11-19 shows the amplifier line thresholds for alarms.

Purpose This task changes the optical channel threshold settings for 32MUX-O, 
32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-18 Multiplexer and Demultiplexer Cards Optical Channel Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. —

opwrMin 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the paramenter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the paramenter, enter a 
value, and press Enter.
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Table 11-19  Multiplexer and Demultiplexer Cards Optical Channel Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 5 dB lower). 

The 32DMX is an exception. 32DMX 
Power Failure Low thresholds apply to 
ports not associated to a VOA. The 
threshold is calculated automatically 
when you run Automatic Node Setup 
(ANS). You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. (See Appendix B, “Hardware 
Specifications.”)

Numeric, double-click the paramenter, 
enter a value, and press Enter. 
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 7 Return to your originating procedure (NTP).

NTP-G93 Modify the 32WSS Thresholds and Settings

Power Degrade 
High (dBm)

Shows the power degrade high threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 3 dB higher). 

This threshold does not apply to the 
32DMX card. 

—

Power Degrade 
Low (dBm)

Shows the power degrade low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 2 dB lower). 

This threshold does not apply to the 
32DMX card. 

Numeric, double-click the paramenter, 
enter a value, and press Enter.

Purpose This procedure changes the 32WSS card thresholds and settings.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-19  Multiplexer and Demultiplexer Cards Optical Channel Alarm Thresholds Settings 

Parameter Description Options
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
32WSS card settings. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G212 Change Optical Channel Parameters for the 32WSS Card, page 11-32

• DLP-G213 Change the 32WSS Optical Channel Thresholds, page 11-35

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Chapter 8, “Manage Alarms.”

• DLP-G214 Change Optical Line Parameters for the 32WSS Card, page 11-37

• DLP-G215 Change the 32WSS Card Optical Line Thresholds, page 11-39

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

DLP-G212 Change Optical Channel Parameters for the 32WSS Card

Step 1 In node view, double-click the 32WSS card where you want to change the optical channel parameter 
settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connector tab for one of the four available groups of 
eight optical channels.

Step 3 Modify any of the settings described in Table 11-20.  The provisionable paramenters are listed in the 
options column in the table.

Purpose This task changes the optical channel parameter settings for the 32WSS 
card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-20 32WSS Optical Channel Parameter Settings

Parameter Description Options

Port (Display only) Shows the port number. Each 
optical channel (wavelength) has two logical 
ports. However only one is active at a time 
depending on the operating mode provisioned 
for the port on the card view Maintenance tab, 
either Add Drop or Pass Through.

Ports 1 through 32 (RX) are assigned to optical 
channels configured as Add Channels. Ports 33 
through 64 (PT) are assigned to optical channels 
configured as Pass-Through channels. 

—

Port Name Allows a logical name to be assigned for each of 
the port.

User-defined. Name can be up to 32 alphanumeric/special 
characters. Blank by default. Double-click, enter the 
name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Administrative and 
Service States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. 
For more information about service states, see 
Appendix C, “DWDM Administrative and 
Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Line Direction (Display only) Displays the line direction 
associated with the port. The parameter is 
automatically configured during ANS. 

Under the drop-down list choose from the following.

• East to West

• West to East

Type (Display only) Port type • Add

• Passthrough

Power Power value read by the photodiode located after 
the VOA associated to the port, and calibrated to 
the COM_TX port. For more information, see 
the “15.7.6 32WSS Card” section on 
page 15-76 and the “B.4.15 32WSS Card 
Specifications” section on page B-32.

Display only

• Numeric value (dB)

VOA Mode (Display only) Displays the active VOA working 
mode.

Display only

• Constant Power

• Constant Attenuation
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

VOA Power 
Reference

(Display only) Shows the value of the optical 
power setpoint that must be reached on the path 
where a VOA is present, when VOA Mode is set 
to Constant Power. This value is the desired 
per-channel optical power. This parameter can 
only be modified by ANS.

• Numeric value (dB)

VOA Power 
Calibration

Allows you to modify the VOA power value 
when VOA Mode is Constant Power.

Double-click the paramenter, enter a value, and press 
Enter.

• Numeric value (dB)

• –37 dB to –2 dB

VOA 
Attenuation 
Reference

(Display only) Shows the attenuation value of 
the VOA when the VOA Mode is Constant 
Attenuation. This parameter can only be 
modified by ANS.

Display only

• Numeric value (dB)

VOA 
Attenuation 
Calibration

Allows you to modify the VOA attenuation 
value when VOA Mode is Constant Attenuation.

Double-click the paramenter, enter a value, and press 
Enter.

• Numeric value (dB)

• –30 dB to +30 dB

Actual 
Wavelength

(Display only) Displays the actual wavelength 
utilized by the channel.

• Actual measured value (nm)

• UNKNOWN

Expected 
Wavelength

(Display only) Displays the expected 
wavelength assigned for the channel.

Display only

• Value (nm) from the ITU-T grid specification

• UNKNOWN

Power ADD (Display only) Displays a measurement of the 
optical power coming in on the ADD RX port. 
This is the power transmitted by the TX laser of 
the TXP/MXP card that is connected to the 
32WSS.

The measurement is performed by a photodiode 
before the selector and the VOA. The 
photodiode validates the power level of the 
incoming wavelength power. 

• Numeric value (dB)

Path Value (Display only) Displays Path value. • Standby

AINS Soak (Display only) Sets the automatic in-service 
soak period.

• Duration of valid input signal, in hh.mm format, after 
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments 

Table 11-20 32WSS Optical Channel Parameter Settings (continued)

Parameter Description Options
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DLP-G213 Change the 32WSS Optical Channel Thresholds

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 1 In node view, double-click the 32WSS card where you want to change the optical channel optics 
threshold settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connector>Optics threshold tab for one of the four 
groups of eight optical channels that are available.

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-21 shows the 32WSS optical line 
thresholds for warnings.  The provisionable paramenters are listed in the options column in the table.

Table 11-22 shows the 32WSS optical line thresholds for alarms.

Purpose This task changes the optical channel optics threshold settings for the 
32WSS card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-21 32WSS Optical Channel Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. —

OpwrMin 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
paramenter, enter a value, and press 
Enter.

OpwrMax 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
paramenter, enter a value, and press 
Enter.
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Table 11-22  32WSS Optical Channel Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. 
For each optical channel (wavelength) 
two “logical” ports are associated but 
only one port can be active at a time, 
depending on the port’s operating mode. 
The operating mode, provisioned on the 
card view Maintenance tab, is either Add 
Drop or Pass-Through.

Ports 1 through 32 (RX) are associated to 
optical channels configured as Add Drop 
channels.

Ports 33 through 64 (PT) are associated to 
optical channels configured as 
Pass-Through Channels.

—

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 5 dB lower). 

The threshold is calculated automatically 
when you run Automatic Node Setup 
(ANS). You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. (See Appendix B, “Hardware 
Specifications.”)

Numeric, double-click the paramenter, 
enter a value, and press Enter.. 

Power Degrade 
High (dBm)

Shows the power degrade high threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 3 dB higher). 

Display only
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Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change. 

Step 7 Return to your originating procedure (NTP).

DLP-G214 Change Optical Line Parameters for the 32WSS Card

Power Degrade 
Low (dBm)

Shows the power degrade low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

The threshold is automatically linked to 
the Power Setpoint (VOA Power Ref + 
VOA Power Calib) provisioned: changing 
the setpoint will result in changing the 
threshold (always 2 dB lower). 

Numeric, display only

Power ADD 
Failure Low 
(dBm)

Shows the power add failure low 
threshold. This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to the actual 
measurement of the optical power on the 
ADD RX port, that is, the power 
transmitted by the Trunk-Tx laser of the 
TXP/MXP card connected to the 32 WSS.

The measurement is performed by a 
photodiode located before the selector 
and the VOA to validate the incoming 
wavelength power level. See the 
“15.7.6 32WSS Card” section on 
page 15-76 for more information.

Numeric, double-click the paramenter, 
enter a value, and press Enter.

Purpose This task changes the optical line parameter settings for the 32WSS card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-22  32WSS Optical Channel Alarm Thresholds Settings (continued)

Parameter Description Options
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Step 1 In node view, double-click the 32WSS card where you want to change the optical line parameter settings.

Step 2 Click the Provisioning > Optical Line > Parameters tab.

Step 3 Modify any of the settings described in Table 11-23. The provisionable paramenters are listed in the 
options column in the table. 

Table 11-23 32WSS Optical Line Parameter Settings

Parameter Description Options

Port (Display only) Port designation information. See 
“15.7.6 32WSS Card” section on page 15-76 for 
more information.

—

Port Name Allows you to assign a logical name for each of the 
ports shown.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 7-9.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Administrative and Service States.”

Under the drop-down list choose from the following.

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Administrative and Service States.”

Display only

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Line 
Direction

Shows the line direction associated with the optical 
signal that passes through the port.

This parameter is automatically configured during 
ANS.

Under the drop-down list choose from the following.

• West to East

• East to West

Type Port type Display only

• Output Express

• Input Express

• Out Com

• Input Com

• Drop
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Step 4 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

DLP-G215 Change the 32WSS Card Optical Line Thresholds

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through 
custom alarm profiles.

Step 1 In node view, double-click the 32WSS card where you want to change the optical line optics warning 
threshold settings.

Step 2 Click the Provisioning > Optical Line > Optical Thresholds tab for one of the four groups of eight 
optical channels that are available.

Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 11-24 shows the 32WSS optical line 
thresholds for warnings.  The provisionable paramenters are listed in the options column in the table.

Power Power value read by the photodiode associated with 
the port.

Display only

• Numeric value (dB)

AINS Soak Sets the automatic in-service soak period. • Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Purpose This task changes the 32WSS card optical line threshold settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-24 32WSS Optical Channel Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Table 11-23 32WSS Optical Line Parameter Settings (continued)

Parameter Description Options
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Table 11-25 shows the 32WSS optical line thresholds for alarms.

Step 6 Click Apply. If the change affects traffic a warning message displays, click Yes to complete the change.

Step 7 Return to your originating procedure (NTP).

OprMin (dBm) Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is –50dBm.

OpwMax(dBm
)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30dBm.

Table 11-24 32WSS Optical Channel Warning Threshold Settings (continued)

Parameter Description Options

Table 11-25  32WSS Optical Channel Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

You can manually change the threshold. 
The value must be within the optical 
power range that is specified for the card. 
(See Appendix B, “Hardware 
Specifications.”)

Numeric, double-click the paramenter, 
enter a value, and press Enter. 

Power Degrade 
High (dBm)

Does not apply to 32WSS cards at the 
optical line level.

—

Power Degrade 
Low (dBm)

Does not apply to 32WSS cards at the 
optical line level.

Numeric
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NTP-G101 Modify Alarm Interface Controller–International 
Settings

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
AIC-I card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G245 Change External Alarms Using the AIC-I Card, page 11-41

• DLP-G246 Change External Controls Using the AIC-I Card, page 11-42

• DLP-G247 Change AIC-I Card Orderwire Settings, page 11-43

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 12-2.

Stop. You have completed this procedure.

DLP-G245 Change External Alarms Using the AIC-I Card

Note The procedure is the same if you are using the alarm expansion panel (AEP). In this case, the number of 
contacts that are shown on the screen is changed accordingly. 

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-47 (ETSI) or “DLP-G23 Install Alarm 
Wires on the Backplane (ANSI Only)” task on page 1-52 (ANSI) for more information.

Purpose This procedure provisions the AIC-I card to receive input from or send 
output to external devices wired to the backplane (called external alarms 
and controls or environmental alarms), or to change orderwire settings. 

Tools/Equipment None

Prerequisite Procedures NTP-G72 Provision External Alarms and Controls on the Alarm Interface 
Controller-International Card, page 8-31 

DLP-G109 Provision Orderwire, page 7-18

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes external alarm settings on the AIC-I card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Double-click the AIC-I card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs.

Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International Card” procedure on page 8-31.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Step 5 To provision additional devices, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

DLP-G246 Change External Controls Using the AIC-I Card

Note The task is the same if you are using the AEP. In this case, the number of contacts that are shown on the 
screen is changed accordingly. 

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-47 (ETSI) or “DLP-G23 Install Alarm 
Wires on the Backplane (ANSI Only)” task on page 1-52 (ANSI) for more information. 

Step 2 In node view, double-click the AIC-I card to display it in card view.

Step 3 On the External Controls subtab, modify any of the following fields for each external control wired to 
the ONS 15454 backplane. For definitions of these fields, see the “NTP-G72 Provision External Alarms 
and Controls on the Alarm Interface Controller-International Card” procedure on page 8-31.

• Enabled

• Trigger Type

• Control Type

• Description

Step 4 To provision additional controls, complete Step 3 for each additional device.

Purpose This task changes external control settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G247 Change AIC-I Card Orderwire Settings

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Step 1 In node view, double-click the AIC-I card to display it in card view.

Step 2 Click the Provisioning > Local Orderwire tabs or the Provisioning > Express Orderwire tabs, 
depending on the orderwire path that you want to change. Provisioning steps are the same for both types 
of orderwire.

Step 3 If needed, adjust the Tx and Rx dBm values by moving the slider to the right or left for the headset type 
(four-wire or two-wire) that you will use. In general, you should not need to adjust the dBm values.

Step 4 If you want to turn on the audible alert (buzzer) for the orderwire, check the Buzzer On check box.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes orderwire settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G102 Change Card Service State

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to change the 
card service state.

Step 2 Click the Inventory tab.

Step 3 Click Admin State for the card you want to change, and choose an Admin state from the drop-down list:

• IS (In-Service [ANSI]) or Unlocked (ETSI)

• OOS,MT (Out-of-Service,Maintenance [ANSI]) or Locked-enabled (ETSI)

Step 4 Click Apply.

Step 5 If an error message appears indicating that the card state cannot be changed from its current state, click 
OK.

For information about the enhanced state model and card state transitions, refer to the “DWDM 
Administrative and Service States” section on page C-1.

Stop. You have completed this procedure.

Purpose This procedure changes a card service state. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27 or
NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454, including database backups and 
restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware 
maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance 
procedures.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454 SDH 
Troubleshooting Guide as necessary for general troubleshooting information and alarm or error 
descriptions. 

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G103 Back Up the Database, page 12-2—Complete as needed.

2. NTP-G104 Restore the Database, page 12-3—Complete as needed.

3. NTP-G105 Restore the Node to Factory Configuration, page 12-4—Complete as needed to clear the 
database and upload a blank database and the latest software.

4. NTP-G106 Reset Cards Using CTC, page 12-9—Complete as needed to reset the Advanced Timing, 
Communications, and Control (TCC2/TCC2P) and dense wavelength division multiplexing 
(DWDM) cards.

5. NTP-G108 Viewing the Audit Trail Records, page 12-11—Complete as needed.

6. NTP-G109 Off-Load the Audit Trail Record, page 12-13—Complete as needed.

7. NTP-G110 Off-Load the Diagnostics File, page 12-13—Complete as needed. 

8. NTP-G112 Change the Node Timing Reference, page 12-14—Complete as needed.

9. NTP-G113 View the ONS 15454 Timing Report, page 12-16—Complete as needed.

10. NTP-G114 Inspect, Clean, and Replace the Air Filter, page 12-19—Complete as needed.

11. NTP-G115 Clean Fiber Connectors, page 12-22—Complete as needed.

12. NTP-G40 Replace the Front Door, page 12-25—Complete as needed.

13. NTP-G116 Replace the Fan-Tray Assembly, page 12-27—Complete as needed.
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14. NTP-G117 Replace the ANSI Shelf Alarm Interface Panel, page 12-32—Complete as needed.

15. NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover, page 12-36—Complete as 
needed.

16. NTP-G135 Edit Network Element Defaults, page 12-38—Complete as needed to edit the 
factory-configured (default) network element settings for the Cisco ONS 15454.

17. NTP-G136 Import Network Element Defaults, page 12-39—Complete as needed to import the 
factory-configured (default) network element settings for the Cisco ONS 15454.

18. NTP-G137 Export Network Element Defaults, page 12-40—Complete as needed to export the 
factory-configured (default) network element settings for the Cisco ONS 15454.

NTP-G103 Back Up the Database

Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a 
backed up database with a different node name, the circuits map to the new node name. Cisco 
recommends keeping a record of the old and new node names.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node you want to back up. If you are 
already logged in, continue with Step 2.

Step 2 Click the Maintenance > Database tabs.

Step 3 Click Backup.

Step 4 Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name 
with the db file extension; for example, database.db.

Step 5 Click Save.

Step 6 Click OK in the confirmation dialog box.

Stop. You have completed this procedure.

Purpose This procedure stores a backup version of the TCC2/TCC2P (software) 
database on the workstation running Cisco Transport Controller (CTC) 
or on a network server.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required. Cisco recommends performing a database backup at 
approximately weekly intervals and prior to and after configuration 
changes.

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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NTP-G104 Restore the Database

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and IIOP port. If you change the node name and then restore a backed up database with a 
different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of 
the old and new node names.

Caution If you are restoring the database on multiple nodes, wait approximately one minute after the 
TCC2/TCC2P card reboot has completed on each node before proceeding to the next node.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you are restoring the 
database. If you are already logged in, continue with Step 2.

Step 2 Click the Circuits tab. Verify that no OCHNC circuits have a PARTIAL_OOS state. If so, investigate 
and resolve the partial state before continuing.

Step 3 Complete the “DLP-G157 Disable Automatic Power Control” task on page 10-4.

Step 4 In node view, click the Maintenance > Database tabs.

Step 5 Click Restore.

Step 6 Locate the database file stored on the workstation hard drive or on network storage. 

To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 
software CD.

Step 7 Click the database file to highlight it. 

Step 8 Click OK. The DB Restore dialog box appears. Opening a restore file from another node or from an 
earlier backup might affect traffic on the login node

Step 9 Click Yes.

The Restore Database dialog box monitors the file transfer (Figure 12-1).

Figure 12-1 Restoring the Database—In-Process Notification

Step 10 Wait for the file to complete the transfer to the TCC2/TCC2P card.

Purpose This procedure restores the TCC2/TCC2P card software database.

Tools/Equipment None

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 11 Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for 
the node to reconnect.

Step 12 Complete the “DLP-G158 Enable Automatic Power Control” task on page 10-4.

Stop. You have completed this procedure.

NTP-G105 Restore the Node to Factory Configuration

Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinit tool chooses the first product-specific software package in the specified directory if you use 
the Search Path field instead of the Package and Database fields. You might accidentally copy an 
incorrect database if multiple databases are kept in the specified directory.

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Cisco recommends that you save the node database to safe location if you will not be restoring the node 
using the database provided on the software CD.

Purpose This procedure reinitializes the ONS 15454 using the CTC 
reinitialization tool. Reinitialization uploads a new software package to 
the TCC2/TCC2P cards, clears the node database, and restores the 
factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 5.0

JRE 1.4.2 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02 or JRE 1.4.2. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

NTP-G17 Set Up Computer for CTC, page 2-1

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1 If you need to install or replace one or more TCC2/TCC2P cards, see the “DLP-G33 Install the TCC2 
or TCC2P Card” task on page 1-70.

Step 2 If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear the 
Database and Upload Software (Windows)” task on page 12-5.

Step 3 If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database 
and Upload Software (UNIX)” task on page 12-7.

Stop. You have completed this procedure.

DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload 
Software (Windows)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Purpose This task reinitializes the ONS 15454 using the CTC reinitialization tool 
on a Windows computer. Reinitialization uploads a new software 
package to the TCC2/TCC2P cards, clears the node database, and 
restores the factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 5.0

JRE 1.4.2 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02 or JRE 1.4.2. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

NTP-G17 Set Up Computer for CTC, page 2-1

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed to clear the existing database from a TCC2/TCC2P and 
restore the node default settings.

Onsite/Remote Onsite

Security Level Superuser
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Note The ONS 14545 Software CD is required if the Reinit.jar file, the CISCO 15454 package file, 
and the NE default file are not stored on your computer.

Step 1 Insert the ONS 15454 System Software CD, Version 5.0, into the computer CD-ROM drive. If the CTC 
Installation Wizard appears, click Cancel.

Step 2 From the Windows Start menu, choose Run. In the Run dialog box, click Browse and navigate to the 
CISCO15454 or CISCO15454SDH folder on the software CD.

Step 3 In the Browse dialog box Files of Type field, choose All Files. 

Step 4 Choose the RE-INIT.jar file and click Open. The NE Re-Initialization window appears (Figure 12-2).

Figure 12-2 Reinitialization Tool

Step 5 Complete the following fields: 

• GNE IP—If the node you are reinitializing is accessed through another node configured as a gateway 
network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave 
this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version.

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the 
installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tabs.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 
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• Search Path—Enter the path to the CISCO15454 folder on the CD drive.

Step 6 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 7 Review the information on the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated, and the database is uploaded 
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. 
Wait a few minutes for the reboot to complete.

Step 8 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-24.

Step 9 Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 
and “NTP-G26 Set Up CTC Network Access” procedure on page 3-10.

Step 10 Return to your originating procedure (NTP).

DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload 
Software (UNIX)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Purpose This task reinitializes the ONS 15454 using the CTC reinitialization tool 
on a UNIX computer. Reinitialization uploads a new software package 
to the TCC2/TCC2P cards, clears the node database, and restores the 
factory default parameters.

Tools/Equipment ONS 15454 SONET System Software CD, Version 5.0.x

JRE 1.4.2 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02 or JRE 1.4.2. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 12-2

NTP-G17 Set Up Computer for CTC, page 2-1

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed to clear the existing database from a TCC2/TCC2P and 
restore the node default settings.

Onsite/Remote Onsite

Security Level Superuser
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Step 1 Insert the system software CD containing the reinit tool, software, and defaults database into the 
computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually 
/cdrom/cdrom0/CISCO15454 or /cdrom/cdrom0/CISCO15454SDH).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file. If you are working with a command 
line, run java -jar RE-INIT.jar. The NE Re-Initialization window appears (Figure 12-2).

Step 4 Complete the following fields: 

• GNE IP—If the node you are reinitializing is accessed through another node configured as a gateway 
network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave 
this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version. 

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the 
installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tabs.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 

• Search Path—Enter the path to the CISCO15454 or CISCO15454SDH folder on the CD drive.

Step 5 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 6 Review the information on the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated and the database is uploaded 
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. 
Wait a few minutes for the reboot to complete.

Step 7 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-24.

Step 8 Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 
and “NTP-G26 Set Up CTC Network Access” procedure on page 3-10.

Step 9 Return to your originating procedure (NTP).
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NTP-G106 Reset Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you are performing the 
TCC2/TCC2P reset. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 12-9.

Step 3 As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 12-10.

Stop. You have completed this procedure. 

DLP-G250 Reset the TCC2/TCC2P Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change 
you made to avoid losing any changes to the database.

Note When a software reset is performed on an active TCC2/TCC2P, the AIC-I card goes through an 
initialization process and also resets. The AIC-I card reset is normal and happens each time an active 
TCC2/TCC2P card goes through a software-initiated reset.

Purpose This procedure resets the TCC2/TCC2P and DWDM cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-70

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task resets the TCC2/TCC2P card and switches the node to the 
redundant TCC2/TCC2P.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-70

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 1 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or 
Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 2 In node view, right-click the TCC2/TCC2P card to reveal a drop-down list.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note For LED behavior during a TCC2/TCC2P reboot, see Table 3-2 on page 3-13.

Step 6 Confirm that the TCC2/TCC2P card LED is amber (standby).

Step 7 Return to your originating procedure (NTP).

DLP-G251 Reset DWDM Cards Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note ONS 15454 cards normally do not need to be reset. However, you may occasionally need to reset a card 
for testing or as an initial trouble-clearing step. For additional information, see the Cisco ONS 15454 
Troubleshooting Guide or Cisco ONS 15454 SDH Troubleshooting Guide.

Step 1 If you will switch an active TXP or MXP card that is in a Y-Cable protection group, complete the 
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-25. If not, continue 
with Step 2.

Purpose This task resets the OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 
32DMX, 32WSS, OPT-BST, OPT-PRE, AD-xC.xx.x, AD-xB.xx.x, 
TXP, and MXP cards using CTC.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-27

NTP-G32 Install the Transponder and Muxponder Cards, page 3-31

DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 2 Right-click the card you want to reset to reveal a drop-down list.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white 
LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

Step 5 If you performed a Y-Cable protection group switch in Step 1, complete the “DLP-G180 Clear a Manual 
or Force Y-Cable or Splitter Protection Switch” task on page 10-26. If not, continue with Step 6.

Step 6 Return to your originating procedure (NTP).

NTP-G108 Viewing the Audit Trail Records

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to view the audit 
trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

A window containing the most recent audit trail records appears as shown in Figure 12-3.

Purpose This procedure explains how to view audit trail records. Audit trail records 
are useful for maintaining security, recovering lost transactions, and 
enforcing accountability. Accountability refers to tracing user activities; 
that is, associating a process or action with a specific user.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 12-3 Viewing the Audit Trail Records

A definition of each column in the audit trail log is listed in Table 12-1.

Right-click on the column headings to display the list in ascending-to-descending or 
descending-to-ascending order. 

Left-click on the column heading to display the following options:

• Reset Sorting—Resets the column to the default setting

• Hide Column—Hides the column from view

• Reset Columns Order/Visibility—Displays all hidden columns

• Row Count—Provides a numerical count of log entries

Shift-click on the column heading for an incremental sort of the list.

Stop. You have completed this procedure.

Table 12-1 Audit Trail Column Definitions

Column Definition

Date Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (that is, whether or not the action was executed)

Operation Action that was taken
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NTP-G109 Off-Load the Audit Trail Record

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to off-load the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save. Click OK

The 640 entries are saved in this file. The next entries continue with the next number in the sequence, 
rather than starting over.

Note Archiving does not delete entries from the CTC audit trail log. However, entries can be 
self-deleted by the system after the log maximum is reached. If you archived the entries, you 
cannot reimport the log file back into CTC and will have to view the log in a different 
application.

Stop. You have completed this procedure.

NTP-G110 Off-Load the Diagnostics File

Purpose This procedure describes how to off-load up to 640 audit trail log entries 
in a local or network drive file to maintain a record of actions performed 
for the node. If the audit trail log is not off-loaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure describes how to off-load a diagnostic file. The diagnostic 
file contains a set of debug commnds run on a node and its results. This 
file is useful to TAC when troubleshooting problems with the node.

Tools/Equipment None

Prerequisite Procedures None
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to off-load the 
diagnostics file. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Diagnostic tabs.

Step 3 Click Retrieve Tech Support Log.

Step 4 In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be 
unzipped and read by Cisco Technical Support.

Step 6 Click Save.

The Get Diagnostics status window shows a progress bar indicating the percentage of the file being 
saved, then shows “Get Diagnostics Complete.”

Step 7 Click OK.

Stop. You have completed this procedure.

NTP-G112 Change the Node Timing Reference

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to enable timing 
switching. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G259 Manual or Force Switch the Node Timing Reference” task on page 12-15 as 
needed.

Step 3 Complete the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on 
page 12-15 as needed.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This procedure describes how to off-load a diagnostic file. The diagnostic 
file contains a set of debug commnds run on a node and its results. This 
file is useful to TAC when troubleshooting problems with the node.

Purpose This procedure enables automatic timing reference switching or returns 
the node timing to normal operation.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 6-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Stop. You have completed this procedure.

DLP-G259 Manual or Force Switch the Node Timing Reference

Step 1 In node view, click the Maintenance > Timing > Source tabs.

Step 2 From the Reference drop-down list for the desired Clock, choose the desired reference.

Step 3 From the Operation drop-down list for the desired Clock, choose one of the following options:

• Manual—This operation commands the node to switch to the reference you have selected if the 
SSM quality of the reference is not lower than the current timing reference.

• Force—This operation commands the node to switch to the reference you have selected, regardless 
of the SSM quality (if the reference is valid).

Note For information about the Clear option, see the “DLP-G260 Clear a Manual or Force Switch 
on a Node Timing Reference” task on page 12-15.

Step 4 Click Apply next to the timing source.

Step 5 Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid 
reference, the node switches to the selected timing reference. If the selected timing reference is invalid, 
a warning dialog box appears. Click OK; the node will not switch to the new timing reference. 

Step 6 Return to your originating procedure (NTP).

DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference

Purpose This task commands the node to switch to the timing reference you have 
selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task clears a Manual or Force switch on a node timing reference and 
reverts the timing reference to its provisioned reference.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 1 In node view, click the Maintenance > Timing > Source tabs.

Step 2 Find the Clock reference that is currently set to Manual or Force in the Operation menu.

Step 3 From the Operation drop-down list, choose Clear.

Step 4 Click Apply.

Step 5 Click Yes in the confirmation dialog box. If the normal timing reference is an acceptable valid reference, 
the node switches back to the normal timing reference as defined by the system configuration. If the 
normal timing reference is invalid or has failed, a warning dialog box appears. Click OK; the timing 
reference will not revert.

Step 6 Return to your originating procedure (NTP).

NTP-G113 View the ONS 15454 Timing Report

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to view the node 
timing status. If you are already logged in, continue with Step 2.

Step 2 Click the Maintenance > Timing > Report tabs.

Step 3 In the Timing Report area, you can view node timing information. The date and time of the report appear 
at the top of the report. The time stamp is the same as the alarms time stamp and can be configured using 
the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-10. Table 12-2 
describes the report fields and entries. 

Step 4 To update the report, click Refresh.

Purpose This procedure displays the current status of the ONS 15454 timing 
references.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 6-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Table 12-2 ONS 15454 Timing Report

Item Description Option Option Description

Clock Indicates the 
timing clock. The 
report section that 
follows applies to 
the timing clock 
indicated.

NE The node timing clock.

BITS-1 Out The BITS-1 Out timing clock.

BITS-2 Out The BITS-2 Out timing clock.
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Status Indicates the 
status of the 
timing clock.

INIT_STATE The timing reference has not been provisioned. For an NE 
reference, this status appears just before the first 
provisioning messages when the TCC2/TCC2P card is 
booting. Timing is provisioned to the internal clock of the 
node.

HOLDOVER_STATE The clock was locked onto a valid timing reference for 
more than 140 seconds when a failure occurred. Holdover 
state timing is a computation based on timing during 
normal state combined with the node’s internal clock. The 
node holds onto this frequency until the valid reference is 
restored. This status appears for NE references only.

FREERUN_STATE The node is running off its internal clock without any 
modification except the calibrated value to bring timing to 
0 PPM. Freerun state can occur when a Force switch to the 
Internal clock is initiated, when all references fail without 
the 140 seconds of holdover data, or when only Internal 
timing references are defined. This status appears for NE 
references only.

NO_SYNC_STATE A synchronization timing reference is not defined. 
BITS-1 Out or BITS-2 Out default to this status until an 
OC-N card is defined as its reference on the 
Provisioning > Timing tab. This status appears for external 
references only.

NE_SYNCH_STATE BITS-1 Out and BITS-2 Out use the same timing source as 
the NE. This is displayed when NE Reference is selected 
in the BITS-1 Out and BITS-2 Out Reference List on the 
Provisioning > Timing tab.

NORMAL_STATE The timing reference is locked onto one of its provisioned 
references. The reference cannot be Internal or 
NO SYNC STATE.

FAST_START_STATE The node has switched references, but the reference is too 
far away to reach NORMAL_STATE within an acceptable 
amount of time. FAST_START_STATE is a fast 
acquisition mode to allow the node to quickly acquire the 
reference. After it achieves this goal, the node progresses 
to the normal state.

FAST_START_FAILED_STATE A timing reference is too far away to reach in normal state. 
The FAST_START_STATE could not acquire sufficient 
timing information within the allowable amount of time.

Status 
Changed 
At

Date and time of 
the last status 
change.

— —

Switch 
Type

Type of switch. AUTOMATIC The timing switch was system-generated.

Manual The timing switch was a user-initiated Manual switch.

Force The timing switch was user-initiated Force switch.

Table 12-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description
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Stop. You have completed this procedure.

Reference Indicates the 
timing reference.

Three timing references are 
available on the Provisioning > 
Timing tab.

—

Selected Indicates whether 
the reference is 
selected.

Selected references are indicated 
with an X.

—

Facility Indicates the 
timing facility 
provisioned for 
the reference on 
the Provisioning > 
Timing tab.

BITS-1 The timing facility is a building integrated timing supply 
(BITS) clock attached to the node’s BITS-1 pins.

BITS-2 The timing facility is a BITS clock attached to the node’s 
BITS-2 pins.

OC-N/STM-N card with port 
number

If the node is set to line timing, this is the OC-N /STM-N 
card and port provisioned as the timing reference.

Internal clock The node is using its internal clock.

State Indicates the 
timing reference 
state.

IS The timing reference is in service.

OOS The timing reference is out of service.

Condition Indicates the 
timing reference 
state.

OKAY The reference is valid to use as a timing reference.

OOB Out of bounds; the reference is not valid and cannot be 
used as a timing reference, for example, a BITS clock is 
disconnected.

Condition 
Changed

Indicates the date 
and time of the 
last status change 
in MM/DD/YY 
HH:MM:SS 
format.

— —

SSM Indicates whether 
SSM is enabled 
for the timing 
reference.

Enabled SSM is enabled.

Disabled SSM is not enabled.

SSM 
Quality

Indicates the SSM 
timing quality.

8 to 10 SSM quality messages 
might be displayed.

For a list of SSM message sets, see the 
“19.2.2 Synchronization Status Messaging” section on 
page 19-8.

SSM 
Changed

Indicates the date 
and time of the 
last SSM status 
change in 
MM/DD/YY 
HH:MM:SS 
format.

— —

Table 12-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description
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NTP-G114 Inspect, Clean, and Replace the Air Filter

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Caution Cisco recommends that you inspect the air filter monthly, and clean the filter every three to six months. 
Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or 
solvents.

Note Although the filter can work if it is installed with either side facing up, Cisco recommends that you 
install it with the metal bracing facing up to preserve the surface of the filter. 

Step 1 Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell, 
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later 
versions of the ONS 15454 use a reusable air filter. 

Step 2 If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being 
careful not to dislodge any dust that might have collected on the filter and proceed to Step 9. Figure 12-4 
shows the reusable fan-tray air filter in an external filter bracket on an ANSI shelf. Figure 12-5 shows 
the reusable fan-tray air filter in an external filter bracket on an ETSI shelf. 

Step 3 If the filter is installed below the fan tray and not in the external filter brackets, open the front door of 
the shelf assembly. If the front door is already open, proceed to Step 4.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 4 Remove the front door (optional). If you do not want to remove the door or it is already removed, proceed 
to Step 5.

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Purpose This procedure ensures that the air filter is free from dirt and dust, which 
allows optimum air flow and prevents dirt and dust from entering the 
shelf.

Tools/Equipment Vacuum or detergent and water faucet, spare filter, pinned hex key tool

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 12-4 ANSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Figure 12-5 ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Step 5 Push the outer side of the handles on the fan-tray assembly to expose the handles. 
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Step 6 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 8 Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that might have 
collected on the filter.

Step 9 Visually inspect the air filter material for dirt and dust.

Step 10 If the reusable air filter contains a concentration of dirt and dust, replace the dirty air filter with a clean 
air filter (spare filters should be kept in stock) and reinsert the fan-tray assembly. Then, vacuum the dirty 
air filter or wash it under a faucet with a light detergent. 

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can 
damage the ONS 15454 cards.

Note Cleaning should take place outside of the operating environment to avoid releasing dirt and dust 
near the equipment.

Step 11 If you washed the filter, allow it to completely air dry for at least eight hours.

Caution Do not put a damp filter back in the ONS 15454.

Step 12 Replace the clean filter:

a. If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back 
of the brackets to complete the procedure, continue to step 16.

b. If the filter is installed below the fan-tray assembly, remove the fan-tray assembly and slide the 
dry/clean air filter into the recessed compartment at the bottom of the shelf assembly. Put the front 
edge of the air filter flush against the front edge of the recessed compartment. Push the fan tray back 
into the shelf assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and 
readjust the position of the reusable filter until the fan tray fits correctly.

Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly 
inserted. 

Step 13 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information.

Step 14 Rotate the retractable handles back into their compartments.

Step 15 If you replace the door, also reattach the ground strap.

Step 16 Close and lock the door.

Stop. You have completed this procedure.
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NTP-G115 Clean Fiber Connectors

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Step 1 Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2 Replace any damaged fiber connectors.

Note Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3 Complete the “DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry 
Wipes” task on page 12-23 as necessary.

Step 4 Complete the “DLP-G262 Clean Fiber Connectors with CLETOP” task on page 12-23 as necessary.

Step 5 Complete the “DLP-G263 Clean the Fiber Adapters” task on page 12-24 as necessary. 

Stop. You have completed this procedure.

Purpose This procedure cleans the fiber connectors.

Tools/Equipment Inspection microscope

Compressed air/duster

Type A Fiber Optic Connector Cleaner (CLETOP reel)

Isopropyl alcohol 70 percent or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and 
Dry Wipes

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Step 1 Remove the dust cap from the fiber connector.

Step 2 Wipe the connector tip with the premoistened alcohol wipe.

Step 3 Blow-dry using filtered air.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the dust 
cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap using a CLETOP 
stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

DLP-G262 Clean Fiber Connectors with CLETOP

Purpose This task cleans the fiber connectors and adapters with alcohol and dry 
wipes.

Tools/Equipment Compressed air/duster

Isopropyl alcohol 70 percent or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task cleans the fiber connectors with CLETOP.

Tools/Equipment Type A Fiber Optic Connector Cleaner (CLETOP reel)

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Step 1 Remove the dust cap from the fiber connector.

Step 2 Press the lever down to open the shutter door. Each time you press the lever, you expose a clean wiping 
surface.

Step 3 Insert the connector into the CLETOP cleaning cassette slot, rotate one quarter turn, and gently swipe 
downwards.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap 
using a CLETOP stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

DLP-G263 Clean the Fiber Adapters

Step 1 Remove the dust plug from the fiber adapter.

Step 2 Insert a CLETOP stick swab (14100400) into the adapter opening and rotate the swab.

Step 3 Place dust plugs on the fiber adapters when not in use.

Step 4 Return to your originating procedure (NTP).

Purpose This task cleans the fiber adapters.

Tools/Equipment CLETOP stick swab

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-G40 Replace the Front Door 

Note Be careful not to crimp any fiber cables that are connected to the MXP/TXP cards or DWDM cards. 
Some might not have the fiber boot attached. 

Step 1 Insert the front door into the hinges on the shelf assembly.

Step 2 Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside of the door. 
Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench (Figure 12-6).

Figure 12-6 Installing the Door Ground Strap Retrofit Kit

Step 3 Attach the other end of the ground strap to the longer screw on the fiber guide.

a. Attach the lock washer.

Purpose This procedure replaces the front door and door ground strap after 
installing cards and fiber-optic cables. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

71
04
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b. Attach the terminal lug.

c. Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug. 

Note To avoid interference with the traffic (line) card, make sure the ground strap is in a flat 
position when the door is open. To move the ground strap into a flat position, rotate the 
terminal lug counterclockwise before tightening the Kepnut.

Step 4 Replace the left cable-routing channel.

Step 5 Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.

Figure 12-7 shows the shelf assembly with the front door and ground strap installed.

Figure 12-7 Shelf Assembly with Door Ground Strap Retrofit Kit Installed

Step 6 Swing the door closed. 

Note The ONS 15454 comes with a pinned hex key tool for locking and unlocking the front door. Turn 
the key counterclockwise to unlock the door and clockwise to lock it. 

Stop. You have completed this procedure. 

71
04

6

Ground strap cable
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NTP-G116 Replace the Fan-Tray Assembly

Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies 
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly includes a 
pin that prevents it from being installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can 
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the backplane.

Note To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities. 

Step 1 Review Table 12-3 (ANSI) or Table 12-4 (ETSI) to ensure that you have compatible components when 
replacing the fan-tray assembly. Note the alarms that will be generated when an incompatibility occurs.

Note If you need to determine the hardware that has been installed on a node, click the Inventory tab 
in node view.

Purpose This procedure replaces a malfunctioning fan-tray assembly.

Tools/Equipment None

Prerequisite Procedures NTP-G8 Install the Fan-Tray Assembly

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 12-3 Incompatibility Alarms for ONS 15454 ANSI

Shelf Assembly1 Fan Tray2 AIP3 10G Cards4 Ethernet Cards5 Alarms

— — No fuse — — Mismatch of 
Equipment Attributes 
(MEA) on alarm 
interface panel (AIP)

NEBS3E or NEBS3 2A 2A No — None

NEBS3E or NEBS3 2A 2A Yes — MEA on 10G

NEBS3E or NEBS3 2A 5A No — None

NEBS3E or NEBS3 2A 5A Yes — MEA on 10G

ANSI or HD 2A 2A No — None

ANSI or HD 2A 2A Yes 2.5G compatible MEA on fan tray, AIP, 
and Ethernet
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ANSI or HD 2A 2A Yes 10G compatible MEA on fan tray and 
AIP

ANSI or HD 2A 5A No Either None

ANSI or HD 2A 5A Yes 2.5G compatible MEA on fan tray and 
Ethernet

ANSI or HD 2A 5A Yes 10G compatible MEA on fan tray

ANSI or HD 5A 2A No Either MEA on AIP

ANSI or HD 5A 2A Yes 2.5G compatible MEA on AIP and 
Ethernet

ANSI or HD 5A 2A Yes 10G compatible MEA on AIP

ANSI or HD 5A 5A No Either None

ANSI or HD 5A 5A Yes Either None

1. 15454-SA-NEBS3E (P/N: 800-07149-xx) or 15454-SA-NEBS3 (P/N: 800-06741-xx) = shelf assemblies released before 
ONS 15454 Release 3.1
15454-SA-ANSI (P/N: 800-19857-01) = ONS 15454 Release 3.1 and later shelf assembly
15454-SA-HD (P/N: 800-24848) = ONS 15454 Release 3.1 and later shelf assembly

2. 5A Fan Tray = 15454-FTA3 (P/N: 800-19858-xx) or 15454-FTA3-T (P/N: 800-21448-xx)
2A Fan Tray = 15454-FTA2 (P/Ns: 800-07145-xx, 800-07385-xx, 800-19591-xx, 800-19590-xx)

3. 5A AIP (P/N: 73-7665-01), 2A AIP (P/N: 73-5262-01)

4. 10G cards include the XC10G, OC192, and OC48AS.

5. 2.5G indicates cards that are compatible with the XCVT cross-connect card. 10G indicates cards that are compatible with the 
XC10G and XC-VXC-10G cross-connect cards.

Table 12-4 Incompatibility Alarms for ONS 15454 ETSI 

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards Alarms

15454E-SA-ETSI 2A No — None

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 2A No — None

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 5A No — MEA on fan tray

15454E-SA-ETSI 5A Yes — MEA on fan tray and 10G 
cards

15454E-SA-ETSI 5A No — None

15454E-SA-ETSI 5A Yes — MEA on 10G

ETSI 2A No — None

ETSI 2A Yes 2.5G compatible MEA on fan tray or 
Ethernet

ETSI 2A Yes 10G compatible MEA on fan tray

ETSI 2A No Either None

ETSI 2A Yes 2.5G compatible MEA on fan tray, Ethernet

Table 12-3 Incompatibility Alarms for ONS 15454 ANSI (continued)

Shelf Assembly1 Fan Tray2 AIP3 10G Cards4 Ethernet Cards5 Alarms
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Step 2 Open the front door of the shelf assembly. If the shelf assembly does not have a front door, continue with 
Step 4. 

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 3 Remove the front door (optional). If you do not want to remove the door, proceed to Step 4.

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step 4 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 5 Fold out the retractable handles at the outside edges of the fan tray.

Step 6 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly. 
Figure 12-8 shows the location of the fan tray on the ONS 15454 ANSI shelf.

ETSI 2A Yes 10G compatible MEA on fan tray

ETSI 5A Yes 2.5G compatible MEA on Ethernet

ETSI 5A No Either None

ETSI 5A Yes Either None

1. 15454-SA-ETSI (P/N: 800-08708-XX) = ONS 15454 SDH Release 3.3 and later shelf assembly

2. 5A Fan Tray = 15454E-FTA-60V
2A Fan Tray = 15454E-FTA-48V 

3. 10G cards = XC-10G, XC-VXL-10G, XC-VXC-10G

Table 12-4 Incompatibility Alarms for ONS 15454 ETSI  (continued)

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards Alarms
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Figure 12-8 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)
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Figure 12-9 shows the location of the fan tray on the ONS 15454 ETSI shelf. 

Figure 12-9 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ETSI)

Step 8 If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the 
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket (ANSI shelf 
only), you can slide the existing air filter out of the bracket and replace it at anytime. For more 
information on the fan-tray air filter, see the “NTP-G114 Inspect, Clean, and Replace the Air Filter” 
procedure on page 12-19.

Step 9 Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into 
the corresponding receptacle on the backplane.

Step 10 To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is 
activated.

Step 11 If you replace the door on an ANSI shelf, be sure to reattach the ground strap.

Stop. You have completed this procedure.
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NTP-G117 Replace the ANSI Shelf Alarm Interface Panel

Caution Do not use a 2A AIP with a 5A fan-tray assembly; doing so will cause a blown fuse on the AIP.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Caution Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and 
result in a loss of data. For assistance with AIP replacement, contact the Cisco Technical Assistance 
Center. See the “Obtaining Technical Assistance” section on page lxxiv.

Step 1 Review Table 12-3 on page 12-27 to ensure that you have compatible components when replacing the 
fan-tray assembly and note the alarms that will occur when an incompatibility occurs.

Step 2 Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each 
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade 
document. No hardware should be changed or circuit repair performed until after the software 
upgrade is complete. If you do not need to upgrade software or have completed the software 
upgrade, proceed to Step 3.

Step 3 Record the MAC address of the old AIP:

a. Log into the node where you will replace the AIP. See the “DLP-G46 Log into CTC” task on 
page 2-24.

b. In node view, click the Provisioning > Network tabs.

c. Record the MAC address shown in the General tab (Figure 12-10).

Purpose This procedure replaces the alarm interface panel (AIP) on the 
ONS 15454 ANSI shelf assembly.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 12-10 Find the MAC Address

Step 4 Call Cisco TAC for assistance in replacing the AIP and maintaining the original MAC address. See the 
“Obtaining Technical Assistance” section on page lxxiv.

Step 5 Unscrew the five screws that hold the lower backplane cover in place (Figure 12-11).

Figure 12-11 Lower Backplane Cover

Step 6 Grip the lower backplane cover and gently pull it away from the backplane.

Step 7 Unscrew the two screws that hold the AIP cover in place.

Step 8 Grip the cover and gently pull away from the backplane.

Note On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI 
shelf (P/N: 800-19857), the AIP cover is metal.
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Step 9 Grip the AIP and gently pull it away from the backplane.

Step 10 Disconnect the fan-tray assembly power cable from the AIP.

Step 11 Set the old AIP aside for return to Cisco.

Caution The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The 
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP, 
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149) 
shelves and earlier use the 2A AIP (P/N: 73-5262-01). 

Caution Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD 
(P/N: 800-24848) shelf; doing so will cause a blown fuse on the AIP.

Step 12 Attach the fan-tray assembly power cable to the new AIP.

Step 13 Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 14 Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 15 Replace the lower backplane cover and secure the cover with the five screws.

Step 16 In node view, click the Provisioning > Network tabs.

Caution Cisco recommends that TCC2/TCC2P card resets be performed in a maintenance window to avoid any 
potential service disruptions.

Step 17 Reset the standby TCC2/TCC2P card:

a. Right-click the standby TCC2/TCC2P card and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears 
on the card in CTC.

Note The reset takes approximately five minutes. Do not perform any other steps until the reset is 
complete.

Step 18 Complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 12-9 to reset the active 
TCC2/TCC2P card.

Step 19 From the File drop-down list, choose Exit to exit the CTC session.

Step 20 Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down 
list. 

Step 21 Record the new MAC address:

a. In node view, click the Provisioning > Network tabs.

b. Record the MAC address shown in the General tab.

Step 22 In node view, click the Circuits tab. Note that all circuits listed have a status of PARTIAL.

Step 23 In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box 
appears.
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Step 24 Read the instructions in the Circuit Repair dialog box (Figure 12-12). If all the steps in the dialog box 
have been completed, click Next. Ensure that you have the old and new MAC addresses.

Figure 12-12 Repairing Circuits

Step 25 The Node MAC Addresses dialog box appears (Figure 12-13):

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 3.

c. Click Next.

Figure 12-13 Recording the Old MAC Address Before Replacing the AIP

Step 26 The Repair Circuits dialog box appears (Figure 12-14). Read the information in the dialog box and click 
Finish.
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Figure 12-14 Circuit Repair Information

Note The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes 
or more depending on the number of circuits provisioned.

When the circuit repair is complete, the Circuits Repaired dialog box appears.

Step 27 Click OK.

Step 28 In the node view of the new node, click the Circuits tab. Check to ensure that all circuits listed have a 
status of DISCOVERED. If all circuits listed are not DISCOVERED, call the Cisco TAC at 
(800) 553-2447 to open a Return Material Authorization (RMA).

Stop. You have completed this procedure.

NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane 
Cover

Step 1 Use the Phillips screwdriver to unscrew the five retaining screws that hold the metal cover in place. 

Step 2 Grasp the metal cover on each side.

Step 3 Gently pull the metal cover away from the backplane.

Step 4 Place the plastic cover against the shelf assembly and align the screw holes on the cover and the shelf 
assembly (Figure 12-15).

Purpose This procedure replaces the plastic cover located at the bottom rear of 
the ONS 15454 ANSI shelf.

Tools/Equipment Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 12-15 Attaching Plastic Lower Backplane Cover

Step 5 Tighten the five retaining screws that hold the plastic cover in place.

Stop. You have completed this procedure.

7
8
4
0
0
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NTP-G135 Edit Network Element Defaults

Note For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to edit NE 
defaults. 

Step 2 Click the Provisioning > Defaults tabs. 

Step 3 Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing 
node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all 
available NE defaults (both node- and card-level) under Default Name. 

Step 4 Locate a default you want to change under Default Name. 

Step 5 Click in the Default Value column for the default property you are changing and either choose a value 
from the drop-down menu (when available), or type in the desired new value.

Note If you click Reset before you click Apply, all values will return to their original settings. 

Step 6 Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You 
can modify multiple default values before applying the changes. 

A pencil icon will appear next to any default value that will be changed as a result of editing the defaults 
file. 

Step 7 If you are modifying node-level defaults, a dialog box appears telling you that defaults were 
successufully applied to the node. Click OK.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see 
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder 
cards see Chapter 5, “Provision Transponder and Muxponder Cards.”

Purpose This procedure edits the factory-configured network element (NE) defaults 
using the NE Defaults editor. The new defaults can be applied to the node 
where they are edited or exported to a file and imported for use on other 
nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser 
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Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G136 Import Network Element Defaults

Note For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to import NE 
defaults. 

Step 2 Click the Provisioning > Defaults tabs. 

Step 3 Click Import.

Step 4 Click Browse and browse to the file you are importing if the correct file name and location of the desired 
file do not appear in the Import Defaults from File dialog box.

Step 5 When the correct file name and location appear in the dialog box click OK. The correct file name is 
15454-defaults.txt for ANSI shelves and 15454SDH-defaults.txt for ETSI shelves if you are importing 
the factory defaults. 

A pencil icon will appear next to any default value that will be changed as a result of importing the new 
defaults file. 

Step 6 Click Apply.

Step 7 If the imported file fails to pass all edits, the problem field shows the first encountered problem default 
value that must be fixed. Change the problem default value and click Apply. Repeat until the imported 
file passes all edits successfully.

Step 8 If you are modifying node-level defaults, a dialog box appears telling you that defaults were 
successufully applied to the node. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Purpose This procedure imports the NE defaults using the NE Defaults editor. The 
defaults can either be imported from the CTC software CD (factory 
defaults) or from a customized file exported and saved from a node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser 
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Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or pre-provisioned slots, see 
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder 
cards see Chapter 5, “Provision Transponder and Muxponder Cards.”

Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G137 Export Network Element Defaults

Note The defaults currently displayed are exported whether or not they have been applied to the current node.

Note The NE defaults can also be exported from the File > Export menu. These exported defaults are for 
reference only and cannot be imported.

Note For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to export NE 
defaults. 

Step 2 Click the Provisioning > Defaults editor tabs. 

Step 3 Click Export.

Step 4 Click Browse and browse to the location where you want to export the file if it does not appear in the 
Export Defaults to File dialog box. 

Step 5 Change the file name to something easy to remember (the file name has no extension). 

Purpose This procedure exports the NE defaults using the NE Defaults editor. The 
exported defaults can be imported to other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser 
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Step 6 Click OK.

Stop. You have completed this procedure.
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Power Down a Node

This chapter explains how to power down a node and stop all node activity on the Cisco ONS 15454 
ANSI or ETSI.

NTP-G119 Power Down the Node

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Caution The following procedure is designed to minimize traffic outages when powering down nodes, but traffic 
will be lost if you delete and recreate circuits that passed through a working node.

Note Always use the supplied ESD wristband when working with the Cisco ONS 15454. Plug the wristband 
into the ESD jack located on the fan-tray assembly or on the lower right outside edge of the shelf on the 
NEBS 3 shelf assembly. To access the ESD plug on the NEBS 3 shelf assembly, open the front door of 
the Cisco ONS 15454. The front door is grounded to prevent electrical shock.

Step 1 Identify the node that you want to power down. If no cards are installed, go to Step 16. If cards are 
installed, log into the node. See the “DLP-G46 Log into CTC” task on page 2-24 for instructions.

Step 2 In node view, choose Go to Network View from the View menu. 

Step 3 Verify that the node is not connected to a network. If the node is not connected to a working network and 
the current configurations are no longer required, proceed to Step 4.

Purpose This procedure stops all node activity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note Before the power-down of a DWDM node, the fiber spans connected around it must be 
disconnected from the network. This is to prevent the accidental disconnection of 
wavelengths that pass through the shelf. A good indication that the shelf has been 
disconnected from the network is optical service channel (OSC) alarms, or no OSC channels 
provisioned.

Note Current configurations will be saved if Steps 4 to 16 are skipped.

Step 4 In node view, click the Circuits tab and verify that no circuits appear, then proceed to Step 5. If circuits 
appear, delete all the circuits that originate or terminate in the node. Complete the “DLP-G106 Delete 
Optical Channel Network Connections” task on page 7-12 or the “DLP-G112 Delete Overhead Circuits” 
task on page 7-21 as needed.

Note When deleting circuits from a node, make sure that the node is not connected to any network.

Step 5 In node view, click the Provisioning > Protection tabs and delete all protection groups:

a. Click the protection group that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no protection groups appear.

Step 6 In node view, click the Provisioning > Comm Channels tabs and delete all communications channel 
terminations:

a. Click the section data communications channel (SDCC), line data communications channel 
(LDCC), generic communications channel (GCC), or OSC termination that needs to be deleted and 
click Delete.

b. Click Yes.

Repeat until no SDCC, LDCC, GCC, or OSC terminations are present.

Note Before deleting the OSC termination, make sure the Ring ID is deleted. Click the Provisioning 
> Comm Channels > OSC tabs. Select the Ring ID and click Delete.

Step 7 Before deleting any installed DWDM cards, the optical patch cords have to be deleted. In the node view, 
click Provisioning > WDM-ANS > Connections tabs.

a. Select all the connections and click Delete.

b. Click Yes.

Step 8 For each installed MSTP channel-bearing card (AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x, where xx.x 
refers to the specific wavelengths), make sure all lines and bands are not in IS-NR (ANSI) or 
Unlocked-Enabled (ETSI) service state:

a. In the card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

c. Click the Provisioning > Optical Chn > Parameters tabs.
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d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

Step 9 For each installed DWDM band-bearing card (AD-1B-xx.x and AD-4B-xx.x, where xx.x refers to the 
specific wavelengths), make sure all lines and bands are not in the IS-NR (ANSI) or Unlocked-Enabled 
(ETSI) service state:

a. In the card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

c. Click the Provisioning > Optical Band > Parameters tabs.

d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

Step 10 For each installed DWDM transponder (TXP), muxponder (MXP), multiplexer, demultiplexer or 
amplifier card (32MUX-O, 32DMX-0, 32DMX, 32WSS, 4MD-xx.x, OPT-BST, OPT-PRE, 
TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E, 
MXP_MR_2.5G, MXPP_MR_2.5G), make sure all lines are not in the IS-NR (ANSI) or 
Unlocked-enabled (ETSI) service state:

a. In card view, click the appropriate tab depending on the card:

• For MXP_2.5G_10G, TXP_MR_10G, TXP_MR_10E cards, click the Provisioning > Line > 
SONET tabs if the card was provisioned for a SONET payload, or the Provisioning > Line > 
SDH tabs if the card was provisioned for an SDH payload. 

• For TXP_MR_2.5G, TXPP_MR_2.5G, and MXPP_MR_2.5G cards, click the Provisioning > 
Line > OC48 tabs.

• For MXP_2.5G_10E cards, click the Provisioning > Line > Trunk tabs.

• For MXP_MR_2.5G cards, click the Provisioning > Line > Client tabs.

• For 32MUX-O, 32DMX-0, 32DMX, 32WSS, OPT-BST, OPT-PRE cards, click the 
Provisioning > Optical Line > Parameters tabs.

• For 32DMX and 32DMX-O cards, click the Provisioning > Optical Chn > Parameters tabs.

• For 4MD-xx.x cards, click the Provisioning > Optical Band > Parameters tabs.

• For OPT-BST and OPT-PRE cards, click the Provisioning > Optical Ampli Line > Parameters 
tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

c. Repeat Steps a and b for each installed DWDM card.

Note Ports are put in service when circuits are provisioned, and put out of service when circuits are deleted. 
When circuits are deleted the Admin State displays as IS, AINS (ANSI) or Unlocked,automaticInservice 
(ETSI) and the Service State displays OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService 
(ETSI).

Step 11 Remove all fiber connections to the cards.

Step 12 In node view, right-click an installed card and click Delete.

Step 13 Click Yes.

Step 14 After you have deleted the card, open the card ejectors and remove it from the node. 
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Step 15 Repeat Step 11 through Step 14 for each installed card.

Note You cannot delete a TCC2 or TCC2P card in Cisco Transport Controller (CTC). Physically 
remove it after all the other cards have been deleted and removed.

Step 16 Shut off the power from the power supply that feeds the node.

Step 17 Disconnect the node from its external fuse source.

Step 18 Store all of the cards that you removed and update inventory records according to local site practice.

Stop. You have completed this procedure. 
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Shelf Hardware Reference

This chapter provides a description of Cisco ONS 15454 hardware for the ANSI and ETSI shelf 
assemblies. For card descriptions, see Chapter 15, “Card Reference.” To install equipment, see 
Chapter 1, “Install the Shelf and Common Control Cards.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 14.1 Overview, page 14-2

• 14.2 ONS 15454 ANSI Rack Installation, page 14-3 

• 14.3 ONS 15454 ETSI Rack Installation, page 14-6

• 14.4 FlexLayer and Y-Cable Protection, page 14-9

• 14.5 Typical DWDM Rack Layouts, page 14-16

• 14.6 Front Door, page 14-19 

• 14.7 ONS 15454 ANSI Backplane Covers, page 14-26

• 14.8 ONS 15454 ETSI Front Mount Electrical Connection, page 14-30

• 14.9 ONS 15454 ANSI Alarm Expansion Panel, page 14-30

• 14.10 Filler Card, page 14-35

• 14.11 Cable Routing and Management, page 14-36

• 14.12 Fan-Tray Assembly, page 14-41

• 14.13 Power and Ground Description, page 14-43

• 14.14 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections, page 14-44

• 14.15 Cards and Slots, page 14-48

Note The Cisco ONS 15454 shelf assemblies are intended for use with telecommunications equipment only.

Caution Unused card slots should be filled with a blank faceplate (Cisco P/N 15454-BLANK for ANSI shelves 
and 15454E-BLANK for ETSI shelves). The blank faceplate ensures proper airflow when operating the 
ONS 15454 without the front door attached, although Cisco recommends that the front door remain 
attached.
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14.1 Overview
This section provides an introduction to the Cisco ONS 15454 ANSI and the Cisco ONS 15454 ETSI. 

Install the ONS 15454 in compliance with your local and national electrical codes:

• United States: National Fire Protection Association (NFPA) 70; United States National Electrical 
Code.

• Canada: Canadian Electrical Code, Part I, CSA C22.1.

• Other countries: If local and national electrical codes, are not available, refer to IEC 364, Part 1 
through Part 7.

14.1.1 Cisco ONS 15454 ANSI
When installed in an equipment rack, the ONS 15454 ANSI assembly is typically connected to a fuse 
and alarm panel to provide centralized alarm connection points and distributed power for the 
ONS 15454 ANSI. Fuse and alarm panels are third-party equipment and are not described in this 
documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, 
consult the user documentation for the related equipment. The front door of the ONS 15454 ANSI allows 
access to the shelf assembly, fan-tray assembly, and fiber-storage area. The backplanes provide access 
to alarm contacts, external interface contacts, power terminals, and BNC/SMB connectors.

You can mount the ONS 15454 ANSI in a 19- or 23-inch rack (482.6 or 584.2 mm). The shelf assembly 
weighs approximately 55 pounds (24.94 kg) with no cards installed.

The ONS 15454 ANSI is powered using –48 VDC power. Negative, return, and ground power terminals 
are accessible on the backplane. 

Note The ONS 15454 ANSI is designed to comply with Telcordia GR-1089-CORE Type 2 and Type 4. Install 
and operate the ONS 15454 ANSI only in environments that do not expose wiring or cabling to the 
outside plant. Acceptable applications include Central Office Environments (COEs), Electronic 
Equipment Enclosures (EEEs), Controlled Environment Vaults (CEVs), huts, and Customer Premise 
Environments (CPEs).

14.1.2 Cisco ONS 15454 ETSI
When installed in an equipment rack, the ONS 15454 ETSI assembly is typically connected to a fuse and 
alarm panel to provide centralized alarm connection points and distributed power for the 
ONS 15454 ETSI. Fuse and alarm panels are third-party equipment and are not described in this 
documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, 
consult the user documentation for the related equipment. The front door of the ONS 15454 ETSI allows 
access to the shelf assembly, fan-tray assembly, and fiber-storage area. The FMEC cover at the top of the 
shelf allows access to power connectors, external alarms and controls, timing input and output, and craft 
interface terminals. 

You can mount the ONS 15454 ETSI in an ETSI rack. The shelf assembly weighs approximately 26 kg 
(57 pounds) with no cards installed. The shelf assembly includes a front door and a Front Mount 
Electrical Connection (FMEC) cover for added security, a fan tray module for cooling, and extensive 
fiber-storage space.
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The ONS 15454 ETSI is powered using –48 VDC power. Negative, return, and ground power terminals 
are connected via the MIC-A/P and the MIC-C/T/P FMECs. 

14.2 ONS 15454 ANSI Rack Installation 
The ONS 15454 ANSI is mounted in a 19- or 23-in. (482.6- or 584.2-mm) equipment rack. The shelf 
assembly projects five inches (127 mm) from the front of the rack. It mounts in both Electronic Industries 
Alliance (EIA) standard and Telcordia-standard racks. The shelf assembly is a total of 17 inches (431.8 
mm) wide with no mounting ears attached. Ring runs are not provided by Cisco and might hinder 
side-by-side installation of shelves where space is limited.

The ONS 15454 ANSI measures 18.5 inches (469.9 mm) high, 19 or 23 inches (482.6 or 584.2 mm) wide 
(depending on which way the mounting ears are attached), and 12 inches (304.8 mm) deep. You can 
install up to four ONS 15454 ANSIs in a seven-foot (2133.6 mm) equipment rack. The 
ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly 
to allow air flow to the fan intake. If a second ONS 15454 ANSI is installed underneath the shelf 
assembly, the air ramp on top of the lower shelf assembly provides the air spacing needed and 
should not be modified in any way. Figure 14-1 shows the dimensions of the ONS 15454 ANSI.

Note A 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and fan-tray assembly 
(15454-FTA3 or 15454-FTA3-T) are required if ONS 15454 ANSI 10-Gbps Cross-Connect (XC10G) 
cards are installed in the shelf. 
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Figure 14-1 Cisco ONS 15454 ANSI Dimensions

14.2.1 Reversible Mounting Bracket

Caution Use only the fastening hardware provided with the ONS 15454 ANSI shelf to prevent loosening, 
deterioration, and electromechanical corrosion of the hardware and joined material.

Caution When mounting the ONS 15454 ANSI shelf in a frame with a nonconductive coating (such as paint, 
lacquer, or enamel) either use the thread-forming screws provided with the ONS 15454 ANSI shipping 
kit, or remove the coating from the threads to ensure electrical continuity.

The shelf assembly comes preset for installation in a 23-inch (584.2 mm) rack, but you can reverse the 
mounting bracket to fit the smaller 19-inch (482.6 mm) rack. 

Front ViewSide View

Top View

18.5 in.
(46.99 cm)

12 in. (30.48 cm)

12 in.
(30.48 cm)

5 in.(12.7 cm)

22 in. (55.88 cm) total width

19 in. (48.26 cm) or 23 in. (58.42 cm)
between mounting screw holes

22 in. (55.88 cm) total width

19 in. (48.26 cm) or 23 in. (58.42 cm)
between mounting screw holes
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14.2.2 Mounting a Single Node
Mounting the ONS 15454 ANSI shelf in a rack requires a minimum of 18.5 inches (469.9 mm) of 
vertical rack space and one additional inch (25.4 mm) for air flow. To ensure the mounting is secure, use 
two to four #12-24 mounting screws for each side of the shelf assembly. Figure 14-2 shows the rack 
mounting position for the ONS 15454 ANSI shelf.

Figure 14-2 Mounting an ONS 15454 ANSI Shelf in a Rack

Two people should install the shelf assembly; however, one person can install it using the temporary set 
screws included. The shelf assembly should be empty for easier lifting. The front door can also be 
removed to lighten the shelf assembly.

14.2.3 Mounting Multiple Nodes
Most standard (Telcordia GR-63-CORE, 19-inch [482.6-mm] or 23-inch [584.2-mm]) seven-foot 
(2.133-m) racks can hold four ONS 15454 ANSI shelves and a fuse and alarm panel. However, unequal 
flange racks are limited to three ONS 15454 ANSI shelves and a fuse and alarm panel, or four 
ONS 15454 ANSI shelves using a fuse and alarm panel from an adjacent rack. 

If you are using the external (bottom) brackets to install the fan-tray air filter, you can install three shelf 
assemblies in a standard seven-foot (2.133-m) rack. If you are not using the external (bottom) brackets, 
you can install four shelf assemblies in a rack. The advantage of using the bottom brackets is that you 
can replace the filter without removing the fan tray.

FAN FAIL
CRIT
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Equipment rack

Universal
ear mounts
(reversible)
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14.2.4 ONS 15454 ANSI Bay Assembly
The Cisco ONS 15454 ANSI bay assembly simplifies ordering and installing the ONS 15454 ANSI 
shelf because it allows you to order shelf assemblies preinstalled in a seven-foot (2,133 mm) rack. The 
bay assembly is available in a three- or four-shelf configuration. The three-shelf configuration includes 
three ONS 15454 ANSI shelf assemblies, a prewired fuse and alarm panel, and two fiber-storage trays. 
The four-shelf configuration includes four ONS 15454 ANSI shelf assemblies and a prewired fuse and 
alarm panel. You can order optional fiber channels with either configuration. Installation procedures are 
included in the Unpacking and Installing the Cisco ONS 15454 Four-Shelf and Zero-Shelf Bay Assembly 
document that ships with the bay assembly.

14.3 ONS 15454 ETSI Rack Installation 
The ONS 15454 ETSI (15454-SA-ETSI) is mounted in a 600 x 600-mm (23-inch) or 600 x 300-mm 
(11.8-inch) equipment cabinet/rack. The shelf assembly projects 240 mm (9.45 inches) from the front of 
the rack. It mounts in ETSI-standard racks. The shelf assembly is a total of 435 mm (17.35 inches) wide 
with no mounting ears attached. Ring runs are not provided by Cisco and might hinder side-by-side 
installation of shelves where space is limited. 

The ONS 15454 ETSI measures 616.5 mm (24.27 inches) high, 535 mm (21.06 inches) wide, and 280 
mm (11.02 inches) deep. You can install up to three ONS 15454 ETSI shelves in a seven-foot (2133.6 
mm) equipment rack. The ONS 15454 ETSI must have one inch (25.4 mm) of airspace below the 
installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed 
below the first shelf assembly, an ETSI air ramp unit must be assembled between the two shelves to 
ensure adequate air flow.

Figure 14-3 provides the dimensions of the ONS 15454 ETSI.

Caution The standard ETSI racks can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When 
mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the 
heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the 
stabilizers before mounting or servicing the unit in the rack.

Caution The ONS 15454 ETSI must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf 
assembly) provides this spacing and should not be modified in any way.
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Figure 14-3 ONS 15454 ETSI Dimensions

14.3.1 Mounting a Single Node
The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure the mounting is secure, use two to four M6 mounting screws for each side of the 
shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in the 
rack.

Figure 14-4 shows the rack mounting position for the ONS 15454 ETSI shelf.
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Figure 14-4 Mounting an ONS 15454 ETSI Shelf in a Rack

Two people should install the shelf assembly; however, one person can install it using the temporary set 
screws included. The shelf assembly should be empty for easier lifting. The front door can also be 
removed to lighten the shelf assembly.

14.3.2 Mounting Multiple Nodes
Most standard (Telcordia GR-63-CORE, 23-inch [584.2 mm]) seven-foot (2,133 mm) racks can hold 
three ONS 15454 ETSI shelves, two air ramps, and a fuse and alarm panel. Figure 14-5 shows a 
three-shelf ONS 15454 ETSI bay assembly.
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Figure 14-5 Three-Shelf ONS 15454 ETSI Bay Assembly

14.4 FlexLayer and Y-Cable Protection
The Cisco ONS 15454 FlexLayer DWDM system includes the following components:

• Two-channel add or drop flex module

• FlexLayer shelf assembly

• Y-cable FlexLayer module

The FlexLayer shelf assembly is 1 rack unit (RU) high and can be mounted in a 19-inch (482.6-mm) or 
23-inch (584.2-mm) rack (two-way mounting brackets). The FlexLayer shelf assembly is used to house 
the FlexLayer and Y-Cable modules.
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14.4.1 FlexLayer Modules
The two-channel add/drop FlexLayer module is a completely passive unidirectional component that 
allows the insertion or the extraction of two channels within the ONS 15454 channel plan. This module 
is used only in point-to-point, one-channel, amplified system configurations. 

Sixteen specific modules are available to cover the whole 32-channel bandwidth. Table 14-1 shows how 
the FlexLayer add/drop modules are grouped in relation to the supported channels.

Table 14-1 ONS 15454 100-GHz Channel Plan

ITU Channel ID Frequency (THz) Wavelength (nm)
Two-Channel A/D 
Flex Module

59 30.3 195.9 1530.33 15216-FLB-2-31.1=

58 31.1 195.8 1531.12

57 31.9 195.7 1531.90 15216-FLB-2-32.6=

56 32.6 195.6 1532.68

54 34.2 195.4 1534.25 15216-FLB-2-35.0=

53 35.0 195.3 1535.04

52 35.8 195.2 1535.82 15216-FLB-2-36.6=

51 36.6 195.1 1536.61

49 38.1 194.9 1538.19 15216-FLB-2-38.9=

48 38.9 194.8 1538.98

47 39.7 194.7 1539.77 15216-FLB-2-40.5=

46 40.5 194.6 1540.56

44 42.1 194.4 1542.14 15216-FLB-2-42.9=

43 42.9 194.3 1542.94

42 43.7 194.2 1543.73 15216-FLB-2-44.5=

41 44.5 194.1 1544.53

39 46.1 193.9 1546.12 15216-FLB-2-46.9=

38 46.9 193.8 1546.92

37 47.7 193.7 1547.72 15216-FLB-2-48.5=

36 48.5 193.6 1548.51

34 50.1 193.4 1550.12 15216-FLB-2-50.9=

33 50.9 193.3 1550.92

32 51.7 193.2 1551.72 15216-FLB-2-52.5=

31 52.5 193.1 1552.52

29 54.1 192.9 1554.13 15216-FLB-2-54.9=

28 54.9 192.8 1554.94

27 55.7 192.7 1555.75 15216-FLB-2-56.5=

26 56.5 192.6 1556.55
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Figure 14-6 shows the module functional block diagram. In Figure 14-6, the signal flows from left to 
right when the card is used as a drop component and from right to left when the module is used as an 
add component.

Figure 14-6 Two-Channel Add/Drop FlexLayer Module Block Diagram

When the module is used as a drop component, the wave-division multiplexing (WDM) composite signal 
coming from the DROP-COM-RX port is filtered sequentially by two filters and the filtered channels are 
dropped at the two DROP-CH-TX ports. The rest of the WDM composite signal is sent to the 
DROP-COM-TX port. A two-percent tap coupler, DROP-MON, is used to monitor the input WDM 
composite signal.

When the module is used as an add component, the added channels coming from the two ADD-CH-RX 
ports are combined with the WDM composite signal coming from the ADD-COM-RX port. The 
multiplexed WDM composite signal is sent to the ADD-COM-TX port. A two-percent tap coupler, 
ADD-MON, is used to monitor the multiplexed WDM composite signal. 

24 58.1 192.4 1558.17 15216-FLB-2-58.9=

23 58.9 192.3 1558.98

22 59.7 192.2 1559.79 15216-FLB-2-60.6=

21 60.6 192.1 1560.61

Table 14-1 ONS 15454 100-GHz Channel Plan (continued)

ITU Channel ID Frequency (THz) Wavelength (nm)
Two-Channel A/D 
Flex Module
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Figure 14-7 shows the physical appearance of the ONS 15454 two-channel add/drop FlexLayer module.

Figure 14-7 ONS 15454 Two-Channel Optical Add/Drop FlexLayer Module

Labels are provided to show how the module ports are mapped. It is the end user’s responsibility to label 
the module for its intended use (drop or add component). 

Figure 14-8 shows how the connectors are mapped and labeled on the front panel when the component 
is used as a drop component. The COM-RX is mapped to Port 1, the COM-TX is mapped to Port 12, and 
the two dropped channel TX ports are mapped to Ports 9 and 10. The two-percent tap MON port is 
mapped to Port 6. Port 7 is not active.

Figure 14-8 Two-Channel Drop Component Connector Mapping and Labeling

Figure 14-9 shows how the connectors are mapped and labeled in the front panel when the component 
is used as an add component. The COM-TX is mapped to Port 1, the COM-RX is mapped to Port 12, and 
the added channels are mapped to the two RX Ports 9 and 10. The two-percent tap MON port is mapped 
to Port 7. Port 6 is not active.
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Figure 14-9 Two-Channel Add Component Connector Mapping and Labeling

14.4.2 Y-Cable Protection Module
The Y-cable protection module is a bidirectional module. It is equipped with two passive star couplers: 
one that is used as a splitter and one that is used as a coupler. 

Note None of the modules in this equipment release can be used for video on demand (VoD) applications.

The purpose of this module is to provide Y-cable protection on the CLIENT side of transponder (TXP) 
cards such as the TXP_MR_10G, XP_MR_10E, or TXP_MR_2.5G (Figure 14-10). There are two 
versions of this module, one for multimode applications (CS-MM-Y) and one for single-mode 
applications (CS-SM-Y).

Figure 14-10 Typical Y-Cable Protection Module Configuration

When the module is used in the coupler direction, the individual signals enter the module from the 
CPL-RXn ports and pass through a passive star coupler to the CPL-TX port.
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The coupler is not meant to combine both the protect and working client card signals. The module allows 
a path for the working client transmit interface to connect to the network in the event the opposite 
interface in the protection pair should fail (the protect interface switches to the working interface).

When the module is used in the splitter direction, the signal enters the module from the SPL-RX port 
and is split through a passive star coupler to the SPL-TXn ports. This module, although designed to pass 
wavelengths associated with the ONS 15454 32-channel plan, is not selective to specific wavelengths 
(modules do not filter wavelengths).

Figure 14-11 shows the  block diagram of the Y-cable protection module. 

Figure 14-11 1:2 Splitter and 2:1 Coupler (Y-Cable Protection) Module Block Diagram

Figure 14-12 and Figure 14-13 show the physical appearance of the ONS 15454 Y-Cable Protection 
FlexLayer Module. This module has two versions, one for single-mode applications and the other for 
multimode applications.

Figure 14-12 ONS 15454 Y-Cable Protection FlexLayer Module (Single-Mode)
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Figure 14-13 ONS 15454 Y-Cable Protection FlexLayer Module (Multimode)

Figure 14-14 shows how the module front panel ports are mapped and labeled. The multimode module 
is mapped and labeled the same as the single-mode module.

Figure 14-14 Y-Cable Protection Component Connector Mapping and Labeling

Table 14-2 details the single-mode and multimode front panel Protection A mapping. It shows how two 
DWDM receive inputs (client working and protect) provide one output signal to the equipment, using 
the module combiner function.

Table 14-3 details the single-mode and multimode front panel Protection A mapping. It shows how the 
module splits a single receive input from the equipment into two DWDM output signals (working and 
protect) to the client.
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Table 14-2 Protection A (TXP 1 and 2) Port Mapping: Combiner from DWDM

Receive Port Number Receive (RX) Signal Names Signal Sources

1 RXa1 (TXP1-W) Client TX

6 RXa2 (TXP2-P) Client TX

Transmit Port Number Transmit (TX) Signal Name Signal Destination

5 TXa (customer client) Customer client equipment RX
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Table 14-4 details the single-mode and multimode front panel Protection B mapping. It shows how two 
DWDM receive inputs (client working and protect) provide one output signal to the equipment, using 
the module combiner function.

Table 14-5 details the single-mode and multimode front panel Protection B mapping. It shows how the 
module splits a single receive input from the equipment into two DWDM output signals (working and 
protect) to the client.

The following muxponder (MXP) and transponder (TXP) cards can use Y-cable protection: 

• MXP_2.5_10G

• MXP_2.5_10E

• MXP_MR_2.5G 

• TXP_MR_10G

• TXP_MR_10E

• TXP_MR_2.5G

14.5 Typical DWDM Rack Layouts
Typical dense wavelength division multiplexing (DWDM) applications might include:

Table 14-3 Protection A (TXP 1 and 2) Port Mapping: Splitter to DWDM

Receive Port Number Receive (RX) Signal Name Signal Source

10 RXa (customer client) Customer client equipment TX

Transmit Port Number Transmit (TX) Signal Names Signal Destinations

2 TXa1 (TXP1-W) Client RX

7 TXa2 (TXP2-P) Client RX

Table 14-4 Protection B (TXP 3 and 4) Port Mapping: Combiner from DWDM

Receive Port Number Receive (RX) Signal Names Signal Sources

3 RXb1 (TXP3-W) Client TX

8 RXb2 (TXP4-P) Client TX

Transmit Port Number Transmit (TX) Signal Name Signal Destination

11 TXb (customer client) Customer client equipment RX

Table 14-5 Protection B (TXP 3 and 4) Port Mapping: Splitter to DWDM

Receive Port Number Receive (RX) Signal Name Signal Source

12 RXb (customer client) Customer client equipment TX

Transmit Port Number Transmit (TX) Signal Names Signal Destinations

4 TXb1 (TXP3-W) Client RX

9 TXb2 (TXP4-P) Client RX
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• 3 ONS 15454 shelves

• 1 Dispersion Compensating Unit (DCU)

• 7 patch panels (or fiber-storage trays)

Or, alternatively:

• 3 ONS 15454 shelves

• 2 DCUs

• 6 patch panels (or fiber-storage trays)

See Figure 14-15 for a typical rack layout. 

Note Use the rack layout generated by Cisco MetroPlanner to determine your exact shelf layout.
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Figure 14-15 Typical DWDM Equipment Layout in an ONS 15454 ANSI Rack

If you are installing a patch panel or fiber-storage tray below the ONS 15454 shelf, you must install the 
air ramp between the shelf and patch-panel tray/fiber-management tray, or leave one rack unit (RU) 
space open.
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14.6 Front Door 
The Critical, Major, and Minor alarm LEDs visible through the front door indicate whether a critical, 
major, or minor alarm is present anywhere on the ONS 15454 shelf. These LEDs must be visible so 
technicians can quickly determine if any alarms are present on the ONS 15454 shelf or the network. You 
can use the LCD to further isolate alarms. The front door (Figure 14-16) provides access to the shelf 
assembly, fiber-storage tray, fan-tray assembly, and LCD screen. 

Figure 14-16 The ONS 15454 Front Door

The ONS 15454 ANSI ships with a standard door but can also accommodate a deep door and extended 
fiber clips (15454-DOOR-KIT) to provide additional room for cabling (Figure 14-17). The 
ONS 15454 ETSI does not support the deep door. 
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Figure 14-17 Cisco ONS 15454 ANSI Deep Door
.

The ONS 15454 door locks with a pinned hex key that ships with the shelf assembly. A button on the 
right side of the shelf assembly releases the door. You can remove the front door to provide unrestricted 
access to the front of the shelf assembly. 
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Before you remove the ONS 15454 front door, you must remove the ground strap of the front door 
(Figure 14-18). 

Figure 14-18 ONS 15454 ANSI Front Door Ground Strap
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Figure 14-19 shows how to remove the ONS 15454 ANSI front door.

Figure 14-19 Removing the ONS 15454 ANSI Front Door
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Figure 14-20 shows how to remove the ONS 15454 ETSI front door.

Figure 14-20 Removing the ONS 15454 ETSI Front Door

An erasable label is pasted on the inside of the front door. You can use the label to record slot 
assignments, port assignments, card types, node ID, rack ID, and serial number for the ONS 15454.
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Figure 14-21 shows the erasable label on the ONS 15454 ANSI shelf. 

Figure 14-21 ONS 15454 ANSI Front-Door Erasable Label
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Figure 14-22 shows the erasable label on the ONS 15454 ETSI shelf.

Figure 14-22 ONS 15454 ETSI Front-Door Erasable Label

The front door label also includes the Class I and Class 1M laser warning.  Figure 14-23 shows the 
ONS 15454 ANSI laser warning. 

Figure 14-23 Laser Warning on the ONS 15454 ANSI Front-Door Label

Figure 14-24 shows the ONS 15454 ETSI laser warning.
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Figure 14-24 Laser Warning on the ONS 15454 ETSI Front-Door Label

14.7 ONS 15454 ANSI Backplane Covers
If a backplane does not have an electrical interface assembly (EIA) panel installed, it should have two 
sheet metal backplane covers (one on each side of the backplane). See Figure 14-25. Each cover is held 
in place with nine 6-32 x 3/8 inch Phillips screws. 
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Figure 14-25 Backplane Covers

14.7.1 Lower Backplane Cover
The lower section of the ONS 15454 ANSI backplane is covered by either a clear plastic protector 
(15454-SA-ANSI) or a sheet metal cover (15454-SA-HD), which is held in place by five 6-32 x 1/2 inch 
screws. Remove the lower backplane cover to access the alarm interface panel (AIP), alarm pin fields, 
frame ground, and power terminals (Figure 14-26).

Figure 14-26 Removing the Lower Backplane Cover
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14.7.2 Rear Cover 
The ONS 15454 ANSI has an optional clear plastic rear cover. This clear plastic cover provides 
additional protection for the cables and connectors on the backplane. Figure 14-27 shows the rear cover 
screw locations. 

Figure 14-27 Backplane Attachment for Cover

You can also install the optional spacers if more space is needed between the cables and rear cover 
(Figure 14-28).
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Figure 14-28 Installing the Plastic Rear Cover with Spacers

14.7.3 Alarm Interface Panel
The AIP is located above the alarm contacts on the lower section of the backplane. The AIP provides 
surge protection for the ONS 15454 ANSI. It also provides an interface from the backplane to the 
fan-tray assembly and LCD. The AIP plugs into the backplane using a 96-pin DIN connector and is held 
in place with two retaining screws. The panel has a nonvolatile memory chip that stores the unique node 
address (MAC address). The MAC address identifies the nodes that support circuits. It allows Cisco 
Transport Controller (CTC) to determine circuit sources, destinations, and spans. The TCC2/TCC2P 
cards in the ONS 15454 ANSI also use the MAC address to store the node database. 

Note The 5-A AIP (73-7665-XX) is required when installing the new fan-tray assembly (15454-FTA3), which 
comes preinstalled on the shelf assembly (15454-SA-ANSI or 15454-SA-HD). 

Note A blown fuse on the AIP board can cause the LCD display to go blank.

14.7.4 Alarm Interface Panel Replacement
If the AIP fails, a MAC Fail alarm appears on the CTC Alarms menu and/or the LCD display on the 
fan-tray assembly goes blank. To perform an in-service replacement of the AIP, you must contact the 
Cisco Technical Assistance Center (Cisco TAC). For contact information, see the “Obtaining Technical 
Assistance” section on page lxxiv.
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You can replace the AIP on an in-service system without affecting traffic (except Ethernet traffic on 
nodes running a software release earlier than Release 4.0). The circuit repair feature allows you to repair 
circuits affected by MAC address changes on one node at a time. Circuit repair works when all nodes are 
running the same software version. Each individual AIP upgrade requires an individual circuit repair; if 
AIPs are replaced on two nodes, the circuit repair must be performed twice. Always replace an AIP 
during a maintenance window.

Caution Do not use a 2-A AIP with a 5-A fan-tray assembly; doing so causes a blown fuse on the AIP.

Note Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits. If you need to upgrade nodes to the same software version, no hardware 
should be changed or circuit repair performed until after the software upgrade is complete.

14.8 ONS 15454 ETSI Front Mount Electrical Connection
The ONS 15454 ETSI positive and negative power terminals are located on FMEC cards in the Electrical 
Facility Connection Assembly (EFCA). The ground connection is the grounding receptacle on the side 
panel of the shelf. 

The ONS 15454 ETSI EFCA at the top of the shelf has 12 FMEC slots numbered sequentially from left 
to right (18 to 29). Slots 18 to 22 and 25 to 29 provide electrical connections. Slots 23 and 24 host the 
MIC-A/P and MIC-C/T/P cards, respectively. The MIC-A/P and the MIC-C/T/P cards also connect 
alarm, timing, LAN, and craft connections to the ONS 15454 ETSI. 

For more information about the MIC-A/P and MIC-C/T/P, see Chapter 15, “Card Reference.”

14.9 ONS 15454 ANSI Alarm Expansion Panel
The optional ONS 15454 ANSI alarm expansion panel (AEP) can be used with the Alarm Interface 
Controller–International card (AIC-I) card to provide an additional 48 dry alarm contacts for the 
ONS 15454 ANSI: 32 inputs and 16 outputs. The AEP is a printed circuit board assembly that is installed 
on the backplane. Figure 14-29 shows the AEP board; the left connector is the input connector and the 
right connector is the output connector. 

The AIC-I without an AEP already contains direct alarm contacts. These direct AIC-I alarm contacts are 
routed through the backplane to wire-wrap pins accessible from the back of the shelf. If you install an 
AEP, you cannot use the alarm contacts on the wire-wrap pins. For more information about the AIC-I, 
see Chapter 15, “Card Reference.”
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Figure 14-29 AEP Printed Circuit Board Assembly

Figure 14-30 shows the AEP block diagram. 

Figure 14-30 AEP Block Diagram

Each AEP alarm input port has provisionable label and severity. The alarm inputs have optocoupler 
isolation. They have one common 32-VDC output and a maximum of 2 mA per input. Each opto-metal 
oxide semiconductor (MOS) alarm output can operate by definable alarm condition, a maximum open 
circuit voltage of 60 VDC, and a maximum current of 100 mA. See the “21.7 External Alarms and 
Controls” section on page 21-12 for further information.

Figure 14-31 shows the wire-wrapping connections on the shelf backplane used to connect to the AEP.
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Figure 14-31 AEP Wire-Wrap Connections to Backplane Pins

Table 14-6 shows the backplane pin assignments and corresponding signals on the AIC-I and AEP.
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Table 14-6 Pin Assignments for the AEP

AEP Cable Wire Backplane Pin AIC-I Signal AEP Signal

Black A1 GND AEP_GND

White A2 AE_+5 AEP_+5

Slate A3 VBAT– VBAT–

Violet A4 VB+ VB+

Blue A5 AE_CLK_P AE_CLK_P

Green A6 AE_CLK_N AE_CLK_N

Yellow A7 AE_DIN_P AE_DOUT_P

Orange A8 AE_DIN_N AE_DOUT_N

Red A9 AE_DOUT_P AE_DIN_P

Brown A10 AE_DOUT_N AE_DIN_N
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Figure 14-32 is a circuit diagram of the alarm inputs. (Inputs 1 and 32 are shown in the example.)

Figure 14-32 Alarm Input Circuit Diagram

Table 14-7 lists the connections to the external alarm sources. 

78
47

3

Station

48 V

max. 2 mA

AEP/AIE

GND

VBAT–

VBAT–

Input 1

Input 48

Table 14-7 Alarm Input Pin Association

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

1 ALARM_IN_1– 27 GND

2 GND 28 ALARM_IN_2–

3 ALARM_IN_3– 29 ALARM_IN_4–

4 ALARM_IN_5– 30 GND

5 GND 31 ALARM_IN_6–

6 ALARM_IN_7– 32 ALARM_IN_8–

7 ALARM_IN_9– 33 GND

8 GND 34 ALARM_IN_10–

9 ALARM_IN_11– 35 ALARM_IN_12–

10 ALARM_IN_13– 36 GND

11 GND 37 ALARM_IN_14–

12 ALARM_IN_15– 38 ALARM_IN_16–

13 ALARM_IN_17– 39 GND

14 GND 40 ALARM_IN_18–

15 ALARM_IN_19– 41 ALARM_IN_20–

16 ALARM_IN_21– 42 GND

17 GND 43 ALARM_IN_22–
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Figure 14-33 is a circuit diagram of the alarm outputs. (Outputs 1 and 16 are shown in the example.)

Figure 14-33 Alarm Output Circuit Diagram

Use the pin numbers in Table 14-8 to connect to the external elements being switched by external 
controls. 

18 ALARM_IN_23– 44 ALARM_IN_24–

19 ALARM_IN_25– 45 GND

20 GND 46 ALARM_IN_26–

21 ALARM_IN_27– 47 ALARM_IN_28–

22 ALARM_IN_29– 48 GND

23 GND 49 ALARM_IN_30–

24 ALARM_IN_31– 50 —

25 ALARM_IN_+ 51 GND1

26 ALARM_IN_0– 52 GND2

Table 14-7 Alarm Input Pin Association (continued)

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

78
47

4

Station

max. 60 V/100 mA

AEP/AIE

Output 1

Output 16

Table 14-8 Pin Association for Alarm Output Pins

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

1 — 27 COM_0

2 COM_1 28 —

3 NO_1 29 NO_2

4 — 30 COM_2
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14.10 Filler Card
The filler card is designed to occupy empty multiservice and AIC-I slots in the Cisco ONS 15454 
(Slots 1 – 6, 9, and 12 – 17). The filler card cannot operate in the XC slots (Slots 8 and 10) or TCC slots 
(Slots 7 and 11). The filler card is detected by CTC.

When installed, the filler card aids in maintaining proper air flow and EMI requirements.

Figure 14-34 shows the card faceplate. The filler card has no card-level LED indicators.

5 COM_3 31 —

6 NO_3 32 NO_4

7 — 33 COM_4

8 COM_5 34 —

9 NO_5 35 NO_6

10 — 36 COM_6

11 COM_7 37 —

12 NO_7 38 NO_8

13 — 39 COM_8

14 COM_9 40 —

15 NO_9 41 NO_10

16 — 42 COM_10

17 COM_11 43 —

18 NO_11 44 NO_12

19 — 45 COM_12

20 COM_13 46 —

21 NO_13 47 NO_14

22 — 48 COM_14

23 COM_15 49 —

24 NO_15 50 —

25 — 51 GND1

26 NO_0 52 GND2

Table 14-8 Pin Association for Alarm Output Pins (continued)

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name
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Figure 14-34 Filler Card Faceplate

14.11 Cable Routing and Management
The ONS 15454 cable management facilities include the following:

• Fiber patch panels

• A cable-routing channel (behind the fold-down door) that runs the width of the shelf assembly 
(Figure 14-35 on page 14-37)

• Plastic horseshoe-shaped fiber guides at each side opening of the cable-routing channel that ensure 
that the proper bend radius is maintained in the fibers (Figure 14-36 on page 14-38)
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Note You can remove the fiber guide, if necessary, to create a larger opening (if you need to route 
CAT-5 Ethernet cables out the side, for example). To remove the fiber guide, take out the 
three screws that anchor it to the side of the shelf assembly. 

• Cable tie-wrap facilities on EIAs that secure cables to the cover panel (ANSI only)

• Reversible jumper routing fins that enable you to route cables out either side by positioning the fins 
as desired

• Jumper slack storage reels (2) on each side panel that reduce the amount of slack in cables that are 
connected to other devices

Note To remove the jumper slack storage reels, take out the screw in the center of each reel.

• Optional fiber-storage tray (recommended for DWDM nodes)

• Optional tie-down bar (ANSI only)

Figure 14-35 shows the cable management facilities that you can access through the fold-down front 
door, including the cable-routing channel and the jumper routing fins. 

Figure 14-35 Managing Cables on the Front Panel 

14.11.1 Fiber Management
The jumper routing fins are designed to route fiber jumpers out of both sides of the shelf. Slots 1 to 6 
exit to the left, and Slots 12 to 17 exit to the right. Figure 14-36 shows fibers routed from cards in the 
left slots, down through the fins, then exiting out the fiber channel to the left. The maximum capacity of 
the fiber routing channel depends on the size of the fiber jumpers. 

FAN FAIL
CRIT

MAJ
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8
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Figure 14-36 Fiber Capacity

Table 14-9 provides the maximum capacity of the fiber channel for one side of an ANSI shelf, depending 
on fiber size and number of Ethernet cables running through that fiber channel.

Table 14-10 provides the maximum capacity of the fiber channel for one side of an ETSI shelf, 
depending on fiber size and number of Ethernet cables running through that fiber channel.

Fiber guides

96
51

8

Table 14-9 ANSI Fiber Channel Capacity (One Side of the Shelf)

Fiber Diameter

Maximum Number of Fibers Exiting Each Side

No Ethernet Cables One Ethernet Cable Two Ethernet Cables

1.6 mm (0.6 inch) 144 127 110

2 mm (0.7 inch) 90 80 70

3 mm (0.11 inch) 40 36 32

Table 14-10 ETSI Fiber Channel Capacity (One Side of the Shelf)

Fiber Diameter

Maximum Number of Fibers Exiting Each Side

No Ethernet Cables One Ethernet Cable Two Ethernet Cables

1.6 mm (0.6 inch) 126 110 94

2 mm (0.7 inch) 80 70 60

3 mm (0.11 inch) 36 31 26
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Determine your fiber size according to the number of cards/ports installed in each side of the shelf. For 
example, if your port combination requires 36 fibers, 3-mm (0.11-inch) fiber is adequate. If your port 
combination requires 68 fibers, you must use 2-mm (0.7-inch) or smaller fibers.

14.11.2 Fiber Management Using the Patch-Panel Tray
The optional patch-panel tray manages the connections between multiplexer/demultiplexer and TXP 
cards by splitting patch cords into single connections. The patch-panel tray consists of a metal shelf, 
pull-out drawer, and drop-in patch-panel module. It can host up to eight ribbon cables (with eight fibers 
each) entering the drawer or 64 cables (with a maximum outer diameter of 2 mm [0.079 inches]). 

Because the patch-panel tray can host 64 connections, hub and ROADM nodes will typically require two 
patch-panel modules each, and other DWDM nodes typically require one. The module fits 19- and 
23-inch (482.6-mm and 584.2-mm) ANSI racks and 600 mm (23.6 inch) x 300 mm (11.8 inch) ETSI 
racks, using reversible brackets.

Figure 14-37 shows a partially fibered patch-panel tray.

Figure 14-37 Patch-Panel Tray

14.11.3 Fiber Management Using the Fiber-Storage Tray
Cisco recommends installing at lease one fiber-storage tray in multinode racks to facilitate fiber-optic 
cable management for DWDM applications. This tray is usually used to store slack cable from cables 
installed between cards within a single node. See Figure 14-15 on page 14-18 for typical mounting 
locations.
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Table 14-11 provides the fiber capacity for each tray.

Figure 14-38 shows a fiber-management tray with fiber-optic cables routed through it. You can route 
cables around the cable rounders, entering and exiting from either side, as necessary.

Note Figure 14-38 shows one example of how to route fibers through the fiber-storage tray. Route fibers as 
necessary for your site configuration.

Figure 14-38 Fiber-Storage Tray

14.11.4 Fiber Management Using the Optional ANSI Tie-Down Bar
You can install a 5-inch (127-mm) tie-down bar on the rear of the ANSI chassis. You can use tie-wraps 
or other site-specific material to bundle the cabling and attach it to the bar so that you can more easily 
route the cable away from the rack.

Figure 14-39 shows the tie-down bar, the ONS 15454 ANSI, and the rack.

Table 14-11 Fiber-Storage Tray Capacity

Fiber Diameter
Maximum Number of Fibers Exiting 
Each Side

1.6 mm (0.6 inch) 62

2 mm (0.7 inch) 48

3 mm (0.11 inch) 32

13
46

09

West
entry/exit

East
entry/exit
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Figure 14-39 Tie-Down Bar on the Cisco ONS 15454 ANSI Shelf Assembly

14.12 Fan-Tray Assembly 
The fan-tray assembly is located at the bottom of the ONS 15454 shelf assembly. The fan tray is a 
removable drawer that holds fans and fan-control circuitry for the ONS 15454. The front door can be left 
in place or removed before installing the fan-tray assembly. After you install the fan tray, you should 
only need to access it if a fan failure occurs or if you need to replace or clean the fan-tray air filter. Refer 
to Chapter 12, “Maintain the Node” to clean and replace the fan-tray assembly.

The front of the fan-tray assembly has an LCD screen that provides slot- and port-level information for 
all card slots, including the number of Critical, Major, and Minor alarms. 

The fan-tray assembly features an air filter at the bottom of the tray that you can install and remove by 
hand. Remove and visually inspect this filter every 30 days and keep spare filters in stock. Refer to 
Chapter 12, “Maintain the Node,” for information about cleaning and maintaining the fan-tray air filter.

Caution Do not operate an ONS 15454 without the mandatory fan-tray air filter. 

Caution The 15454-FTA3-T fan-tray assembly can only be installed in ONS 15454 Release 3.1 and later shelf 
assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly 
includes a pin that prevents it from being installed in ONS 15454 shelf assemblies released before 
ONS 15454 Release 3.1 (15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1). Equipment 
damage can result from attempting to install the 15454-FTA3 in a noncompatible shelf assembly. 

See Figure 14-40 for the position of the ONS 15454 ETSI fan-tray assembly. 

10
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14-41
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 14      Shelf Hardware Reference
Fan-Tray Assembly
Figure 14-40 Position of the ONS 15454 ETSI Fan-Tray Assembly

14.12.1 Fan Speed and Power Requirements
Fan speed is controlled by the TCC2/TCC2P card’s temperature sensors. The sensors measure the input 
air temperature at the fan-tray assembly. Fan speed options are low, medium, and high. If the 
TCC2/TCC2P card fails, the fans automatically shift to high speed. The temperature measured by the 
TCC2/TCC2P sensors appears on the LCD screen.

Table 14-12 lists power requirements for the fan-tray assembly.

61
23
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Fan tray
assembly

LCD

Table 14-12 Fan Tray Assembly Power Requirements

Fan Tray Assembly Watts Amps BTU/Hr

FTA2 53 1.21 198

FTA3 -T 86.4 1.8 295
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14.12.2 Fan Failure
If one or more fans fail on the fan-tray assembly, replace the entire assembly. You cannot replace 
individual fans. The red Fan Fail LED on the front of the fan tray illuminates when one or more fans fail. 
For fan-tray replacement instructions, see the “NTP-G116 Replace the Fan-Tray Assembly” procedure 
on page 12-27. The red Fan Fail LED clears after you install a working fan tray. 

14.12.3 Air Filter 
The ONS 15454 contains a reusable air filter (for ANSI: 15454-FTF2; for ETSI: 15454E-ETSI-FTF) that 
is installed either below the fan-tray assembly or, for the ONS 15454 ANSI, in the optional external filter 
brackets. 

The reusable filter is made of a gray, open-cell, polyurethane foam that is specially coated to provide fire 
and fungi resistance. All versions of the ONS 15454 can use the reusable air filter. Spare filters should 
be kept in stock. Inspect the air filter every 30 days, and clean the filter every three to six months. 
Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or 
solvents.

Earlier versions of the ONS 15454 ANSI shelf used a disposable air filter that is installed beneath the 
fan-tray assembly only. However, the reusable air filter is backward compatible.

14.13 Power and Ground Description
Ground the equipment according to Telcordia standards or local practices. The following sections 
describe power and ground for the ONS 15454 shelves.

14.13.1 ONS 15454 ANSI Power and Ground
Cisco recommends the following wiring conventions, but customer conventions prevail:

• Red wire for battery connections (–48 VDC).

• Black wire for battery return connections (0 VDC). 

• The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE, Issue 3.

The ONS 15454 ANSI has redundant –48 VDC #8 power terminals on the shelf-assembly backplane. 
The terminals are labeled BAT1, RET1, BAT2, and RET2 and are located on the lower section of the 
backplane behind a clear plastic cover. 

To install redundant power feeds, use four power cables and one ground cable. For a single power feed, 
only two power cables (#10 AWG, 2.588 mm² [0.1018 inch], copper conductor, 194°F [90°C]) and one 
ground cable (#6 AWG, 4.115 mm² [0.162 inch]) are required. Use a conductor with low impedance to 
ensure circuit overcurrent protection. However, the conductor must have the capability to safely conduct 
any faulty current that might be imposed. 

Note If you are installing power on a Release 3.0 ONS 15454 ANSI shelf assembly (15454-SA-NEBS3E, 
15454-SA-NEBS3, and 15454-SA-R1), the #12 to #14 AWG (2.053 to 1.628 mm²) power cable and #14 
AWG (1.628 mm²) ground cable are required.
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The existing ground post is a #10-32 bolt. The nut provided for a field connection is also a #10 AWG 
(2.588 mm² [0.1018 inch]), with an integral lock washer. The lug must be a dual-hole type and rated to 
accept the #6 AWG (4.115 mm² [0.162 inch]) cable. Two posts are provided on the ONS 15454 ANSI to 
accommodate the dual-hole lug. Figure 14-41 shows the location of the ground posts.

Figure 14-41 Ground Posts on the ONS 15454 ANSI Backplane

14.13.2 ONS 15454 ETSI Power and Ground
The ONS 15454 ETSI has redundant –48 VDC power connectors on the MIC-A/P and MIC-C/T/P 
faceplates. 

To install redundant power feeds, use the two power cables shipped with the ONS 15454 ETSI and one 
ground cable. 

For details, see the “15.3.1 MIC-A/P FMEC” section on page 15-21 and the “15.3.2 MIC-C/T/P 
FMEC” section on page 15-24. 

Caution Only use the power cables shipped with the ONS 15454 ETSI.

14.14 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin 
Connections

Pin connections are provided on the ONS 15454 ANSI backplane. For information about 
ONS 15454 ETSI connections, see the “14.8 ONS 15454 ETSI Front Mount Electrical Connection” 
section on page 14-30.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

The ONS 15454 ANSI has a backplane pin field located at the bottom of the backplane. The backplane 
pin field provides 0.045 inch2 (29 mm2) wire-wrap pins for enabling external alarms, timing input and 
output, and craft interface terminals. This section describes the backplane pin field and the pin 
assignments for the field. Figure 14-42 shows the wire-wrap pins on the backplane pin field. Beneath 
each wire-wrap pin is a frame ground pin. Frame ground pins are labeled FG1, FG2, FG3, etc. Install the 
ground shield of the cables connected to the backplane to the ground pin that corresponds to the pin field 
used. 

FRAME GROUND 61
85

2

Attach #10 AWG
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Note The AIC-I requires a shelf assembly running Software Release 3.4.0 or later. The backplane of the ANSI 
shelf contains a wire-wrap field with pin assignment according to the layout in Figure 1-21 on page 1-53. 
The shelf assembly might be an existing shelf that has been upgraded to R3.4 or later. In this case the 
backplane pin labeling appears as indicated in Figure 14-42 on page 14-45, but you must use the pin 
assignments provided by the AIC-I as shown in Figure 1-21 on page 1-53.

Figure 14-42 ONS 15454 ANSI Backplane Pinouts

14.14.1 Alarm Contact Connections
The alarm pin field supports up to 17 alarm contacts, including four audible alarms, four visual alarms, 
one alarm cutoff (ACO), and four user-definable alarm input and output contacts. 

Field Pin Function Field Pin Function

BITS A1 BITS Output 2 negative (-)   ENVIR
 ALARMS 

OUT

N/O

A1 Normally open output pair number 1

B1 BITS Output 2 positive (+) B1

A2 BITS Input 2 negative (-) A2 Normally open output pair number 2

B2 BITS Input 2 positive (+) B2

A3 BITS Output 1 negative (-) A3 Normally open output pair number 3

B3 BITS Output 1 positive (+) B3

A4 BITS Input 1 negative (-) A4 Normally open output pair number 4

B4 BITS Input 1 positive (+) B4

LAN Connecting to a hub, or switch  ACO A1 Normally open ACO pair

A1 B1

B1 CRAFT A1 Receive (PC pin #2)

A2 A2 Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)

  LOCAL
ALARMS 

AUD
(Audible)

N/O

N/O

A1 Alarm output pair number 1: Remote 
audible alarm.B1 B1

 ENVIR
ALARMS 

IN

A2 Alarm output pair number 2: Critical 
audible alarm.B2

A3 Alarm output pair number 3: Major 
audible alarm.

A1

B3B1

A4 Alarm output pair number 4: Minor 
audible alarm.

A2

B4B2

 LOCAL
ALARMS 

VIS
(Visual)

A1 Alarm output pair number 1: Remote
visual alarm.

A3

B1

A2 Alarm output pair number 2:  Critical
visual alarm.B2

A3 Alarm output pair number 3: Major
visual alarm.B3

A4 Alarm output pair number 4: Minor 
visual alarm.B4

A1

A2

B3

A4

B4

RJ-45 pin 2 TX-

RJ-45 pin 1 TX+

RJ-45 pin 2 RX-

RJ-45 pin 1 RX+

RJ-45 pin 6 TX-

Alarm input pair number 1: Reports 
closure on connected wires.

Alarm input pair number 2: Reports 
closure on connected wires.

Alarm input pair number 3: Reports 
closure on connected wires.

Alarm input pair number 4: Reports
closure on connected wires.

Connecting to a PC/Workstation or router

RJ-45 pin 3 TX+B2

RJ-45 pin 3 RX+

RJ-45 pin 6 RX-

TBOS

AUDVIS
FG12FG11FG10FG9FG8FG7FG6FG5FG4FG3FG2

BITS LAN

FG1

111111111111

2222222222

3333333333

4444444444

2

3

4

2

ABABAABABABABABABABA B

LOCAL ALARMSCRAFTMODEM X . 25 ACO ENVIR  ALARMS
OUTIN

38
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Audible alarm contacts are in the LOCAL ALARM AUD pin field and visual contacts are in the LOCAL 
ALARM VIS pin field. Both of these alarms are in the LOCAL ALARMS category. User-definable 
contacts are in the ENVIR ALARM IN (external alarm) and ENVIR ALARM OUT (external control) 
pin fields. These alarms are in the ENVIR ALARMS category; you must have the AIC-I card installed 
to use the ENVIR ALARMS. Alarm contacts are Normally Open (N/O), meaning that the system closes 
the alarm contacts when the corresponding alarm conditions are present. Each alarm contact consists of 
two wire-wrap pins on the shelf assembly backplane. Visual and audible alarm contacts are classified as 
Critical, Major, Minor, and Remote. Figure 14-42 on page 14-45 shows alarm pin assignments. 

Visual and audible alarms are typically wired to trigger an alarm light or bell at a central alarm collection 
point when the corresponding contacts are closed. You can use the ACO pins to activate a remote ACO 
for audible alarms. You can also activate the ACO function by pressing the ACO button on the 
TCC2/TCC2P card faceplate. The ACO function clears all audible alarm indications. After clearing the 
audible alarm indication, the alarm is still present and viewable in the Alarms tab in CTC. 

14.14.2 Timing Connections
The ONS 15454 ANSI backplane supports two building integrated timing supply (BITS) clock pin 
fields. The first four BITS pins, rows 3 and 4, support output and input from the first external timing 
device. The last four BITS pins, rows 1 and 2, perform the identical functions for the second external 
timing device. Table 14-13 lists the pin assignments for the BITS timing pin fields.

Note For timing connection, use 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² 
[0.020 inch] or 0.64 mm² [0.0252 inch]), twisted-pair T1-type.

Note Refer to Telcordia SR-NWT-002224 for rules about provisioning timing references.

Table 14-13 BITS External Timing Pin Assignments

External Device Contact Tip and Ring Function

First external device A3 (BITS 1 Out) Primary ring (–) Output to external device

B3 (BITS 1 Out) Primary tip (+) Output to external device

A4 (BITS 1 In) Secondary ring (–) Input from external device

B4 (BITS 1 In) Secondary tip (+) Input from external device

Second external device A1 (BITS 2 Out) Primary ring (–) Output to external device

B1 (BITS 2 Out) Primary tip (+) Output to external device

A2 (BITS 2 In) Secondary ring (–) Input from external device

B2 (BITS 2 In) Secondary tip (+) Input from external device
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14.14.3 LAN Connections
Use the LAN pins on the ONS 15454 ANSI backplane to connect the ONS 15454 ANSI to a workstation 
or Ethernet LAN, or to a LAN modem for remote access to the node. You can also use the LAN port on 
the TCC/TCC2P faceplate to connect a workstation or to connect the ONS 15454 ANSI to the network. 
Table 14-14 shows the LAN pin assignments.

Before you can connect an ONS 15454 ANSI to other ONS 15454 ANSI shelves or to a LAN, you must 
change the default IP address that is shipped with each ONS 15454 ANSI (192.1.0.2). 

14.14.4 TL1 Craft Interface Installation
You can use the craft pins on the ONS 15454 ANSI backplane or the EIA/TIA-232 port on the 
TCC2/TCC2P faceplate to create a VT100 emulation window to serve as a TL1 craft interface to the 
ONS 15454 ANSI. Use a straight-through cable to connect to the EIA/TIA-232 port. Table 14-15 shows 
the pin assignments for the CRAFT pin field.

Note You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2/TCC2P card 
simultaneously.

Table 14-14 LAN Pin Assignments

Pin Field Backplane Pins RJ-45 Pins

LAN 1 
Connecting to data circuit-terminating 
equipment (DCE1, a hub or switch)

1. The Cisco ONS 15454 ANSI is DCE.

B2 1

A2 2

B1 3

A1 6

LAN 1
Connecting to data terminal equipment 
(DTE) (a PC/workstation or router)

B1 1

A1 2

B2 3

A2 6

Table 14-15 Craft Interface Pin Assignments

Pin Field Contact Function

Craft A1 Receive

A2 Transmit

A3 Ground

A4 DTR
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14.15 Cards and Slots 
ONS 15454 cards have electrical plugs at the back that plug into electrical connectors on the shelf 
assembly backplane. When the ejectors are fully closed, the card plugs into the assembly backplane. 
Figure 14-43 shows card installation for an ONS 15454 ANSI shelf. 

Figure 14-43 Installing Cards in the ONS 15454 ANSI
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Figure 14-44 shows card installation in the ONS 15454 ETSI shelf. 

Figure 14-44 Installing Cards in the ONS 15454 ETSI Shelf

14.15.1 Card Slot Requirements
The ONS 15454 shelf assemblies have 17 card slots numbered sequentially from left to right. Slots 7 and 
11 are dedicated to TCC2/TCC2P cards. Slot 9 is reserved for the optional AIC-I card. 

Caution Do not operate the ONS 15454 with a single TCC2/TCC2P card. Always operate the shelf assembly with 
one working and one protect card of the same type.

Shelf assembly slots have symbols indicating the type of cards that you can install in them. Each 
ONS 15454 card has a corresponding symbol. The symbol on the card must match the symbol on the slot.
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Table 14-16 shows the slot and card symbol definitions.

14.15.2 Card Replacement
To replace an ONS 15454 card with another card of the same type, you do not need to make any changes 
to the database; remove the old card and replace it with a new card. To replace a card with a card of a 
different type, physically remove the card and replace it with the new card, then delete the original card 
from CTC. For specifics, see Chapter 12, “Maintain the Node.”

Caution Removing any active card from the ONS 15454 can result in traffic interruption. Use caution when 
replacing cards and verify that only inactive or standby cards are being replaced. If the active card needs 
to be replaced, switch it to standby prior to removing the card from the node. For traffic switching 
procedures, refer to the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on 
page 10-25. 

Note An improper removal (IMPROPRMVL) alarm is raised whenever a card pull (reseat) is performed, 
unless the card is deleted in CTC first. The alarm clears after the card replacement is complete.

14.16 Ferrites (ANSI Only)
Place third-party ferrites on certain cables to dampen electromagnetic interference (EMI) from the 
ONS 15454 ANSI. Ferrites must be added to meet the requirements of Telcordia GR-1089-CORE. Refer 
to the ferrite manufacturer documentation for proper use and installation of the ferrites. Ferrite 
placements on the ONS 15454 ANSI can include power cables, AMP Champ connectors, baluns, 
BNC/SMB connectors, and the wire-wrap pin field.

Table 14-16 Slot and Card Symbols

Symbol Color/Shape Definition

Orange/Circle Slots 1 to 6 and 12 to 17. Only install cards with a circle symbol on the faceplate.

Blue/Triangle Slots 5, 6, 12, and 13. Only install cards with circle or a triangle symbol on the 
faceplate.

Purple/Square TCC2/TCC2P slot, Slots 7 and 11. Only install cards with a square symbol on 
the faceplate.

Green/Cross Cross-connect (XC/XCVT/XC10G) slot, Slots 8 and 10. Only install 
ONS 15454 cards with a cross symbol on the faceplate.

Red/P Protection slot in 1:N protection schemes.

Red/Diamond AIC/AIC-I slot, Slot 9. Only install cards with a diamond symbol on the 
faceplate.

Gold/Star Slots 1 to 4 and 14 to 17. Only install cards with a star symbol on the faceplate. 

Blue/Hexagon (Only used with the 15454-SA-HD shelf assembly.) Slots 3 and 15. Only install 
ONS 15454 ANSI cards with a blue hexagon symbol on the faceplate.
14-50
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Cisco ONS 15454 DWDM
September 2005
C H A P T E R 15

Card Reference

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter describes Cisco ONS 15454 dense wavelength division multiplexing (DWDM) card and 
client card features and functions. It also describes the common control cards needed to support them as 
well as the optical plug-in modules (Small Form-factor Pluggables [SFPs]). For installation and card 
turn-up procedures, refer to Chapter 3, “Turn Up a Node.” For card safety and compliance information, 
refer to the Cisco Optical Transport Products Safety and Compliance Information document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 15.1 Card Overview, page 15-2

• 15.2 Common Control Cards, page 15-9

• 15.3 Front Mount Electrical Connections, page 15-21

• 15.4 Optical Service Channel Cards, page 15-25

• 15.5 Optical Amplifier Cards, page 15-34

• 15.6 Multiplexer and Demultiplexer Cards, page 15-45

• 15.7 Optical Add/Drop Multiplexer Cards, page 15-59

• 15.8 Transponder and Muxponder Cards, page 15-82

• 15.9 Transponder and Muxponder Protection, page 15-114

• 15.10 Far-End Laser Control (FELC), page 15-116

• 15.11 Jitter Considerations, page 15-116

• 15.12 Termination Modes, page 15-117

• 15.13 SFP and XFP Modules, page 15-118
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15.1 Card Overview
The card overview section lists the cards described in this chapter and summarizes card functions, power 
consumption, and temperature ranges of the optical cards covered in this reference section. 

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. See the “14.15.1 Card Slot 
Requirements” section on page 14-49 for a list of slots and symbols. 

15.1.1 Common Control Cards
The following common control cards are needed to support the functions of the DWDM, transponder, 
and muxponder cards:

• TCC2 or TCC2P

• AIC-I (optional)

15.1.2 Front Mount Electrical Connections (ETSI only)
The following Front Mount Electrical Connections (FMECs) are needed to support the functions of the 
DWDM, transponder, and muxponder cards:

• MIC-A/P

• MIC-C/T/P

15.1.3 DWDM Cards
ONS 15454 DWDM cards are grouped into the following categories: 

• Optical service channel cards—These cards provide channels that connect ONS 15454 DWDM 
nodes and transport general-purpose information (including Cisco Transport Controller [CTC] 
management) without affecting the client traffic. ONS 15454 optical service channel cards include 
the Optical Service Channel Module (OSCM) and the Optical Service Channel and 
Combiner/Separator Module (OSC-CSM).

• Optical amplifier cards—These cards are used in amplified DWDM nodes, including hub nodes, 
amplified OADM nodes, and line amplified nodes. Optical amplifier cards include the Optical 
Preamplifier (OPT-PRE), Optical Booster (OPT-BST), and Optical Booster Enhanced (OPT-BST-E) 
amplifier.

• Dispersion compensation units—These cards are installed in the ONS 15454 dispersion 
compensation shelf when optical preamplifier cards are installed in the DWDM node. Each 
dispersion compensation unit (DCU) module is designed to compensate a specific fiber length, up 
to a maximum (per-module) of 65 km of standard single-mode fiber (SMF-28). DCUs can be 
cascaded to extend the compensation to 130 km.

• Multiplexer and demultiplexer cards—These cards multiplex and demultiplex DWDM optical 
channels. ONS 15454 multiplexer and demultiplexer cards include the 32-Channel Multiplexer 
(32MUX-O), the 32-Channel Demultiplexer (32DMX-O), the single-slot 32-Channel Demultiplexer 
(32DMX), and the 4-Channel Multiplexer/Demultiplexer (4MD-xx.x).
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• Optical Add/Drop Multiplexer (OADM) cards—These cards are mainly divided into two groups: 
band OADM and channel OADM cards. Band OADM cards add and drop one or four bands of 
adjacent channels; they include the 4-Band OADM (AD-4B-xx.x) and the 1-Band OADM 
(AD-1B-xx.x). Channel OADM cards add and drop one, two, or four adjacent channels; they include 
the 4-Channel OADM (AD-4C-xx.x), the 2-Channel OADM (AD-2C-xx.x), and the 1-Channel 
OADM (AD-1C-xx.x). This section also covers the 32-Channel Wavelength Selective Switch 
(32WSS) used to implement Reconfigurable OADM (ROADM) functionality.

15.1.4 Transponder and Muxponder Cards
The purpose of a transponder (TXP) or muxponder (MXP) card is to convert the “gray” optical client 
interface signals into trunk signals that operate in the “colored” DWDM wavelength range1. 
Transponding or muxponding is the process of converting the signals between the client and trunk 
wavelengths. 

A muxponder generally handles several client signals. It aggregates, or multiplexes, lower rate client 
signals together and sends them out over a higher rate trunk port. Likewise, it demultiplexes optical 
signals coming in on a trunk and sends them out to individual client ports. A transponder converts a 
single client signal to a single trunk signal and converts a single incoming trunk signal to a single client 
signal.

All of the TXP and MXP cards perform optical to electrical to optical (OEO) conversion. As a result, 
they are not optically transparent cards. The reason for this is that the cards must operate on the signals 
passing through them, so it is necessary to do an OEO conversion.

On the other hand, the termination mode for all of the TXPs and MXPs, which is done at the electrical 
level, can be configured to be transparent. In this case, neither the Line nor the Section overhead is 
terminated. The cards can also be configured so that either Line or Section overhead can be terminated, 
or both can be terminated.

Note The MXP_2.5G_10G card, by design, when configured in the transparent termination mode, actually 
does terminate some of the bytes. See Table 15-68 on page 15-117 for details.

15.1.5 Card Summary
Table 15-1 lists and summarizes the functions of each Cisco ONS 15454 DWDM and client card.

1. Client-facing gray optical signals generally operate at shorter wavelengths, whereas DWDM colored optical 
signals are in the longer wavelength range (for example, 1490 nm = violet; 1510 nm = blue; 1530 nm = green; 
1550 nm = yellow; 1570 nm = orange; 1590 nm = red; 1610 nm = brown). Some of the newer client-facing 
SFPs, however, operate in the colored region.

Table 15-1 DWDM and Client Cards for the ONS 15454

Card Port Description For Additional Information

Optical Service Channel Cards

OSCM The OSCM has one set of optical ports and one 
Ethernet port located on the faceplate. It operates 
in Slots 8 and 10.

See the “15.4.1 OSCM Card” 
section on page 15-26.
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OSC-CSM The OSC-CSM has three sets of optical ports and 
one Ethernet port located on the faceplate. It 
operates in Slots 1 to 6 and 12 to 17.

See the “15.4.2 OSC-CSM 
Card” section on page 15-29.

Optical Amplifier Cards

OPT-PRE The OPT-PRE amplifier has five optical ports 
(three sets) located on the faceplate. It operates in 
Slots 1 to 6 and 12  to 17.

See the “15.5.1 OPT-PRE 
Amplifier” section on 
page 15-35.

OPT-BST The OPT-BST amplifier has four sets of optical 
ports located on the faceplate. It operates in 
Slots 1 to 6 and 12  to 17.

See the “15.5.2 OPT-BST 
Amplifier Card” section on 
page 15-38.

OPT-BST-E The OPT-BST-E amplifier has four sets of optical 
ports located on the faceplate. It operates in 
Slots 1 to 6 and 12  to 17.

See the “15.5.3 OPT-BST-E 
Amplifier Card” section on 
page 15-41.

Multiplexer and Demultiplexer Cards

32MUX-O The 32MUX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16.

See the “15.6.1 32MUX-O 
Card” section on page 15-45.

32DMX-O The 32DMX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16.

See the “15.6.2 32DMX-O 
Card” section on page 15-49.

32DMX The 32DMX has five sets of ports located on the 
faceplate. It operates in Slots 1 to 6 and 12 to 17.

See the “15.6.3 32DMX Card” 
section on page 15-52

4MD-xx.x The 4MD-xx.x card has five sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “15.6.4 4MD-xx.x 
Card” section on page 15-55.

Optical Add/Drop Multiplexer Cards

AD-1C-xx.x The AD-1C-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “15.7.1 AD-1C-xx.x 
Card” section on page 15-59.

AD-2C-xx.x The AD-2C-xx.x card has four sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “15.7.2 AD-2C-xx.x 
Card” section on page 15-62.

AD-4C-xx.x The AD-4C-xx.x card has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “15.7.3 AD-4C-xx.x 
Card” section on page 15-66.

AD-1B-xx.x The AD-1B-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “15.7.4 AD-1B-xx.x 
Card” section on page 15-70.

AD-4B-xx.x The AD-4B-xx.x card has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “15.7.5 AD-4B-xx.x 
Card” section on page 15-73.

32WSS The 32WSS card has seven sets of ports located on 
the faceplate. It operates in Slots 1 to 5 and 
12 to 16.

See the “15.7.6 32WSS Card” 
section on page 15-76

Transponder and Muxponder Cards

Table 15-1 DWDM and Client Cards for the ONS 15454 (continued)

Card Port Description For Additional Information
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15.1.6 Card Compatibility
Table 15-2 lists the CTC software compatibility for each DWDM and client card.

TXP_MR_10G The TXP_MR_10G card has two sets of ports 
located on the faceplate.

See the “15.8.1 TXP_MR_10G 
Card” section on page 15-82

TXP_MR_10E The TXP_MR_10E card has two sets of ports 
located on the faceplate.

See the “15.8.2 TXP_MR_10E 
Card” section on page 15-84

TXP_MR_2.5G The TXP_MR_2.5G card has two sets of ports 
located on the faceplate.

See the “15.8.3 TXP_MR_2.5G 
and TXPP_MR_2.5G Cards” 
section on page 15-88

TXPP_MR_2.5G The TXPP_MR_2.5G card has three sets of ports 
located on the faceplate.

See the “15.8.3 TXP_MR_2.5G 
and TXPP_MR_2.5G Cards” 
section on page 15-88

MXP_2.5G_10G The MXP_2.5G_10G card has 9 sets of ports 
located on the faceplate.

See the 
“15.8.4 MXP_2.5G_10G Card” 
section on page 15-95.

MXP_2.5G_10E The MXP_2.5G_10E card has 9 sets of ports 
located on the faceplate.

See the 
“15.8.5 MXP_2.5G_10E Card” 
section on page 15-99

MXP_MR_2.5G The MXP_MR_2.5G card has 9 sets of ports 
located on the faceplate.

See the 
“15.8.6 MXP_MR_2.5G and 
MXPP_MR_2.5G Cards” 
section on page 15-106

MXPP_MR_2.5G The MXPP_MR_2.5G card has ten sets of ports 
located on the faceplate.

See the 
“15.8.6 MXP_MR_2.5G and 
MXPP_MR_2.5G Cards” 
section on page 15-106

Table 15-1 DWDM and Client Cards for the ONS 15454 (continued)

Card Port Description For Additional Information

Table 15-2 DWDM and Client Card CTC Software Release Compatibility

Card Type

Compatibility

R4.5 R4.6 R4.7 R5.0

Optical Service Channel Cards Yes Yes Yes Yes

OSCM Yes Yes Yes Yes

OSC-CSM Yes Yes Yes Yes

Optical Amplifier Cards Yes Yes Yes Yes

OPT-PRE Yes Yes Yes Yes

OPT-BST Yes Yes Yes Yes

OPT-BST-E Yes Yes Yes Yes

Multiplexer and Demultiplexer Cards Yes Yes Yes Yes

32MUX-O Yes Yes Yes Yes
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15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes
The 32MUX-O, 32WSS, 32DMX, 32DMX-O, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x 
cards have different input and output optical channel signals depending upon the interface card where 
the input signal originates. The input interface cards have been grouped in classes listed in Table 15-3. 
The subsequent tables list the optical performances and output power of each interface class. 

32DMX-O Yes Yes Yes Yes

32DMX No No Yes Yes

4MD-xx.x Yes Yes Yes Yes

Optical Add/Drop Multiplexer Cards Yes Yes Yes Yes

AD-1C-xx.x Yes Yes Yes Yes

AD-2C-xx.x Yes Yes Yes Yes

AD-4C-xx.x Yes Yes Yes Yes

AD-1B-xx.x Yes Yes Yes Yes

AD-4B-xx.x Yes Yes Yes Yes

32WSS No No Yes Yes

Transponder and Muxponder Cards Yes Yes Yes Yes

TXP_MR_10G Yes Yes Yes Yes

TXP_MR_10E No No Yes Yes

TXP_MR_2.5G Yes Yes Yes Yes

TXPP_MR_2.5G Yes Yes Yes Yes

MXP_2.5G_10G Yes Yes Yes Yes

MXP_2.5G_10E No No Yes Yes

MXP_MR_2.5G No No Yes Yes

MXPP_MR_2.5G No No Yes Yes

Table 15-2 DWDM and Client Card CTC Software Release Compatibility (continued)

Card Type

Compatibility

R4.5 R4.6 R4.7 R5.0

Table 15-3 ONS 15454 Card Interfaces Assigned to Input Power Classes

Input Power Class Card

A 10-Gbps multirate transponder (TXP_MR_10G or TXP_MR_10E) with forward 
error correction (FEC) enabled or 10-Gbps muxponder (MXP_2.5G_10G or 
MXP_2.5G_10E) with FEC enabled

B 10-Gbps multirate transponder (TXP_MR_10G) without FEC or 10-Gbps 
muxponder (MXP_2.5G_10G) with FEC disabled

C OC-192 LR ITU, TXP_MR_10E without FEC

D 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, with FEC enabled
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10-Gbps cards that provide signal input to OADM cards have the optical performance parameters listed 
in Table 15-4. 2.5-Gbps card interface performance parameters are listed in Table 15-5 on page 15-8.

E 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, with FEC disabled and reshape, regenerate, and retime (3R) mode 
enabled, or OC-48 100-GHz DWDM muxponder (MXP_MR_2.5G)

F 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, in regenerate and reshape (2R) mode

G OC-48 ELR 100 GHz

H 2/4 port GbE transponder (GBIC WDM 100GHz)

I TXP_MR_10E with extended FEC (E-FEC) or MXP_2.5G_10E with E-FEC 
enabled

Table 15-3 ONS 15454 Card Interfaces Assigned to Input Power Classes (continued)

Input Power Class Card

Table 15-4 10-Gbps Interface Optical Performance

Parameter Class A Class B Class C Class I

Type
Power 
Limited

OSNR1 
Limited

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R 3R 3R 3R

FEC Yes No No Yes (E-FEC)

Threshold Optimum Average Average Optimum

Maximum BER2

2. BER = bit error rate

10–15 10–12 10–12 10–15

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 dBm –20 dBm –22 dBm –26 dBm –18 dBm

Power overload –8 dBm –8 dBm –9 dBm –8 dBm

Transmitted Power Range3

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10G)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm — —

OC-192 LR ITU — — +3.0 to 6.0 
dBm

—

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10E)

+3.0 to 6.0 dBm +3.0 to 6.0 dBm — +3.0 to 6.0 dBm

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–1,000 
ps/nm

+/–800 ps/nm
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15.1.8 DWDM Card Channel Allocation Plan
ONS 15454 DWDM multiplexers, demultiplexers, channel OADM, and band OADM cards are designed 
for use with specific channels. In most cases, the channels for these cards are either numbered (1 to 32) 
or delimited (odd or even). Client interfaces must comply with these channel assignments to be 
compatible with the ONS 15454 system.

Table 15-6 lists the channel IDs and wavelengths assigned to the DWDM channels.

3. These values, decreased by patch cord and connector losses, are also the input power values for the OADM cards.

Table 15-5 2.5-Gbps Interface Optical Performance

Parameter Class D Class E Class F Class G Class H Class J

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

Maximum bit rate 2.5 Gbps 2.5 Gbps 2.5 Gbps 2.5 Gbps 1.25 Gbps 2.5 Gbps

Regeneration 3R 3R 2R 3R 3R 3R

FEC Yes No No No No No

Threshold Average Average Average Average Average Average

Maximum BER 10–15 10–12 10–12 10–12 10–12 10–12

OSNR sensitivity 14 dB 6 dB 14 dB 10 dB 15 dB 14 dB 11 dB 13 dB 8 dB 12 dB

Power sensitivity –31 
dBm

–25 
dBm

–30 
dBm

–23 
dBm

–24 dBm –27 
dBm

–33 
dBm

–28 dBm –18 dBm –26 dBm

Power overload –9 dBm –9 dBm –9 dBm –9 dBm –7 dBm –17dBm

Transmitted Power Range1

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

TXP_MR_2.5G –1.0 to 1.0 dBm –1.0 to 1.0 dBm –1.0 to 
1.0 dBm

–2.0 to 0 dBm

TXPP_MR_2.5G –4.5 to –2.5 dBm –4.5 to –2.5 dBm –4.5 to 
–2.5 dBm

MXP_MR_2.5G — +2.0 to +4.0 dBm —

MXPP_MR_2.5G — –1.5 to +0.5 dBm —

2/4 port GbE 
Transponder (GBIC 
WDM 100GHz)

+2.5 to 3.5 dBm —

Dispersion 
compensation 
tolerance

 –1200 to 
+5400 ps/nm

 –1200 to 
+5400 ps/nm

 –1200 to 
+3300 
ps/nm

 –1200 to 
+3300 ps/nm

–1000 to +3600 
ps/nm

–1000 to 
+3200 
ps/nm
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15.2 Common Control Cards
This section describes the common control cards (TCC2, TCC2P, and AIC-I).

Table 15-6 DWDM Channel Allocation Plan

Channel Number Channel ID Frequency (THz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61
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15.2.1 TCC2 Card
The Advanced Timing, Communications, and Control (TCC2) card performs system initialization, 
provisioning, alarm reporting, maintenance, diagnostics, IP address detection/resolution, SONET 
section overhead (SOH) data communications channel/generic communications channel (DCC/GCC) 
termination, optical service channel (OSC) DWDM data communications network (DCN) termination, 
and system fault detection for the ONS 15454. The TCC2 also ensures that the system maintains 
Stratum 3 (Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system. 

Note The LAN interface of the TCC2 card meets the standard Ethernet specifications by supporting a cable 
length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius).

Figure 15-1 shows the faceplate and block diagram for the TCC2. 
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Figure 15-1 TCC2 Faceplate and Block Diagram

15.2.1.1 TCC2 Functionality

The TCC2 card terminates up to 32 DCCs. The TCC2 hardware is prepared for up to 84 DCCs, which 
will be available in a future software release. 

The node database, IP address, and system software are stored in TCC2 nonvolatile memory, which 
allows quick recovery in the event of a power or card failure.
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The TCC2 performs all system-timing functions for each ONS 15454. The TCC2 monitors the recovered 
clocks from each traffic card and two building integrated timing supply (BITS) ports for frequency 
accuracy. The TCC2 selects a recovered clock, a BITS, or an internal Stratum 3 reference as the 
system-timing reference. You can provision any of the clock inputs as primary or secondary timing 
sources. A slow-reference tracking loop allows the TCC2 to synchronize with the recovered clock, which 
provides holdover if the reference is lost. 

The TCC2 monitors both supply voltage inputs on the shelf. An alarm is generated if one of the supply 
voltage inputs has a voltage out of the specified range. 

Install TCC2 cards in Slots 7 and 11 for redundancy. If the active TCC2 fails, traffic switches to the 
protect TCC2.

The TCC2 card has two built-in interface ports for accessing the system: an RJ-45 10BaseT LAN 
interface and an EIA/TIA-232 ASCII interface for local craft access. It also has a 10BaseT LAN port for 
user interfaces via the backplane. 

15.2.1.2 Redundant TCC2 Card Installation

Cisco does not support operation of the ONS 15454 with only one TCC2 card. For full functionality and 
to safeguard your system, always operate with two TCC2 cards. 

When a second TCC2 card is inserted into a node, it synchronizes its software, its backup software, and 
its database with the active TCC2. If the software version of the new TCC2 does not match the version 
on the active TCC2, the newly inserted TCC2 copies from the active TCC2, taking about 15 to 20 
minutes to complete. If the backup software version on the new TCC2 does not match the version on the 
active TCC2, the newly inserted TCC2 copies the backup software from the active TCC2 again, taking 
about 15 to 20 minutes. Copying the database from the active TCC2 takes about 3 minutes. Depending 
on the software version and backup version the new TCC2 started with, the entire process can take 
between 3 and 40 minutes. 

15.2.1.3 TCC2 Card-Level Indicators

The TCC2 faceplate has eight LEDs. Table 15-7 describes the two card-level LEDs on the TCC2 
faceplate.

15.2.1.4 Network-Level Indicators

Table 15-8 describes the six network-level LEDs on the TCC2 faceplate.

Table 15-7 TCC2 Card-Level Indicators 

Card-Level LEDs Definition

Red FAIL LED This LED is on during reset. The FAIL LED flashes during the boot and 
write process. Replace the card if the FAIL LED persists. 

ACT/STBY LED

Green (Active)

Yellow (Standby)

Indicates the TCC2 is active (green) or in standby (yellow) mode. The 
ACT/STBY LED also provides the timing reference and shelf control. When 
the active TCC2 is writing to its database or to the standby TCC2 database, 
the card LEDs blink. To avoid memory corruption, do not remove the TCC2 
when the active or standby LED is blinking. 
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15.2.2 TCC2P Card
The Advanced Timing, Communications, and Control Plus (TCC2P) card is an enhanced version of the 
TCC2 card. The primary enhancements are Ethernet security features and 64K composite clock BITS 
timing.

The TCC2P card performs system initialization, provisioning, alarm reporting, maintenance, 
diagnostics, IP address detection/resolution, SONET SOH DCC/GCC termination, and system fault 
detection for the ONS 15454. The TCC2P also ensures that the system maintains Stratum 3 
(Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system. 

Note The LAN interface of the TCC2P card meets the standard Ethernet specifications by supporting a cable 
length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius). 
The interfaces can operate with a cable length of 32.8 ft (10 m) maximum at temperatures from –40 to 
32 degrees Fahrenheit (–40 to 0 degrees Celsius). 

Figure 15-2 shows the faceplate and block diagram for the TCC2P card. 

Table 15-8 TCC2 Network-Level Indicators

System-Level LEDs Definition

Red CRIT LED Indicates critical alarms in the network at the local terminal.

Red MAJ LED Indicates major alarms in the network at the local terminal.

Yellow MIN LED Indicates minor alarms in the network at the local terminal.

Red REM LED Provides first-level alarm isolation. The remote (REM) LED turns red when 
an alarm is present in one or more of the remote terminals.

Green SYNC LED Indicates that node timing is synchronized to an external reference.

Green ACO LED After pressing the alarm cutoff (ACO) button, the ACO LED turns green. 
The ACO button opens the audible alarm closure on the backplane. ACO is 
stopped if a new alarm occurs. After the originating alarm is cleared, the 
ACO LED and audible alarm control are reset.
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Figure 15-2 TCC2P Faceplate and Block Diagram
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15.2.3 TCC2P Functionality
The TCC2P card supports multichannel, high-level data link control (HDLC) processing for the DCC. 
Up to 84 DCCs can be routed over the TCC2P card and up to 84 section DCCs can be terminated at the 
TCC2P card (subject to the available optical digital communication channels). The TCC2P selects and 
processes 84 DCCs to facilitate remote system management interfaces. 

The TCC2P card also originates and terminates a cell bus carried over the module. The cell bus supports 
links between any two cards in the node, which is essential for peer-to-peer communication. Peer-to-peer 
communication accelerates protection switching for redundant cards.

The node database, IP address, and system software are stored in TCC2P card nonvolatile memory, 
which allows quick recovery in the event of a power or card failure.

The TCC2P card performs all system-timing functions for each ONS 15454. The TCC2P card monitors 
the recovered clocks from each traffic card and two BITS ports for frequency accuracy. The TCC2P card 
selects a recovered clock, a BITS, or an internal Stratum 3 reference as the system-timing reference. You 
can provision any of the clock inputs as primary or secondary timing sources. A slow-reference tracking 
loop allows the TCC2P card to synchronize with the recovered clock, which provides holdover if the 
reference is lost. 

The TCC2P card supports 64/8K composite clock and 6.312 MHz timing output.

The TCC2P card monitors both supply voltage inputs on the shelf. An alarm is generated if one of the 
supply voltage inputs has a voltage out of the specified range. 

Install TCC2P cards in Slots 7 and 11 for redundancy. If the active TCC2P card fails, traffic switches to 
the protect TCC2P card. All TCC2P card protection switches conform to protection switching standards 
when the bit error rate (BER) counts are not in excess of 1 * 10 exp – 3 and completion time is less than 
50 ms.

The TCC2P card has two built-in Ethernet interface ports for accessing the system: one built-in RJ-45 
port on the front faceplate for on-site craft access and a second port on the backplane. The rear Ethernet 
interface is for permanent LAN access and all remote access via TCP/IP as well as for Operations 
Support System (OSS) access. The front and rear Ethernet interfaces can be provisioned with different 
IP addresses using CTC.

Two EIA/TIA-232 serial ports, one on the faceplate and a second on the backplane, allow for craft 
interface in TL1 mode.

15.2.3.1 Redundant TCC2P Card Installation

Cisco does not support operation of the ONS 15454 with only one TCC2P card. For full functionality 
and to safeguard your system, always operate with two TCC2P cards. 

When a second TCC2P card is inserted into a node, it synchronizes its software, its backup software, and 
its database with the active TCC2P card. If the software version of the new TCC2P card does not match 
the version on the active TCC2P card, the newly inserted TCC2P card copies from the active TCC2P 
card, taking about 15 to 20 minutes to complete. If the backup software version on the new TCC2P card 
does not match the version on the active TCC2P card, the newly inserted TCC2P card copies the backup 
software from the active TCC2P card again, taking about 15 to 20 minutes. Copying the database from 
the active TCC2P card takes about 3 minutes. Depending on the software version and backup version the 
new TCC2P card started with, the entire process can take between 3 and 40 minutes. 
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15.2.3.2 TCC2P Card-Level Indicators

The TCC2P faceplate has eight LEDs. Table 15-9 describes the two card-level LEDs on the TCC2P 
faceplate.

15.2.3.3 Network-Level Indicators

Table 15-10 describes the six network-level LEDs on the TCC2P faceplate.

15.2.4 AIC-I Card
The optional Alarm Interface Controller–International (AIC-I) card provides customer-defined 
(environmental) alarms and controls and supports local and express orderwire. It provides 
12 customer-defined input and 4 customer-defined input/output contacts. The physical connections are 
via the backplane wire-wrap pin terminals. If you use the additional alarm expansion panel (AEP), the 
AIC-I card can support up to 32 inputs and 16 outputs, which are connected on the AEP connectors. The 
AEP is compatible with ANSI shelves only. A power monitoring function monitors the supply voltage 
(–48 VDC). Figure 15-3 shows the AIC-I faceplate and a block diagram of the card. 

Table 15-9 TCC2P Card-Level Indicators 

Card-Level LEDs Definition

Red FAIL LED This LED is on during reset. The FAIL LED flashes during the boot and 
write process. Replace the card if the FAIL LED persists. 

ACT/STBY LED

Green (Active)

Amber (Standby)

Indicates the TCC2P is active (green) or in standby (amber) mode. The 
ACT/STBY LED also provides the timing reference and shelf control. When 
the active TCC2P is writing to its database or to the standby TCC2P 
database, the card LEDs blink. To avoid memory corruption, do not remove 
the TCC2P when the active or standby LED is blinking. 

Table 15-10 TCC2P Network-Level Indicators

System-Level LEDs Definition

Red CRIT LED Indicates critical alarms in the network at the local terminal.

Red MAJ LED Indicates major alarms in the network at the local terminal.

Amber MIN LED Indicates minor alarms in the network at the local terminal.

Red REM LED Provides first-level alarm isolation. The remote (REM) LED turns red when 
an alarm is present in one or more of the remote terminals.

Green SYNC LED Indicates that node timing is synchronized to an external reference.

Green ACO LED After pressing the ACO button, the ACO LED turns green. The ACO button 
opens the audible alarm closure on the backplane. ACO is stopped if a new 
alarm occurs. After the originating alarm is cleared, the ACO LED and 
audible alarm control are reset.
15-16
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 15      Card Reference
Common Control Cards
Figure 15-3 AIC-I Faceplate and Block Diagram

15.2.4.1 AIC-I Card-Level Indicators

Table 15-11 describes the eight card-level LEDs on the AIC-I card faceplate. 
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Table 15-11 AIC-I Card-Level Indicators

Card-Level LEDs Description

Red FAIL LED Indicates that the card’s processor is not ready. The FAIL LED is on during 
reset and flashes during the boot process. Replace the card if the red FAIL 
LED persists.

Green ACT LED Indicates the AIC-I card is provisioned for operation.
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15.2.4.2 External Alarms and Controls

The AIC-I card provides input/output alarm contact closures. You can define up to 12 external alarm 
inputs and 4 external alarm inputs/outputs (user configurable). The physical connections are made using 
the backplane wire-wrap pins or FMEC connections. See the “14.9 ONS 15454 ANSI Alarm Expansion 
Panel” section on page 14-30 for information about increasing the number of input/output contacts.

LEDs on the front panel of the AIC-I indicate the status of the alarm lines, one LED representing all of 
the inputs and one LED representing all of the outputs. External alarms (input contacts) are typically 
used for external sensors such as open doors, temperature sensors, flood sensors, and other 
environmental conditions. External controls (output contacts) are typically used to drive visual or 
audible devices such as bells and lights, but they can control other devices such as generators, heaters, 
and fans.

You can program each of the twelve input alarm contacts separately. You can program each of the sixteen 
input alarm contacts separately. Choices include:

• Alarm on Closure or Alarm on Open

• Alarm severity of any level (Critical, Major, Minor, Not Alarmed, Not Reported)

• Service Affecting or Non-Service Affecting alarm-service level

• 63-character alarm description for CTC display in the alarm log.

You cannot assign the fan-tray abbreviation for the alarm; the abbreviation reflects the generic name of 
the input contacts. The alarm condition remains raised until the external input stops driving the contact 
or you provision the alarm input.

The output contacts can be provisioned to close on a trigger or to close manually. The trigger can be a 
local alarm severity threshold, a remote alarm severity, or a virtual wire:

• Local NE alarm severity: A hierarchy of Not Reported, Not Alarmed, Minor, Major, or Critical 
alarm severities that you set to cause output closure. For example, if the trigger is set to Minor, a 
Minor alarm or above is the trigger.

• Remote NE alarm severity: Same as the local NE alarm severity but applies to remote alarms only.

Green/red PWR A LED The PWR A LED is green when a supply voltage within a specified range 
has been sensed on supply input A. It is red when the input voltage on supply 
input A is out of range. 

Green/red PWR B LED The PWR B LED is green when a supply voltage within a specified range has 
been sensed on supply input B. It is red when the input voltage on supply 
input B is out of range.

Yellow INPUT LED The INPUT LED is yellow when there is an alarm condition on at least one 
of the alarm inputs. 

Yellow OUTPUT LED The OUTPUT LED is yellow when there is an alarm condition on at least one 
of the alarm outputs. 

Green RING LED The RING LED on the local orderwire (LOW) side is flashing green when a 
call is received on the LOW.

Green RING LED The RING LED on the express orderwire (EOW) side is flashing green when 
a call is received on the EOW.

Table 15-11 AIC-I Card-Level Indicators (continued)

Card-Level LEDs Description
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• Virtual wire entities: You can provision any environmental alarm input to raise a signal on any 
virtual wire on external outputs 1 through 4 when the alarm input is an event. You can provision a 
signal on any virtual wire as a trigger for an external control output.

You can also program the output alarm contacts (external controls) separately. In addition to 
provisionable triggers, you can manually force each external output contact to open or close. Manual 
operation takes precedence over any provisioned triggers that might be present.

Note For ANSI shelves, the number of inputs and outputs can be increased using the AEP. The AEP is 
connected to the shelf backplane and requires an external wire-wrap panel. 

15.2.4.3 Orderwire

Orderwire allows a craftsperson to plug a phoneset into an ONS 15454 and communicate with 
craftspeople working at other ONS 15454s or other facility equipment. The orderwire is a pulse code 
modulation (PCM) encoded voice channel that uses E1 or E2 bytes in section/line overhead.

The AIC-I allows simultaneous use of both local (section overhead signal) and express (line overhead 
channel) orderwire channels on a SONET/SDH ring or particular optics facility. Express orderwire also 
allows communication via regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with CTC similar to the current provisioning model for 
DCC/GCC channels. In CTC, you provision the orderwire communications network during ring turn-up 
so that all NEs on the ring can reach one another. Orderwire terminations (that is, the optics facilities 
that receive and process the orderwire channels) are provisionable. Both express and local orderwire can 
be configured as on or off on a particular SONET/SDH facility. The ONS 15454 supports up to four 
orderwire channel terminations per shelf. This allows linear, single ring, dual ring, and small 
hub-and-spoke configurations. Orderwire is not protected in ring topologies such as BLSR/MS-SPRing 
and path protection/SNCP.

Caution Do not configure orderwire loops. Orderwire loops cause feedback that disables the orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line acts 
as a party line. Anyone who picks up the orderwire channel can communicate with all other participants 
on the connected orderwire subnetwork. The local orderwire party line is separate from the express 
orderwire party line. Up to four OC-N/STM-N facilities for each local and express orderwire are 
provisionable as orderwire paths.

The AIC-I supports selective dual tone multifrequency (DTMF) dialing for telephony connectivity, 
which causes one AIC-I card or all ONS 15454 AIC-I cards on the orderwire subnetwork to “ring.” The 
ringer/buzzer resides on the AIC-I. There is also a “ring” LED that mimics the AIC-I ringer. It flashes 
when a call is received on the orderwire subnetwork. A party line call is initiated by pressing *0000 on 
the DTMF pad. Individual dialing is initiated by pressing * and the individual four-digit number on the 
DTMF pad. 

Table 15-12 shows the pins on the orderwire connector that correspond to the tip and ring orderwire 
assignments. 
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When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist. Loops 
cause oscillation and an unusable orderwire channel. 

Figure 15-4 shows the standard RJ-11 connectors used for orderwire ports.

Figure 15-4 RJ-11 Connector

15.2.4.4 Power Monitoring

The AIC-I card provides a power monitoring circuit that monitors the supply voltage of –48 VDC for 
presence, undervoltage, and overvoltage. 

15.2.4.5 User Data Channel 

The user data channel (UDC) features a dedicated data channel of 64 kbps (F1 byte) between two nodes 
in an ONS 15454 network. Each AIC-I card provides two user data channels, UDC-A and UDC-B, 
through separate RJ-11 connectors on the front of the AIC-I card. Each UDC can be routed to an 
individual optical interface in the ONS 15454. For instructions, see the “DLP-G110 Create a User Data 
Channel Circuit” task on page 7-19. 

The UDC ports are standard RJ-11 receptacles. Table 15-13 lists the UDC pin assignments.

Table 15-12 Orderwire Pin Assignments

RJ-11 Pin Number Description

1 Four-wire receive ring

2 Four-wire transmit tip

3 Two-wire ring

4 Two-wire tip

5 Four-wire transmit ring

6 Four-wire receive tip

61
07

7

Pin 1 Pin 6

RJ-11

Table 15-13 UDC Pin Assignments

RJ-11 Pin Number Description

1 For future use

2 TXN

3 RXN

4 RXP
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15.2.4.6 Data Communications Channel

The DCC features a dedicated data channel of 576 kbps (D4 to D12 bytes) between two nodes in an 
ONS 15454 network. Each AIC-I card provides two data communications channels, DCC-A and 
DCC-B, through separate RJ-45 connectors on the front of the AIC-I card. Each DCC can be routed to 
an individual optical interface in the ONS 15454. For instructions, see the “DLP-G110 Create a User 
Data Channel Circuit” task on page 7-19.

The DCC ports are standard RJ-45 receptacles. Table 15-14 lists the DCC pin assignments. 

15.3 Front Mount Electrical Connections
This section describes the MIC-A/P and MIC-C/T/P FMECs, which provide power, external alarm, and 
timing connections for the ONS 15454 ETSI shelf.

15.3.1 MIC-A/P FMEC
The MIC-A/P FMEC provides connection for the BATTERY B input, one of the two possible redundant 
power supply inputs. It also provides connection for eight alarm outputs (coming from the TCC2/TCC2P 
card), sixteen alarm inputs, and four configurable alarm inputs/outputs. Its position is in Slot 23 in the 
center of the subrack Electrical Facility Connection Assembly (EFCA) area. 

The MIC-A/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for eight alarm outputs (coming from the TCC2/TCC2P card)

• Connection for four configurable alarm inputs/outputs 

• Connection for sixteen alarm inputs 

5 TXP

6 For future use

Table 15-13 UDC Pin Assignments (continued)

RJ-11 Pin Number Description

Table 15-14 DCC Pin Assignments

RJ-45 Pin Number Description

1 TCLKP

2 TCLKN

3 TXP

4 TXN

5 RCLKP

6 RCLKN

7 RXP

8 RXN
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• Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the 
ONS 15454 ETSI shelf. Figure 15-5 shows the MIC-A/P faceplate. 

Figure 15-5 MIC-A/P Faceplate 

Figure 15-6 shows a block diagram of the MIC-A/P.

Figure 15-6 MIC-A/P Block Diagram

Table 15-15 shows the alarm interface pinouts on the MIC-A/P DB-62 connector. 
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Table 15-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector

Pin No. Signal Name Signal Description

1 ALMCUTOFF N Alarm cutoff, normally open ACO pair

2 ALMCUTOFF P Alarm cutoff, normally open ACO pair

3 ALMINP0 N Alarm input pair 1, reports closure on connected wires

4 ALMINP0 P Alarm input pair 1, reports closure on connected wires

5 ALMINP1 N Alarm input pair 2, reports closure on connected wires

6 ALMINP1 P Alarm input pair 2, reports closure on connected wires

7 ALMINP2 N Alarm input pair 3, reports closure on connected wires
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8 ALMINP2 P Alarm input pair 3, reports closure on connected wires

9 ALMINP3 N Alarm input pair 4, reports closure on connected wires

10 ALMINP3 P Alarm input pair 4, reports closure on connected wires

11 EXALM0 N External customer alarm 1

12 EXALM0 P External customer alarm 1

13 GND Ground

14 EXALM1 N External customer alarm 2

15 EXALM1 P External customer alarm 2

16 EXALM2 N External customer alarm 3

17 EXALM2 P External customer alarm 3

18 EXALM3 N External customer alarm 4

19 EXALM3 P External customer alarm 4

20 EXALM4 N External customer alarm 5

21 EXALM4 P External customer alarm 5

22 EXALM5 N External customer alarm 6

23 EXALM5 P External customer alarm 6

24 EXALM6 N External customer alarm 7

25 EXALM6 P External customer alarm 7

26 GND Ground

27 EXALM7 N External customer alarm 8

28 EXALM7 P External customer alarm 8

29 EXALM8 N External customer alarm 9

30 EXALM8 P External customer alarm 9

31 EXALM9 N External customer alarm 10

32 EXALM9 P External customer alarm 10

33 EXALM10 N External customer alarm 11

34 EXALM10 P External customer alarm 11

35 EXALM11 N External customer alarm 12

36 EXALM11 P External customer alarm 12

37 ALMOUP0 N Normally open output pair 1

38 ALMOUP0 P Normally open output pair 1

39 GND Ground

40 ALMOUP1 N Normally open output pair 2

41 ALMOUP1 P Normally open output pair 2

42 ALMOUP2 N Normally open output pair 3

43 ALMOUP2 P Normally open output pair 3

Table 15-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description
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15.3.2 MIC-C/T/P FMEC 
The MIC-C/T/P FMEC provides connection for the BATTERY A input, one of the two possible 
redundant power supply inputs. It also provides connection for system management serial port, system 
management LAN port, modem port (for future use), and system timing inputs and outputs. Install the 
MIC-C/T/P in Slot 24. 

The MIC-C/T/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for two serial ports for local craft/modem (for future use)

• Connection for one LAN port

• Connection for two system timing inputs

• Connection for two system timing outputs

• Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the shelf.

Figure 15-7 shows the MIC-C/T/P FMEC faceplate. 

44 ALMOUP3 N Normally open output pair 4

45 ALMOUP3 P Normally open output pair 4

46 AUDALM0 N Normally open Minor audible alarm

47 AUDALM0 P Normally open Minor audible alarm

48 AUDALM1 N Normally open Major audible alarm

49 AUDALM1 P Normally open Major audible alarm

50 AUDALM2 N Normally open Critical audible alarm

51 AUDALM2 P Normally open Critical audible alarm

52 GND Ground

53 AUDALM3 N Normally open Remote audible alarm

54 AUDALM3 P Normally open Remote audible alarm

55 VISALM0 N Normally open Minor visual alarm

56 VISALM0 P Normally open Minor visual alarm

57 VISALM1 N Normally open Major visual alarm

58 VISALM1 P Normally open Major visual alarm

59 VISALM2 N Normally open Critical visual alarm

60 VISALM2 P Normally open Critical visual alarm

61 VISALM3 N Normally open Remote visual alarm

62 VISALM3 P Normally open Remote visual alarm

Table 15-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description
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Figure 15-7 MIC-C/T/P Faceplate 

Figure 15-8 shows a block diagram of the MIC-C/T/P.

Figure 15-8 MIC-C/T/P Block Diagram

The MIC-C/T/P FMEC has one pair of LEDs located on the RJ45 LAN connector. The green LED is on 
when a link is present, and the amber LED is on when data is being transferred. 

15.4 Optical Service Channel Cards
This section describes the optical service channel cards. An optical service channel (OSC) is a 
bidirectional channel connecting two adjacent nodes in a DWDM ring. For every DWDM node (except 
terminal nodes), two different OSC terminations are present, one for the West side and another for the 
East side. The channel transports OSC overhead that is used to manage ONS 15454 DWDM networks. 
An OSC signal uses the 1510-nm wavelength and does not affect client traffic. The primary purpose of 
this channel is to carry clock synchronization and orderwire channel communications for the DWDM 
network. It also provides transparent links between each node in the network. The OSC is an 
OC-3/STM-1 formatted signal. 

There are two versions of the OSC modules: the OSCM, and the OSC-CSM, which contains the OSC 
wavelength combiner and separator component in addition to the OSC module.
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15.4.1 OSCM Card
The OSCM card is used in amplified nodes that include the OPT-BST or OPT-BST-E booster amplifier. 
The OPT-BST and OPT-BST-E include the required OSC wavelength combiner and separator 
component. The OSCM cannot be used in nodes where you use OC-N/STM-N cards, electrical cards, or 
cross-connect cards. The OSCM uses Slots 8 and 10, which are also cross-connect card slots. 

The OSCM supports the following features:

• OC-3/STM-1 formatted OSC

• Supervisory data channel (SDC) forwarded to the TCC2/TCC2P cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT far-end (FE) UDC

• Monitoring functions such as orderwire support and optical safety

The OC-3/STM-1 section data communications channel (SDCC) overhead bytes are used for network 
communications. An optical transceiver terminates the OC-3/STM-1, then it is regenerated and 
converted into an electrical signal. The SDCC bytes are forwarded to the active and standby 
TCC2/TCC2P cards for processing via the system communication link (SCL) bus on the backplane. 
Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the TCC2/TCC2P for forwarding to 
the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UDC. The frame is sent to a 
packet-over-SONET/SDH (POS) processing block that extracts the Ethernet packets and makes them 
available at the RJ-45 connector.

The OSCM distributes the reference clock information by removing it from the incoming OC-3/STM-1 
signal and then sending it to the DWDM cards. The DWDM cards then forward the clock information to 
the active and standby TCC2/TCC2P cards.
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Figure 15-9 shows the OSCM faceplate.

Figure 15-9 OSCM Card Faceplate 

Figure 15-10 shows a block diagram of the OSCM card.
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Figure 15-10 OSCM Block Diagram

Figure 15-11 shows the block diagram of the variable optical attenuator (VOA) within the OSCM.

Figure 15-11 OSCM VOA Optical Module Functional Block Diagram

15.4.1.1 Power Monitoring

Physical photodiode P1 monitors the power for the OSCM card. The returned power level value is 
calibrated to the OSC TX port (Table 15-16).
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Table 15-16 OSCM VOA Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Output OSC OSC TX
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15.4.1.2 OSCM Card-Level Indicators

The OSCM card has three card-level LED indicators, described in Table 15-17.

15.4.1.3 OSCM Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OSCM has one OC-3/STM-1 optical port located on the faceplate. One 
long-reach OSC transmits and receives the OSC to and from another DWDM node. Both data 
communications network (DCN) data and FE payload are carried on this link.

15.4.2 OSC-CSM Card
The OSC-CSM card is used in unamplified nodes. This means that the booster amplifier with the OSC 
wavelength combiner and separator is not required for OSC-CSM operation. The OSC-CSM can be 
installed in Slots 1 to 6 and 12 to 17. To operate in hybrid mode, the OSC-CSM cards must be 
accompanied by cross-connect cards. The cross-connect cards enable functionality on the OC-N/STM-N 
cards and electrical cards.

The OSC-CSM supports the following features:

• Optical combiner and separator module for multiplexing and demultiplexing the optical service 
channel to or from the wavelength division multiplexing (WDM) signal

• OC-3/STM-1 formatted OSC

• SDC forwarded to the TCC2/TCC2P cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT FE UDC

• Monitoring functions such as orderwire support

• Optical safety: Signal loss detection and alarming, fast transmitted power shut down by means of an 
optical 1x1 switch

• Optical safety remote interlock (OSRI), a feature capable of shutting down the optical output power

• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut

Table 15-17 OSCM Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OSCM is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as loss of 
signal (LOS), loss of frame alignment (LOF), line alarm indication signal 
(AIS-L), or high BER on one or more of the card’s ports. The amber signal 
fail (SF) LED also illuminates when the transmit and receive fibers are 
incorrectly connected. When the fibers are properly connected, the light 
turns off.
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The WDM signal coming from the line is passed through the OSC combiner and separator, where the 
OSC signal is extracted from the WDM signal. The WDM signal is sent along with the remaining 
channels to the COM port (label on the front panel) for routing to the OADM or amplifier units, while 
the OSC signal is sent to an optical transceiver.

The OSC is an OC-3/STM-1 formatted signal. The OC-3/STM-1 SDCC overhead bytes are used for 
network communications. An optical transceiver terminates the OC-3/STM-1, and then it is regenerated 
and converted into an electrical signal. The SDCC bytes are forwarded to the active and standby 
TCC2/TCC2P cards for processing via the SCL bus on the backplane. Orderwire bytes (E1, E2, F1) are 
also forwarded via the SCL bus to the TCC2/TCC2P for forwarding to the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UDC. The frame is sent to a 
POS processing block that extracts the Ethernet packets and makes them available at the RJ-45 front 
panel connector.

The OSC-CSM distributes the reference clock information by removing it from the incoming 
OC-3/STM-1 signal and then sending it to the active and standby TCC2/TCC2P cards. The clock 
distribution is different from the OSCM card because the OSC-CSM does not use Slot 8 or 10 
(cross-connect card slots). 

Note S1 and S2 (Figure 15-14 on page 15-33) are optical splitters with a splitter ratio of 2:98. The result is 
that the power at the MON TX port is about 17 dB lower than the relevant power at the COM RX port, 
and the power at the MON RX port is about 20 dB lower than the power at the COM TX port. The 
difference is due to the presence of a tap coupler for the P1 photodiode.
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Figure 15-12 shows the OSC-CSM faceplate.

Figure 15-12 OSC-CSM Faceplate 

Figure 15-13 shows a block diagram of the OSC-CSM card.
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Figure 15-13 OSC-CSM Block Diagram
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Figure 15-14 shows the OSC-CSM optical module functional block diagram.

Figure 15-14 OSC-CSM Optical Module Functional Block Diagram

15.4.2.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P5 monitor the power for the OSC-CSM card. Their function is as 
follows:

• P1 and P2: The returned power value is calibrated to the LINE RX port, including the insertion loss 
of the previous filter (the reading of this power dynamic range has been brought backward towards 
the LINE RX output).

• P3: The returned value is calibrated to the COM RX port.

• P5: The returned value is calibrated to the LINE TX port, including the insertion loss of the 
subsequent filter.

The returned power level values are calibrated to the ports as shown in Table 15-18.
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15.4.2.2 OSC-CSM Card-Level Indicators

The OSC-CSM card has three card-level LED indicators, described in Table 15-19.

15.4.2.3 OSC-CSM Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OSC-CSM has a OC3 port and three other sets of ports located on the 
faceplate.

15.5 Optical Amplifier Cards
This section describes the optical amplifier cards. Optical amplifiers are used in amplified nodes, such 
as hub nodes, amplified OADM nodes, and line amplifier nodes. There are three forms of amplifiers, the 
Optical Preamplifier (OPT-PRE), the Optical Booster (OPT-BST) amplifier, and the Optical Booster 
Enhanced (OPT-BST-E) amplifier. The optical amplifier card architecture includes an optical plug-in 
module with a controller that manages optical power, laser current, and temperature control loops. The 
amplifier also manages communication with the TCC2/TCC2P card, and operations, administration, 
maintenance, and provisioning (OAM&P) functions such as provisioning, controls, and alarms. 

Optical amplifiers have a linear power feature that enables them to be kept in the constant gain mode if 
the gain is less than 28 dB. However, for longer span solutions it is necessary to place the amplifier in 
constant power mode. In constant power mode, automatic power control (APC) requirements change. 
This is because span loss degradation does not affect the system and amplifiers are not able to 
automatically modify the output power for variations in the number of channels when provisioning 
changes and a failure occurs. 

Table 15-18 OSC-CSM Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Out Com LINE RX

P2 Input OSC LINE RX

P3 In Com COM RX

P5 Output Osc LINE TX

Table 15-19 OSC-CSM Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OSC-CSM is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
AIS-L, or high BER on one or more of the card’s ports. The amber SF LED 
also illuminates when the transmit and receive fibers are incorrectly 
connected. When the fibers are properly connected, the light turns off.
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15.5.1 OPT-PRE Amplifier
This section describes the OPT-PRE amplifier card. The OPT-PRE is designed to support 64 channels at 
50-GHz channel spacing, but is currently limited to 32 channels at 100 GHz. The OPT-PRE is a C-band 
DWDM, two-stage erbium-doped fiber amplifier (EDFA) with mid-amplifier loss (MAL) for allocation 
to a DCU. To control the gain tilt, the OPT-PRE is equipped with a built-in VOA. The VOA can also be 
used to pad the DCU to a reference value. You can install the OPT-PRE in Slots 1 to 6 and 12 to 17. 

The OPT-PRE features:

• Fixed gain mode with programmable tilt

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• MAL for fiber-based DCU

• Amplified spontaneous emissions (ASE) compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Four signal photodiodes to monitor the input and output optical power of the two amplifier stages 
through CTC

• An optical output port for external monitoring

Note The optical splitter has a ratio of 1:99. The result is that the power at the MON port is about 20 dB lower 
than the power at the COM TX port.
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Figure 15-15 shows the OPT-PRE amplifier faceplate.

Figure 15-15 OPT-PRE Faceplate 

Figure 15-16 shows a block diagram of the OPT-PRE card.
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Figure 15-16 OPT-PRE Block Diagram

Figure 15-17 shows the OPT-PRE optical module functional block diagram.

Figure 15-17 OPT-PRE Optical Module Functional Block Diagram

15.5.1.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-PRE card. The returned power 
level values are calibrated to the ports as shown in Table 15-20.
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Table 15-20 OPT-PRE Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Input Com COM RX

P2 Output DC DC TX

P3 Input DC DC RX

P4 Output COM (Total Output) COM TX

Output COM (Signal Output)
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15.5.1.2 OPT-PRE Amplifier Card-Level Indicators

The OPT-PRE amplifier has three card-level LED indicators, described in Table 15-21.

15.5.1.3 OPT-PRE Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OPT-PRE amplifier has five optical ports located on the faceplate. MON is 
the output monitor port. COM RX (receive) is the input signal port. COM TX (transmit) is the output 
signal port. DC Rx is the MAL input signal port. DC Tx is the MAL output signal port.

15.5.2 OPT-BST Amplifier Card
This section describes the OPT-BST amplifier card. The OPT-BST gain range is 5 to 20 dB in constant 
gain mode and output power mode. The OPT-BST is designed to support 64 channels at 50-GHz channel 
spacing, but currently is limited to 32 channels at 100 GHz. The OPT-BST is a C-band DWDM EDFA 
with OSC add-and-drop capability. When an ONS 15454 has an OPT-BST installed, it is only necessary 
to have the OSCM to process the OSC. You can install the OPT-BST in Slots 1 to 6 and 12 to 17. To 
control the gain tilt, the OPT-BST is equipped with a built-in VOA. 

The OPT-BST features include:

• Fixed gain mode (with programmable tilt)

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• OSRI, which is a software feature capable (through CTC) of shutting down the optical output power 
or reducing the power to a safe level (automatic power reduction)

• ALS, which is a safety mechanism used in the event of a fiber cut

Table 15-21 OPT-PRE Amplifier Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OPT-PRE is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS on 
one or more of the card’s ports. The amber SF LED also illuminates when 
the transmit and receive fibers are incorrectly connected. When the fibers are 
properly connected, the light turns off.
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Note The optical splitters each have a ratio of 1:99. The result is that the power at the MON TX and MON RX 
ports is about 20 dB lower than the power at the COM TX and COM RX ports.

Figure 15-18 shows the OPT-BST amplifier faceplate.

Figure 15-18 OPT-BST Faceplate 

Figure 15-19 shows a block diagram of the OPT-BST card.
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Figure 15-19 OPT-BST Block Diagram

Figure 15-20 shows the OPT-BST optical module functional block diagram.

Figure 15-20 OPT-BST Optical Module Functional Block Diagram

15.5.2.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST card. The returned power 
level values are calibrated to the ports as shown in Table 15-22.
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Table 15-22 OPT-BST Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Input Com COM RX

P2 Output Line (Total Output) LINE TX

Output Line (Signal Output)

P3 Output COM LINE RX

P4 Output OSC
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15.5.2.2 OPT-BST Amplifier Card-Level Indicators

The OPT-BST amplifier has three card-level LED indicators, described in Table 15-23.

15.5.2.3 OPT-BST Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OPT-BST amplifier has eight optical ports located on the faceplate. 
MON RX is the output monitor port (receive section). MON TX is the output monitor port. COM RX is 
the input signal port. LINE TX is the output signal port. LINE RX is the input signal port (receive 
section). COM TX is the output signal port (receive section). OSC RX is the OSC add input port. 
OSC TX is the OSC drop output port.

15.5.3 OPT-BST-E Amplifier Card
This section describes the OPT-BST-E amplifier card. The OPT-BST-E gain range is 8 to 23 dBm with 
the tilt managed at 0 dBm in constant gain mode and output power mode. However, an extended gain 
range of 23 to 26 dBm is available with the tilt unmanaged. See Appendix B, “Hardware Specifications” 
for detailed specification information. The OPT-BST-E is designed to support 64 channels at 50-GHz 
channel spacing, but currently is limited to 32 channels at 100 GHz. The OPT-BST-E is a C-band DWDM 
EDFA with OSC add-and-drop capability. When an ONS 15454 has an OPT-BST-E installed, it is only 
necessary to have the OSCM to process the OSC. You can install the OPT-BST-E in Slots 1 to 6 and 
12 to 17. To control the gain tilt, the OPT-BST-E is equipped with a built-in VOA. 

The OPT-BST-E features include:

• Fixed gain mode (with programmable tilt)

• True variable gain

• Extended gain (with unmanaged tilt)

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

Table 15-23 OPT-BST Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OPT-BST is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS on 
one or more of the card’s ports. The amber SF LED also illuminates when 
the transmit and receive fibers are incorrectly connected. When the fibers are 
properly connected, the light turns off.
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• Full monitoring and alarm handling with settable thresholds

• OSRI, which is a software feature capable (through CTC) of shutting down the optical output power 
or reducing the power to a safe level (automatic power reduction)

• ALS, which is a safety mechanism used in the event of a fiber cut

Note The optical splitters each have a ratio of 1:99. The result is that the power at the MON TX and MON RX 
ports is about 20 dB lower than the power at the COM TX and COM RX ports.
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Figure 15-21 shows the OPT-BST-E amplifier faceplate.

Figure 15-21 OPT-BST-E Faceplate 

Figure 15-22 shows a block diagram of the OPT-BST-E card.
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Figure 15-22 OPT-BST-E Block Diagram

Figure 15-23 shows the OPT-BST-E optical module functional block diagram.

Figure 15-23 OPT-BST-E Optical Module Functional Block Diagram

15.5.3.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST-E card. The returned power 
level values are calibrated to the ports as shown in Table 15-24.
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Table 15-24 OPT-BST-E Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Input Com COM RX

P2 Output Line (Total Output) LINE TX

Output Line (Signal Output)

P3 Output COM LINE RX

P4 Output OSC
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15.5.3.2 OPT-BST-E Amplifier Card-Level Indicators

The OPT-BST-E amplifier has three card-level LED indicators, described in Table 15-25.

15.5.3.3 OPT-BST-E Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OPT-BST-E amplifier has eight optical ports located on the faceplate. 
MON RX is the output monitor port (receive section). MON TX is the output monitor port. COM RX is 
the input signal port. LINE TX is the output signal port. LINE RX is the input signal port (receive 
section). COM TX is the output signal port (receive section). OSC RX is the OSC add input port. 
OSC TX is the OSC drop output port.

15.6 Multiplexer and Demultiplexer Cards
This section describes the multiplexer and demultiplexer cards.

15.6.1 32MUX-O Card
The 32-Channel Multiplexer (32MUX-O) card multiplexes 32 100-GHz-spaced channels identified in 
the channel plan. The 32MUX-O card takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16. 

The 32MUX-O features include:

• Arrayed waveguide grating (AWG) device that enables full multiplexing functions for the channels.

• Each single-channel port is equipped with VOAs for automatic optical power regulation prior to 
multiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for 
safety purposes. A manual VOA setting is also available.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

An additional optical monitoring port with 1:99 splitting ratio is available.

Figure 15-24 shows the 32MUX-O faceplate.

Table 15-25 OPT-BST-E Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OPT-BST-E is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS on 
one or more of the card’s ports. The amber SF LED also illuminates when 
the transmit and receive fibers are incorrectly connected. When the fibers are 
properly connected, the light turns off.
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Figure 15-24 32MUX-O Faceplate 

Figure 15-25 shows a block diagram of the 32MUX-O card. 
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Figure 15-25 32MUX-O Block Diagram

The 32MUX-O has four receive connectors that accept multifiber push-on (MPO) cables, which break 
out into eight separate cables, on its front panel for the client input interfaces. The 32MUX-O also has 
two LC-PC-II optical connectors, one for the main output and the other for the monitor port.

Figure 15-26 shows the 32MUX-O optical module functional block diagram.

Figure 15-26 32MUX-O Optical Module Functional Block Diagram

15.6.1.1 Channel Plan

The 32MUX-O is typically used in hub nodes and provides the multiplexing of 32 channels, spaced at 
100 GHz, into one fiber before their amplification and transmission along the line. The channel plan is 
shown in Table 15-26.
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Table 15-26 32MUX-O Channel Plan

Channel Number1

1. The Channel Number column is only for reference purposes. The channel ID is consistent with 
ONS 15454 and will be used in unit identification.

Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61
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15.6.1.2 Power Monitoring

Physical photodiodes P1 through P32 monitor the power for the 32MUX-O card. The returned power 
level values are calibrated to the ports as shown in Table 15-27.

15.6.1.3 32MUX-O Card-Level Indicators

The 32MUX-O card has three card-level LED indicators, described in Table 15-28.

15.6.1.4 32MUX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 32MUX-O card has five sets of ports located on the faceplate. 

COM Tx is the line output. MON is the optical monitoring port. The xx.x-yy.y RX ports represent the 
four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel 
plan.

15.6.2 32DMX-O Card
The 32-Channel Demultiplexer (32DMX-O) card demultiplexes 32 100-GHz-spaced channels identified 
in the channel plan. The 32DMX-O takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16.

The 32DMX-O features include:

• AWG that enables channel demultiplexing functions.

• Each single-channel port is equipped with VOAs for automatic optical power regulation after 
demultiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation 
for safety purposes. A manual VOA setting is also available. 

Table 15-27 32MUX-O Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 ADD COM TX

Table 15-28 32MUX-O Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32MUX-O is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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• The 32DXM-O has four physical receive connectors that accept multifiber push-on (MPO) cables, 
which break out into eight separate cables, on its front panel for the client input interfaces. 

Note In contrast, the single-slot 32DMX card does not have VOAs on each drop port for optical power 
regulation. The 32DMX optical demultiplexer module is used in conjunction with the 
32-Channel Wavelength Selective Switch (32WSS) card in ONS 15454 Multiservice Transport 
Platform (MSTP) nodes.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

Figure 15-27 shows the 32DMX-O card faceplate.

Figure 15-27 32DMX-O Faceplate 

Figure 15-28 shows a block diagram of the 32DMX-O card.
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Figure 15-28 32DMX-O Block Diagram

Figure 15-29 shows the 32DMX-O optical module functional block diagram.

Figure 15-29 32DMX-O Optical Module Functional Block Diagram

15.6.2.1 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX-O card. The returned 
power level values are calibrated to the ports as shown in Table 15-29.
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Table 15-29 32DMX-O Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 DROP DROP TX

P33 INPUT COM COM RX
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15.6.2.2 32DMX-O Card-Level Indicators

The 32DMX-O card has three card-level LED indicators, described in Table 15-30.

15.6.2.3 32DMX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 32DMX-O card has five sets of ports located on the faceplate. MON is the 
output monitor port. COM RX is the line input. The xx.x-yy.y Tx ports represent the four groups of eight 
channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

15.6.3 32DMX Card
The 32-Channel Demultiplexer card (32DMX) is a single-slot optical demultiplexer. The card receives 
an aggregate optical signal on its COM RX port and demultiplexes it into to 32 100-GHz-spaced 
channels. The 32DMX card can be installed in Slots 1 to 6 and in Slots 12 to 17. 

The 32DMX includes these high-level features:

• COM RX port: COM RX is the input port for the aggregate optical signal being demultiplexed. This 
port is supported by both a VOA for optical power regulation and a photodiode for optical power 
monitoring.

• DROP ports (1 to 32): On its output, the 32DMX provides 32 drop ports that are typically used for 
dropping channels within the ROADM node. Each drop port has a photodiode for optical power 
monitoring. Unlike the two-slot 32DMX-O demultiplexer, the drop ports on the 32DMX do not have 
a VOA per channel for optical power regulation.

• A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east 
or west side of the shelf.

Figure 15-30 shows the 32DMX card front panel and the basic traffic flow through the ports.

Table 15-30 32DMX-O Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32DMX-O is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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Figure 15-30 32DMX Faceplate and Ports

The 32DMX front panel has connectors for 32 DROP TX ports. These ports are connected using four 
8-fiber multifiber push-on (MPO) ribbon connectors. The incoming optical signal to the demultiplexer 
comes into the COM RX. This input port is connected using a single LC duplex optical connector.

A block diagram of the 32DMX card is shown in Figure 15-31.
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Figure 15-31 32DMX Block Diagram

Figure 15-32 shows the 32DMX optical module functional block diagram.

Figure 15-32 32DMX Optical Module Functional Block Diagram
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element with ROADM functionality. ROADM functionality requires two 32DMX single-slot cards and 
two 32WSS double-slot cards (six slots in the ONS 15454 chassis). 

Equipped with ROADM functionality, ONS 15454 MSTP nodes can be configured at the optical channel 
level using CTC, Cisco MetroPlanner, and Cisco Transport Manager (CTM). Both the 32DMX card and 
32WSS card utilize planar lightwave circuit (PLC) technology to perform wavelength-level processing.
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15.6.3.2 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX card. The returned 
power level values are calibrated to the ports as shown in Table 15-31.

15.6.3.3 32DMX Card-Level Indicators

Table 15-32 describes the three card-level LED indicators on the 32DMX card.

15.6.3.4 32DMX Port-Level Indicators

You can find the status of the 32DMX ports using the LCD screen on the ONS 15454 fan-tray assembly. 
Use the LCD to view the status of any port or card slot; the screen displays the number and severity of 
alarms for a given port or slot. 

The 32DMX card has five ports located on the faceplate. The port labeled COM RX is the line input (it 
typically receives DROP TX from the 32WSS module). The TX ports are 32 drop ports. The connectors 
provide four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the 
channel plan.

15.6.4 4MD-xx.x Card
The 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) card multiplexes and demultiplexes four 
100-GHz-spaced channels identified in the channel plan. The 4MD-xx.x card is designed to be used with 
band OADMs (both AD-1B-xx.x and AD-4B-xx.x). 

The card is bidirectional. The demultiplexer and multiplexer functions are implemented in two different 
sections of the same card. In this way, the same card can manage signals flowing in opposite directions.

There are eight versions of this card that correspond with the eight sub-bands specified in Table 15-33. 
The 4MD-xx.x can be installed in Slots 1 to 6 and 12 to 17.

Table 15-31 32DMX Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 DROP DROP TX

P33 INPUT COM COM RX

Table 15-32 32DMX Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32DMX card is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
15-55
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 15      Card Reference
Multiplexer and Demultiplexer Cards
The 4MD-xx.x has the following features implemented inside a plug-in optical module:

• Passive cascade of interferential filters perform the channel multiplex/demultiplex function.

• Software-controlled VOAs at every port of the multiplex section regulate the optical power of each 
multiplexed channel.

• Software-monitored photodiodes at the input and output multiplexer and demultiplexer ports for 
power control and safety purposes.

• Software-monitored “virtual photodiodes” at the common DWDM output and input ports. A “virtual 
photodiode” is a firmware calculation of the optical power at that port. This calculation is based on 
the single channel photodiode reading and insertion losses of the appropriated paths.

Figure 15-33 shows the 4MD-xx.x faceplate.

Figure 15-33 4MD-xx.x Faceplate 
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Figure 15-34 shows a block diagram of the 4MD-xx.x card.

Figure 15-34 4MD-xx.x Block Diagram

Figure 15-35 shows the 4MD-xx.x optical module functional block diagram.

Figure 15-35 4MD-xx.x Optical Module Functional Block Diagram
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VOAs are present in every input path of the multiplex section in order to regulate the optical power of 
each multiplexed channel. Some optical input and output ports are monitored by means of photodiodes 
implemented both for power control and for safety purposes. An internal control manages VOA settings 
and functionality as well as photodiode detection and alarm thresholds. The power at the main output 
and input ports is monitored through the use of virtual photodiodes. A virtual photodiode is implemented 
in the firmware of the plug-in module. This firmware calculates the power on a port, summing the 
measured values from all single channel ports (and applying the proper path insertion loss) and then 
providing the TCC2/TCC2P card with the obtained value. 

15.6.4.1 Wavelength Pairs

Table 15-33 shows the band IDs and the add/drop channel IDs for the 4MD-xx.x card.

15.6.4.2 Power Monitoring

Physical photodiodes P1 through P8 and virtual photodiodes V1 and V2 monitor the power for the 
4MD-xx.x card. The returned power level values are calibrated to the ports as shown in Table 15-34.

15.6.4.3 4MD-xx.x Card-Level Indicators

The 4MD-xx.x card has three card-level LED indicators, described in Table 15-35.

Table 15-33 4MD-xx.x Channel Sets

Band ID Add/Drop Channel IDs

Band 30.3 (A) 30.3, 31.2, 31.9, 32.6

Band 34.2 (B) 34.2, 35.0, 35.8, 36.6

Band 38.1 (C) 38.1, 38.9, 39.7, 40.5

Band 42.1 (D) 42.1, 42.9, 43.7, 44.5

Band 46.1 (E) 46.1, 46.9, 47.7, 48.5

Band 50.1 (F) 50.1, 50.9, 51.7, 52.5

Band 54.1 (G) 54.1, 54.9, 55.7, 56.5

Band 58.1 (H) 58.1, 58.9, 59.7, 60.6

Table 15-34 4MD-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

V1 OUT COM COM TX

V2 IN COM COM RX
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15.6.4.4 4MD-xx.x Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 4MD-xx.x card has five sets of ports located on the faceplate. COM RX is 
the line input. COM TX is the line output. The 15xx.x TX ports represent demultiplexed channel 
outputs 1 to 4. The 15xx.x RX ports represent multiplexed channel inputs 1 to 4.

15.7 Optical Add/Drop Multiplexer Cards
This section discusses the optical add/drop multiplexer cards.

15.7.1 AD-1C-xx.x Card
The 1-Channel OADM (AD-1C-xx.x) card passively adds or drops one of the 32 channels utilized within 
the 100-GHz-spacing of the DWDM card system. Thirty-two versions of this card—each designed only 
for use with one wavelength—are used in the ONS 15454 DWDM system. Each wavelength version of 
the card has a different part number. The AD-1C-xx.x can be installed in Slots 1 to 6 and 12 to 17.

The AD-1C-xx.x has the following internal features:

• Two cascaded passive optical interferential filters perform the channel add and drop functions.

• One software-controlled VOA regulates the optical power of the inserted channel.

• Software-controlled VOA regulates the insertion loss of the express optical path.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculations of port optical power) at the 
common DWDM output and input ports.

Figure 15-36 shows the AD-1C-xx.x faceplate.

Table 15-35 4MD-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 4MD-xx.x card is carrying traffic or 
is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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Figure 15-36 AD-1C-xx.x Faceplate 

Figure 15-37 shows a block diagram of the AD-1C-xx.x card.
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Figure 15-37 AD-1C-xx.x Block Diagram

Figure 15-38 shows the AD-1C-xx.x optical module functional block diagram.

Figure 15-38 AD-1C-xx.x Optical Module Functional Block Diagram

15.7.1.1 Power Monitoring

Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2 monitor the power for the 
AD-1C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 15-36
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Table 15-36 AD-1C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 ADD COM TX

P2 DROP DROP TX

P3 IN EXP EXP RX
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15.7.1.2 AD-1C-xx.x Card-Level Indicators

The AD-1C-xx.x card has three card-level LED indicators, described in Table 15-37.

15.7.1.3 AD-1C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-1C-xx.x has six LC-PC-II optical ports: two for add/drop channel client 
input and output, two for express channel input and output, and two for communication.

15.7.2 AD-2C-xx.x Card
The 2-Channel OADM (AD-2C-xx.x) card passively adds or drops two adjacent 100-GHz channels 
within the same band. Sixteen versions of this card—each designed for use with one pair of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. Each version of the 
card has a different part number.

The AD-2C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

• Two software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Software-controlled VOAs regulate insertion loss on express channels.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common 
DWDM output and input ports. 

Figure 15-39 shows the AD-2C-xx.x faceplate.

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 15-36 AD-1C-xx.x Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port

Table 15-37 AD-1C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-1C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The SF LED also illuminates 
when the transmitting and receiving fibers are incorrectly connected. When 
the fibers are properly connected, the LED turns off.
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Figure 15-39 AD-2C-xx.x Faceplate 

Figure 15-40 shows a block diagram of the AD-2C-xx.x card. 
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Figure 15-40 AD-2C-xx.x Block Diagram

Figure 15-41 shows the AD-2C-xx.x optical module functional block diagram.

Figure 15-41 AD-2C-xx.x Optical Module Functional Block Diagram

15.7.2.1 Wavelength Pairs

The AD-2C-xx.x cards are provisioned for the wavelength pairs in Table 15-38. In this table, channel 
IDs are given rather than wavelengths. To compare channel IDs with the actual wavelengths they 
represent, see Table 15-6 on page 15-9.
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15.7.2.2 Power Monitoring

Physical photodiodes P1 through P10, and virtual photodiodes V1 and V2 monitor the power for the 
AD-2C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 15-39.

15.7.2.3 AD-2C-xx.x Card-Level Indicators

The AD-2C-xx.x card has three card-level LED indicators, described in Table 15-40.

Table 15-38 AD-2C-xx.x Channel Pairs

Band ID Add/Drop Channel ID

Band 30.3 (A) 30.3, 31.2

31.9, 32.6

Band 34.2 (B) 34.2, 35.0

35.8, 36.6

Band 38.1 (C) 38.1, 38.9

39.7, 40.5

Band 42.1 (D) 42.1, 42.9

43.7, 44.5

Band 46.1 (E) 46.1, 46.9

47.7, 48.5

Band 50.1 (F) 50.1, 50.9

51.7, 52.5

Band 54.1 (G) 54.1, 54.9

55.7, 56.5

Band 58.1 (H) 58.1, 58.9

59.7, 60.6

Table 15-39 AD-2C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX
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15.7.2.4 AD-2C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-2C-xx.x card has eight LC-PC-II optical ports: four for add/drop channel 
client input and output, two for express channel input and output, and two for communication.

15.7.3 AD-4C-xx.x Card
The 4-Channel OADM (AD-4C-xx.x) card passively adds or drops all four 100-GHz-spaced channels 
within the same band. Eight versions of this card—each designed for use with one band of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. There are eight versions 
of this card with eight part numbers. 

The AD-4C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

• Four software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Two software-controlled VOAs regulate insertion loss on express and drop path, respectively.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common 
DWDM output and input ports.

Figure 15-42 shows the AD-4C-xx.x faceplate.

Table 15-40 AD-2C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-2C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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Figure 15-42 AD-4C-xx.x Faceplate 

Figure 15-43 shows a block diagram of the AD-4C-xx.x card.
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Figure 15-43 AD-4C-xx.x Block Diagram

Figure 15-44 shows the AD-4C-xx.x optical module functional block diagram.

Figure 15-44 AD-4C-xx.x Optical Module Functional Block Diagram

15.7.3.1 Wavelength Pairs

The AD-4C-xx.x cards are provisioned for the wavelength pairs in Table 15-41 on page 15-69. In this 
table, channel IDs are given rather than wavelengths. To compare channel IDs with the actual 
wavelengths they represent, see Table 15-6 on page 15-9.
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15.7.3.2 Power Monitoring

Physical photodiodes P1 through P10, and virtual photodiodes V1 and V2 monitor the power for the 
AD-4C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 15-42.

15.7.3.3 AD-4C-xx.x Card-Level Indicators

The AD-4C-xx.x card has three card-level LED indicators, described in Table 15-43.

Table 15-41 AD-4C-xx.x Channel Sets

Band ID Add/Drop Channel IDs

Band 30.3 (A) 30.3, 31.2, 31.9, 32.6

Band 34.2 (B) 34.2, 35.0, 35.8, 36.6

Band 38.1 (C) 38.1, 38.9, 39.7 40.5

Band 42.1 (D) 42.1, 42.9, 43.7, 44.5

Band 46.1 (E) 46.1, 46.9, 47.7, 48.5

Band 50.1 (F) 50.1, 50.9, 51.7, 52.5

Band 54.1 (G) 54.1, 54.9, 55.7, 56.5

Band 58.1 (H) 58.1, 58.9, 59.7, 60.6

Table 15-42 AD-4C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 15-43 AD-4C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-4C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition. The amber SF 
LED also illuminates when the transmit and receive fibers are incorrectly 
connected. When the fibers are properly connected, the light turns off.
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15.7.3.4 AD-4C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-4C-xx.x card has 12 LC-PC-II optical ports: eight for add/drop channel 
client input and output, two for express channel input and output, and two for communication.

15.7.4 AD-1B-xx.x Card
The 1-Band OADM (AD-1B-xx.x) card passively adds or drops a single band of four adjacent 
100-GHz-spaced channels. Eight versions of this card with eight different part numbers—each version 
designed for use with one band of wavelengths—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other.

The AD-1B xx.x can be installed in Slots 1 to 6 and 12 to17 and has the following features:

• Passive cascaded interferential filters perform the channel add and drop functions.

• Two software-controlled VOAs regulate the optical power flowing in the express and drop OADM 
paths (drop section). 

• Output power of the dropped band is set by changing the attenuation of the VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiode (firmware calculation of port optical power) at the common 
DWDM output. 

Figure 15-45 shows the AD-1B-xx.x faceplate.
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Figure 15-45 AD-1B-xx.x Faceplate 

Figure 15-46 shows a block diagram of the AD-1B-xx.x card. 
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Figure 15-46 AD-1B-xx.x Block Diagram

Figure 15-47 shows the AD-1B-xx.x optical module functional block diagram.

Figure 15-47 AD-1B-xx.x Optical Module Functional Block Diagram

15.7.4.1 Power Monitoring

Physical photodiodes P1 through P4, and virtual photodiodes V1 and V2 monitor the power for the 
AD-1B-xx.x card. The returned power level values are calibrated to the ports as shown in Table 15-44.
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Table 15-44 AD-1B-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 ADD BAND RX

P2 DROP BAND TX

P3 IN EXP EXP RX
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15.7.4.2 AD-1B-xx.x Card-Level Indicators

The AD-1B-xx.x card has three card-level LED indicators, described in Table 15-45.

15.7.4.3 AD-1B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-1B-xx.x has six LC-PC-II optical ports: two for add/drop channel client 
input and output, two for express channel input and output, and two for communication.

15.7.5 AD-4B-xx.x Card
The 4-Band OADM (AD-4B-xx.x) card passively adds or drops four bands of four adjacent 
100-GHz-spaced channels. Two versions of this card with different part numbers—each version 
designed for use with one set of bands—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other. 

The AD1B-xx.x can be installed in Slots 1 to 6 and 12 to 17 and has the following features:

• Five software-controlled VOAs regulate the optical power flowing in the OADM paths. 

• Output power of each dropped band is set by changing the attenuation of each VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiode (firmware calculation of port optical power) at the common 
DWDM output port.

Figure 15-48 shows the AD-4B-xx.x faceplate.

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 15-44 AD-1B-xx.x Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port

Table 15-45 AD-1B-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-1B-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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Figure 15-48 AD-4B-xx.x Faceplate 

Figure 15-49 shows a block diagram of the 4D-4B-xx.x card.
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Figure 15-49 AD-4B-xx.x Block Diagram

Figure 15-50 shows the AD-4B-xx.x optical module functional block diagram.

Figure 15-50 AD-4B-xx.x Optical Module Functional Block Diagram

15.7.5.1 Power Monitoring

Physical photodiodes P1 through P11, and virtual photodiode V1 monitor the power for the AD-4B-xx.x 
card. The returned power level values are calibrated to the ports as shown in Table 15-46.
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15.7.5.2 AD-4B-xx.x Card-Level Indicators

The AD-4B-xx.x card has three card-level LED indicators, described in Table 15-47.

15.7.5.3 AD-4B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-4B-xx.x has 12 LC-PC-II optical ports: eight for add/drop band client 
input and output, two for express channel input and output, and two for communication.

15.7.6 32WSS Card
The 32-Channel Wavelength Selective Switch (32WSS) card performs channel add/drop processing 
within the ONS 15454 DWDM node. The 32WSS works in conjunction with the 32DMX to implement 
ROADM functionality. Equipped with ROADM functionality, the ONS 15454 DWDM can be configured 
to add or drop individual optical channels using CTC, Cisco MetroPlanner, and CTM.

An ROADM network element utilizes two 32WSS cards (two slots each) and two 32DMX cards (one 
slot each), for a total of six slots in the chassis. For a diagram of a typical ROADM configuration, see 
the “16.1.4 ROADM Node” section on page 16-8. The 32WSS card can be installed in Slots 1 and 2, 3 
and 4, 5 and 6, 12 and 13, 14 and 15, or 16 and 17. 

Table 15-46 AD-4B-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

P11 IN COM COM RX

V1 OUT COM COM TX

Table 15-47 AD-4B-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-4B-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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The 32WSS has six types of ports: 

• ADD RX ports (1 to 32): These ports are used for adding channels. Each add channel is associated 
with an individual switch element that selects whether an individual channel is added. Each add port 
has optical power regulation provided by a VOA. The 32WSS has four physical receive connectors 
that accept multifiber push-on (MPO) cables, which break out into eight separate cables, on its front 
panel for the client input interfaces. 

• EXP RX port: The EXP RX port receives an optical signal from another 32WSS module in the same 
network element.

• EXP TX port: The EXP TX port sends an optical signal to the other 32WSS module within the 
network element.

• COM TX port: The COM TX port sends an aggregate optical signal to a booster amplifier card (for 
example, OPT-BST) for transmission outside of the network element.

• COM RX port: The COM RX port receives the optical signal from a preamplifier and sends it to the 
optical splitter.

• DROP TX port: The DROP TX port sends the split off optical signal that contains drop channels to 
the 32DMX card where the channels are further processed and dropped. 

A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or 
west side of the shelf.

Figure 15-51 shows the 32WSS module front panel and identifies the traffic flow through the ports. 
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Figure 15-51 32WSS Faceplate and Ports

Figure 15-52 provides a high-level functional block diagram of the 32WSS card.
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Figure 15-52 32WSS Block Diagram

Aggregate optical signals that enter the EXP RX and COM RX port are processed in two ways. The 
optical processing stages are shown in Figure 15-53, which provides a detailed optical functional 
diagram of the 32WSS card.
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Figure 15-53 32WSS Optical Block Diagram

The EX PORT and COM PORT operate as follows:

• EXP RX Port Add Channel/Pass-through Processing

The incoming optical signal is received at the EXP RX port from the other 32WSS module within 
the network element. The incoming aggregate optical signal is demultiplexed into 32 individual 
wavelength components, or channels. Then each channel is individually processed by the optical 
switch, which does add/pass-through processing. Under software control, the switch either selects 
the optical channel coming in from the demultiplexer (the pass-through channel) or it selects the 
external ADD channel. If the ADD port channel is selected, the optical signal coming from the 
demultiplexer is blocked, and the ADD channel is transmitted in its place.

After the optical switch stage, all of the channels are multiplexed together into an aggregate optical 
signal, which is sent out on the COM TX port. The output is typically connected to an OPT-BST or 
OPT-BST-E (in the event a booster amplifier is needed) or to an OSC-CSM (if no amplification is 
needed).

• COM RX Port Optical Splitter Processing

The incoming optical signal received at the COM RX port and is applied to the optical splitter within 
the 32WSS. Channels that are designated to be dropped are diverted optically to the DROP TX port 
by the splitter. The DROP TX port on the 32WSS is typically connected to the COM RX port of the 
32DMX where the drop channels are dropped. Channels that are not dropped pass through the 
optical splitter and flow out of the EXP TX port of the 32WSS. This optical signal is typically 
connected to the other 32WSS module within the network element.
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15.7.6.1 Power Monitoring

Physical photodiodes P1 through P69 monitor the power for the 32WSS card. The returned power level 
values are calibrated to the ports as shown in Table 15-48.

15.7.6.2 32WSS Card-Level Indicators

Table 15-49 describes the three card-level LED indicators on the 32WSS card.

15.7.6.3 32WSS Port-Level Indicators

You can find the status of the 32WSS card’s ports using the LCD screen on the ONS 15454 fan-tray 
assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and 
severity of alarms for a given port or slot. The 32WSS card has five sets of ports located on the faceplate. 
COM RX is the line input, COM TX is the line output, EXP RX is the port where a channel can be added 
or passed through, EXP TX is the port that passes through the channels that are not dropped, and 
DROP TX is the port for the dropped channels. The xx.x-yy.y TX ports represent the four groups of eight 
channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

Table 15-48 32WSS Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 ADD (Power) COM TX

ADD (Power ADD) ADD RX

P33–P64 PASS THROUGH COM TX

P65 OUT EXP EXP TX

P66 IN EXP EXP RX

P67 OUT COM COM TX

P68 IN COM COM RX

P69 DROP DROP TX

Table 15-49 32WSS Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32WSS card is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
15-81
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 15      Card Reference
Transponder and Muxponder Cards
15.8 Transponder and Muxponder Cards
This section describes the transponder (TXP) and muxponder (MXP) cards. See the “NTP-G32 Install 
the Transponder and Muxponder Cards” procedure on page 3-31 as needed. Detailed specifications for 
the cards are found in Appendix B, “Hardware Specifications.”

TXP and MXP cards detect SF, LOS, or LOF conditions on the optical facility. Refer to the Cisco ONS 
15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for a description of 
these conditions. The cards also count section and line BIP errors from B1 and B2 byte registers in the 
section and line overhead.

15.8.1 TXP_MR_10G Card
The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx card (TXP_MR_10G) processes one 
10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side). It provides one 
10-Gbps port per card that can be provisioned for an STM-64/OC-192 short reach (1310-nm) signal, 
compliant with ITU-T G.707, G.709, ITU-T G.691, and Telcordia GR-253-CORE, or a 10GBASE-LR 
signal compliant with IEEE 802.3. 

The TXP_MR_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage 
of 32 different wavelengths in the 1550-nm range. 

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The trunk port operates at 9.95328 Gbps (or 10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC) 
and at 10.3125 Gbps (or 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified 
distances up to 80 km (50 miles) with different types of fiber such as C-SMF or dispersion compensated 
fiber limited by loss and/or dispersion.

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_10G 
card does not display circuits under card view. 

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

You can install TXP_MR_10G cards in Slots 1 to 6 and 12 to 17 and provision this card in a linear 
configuration. TXP_MR_10G cards cannot be provisioned as a BLSR/MS-SPRing, a path 
protection/SNCP, or a regenerator. They can only be used in the middle of BLSR/MS-SPRing and 
1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10G port features a 1550-nm laser for the trunk port and a 1310-nm laser for the for the 
client port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

Figure 15-54 shows the TXP_MR_10G faceplate and block diagram.
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Figure 15-54 TXP_MR_10G Faceplate and Block Diagram

15.8.1.1 Y-Cable Protection

Two TXP_MR_10G cards can be joined in a Y-cable protection group. In Y-cable protection, the client 
ports of the two cards are joined by Y-cables. A single incoming receive (Rx) client signal is injected 
into the Rx Y-cable port and is split between the two TXP_MR_10G cards (connected to the Rx client 
ports) in the protection group. The transmit (Tx) client signals from the two protection group 
TXP_MR_10G cards are connected to the correspondent ports of the Tx Y-cable. Only the Tx client port 
of the active TXP_MR_10G card is turned on and transmits the signal toward the receiving client 
equipment. See the “15.9 Transponder and Muxponder Protection” section on page 15-114 for more 
information.

Note If you create a GCC on either card of the protection group, the trunk (span) port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

15.8.1.2 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G217 Change Line Settings for TXP_MR_10G and 
TXP_MR_10E Cards” section on page 5-10.
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15.8.1.3 TXP_MR_10G Card-Level Indicators

Table 15-50 lists the three card-level LEDs on the TXP_MR_10G card.

15.8.1.4 TXP_MR_10G Port-Level Indicators

Table 15-51 lists the four port-level LEDs in the TXP_MR_10G card. 

15.8.2 TXP_MR_10E Card 
The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_10E) card is a multirate 
transponder for the ONS 15454 platform. The card is fully backward compatible with the TXP_MR_10G 
card. It processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk 
side) that is tunable over four wavelength channels (spaced at 100 GHz on the ITU grid) in the C-band 
and tunable over eight wavelength channels (spaced at 50 GHz on the ITU grid) in the L-band. There are 
eight versions of the C-band card, with each version covering four wavelengths, for a total coverage of 
32 wavelengths. There are five versions of the L-band card, with each version covering eight 
wavelengths, for a total coverage of 40 wavelengths.

Table 15-50 TXP_MR_10G Card-Level Indicators 

Card-Level LED Description

FAIL LED (Red) Red indicates that the card’s processor is not ready. This LED is on during 
reset. The FAIL LED flashes during the boot process. Replace the card if the 
red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

Green indicates that the card is operational (one or both ports active) and 
ready to carry traffic. 

Amber indicates that the card is operational and in standby (protect) mode.

SF LED (Amber) Amber indicates a signal failure or condition such as LOS, LOF, or high 
BERs on one or more of the card’s ports. The amber SF LED is also 
illuminated if the transmit and receive fibers are incorrectly connected. If the 
fibers are properly connected and the link is working, the LED turns off.

Table 15-51 TXP_MR_10G Port-Level Indicators 

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green Wavelength 1 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 1. 

Green Wavelength 2 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 2.
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You can install TXP_MR_10E cards in Slots 1 to 6 and 12 to 17 and provision the cards in a linear 
configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The card can be used in the 
middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10E card features a 1550-nm tunable laser (C-band) or a 1580-nm tunable laser (L-band) 
for the trunk port and a separately orderable ONS-XC-10G-S1 1310-nm laser XFP module for the client 
port. On its faceplate, the TXP_MR_10E card contains two transmit and receive connector pairs, one for 
the trunk port and one for the client port. Each connector pair is labeled.

15.8.2.1 Key Features 

The key features of the TXP_MR_10E card are:

• A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately)

– OC-192 (SR1) 

– 10GE (10GBASE-LR)

– 10G-FC (1200-SM-LL-L)

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping

15.8.2.2 Faceplate and Block Diagram

Figure 15-55 shows the TXP_MR_10E faceplate and block diagram.

Figure 15-55 TXP_MR_10E Faceplate and Block Diagram
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Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

15.8.2.3 Client Interface

The client interface is implemented with a separately orderable XFP module. The module is a tri-rate 
transceiver, providing a single port that can be configured in the field to support an OC-192 SR-1 
(Telcordia GR-253-CORE) or STM-64 I-64.1 (ITU-T G.691) optical interface, as well as 10GE LAN 
PHY (10GBASE-LR), 10GE WAN PHY (10GBASE-LW), or 10G FC signals.

The client side XFP pluggable module supports LC connectors and is equipped with a 1310-nm laser.

15.8.2.4 DWDM Trunk Interface

On the trunk side, the TXP_MR_10E card provides a 10-Gbps STM-64/OC-192 interface. There are four 
tunable channels available in the 1550-nm band or eight tunable channels available in the 1580-nm band 
on the 50-GHz ITU grid for the DWDM interface. The TXP_MR_10E card provides 3R transponder 
functionality for this 10-Gbps trunk interface. Therefore, the card is suited for use in long-range 
amplified systems. The DWDM interface is complaint with ITU-T G.707, ITU-T G.709, and Telcordia 
GR-253-CORE standards.

The DWDM trunk port operates at a rate that is dependent on the input signal and the presence or absence 
of the ITU-T G.709 Digital Wrapper/FEC. The possible trunk rates are:

• OC192 (9.95328 Gbps)

• OTU2 (10.70923 Gbps)

• 10GE (10.3125 Gbps) or 10GE into OTU2 (nonstandard 11.0957 Gbps)

• 10G FC (10.51875 Gbps) or 10G FC into OTU2 (nonstandard 11.31764 Gbps).

The maximum system reach in filterless applications without the use of optical amplification or 
regenerators is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but 
is given for informational purposes. It is subject to change.

15.8.2.5 Y-Cable Protection

The TXP_MR_10E card supports Y-cable protection, which provides transponder equipment protection 
without client terminal equipment interface protection. A single client interface can be split between two 
transponder cards using a Y-protection device. 

With Y-cable protection, two TXP_MR_10E transponder cards can be joined in a Y-cable protection 
group. In Y-cable protection, the client ports of the two cards are joined by Y cables. An incoming client 
signal is injected into the Rx Y-cable port and is split between the two TXP_MR_10E cards (connected 
to Rx client ports) in the protection group. The Tx client signals from the two protection group 
TXP_MR_10E cards are connected to the correspondent ports of the Tx Y cable. Only the Tx client port 
of the active TXP_MR_10E card is turned on and transmits the signal towards the receiving client 
equipment. See the “15.9.1 Y-Cable Protection” section on page 15-114 for more details.
15-86
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 15      Card Reference
Transponder and Muxponder Cards
Note If you create a GCC using a digital wrapper and apply it to either card of the Y-cable protect group, the 
DWDM trunk (span) port stays permanently active, regardless of the switch’s state. When you provision 
a GCC, you are provisioning unprotected overhead (OH) bytes. The GCC is not protected by the 
protection group. 

15.8.2.6 Enhanced FEC (E-FEC) Feature

A key feature of the TXP_MR_10E is the availability to configure the forward error correction in three 
modes: NO FEC, FEC, and E-FEC. The output bit rate is always 10.7092 Gbps as defined in 
ITU-T G.709, but the error coding performance can be provisioned as follows:

• NO FEC—No forward error correction

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• E-FEC—Standard ITU-T G.975.1 algorithm, which is a super FEC code.

15.8.2.7 FEC and E-FEC Modes

As client side traffic passes through the TXP_MR_10E card, it can be digitally wrapped using FEC 
mode, E-FEC mode, or no error correction at all. The FEC mode setting provides a lower level of error 
detection and correction than the E-FEC mode setting of the card. As a result, using E-FEC mode allows 
higher sensitivity (lower OSNR) with a lower bit error rate than FEC mode. E-FEC enables longer 
distance trunk-side transmission than with FEC. 

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be 
turned on, or E-FEC can be turned on to provide greater range and lower BER. The default mode is FEC 
on and E-FEC off. E-FEC is provisioned using CTC.

Caution Because the transponder has no visibility into the data payload and detect circuits, the TXP_MR_10E 
card does not display circuits under the card view. 

15.8.2.8 Client-to-Trunk Mapping

The TXP_MR_10E card can perform ODU2-to-OCh mapping, which allows operators to provision data 
payloads in a standard way across 10-Gbps optical links. 

Digital wrappers that define client side interfaces are called Optical Data Channel Unit 2 (ODU2) 
entities in ITU-T G.709. Digital wrappers that define trunk side interfaces are called Optical Channels 
(OCh) in ITU-T G.709. ODU2 digital wrappers can include Generalized Multiprotocol Label Switching 
(G-MPLS) signaling extensions to ITU-T G.709 (such as Least Significant Part [LSP] and Generalized 
Payload Identifier [G-PID] values) to define client interfaces and payload protocols.

15.8.2.9 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G217 Change Line Settings for TXP_MR_10G and 
TXP_MR_10E Cards” section on page 5-10.
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15.8.2.10 TXP_MR_10E Card-Level Indicators

Table 15-52 lists the three card-level LEDs on the TXP_MR_10E card.

15.8.2.11 TXP_MR_10E Port-Level Indicators

Table 15-53 lists the two port-level LEDs in the TXP_MR_10E card. 

15.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
The 2.5-Gbps Multirate Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_2.5G) card processes 
one 8-Mbps to 2.488-Gbps signal (client side) into one 8-Mbps to 2.5-Gbps, 100-GHz DWDM signal 
(trunk side). It provides one long-reach STM-16/OC-48 port per card, compliant with ITU-T G.707, 
ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE. 

The 2.5-Gbps Multirate Transponder–Protected–100-GHz–Tunable xx.xx-xx.xx (TXPP_MR_2.5G) 
card processes one 8-Mbps to 2.488-Gbps signal (client side) into two 8-Mbps to 2.5-Gbps, 100-GHz 
DWDM signals (trunk side). It provides two long-reach STM-16/OC-48 ports per card, compliant with 
ITU-T G.707, ITU-T G.957, and Telcordia GR-253-CORE.

The TXP_MR_2.5G and TXPP_MR_2.5G cards are tunable over four wavelengths in the 1550-nm, 
ITU 100-GHz range. They are available in eight versions, each of which covers four wavelengths, for a 
total coverage of 32 different wavelengths in the 1550-nm range. 

Table 15-52 TXP_MR_10E Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or both ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 15-53 TXP_MR_10E Port-Level Indicators

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.
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Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it, and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The trunk/line port operates at up to 2.488 Gbps (or up to 2.66 Gbps with ITU-T G.709 Digital 
Wrapper/FEC) over unamplified distances up to 360 km (223.7 miles) with different types of fiber such 
as C-SMF or higher if dispersion compensation is used. 

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_2.5G 
or TXPP_MR_2.5G card does not display circuits under card view. 

The TXP_MR_2.5G and TXPP_MR_2.5G cards support 2R and 3R modes of operation where the client 
signal is mapped into a ITU-T G.709 frame. The mapping function is simply done by placing a digital 
wrapper around the client signal. Only OC-48/STM-16 client signals are fully ITU-T G.709 compliant, 
and the output bit rate depends on the input client signal. Table 15-54 shows the possible combinations 
of client interfaces, input bit rates, 2R and 3R modes, and ITU-T G.709 monitoring.

The output bit rate is calculated for the trunk bit rate by using the 255/238 ratio as specified in 
ITU-T G.709 for OTU1. Table 15-55 lists the calculated trunk bit rates for the client interfaces with 
ITU-T G.709 enabled.

Table 15-54 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

Client Interface Input Bit Rate 3R vs. 2R ITU-T G.709

OC-48/STM-16 2.488 Gbps 3R On or Off

DV-6000 2.38 Gbps 2R —

2 Gigabit Fibre Channel (2G-FC)/fiber connection 
(FICON)

2.125 Gbps 3R1

1. No monitoring

On or Off

High-Definition Television (HDTV) 1.48 Gbps 2R —

Gigabit Ethernet (GE) 1.25 Gbps 3R On or Off

1 Gigabit Fibre Channel (1G-FC)/FICON 1.06 Gbps 3R On or Off

OC-12/STM-4 622 Mbps 3R On or Off

OC-3/STM-1 155 Mbps 3R On or Off

Enterprise System Connection (ESCON) 200 Mbps 2R —

SDI/D1 video 270 Mbps 2R —

ISC-1 Compact 1.06 Gbps 3R Off

ISC-3 1.06 or 
2.125 Gbps

2R —

ETR_CLO 16 Mbps 2R —
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For 2R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to pass data 
through transparently from client side interfaces to a trunk side interface, which resides on an ITU grid. 
The data might vary at any bit rate from 200-Mbps up to 2.38-Gbps, including ESCON and video signals. 
In this pass-through mode, no performance monitoring (PM) or digital wrapping of the incoming signal 
is provided, except for the usual PM outputs from the SFPs. Similarly, this card has the ability to pass 
data through transparently from the trunk side interfaces to the client side interfaces with bit rates 
varying from 200-Mbps up to 2.38-Gbps. Again, no performance monitoring or digital wrapping of 
received signals is available in this pass-through mode.

For 3R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards apply a digital wrapper to the 
incoming client interface signals (OC-N/STM-N, 1G-FC, 2G-FC, GE). Performance monitoring is 
available on all of these signals except for 2G-FC, and varies depending upon the type of signal. For 
client inputs other than OC-48/STM-16, a digital wrapper might be applied but the resulting signal is not 
ITU-T G.709 compliant. The card applies a digital wrapper that is scaled to the frequency of the input 
signal.

The TXP_MR_2.5G and TXPP_MR_2.5G card has the ability to take digitally wrapped signals in from 
the trunk interface, remove the digital wrapper, and send the unwrapped data through to the client 
interface. Performance monitoring of the ITU-T G.709 OH and SONET/SDH OH is implemented.

15.8.3.1 Faceplate

Figure 15-56 shows the TXP_MR_2.5G and TXPP_MR_2.5G faceplates. 

Table 15-55 Trunk Bit Rates With ITU-T G.709 Enabled

Client Interface ITU-T G.709 Disabled ITU-T G.709 Enabled

OC-48/STM-16 2.488 Gbps 2.66 Gbps

2G-FC 2.125 Gbps 2.27 Gbps

GE 1.25 Gbps 1.34 Gbps

1G-FC 1.06 Gbps 1.14 Gbps

OC-12/STM-3 622 Mbps 666.43 Mbps

OC-3/STM-1 155 Mbps 166.07 Mbps
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Figure 15-56 TXP_MR_2.5G and TXPP_MR_2.5G Faceplates

15.8.3.2 Block Diagram

Figure 15-57 shows a block diagram of the TXP_MR_2.5G and TXPP_MR_2.5G cards.
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Figure 15-57 TXP_MR_2.5G and TXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G and 
TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to 
the TXP_MR_2.5G and TXPP_MR_2.5G cards.

You can install TXP_MR_2.5G and TXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. You can 
provision this card in a linear configuration. TXP_MR_10G and TXPP_MR_2.5G cards cannot be 
provisioned as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the 
middle of BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination 
mode.

The TXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm laser for the 
client port. It contains two transmit and receive connector pairs (labeled) on the card faceplate. The card 
uses dual LC connectors for optical cable termination. 

The TXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm 
laser (depending on the SFP) for the client port and contains three transmit and receive connector pairs 
(labeled) on the card faceplate. The card uses dual LC connectors for optical cable termination.

15.8.3.3 Y-Cable Protection

For the TXP_MR_2.5G card, protection is done using Y-cable protection. In Y-cable protection, the 
client ports of two TXP_MR_2.5G cards can be joined by Y cables in a Y-cable protection group. A 
single incoming Rx client signal is injected into the Rx Y-cable port and is split between the two 
TXP_MR_2.5G cards (connected to the Rx client ports) in the protection group. The Tx client signals 
from the two protection group TXP_MR_2.5G cards are connected to the correspondent ports of the Tx 
Y-cable. Only the Tx client port of the active TXP_MR_2.5G card is turned on and transmits the signal 
towards the receiving client equipment. See the “15.9 Transponder and Muxponder Protection” section 
on page 15-114 for more information.
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Note If you create a GCC on either card of the protect group, the trunk (span) port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

15.8.3.4 Splitter Protection

For the TXPP_MR_2.5G card, protection is done using splitter protection. In splitter protection, the 
single client signal is injected into the client Rx port. It is then split into two separate signals on the two 
trunk Tx ports. The two signals are transmitted over diverse paths. The far-end TXPP_MR_2.5G card 
chooses one of the two trunk Rx port signals and injects it into the Tx client port. The TXPP_MR_2.5G 
card switches the selected trunk Rx port signal in case of failure. See the “15.9 Transponder and 
Muxponder Protection” section on page 15-114 for more details.

15.8.3.5 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G230 Change Line Settings for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards” section on page 5-42.

15.8.3.6 TXP_MR_2.5G and TXPP_MR_2.5G Safety Labels

The TXP_MR_2.5G and TXPP_MR_2.5G cards have several safety labels that provide laser radiation 
and electrical shock warnings. 

Figure 15-58 shows the laser radiation warning hazard level label. The faceplate of these cards are 
clearly labeled with warnings about the equipment radiation level. Personnel must understand all 
warning labels before working with these cards. The hazard level label warns the personnel against 
exposure to laser radiation of Class 1M limits calculated in accordance with IEC60825-1 Ed.1.2.

Figure 15-58 Laser Radiation Warning—Hazard Level Label

Figure 15-59 shows the laser source connector label. This label indicates a laser source at the optical 
connectors where it has been placed.
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Figure 15-59 Laser Radiation Warning—Laser Source Connector Label

Figure 15-60 shows the FDA compliance label. This label shows the statement of compliance to FDA 
standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure 15-60 FDA Compliance Statement Label

Figure 15-61 shows the electrical energy hazard label. This label alerts personnel to electrical hazards 
within the card. The potential of shock hazard exists when adjacent cards are removed during 
maintenance and touching exposed electrical circuitry on the card itself.

Figure 15-61 Electrical Energy Hazard Label

15.8.3.7 TXP_MR_2.5G and TXPP_MR_2.5G Card-Level Indicators

Table 15-56 lists the three card-level LEDs on the TXP_MR_2.5G and TXPP_MR_2.5G cards.
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15.8.3.8 TXP_MR_2.5G and TXPP_MR_2.5G Port-Level Indicators

Table 15-57 lists the four port-level LEDs on the TXP_MR_2.5G and TXPP_MR_2.5G cards.

15.8.4 MXP_2.5G_10G Card
The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10G) card 
multiplexes/demultiplexes four 2.5-Gbps signals (client side) into one 10-Gbps, 100-GHz DWDM signal 
(trunk side). It provides one extended long-range STM-64/OC-192 port per card on the trunk side 
(compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE) and four 
intermediate- or short-range OC-48/STM-16 ports per card on the client side. The port operates at 
9.95328 Gbps over unamplified distances up to 80 km (50 miles) with different types of fiber such as 
C-SMF or dispersion compensated fiber limited by loss and/or dispersion. 

Client ports on the MXP_2.5G_10G card are also interoperable with OC-1 (STS-1) fiber optic signals 
defined in Telcordia GR-253-CORE. An OC-1 signal is the equivalent of one DS-3 channel transmitted 
across optical fiber. OC-1 is primarily used for trunk interfaces to phone switches in the United States. 
There is no SDH equivalent for OC-1.

The MXP_2.5G_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage 
of 32 different wavelengths in the 1550-nm range. 

Table 15-56 TXP_MR_2.5G and TXPP_MR_2.5G Card-Level Indicators

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or both ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 15-57 TXP_MR_2.5G and TXPP_MR_2.5G Port-Level Indicators 

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green TX LED The green TX LED indicates that indicated the DWDM port is in service and 
that it is currently transmitting a recognized signal.

Green RX LED The green RX LED indicates that the indicated DWDM port is in service and 
that it is currently receiving a recognized signal.
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Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The port can also operate at 10.70923 Gbps in ITU-T G.709 Digital Wrapper/FEC mode. 

Caution Because the transponder has no capability to look into the payload and detect circuits, an 
MXP_2.5G_10G card does not display circuits under card view. 

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using 
direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

You can install MXP_2.5G_10G cards in Slots 1 to 6 and 12 to 17. 

Caution Do not install an MXP_2.5G_10G card in Slot 3 if you have installed a DS3/EC1-48 card in Slots 1or 2. 
Likewise, do not install an MXP_2.5G_10G card in Slot 17 if you have installed a DS3/EC1-48 card in 
Slots 15 or 16. If you do, the cards will interact and cause DS-3 bit errors.

You can provision this card in a linear configuration. MXP_2.5G_10G cards cannot be provisioned as a 
BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of 
BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The MXP_2.5G_10G port features a 1550-nm laser on the trunk port and four 1310-nm lasers on the 
client ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The 
card uses a dual LC connector on the trunk side and SFP connectors on the client side for optical cable 
termination.

Figure 15-62 shows the MXP_2.5G_10G faceplate.
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Figure 15-62 MXP_2.5G_10G Faceplate 

Figure 15-63 shows a block diagram of the MXP_2.5G_10G card.
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Figure 15-63 MXP_2.5G_10G Card Block Diagram

15.8.4.1 Y-Cable Protection

For the MXP_2.5G_10G card, protection is done using Y-cable protection. In Y-cable protection, the 
client ports of two MXP_2.5G_10G cards can be joined by Y cables in a Y-cable protection group. A 
single Rx client signal is injected into the Rx Y-cable and is split between the two MXP_2.5G_10G cards 
in the protection group. The Tx client signals from the two protection group MXP_2.5G_10G cards are 
connected via the TX Y cable with only the active card signal passing through as the single TX client 
signal. See the “15.9.1 Y-Cable Protection” section on page 15-114 for more details.

Note If you create a GCC on either card of the protect group, the trunk port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

15.8.4.2 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G223 Change Line Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards” section on page 5-28.

15.8.4.3 Timing Synchronization

The MXP_2.5G_10G card is synchronized to the TCC2/TCC2P clock during normal conditions and 
transmits the ITU-T G.709 frame using this clock. The TCC2/TCC2P card can operate from an external 
BITS clock, an internal Stratum 3 clock, or from clock recovered from one of the four valid client clocks. 
If clocks from both TCC2/TCC2P cards are not available, the MXP_2.5G_10G card switches 
automatically (with errors, not hitless) to an internal 19.44 MHz clock that does not meet SONET clock 
requirements. This will result in a clock alarm.
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15.8.4.4 MXP_2.5G_10G Card-Level Indicators

Table 15-58 describes the three card-level LEDs on the MXP_2.5G_10G card.

15.8.4.5 MXP_2.5G_10G Port-Level Indicators

Table 15-59 describes the four port-level LEDs on the MXP_2.5G_10G card. 

15.8.5 MXP_2.5G_10E Card 
The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10E) card is a 
DWDM muxponder for the ONS 15454 platform that supports full optical transparency on the client 
side. The card multiplexes four 2.5 Gbps client signals (4 x OC48/STM-16 SFP) into a single 10-Gbps 
DWDM optical signal on the trunk side. The MXP_2.5G_10E provides wavelength transmission service 
for the four incoming 2.5 Gbps client interfaces. The MXP_2.5G_10E muxponder passes all 
SONET/SDH overhead bytes transparently. 

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring.

Table 15-58 MXP_2.5G_10G Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or more ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 15-59 MXP_2.5G_10G Port-Level Indicators 

Port-Level LED Description

Green Client LED
(four LEDs)

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. The card has four client ports, and so has four 
Client LEDs. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green Wavelength 1 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the board is 
configured for Wavelength 1. 

Green Wavelength 2 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the board is 
configured for Wavelength 2.
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The MXP_2.5G_10E works with OTN devices defined in ITU-T G.709. The card supports ODU1 to 
OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH payload 
into a digitally wrapped envelope. See the “15.8.5.5 Multiplexing Function” section on page 15-102.

The MXP_2.5G_10E card is not compatible with the MXP_2.5G_10G card, which does not support full 
optical transparency. The faceplate designation of the card is “4x2.5G 10E MXP.”

You can install MXP_2.5G_10E cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear 
configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The card can be used 
in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination 
mode.

The MXP_2.5G_10E features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client 
ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses 
a dual LC connector on the trunk side and uses SFP modules on the client side for optical cable 
termination. The SFP pluggable modules are short reach (SR) or intermediate reach (IR) and support an 
LC fiber connector.

15.8.5.1 Key Features

The MXP_2.5G_10E card has the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals 
are mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and 
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the 
transmission range on these interfaces. The E-FEC functionality increases the correction capability 
of the transponder to improve performance, allowing operation at a lower OSNR compared to the 
standard RS (237,255) correction algorithm. A new BCH algorithm implemented in E-FEC allows 
recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_MP_10E card has modular interfaces. Two 
types of optics modules can be plugged into the card. These include an OC-48/STM 16 SR-1 
interface with a 7 km nominal range (for short range and intra-office applications) and an IR-1 
interface with a range up to 40 km. SR-1 is defined in Telcordia GR-253-CORE and in I-16 
(ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 (ITU-T G.957).

• High level provisioning support: The MXP_MP_10E card is initially provisioned using 
Cisco MetroPlanner software. Subsequently, the card can be monitored and provisioned using CTC 
software.

• Link monitoring and management: The MXP_MP_10E card uses standard OC-48 OH (overhead) 
bytes to monitor and manage incoming interfaces. The card passes the incoming SDH/SONET data 
stream and its overhead bytes transparently. 

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MP_10E normally synchronizes from the 
TCC2/TCC2P card. If for some reason, such as maintenance or upgrade activity, the TCC2/TCC2P 
is not available, the MXP_MP_10E automatically synchronizes to one of the input client interface 
clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if 
there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the 
card manages multiplex section alarm indication signal (MS-AIS) insertion.
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15.8.5.2 Faceplate

Figure 15-64 shows the MXP_2.5G_10E faceplate.

Figure 15-64 MXP_2.5G_10E Faceplate

Figure 15-65 shows a block diagram of the MXP_2.5G_10E card.
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Figure 15-65 MXP_2.5G_10E Block Diagram

15.8.5.3 Client Interfaces

The MXP_2.5G_10E provides four intermediate- or short-range OC-48/STM-16 ports per card on the 
client side. Both SR-1 or IR-1 optics can be supported and the ports use SFP connectors. The client 
interfaces use four wavelengths in the 1310-nm, ITU 100-MHz-spaced, channel grid. 

15.8.5.4 DWDM Interface

The MXP_MP_10E serves as an OTN multiplexer, transparently mapping four OC-48 channels 
asynchronously to ODU1 into one 10-Gbps trunk. The DWDM trunk is tunable for transmission over 
four wavelengths in the 1550-nm, ITU 100-GHz spaced channel grid.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MP_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_MP_10E card. Using direct 
fiber loopbacks causes irreparable damage to the MXP_MP_10E card.

15.8.5.5 Multiplexing Function

The muxponder is an integral part of the optically transparent ROADM network in which data payload 
channels and wavelengths are processed exclusively at the optical level without electrical to optical 
(E-O) conversion. The key function of MXP_MP_10E is to multiplex 4 OC-48/STM16 signals onto one 
ITU-T G.709 OTU2 optical signal (DWDM transmission). The multiplexing mechanism allows the 
signal to be terminated at a far-end node by another MXP_2.5G_10E card.

Optical transparency on the muxponder is configured using OTUx and ODUx OH bytes. The 
ITU-T G.709 specification defines OH byte formats that are used to configure, set, and monitor frame 
alignment, FEC mode, section monitoring, tandem connection monitoring, and optical transparency.
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The MXP_2.5G_10E card performs ODU to OTU multiplexing as defined in ITU-T G.709. The ODU is 
the framing structure and byte definition (ITU-T G.709 digital wrapper) used to define the data payload 
coming into one of the SONET/SDH client interfaces on MXP_2.5G_10E. The term ODU1 refers to an 
ODU that operates at 2.5-Gbps line rate. On the MXP_2.5G_10E, there are four client interfaces that can 
be defined using ODU1 framing structure and format by asserting a ITU-T G.709 digital wrapper. 

The output of the muxponder is a single 10-Gbps DWDM trunk interface defined using OTU2. It is 
within the OTU2 framing structure that FEC or E-FEC information is appended to enable error checking 
and correction.

15.8.5.6 Timing Synchronization

The MXP_2.5G_10E card is synchronized to the TCC2/TCC2P clock during normal conditions and 
transmits the ITU-T G.709 frame using this clock. No holdover function is implemented. If neither 
TCC2/TCC2P clock is available, the MXP_2.5G_10E switches automatically (hitless) to the first of the 
four valid client clocks with no time restriction as to how long it can run on this clock. The 
MXP_2.5G_10E continues to monitor the TCC2/TCC2P card. If a TCC2/TCC2P card is restored to 
working order, the MXP_2.5G_10E reverts to the normal working mode of running from the 
TCC2/TCC2P clock. If there is no valid TCC2/TCC2P clock and all of the client channels become 
invalid, the card waits (no valid frames processed) until one of the TCC2/TCC2P cards supplies a valid 
clock. In addition, the card is allowed to select the recovered clock from one active and valid client 
channel and supply that clock to the TCC2/TCC2P card.

15.8.5.7 Y-Cable Protection

The MXP_2.5G_10E card supports Y-cable protection. Two MXP_2.5G_10E cards can be joined in a 
Y-cable protection group with one card assigned as the working card and the other defined as the 
protection card. This protection mechanism provides redundant bidirectional paths. See the 
“15.9.1 Y-Cable Protection” section on page 15-114 for more detailed information.

The Y-protection mechanism is provisionable and can be set ON or OFF (OFF is the default mode). 
When a signal fault is detected (LOS, LOF, signal degrade [SD], or SF on the DWDM receiver port in 
the case of ITU-T G.709 mode) the protection mechanism software automatically switches between 
paths.

Note If you create a GCC on either card of the protect group, the trunk port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

15.8.5.8 Enhanced FEC (E-FEC) Capability

The MXP_2.5G_10E can configure the FEC in three modes: NO FEC, FEC, and E-FEC. The output bit 
rate is always 10.7092 Gbps as defined in ITU-T G.709, but the error coding performance can be 
provisioned as follows:

• NO FEC—No FEC

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• E-FEC—Standard ITU-T G.975.1, two orthogonally concatenated BCH super FEC code. This FEC 
scheme contains three parameterizations of the same scheme of two orthogonally interleaved block 
codes (BCH). The constructed code is decoded iteratively to achieve the expected performance.
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15.8.5.9 FEC and E-FEC Modes

As client side traffic passes through the MXP_2.5G_10E card, it can be digitally wrapped using FEC 
mode error correction or E-FEC mode error correction (or no error correction at all). The FEC mode 
setting provides a lower level of error detection and correction than the E-FEC mode setting of the card. 
As a result, using E-FEC mode allows higher sensitivity (lower OSNR) with a lower BER than FEC 
mode. E-FEC enables longer distance trunk-side transmission than with FEC. 

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be 
turned on, or E-FEC can be turned on to provide greater range and lower BER. The default mode is FEC 
on and E-FEC off. E-FEC is provisioned using CTC.

15.8.5.10 SONET/SDH Overhead Byte Processing

The card passes the incoming SONET/SDH data stream and its overhead bytes for the client signal 
transparently. The card can be provisioned to terminate regenerator section overhead. This is used to 
eliminate forwarding of unneeded layer overhead. It can help reduce the number of alarms and help 
isolate faults in the network.

15.8.5.11 Client Interface Monitoring

The following parameters are monitored on the MXP_2.5G_10E card:

• Laser bias current is measured as a PM parameter

• LOS is detected and signaled

• Rx and Tx power are monitored

The following parameters are monitored in real time mode (one second):

• Optical power transmitted (client)

• Optical power received (client)

In case of loss of communication (LOC) at the DWDM receiver or far-end LOS, the client interface 
behavior is configurable. AIS can be invoked or the client signal can be squelched.

15.8.5.12 Wavelength Identification

The card uses trunk lasers that are wave-locked, which allows the trunk transmitter to operate on the ITU 
grid effectively. Table 15-60 describes the required trunk transmit laser wavelengths. The laser is tunable 
over eight wavelengths at 50-GHz spacing or four at 100-GHz spacing.

Table 15-60 MXP_2.5G_10E Trunk Wavelengths

Band Wavelength (nm)

30.3 1530.33

30.3 1531.12

30.3 1531.90

30.3 1532.68

34.2 1534.25

34.2 1535.04
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15.8.5.13 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G223 Change Line Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards” section on page 5-28.

15.8.5.14 Jitter

For SONET and SDH signals, the MXP_2.5G_10E card complies to GR-253-CORE, ITU-T G.825, and 
ITU-T G.873 for jitter generation, jitter tolerance, and jitter transfer.

34.2 1535.82

34.2 1536.61

38.1 1538.19

38.1 1538.98

38.1 1539.77

38.1 1540.56

42.1 1542.14

42.1 1542.94

42.1 1543.73

42.1 1544.53

46.1 1546.12

46.1 1546.92

46.1 1547.72

46.1 1548.51

50.1 1550.12

50.1 1550.92

50.1 1551.72

50.1 1552.52

54.1 1554.13

54.1 1554.94

54.1 1555.75

54.1 1556.55

58.1 1558.17

58.1 1558.98

58.1 1559.79

58.1 1560.61

Table 15-60 MXP_2.5G_10E Trunk Wavelengths (continued)

Band Wavelength (nm)
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15.8.5.15 Lamp Test

The MXP_2.5G_10E card supports a lamp test function that is activated from the ONS 15454 front panel 
or through CTC to ensure that all LEDs are functional.

15.8.5.16 Onboard Traffic Generation

The MXP_2.5G_10E card provides internal traffic generation for testing purposes according to 
pseudo-random bit sequence (PRBS), SONET/SDH, or ITU-T G.709.

15.8.5.17 MXP_2.5G_10E Card-Level Indicators

Table 15-61 describes the three card-level LEDs on the MXP_2.5G_10E card.

15.8.5.18 MXP_2.5G_10E Port-Level Indicators

Table 15-62 describes the port-level LEDs on the MXP_2.5G_10E card. 

15.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards 
The 2.5-Gbps Multirate Muxponder-100 GHz-Tunable 15xx.xx-15yy.yy (MXP_MR_2.5G) card 
aggregates a mix and match of client Storage Area Network (SAN) service client inputs (GE, FICON, 
and Fibre Channel) into one 2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides one 
long-reach STM-16/OC-48 port per card and is compliant with Telcordia GR-253-CORE.

Table 15-61 MXP_2.5G_10E Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or more ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 15-62 MXP_2.5G_10E Port-Level Indicators 

Port-Level LED Description

Green Client LED
(four LEDs)

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. The card has four client ports, and so has four 
Client LEDs. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.
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The 2.5-Gbps Multirate Muxponder–Protected–100 GHz–Tunable 15xx.xx-15yy.yy (MXPP_MR_2.5G) 
card aggregates various client SAN service client inputs (GE, FICON, and Fibre Channel) into one 
2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides two long-reach STM-16/OC-48 
ports per card and is compliant with ITU-T G.957 and Telcordia GR-253-CORE.

Because the cards are tunable to one of four adjacent grid channels on a 100-GHz spacing, each card is 
available in eight versions, with 15xx.xx representing the first wavelength and 15yy.yy representing the 
last wavelength of the four available on the board. In total, 32 DWDM wavelengths are covered in 
accordance with the ITU-T 100-GHz grid standard, G.692, and Telcordia GR-2918-CORE, Issue 2. The 
card versions along with their corresponding wavelengths are shown in Table 15-63.

The muxponders are intended to be used in applications with long DWDM metro or regional 
unregenerated spans. Long transmission distances are achieved through the use of flat gain optical 
amplifiers. 

The client interface supports the following payload types: 

• GE

• 1G FC

• 2G FC

• 1G FICON

• 2G FICON

Note Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to 
a maximum limit of 2.5 Gbps. 

Table 15-64 shows the input data rate for each client interface, and the encapsulation method. The 
current version of the Transparent Generic Framing Procedure (GFP-T) G.7041 supports transparent 
mapping of 8B/10B block-coded protocols, including Gigabit Ethernet, Fibre Channel, and FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed SERDES is mapped to 
an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the high-speed 
serializer/deserializer (SERDES), the Port 1 signal is mapped into the first STS-24c channel and the Port 
2 signal into the second STS-24c channel. The two channels are then mapped into an OC-48 trunk 
channel.

Table 15-63 Card Versions

Card Version Frequency Channels at 100 GHz (0.8 nm) Spacing

1530.33–1532.68 1530.33 nm 1531.12 nm 1531.90 nm  1532.68 nm

1534.25–1536.61 1534.25 nm  1535.04 nm  1535.82 nm  1536.61 nm

1538.19–1540.56 1538.19 nm 1538.98 nm 1539.77 nm 1540.56 nm

1542.14–1544.53 1542.14 nm 1542.94 nm 1543.73 nm 1544.53 nm

1546.12–1548.51 1546.12 nm 1546.92 nm 1547.72 nm 1548.51 nm

1550.12–1552.52 1550.12 nm 1550.92 nm 1551.72 nm 1552.52 nm

1554.13–1556.55 1554.13 nm  1554.94 nm 1555.75 nm  1556.55 nm

1558.17–1560.61 1558.17 nm 1558.98 nm 1559.79 nm 1560.61 nm
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Table 15-65 shows some of the mix and match possibilities on the various client ports. The table is 
intended to show the full client payload configurations for the card.

For the MXP_MR_2.5G card, protection is done using Y-cable protection. Two MXP_MR_2.5G cards 
can be joined in a Y-cable protection group, which provides protection against failures both on the fiber 
and in the muxponders.

For the MXPP_MR_2.5G card, protection is done using splitter protection, which provides protection 
against failures due to fiber cuts or unacceptable signal degradation on the trunk side. See the 
“15.9 Transponder and Muxponder Protection” section on page 15-114 for more detailed information.

Note Switching is performed only if the protect line is error free.

GFP-T performance monitoring (GFP-T PM) is available via remote monitoring (RMON), and trunk PM 
is managed according to Telcordia GR-253-CORE and ITU G.783/826. Client PM is achieved through 
RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port 
indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to 
stop transmitting and wait for the receipt of a “ready” indication The MXP_MR_2.5G and 
MXPP_MR_2.5 cards support FC credit-based flow control with a buffer-to-buffer credit extension of 
up to 1600 km for 1G FC and up to 800 km for 2G FC. The feature can be enabled or disabled. 

You can install MXP_MR_2.5G and MXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. The 
TCC2/TCC2P card is the only other card required to be used with these muxponder cards. Cross-connect 
cards do not affect the operation of the muxponder cards.

Table 15-64 MXP_MR_2.5G and MXPP_MR_2.5G Client Interface Data Rates and Encapsulation

Client Interface Input Data Rate GFP-T G.7041 Encapsulation

GE 1.25 Gbps Yes

1G FC 1.06 Gbps Yes

2G FC 2.125 Gbps Yes

1G FICON 1.06 Gbps Yes

2G FICON 2.125 Gbps Yes

Table 15-65 Client Data Rates and Ports

Mode Port(s) Aggregate Data Rate

GE 1, 2 2.5 Gbps

1G FC 1, 2 2.125 Gbps

2G FC 1 2.125 Gbps

1G FICON 1, 2 2.125 Gbps

2G FICON 1 2.125 Gbps
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The MXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser 
(depending on the SFP) for the client ports. The card contains eight 12.5 degree downward tilt SFP 
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are 
labeled TX and RX on the faceplate. The trunk port is a dual-LC connector with a 45 degree downward 
angle.

The MXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm 
laser (depending on the SFP) for the client port. The card contains eight 12.5 degree downward tilt SFP 
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are 
labeled TX and RX on the faceplate. There are two trunk port connectors (one for working and one for 
protect). Each is a dual-LC connector with a 45-degree downward angle.

15.8.6.1 Faceplates

Figure 15-66 shows the MXP_MR_2.5G and MXPP_MR_2.5G faceplates. 
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Figure 15-66 MXP_MR_2.5G and MXPP_MR_2.5G Faceplates

15.8.6.2 Block Diagram

Figure 15-67 shows a block diagram of the MXP_MR_2.5G card. The card has eight SFP client 
interfaces. Ports 1 and 2 can be used for GE, FC, or FICON. Ports 3 through 8 are for future use. There 
are two SERDES blocks dedicated to the high-speed interfaces (GE, FC, and FICON) and two SERDES 
blocks for future interfaces. A field programmable gate array (FPGA) is provided to support different 
configurations for different modes of operation. This FPGA has a Universal Test and Operations 
Physical Interface for ATM (UTOPIA) interface. A transceiver add-drop multiplexer (TADM) chip 

MXP_MR_2.5G MXPP_MR_2.5G 12
40

77

MXP
MR
2.5G
15xx.xx

15xx.xx

FAIL

ACT/STBY

SF

MXPP
MR
2.5G
15xx.xx

15xx.xx

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

D
W

D
M

A
D

W
D

M
B

FAIL

ACT/STBY

SF

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

R
X

T
X

D
W

D
M

R
X

T
X

15-110
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 15      Card Reference
Transponder and Muxponder Cards
supports framing. Finally, the output signal is serialized and connected to the trunk front end with a 
direct modulation laser. The trunk receive signal is converted into an electrical signal with an avalanche 
photodiode (APD), is deserialized, and is then sent to the TADM framer and FPGA. 

The MXPP_MR_2.5G is the same, except a 50/50 splitter divides the power at the trunk interface. In the 
receive direction, there are two APDs, two SERDES blocks, and two TADM framers. This is necessary 
to monitor both the working and protect paths. A switch selects one of the two paths to connect to the 
client interface.

Figure 15-67 MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and 
MXPP_MR_2.5G cards in a loopback configuration on the trunk port. Do not use direct fiber loopbacks 
with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable 
damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

15.8.6.3 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is 
compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off 
pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS 
provisioning information, see the “DLP-G236 Change Client Line Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards” section on page 5-55.

15.8.6.4 MXP_MR_2.5G and MXPP_MR_2.5G Safety Labels

The MXP_MR_2.5G and MXPP_MR_2.5G cards have several safety labels that provide laser radiation 
and electrical shock warnings. 
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Figure 15-68 shows the laser radiation warning hazard level label. The faceplate of these cards are 
clearly labeled with warnings about the equipment radiation level. Personnel must understand all 
warning labels before working with these cards. The hazard level label warns the personnel against 
exposure to laser radiation of Class 1M limits calculated in accordance with IEC60825-1 Ed.1.2.

Figure 15-68 Laser Radiation Warning—Hazard Level Label

Figure 15-69 shows the laser source connector label. This label indicates a laser source at the optical 
connectors where it has been placed.

Figure 15-69 Laser Radiation Warning—Laser Source Connector Label

Figure 15-70 shows the FDA compliance label. This label shows the statement of compliance to FDA 
standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure 15-70 FDA Compliance Statement Label

Figure 15-71 shows the electrical energy hazard label. This label alerts personnel to electrical hazards 
within the card. The potential of shock hazard exists when adjacent cards are removed during 
maintenance and touching exposed electrical circuitry on the card itself.
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Figure 15-71 Electrical Energy Hazard Label

15.8.6.5 MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators

Table 15-66 lists the four card-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

15.8.6.6 MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators

Table 15-67 lists the eight port-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

65
54

1

Table 15-66 MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators

Card-Level LED Description

FAIL LED (Red) Red indicates that the card’s processor is not ready. This LED is on during 
reset. The FAIL LED flashes during the boot process. Replace the card if the 
red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

Green indicates that the card is operational (one or both ports active) and 
ready to carry traffic. 

Amber indicates that the card is operational and in standby (protect) mode.

SF LED (Amber) Amber indicates a signal failure or condition such as LOS, LOF, or high 
BERs on one or more of the card’s ports. The amber SF LED is also 
illuminated if the transmit and receive fibers are incorrectly connected. If the 
fibers are properly connected and the link is working, the LED turns off.

DWDM LED

Green (Active)

Amber (Protect Traffic)

Red (LOS)

Green indicates that the board is carrying traffic (active) on the interface. 

When the LED is amber, it indicates that the interface is carrying protect 
traffic in a splitter protection card (MXPP_MR_2.5G). 

A red LED indicates that the interface has detected an LOS or LOC.

Table 15-67 MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators

Port-Level LED Description

Client LEDs (eight LEDs) Green indicates that the port is carrying traffic (active) on the interface. 
Amber indicates that the port is carrying protect traffic (MXPP_MR_2.5G). 
Red indicates that the port has detected a loss of signal.
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15.9 Transponder and Muxponder Protection
Two types of protection are available:

• Y-cable protection

• Splitter protection

15.9.1 Y-Cable Protection
Y-cable protection is available for the following ONS 15454 transponder and muxponder cards:

• TXP_MR_10G

• TXP_MR_2.5G

• MXP_MR_2.5G

• MXP_2.5G_10G

To create Y-cable protection, you create a Y-cable protection group for two TXP or MXP cards using the 
CTC software, then connect the client ports of the two cards physically with a Y-cable. The single client 
signal is sent into the Rx Y-cable and is split between the two TXP or MXP cards. The two Tx signals 
from the client side of the TXP or MXP cards are combined in the TX Y-cable into a single client signal. 
Only the active card signal passes through as the single TX client signal. The other card must have its 
laser turned off to avoid signal degradation where the Y-cable joins. See the “NTP-G33 Create a Y-Cable 
Protection Group” procedure on page 3-36 as needed.

Figure 15-72 shows the Y-cable signal flow.

Note Loss of Signal–Payload (LOS-P) alarms, also called Incoming Payload Signal Absent alarms, can occur 
on a split signal if the ports are not in a Y-cable protection group.
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Figure 15-72 Y-Cable Protection

15.9.2 Splitter Protection
Splitter protection, shown in Figure 15-73, is provided with TXPP and MXPP cards. To implement 
splitter protection, a client injects a single signal into the client Rx port. An optical splitter internal to 
the card then splits the signal into two separate signals and routes them to the two trunk Tx ports. The 
two signals are transmitted over diverse optical paths. The far-end MXPP or TXPP card uses an optical 
switch to choose one of the two trunk Rx port signals and injects it into the Tx client port. When using 
splitter protection with two MXPP or TXPP cards, there are two different optical signals that flow over 
diverse paths in each direction. In case of failure. the far-end switch must choose the appropriate signal 
using its built-in optical switch. The triggers for a protection switch are LOS, LOF, SF, or SD.
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Figure 15-73 Splitter Protection

You create and modify protection schemes using CTC software.

15.10 Far-End Laser Control (FELC)
The 15454 DWDM cards provide a transparent mode that accurately conveys the client input signal to 
the far-end client output signal. The client signal is normally carried as payload over the DWDM signals. 
Certain client signals, however, cannot be conveyed as payload. In particular, client LOS or LOF cannot 
be carried. Far-end laser control is the ability to convey an LOS or LOF from the near-end client input 
to the far-end client output.

If an LOS is detected on the near-end client input, the near-end trunk sets the appropriate bytes in the 
OTN overhead of the DWDM line. These bytes are received by the far-end trunk, and cause the far-end 
client laser to be turned off. When the laser is turned off, it is said to be squelched. If the near-end LOS 
clears, the near-end trunk clears the appropriate bytes in the OTN overhead, the far-end detects the 
changed bytes, and the far-end client squelch is removed.

FELC also covers the situation in which the trunk port detects that it has an invalid signal; the client is 
squelched so as not to propagate the invalid signal.

Payload types with the 2R mode preclude the use of OTN overhead bytes. In 2R mode, an LOS on the 
client port causes the trunk laser to turn off. The far end detects the LOS on its trunk receiver and 
squelches the client.

FELC is not provisionable. It is always enabled when the DWDM card is in Transparent mode. However, 
FELC signaling to the far-end is only possible when ITU-T G.709 is enabled on both ends of the trunk 
span.

15.11 Jitter Considerations
Jitter introduced by the SFPs used in the transponders and muxponders must be considered when 
cascading several cards. With TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, 
and TXP_MR_10E cards, several transponders can be cascaded before the cumulative jitter violates the 
jitter specification. The recommended limit is 20 cards. With TXP_MR_10G cards, you can also cascade 
several cards, although the recommended limit is 12 cards. With MXP_2.5G_10G and MXP_2.5G_10E 
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cards, any number of cards can be cascaded as long as the maximum reach between any two is not 
exceeded. This is because any time the signal is demultiplexed, the jitter is eliminated as a limiting 
factor.

The maximum reach between one transponder and the other must be halved if a Y cable is used. For more 
information on Y-cable operation, see the “15.9.1 Y-Cable Protection” section on page 15-114.

15.12 Termination Modes
Transponder and muxponder cards have various SONET and SDH termination modes that can be 
configured using CTC (see Chapter 11, “Change DWDM Card Settings”). The termination modes are 
summarized in Table 15-68.

Table 15-68 Termination Modes

Card Termination Modes Description

All TXP and MXP 
cards, with the 
exception of the 
MXP_2.5G_10G 
card (see next section 
of this table)

Transparent Termination

Section Termination

Line Termination

All the bytes of the payload pass transparently through t

The SONET Transport Overhead (TOH) section bytes a
regenerator section overhead bytes are terminated. None
overhead bytes are passed through. They are all regener
the SONET TOH section data communication channel (S
the SDH data communications channel regenerator (DC
section termination mode, the SONET TOH line and SD
section overhead bytes are passed transparently.

In line termination mode, the section and line overhead b
and the overhead bytes for the SDH multiplex and regen
are terminated. None of the overhead bytes are passed th
all regenerated, including the SONET SDCC and line da
communication channel (LDCC) bytes and the SDH DC
communications channel multiplexer (DCCm) bytes.

MXP_2.5G_10G1

1. The clients operating at rates of OC48/STM16 are multiplexed into an OC192/STM64 frame before going to OTN or DWDM.

Transparent Termination

Section Termination

Line Termination

All of the client bytes of the clients passes transparently
the following: B1 is rebuilt, S1 is rewritten, A1 to A2 are 
H1 to H3 are regenerated.

The SONET TOH section bytes and the SDH regenerato
overhead bytes are terminated. None of these section ov
passed through. They are all regenerated, including the 
section DCC bytes and the SDH DCCr bytes. In the sec
mode, the SONET TOH line and SDH multiplex section
are passed transparently.

In the line termination mode, the section and line overh
SONET and the overhead bytes for the SDH multiplex a
sections are terminated. None of the overhead bytes are 
They are all regenerated, including the SONET SDCC a
and the SDH DCCr and DCCm bytes.
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15.13 SFP and XFP Modules
This section describes the SFPs and 10-Gbps SFPs (XFPs) that can be used with some transponder and 
muxponder cards. To install SFPs or XFPs, see the “DLP-G63 Install an SFP or XFP” task on page 3-34. 
In CTC, SFPs/XFPs are called pluggable port modules (PPMs). To provision SFPs/XFPs and change the 
line rate for multirate PPMs, see the “NTP-G128 Manage Pluggable Port Modules” procedure on 
page 5-2.

15.13.1 Compatibility by Card
Table 15-65 lists the transponder and muxponder cards and their compatible SFPs/XFPs.

Caution Only use SFPs/XFPs certified for use in Cisco Optical Networking Systems (ONSs). The qualified Cisco 
SFP/XFP pluggable module’s top assembly numbers (TANs) are provided in Table 15-65.

Table 15-69 SFP/XFP Card Compatibility

Card
ANSI Compatible SFP 
(Cisco Product ID)

ETSI Compatible SFP 
(Cisco Product ID)

Cisco Top 
Assembly 
Number (TAN)

MXP_2.5G_10G (ONS 15454 SONET/SDH) 15454-SFP-OC48-IR= 15454E-SFP-L.16.1= 10-1975-01

MXP_2.5G_10E (ONS 15454 SONET/SDH) ONS-SE-2G-S1= ONS-SE-2G-S1= 10-2017-01

MXP_MR_2.5G

MXPP_MR_2.5G

15454-SFP-GE+-LX= 15454E-SFP-GE+-LX= 10-1832-03

15454-SFP-GEFC-SX= N/A 10-1833-01

N/A 15454E-SFP-GEFC-S= 10-1833-02

TXP_MR_2.5G (ONS 15454 SONET/SDH)

TXPP_MR_2.5G (ONS 15454 SONET/SDH)

15454-SFP3-1-IR= 15454E-SFP-L.1.1= 10-1828-01

15454-SFP12-4-IR= 15454E-SFP-L.4.1= 10-1976-01

15454-SFP-OC48-IR= 15454E-SFP-L.16.1= 10-1975-01

ONS-SE-2G-S1= ONS-SE-2G-S1= 10-2017-01

15454-SFP-200= 15454E-SFP-200= 10-1750-01

15454-SFP-GEFC-SX= N/A 10-1833-01

N/A 15454E-SFP-GEFC-S= 10-1833-02

15454-SFP-GE+-LX= N/A 10-1832-01

N/A 15454E-SFP-GE+-LX= 10-1832-02

TXP_MR_10E (ONS 15454 SONET/SDH) ONS-XC-10G-S1 ONS-XC-10G-S1 10-2012-01
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15.13.2 SFP and XFP Description
SFPs and XFPs are integrated fiber optic transceivers that provide high-speed serial links from a port or 
slot to the network. Various latching mechanisms can be utilized on the SFP modules. There is no 
correlation between the type of latch to the model type (such as SX or LX/LH) or technology type (such 
as Gigabit Ethernet). See the label on the SFP or XFP for technology type and model. 

The SFPs use the latches show in the following figures. One type of latch is a mylar tab (Figure 15-74). 

Figure 15-74 Mylar Tab SFP

A second type of latch is an actuator/button (Figure 15-75).

Figure 15-75 Actuator/Button SFP

A third type of latch is a bail clasp (Figure 15-76).

Figure 15-76 Bail Clasp SFP

SFP dimensions are: 

• Height 0.03 in. (8.5 mm)

• Width 0.53 in. (13.4 mm)

• Depth 2.22 in. (56.5 mm)

SFP temperature ranges are:

• COM—Commercial operating temperature range –5 to 70 degrees Celsius (23 to 158 degrees 
Fahrenheit)
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• EXT—Extended operating temperature range –5 to 85 degrees Celsius (23 to 185 degrees 
Fahrenheit)

• IND—Industrial operating temperature range –40 to 85 degrees Celsius (–40 to 185 degrees 
Fahrenheit)

The XFPs uses the bail clasp latching mechanism as shown unlatched in Figure 15-77 and latched in 
Figure 15-78. See the label on the XFP for technology type and model. 

Figure 15-77 Bail Clasp XFP (Unlatched)

Figure 15-78 Bail Clasp XFP (Latched)

XFP dimensions are: 

• Height 0.33 in. (8.5 mm)

• Width 0.72 in. (18.3 mm)

• Depth 3.1 in. (78 mm)

XFP temperature ranges are:

• COM—Commercial operating temperature range –5 to 70 degrees Celsius (23 to 158 degrees 
Fahrenheit)

• EXT—Extended operating temperature range –5 to 85 degrees Celsius (23 to 185 degrees 
Fahrenheit)

• IND—Industrial operating temperature range –40 to 85 degrees Celsius (–40 to 185 degrees 
Fahrenheit)
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C H A P T E R 16

Node Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) node types that 
are available for the ONS 15454. The DWDM node type is determined by the type of amplifier and filter 
cards that are installed in an ONS 15454. The chapter also explains the DWDM automatic power control, 
ROADM power equalization, span loss verification, and automatic node setup functions. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 16.1 DWDM Node Configurations, page 16-1

• 16.2 DWDM and TDM Hybrid Node Types, page 16-14

• 16.3 Automatic Node Setup, page 16-29

16.1 DWDM Node Configurations
The ONS 15454 supports the following DWDM node configurations: hub, terminal, OADM, 
reconfigurable OADM, anti-ASE, line amplifier, and OSC regeneration line. 

Note The Cisco MetroPlanner tool creates a plan for amplifier placement and proper node equipment. 

16.1.1 Hub Node
A hub node is a single ONS 15454 node equipped with two TCC2/TCC2P (Timing Control Card) cards 
and one of the following combinations:

• Two 32MUX-O (32-Channel Multiplexer) and two 32DMX-O (32-Channel Demultiplexer) or 
32DMX cards

• Two 32WSS (32-Channel Wavelength Selective Switch) and two 32DMX or 32DMX-O cards

Note The 32WSS and 32DMX are normally installed in reconfigurable OADM (ROADM) nodes, but 
they can be installed in hub and terminal nodes. If the cards are installed in a hub node, the 
32WSS express (EXP RX and EXP TX) ports are not cabled.
16-1
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A Dispersion Compensation Unit (DCU) can also be added, if necessary. The hub node does not support 
both DWDM and time-division multiplexing (TDM) applications since the DWDM slot requirements do 
not leave room for TDM cards. Figure 16-1 shows a hub node configuration with 32MUX-O and 
32DMX-O cards installed. 

Note The optical add/drop multiplexing (OADM) AD-xC-xx.x or AD-xB-xx.x cards are not part of a hub node 
because the 32MUX-O and 32DMX-O cards drop and add all 32 channels; therefore, no other cards are 
necessary.

Figure 16-1 Hub Node Configuration Example

Figure 16-2 shows the channel flow for a hub node. Up to 32-channels from the client ports are 
multiplexed and equalized onto one fiber using the 32MUX-O card. Then, multiplexed channels are 
transmitted on the line in the eastward direction and fed to the Optical Booster (OPT-BST) amplifier. 
The output of this amplifier is combined with an output signal from the Optical Service Channel Modem 
(OSCM) card and transmitted toward the east line. 

Received signals from the east line port are split between the OSCM card and an Optical Preamplifier 
(OPT-PRE). Dispersion compensation is applied to the signal received by the OPT-PRE amplifier, and 
it is then sent to the 32DMX-O card, which demultiplexes and attenuates the input signal. The west 
receive fiber path is identical through the west OPT-BST amplifier, the west OPT-PRE amplifier, and the 
west 32DMX-O card.
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Figure 16-2 Hub Node Channel Flow Example

16.1.2 Terminal Node
A terminal node is a single ONS 15454 node equipped with two TCC2/TCC2P cards and one of the 
following combinations:

• One 32MUX-O card and one 32DMX-O card

• One 32WSS and either a 32DMX or a 32DMX-O cards

Terminal nodes can be either east or west. In west terminal nodes, the cards are installed in the east slots 
(Slots 1 through 6). In east terminal nodes, cards are installed in the west slots (Slots 12 through 17). 
Figure 16-3 shows an example of an east terminal configuration with a 32MUX-O and 32DMX-O cards 
installed. The channel flow for a terminal node is the same as the hub node (Figure 16-2).
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Figure 16-3 Terminal Node Configuration Example

16.1.3 OADM Node
An OADM node is a single ONS 15454 node equipped with cards installed on both sides and at least one 
AD-xC-xx.x card or one AD-xB-xx.x card and two TCC2/TCC2P cards. 32MUX-O or 32DMX-O cards 
cannot be installed in an OADM node. In an OADM node, channels can be added or dropped 
independently from each direction, and then passed through the reflected bands of all OADMs in the 
DWDM node (called express path). They can also be passed through one OADM card to another OADM 
card without using a TDM ITU line card (called optical passthrough) if an external patch cord is 
installed. 

Unlike express path, an optical passthrough channel can be converted later to an add/drop channel in an 
altered ring without affecting another channel. OADM amplifier placement and required card placement 
is determined by the Cisco MetroPlanner tool or your site plan.

OADM nodes can be amplified or passive. In amplified OADMs, the OPT-PRE and the OPT-BST 
amplifiers are installed on the east and west sides of the node. Figure 16-4 shows an example of an 
amplified OADM node configuration. 

O
P

T-B
S

T

O
P

T-P
R

E

32M
U

X
-O

DCU

Air ramp

Available

32D
M

X
-O

A
vailable

O
S

C
M

T
C

C
2/T

C
C

2P

A
vailable

T
C

C
2/T

C
C

2P
A

vailable

A
vailable

A
vailable

A
vailable

A
vailable

A
IC

-I

96
42

2

16-4
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 16      Node Reference
DWDM Node Configurations
Figure 16-4 Amplified OADM Node Configuration Example

Figure 16-5 shows an example of the channel flow on the amplified OADM node. Since the 
32-wavelength plan is based on eight bands (each band contains four channels), optical adding and 
dropping can be performed at the band level and/or at the channel level (meaning individual channels 
can be dropped). 
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Figure 16-5 Amplified OADM Node Channel Flow Example

Figure 16-6 shows an example of a passive OADM node configuration. The passive OADM node is 
equipped with a band filter, one four-channel multiplexer/demultiplexer, and a channel filter on each side 
of the node. 
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Figure 16-6 Passive OADM Node Configuration Example

Figure 16-7 shows an example of traffic flow on the passive OADM node. The signal flow of the 
channels is the same as the amplified OADM, except that the Optical Service Channel and 
Combiner/Separator Module (OSC-CSM) card is used instead of the OPT-BST amplifier and the OSCM 
card.

Figure 16-7 Passive OADM Node Channel Flow Example
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16.1.4 ROADM Node
A reconfigurable OADM (ROADM) node allows you to add and drop wavelengths without changing the 
physical fiber connections. ROADM nodes are equipped with two 32WSS cards. 32DMX or 32DMX-O 
demultiplexers are typically installed, but are not required. Transponders (TXPs) and muxponders 
(MXPs) can be installed in Slots 6 and 12 and, if amplification is not used, in any open slot. Figure 16-8 
shows an example of an amplified ROADM node configuration. 

Both 32DMX-O and 32-DMX cards can be used in ROADM nodes. Cisco MetroPlanner automatically 
determines at ROADM Node level which Demultiplexer to use based on the overall Network design.

Note Both 32DMX-O and 32DMX cards can be used in an ROADM node. Cisco Metroplanner automatically 
chooses the demultiplexer to use for the ROADM node based on the overall network requirements.

Figure 16-8 ROADM Node with BST-PRE, OPT-BST, and 32DMX Cards Installed
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Figure 16-9 shows an example of an ROADM with 32DMX-O cards installed. 

Figure 16-9 ROADM Node with BST-PRE, OPT-BST, and 32DMX-O Cards Installed

Figure 16-10 shows an example of a reconfigurable OADM east-to-west optical signal flow. The 
west-to-east optical signal flow follows an identical path through the west OSC-CSM and west 32WSS 
modules. In this example, OSC-CSM modules are installed so OPT-BST modules are not needed.
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Figure 16-10 ROADM Optical Signal Flow Example

16.1.5 Anti-ASE Node
In a meshed ring network, the ONS 15454 requires a node configuration that prevents amplified 
spontaneous emission (ASE) accumulation and lasing. An anti-ASE node can be created by configuring 
a hub node or an OADM node with some modifications. No channels can travel through the express path, 
but they can be demultiplexed and dropped at the channel level on one side and added and multiplexed 
on the other side. 

The hub node is the preferred node configuration when some channels are connected in passthrough 
mode. For rings that require a limited number of channels, combine AD-xB-xx.x and 4MD-xx.x cards, 
or cascade AD-xC-xx.x cards. See Figure 16-5 on page 16-6.

Figure 16-11 shows an anti-ASE node that uses all wavelengths in the passthrough mode. Use 
Cisco MetroPlanner to determine the best configuration for anti-ASE nodes.

1 The OSC-CSM receives the optical signal. It separates the optical service channel from the optical payload and sends the 
payload to the OPT-PRE module.

2 The OPT-PRE compensates for chromatic dispersion, amplifies the optical payload, and sends it to the 32WSS.

3 The 32WSS splits the signal into two components. The 80% component is sent to the DROP-TX port and the 20% 
component is sent to the EXP-TX port. 

4 The drop component goes to the 32DMX where it is de-multiplexed and dropped.

5 The express wavelength aggregate signal goes to the 32WSS on the other side where it is de-multiplexed. Channels are 
stopped or forwarded based upon their switch states. Forwarded wavelengths are merged with those coming from the 
ADD path and sent to the OSC-CSM module.

6 The OSC-CSM combines the multiplexed payload with the OSC and sends the signal out the transmission line.
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Figure 16-11 Anti-ASE Node Channel Flow Example

16.1.6 Line Amplifier Node
A line amplifier node is a single ONS 15454 node equipped with OPT-PRE amplifiers or OPT-BST 
amplifiers and TCC2/TCC2P cards. Attenuators might also be required between each preamplifier and 
booster amplifier to match the optical input power value and to maintain the amplifier gain tilt value. 

Two OSCM cards are connected to the east or west ports of the booster amplifiers to multiplex the optical 
service channel (OSC) signal with the pass-though channels. If the node does not contain OPT-BST 
amplifiers, you must use OSC-CSM cards rather than OSCM cards in your configuration. Figure 16-12 
shows an example of a line node configuration. 
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Figure 16-12 Line Amplifier Node Configuration Example

16.1.7 OSC Regeneration Node
The OSC regeneration node is added to the DWDM networks for two purposes: 

• To electrically regenerate the OSC channel whenever the span links are 37 dB or longer and payload 
amplification and add/drop capabilities are not present. Cisco MetroPlanner places an OSC 
regeneration node in spans longer than 37 dB. 31 dB is the longest span between the OSC 
regeneration node and the next DWDM network site. 

• To add data communications network (DCN) capability wherever needed within the network.

OSC regeneration nodes require two OSC-CSM cards, as shown in Figure 16-13. 
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Figure 16-13 OSC Regeneration Line Node Configuration Example

Figure 16-14 shows the OSC regeneration line node OSC signal flow. 

Figure 16-14 OSC Regeneration Line Node Flow
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16.2 DWDM and TDM Hybrid Node Types
The node type in a network configuration is determined by the type of card that is installed in an 
ONS 15454 hybrid node. The ONS 15454 supports the following hybrid DWDM and TDM node types: 
1+1 protected flexible terminal, scalable terminal, hybrid terminal, hybrid OADM, hybrid line amplifier, 
and amplified TDM.

Note The MetroPlanner tool creates a plan for amplifier placement and proper equipment for DWDM node 
configurations. Although TDM cards can be used with DWDM node configuration, the MetroPlanner 
tool does not create a plan for TDM card placement. MetroPlanner will support TDM configurations in 
a future release.

16.2.1 1+1 Protected Flexible Terminal Node
The 1+1 protected flexible terminal node is a single ONS 15454 node equipped with a series of OADM 
cards acting as a hub node configuration. This configuration uses a single hub or OADM node connected 
directly to the far-end hub or OADM node through four fiber links. This node type is used in a ring 
configured with two point-to-point links. The advantage of the 1+1 protected flexible terminal node 
configuration is that it provides path redundancy for 1+1 protected TDM networks (two transmit paths 
and two receive paths) using half of the DWDM equipment that is usually required. In the following 
example (Figure 16-15), one node transmits traffic to the other node on both east and west sides of the 
ring for protection purposes. If the fiber is damaged on one side of the ring, traffic still arrives safely 
through fiber on the other side of the ring.
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Figure 16-15 Double Terminal Protection Configuration

Figure 16-16 shows a 1+1 protected single-span link with hub nodes. This node type cannot be used in 
a hybrid configuration.
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Figure 16-16 1+1 Protected Single-Span Link with Hub Nodes

Figure 16-17 shows a 1+1 protected single-span link with active OADM nodes. This node type can be 
used in a hybrid configuration.
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Figure 16-17 1+1 Protected Single-Span Link with Active OADM Nodes

Figure 16-18 shows a 1+1 protected single-span link with passive OADM nodes. This node type can be 
used in a hybrid configuration.
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Figure 16-18 1+1 Protected Single-Span Link with Passive OADM Nodes

16.2.2 Scalable Terminal Node
The scalable terminal node is a single ONS 15454 node equipped with a series of OADM cards and 
amplifier cards. This node type is more cost effective if a maximum of 16 channels are used (Table 16-1). 
This node type does not support a terminal configuration exceeding 16 channels because the 32-channel 
terminal site is more cost effective for 17 channels and beyond.

Note The dash (—) in the following table below means not applicable.
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The OADM cards that can be used in this type of node are: AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, and 
AD-1B-xx.x. You can also use AD-4B-xx.x and up to four 4MD-xx.x cards. The OPT-PRE and/or 
OPT-BST amplifiers can be used. The OPT-PRE or OPT-BST configuration depends on the node loss 
and the span loss. When the OPT-BST is not installed, the OSC-CSM must be used instead of the OSCM 
card. Figure 16-19 on page 16-20 shows a channel flow example of a scalable terminal node 
configuration.

Table 16-1 Typical AD Configurations for Scalable Terminal Nodes

Number of 
Channels

Terminal Configuration

Option 1 Option 2

1 AD-1C-xx.x —

2 AD-2C-xx.x —

3 AD-4C-xx.x AD-1B-xx.x + 4MD-xx.x

4 AD-4C-xx.x AD-1B-xx.x + 4MD-xx.x

5 AD-1C-xx.x + AD-4C-xx.x AD-1C-xx.x + AD-1B-xx.x + 4MD-xx.x

6 AD-2C-xx.x + AD-4C-xx.x AD-2C-xx.x + AD-1B-xx.x + 4MD-xx.x

7 2 x AD-4C-xx.x 2 x (AD-1B-xx.x + 4MD-xx.x)

8 2 x AD-4C-xx.x 2 x (AD-1B-xx.x + 4MD-xx.x)

9 AD-1C-xx.x + (2 x AD-4C-xx.x) AD-1C-xx.x + 2 x (AD-1B-xx.x + 4MD-xx.x)

10 AD-2C-xx.x + (2 x AD-4C-xx.x) AD-2C-xx.x + 2 x (AD-1B-xx.x + 4MD-xx.x)

11 3 x AD-4C-xx.x AD-4B-xx.x + (3 x 4MD-xx.x)

12 3 x AD-4C-xx.x AD-4B-xx.x + (3 x 4MD-xx.x)

13 AD-4B-xx.x + (3 x 4MD-xx.x) + 
AD-1C-xx.x

AD-4B-xx.x + (4 x 4MD-xx.x)

14 AD-4B-xx.x + (3 x 4MD-xx.x) + 
AD-1C-xx.x

AD-4B-xx.x + (4 x 4MD-xx.x)

15 — AD-4B-xx.x + (4 x 4MD-xx.x)

16 — AD-4B-xx.x + (4 x 4MD-xx.x)
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Figure 16-19 Scalable Terminal Channel Flow Example

A scalable terminal node can be created by using band and/or channel OADM filter cards. This node type 
is the most flexible of all node types because the OADM filter cards can be configured to accommodate 
node traffic. If the node does not contain amplifiers, it is considered a passive hybrid terminal node. 
Figure 16-20 shows an example of a scalable terminal node configuration. This node type can be used 
without add or drop cards.
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Figure 16-20 Scalable Terminal Example

16.2.3 Hybrid Terminal Node
A hybrid terminal node is a single ONS 15454 node equipped with at least one 32 MUX-O card, one 
32 DMX-O card, two TCC2/TCC2P cards, and TDM cards. If the node is equipped with OPT-PRE or 
OPT-BST amplifiers, it is considered an amplified terminal node. The node becomes passive if the 
amplifiers are removed. The hybrid terminal node type is based on the DWDM terminal node type 
described in the “16.1.2 Terminal Node” section on page 16-3. Figure 16-21 shows an example of an 
amplified hybrid terminal node configuration. 
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Figure 16-21 Amplified Hybrid Terminal Example

Figure 16-22 shows an example of a passive hybrid terminal node configuration.
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Figure 16-22 Passive Hybrid Terminal Example

16.2.4 Hybrid OADM Node
A hybrid OADM node is a single ONS 15454 node equipped with at least one AD-xC-xx.x card or one 
AD-xB-xx.x card, and two TCC2/TCC2P cards. The hybrid OADM node type is based on the DWDM 
OADM node type described in the “16.1.3 OADM Node” section on page 16-4. TDM cards can be 
installed in any available slot. Review the plan produced by MetroPlanner to determine slot availability. 
Figure 16-23 shows an example of an amplified hybrid OADM node configuration. The hybrid OADM 
node can also become passive by removing the amplifier cards.
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Figure 16-23 Hybrid Amplified OADM Example

16.2.5 Hybrid Line Amplifier Node
A hybrid line amplifier node is a single ONS 15454 node with open slots for both TDM and DWDM 
cards. Figure 16-24 shows an example of a hybrid line amplifier node configuration. Figure 16-25 on 
page 16-26 shows a channel flow example of a hybrid line node configuration. Since this node contains 
both TDM and DWDM rings, both TDM and DWDM rings should be terminated even if no interactions 
are present between them.

Note For DWDM applications, if the OPT-BST is not installed within the node, the OSC-CSM card must be 
used instead of the OSCM card.
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Figure 16-24 Hybrid Line Amplifier Example
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Figure 16-25 Hybrid Line Amplifier Channel Flow Example

A hybrid line node is another example of the hybrid line amplifier OADM node. A hybrid line node is 
single ONS 15454 node equipped with OPT-PRE amplifiers, OPT-BST amplifiers, and TCC2/TCC2P 
cards for each line direction. Both types of amplifiers can be used or just one type of amplifier. 
Attenuators might also be required between each preamplifier and booster amplifier to match the optical 
input power value and to maintain the amplifier gain tilt value. TDM cards can be installed in any 
available slot. Review the plan produced by MetroPlanner to determine slot availability. 

16.2.6 Amplified TDM Node
An amplified TDM node is a single ONS 15454 node that increases the span length between two 
ONS 15454 nodes that contain TDM cards and optical amplifiers. There are three possible installation 
configurations for an amplified TDM node. Scenario 1 uses client cards and OPT-BST amplifiers. 
Scenario 2 uses client cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters. 
Scenario 3 uses client cards, OPT-BST amplifiers, OPT-PRE amplifiers, AD-1C-xx.x cards, and 
OSC-CSM cards.

The client cards that can be used in an amplified TDM node are: TXP_MR_10G, MXP_2.5G_10G, 
TXP_MR_2.5G, TXPP_MR_2.5G, OC-192 LR/STM 64 ITU 15xx.xx, and OC-48 ELR/STM 16 EH 
100 GHz. 

Figure 16-26 shows the first amplified TDM node scenario with an OPT-BST amplifier.
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Figure 16-26 Amplified TDM Example with an OPT-BST Amplifier

Figure 16-27 shows the first amplified TDM node channel flow scenario configured with OPT-BST 
amplifiers.

Figure 16-27 Amplified TDM Channel Flow Example With OPT-BST Amplifiers

Figure 16-28 shows the second amplified TDM node configuration scenario with client cards, 
AD-1C-xx.x cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters.
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Figure 16-28 Amplified TDM Example with FlexLayer Filters

Figure 16-29 shows the second amplified TDM node channel flow configuration scenario with client 
cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters.

Figure 16-29 Amplified TDM Channel Flow Example With FlexLayer Filters

Figure 16-30 shows the third amplified TDM channel flow configuration scenario with client cards, 
OPT-BST amplifiers, OPT-PRE amplifiers, AD-1C-xx.x cards, and OSC-CSM cards.
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Figure 16-30 Amplified TDM Channel Flow Example With Amplifiers, AD-1C-xx.x Cards, and OSC-CSM Cards

16.3 Automatic Node Setup
Automatic node setup (ANS) is a TCC2/TCC2P function that adjusts values of the VOAs on the DWDM 
channel paths to equalize the per-channel power at the amplifier input. This power equalization means 
that at launch, all the channels have the same amplifier power level, independent from the input signal 
on the client interface and independent from the path crossed by the signal inside the node. This 
equalization is needed for two reasons:

• Every path introduces a different penalty on the signal that crosses it.

• Client interfaces add their signal to the ONS 15454 DWDM ring with different power levels.

To support ANS, the integrated VOAs and photodiodes are provided in the following ONS 15454 
DWDM cards:

• OADM band cards (AD-xB-xx.x) express and drop path

• OADM channel cards (AD-xC-xx.x) express and add path

• 4-Channel Terminal Multiplexer/Demultiplexer (4MD-xx.x) input port

• 32-Channel Terminal Multiplexer (32MUX-O) input port

• 32-Channel Wavelength Selective Switch (32WSS) input port

• 32-Channel Terminal Demultiplexer (32DMX-O and 32DMX) output port 

Optical power is equalized by regulating the VOAs. Based on the expected per-channel power, ANS 
automatically calculates the VOA values by:

• Reconstructing the different channels paths

• Retrieving the path insertion loss (stored in each DWDM transmission element) 

VOAs operate in one of three working modes:

• Automatic VOA Shutdown—In this mode, the VOA is set at maximum attenuation value. Automatic 
VOA shutdown mode is set when the channel is not provisioned to ensure system reliability in the 
event that power is accidentally inserted.
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• Constant Attenuation Value—In this mode, the VOA is regulated to a constant attenuation 
independent from the value of the input signal. Constant attenuation value mode is set on the 
following VOAs:

– OADM band card VOAs on express and drop paths (as operating mode)

– OADM channel card VOAs during power insertion startup

– The multiplexer/demultiplexer card VOAs during power insertion startup

• Constant Power Value—In this mode, the VOA values are automatically regulated to keep a constant 
output power when changes occur to the input power signal. This working condition is set on OADM 
channel card VOAs as “operating” and on 32MUX-O, 32WSS, 32DMX-O, and 32DMX card VOAs 
as “operating mode.”

In the normal operating mode, OADM band card VOAs are set to a constant attenuation, while OADM 
channel card VOAs are set to a constant power. ANS requires the following VOA provisioning 
parameters to be specified:

• Target attenuation (OADM band card VOA and OADM channel card startup)

• Target power (channel VOA)

To allow you to modify ANS values based on your DWDM deployment, provisioning parameters are 
divided into two contributions:

• Reference Contribution (read only)—Set by ANS.

• Calibration Contribution (read and write)—Set by user.

The ANS equalization algorithm requires the following knowledge of the DWDM transmission element 
layout:

• The order in which the DWDM elements are connected together on the express paths

• Channels that are dropped and added

• Channels or bands that have been configured as passthrough

ANS assumes that every DWDM port has a line direction parameter that is either west to east (W-E) or 
east to west (E-W). ANS automatically configures the mandatory optical connections according to 
following main rules: 

• Cards equipped in Slots 1 to 6 have a drop section facing west.

• Cards equipped in Slots 12 to 17 have a drop section facing east.

• Contiguous cards are cascaded on the express path.

• 4MD-xx.x and AD-xB-xx.x are always optically coupled.

• A 4MD-xx.x absence forces an optical passthrough connection.

• Transmit (Tx) ports are always connected to receive (Rx) ports.

Optical patch cords are passive devices that are not autodiscovered by ANS. However, optical patch 
cords are used to build the alarm correlation graph. From CTC or TL1 you can:

• Calculate the default connections on the NE.

• Retrieve the list of existing connections.

• Retrieve the list of free ports.

• Create new connections or modify existing ones.

• Launch ANS.

After you launch ANS, the following status are provided for each ANS parameter:
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• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not Applicable—The parameter setpoint does not apply to this node type.

• Fail - Out of Range—The calculated setpoint is outside the expected range. 

• Fail - Port in IS State—The parameter could not be calculated because the port is in-service. 

Optical connections are identified by the two termination points, each with an assigned slot and port. 
ANS checks that a new connection is feasible (according to embedded connection rules) and returns a 
denied message in the case of a violation.

ANS requires provisioning of the expected wavelength. When provisioning the expected wavelength, the 
following rules apply:

• The card name is generically characterized by the card family, and not the particular wavelengths 
supported (for example, AD-2C for all 2-channel OADMs).

• At the provisioning layer, you can provision a generic card for a specific slot using CTC or TL1. 

• Wavelength assignment is done at the port level.

• An equipment mismatch alarm is raised when a mismatch between the identified and provisioned 
value occurs. The default value for the provisioned attribute is AUTO.

16.3.1 Automatic Node Setup Parameters
All ONS 15454 ANS parameters are calculated by Cisco MetroPlanner for nodes configured for metro 
core networks. (Parameters must be configured manually for metro access nodes.) Cisco MetroPlanner 
exports the calculated parameters to an ASCII file called “NE Update.” In CTC, you can import the NE 
Update file to automatically provision the node. Table 16-2 shows ANS parameters arranged in east and 
west, transmit and receive groups.
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Table 16-2 ANS Parameters

Direction ANS Parameters

West Side - Receive • West Side Rx Max Expected Span Loss

• West Side Rx Min Expected Span Loss

• West Side Rx Amplifier Working Mode

• West Side Rx Amplifier Ch Power

• West Side Rx Amplifier Gain

• West Side Rx Amplifier Tilt

• West Side OSC LOS Threshold 

• West Side Channel LOS Threshold

• West Side Rx Amplifier Input Power Fail Th

• West Side Add and Drop Stage Input Power

• West Side Add and Drop Stage Drop Power

• West Side Add and Drop Stage Band (i) Drop Power (i = 1 through 8)

• West Side Add and Drop Stage Channel (i) Drop Power (i = 1 through 
32)

East Side - Receive • East Side Rx Max Expected Span Loss

• East Side Rx Min Expected Span Loss

• East Side Rx Amplifier Working Mode

• East Side Rx Amplifier Ch Power

• East Side Rx Amplifier Gain

• East Side Rx Amplifier Tilt

• East Side OSC LOS Threshold 

• East Side Channel LOS Threshold

• East Side Rx Amplifier Input Power Fail Th

• East Side Add and Drop Stage Input Power

• East Side Add and Drop Stage Drop Power

• East Side Add and Drop Stage Band (i) Drop Power (i = 1 through 8

• East Side Add and Drop Stage Channel (i) Drop Power (i = 1 through 
32)
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16.3.2 View and Provision ANS Parameters
All ANS parameters can be viewed and provisioned from the node view Provisioning > WDM-ANS > 
Provisioning subtab, shown in Figure 16-31. The WDM-ANS > Provisioning > Provisioning subtab 
presents the parameters in the following tree view:

root

+/– East

• +/– Receiving

– +/– Amplifier

– +/– Power

– +/– Threshold

• +/– Transmitting

– +/– Amplifier

– +/– Power

– +/– Threshold

+/– West

• +/– Receiving

– +/– Amplifier

– +/– Power

– +/– Threshold

• +/– Transmitting

West Side - Transmit • West Side Tx Amplifier Working Mode

• West Side Tx Amplifier Ch Power

• West Side Tx Amplifier Gain

• West Side Tx Amplifier Tilt

• West Side Fiber Stage Input Threshold

• West Side Add and Drop Stage Output Power

• West Side Add and Drop Stage By-Pass Power

East Side - Transmit • East Side Tx Amplifier Working Mode

• East Side Tx Amplifier Ch Power

• East Side Tx Amplifier Gain

• East Side Tx Amplifier Tilt

• East Side Fiber Stage Input Threshold

• East Side Add and Drop Stage Output Power

• East Side Add and Drop Stage By-Pass Power

Table 16-2 ANS Parameters (continued)

Direction ANS Parameters
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– +/– Amplifier

– +/– Power

– +/– Threshold

Figure 16-31 WDM-ANS Provisioning

Table 16-3 shows the parameter IDs based on platform, line-direction, and functional group.
11

57
17

Parameter tree view ANS parameters Parameter values

Table 16-3 ANS-WDM > Provisioning Subtab Parameters

Tree Element Parameters

root Network Type (dwdm)

root +/– East +/– Receiving East Side Rx Max Expected Span Loss

East Side Rx Min Expected Span Loss

root +/– East +/– Receiving +/– Amplifier East Side Rx Amplifier Working Mode

East Side Rx Amplifier Ch Power

East Side Rx Amplifier Gain

East Side Rx Amplifier Tilt
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root +/– East +/– Receiving +/– Power East Side Add and Drop Input Power

East Side Add and Drop Drop Power

East Side Band n Drop Power (n = 1-8)

East Side Channel n Drop Power East (n = 1-32)

root +/– East +/– Receiving +/– Thresholds East Side OSC LOS Threshold

East Side Channel LOS Threshold

East Side Rx Amplifier In Power Fail Th

root +/– East +/– Transmitting +/– Amplifier East Side Tx Amplifier Working Mode

East Side Tx Amplifier Ch Power

East Side Tx Amplifier Gain

East Side Tx Amplifier Tilt

root +/– East +/– Transmitting +/– Power East Side Add and Drop Output Power

East Side Add and Drop By-Pass Power

root +/– East +/– Transmitting +/– Thresholds East Side Fiber Stage Input Threshold

root +/– West +/– Receiving West Side Rx Max Expected Span Loss

West Side Rx Min Expected Span Loss

root +/– West +/– Receiving +/– Amplifier West Side Rx Amplifier Working Mode

West Side Rx Amplifier Ch Power

West Side Rx Amplifier Gain

West Side Rx Amplifier Tilt

root +/– West +/– Receiving +/– Power West Side Add and Drop Input Power

West Side Add and Drop Drop Power

West Side Band n Drop Power (n = 1-8)

West Side Channel n Drop Power (n = 1-32)

root +/– West +/– Receiving +/– Thresholds West Side OSC LOS Threshold

West Side Channel LOS Threshold

West Side Rx Amplifier In Power Fail Th

root +/– West +/– Transmitting +/– Amplifier West Side Tx Amplifier Working Mode

West Side Tx Amplifier Ch Power

West Side Tx Amplifier Gain

West Side Tx Amplifier Tilt

root +/– East +/– Transmitting +/– Power West Side Add and Drop Output Power

West Side Add and Drop By-Pass Power

root +/– West +/– Transmitting +/– Thresholds West Side Fiber Stage Input Threshold

Table 16-3 ANS-WDM > Provisioning Subtab Parameters (continued)

Tree Element Parameters
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The ANS parameters that appear in the WDM-ANS > Provisioning subtab depend on the node type. 
Table 16-4 shows the DWDN node types and their ANS parameters.

Table 16-4 ANS Parameters By Node Type

Node Type Parameter Group Parameters

Hub Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power 

East and West Side Add and Drop By-Pass Power

East and West Side Channel (n) Drop Power
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Terminal Network Network Type

Span Loss East or West Expected Span Loss

Amplifier Tx East or West Side Transmit Amplifier Working Mode

East or West Side Transmit Amplifier Channel Power

East or West Side Transmit Amplifier Gain

East or West Side Transmit Amplifier Tilt

Amplifier Rx East or West Side Receive Amplifier Working Mode

East or West Side Receive Amplifier Channel Power

East or West Side Receive Amplifier Gain

East or West Side Receive Amplifier Tilt

Thresholds Tx East or West Side Fiber Stage Input Threshold

Thresholds Rx East or West Side Osc Los Threshold

East or West Side Channel Los Threshold

East or West Side Receive Amplifier Input Power Fail

Power East or West Side Add and Drop Input Power 

East or West Side Add and Drop Output Power 

East or West Side Channel (n) Drop Power (n = 1-32)

Flexible Channel 
Count Terminal

Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power

East and West Side Band (n) Drop Power (n = 1-8)

Table 16-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters
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OADM Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power 

East and West Side Band (n) Drop Power (n = 1-8)

Line Amplifier Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Table 16-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters
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Table 16-5 shows the following information for all ONS 15454 ANS parameters: 

• Min—Minimum value in decibels.

• Max—Maximum value in decibels.

• Def—Default value in decibels. Other defaults include MC (metro core), CG (control gain), 
U (unknown).

• Group—Group(s) to which the parameter belongs: ES (east side), WS (west side), Rx (receive), 
Tx (transmit), Amp (amplifier), P (power), DB (drop band), DC (drop channel), A (attenuation), 
Th (threshold).

• Network Type—Parameter network type: MC (metro core), MA (metro access), ND (not DWDM)

• Optical Type—Parameter optical type: TS (32 channel terminal), FC (flexible channel count 
terminal), O (OADM), H (hub), LS (line amplifier), R (ROADM), U (unknown)

ROADM Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power (if 32DMX 
East/West is installed)

East and West Side Add and Drop Output Power 

East and West Side Add and Drop Drop Power (if 32DMX 
East/West is installed)

East and West Side Channel (n) Drop Power (if 32DMX-O 
East/West is installed)

Table 16-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters

Table 16-5 ANS Parameters Summary

General Name Min Max Def Group Network Type Optical Type

Network Type – – MC Root MC, MA, ND U, TS, FC, O, H, LS, R

West Side Rx Max Expected Span Loss 0 60 60 WS, Rx MC, MA TS, FC, O, H, LS, R
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East Side Rx Max Expected Span Loss 0 60 60 ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Rx Min Expected Span Loss 0 60 60 WS, Rx MC, MA TS, FC, O, H, LS, R

East Side Rx Min Expected Span Loss 0 60 60 ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Tx Amplifier Working Mode – – CG WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Tx Amplifier Working Mode – – CG ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Rx Amplifier Working Mode – – CG WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Rx Amplifier Working Mode – – CG ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Tx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Tx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

West Side Rx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Rx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

West Side Tx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

East Side Tx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS. R

West Side Rx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

East Side Rx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

West Side Tx Amplifier Tilt 0 30 0 WS, Tx, Amp MC, MA TS, FC, O, H, LS, R

East Side Tx Amplifier Tilt 0 30 0 WS, Tx, Amp MC, MA TS, FC, O, H, LS, R

West Side Rx Amplifier Tilt 0 30 0 WS, Rx, Amp MC, MA TS, FC, O, H, LS, R

East Side Rx Amplifier Tilt 0 30 0 WS, Rx, Amp MC, MA TS, FC, O, H, LS, R

West Side OSC LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

East Side OSC LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

West Side Channel LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

East Side Channel LOS Threshold –50 30 U ES, Rx, Th MC, MA, ND TS, FC, O, H, LS, R

West Side Fiber State Input Threshold –50 30 U WS, Tx, Th MC, MA, ND TS, FC, O, H, LS, R

East Side Fiber State Input Threshold –50 30 U ES, Tx, Th MC, MA, ND TS, FC, O, H, LS, R

West Side Add and Drop Output Power –50 30 –14 WS, Tx, P MC TS, FC, O, H, R

East Side Add and Drop Output Power –50 30 –14 ES, Tx, P MC TS, FC, O, H, R

West Side Add and Drop Input Power –50 30 –14 WS, Rx, P MC TS, FC, O, H, R

East Side Add and Drop Input Power –50 30 –14 ES, Rx, P MC TS, FC, O, H, R

West Side Add and Drop By-Pass Power –50 30 –14 WS, Tx, P MC H

East Side Add and Drop By-Pass Power –50 30 –14 ES, Tx, P MC H

West Side Add and Drop Drop Power –50 30 –14 WS, Tx, P MC R

East Side Add and Drop Drop Power –50 30 –14 ES, Tx, P MC R

West Side Band 1...8 Drop Power –50 30 –14 WS, Rx, P, DB MC FC, O

East Side Band 1...8 Drop Power –50 30 –14 ES, Rx, P, DB MC FC, O

Table 16-5 ANS Parameters Summary (continued)

General Name Min Max Def Group Network Type Optical Type
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West Side Channel 1...32 Drop Power –50 30 –14 WS, Rx, P, DC, B1 MC, MA TS, H, R

East Side Channel 1...32 Drop Power –50 30 –14 ES, Rx, P, DC, B1 MC, MA TS, H, R

Table 16-5 ANS Parameters Summary (continued)

General Name Min Max Def Group Network Type Optical Type
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C H A P T E R 17

Network Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) network 
applications and topologies. The chapter also provides network-level optical performance references. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 17.1 Network Applications, page 17-1

• 17.2 Network Topologies, page 17-2

• 17.3 Optical Performance, page 17-6

• 17.4 Automatic Power Control, page 17-17

• 17.5 ROADM Power Equalization Monitoring, page 17-22

• 17.6 Span Loss Verification, page 17-23

• 17.7 Network Optical Safety––Automatic Laser Shutdown, page 17-24

• 17.8 Network-Level Gain—Tilt Management of Optical Amplifiers, page 17-28

17.1 Network Applications
Cisco ONS 15454s can be provisioned for metro access and metro core DWDM network applications. 
Metro access networks are 60 km or less in size. Channels are not equalized and dispersion compensation 
is not applied. Metro access networks have few spans and very low span loss, so the signal link budget 
is the limiting factor for performance. Metro core networks can be up to 400 km in size. The channel 
power is equalized and dispersion compensation is applied. Metro core networks often include multiple 
spans and amplifiers, so the optical signal-to-noise ratio (OSNR) is the limiting factor for channel 
performance in metro core networks.

Within DWDM networks, the ONS 15454 uses a communications protocol, called node services protocol 
(NSP), to communicate with other nodes. NSP automatically updates nodes whenever a change in the 
network occurs. Each ONS 15454 DWDM node can: 

• Identify other ONS 15454 DWDM nodes in the network.

• Identify the different types of DWDM networks.

• Identify when the DWDM network is complete and when it is incomplete.
17-1
 Installation and Operations Guide, R5.0



Chapter 17      Network Reference
Network Topologies
17.2 Network Topologies
The ONS 15454 DWDM network topologies include hubbed, multihubbed, and meshed rings, and linear 
and single-span networks.

17.2.1 Hubbed Rings
In the hubbed ring topology (Figure 17-1), a hub node terminates all the DWDM channels. A channel 
can be provisioned to support protected traffic between the hub node and any node in the ring. Both 
working and protected traffic use the same wavelength on both sides of the ring. Protected traffic can 
also be provisioned between any pair of optical add/drop multiplexing (OADM) nodes, except that either 
the working or the protected path must be regenerated in the hub node. 

Protected traffic saturates a channel in a hubbed ring, that is, no channel reuse is possible. However, the 
same channel can be reused in different sections of the ring by provisioning unprotected multihop traffic. 
From a transmission point of view, this network topology is similar to two bidirectional point-to-point 
links with OADM nodes.

For more information about hub nodes, see the “16.1.1 Hub Node” section on page 16-1.

Figure 17-1 Hubbed Ring

17.2.2 Multihubbed Rings
A multihubbed ring (Figure 17-2) is based on the hubbed ring topology, except that two or more hub 
nodes are added. Protected traffic can only be established between the two hub nodes. Protected traffic 
can be provisioned between a hub node and any OADM node only if the allocated wavelength channel 
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is regenerated through the other hub node. Multihop traffic can be provisioned on this ring. From a 
transmission point of view, this network topology is similar to two or more point-to-point links with 
OADM nodes.

Figure 17-2 Multihubbed Ring

17.2.3 Any-to-Any Rings
The any-to-any ring topology (Figure 17-3) contains only reconfigurable OADM (ROADM) nodes, or 
ROADM nodes with Optical Service Channel (OSC) regeneration or amplifier nodes. This topology 
potentially allows you to route every wavelength from any source to any destination node inside the 
network.

See the “16.1.4 ROADM Node” section on page 16-8 for more information.
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Figure 17-3 Any-to-Any Ring

17.2.4 Meshed Rings
The meshed ring topology (Figure 17-4) does not use hubbed nodes; only amplified and passive OADM 
nodes are present. Protected traffic can be provisioned between any two nodes; however, the selected 
channel cannot be reused in the ring. Unprotected multihop traffic can be provisioned in the ring. A 
meshed ring must be designed to prevent amplified spontaneous emission (ASE) lasing. This is done by 
configuring a particular node as an anti-ASE node. An anti-ASE node can be created in two ways:

• Equip an OADM node with 32MUX-O cards and 32DMX-O cards. This solution is adopted when 
the total number of wavelengths deployed in the ring is higher than ten. OADM nodes equipped with 
32MUX-O cards and 32DMX-O cards are called full OADM nodes.

• When the total number of wavelengths deployed in the ring is lower than ten, the anti-ASE node is 
configured by using an OADM node where all the channels that are not terminated in the node are 
configured as “optical pass-through.” In other words, no channels in the anti-ASE node can travel 
through the express path of the OADM node. 

For more information about OADM nodes, see the “16.1.3 OADM Node” section on page 16-4. For 
more information about anti-ASE nodes, see the “16.1.5 Anti-ASE Node” section on page 16-10.
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Figure 17-4 Meshed Ring

17.2.5 Linear Configurations
Linear configurations are characterized by the use of two terminal nodes (west and east). The terminal 
nodes can be equipped with a 32MUX-O card and a 32DMX-O card, or a 32WSS card with a 32DMX 
or 32DMX-O card. OADM or line amplifier nodes can be installed between the two terminal nodes. Only 
unprotected traffic can be provisioned in a linear configuration. Figure 17-5 shows five ONS 15454 
nodes in a linear configuration with an amplified and a passive OADM node. 

Figure 17-5 Linear Configuration with an OADM Node

Figure 17-6 shows five ONS 15454 nodes in a linear configuration without an OADM node.

See the “16.1.2 Terminal Node” section on page 16-3 for more information.
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Figure 17-6 Linear Configuration without an OADM Node

17.2.6 Single-Span Link
Single-span link is a type of linear configuration characterized by a single-span link with 
pre-amplification and post-amplification. A single-span link is also characterized by the use of two 
terminal nodes (west and east). The terminal nodes are usually equipped with a 32MUX-O card and a 
32DMX-O card. However, a 32WSS card and a 32DMX or a 32DMX-O card can be installed. Software 
R4.7 and later also supports single-span links with AD-4C-xx.x cards. Only unprotected traffic can be 
provisioned on a single-span link. 

Figure 17-7 shows ONS 15454s in a single-span link. Eight channels are carried on one span. 
Single-span link losses apply to OC-192 LR ITU cards. The optical performance values are valid 
assuming that the sum of the OADM passive node insertion losses and the span losses does not exceed 
35 dB.

Figure 17-7 Single-Span Link

17.3 Optical Performance
This section provides optical performance information for ONS 15454 DWDM networks. The 
performance data is a general guideline based upon the network topology, node type, client cards, fiber 
type, number of spans, and number of channels. The maximum number of nodes that can be in an 
ONS 15454 DWDM network is 16. The DWDM topologies and node types that are supported are shown 
in Table 17-1.
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DWDM client cards are grouped into nine classes, shown in Table 17-2. Span loss estimates are based 
on the number of spans in the network and the client card class. Some cards belong to more than one 
class depending on whether forward error correction (FEC) is enabled and on the payload data type 
provisioned for the card.

Table 17-1 Supported Topologies and Node Types

Number of Channels Fiber Topologies Node Type

32 channels SMF-281

E-LEAF2

TW-RS3

1. SMF-28 = single-mode fiber 28

2. E-LEAF = enhanced large effective area fiber

3. TW-RS = TrueWave reduced slope fiber

Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

16 channels SMF-28 Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

8 channels SMF-28 Linear without OADM Terminal

Line

Table 17-2 ONS 15454 Client Card Classes

Class Rate Clients

A 10 Gbps TXP_2.5G_10G—FEC enabled

TXP_2.5G_10E—FEC enabled

TXP_MR_10G—FEC enabled

TXP_MR_10E—FEC enabled

B 10 Gbps TXP_2.5G_10G—FEC not enabled

TXP_MR_10G—FEC not enabled

C 10 Gbps OC-192 LR ITU

TXP_2.5G_10E—FEC not enabled

D 2.5 Gbps TXP_MR_2.5G—FEC enabled

TXPP_MR_2.5G—FEC enabled
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17.3.1 Optical Performance for Rings and Linear Networks with OADM Nodes
The following tables provide optical performance estimates for open and closed ONS 15454 rings and 
linear networks with OADM nodes. 

Table 17-3 shows the optical performance for 32-channel networks using SMF fiber. Span losses shown 
in the table assume:

• OADM nodes have a loss of 16 dB and equal span losses. 

• The DCU loss is 9 dB.

• Optical Preamplifier (OPT-PRE) and Optical Booster (OPT-BST/OPT-BST-E) amplifiers are 
installed in all nodes.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 17-2 for a list of cards in each class. A dash (—) indicates spans that are not supported.

E 2.5 Gbps TXP_MR_2.5G—3R payload data type; FEC disabled

TXPP_MR_2.5G—3R payload data type; FEC disabled

MXP_MR_2.5G

MXPP_MR_2.5G

F 2.5 Gbps TXP_MR_2.5G—2R payload data type

TXPP_MR_2.5G—2R payload data type

G 2.5 Gbps OC-48 ELR ITU

H 2.5 Gbps 2/4 port Gigabit Ethernet Transponder (GBIC WDM 100 GHz)

I 10 Gbps TXP_2.5G_10E—E-FEC1 enabled

TXP_MR_10E—E-FEC enabled

1. Forward error correction

Table 17-2 ONS 15454 Client Card Classes (continued)

Class Rate Clients

Table 17-3 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 29 dB 21 dB 20 dB 30 dB 31 dB 27 dB 25 dB 26 dB 28 dB 25 dB

3 26 dB 17 dB 15 dB 28 dB 29 dB 25 dB 23 dB 24 dB 26 dB 23 dB

4 24 dB — — 25 dB 26 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 23 dB — — 24 dB 25 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 21 dB — — 23 dB 24 dB 19 dB — 17 dB 21 dB —

7 201 dB

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER > 10-6

— — 22 dB 23 dB 16 dB — — 19 dB —
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Table 17-4 shows the optical performance for 16-channel networks using SMF fiber. Span loss values 
assume the following:

• OADM nodes have a loss of 16 dB and equal span losses.

• The DCU loss is 9 dB.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-5 shows the optical performance for 32-channel networks using TW-RS fiber. Span loss values 
assume the following:

• OADM nodes have a loss of 16 dB and equal span losses.

• The DCU is 550 ps with 4 dB loss.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-6 shows the optical performance for 32-channel networks using E-LEAF fiber. Span loss values 
assume the following:

Table 17-4 Span Loss for 16-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 29 dB 28 dB 37 dB 37 dB 36 dB 33 dB 35 dB 37 dB 33 dB

2 32 dB 24 dB 24 dB 34 dB 35 dB 31 dB 28 dB 30 dB 32 dB 28 dB

3 29 dB 22 dB 21 dB 31 dB 32 dB 28 dB 25 dB 27 dB 29 dB 25 dB

4 27 dB 19 dB 17 dB 29 dB 30 dB 26 dB 23 dB 25 dB 27 dB 23 dB

5 26 dB — — 27 dB 28 dB 24 dB 22 dB 24 dB 25 dB 22 dB

6 25 dB — — 26 dB 27 dB 23 dB 21 dB 23 dB 24 dB 21 dB

7 24 dB — — 25 dB 256dB 23 dB 19 dB 22 dB 23 dB 19 dB

Table 17-5 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using TW-RS Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 29 dB 21 dB 20 dB 31 dB 32 dB 28 dB 26 dB 27 dB 29 dB 26 dB

3 27 dB 17 dB 15 dB 29 dB 30 dB 26 dB 23 dB 25 dB 27 dB 23 dB

4 25 dB — — 27 dB 28 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 23 dB — — 26 dB 27 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 21 dB — — 24 dB 25 dB 19 dB — 17 dB 21 dB —

7 20 dB — — 22 dB 24 dB 16 dB — — 19 dB —
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• OADM nodes have a loss of 16 dB and equal span losses.

• The DCU is 550 ps with 4 dB loss.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

17.3.2 Optical Performance for Linear Networks Without OADM Nodes
The following tables list the reference optical performances for linear networks without OADM nodes. 
Table 17-7 shows the optical performance for 32-channel linear networks using SMF fiber. Span loss 
values assume the following:

• No OADM nodes are installed and span losses are equal.

• The DCU loss is 9 dB.

• Only OPT-PRE amplifiers are installed.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-8 shows the optical performance for 32-channel linear networks using TW-RS fiber. Span loss 
values assume the following:

Table 17-6 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using E-LEAF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 29 dB 21 dB 20 dB 31 dB 32 dB 28 dB 26 dB 27 dB 29 dB 26 dB

3 27 dB 17 dB 15 dB 29 dB 30 dB 26 dB 23 dB 25 dB 27 dB 23 dB

4 24 dB — — 26 dB 28 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 22 dB — — 24 dB 27 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 20 dB — — 22 dB 25 dB 19 dB — 17 dB 21 dB —

7 17 dB — — 20 dB 24 dB 16 dB — — 19 dB —

Table 17-7 Span Loss for 32-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 27 dB 20 dB 19 dB 29 dB 30 dB 26 dB 23 dB 25 dB 26 dB 23 dB

3 24 dB 17 dB 17 dB 25 dB 26 dB 23 dB 20 dB 22 dB 23 dB 20 dB

4 22 dB 15 dB 14 dB 23 dB 24 dB 21 dB 19 dB 20 dB 22 dB 19 dB

5 21 dB — — 22 dB 22 dB 20 dB 18 dB 19 dB 20 dB 18 dB

6 20 dB — — 21 dB 21 dB 19 dB 17 dB 18 dB 19 dB 17 dB

7 19 dB — — 20 dB 20 dB 18 dB 16 dB 18 dB 19 dB 16 dB
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• No OADM nodes are installed and span losses are equal.

• The DCU is 550 ps with 4 dB loss.

• Only OPT-PRE amplifiers are installed.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-9 shows the optical performance for 32-channel linear networks using E-LEAF fiber. Span loss 
values assume the following:

• No OADM nodes are installed and span losses are equal.

• The DCU is 550 ps with 4 dB loss.

• Only OPT-PRE amplifiers are installed.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-10 shows the optical performance for 16-channel linear networks using SMF fiber. Span loss 
values assume the following:

• No OADM nodes are installed and span losses are equal.

• The DCU loss is 9 dB.

• Only OPT-PRE amplifiers are installed.

Table 17-8 Span Loss for 32-Channel Linear Networks without OADM Nodes Using TW-RS Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 28 dB 20 dB 20 dB 30 dB 31 dB 27 dB 24 dB 26 dB 27 dB 24 dB

3 26 dB 18 dB 17 dB 27 dB 28 dB 24 dB 22 dB 23 dB 25 dB 22 dB

4 24 dB 15 dB 14 dB 25 dB 26 dB 23 dB 21 dB 22 dB 24 dB 20 dB

5 23 dB — — 24 dB 25 dB 22 dB 19 dB 21 dB 22 dB 19 dB

6 22 dB — — 23 dB 24 dB 20 dB 17 dB 19 dB 21 dB 17 dB

7 21 dB — — 23 dB 23 dB 19 dB 16 dB 18 dB 20 dB 16 dB

Table 17-9 Span Loss for 32-Channel Linear Networks without OADM Nodes Using E-LEAF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 37 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 28 dB 20 dB 20 dB 30 dB 31 dB 27 dB 24 dB 26 dB 27 dB 24 dB

3 25 dB 18 dB 17 dB 27 dB 28 dB 24 dB 22 dB 23 dB 25 dB 22 dB

4 24 dB 15 dB 14 dB 25 dB 26 dB 23 dB 21 dB 22 dB 24 dB 20 dB

5 23 dB — — 24 dB 25 dB 22 dB 19 dB 21 dB 22 dB 19 dB

6 21 dB — — 22 dB 24 dB 20 dB 17 dB 19 dB 21 dB 17 dB

7 20 dB — — 21 dB 23 dB 19 dB 16 dB 18 dB 20 dB 16 dB
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• The minimum channel power is 4 dBm. 

• Wavelengths are picked up without any restriction from Bands 4 and 5 (1542.14 to 1545.51 nm).

See Table 17-2 for a list of cards in each class.

Table 17-11 shows the optical performance for 8-channel linear networks with 8 dBm per channel using 
SMF fiber. Span loss values assume the following:

• No OADM nodes are installed and span losses are equal.

• The DCU loss is 9 dB.

• Only OPT-PRE amplifiers are installed.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

17.3.3 Optical Performance for ROADM Rings and Linear Networks
The following tables list the reference optical performances for ROADM rings and linear networks. 
Table 17-12 shows the optical performance for 32-channel linear or ring networks using SMF fiber with 
only ROADM nodes installed. Span loss values assume the following:

• All nodes in the ring or linear network are ROADM with equal span losses.

• The DCU loss is 9 dB.

• OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.

Table 17-10 Span Loss for 16-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 29 dB 28 dB 37 dB 37 dB 36 dB 33 dB 35 dB 37 dB 33 dB

2 32 dB 23 dB 23 dB 33 dB 34 dB 30 dB 27 dB 29 dB 31 dB 27 dB

3 28 dB 21 dB 20 dB 30 dB 30 dB 26 dB 24 dB 26 dB 27 dB 24 dB

4 26 dB 19 dB 18 dB 27 dB 28 dB 24 dB 22 dB 23 dB 25 dB 22 dB

5 24 dB 18 dB 17 dB 26 dB 26 dB 23 dB 21 dB 22 dB 24 dB 21 dB

6 23 dB 17 dB 17 dB 24 dB 25 dB 22 dB 20 dB 21 dB 22 dB 20 dB

7 22 dB 16 dB 15 dB 23 dB 24 dB 21 dB 19 dB 20 dB 21 dB 19 dB

Table 17-11 Span Loss for Eight-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 31 dB 30 dB 37 dB 37 dB 37 dB 35 dB 37 dB 37 dB 35 dB

2 34 dB 26 dB 25 dB 34 dB 34 dB 32 dB 30 dB 31 dB 33 dB 30 dB

3 31 dB 23 dB 22 dB 33 dB 34 dB 29 dB 26 dB 28 dB 30 dB 26 dB

4 29 dB — — 30 dB 31 dB 27 dB 24 dB 26 dB 28 dB 24 dB

5 27 dB — — 29 dB 30 dB 26 dB 23 dB 25 dB 26 dB 23 dB

6 — — — 27 dB — — — — — —
17-12
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 17      Network Reference
Optical Performance
See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-13 shows the optical performance for 32-channel linear or ring network with ROADM and 
OADM nodes using SMF fiber. Span loss values assume the following:

• All nodes in the ring or linear network are ROADM or OADM.

• OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.

• Span losses are equal.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 17-12 Span Loss for 32-Channel Linear or Ring Networks with all ROADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 35 dB 25 dB 25 dB 36 dB 37 dB 33 dB 30 dB 32 dB 34 dB —

2 30 dB 21 dB 20 dB 32 dB 34 dB 28 dB 25 dB 26 dB 29 dB —

3 28 dB 18 dB 17 dB 30 dB 32 dB 26 dB 23 dB 24 dB 27 dB —

4 26 dB — — 28 dB 30 dB 24 dB 21 dB 22 dB 25 dB —

5 25 dB — — 27 dB 29 dB 23 dB 20 dB 20 dB 23 dB —

6 24 dB — — 26 dB 28 dB 22 dB 18 dB 19 dB 22 dB —

7 23 dB — — 25 dB 27 dB 21 dB 14 dB 17 dB 20 dB —

8 22 dB — — 24 dB 26 dB 20 dB — — 18 dB —

9 21 dB — — 23 dB 25 dB 19 dB — — — —

10 21 dB — — 23 dB 25 dB 18 dB — — — —

11 181 dB

1. If the number of boosters is greater than 10 and power per channel is = to +1 dBm.

— — 22 dB 24 dB 17 dB — — — —

12 171 — — 21 dB 24 dB 15 dB — — — —

13 151 — — 21 dB 23 dB — — — — —

14 — — — 20 dB 23 dB — — — — —

15 — — — 20 dB 22 dB — — — — —

Table 17-13 Span Loss for 32-Channel Ring and Linear Networks with ROADM and OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 30 dB 23 dB 24 dB 31 dB 34 dB 31 dB 28 dB 29 dB 30 dB 28 dB

2 26 dB 19 dB 19 dB 27 dB 27 dB 26 dB 23 dB 26 dB 27 dB 23 dB

3 23 dB — — 25 dB 26 dB 23 dB 21 dB 23 dB 24 dB 21 dB

4 21 dB — — 23 dB 24 dB 22 dB 18 dB 21 dB 22 dB 18 dB

5 20 dB — — 22 dB 23 dB 20 dB 13 dB 20 dB 21 dB 13 dB

6 17 dB — — 19 dB 22 dB 18 dB — 17 dB 18 dB —

7 151 dB — — 17 dB 21 dB 16 dB — 151 16 dB —
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The following tables show the pass/fail criteria for eight and sixteen ROADM nodes. Table 17-14 shows 
the pass/fail criteria for eight ROADM nodes (seven spans) required for any-to-any node circuit 
reconfigurations:

• All nodes in the ring are ROADM.

• Span losses are equal.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER>10-6

Table 17-14 Pass/Fail Criteria for 32-Channel, Eight-Node ROADM Rings Using SMF Fiber

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 OPT-PRE only Yes <7 <7 Yes Yes Yes Yes Yes Yes —

2 OPT-PRE only Yes <7 <7 Yes Yes Yes Yes Yes Yes —

3 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

4 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

5 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

6 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

7 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes <7 Yes Yes —

8 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes <7 Yes Yes —

9 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

10 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

11 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

12 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

13 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —
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Table 17-15 shows the pass/fail criteria for 16 ROADM nodes (15 spans) required for any-to-any node 
circuit reconfigurations.

• All nodes in the ring are ROADM.

• Span losses are equal.

See Table 17-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

14 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

15 OPT-PRE and 
OPT-BST/
OPT-BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

Table 17-14 Pass/Fail Criteria for 32-Channel, Eight-Node ROADM Rings Using SMF Fiber (continued)

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

Table 17-15 Pass/Fail Criteria for 32-Channel, 16-Node ROADM Rings Using SMF Fiber

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

2 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

3 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

4 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

5 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

6 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

7 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

8 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

9 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

10 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

11 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

12 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —
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17.3.4 Optical Performance for Single-Span Networks
Table 17-16 lists the span loss for a single-span link configuration with eight channels. The optical 
performance for this special configuration is given only for Classes A and C. This configuration assumes 
a maximum channel capacity of eight channels (8-dBm nominal channel power) used without any 
restrictions on the 32 available channels.

Table 17-17 lists the span loss for a single-span link configuration with 16 channels. The optical 
performance for this special configuration is given only for Class A and Class C. This configuration 
assumes a maximum channel capacity of 16 channels (5-dBm nominal channel power) used without any 
restrictions on the 32 available channels.

Table 17-18 lists the span loss for a single-span link configuration with AD-1C-x.xx cards, OPT-PRE 
amplifiers, and OPT-BST/OPT-BST-E amplifiers. The single-span link with a flexible channel count is 
used both for transmitting and receiving. If dispersion compensation is required, a DCU can be used with 
an OPT-PRE amplifier. The optical performance for this special configuration is given for Classes A 
through G (8-dBm nominal channel power) used without any restrictions on the 32 available channels. 

13 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

14 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

15 OPT-PRE and 
OPT-BST/
OPT-BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

1. Cisco MetroPlanner calculates the maximum ring circumference and number of nodes that can be supported.

Table 17-15 Pass/Fail Criteria for 32-Channel, 16-Node ROADM Rings Using SMF Fiber (continued)

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

Table 17-16 Span Loss for Single-Span Link with Eight Channels

Node Configuration
Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM card 1 37 dB — 37 dB — — — —

With OSC-CSM card 1 35 dB — 35 dB — — — —

Table 17-17 Span Loss for Single-Span Link with 16 Channels

Node Configuration
Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM or 
OSC-SCM cards

1 35 dB — 35 dB — — — —
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Table 17-19 lists the span loss for a single-span link configuration with one channel and 
OPT-BST/OPT-BST-E amplifiers. The optical performance for this special configuration is given for 
Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. Classes D, E, F, and G use 
12-dBm nominal channel power. There are no restriction on the 32 available channels. That is, a line 
card, transponder, or muxponder wavelength can be extracted from the 32 available wavelengths. Also, 
the optical service channel is not required.

Table 17-20 lists the span loss for a single-span link configuration with one channel, 
OPT-BST/OPT-BST-E amplifiers, OPT-PRE amplifiers, and ONS 15216 FlexLayer filters. ONS 15216 
FlexLayer filters are used instead of the AD-1C-xx.x cards to reduce equipment costs and increase the 
span length, since the optical service channel is not necessary. The optical performance for this special 
configuration is given for Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. 
Classes D, E, F, and G use 12-dBm nominal channel power. There are no restriction on the first 16 
available wavelengths (from 1530.33 to 1544.53 nm).

17.4 Automatic Power Control
The ONS 15454 automatic power control (APC) feature performs the following functions:

• Maintains constant per-channel power when changes to the number of channels occur.

Table 17-18 Span Loss for Single-Span Link with AD-1C-xx.x Cards, OPT-PRE Amplifiers, and 

OPT-BST/OPT-BST-E Amplifiers

Node Configuration
Number 
of Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM cards1

1. OSCM sensitivity limits the performance to 37 dB.

1 37 dB 31 dB 31 dB 37 dB 37 dB 37 dB 37 dB

Hybrid with OSC-CSM 
cards2

2. OSC-CSM sensitivity limits the performance to 35 dB when it replaces the OSCM.

1 35 dB 31 dB 31 dB 35 dB 35 dB 35 dB 35 dB

Table 17-19 Span Loss for Single-Span Link with One Channel and OPT-BST Amplifiers

Number 
of Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

1 20 to 
30 dB

17 to 
26 dB

17 to 
28 dB

Unprotected 
from 29 to 41 dB

Protected from 
25 to 41 dB

Unprotected 
from 28 to 37 dB

Protected from 
24 to 40 dB

Unprotected 
from 21 to 34 dB

Protected from 
18 to 34 dB

From 23 
to 36 dB

Table 17-20 Span Loss for Single-Span Link with One Channel, OPT-BST/OPT-BST-E Amplifiers, 

OPT-PRE Amplifiers, and ONS 15216 FlexLayer Filters

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B1 Class C1 Class D1 Class E1 Class F1 Class G1

1x 38 dB 30 dB 30 dB 44 dB 40 dB 38 dB 40 dB
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• Compensates for optical network degradation (aging effects).

• Simplifies the installation and upgrade of DWDM optical networks by automatically calculating the 
amplifier setpoints.

Note APC functions are performed by software algorithms on the OPT-BST, OPT-PRE, and TCC2/TCC2P 
cards.

Amplifier software uses a control gain loop with fast transient suppression to keep the channel power 
constant regardless of any changes in the number of channels. Amplifiers monitor the changes to the 
input power and change the output power according to the calculated gain setpoint. The shelf controller 
software emulates the control output power loop to adjust for fiber degradation. To perform this function, 
the TCC2/TCC2P needs to know the channel distribution, which is provided by a signaling protocol, and 
the expected per-channel power, which you can provision. The TCC2/TCC2P compares the actual 
amplifier output power with the expected amplifier output power and modifies the setpoints if any 
discrepancies occur.

17.4.1 APC at the Amplifier Card Level
In constant gain mode, the amplifier power out control loop performs the following input and output 
power calculations, where G represents the gain and t represents time.

Pout (t) = G * Pin (t) (mW)

Pout (t) = G + Pin (t) (dB)

In a power-equalized optical system, the total input power is proportional to the number of channels. The 
amplifier software compensates for any variation of the input power due to changes in the number of 
channels carried by the incoming signal. 

Amplifier software identifies changes in the read input power in two different instances, t1 and t2 as a 
change in the carried traffic. The letters m and n in the following formula represent two different channel 
numbers. Pin/ch represents the per-channel input power:

Pin (t1)= nPin/ch

Pin (t2) = mPin/ch

Amplifier software applies the variation in the input power to the output power with a reaction time that 
is a fraction of a millisecond. This keeps the power constant on each channel at the output amplifier, even 
during a channel upgrade or a fiber cut.

Amplifier parameters are configured using east and west conventions for ease of use. Selecting west 
provisions parameters for the preamplifier receiving from the west and the booster amplifier transmitting 
to the west. Selecting east provisions parameters for the preamplifiers receiving from the east and the 
booster amplifier transmitting to the east. 

Starting from the expected per-channel power, the amplifiers automatically calculate the gain setpoint 
after the first channel is provisioned. An amplifier gain setpoint is calculated in order to make it equal 
to the loss of the span preceding the amplifier itself. After the gain is calculated, the setpoint is no longer 
changed by the amplifier. Amplifier gain is recalculated every time the number of provisioned channels 
returns to zero. If you need to force a recalculation of the gain, move the number of channels back to 
zero.
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17.4.2 APC at the Node and Network Levels
The amplifier adjusts the gain to compensate for span loss. Span loss changes due to aging fiber and 
components, or changes in operating conditions. To correct the gain or express variable optical 
attenuator (VOA) setpoints, APC calculates the difference between the power value read by the 
photodiodes and the expected power value. The expected power values is calculated using:

• Provisioned per-channel power value

• Channel distribution (the number of express, add, and drop channels in the node)

• ASE estimation

Channel distribution is determined by the sum of the provisioned and failed channels. Information about 
provisioned wavelengths is sent to APC on the applicable nodes during circuit creation. Information 
about failed channels is collected through a signaling protocol that monitors alarms on ports in the 
applicable nodes and distributes that information to all the other nodes in the network.

ASE calculations purify the noise from the power level reported from the photodiode. Each amplifier can 
compensate for its own noise, but cascaded amplifiers cannot compensate for ASE generated by 
preceding nodes. The ASE effect increases when the number of channels decreases; therefore, a 
correction factor must be calculated in each amplifier of the ring to compensate for ASE build-up.

APC is a network-level feature. The APC algorithm designates a master node that is responsible for 
starting APC hourly or every time a new circuit is provisioned or removed. Every time the master node 
signals for APC to start, gain and VOA setpoints are evaluated on all nodes in the network. If corrections 
are needed in different nodes, they are always performed sequentially following the optical paths starting 
from the master node.

APC corrects the power level only if the variation exceeds the hysteresis thresholds of +/– 0.5 dB. Any 
power level fluctuation within the threshold range is skipped since it is considered negligible. Because 
APC is designed to follow slow time events, it skips corrections greater than 3 dB. This is the typical 
total aging margin that is provisioned during the network design phase. After you provision the first 
channel or the amplifiers are turned up for the first time, APC does not apply the 3 dB rule. In this case, 
APC corrects all the power differences to turn up the node. 

Note Software R5.0 does not report corrections that are not performed and exceed the 3 dB correction factor 
to Cisco Transport Controller (CTC), Cisco Transport Manager (CTM), and Transaction Language One 
(TL1) management interfaces.

To avoid large power fluctuations, APC adjusts power levels incrementally. The maximum power 
correction is +/– 0.5 dB. This is applied to each iteration until the optimal power level is reached. For 
example, a gain deviation of 2 dB is corrected in four steps. Each of the four steps requires a complete 
APC check on every node in the network. APC can correct up to a maximum of 3 dB on an hourly basis. 
If degradation occurs over a longer time period, APC will compensate for it by using all margins that 
you provision during installation.

When no margin is available, adjustments cannot be made because setpoints exceed ranges. APC 
communicates the event to CTC, CTM, and TL1 through an APC Fail condition. APC will clear the APC 
fail condition when the setpoints return to the allowed ranges.

APC automatically disables itself when:

• A HW FAIL alarm is raised by any card in any of the network nodes.

• A Mismatch Equipment Alarm (MEA) is raised by any card in any of the network nodes.

• An Improper Removal alarm is raised by any card in any of the network nodes.
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• Gain Degrade, Power Degrade, and Power Fail Alarms are raised by the output port of any amplifier 
card in any of the network nodes.

• A VOA degrade or fail alarm is raised by any of the cards in any of the network nodes.

The APC state (Enable/Disable) is located on every node and can be retrieved by the CTC or TL1 
interfaces. If an event that disables APC occurs in one of the network nodes, APC is disabled on all the 
others and the APC state changes to DISABLE - INTERNAL. The disabled state is raised only by the 
node where the problem occurred to simplify troubleshooting. 

APC raises the following standing conditions at the port level in CTC, TL1, and SNMP:

• APC Out of Range—APC cannot assign a new setpoint for a parameter this is allocated to a port 
because the new setpoint exceeds the parameter range.

• APC Correction Skipped—APC skipped a correction to one parameter allocated to a port because 
the difference between the expected and current values exceeds the +/– 3 dB security range.

After the error condition is cleared, signaling protocol enables APC on the network and the APC 
DISABLE - INTERNAL condition is cleared. Because APC is required after channel provisioning to 
compensate for ASE effects, all optical channel network connection (OCHNC) circuits that you 
provision during the disabled APC state are kept in the Out-of-Service and Autonomous, Automatic 
In-Service (OOS-AU,AINS [ANSI]) or Unlocked-disabled,automaticInService (ETSI) service state 
until APC is enabled. OCHNCs automatically go into the In-Service and Normal (IS-NR [ANSI]) or 
Unlocked-enabled (ETSI) service state only after APC is enabled.

17.4.3 Managing APC
The automatic power control status is indicated by four APC states shown in the node view status area:

• Enable—APC is enabled.

• Disable - Internal—APC has been automatically disabled for an internal cause.

• Disable - User—APC was disabled manually by a user. 

• Not Applicable—The node is provisioned to Metro Access or Not DWDM, which do not support 
APC.

You can view the automatic power control information and disable and enable APC manually on the 
Maintenance > DWDM > APC subtab (Figure 17-8). 

Caution When APC is disabled, aging compensation is not applied and circuits cannot be activated. Do not 
disable APC unless it is required for specific maintenance or troubleshooting tasks. Always enable APC 
as soon as the tasks are completed.
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Figure 17-8 Automatic Power Control

The APC subtab provides the following information:

• Slot ID—The ONS 15454 slot number for which APC information is shown.

• Port—The port number for which APC information is shown.

• Card—The card for which power control information is shown.

• Last Modification—Date and time APC last modified a setpoint for the parameters shown in 
Table 17-21. 

• Last Check—Date and time APC last verified the setpoints for the parameters shown in Table 17-21.

APC State

13
46

72

Table 17-21 APC-Managed Parameters

Card Port Parameters

OPT-BST LINE-3-TX • Gain

• Total Signal Output Power

OPT-PRE LINE-1-TX • Gain

• Total Signal Output Power

AD-xB-xx.x LINE-1-TX

BAND-i-TX

VOA Target Attenuation
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17.5 ROADM Power Equalization Monitoring
Reconfigurable OADM (ROADM) nodes allow you to monitor the 32WSS card equalization functions 
on the Maintenance > DWDM > Power Monitoring subtab (Figure 17-9). The tab shows the input 
channel power (Padd), the express or pass-through (Ppt) power and the power level at output (Pout).

Figure 17-9 Power Monitoring Subtab

AD-1C-xx.x

AD-2C-xx.x

LINE-1-TX VOA Target Attenuation

AD-4C-xx.x LINE-1-TX

CHAN-i-TX

VOA Target Attenuation

32-DMX LINE-1-TX VOA Target Attenuation

Table 17-21 APC-Managed Parameters (continued)

Card Port Parameters
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17.6 Span Loss Verification
Span loss measurements can be performed from the Maintenance > DWDM > WDM Span Check subtab 
(Figure 17-10). The CTC span check compares the far-end OSC power with the near-end OSC power. A 
“Span Loss Out of Range” condition is raised when the measured span loss is higher than the maximum 
expected span loss. It is also raised when the measured span loss is lower than the minimum expected 
span loss and the difference between the minimum and maximum span loss values is greater than 1 dB. 
The minimum and maximum expected span loss values are calculated by Cisco MetroPlanner for the 
network and imported into CTC. However, you can manually change the minimum and expected span 
loss values.

CTC span loss measurements provide a quick span loss check and are useful whenever changes to the 
network occur, for example after you install equipment or repair a broken fiber. CTC span loss 
measurement resolutions are:

• +/– 1.5 dB for measured span losses between 0 and 25 dB

• +/– 2.5 dB for measured span losses between 25 and 38 dB

For ONS 15454 span loss measurements with higher resolutions, an optical time domain reflectometer 
(OTDR) must be used. 

Figure 17-10 Span Loss Verification
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17.7 Network Optical Safety––Automatic Laser Shutdown
Automatic laser shutdown (ALS) is a technique used to automatically shut down the output power of 
OSC laser transmitters (contained in the OSCM and OSC-CSM cards) and optical amplifiers (contained 
in OPT-BST cards) in the event of a fiber break. Cards with OSC laser transmitters and optical amplifiers 
(OPT-BST only) can be provisioned as follows with respect to ALS:

• Disable: ALS is off; the laser and optical amplifiers (OPT-BST only) is not automatically shut down 
when a traffic outage loss of signal (LOS) occurs

• Auto Restart: ALS is on. The laser and optical amplifiers (OPT-BST only) automatically shuts down 
when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the 
outage are resolved.

Note Auto Restart is the default ALS provisioning.

• Manual Restart: ALS is on. The laser and optical amplifiers (OPT-BST only) automatically shuts 
down when traffic outages (LOS) occur. However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser and optical amplifiers (OPT-BST only) for 
testing.

In the following paragraphs, two ALS scenarios are given:

• Nodes using OPT-BST cards (amplified nodes)

• Nodes using OSC-CSM cards (passive nodes)

17.7.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST/OPT-BST-E Cards
Figure 17-11 shows nodes using OPT-BST/OPT-BST-E cards with a fiber cut between them.
17-24
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Chapter 17      Network Reference
Network Optical Safety––Automatic Laser Shutdown
Figure 17-11 Nodes Using OPT-BST/OPT-BST-E Cards

Two photodiodes at Node B monitor the received signal strength for the optical payload and optical 
service channel (OSC) signals. When the fiber is cut, a loss of signal (LOS) is detected at both of the 
photodiodes. The AND function then indicates an overall LOS condition, which causes the 
OPT-BST/OPT-BST-E transmitter, OPT-PRE transmitter, and OSCM lasers to shut down. This in turn 
leads to a LOS for both the optical payload and OSC at Node A, which causes Node A to turn off the 
OSCM, OPT-PRE transmitter, and OPT-BST/OPT-BST-E transmitter lasers. The sequence of events 
after a fiber cut is as follows (refer to the numbered circles in Figure 17-11):

1. Fiber is cut.

2. Node B power monitoring photodiode detects a Loss of Incoming Overhead (LOS-O) on the 
OPT-BST/OPT-BST-E card and the OSCM card detects a LOS (OC3) at the SONET layer. Refer to 
the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

3. Node B power monitoring photodiode detects a Loss of Incoming Payload (LOS-P) on the 
OPT-BST/OPT-BST-E card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 
15454 SDH Troubleshooting Guide.

4. On the OPT-BST/OPT-BST-E card, the simultaneous LOS-O and LOS-P detection triggers a 
command to shut down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O 
and LOS-P are demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 
15454 SDH Troubleshooting Guide.

5. The OPT-BST/OPT-BST-E card amplifier is shut down within three seconds.

6. The OSCM laser is shut down.

7. The OPT-PRE card automatically shuts down due to a loss of incoming optical power 

OPT-BST/OPT-BST-E OPT-BST/OPT-BST-E

P

P

P

OSCM

PP
OSCM

= power monitoring photodiode

= logical AND function

Node A
Side B

Node B
Side A

X
11

1

7

13

10

9 8

12

6

2 3

4

5

2

8

12
09

88

OPT-PRE

OPT-PRE
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8. Node A power monitoring photodiode detects a LOS-O on the OPT-BST/OPT-BST-E card and the 
OSCM card detects a LOS (OC3) at the SONET layer. Refer to the Cisco ONS 15454 
Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

9. Node A power monitoring photodiode detects a LOS-P on the OPT-BST/OPT-BST-E card. Refer to 
the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

10. On the OPT-BST, the simultaneous LOS-O and LOS-P detection triggers a command to shut down 
the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are demoted. 
Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

11. The OPT-BST/OPT-BST-E card amplifier is shut down within three seconds.

12. The OSCM laser is shut down.

Note The shutdown of the OPT-BST/OPT-BST-E and OSCM cards, which launch power into the cut 
fiber, achieves the aim of the Network Optical Safety feature.

13. The node A OPT-PRE card automatically shuts down due to a loss of incoming optical power.

When the fiber is repaired, either an automatic or manual restart at the Node A OPT-BST/OPT-BST-E 
transmitter or at the Node B OPT-BST/OPT-BST-E transmitter is required. A system that has been shut 
down is reactivated through the use of a restart pulse. The pulse is used to signal that the optical path has 
been restored and transmission can begin. For example, when the far end, Node B, receives a pulse, it 
signals to the Node B OPT-BST/OPT-BST-E transmitter to begin transmitting an optical signal. The 
OPT-BST/OPT-BST-E receiver at Node A receives that signal and signals the Node A 
OPT-BST/OPT-BST-E transmitter to resume transmitting.

Note During a laser restart pulse, automatic power reduction (APR) is disabled and the laser power does not 
exceed Class 1 limits.

17.7.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards
Figure 17-12 shows nodes using OSC-CSM cards with a fiber cut between them.
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Figure 17-12 Nodes Using OSC-CSM Cards

Two photodiodes at the Node B OSC-CSM card monitor the received signal strength for the received 
optical payload and OSC signals. When the fiber is cut, LOS is detected at both of the photodiodes. The 
AND function then indicates an overall LOS condition, which causes the Node B OSC laser to shut down 
and the optical switch to block traffic. This in turn leads to LOS for both the optical payload and OSC 
signals at Node A, which causes Node A to turn off the OSC laser and the optical switch to block 
outgoing traffic. The sequence of events after a fiber cut is as follows (refer to the numbered circles in 
Figure 17-12):

1. Fiber is cut.

2. Node B power monitoring photodiode detects a LOS-O on the OSC-CSM card. Refer to the Cisco 
ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

3. Node B power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the Cisco 
ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

4. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position 
of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

5. The optical switch blocks outgoing traffic.

6. The OSC laser is shut down.

7. Node A power monitoring photodiode detects a LOS-O on the OSC-CSM card. Refer to the Cisco 
ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
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8. Node A power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the Cisco 
ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

9. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position 
of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH 
Troubleshooting Guide.

10. The OSC laser is shut down.

11. The optical switch blocks outgoing traffic.

When the fiber is repaired, either an automatic or manual restart at the Node A OSC-CSM OSC or at the 
Node B OSC-CSM OSC is required. A system that has been shut down is reactivated through the use of 
a restart pulse. The pulse is used to signal that the optical path has been restored and transmission can 
begin. For example, when the far-end Node B receives a pulse, it signals to the Node B OSC to begin 
transmitting its optical signal and for the optical switch to pass incoming traffic. The OSC-CSM at Node 
A then receives the signal and tells the Node A OSC to resume transmitting and for the optical switch to 
pass incoming traffic.

17.8 Network-Level Gain—Tilt Management of Optical 
Amplifiers

The ability to control and adjust per channel optical power equalization is a principal feature of 
ONS 15454 DWDM Metro-Core network applications. A critical parameter to assure optical spectrum 
equalization throughout the DWDM system is the gain flatness of EDFA amplifiers.

Two items, gain tilt and gain ripple, are factors in the power equalization of optical amplifier cards such 
as the OPT-BST/OPT-BST-E or OPT-PRE. Figure 17-13 is a graph of the amplifier output power 
spectrum and how it is affected by gain tilt and gain ripple.
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Figure 17-13 Effect of Gain Ripple and Gain Tilt on Amplifier Output Power

Gain ripple and gain tilt are defined as follows:

• Gain Ripple is random and depends on the spectral shape of the amplifier optical components.

• Gain Tilt is systematic and depends on the gain setpoint (Gstp) of the optical amplifier, which is a 
mathematical function F(Gstp) that relates to the internal amplifier design.

Gain tilt is the only contribution to the power spectrum disequalization that can be compensated at the 
card level. A Variable Optical Attenuator (VOA) internal to the amplifier can be used to compensate for 
gain tilt.

An Optical Spectrum Analyzer (OSA) device is used to acquire the output power spectrum of an 
amplifier. The OSA shows the peak-to-peak difference between the maximum and minimum power 
levels, and takes into account the contributions of both gain tilt and gain ripple.

Note Peak-to-peak power acquisition using an OSA cannot be used to “measure” the Gain Tilt, because gain 
ripple itself is a component of the actual measurement.

17.8.1 Gain Tilt Control at the Card Level
The OPT-BST/OPT-BST-E and OPT-PRE amplifier cards have a “flat” output (gain tilt = 0 dB) for only 
a specific gain value (Gdesign), based on the internal optical design (see Figure 17-14).
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Figure 17-14 Flat Gain (Gain Tilt = 0 dB)

If the “working” gain setpoint of the amplifier is different from Gdesign, the output spectrum begins to 
suffer a gain tilt variation.

In order to compensate for the absolute value of the increase of the spectrum tilt, the 
OPT-BST/OPT-BST-E and OPT-PRE cards automatically adjust the attenuation of the VOA to maintain 
a flat power profile at the output, as shown in Figure 17-15.

Figure 17-15 Effect of VOA Attenuation on Gain Tilt

The VOA attenuator automatic regulation guarantees (within limits) a “zero tilt” condition in the EDFA 
amplifier for a wide range of possible gain setpoint values.
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Table 17-22 shows the “flat output” gain range limits for the OPT-BST/OPT-BST-E and OPT-PRE cards, 
as well as the maximum (worst case) values of gain tilt and gain ripple expected in the specific gain 
range.

If the “operating” gain value is outside of the range shown in Table 17-22, the EDFA amplifier 
introduces a tilt contribution for which the card itself cannot directly compensate. This condition is 
managed in different ways, depending the amplifier card type:

• OPT-BST/OPT-BST-E. The OPT-BST/OPT-BST-E amplifier is, by card design, not allowed to work 
outside the “zero tilt” range. The MetroPlanner tool validates network designs using the 
OPT-BST/OPT-BST-E amplifier card only when the gain is less than or equal to 20 dB.

• OPT-PRE. The MetroPlanner tool allows network designs even if the operating gain value is equal 
to or greater than 21 dB. In this case, a system-level tilt compensation strategy is adopted by the 
DWDM system. A more detailed explanation is given in the following section.

17.8.2 System Level Gain Tilt Control
System level gain tilt control for OPT-PRE cards is achievable with two main scenarios:

• Without a reconfigurable optical add-drop multiplexer (ROADM) node

• With a ROADM node

17.8.2.1 System Gain Tilt Compensation Without ROADM Nodes

When an OPT-PRE card along a specific line direction (West to East or East to West) is working outside 
the “flat output” gain range (G > 21 dB), the unregulated tilt is compensated for in spans not facing 
ROADM nodes by configuring an equal but opposite tilt on one or more of the amplifiers in the 
downstream direction. The number of downstream amplifiers involved depends on the amount of tilt 
compensation needed and the gain setpoint of the amplifiers that are involved. See Figure 17-16.

Table 17-22 Flat Output Gain Range Limits

Amplifier 
Card Type

Flat Output
Gain Range

Gain Tilt 
(Maximum)

Gain Ripple 
(Maximum)

OPT-BST/
OPT-BST-E

G < 20 dB 0.5 dB 1.5 dB

OPT-PRE G < 21 dB 0.5 dB 1.5 dB
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Figure 17-16 System Tilt Compensation Without a ROADM

The proper Tilt Reference value is calculated by MetroPlanner and inserted in the Installation Parameter 
List imported during the Node Turn-Up procedure (see “NTP-G138 Import a Cisco MetroPlanner 
Configuration File” task on page 3-72). For both OPT-PRE and OPT-BST/OPT-BST-E cards, the 
provisionable Gain Tilt Reference range is between –3 dB and +3 dB.

During the Automatic Node Setup (ANS) procedure, the Tilt value for the OPT-BST/OPT-BST-E or 
OPT-PRE card is provisioned by the TCC card (see Figure 17-17). The provisi1

oned Tilt Reference Value is reported in the CTC OPT-PRE or OPT-BST/OPT-BST-E card view 
(Provisioning > Opt.Ampli.Line > Parameters > Tilt Reference).
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Figure 17-17 MetroPlanner Installation Parameters

17.8.2.2 System Gain Tilt Compensation With ROADM Nodes

When an ROADM Node is present in the network, as shown in Figure 17-18, a per-channel dynamic gain 
equalization can be performed. Both gain tilt and gain ripple are completely compensated using the 
following techniques:

• Implementing the per-channel VOAs present inside the 32-WSS, and

• Operating in Power Control Mode with the specific power setpoint designed by MetroPlanner.
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Figure 17-18 System Tilt Compensation With a ROADM
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C H A P T E R 18

CTC Operation Reference

This chapter describes Cisco Transport Controller (CTC), the software interface for the 
Cisco ONS 15454. For CTC setup and login information, see Chapter 2, “Connect the PC and Log into 
the GUI.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 18.1 CTC Software Delivery Methods, page 18-1

• 18.2 CTC Installation Overview, page 18-3

• 18.3 PC and UNIX Workstation Requirements, page 18-4

• 18.4 ONS 15454 Connections, page 18-6

• 18.5 CTC Window, page 18-7

• 18.6 TCC2/TCC2P Card Reset, page 18-14

• 18.7 TCC2/TCC2P Card Database, page 18-15

• 18.8 Software Revert, page 18-15

18.1 CTC Software Delivery Methods
ONS 15454 provisioning and administration is performed using the CTC software. CTC is a Java 
application that is installed in two locations: it is stored on the TCC2 or TCC2P card and it is downloaded 
to your workstation the first time you log into the ONS 15454 with a new software release.

18.1.1 CTC Software Installed on the TCC2/TCC2P Card
CTC software is preloaded on the ONS 15454 TCC2/TCC2P cards; therefore, you do not need to install 
software on the TCC2/TCC2P cards. When a new CTC software version is released, use the 
release-specific software upgrade document to upgrade the ONS 15454 software on the TCC2/TCC2P 
card. 
18-1
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When you upgrade CTC software, the TCC2/TCC2P cards store the new CTC version as the protect CTC 
version. When you activate the new CTC software, the TCC2/TCC2P cards store the older CTC version 
as the protect CTC version, and the newer CTC release becomes the working version. You can view the 
software versions that are installed on an ONS 15454 by selecting the Maintenance > Software tabs in 
node view (Figure 18-1). 

Figure 18-1 CTC Software Versions, Node View

Select the Maintenance > Software tabs in network view to display the software versions installed on all 
the network nodes (Figure 18-2).
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Figure 18-2 CTC Software Versions, Network View

18.1.2 CTC Software Installed on the PC or UNIX Workstation
CTC software is downloaded from the TCC2/TCC2P cards and installed on your computer automatically 
after you connect to the ONS 15454 with a new software release for the first time. Downloading the CTC 
software files automatically ensures that your computer is running the same CTC software version as the 
TCC2/TCC2P cards you are accessing. The CTC files are stored in the temporary directory designated 
by your computer operating system. You can use the Delete CTC Cache button to remove files stored in 
the temporary directory. If the files are deleted, they download the next time you connect to an ONS 
15454. Downloading the Java archive (JAR) files for CTC takes several minutes depending on the 
bandwidth of the connection between your workstation and the ONS 15454. For example, JAR files 
downloaded from a modem or a data communications channel (DCC) network link require more time 
than JAR files downloaded over a LAN connection.

18.2 CTC Installation Overview
To connect to an ONS 15454 using CTC, you enter the ONS 15454 IP address in the URL field of 
Netscape Navigator or Microsoft Internet Explorer. After connecting to an ONS 15454, the following 
occurs automatically:

1. A CTC launcher applet is downloaded from the TCC2/TCC2P card to your computer.

2. The launcher determines whether your computer has a CTC release matching the release on the 
ONS 15454 TCC2/TCC2P card. 
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3. If the computer does not have CTC installed, or if the installed release is older than the 
TCC2/TCC2P card’s version, the launcher downloads the CTC program files from the TCC2/TCC2P 
card.

4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web 
browser is no longer needed. Always log into nodes having the latest software release. If you log 
into an ONS 15454 that is connected to ONS 15454s with older versions of CTC, or to 
Cisco ONS 15327s or Cisco ONS 15600s, CTC files are downloaded automatically to enable you to 
interact with those nodes. The CTC file download occurs only when necessary, such as during your 
first login. You cannot interact with nodes on the network that have a software version later than the 
node that you used to launch CTC.

Each ONS 15454 can handle up to five concurrent CTC sessions. CTC performance can vary, depending 
upon the volume of activity in each session, network bandwidth, and TCC2/TCC2P card load.

Note You can also use TL1 commands to communicate with the Cisco ONS 15454 through VT100 terminals 
and VT100 emulation software, or you can telnet to an ONS 15454 using TL1 port 3083. Refer to the 
Cisco ONS SONET TL1 Command Guide or Cisco ONS 15454 SDH TL1 Command Guide for a 
comprehensive list of TL1 commands. 

18.3 PC and UNIX Workstation Requirements
To use CTC for the ONS 15454, your computer must have a web browser with the correct Java Runtime 
Environment (JRE) installed. The correct JRE for each CTC software release is included on the 
Cisco ONS 15454 software CD and the ONS 15454 documentation CD. If you are running multiple CTC 
software releases on a network, the JRE installed on the computer must be compatible with the different 
software releases. 

When you change the JRE version on the JRE tab, you must exit and restart CTC for the new JRE version 
to take effect. Table 18-1 shows JRE compatibility with ONS 15454 software releases.

Table 18-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java 
plug-in and modified java.policy file are also included on the ONS 15454 software CD and the ONS 
15454 documentation CD.

Table 18-1 JRE Compatibility

ONS Software Release JRE 1.2.2 Compatible JRE 1.3 Compatible JRE 1.4 Compatible

ONS 15454 Release 4.1 No Yes No

ONS 15454 Release 4.5 No Yes No

ONS 15454 Release 4.6 No Yes Yes

ONS 15454 Release 4.7 No No Yes

ONS 15454 Release 5.0 No No Yes
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Table 18-2 Computer Requirements for CTC

Area Requirements Notes

Processor Pentium III 700 MHz, UltraSPARC, or 
equivalent

700 MHz is the recommended 
processor speed. You can use 
computers with a lower processor 
speed; however, you might experience 
longer response times and slower 
performance.

RAM 384 MB RAM recommended, 512 MG RAM 
optimum

—

Hard drive 20 GB hard drive with 50 MB of space 
available

—

Operating 
System

• PC: Windows 98 (1st and 2nd editions), 
Windows ME, Windows NT 4.0 (with 
Service Pack 6a), Windows 2000 (with 
Service Pack 3), or Windows XP Home

• Workstation: Solaris versions 8 or 9

—

Java Runtime 
Environment

JRE 1.4.2 JRE 1.4.2 is installed by the CTC 
Installation Wizard included on the 
Cisco ONS 15454 software and 
documentation CDs. JRE 1.4.2 
provides enhancements to CTC 
performance, especially for large 
networks with numerous circuits.

If CTC must be launched directly from 
nodes running software earlier than 
R4.6, uninstall JRE 1.4.2 and reinstall 
JRE 1.3.1_02, then, to run R5.0, 
uninstall JRE 1.3.1_02 and reinstall 
JRE 1.4.2.

Web browser Netscape 7.x or Internet Explorer 6.x Netscape 7.x is available at the 
following site: 
http://channels.netscape.com/ns/brows
ers/default.jsp

Internet Explorer 6.x is available at the 
following site: 
http://www.microsoft.com

Cable User-supplied CAT-5 straight-through cable 
with RJ-45 connectors on each end to 
connect the computer to the ONS 15454 
directly or through a LAN

—
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18.4 ONS 15454 Connections
You can connect to the ONS 15454 in multiple ways. You can connect your PC directly to the ONS 15454 
(local craft connection) using the RJ-45 port on the TCC2/TCC2P card or, for the ANSI shelf, the LAN 
pins on the backplane (the ETSI shelf provides a LAN connection via the RJ-45 jack on the MIC-T/C/P 
FMEC). Alternatively, you can connect your PC to a hub or switch that is connected to the ONS 15454, 
connect to the ONS 15454 through a LAN or modem, or establish TL1 connections from a PC or TL1 
terminal. Table 18-3 lists the ONS 15454 connection methods and requirements.

Table 18-3 ONS 15454 Connection Methods

Method Description Requirements

Local craft Refers to onsite network connections 
between the CTC computer and the 
ONS 15454 using one of the following:

• The RJ-45 (LAN) port on the 
TCC2/TCC2P card

• The LAN pins on the ONS 15454 
backplane (ANSI)

• The RJ-45 jack on the MIC-T/C/P 
FMEC (ETSI)

• A hub or switch to which the ONS 15454 
is connected

If you do not use Dynamic Host 
Configuration Protocol (DHCP), you must 
change the computer IP address, subnet 
mask, and default router, or use automatic 
host detection. 

Corporate 
LAN

Refers to a connection to the ONS 15454 
through a corporate or network operations 
center (NOC) LAN.

• The ONS 15454 must be provisioned 
for LAN connectivity, including IP 
address, subnet mask, and default 
gateway.

• The ONS 15454 must be physically 
connected to the corporate LAN.

• The CTC computer must be connected 
to the corporate LAN that has 
connectivity to the ONS 15454.

TL1 Refers to a connection to the ONS 15454 
using TL1 rather than CTC. TL1 sessions can 
be started from CTC, or you can use a TL1 
terminal. The physical connection can be a 
craft connection, corporate LAN, or a TL1 
terminal. 

Refer to the Cisco ONS 15454 and Cisco 
ONS 15327 TL1 Command Guide.

Remote Refers to a connection made to the 
ONS 15454 using a modem.

• A modem must be connected to the 
ONS 15454.

• The modem must be provisioned for 
the ONS 15454. To run CTC, the 
modem must be provisioned for 
Ethernet access.
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18.5 CTC Window
The CTC window appears after you log into an ONS 15454 (Figure 18-3). The window includes a menu 
bar, a toolbar, and a top and bottom pane. The top pane provides status information about the selected 
objects and a graphic of the current view. The bottom pane provides tabs and subtab to view ONS 15454 
information and perform ONS 15454 provisioning and maintenance. From this window, you can display 
three ONS 15454 views: network, node, and card. 

Figure 18-3 Node View (Default Login View)

18.5.1 Node View
Node view, shown in Figure 18-3, is the first view that appears after you log into an ONS 15454. The 
login node is the first node shown, and it is the “home view” for the session. Node view allows you to 
manage one ONS 15454 node. The status area shows the node name; IP address; session boot date and 
time; number of Critical (CR), Major (MJ), and Minor (MN) alarms; name and security level of the 
current logged-in user; software version; and network element default setup. 

18.5.1.1 CTC Card Colors

The graphic area of the CTC window depicts the ONS 15454 shelf assembly. The colors of the cards in 
the graphic reflect the real-time status of the physical card and slot (Table 18-4).
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Table 18-4 Node View Card Colors

Card Color Status

Gray Slot is not provisioned; no card is installed.

Violet Slot is provisioned; no card is installed.
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On the ONS 15454 ETSI, the colors of the Front Mount Electrical Connection (FMEC) cards reflect the 
real-time status of the physical FMEC cards. Table 18-5 lists the FMEC card colors. The FMEC ports 
shown in CTC do not change color.

Note You cannot preprovision FMECs. 

The wording on a card in node view shows the status of a card (Active, Standby, Loading, or 
Not Provisioned). Table 18-6 lists the card statuses.

Port color in both card and node view indicates the port service state. Table 18-7 lists the port colors and 
their service states. For more information about port service states, refer to Appendix C, “DWDM 
Administrative and Service States.”

White Slot is provisioned; a functioning card is installed.

Yellow Slot is provisioned; a Minor alarm condition exists.

Orange Slot is provisioned; a Major alarm condition exists.

Red Slot is provisioned; a Critical alarm exists.

Table 18-4 Node View Card Colors (continued)

Card Color Status

Table 18-5 Node View FMEC Color 

Upper Shelf FMEC Color Status

White Functioning card is installed.

Yellow Minor alarm condition exists.

Orange (Amber) Major alarm condition exists.

Red Critical alarm exists.

Table 18-6 Node View Card Statuses

Card Status Description

Sty Card is in standby mode.

Act Card is active.

NP Card is not present.

Ldg Card is resetting.
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Figure 18-4 Terminal Loopback Indicator

Table 18-7 Node View Card Port Colors and Service States

Port Color Service State Description

Cyan (blue) Out-of-Service and Management, Loopback 
(OOS-MA,LPBK [ANSI])

Locked-enabled,loopback (ETSI)

Port is in a loopback state. On the card in node view, a 
line between ports indicates that the port is in terminal or 
facility loopback (see Figure 18-4 and Figure 18-5). 
Traffic is carried and alarm reporting is suppressed. 
Raised fault conditions, whether or not their alarms are 
reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command. 

Cyan (blue) Out-of-Service and Management, Maintenance 
(OOS-MA,MT [ANSI])

Locked-enabled,maintenance (ETSI)

Port is out-of-service for maintenance. Traffic is carried 
and loopbacks are allowed. Alarm reporting is 
suppressed. Raised fault conditions, whether or not their 
alarms are reported, can be retrieved on the CTC 
Conditions tab or by using the TL1 RTRV-COND 
command. Use this service state for testing or to suppress 
alarms temporarily. Change the state to 
IS-NR/Unlocked-enabled; 
OOS-MA,DSBLD/Locked-enabled,disabled; or 
OOS-AU,AINS/Unlocked-disabled,automaticInService 
when testing is complete.

Gray Out-of-Service and Management, Disabled 
(OOS-MA,DSBLD [ANSI])

Locked-enabled,disabled (ETSI)

The port is out-of-service and unable to carry traffic. 
Loopbacks are not allowed in this service state. 

Green In-Service and Normal (IS-NR [ANSI])

Unlocked-enabled (ETSI)

The port is fully operational and performing as 
provisioned. The port transmits a signal and displays 
alarms; loopbacks are not allowed. 

Violet Out-of-Service and Autonomous, Automatic 
In-Service (OOS-AU,AINS [ANSI])

Unlocked-disabled,automaticInService (ETSI)

The port is out-of-service, but traffic is carried. Alarm 
reporting is suppressed. The node monitors the ports for 
an error-free signal. After an error-free signal is detected, 
the port stays in this service state for the duration of the 
soak period. After the soak period ends, the port service 
state changes to IS-NR/Unlocked-enabled. 

Raised fault conditions, whether or not their alarms are 
reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command. The AINS 
port will automatically transition to 
IS-NR/Unlocked-enabled when a signal is received for 
the length of time provisioned in the soak field.
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Figure 18-5 Facility Loopback Indicator

18.5.1.2 Node View Card Shortcuts

If you move your mouse over cards in the graphic, popups display additional information about the card 
including the card type; the card status (active or standby); the type of alarm, such as Critical, Major, or 
Minor (if any); the alarm profile used by the card; and for transponder (TXP) or muxponder (MXP) 
cards, the wavelength of the dense wavelength division multiplexing (DWDM) port. Right-click a card 
to reveal a shortcut menu, which you can use to open, reset, delete, or change a card. Right-click a slot 
to preprovision a card (that is, provision a slot before installing the card). 

18.5.1.3 Node View Tabs

Table 18-8 lists the tabs and subtabs available in the node view.

Table 18-8 Node View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the node 
and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
node.

—

History Provides a history of node alarms including date, 
type, and severity of each alarm. The Session 
subtab displays alarms and events for the current 
session. The Node subtab displays alarms and 
events retrieved from a fixed-size log on the 
node.

Session, Node

Circuits Creates, deletes, edits, and maps circuits. —

Provisioning Provisions the ONS 15454 node. General, Ether Bridge, Network, 
Protection, BLSR, Security, SNMP, 
Comm Channels, Timing, Alarm 
Profiles, Defaults, UCP, WDM-ANS

Inventory Provides inventory information (part number, 
serial number, Common Language Equipment 
Identification [CLEI] codes) for cards installed 
in the node. Allows you to delete and reset cards 
and change the card service state. 

—

Maintenance Performs maintenance tasks for the node. Database, Ether Bridge, Protection, 
BLSR (ANSI), MS-SPRing (ETSI), 
Software, Cross-Connect, Overhead 
XConnect, Diagnostic, Timing, 
Audit, Routing Table, RIP Routing 
Table, Test Access, DWDM
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18.5.2 Network View
Network view allows you to view and manage ONS 15454s that have DCC connections to the node that 
you logged into and any login node groups you have selected (Figure 18-6). 

Figure 18-6 Network in CTC Network View 

Note Nodes with DCC connections to the login node do not appear if you checked the Disable Network 
Discovery check box in the Login dialog box. 

The graphic area displays a background image with colored ONS 15454 icons. A Superuser can set up 
the logical network view feature, which enables each user to see the same network view. 

The lines show DCC connections between the nodes (Table 18-9). DCC connections can be green 
(active) or gray (fail). The lines can also be solid (circuits can be routed through this link) or dashed 
(circuits cannot be routed through this link). Circuit provisioning uses active/routable links. Selecting a 
node or span in the graphic area displays information about the node and span in the status area.

96
93

9

Bold letters indicate
login node, asterisk

indicates topology host
Icon color indicates

node status
Dots indicate
selected node

Table 18-9 DCC Colors Indicating State in Network View

Color and Line Style State

Green and solid Active/Routable

Green and dashed Active/Nonroutable

Gray and solid Failed/Routable

Gray and dashed Failed/Nonroutable
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The color of a node in network view, shown in Table 18-10, indicates the node alarm status. 

Table 18-11 lists the tabs and subtabs available in network view.

18.5.3 Card View
The card view provides information about individual ONS 15454 cards. Use this window to perform 
card-specific maintenance and provisioning (Figure 18-7). A graphic showing the ports on the card is 
shown in the graphic area. The status area displays the node name, slot, number of alarms, card type, 
equipment type, card status (active or standby), card service state if the card is present, and port service 
state (described in Table 18-7 on page 18-9). The information that appears and the actions you can 
perform depend on the card. For more information about card service states, refer to Appendix C, 
“DWDM Administrative and Service States.”

Table 18-10 Node Status Shown in Network View

Color Alarm Status

Green No alarms

Yellow Minor alarms

Orange Major alarms

Red Critical alarms

Gray with 
Unknown#

Node initializing for the first time (CTC displays Unknown# because CTC has 
not discovered the name of the node yet)

Table 18-11 Network View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the 
network and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
network.

—

History Provides a history of network alarms including 
date, type, and severity of each alarm.

—

Circuits Creates, deletes, edits, filters, and searches for 
network circuits.

—

Provisioning Provisions security, alarm profiles, 
bidirectional line switched rings (BLSRs) 
(ANSI), multiplex section-shared protection 
rings (MS-SPRing) (ETSI), and overhead 
circuits.

Security, Alarm Profiles, BLSR 
(ANSI), MS-SPRing (ETSI), 
Overhead Circuits, Provisionable 
Patchcords

Maintenance Displays the type of equipment and the status 
of each node in the network; displays working 
and protect software versions; and allows 
software to be downloaded.

Software
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Figure 18-7 CTC Card View Showing a 32DMX-O Card

Note CTC provides a card view for all ONS 15454 cards except the TCC2/TCC2P card.

Use the card view tabs and subtabs shown in Table 18-12 to provision and manage the ONS 15454. The 
subtabs, fields, and information shown under each tab depend on the card type selected. The 
Performance tab is not available for the Alarm Interface Controller (AIC) or Alarm Interface 
Controller–International (AIC-I) cards.

Table 18-12 Card View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the card 
and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
card.

—

History Provides a history of card alarms including 
date, object, port, and severity of each alarm.

Session (displays alarms and events 
for the current session), Card 
(displays alarms and events retrieved 
from a fixed-size log on the card)

Circuits Creates, deletes, edits, and search circuits. —
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18.6 TCC2/TCC2P Card Reset
You can reset the ONS 15454 TCC2/TCC2P card by using CTC (a soft reset) or by physically reseating 
a TCC2/TCC2P card (a hard reset). A soft reset reboots the TCC2/TCC2P card and reloads the operating 
system and the application software. Additionally, a hard reset temporarily removes power from the 
TCC2/TCC2P card and clears all buffer memory. 

You can apply a soft reset from CTC to either an active or standby TCC2/TCC2P card without affecting 
traffic. If you need to perform a hard reset on an active TCC2/TCC2P card, put the TCC2/TCC2P card 
into standby mode first by performing a soft reset.

Note When a CTC reset is performed on an active TCC2/TCC2P card, the AIC and AIC-I cards go through 
an initialization process and also reset because the AIC and AIC-I cards are controlled by the active 
TCC2/TCC2P. 

Provisioning Provisions an ONS 15454 card. DS-N and OC-N cards: Line, Line 
Thresholds (different threshold 
options are available for DS-N and 
OC-N cards), Elect Path Thresholds, 
SONET Thresholds, SONET STS, 
and Alarm Profiles

TXP and MXP cards: Card, Line, 
Line Thresholds, Optics Thresholds, 
OTN, and Alarm Profiles

DWDM cards (subtabs depend on 
card type): Optical Line, Optical 
Chn, Optical Amplifier, Parameters, 
Optics Thresholds, and Alarm 
Profiles

Maintenance Performs maintenance tasks for the card. Loopback, Info, Protection, J1 Path 
Trace, AINS Soak (options depend 
on the card type), Automatic Laser 
Shutdown

Performance Performs performance monitoring for the card. DS-N and OC-N cards: no subtabs

TXP and MXP cards: Optics PM, 
Payload PM, OTN PM

DWDM cards (subtabs depend on 
card type): Optical Line, Optical 
Chn, Optical Amplifier Line, OC3 
Line, Parameters, Optics Thresholds

Inventory Displays an Inventory screen of the ports (TXP 
and MXP cards only).

—

Table 18-12 Card View Tabs and Subtabs (continued)

Tab Description Subtabs
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18.7 TCC2/TCC2P Card Database
When dual TCC2/TCC2P cards are installed in the ONS 15454, each TCC2/TCC2P card hosts a separate 
database; therefore, the protect card database is available if the database on the working TCC2/TCC2P 
fails. You can also store a backup version of the database on the workstation running CTC. This 
operation should be part of a regular ONS 15454 maintenance program at approximately weekly 
intervals, and should also be completed when preparing an ONS 15454 for a pending natural disaster, 
such as a flood or fire.

Note The following parameters are not backed up and restored: node name, IP address, mask and gateway, and 
Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up 
database with a different node name, the circuits map to the new node name. Cisco recommends keeping 
a record of the old and new node names.

18.8 Software Revert 
When you click the Activate button after a software upgrade, the TCC2/TCC2P card copies the current 
working database and saves it in a reserved location in the TCC2/TCC2P card flash memory. If later 
during the upgrade you need to revert to the original working software load from the protect software 
load, the saved database installs automatically. You do not need to restore the database manually or 
recreate circuits. 

The revert feature is useful if the maintenance window in which you were performing an upgrade closes 
while you are still upgrading CTC software. You can revert to the protect software load without losing 
traffic. During the next maintenance window, you can complete the upgrade and activate the new 
software load.

Circuits created or provisioning done after you activate a new software load (upgrade to a higher release) 
will be lost with a revert. The database configuration at the time of activation is reinstated after a revert. 
(This does not apply to maintenance reverts, such as R5.0.1 to 5.0.2, because maintenance releases retain 
the database during activation.) 

Caution Cisco does not recommend reverting after changing provisioning on the node. Depending upon the 
particular provisioning, reverting in this case can be traffic affecting. 

To perform a supported (non-service-affecting) revert from a software release you have just activated, 
the release you revert to must have been working at the time you first activated the new software on that 
node. Because a supported revert automatically restores the node configuration at the time of the 
previous activation, any configuration changes made after activation will be lost when you revert the 
software. Downloading the software release you are upgrading to a second time after you have activated 
the new load ensures that no actual revert to a previous load can take place (the TCC2/TCC2P will reset, 
but will not be traffic affecting and will not change your database). 

Note To perform a supported software upgrade or revert you must consult the specific upgrade document and 
release notes for the release you are upgrading to (or reverting from).
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Security and Timing Reference

This chapter provides information about Cisco ONS 15454 users and node timing. To provision security 
and timing, see the “NTP-G23 Create Users and Assign Security” procedure on page 3-5.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 19.1 Users and Security, page 19-1

• 19.2 Node Timing, page 19-6

19.1 Users and Security
The Cisco Transport Controller (CTC) ID is provided with the ONS 15454 system, but the system does 
not display the user ID when you sign into CTC. This ID can be used to set up other ONS 15454 users. 

You can have up to 500 user IDs on one ONS 15454. Each CTC or TL1 user can be assigned one of the 
following security levels:

• Retrieve—Users can retrieve and view CTC information but cannot set or modify parameters.

• Maintenance—Users can access only the ONS 15454 maintenance options.

• Provisioning—Users can access provisioning and maintenance options.

• Superusers—Users can perform all of the functions of the other security levels as well as set names, 
passwords, and security levels for other users.

By default, multiple concurrent user ID sessions are permitted on the node, that is, multiple users can 
log into a node using the same user ID. However, you can provision the node to allow only a single login 
per user and prevent concurrent logins for all users. 

Note You must add the same user name and password to each node the user accesses.

19.1.1 Security Requirements 
Table 19-1 shows the actions that each user privilege level can perform in node view.
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Table 19-1 ONS 15454 Security Levels—Node View

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser

Alarms — Synchronize/Filter/Delete 
Cleared Alarms

X X X X

Conditions — Retrieve/Filter X X X X

History Session Filter X X X X

Node Retrieve/Filter X X X X

Circuits — Create/Edit/Delete — — X X

Filter/Search X X X X

Provisioning General General: Edit — — Partial1 X

Power Monitor: Edit — — X X

EtherBridge Spanning trees: Edit — — X X

Network General: All — — — X

Static Routing: Create/Edit/ 
Delete

— — X X

OSPF: Create/Edit/Delete — — X X

RIP: Create/Edit/Delete — — X X

Proxy: Create/Delete — — — X

Firewall: Create/Delete — — — X

Protection Create/Delete/Edit — — X X

View X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

Create/Edit/Delete — — X X

Ring Map/Squelch Table/RIP 
Table

X X X X

Security Users: Create/Delete — — — X

Users: Change Same user Same user Same user All users

Users: Clear Security Intrusion — — — X

Active Logins: Logout — — — X

Policy: Edit — — — X

Access: Edit — — — X

Legal Disclaimer: Edit — — — X

SNMP Create/Delete/Edit — — X X

Browse trap destinations X X X X
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Provisioning Comm Channels SDCC: Create/Edit/Delete — — X X

LDCC: Create/Edit/Delete — — X X

GCC: Create/Edit/Delete — — X X

OSC: OSC Terminations: 
Create/Edit/Delete

— — X X

OSC: DWDM Ring ID: 
Create/Edit/Delete

— X X X

Provisionable Patchcords: 
Create/Delete

— — X X

Timing General: Edit — — X X

BITS Facilities: Edit — — X X

Alarm Profiles Alarm Behavior: Edit — — X X

Alarm Profiles Editor: 
Load/Store/Delete2

— — X X

Alarm Profile Editor: 
New/Compare/Available/Usage

X X X X

Defaults Edit/Import — — — X

Export X X X X

UCP Node: Edit/Provision — — X X

Neighbor: Create/Edit/Delete — — X X

IPCC: Create/Edit/Delete — — X X

Interface: Create/Edit/Delete — — X X

Circuit: Create/Edit/Delete — — X X

WDM-ANS Provisioning: Import — — — X

Provisioning: Export X X X X

Connections: 
Create/Edit/Delete/Commit/ 
Calculate

— — X X

Port Status: Launch — — X X

Inventory — Delete — — X X

Reset — X X X

Maintenance Database Backup — X X X

Restore — — — X

EtherBridge Spanning Trees: View X X X X

MAC Table: Retrieve X X X X

MAC Table: Clear/Clear All — X X X

Trunk Utilization: Refresh X X X X

Circuits: Refresh X X X X

Table 19-1 ONS 15454 Security Levels—Node View (continued)

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser
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Table 19-2 shows the actions that each user privilege level can perform in network view.

Maintenance Protection Switch/Lock out/Lockon/ Clear/ 
Unlock

X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

West/East Switches — — X X

Reset — X X X

Software Download — X X X

Activate/Revert — — — X

Cross-Connect Cards: Switch/Lock/Unlock — X X X

Resource Usage: Delete — — X X

Overhead 
XConnect

View X X X X

Diagnostic Retrieve/Lamp Test — X X X

Timing Source: Edit — X X X

Timing Report: View/Refresh X X X X

Audit Retrieve/Archive — — — X

Routing Table Retrieve X X X X

RIP Routing Table Retrieve X X X X

Test Access Read-only X X X X

DWDM APC: Run/Disable/Refresh — X X X

WDM Span Check: Retrieve 
Span Loss values, Reset

X X X X

Power Monitoring: Refresh X X X X

1. Provisioner user cannot change node name, contact, or AIS-V insertion on STS-1 signal degrade (SD) parameters.

2. The action buttons in the subtab are active for all users, but the actions can be completely performed only by the users assigned with the required security 
levels.

Table 19-1 ONS 15454 Security Levels—Node View (continued)

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser

Table 19-2 ONS 15454 Security Levels—Network View

CTC Tab Subtab [Subtab]: Actions Retrieve Maintenance Provisioning Superuser

Alarms — Synchronize/Filter/Delete 
cleared alarms

X X X X

Conditions — Retrieve/Filter X X X X

History — Filter X X X X

Circuits — Create/Edit/Delete — — X X

Filter/Search X X X X
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19.1.2 Security Policies
Users with Superuser security privilege can provision security policies on the ONS 15454. These 
security policies include idle user timeouts, password changes, password aging, and user lockout 
parameters. In addition, a Superuser can access the ONS 15454 through the TCC2/TCC2P RJ-45 port, 
the backplane LAN connection, or both. 

19.1.2.1 Idle User Timeout

Each ONS 15454 CTC or TL1 user can be idle during his or her login session for a specified amount of 
time before the CTC window is locked. The lockouts prevent unauthorized users from making changes. 
Higher-level users have shorter default idle periods and lower-level users have longer or unlimited 
default idle periods, as shown in Table 19-3. The user idle period can be modified by a Superuser; refer 
to the “NTP-G88 Modify Users and Change Security” procedure on page 10-35.

Provisioning Security Users: Create/Delete — — — X

Users: Change Same User Same User Same User All Users

Active logins: Logout — — — X

Policy: Change — — — X

Alarm Profiles New/Load/Store/Delete1 — — X X

Compare/Available/Usage X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

Create/Edit/Delete/Upgrade — — X X

Overhead Circuits Create/Delete/Edit/Merge — — X X

Search X X X X

Provisionable 
Patchcords

Create/ Delete — — X X

Maintenance Software Download/Cancel X X X X

1. The action buttons in the subtab are active for all users, but the actions can be completely performed only by the users assigned with the required security 
levels.

Table 19-2 ONS 15454 Security Levels—Network View (continued)

CTC Tab Subtab [Subtab]: Actions Retrieve Maintenance Provisioning Superuser

Table 19-3 ONS 15454 Default User Idle Times

Security Level Idle Time

Superuser 15 minutes

Provisioning 30 minutes

Maintenance 60 minutes

Retrieve Unlimited
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19.1.2.2 User Password, Login, and Access Policies

Superusers can view real-time lists of users who are logged into CTC or TL1 user logins by node. 
Superusers can also provision the following password, login, and node access policies:

• Password expirations and reuse—Superusers can specify when users must change their passwords 
and when they can reuse them.

• Login attempts—Superusers can specify the maximum number of times a user is allowed to attempt 
to login to CTC.

• Locking out and disabling users—Superusers can provision the number of invalid logins that are 
allowed before locking out users and the length of time before inactive users are disabled. The 
number of allowed lockout attempts is set to the number of allowed login attempts.

• Node access and user sessions—Superusers can limit the number of CTC sessions one user can have, 
and they can prohibit access to the ONS 15454 using the LAN or TCC2/TCC2P RJ-45 connections. 

In addition, a Superuser can select secure shell (SSH) instead of Telnet at the CTC Provisioning > 
Security > Access tabs. SSH is a terminal-remote host Internet protocol that uses encrypted links. It 
provides authentication and secure communication over unsecure channels. Port 22 is the default 
port and cannot be changed.

19.1.2.3 Audit Trail

Audit trails prove useful for maintaining security, recovering lost transactions, and enforcing 
accountability. Accountability refers to tracing user activities; that is, associating a process or action 
with a specific user.

The ONS 15454 maintains a 640-entry, human-readable audit trail of user or system actions such as 
login, logout, circuit creation or deletion, and user- or system-generated actions. Login events include 
authorized Cisco logins using the ONS 15454 command line interface (CLI) or CTC, the ONS 15454 
graphical user interface. You can move the log to a local or network drive for later review. The 
ONS 15454 generates an event to indicate when the log is 80 percent full, and another event to indicate 
that the oldest log entries are being overwritten.

Table 19-4 contains the columns listed in Audit Trail window.

19.2 Node Timing
SONET timing parameters must be set for each ONS 15454. Each ONS 15454 independently accepts its 
timing reference from one of three sources:

• The building integrated timing supply (BITS) pins on the ONS 15454 backplane (ANSI) or 
MIC-C/T/P coaxial connectors (ETSI).

Table 19-4 Audit Trail Window Columns

Heading Explanation

Date Date when the action occurred

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (whether or not the action was executed)

Operation Action that was taken
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• An OC-N/STM-N card installed in the ONS 15454. The card is connected to a node that receives 
timing through a BITS source. 

• The internal ST3 clock on the TCC2/TCC2P card.

You can set ONS 15454 timing to one of three modes: external, line, or mixed. If timing is coming from 
the BITS pins, set ONS 15454 timing to external. If the timing comes from an OC-N/STM-N card, set 
the timing to line. In typical ONS 15454 networks:

• One node is set to external. The external node derives its timing from a BITS source wired to the 
BITS backplane pins. The BITS source, in turn, derives its timing from a primary reference source 
(PRS) such as a Stratum 1 clock or global positioning satellite (GPS) signal.

• The other nodes are set to line. The line nodes derive timing from the externally timed node through 
the OC-N trunk (span) cards. The DWDM node normally derives timing from the line using the 
OSCM or OSC-CSM card that are inside an OC-3/STM-1 channel.

You can set three timing references for each ONS 15454. The first two references are typically two 
BITS-level sources, or two line-level sources optically connected to a node with a BITS source. The third 
reference is usually assigned to the internal clock provided on every ONS 15454 TCC2/TCC2P card. 
However, if you assign all three references to other timing sources, the internal clock is always available 
as a backup timing reference. The internal clock is a Stratum 3 (ST3), so if an ONS 15454 node becomes 
isolated, timing is maintained at the ST3 level.

The CTC Maintenance > Timing > Report tabs show current timing information for an ONS 15454, 
including the timing mode, clock state and status, switch type, and reference data. 

Caution Mixed timing allows you to select both external and line timing sources. However, Cisco does not 
recommend its use because it can create timing loops. Use this mode with caution.

19.2.1 Network Timing Example
Figure 19-1 shows an ONS 15454 network timing setup example. Node 1 is set to external timing. Two 
timing references are set to BITS. These are Stratum 1 timing sources wired to the BITS input pins on 
the Node 1 backplane. The third reference is set to internal clock. The BITS output pins on the backplane 
of Node 3 are used to provide timing to outside equipment, such as a digital access line access 
multiplexer.

In the example, Slots 5 and 6 contain the trunk (span) cards. Timing at Nodes 2, 3, and 4 is set to line, 
and the timing references are set to the trunk cards based on distance from the BITS source. Reference 1 
is set to the trunk card closest to the BITS source. At Node 2, Reference 1 is Slot 5 because it is 
connected to Node 1. At Node 4, Reference 1 is set to Slot 6 because it is connected to Node 1. At 
Node 3, Reference 1 could be either trunk card because they are equal distance from Node 1. 
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Figure 19-1 ONS 15454 Timing Example

19.2.2 Synchronization Status Messaging
Synchronization status messaging (SSM) is a SONET protocol that communicates information about the 
quality of the timing source. SSM messages are carried on the S1 byte of the SONET Line layer. They 
enable SONET devices to automatically select the highest quality timing reference and to avoid timing 
loops.

SSM messages are either Generation 1 or Generation 2. Generation 1 is the first and most widely 
deployed SSM message set. Generation 2 is a newer version. If you enable SSM for the ONS 15454, 
consult your timing reference documentation to determine which message set to use. Table 19-5 and 
Table 19-6 on page 19-9 show the Generation 1 and Generation 2 message sets.

Node 4
Timing Line
Ref 1: Slot 6
Ref 2: Slot 5
Ref 3: Internal (ST3)

Node 2
Timing Line
Ref 1: Slot 5
Ref 2: Slot 6
Ref 3: Internal (ST3)

Node 1
Timing External
Ref 1: BITS1
Ref 2: BITS2
Ref 3: Internal (ST3)

Node 3
Timing Line
Ref 1: Slot 5
Ref 2: Slot 6
Ref 3: Internal (ST3)

BITS1
out

BITS2
out

BITS1
source

BITS2
source

Third party
equipment

34
72

6

Slot 5

Slot 5

Slot 5

Slot 5

Slot 6

Slot 6

Slot 6

Slot 6

Table 19-5 SSM Generation 1 Message Set

Message Quality Description

PRS 1 Primary reference source—Stratum 1

STU 2 Synchronization traceability unknown

ST2 3 Stratum 2
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ST3 4 Stratum 3

SMC 5 SONET minimum clock

ST4 6 Stratum 4

DUS 7 Do not use for timing synchronization

RES — Reserved; quality level set by user

Table 19-6 SSM Generation 2 Message Set

Message Quality Description

PRS 1 Primary reference source—Stratum 1

STU 2 Synchronization traceability unknown

ST2 3 Stratum 2

TNC 4 Transit node clock

ST3E 5 Stratum 3E

ST3 6 Stratum 3

SMC 7 SONET minimum clock

ST4 8 Stratum 4

DUS 9 Do not use for timing synchronization

RES — Reserved; quality level set by user

Table 19-5 SSM Generation 1 Message Set (continued)

Message Quality Description
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C H A P T E R 20

CTC Connectivity Reference

This chapter provides nine scenarios showing Cisco ONS 15454s in common IP network configurations 
as well as information about provisionable patchcords, the routing table, external firewalls, and open 
gateway network element (GNE) networks. The chapter does not provide a comprehensive explanation 
of IP networking concepts and procedures. For IP setup instructions, see the “DLP-G56 Provision IP 
Settings” task on page 3-11.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 20.1 IP Networking Overview, page 20-1

• 20.2 IP Addressing Scenarios, page 20-2

• 20.3 Provisionable Patchcords, page 20-22

• 20.4 Routing Table, page 20-24

• 20.5 External Firewalls, page 20-25

• 20.6 Open GNE, page 20-27

Note To connect ONS 15454s to an IP network, you must work with a LAN administrator or other individual 
at your site who has IP networking training and experience. 

20.1 IP Networking Overview
ONS 15454s can be connected in many different ways within an IP environment:

• They can be connected to LANs through direct connections or a router.

• IP subnetting can create ONS 15454 node groups that allow you to provision non-data 
communication channel (DCC) connected nodes in a network. 

• Different IP functions and protocols can be used to achieve specific network goals. For example, 
Proxy Address Resolution Protocol (ARP) enables one LAN-connected ONS 15454 to serve as a 
gateway for ONS 15454s that are not connected to the LAN. 

• Static routes can be created to enable connections among multiple Cisco Transport Controller (CTC) 
sessions with ONS 15454s that reside on the same subnet with multiple CTC sessions. 
20-1
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• ONS 15454s can be connected to Open Shortest Path First (OSPF) networks so ONS 15454 network 
information is automatically communicated across multiple LANs and WANs.

• The ONS 15454 proxy server can control the visibility and accessibility between CTC computers 
and ONS 15454 element nodes.

20.2 IP Addressing Scenarios
ONS 15454 IP addressing generally has eight common scenarios or configurations. Use the scenarios as 
building blocks for more complex network configurations. Table 20-1 provides a general list of items to 
check when setting up ONS 15454s in IP networks.

20.2.1 Scenario 1: CTC and ONS 15454s on Same Subnet
Scenario 1 shows a basic ONS 15454 LAN configuration (Figure 20-1). The ONS 15454s and CTC 
computer reside on the same subnet. All ONS 15454s connect to LAN A, and all ONS 15454s have DCC 
connections.

Table 20-1 General ONS 15454 IP Troubleshooting Checklist

Item What to Check

Link integrity Verify that link integrity exists between:

• CTC computer and network hub/switch

• ONS 15454s (backplane [ANSI] or MIC-C/T/P [ETSI] wire-wrap pins or 
RJ-45 port) and network hub/switch

• Router ports and hub/switch ports

ONS 15454 
hub/switch ports

If connectivity problems occur, set the hub or switch port that is connected to 
the ONS 15454 to 10 Mbps half-duplex.

Ping Ping the node to test connections between computers and ONS 15454s.

IP addresses/subnet 
masks

Verify that ONS 15454 IP addresses and subnet masks are set up correctly.

Optical connectivity Verify that ONS 15454 optical trunk ports are in service and that a DCC is 
enabled on each trunk port.
20-2
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Figure 20-1 Scenario 1: CTC and ONS 15454s on Same Subnet (ANSI and ETSI)

20.2.2 Scenario 2: CTC and ONS 15454s Connected to a Router
In Scenario 2, the CTC computer resides on a subnet (192.168.1.0) and attaches to LAN A (Figure 20-2). 
The ONS 15454s reside on a different subnet (192.168.2.0) and attach to LAN B. A router connects LAN 
A to LAN B. The IP address of router interface A is set to LAN A (192.168.1.1), and the IP address of 
router interface B is set to LAN B (192.168.2.1). The routers each have a subnet mask of 255.255.255.0.

On the CTC computer, the default gateway is set to router interface A. If the LAN uses DHCP (Dynamic 
Host Configuration Protocol), the default gateway and IP address are assigned automatically. In the 
Figure 20-2 example, a DHCP server is not available.

CTC Workstation
IP Address 192.168.1.100
Subnet Mask 255.255.255.0
Default Gateway = N/A
Host Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #2
IP Address 192.168.1.20
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring

12
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Figure 20-2 Scenario 2: CTC and ONS 15454s Connected to Router (ANSI and ETSI)

20.2.3 Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
ARP matches higher-level IP addresses to the physical addresses of the destination host. It uses a lookup 
table (called ARP cache) to perform the translation. When the address is not found in the ARP cache, a 
broadcast is sent out on the network with a special format called the ARP request. If one of the machines 
on the network recognizes its own IP address in the request, it sends an ARP reply back to the requesting 
host. The reply contains the physical hardware address of the receiving host. The requesting host stores 
this address in its ARP cache so that all subsequent datagrams (packets) to this destination IP address 
can be translated to a physical address.

Proxy ARP enables one LAN-connected ONS 15454 to respond to the ARP request for ONS 15454s not 
connected to the LAN. (ONS 15454 proxy ARP requires no user configuration.) For this to occur, the 
DCC-connected ONS 15454s must reside on the same subnet as the LAN-connected (gateway) 
ONS 15454. When a LAN device sends an ARP request to an ONS 15454 that is not connected to the 
LAN, the gateway ONS 15454 (the one connected to the LAN) returns its MAC address to the LAN 

ONS 15454 #2
IP Address 192.168.2.20
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface “A” to LAN “A” 192.168.1.1
IP Address of interface “B” to LAN “B”  192.168.2.1
Subnet Mask 255.255.255.0
Default Router = N/A
Host Routes =  N/A

ONS 15454 #1
IP Address 192.168.2.10

Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

Static Routes = N/A

ONS 15454 #3
IP Address 192.168.2.30
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
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device. The LAN device then sends the datagram for the remote ONS 15454 to the MAC address of the 
proxy ONS 15454. The proxy ONS 15454 uses its routing table to forward the datagram to the non-LAN 
ONS 15454.

Scenario 3 is similar to Scenario 1, but only one ONS 15454 (Node 1) connects to the LAN 
(Figure 20-3). Two ONS 15454s (Node 2 and Node 3) connect to ONS 15454 Node 1 through the section 
DCC. Because all three ONS 15454s are on the same subnet, proxy ARP enables ONS 15454 Node 1 to 
serve as a gateway for ONS 15345 Node 2 and Node 3.

Note This scenario assumes all CTC connections are to Node 1. If you connect a laptop to either ONS 15454 
Node 2 or Node 3, network partitioning occurs; neither the laptop or the CTC computer can see all nodes. 
If you want laptops to connect directly to end network elements, you must create static routes (see 
Scenario 5) or enable the ONS 15454 proxy server (see Scenario 7). 

Be aware that:

• GNE and ENE 15454 proxy ARP is disabled.

• There is exactly one proxy ARP server on any given Ethernet segment; however, there may be more 
than one server in an ANSI or ETSI topology.

• The proxy ARP server does not perform the proxy ARP function for any node or host that is on the 
same Ethernet segment.

• It is important in Figure 20-3 that the CTC workstation be located within the same subnet and on 
the same Ethernet segment as the proxy ARP server.
20-5
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Figure 20-3 Scenario 3: Using Proxy ARP (ANSI and ETSI)

You can also use proxy ARP to communicate with hosts attached to the craft Ethernet ports of 
DCC-connected nodes (Figure 20-4). The node with an attached host must have a static route to the host. 
Static routes are propagated to all DCC peers using OSPF. The existing proxy ARP node is the gateway 
for additional hosts. Each node examines its routing table for routes to hosts that are not connected to 
the DCC network but are within the subnet. The existing proxy server replies to ARP requests for these 
additional hosts with the node MAC address. The existence of the host route in the routing table ensures 
that the IP packets addressed to the additional hosts are routed properly. Other than establishing a static 
route between a node and an additional host, no provisioning is necessary. The following restrictions 
apply:

• Only one node acts as the proxy ARP server for any given additional host. 

• A node cannot be the proxy ARP server for a host connected to its Ethernet port. 

In Figure 20-4, Node 1 announces to Node 2 and 3 that it can reach the CTC host. Similarly, Node 3 
announces that it can reach the ONS 152xx. The ONS 152xx is shown as an example; any network 
element can be set up as an additional host. 

CTC Workstation
IP Address 192.168.1.100
Subnet Mark at CTC Workstation 255.255.255.0
Default Gateway = N/A

ONS 15454 #2
IP Address 192.168.1.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring

12
42
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Figure 20-4 Scenario 3: Using Proxy ARP with Static Routing (ANSI and ETSI)

20.2.4 Scenario 4: Default Gateway on CTC Computer
Scenario 4 is similar to Scenario 3, but Nodes 2 and 3 reside on different subnets, 192.168.2.0 and 
192.168.3.0, respectively (Figure 20-5). Node 1 and the CTC computer are on subnet 192.168.1.0. Proxy 
ARP is not used because the network includes different subnets. For the CTC computer to communicate 
with Nodes 2 and 3, Node 1 is entered as the default gateway on the CTC computer.

CTC Workstation
IP Address 192.168.1.100
Subnet Mark at CTC Workstation 255.255.255.0
Default Gateway = N/A

ONS 15454 #2
IP Address 192.168.1.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.100

Mask 255.255.255.0
Next Hop 192.168.1.30

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.31

Mask 255.255.255.255
Next Hop 192.168.1.30

ONS 152xx
IP Address 192.168.1.31
Subnet Mask 255.255.255.0

LAN A

Ring

12
42

47
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Figure 20-5 Scenario 4: Default Gateway on a CTC Computer (ANSI and ETSI)

20.2.5 Scenario 5: Using Static Routes to Connect to LANs
Static routes are used for two purposes: 

• To connect ONS 15454s to CTC sessions on one subnet connected by a router to ONS 15454s 
residing on another subnet. (These static routes are not needed if OSPF is enabled. Scenario 6 shows 
an OSPF example.)

• To enable multiple CTC sessions among ONS 15454s residing on the same subnet.

In Figure 20-6, one CTC residing on subnet 192.168.1.0 connects to a router through interface A (the 
router is not set up with OSPF). ONS 15454s residing on different subnets are connected through Node 
1 to the router through interface B. Because Nodes 2 and 3 are on different subnets, proxy ARP does not 
enable Node 1 as a gateway. To connect to CTC computers on LAN A, a static route is created on 
Node 1. 

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

CTC Workstation
IP Address 192.168.1.100
Subnet Mask at CTC Workstation 255.255.255.0
Default Gateway  = 192.168.1.10
Host Routes = N/A

ONS 15454 #2
IP Address 192.168.2.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.3.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring

12
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Figure 20-6 Scenario 5: Static Route With One CTC Computer Used as a Destination (ANSI and ETSI)

The destination and subnet mask entries control access to the ONS 15454s:

• If a single CTC computer is connected to a router, enter the complete CTC “host route” IP address 
as the destination with a subnet mask of 255.255.255.255. 

• If CTC computers on a subnet are connected to a router, enter the destination subnet (in this example, 
192.168.1.0) and a subnet mask of 255.255.255.0.

• If all CTC computers are connected to a router, enter a destination of 0.0.0.0 and a subnet mask of 
0.0.0.0. Figure 20-7 shows an example.

The IP address of router interface B is entered as the next hop, and the cost (number of hops from source 
to destination) is 2.

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface ”A” to  LAN “A”  192.168.1.1
IP Address of interface  “B” to LAN  “B”   192.168.2.1
Subnet Mask 255.255.255.0

ONS 15454 #2
IP Address 192.168.3.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes
    Destination 192.168.1.0
    Mask 255.255.255.0
    Next Hop 192.168.2.1
    Cost = 2

ONS 15454 #3
IP Address 192.168.4.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
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Figure 20-7 Scenario 5: Static Route With Multiple LAN Destinations (ANSI and ETSI)

20.2.6 Scenario 6: Using OSPF
Open Shortest Path First (OSPF) is a link state Internet routing protocol. Link state protocols use a “hello 
protocol” to monitor their links with adjacent routers and to test the status of their links to their 
neighbors. Link state protocols advertise their directly connected networks and their active links. Each 
link state router captures the link state “advertisements” and puts them together to create a topology of 
the entire network or area. From this database, the router calculates a routing table by constructing a 
shortest path tree. Routes are recalculated when topology changes occur.

ONS 15454s use the OSPF protocol in internal ONS 15454 networks for node discovery, circuit routing, 
and node management. You can enable OSPF on the ONS 15454s so that the ONS 15454 topology is 
sent to OSPF routers on a LAN. Advertising the ONS 15454 network topology to LAN routers 

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router #1
IP Address  of interface ”A” to  LAN “A”  192.168.1.1
IP Address of interface  “B” to LAN  “B”   192.168.2.1
Subnet Mask 255.255.255.0

ONS 15454 #2
IP Address 192.168.2.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

ONS 15454 #3
IP Address 192.168.2.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN B

LAN A

Int "A"
Int "B"

Ring

12
42

50

Static Routes
    Destination 0.0.0.0
    Mask 0.0.0.0
    Next Hop 192.168.2.1
    Cost = 2

LAN C

LAN D
Router #3

Router #2
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eliminates the need to manually enter static routes for ONS 15454 subnetworks. Figure 20-8 shows a 
network enabled for OSPF. Figure 20-9 shows the same network without OSPF. Static routes must be 
manually added to the router for CTC computers on LAN A to communicate with Nodes 2 and 3 because 
these nodes reside on different subnets.

OSPF divides networks into smaller regions, called areas. An area is a collection of networked end 
systems, routers, and transmission facilities organized by traffic patterns. Each OSPF area has a unique 
ID number, known as the area ID. Every OSPF network has one backbone area called “area 0.” All other 
OSPF areas must connect to area 0.

When you enable an ONS 15454 OSPF topology for advertising to an OSPF network, you must assign 
an OSPF area ID in decimal format to the ONS 15454 network. An area ID is a “dotted quad” value that 
appears similar to an IP address. Coordinate the area ID number assignment with your LAN 
administrator. All DCC-connected ONS 15454s should be assigned the same OSPF area ID. 

Note It is recommended that the number of 15454s in an OSPF area be limited, because this allows faster 
loading into a CTC an is less likely to incur any problems.

Figure 20-8 Scenario 6: OSPF Enabled (ANSI and ETSI)

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface “A” to LAN A 192.168.1.1
IP Address of interface “B” to LAN B  192.168.2.1
Subnet Mask 255.255.255.0

ONS 15454 #2
IP Address 192.168.3.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.4.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
42

51
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Figure 20-9 Scenario 6: OSPF Not Enabled (ANSI and ETSI)

20.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server
The ONS 15454 proxy server is a set of functions that allows you to network ONS 15454s in 
environments where visibility and accessibility between ONS 15454s and CTC computers must be 
restricted. For example, you can set up a network so that field technicians and network operating center 
(NOC) personnel can both access the same ONS 15454s while preventing the field technicians from 
accessing the NOC LAN. To do this, one ONS 15454 is provisioned as a GNE and the other ONS 15454s 
are provisioned as end network elements (ENEs). The GNE ONS 15454 tunnels connections between 
CTC computers and ENE ONS 15454s, providing management capability while preventing access for 
non-ONS 15454 management purposes.

The ONS 15454 gateway setting performs the following tasks:

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes 
    Destination = 192.168.1.100
    Mask = 255.255.255.255
    Next Hop = 192.168.2.1
    Cost = 2

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface “A” to LAN A 192.168.1.1
IP Address of interface “B” to LAN B  192.168.2.1
Subnet Mask 255.255.255.0
Static Routes = Destination 192.168.3.20 Next Hop  192.168.2.10
                         Destination 192.168.4.30 Next Hop  192.168.2.10

ONS 15454 #2
IP Address 192.168.3.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.4.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
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• Isolates DCC IP traffic from Ethernet (craft port) traffic and accepts packets based on filtering rules. 
The filtering rules (see Table 20-3 on page 20-17 and Table 20-4 on page 20-18) depend on whether 
the packet arrives at the ONS 15454 DCC or TCC2/TCC2P Ethernet interface.

• Processes Simple Network Time Protocol (SNTP) and Network Time Protocol (NTP) requests. 
ONS 15454 ENEs can derive time-of-day from an SNTP/NTP LAN server through the GNE 
ONS 15454.

• Processes Simple Network Management Protocol version 1 (SNMPv1) traps. The GNE ONS 15454 
receives SNMPv1 traps from the ENE ONS 15454s and forwards or relays the traps to SNMPv1 trap 
destinations or ONS 15454 SNMP relay nodes.

The ONS 15454 proxy server is provisioned using the Enable proxy server on port check box on the 
Provisioning > Network > General tab (see Figure 20-10 and Figure 20-11). If checked, the ONS 15454 
serves as a proxy for connections between CTC clients and ONS 15454s that are DCC-connected to the 
proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes through the proxy 
node. The CTC client can connect to nodes that it cannot directly reach from the host on which it runs. 
If not selected, the node does not proxy for any CTC clients, although any established proxy connections 
continue until the CTC client exits. In addition, you can set the proxy server as an ENE or a GNE:

• End Network Element (ENE)—If set as an ENE, the ONS 15454 neither installs nor advertises 
default or static routes that go through its Ethernet port. However, an ENE does install and advertise 
routes that go through the DCC. CTC computers can communicate with the ONS 15454 using the 
TCC2/TCC2P craft port, but they cannot communicate directly with any other DCC-connected 
ONS 15454. 

In addition, firewall is enabled, which means that the node prevents IP traffic from being routed 
between the DCC and the LAN port. The ONS 15454 can communicate with machines connected to 
the LAN port or connected through the DCC. However, the DCC-connected machines cannot 
communicate with the LAN-connected machines, and the LAN-connected machines cannot 
communicate with the DCC-connected machines. A CTC client using the LAN to connect to the 
firewall-enabled node can use the proxy capability to manage the DCC-connected nodes that would 
otherwise be unreachable. A CTC client connected to a DCC-connected node can only manage other 
DCC-connected nodes and the firewall itself. 

• Gateway Network Element (GNE)—If set as a GNE, the CTC computer is visible to other 
DCC-connected nodes and firewall is enabled.

• Proxy-only—If Proxy-only is selected, firewall is not enabled. CTC can communicate with any 
other DCC-connected ONS 15454s. 

Note If you launch CTC against a node through a Network Address Translation (NAT) or Port Address 
Translation (PAT) router and that node does not have proxy enabled, your CTC session starts and initially 
appears to be fine. However CTC never receives alarm updates and disconnects and reconnects every two 
minutes. If the proxy is accidentally disabled, it is still possible to enable the proxy during a reconnect 
cycle and recover your ability to manage the node, even through a NAT/PAT firewall.
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Figure 20-10 Proxy Server Gateway Settings (ANSI)

Figure 20-11 Proxy Server Gateway Settings (ETSI)
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Figure 20-12 shows an ONS 15454 proxy server implementation. A GNE ONS 15454 is connected to a 
central office LAN and to ENE ONS 15454s. The central office LAN is connected to a NOC LAN, which 
has CTC computers. The NOC CTC computer and craft technicians must both be able to access the 
ONS 15454 ENEs. However, the craft technicians must be prevented from accessing or seeing the NOC 
or central office LANs.

In the example, the ONS 15454 GNE is assigned an IP address within the central office LAN and is 
physically connected to the LAN through its LAN port. ONS 15454 ENEs are assigned IP addresses that 
are outside the central office LAN and given private network IP addresses. If the ONS 15454 ENEs are 
collocated, the craft LAN ports could be connected to a hub. However, the hub should have no other 
network connections. 

Figure 20-12 ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI and ETSI)

Table 20-2 shows recommended settings for ONS 15454 GNEs and ENEs in the configuration shown in 
Figure 20-12.

Remote CTC
10.10.20.10

10.10.20.0/24

10.10.10.0/24

Interface 0/0
10.10.20.1

Router A

Interface 0/1
10.10.10.1

ONS 15454
Gateway NE

10.10.10.100/24

ONS 15454
End NE

10.10.10.250/24

ONS 15454
End NE
10.10.10.150/24

ONS 15454
End NE
10.10.10.200/24

12
42

53Local/Craft CTC
192.168.20.20
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Table 20-2 ONS 15454 Gateway and End NE Settings

Setting ONS 15454 Gateway NE ONS 15454 End NE

OSPF Off Off
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Figure 20-13 shows the same proxy server implementation with ONS 15454 ENEs on different subnets. 
The ONS 15454 GNEs and ENEs are provisioned with the settings shown in Table 20-2.

Figure 20-13 Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on Different Subnets (ANSI 

and ETSI)

SNTP server (if used) SNTP server IP address Set to ONS 15454 GNE IP address

SNMP (if used) SNMPv1 trap destinations Set SNMPv1 trap destinations to 
ONS 15454 GNE, port 391

Table 20-2 ONS 15454 Gateway and End NE Settings (continued)

Setting ONS 15454 Gateway NE ONS 15454 End NE
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Figure 20-14 shows the implementation with ONS 15454 ENEs in multiple rings.

Figure 20-14 Scenario 7: ONS 15454 Proxy Server With ENEs on Multiple Rings (ANSI and ETSI)

Table 20-3 shows the rules the ONS 15454 follows to filter packets for the firewall when nodes are 
configured as ENEs and GNEs. If the packet is addressed to the ONS 15454, additional rules, shown in 
Table 20-4, are applied. Rejected packets are silently discarded.
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Table 20-3 Proxy Server Firewall Filtering Rules

Packets Arriving At: Are Accepted if the Destination IP Address is:

TCC2/TCC2P 
Ethernet interface

• The ONS 15454 itself

• The ONS 15454’s subnet broadcast address

• Within the 224.0.0.0/8 network (reserved network used for standard 
multicast messages)

• Subnet mask = 255.255.255.255

DCC interface • The ONS 15454 itself

• Any destination connected through another DCC interface

• Within the 224.0.0.0/8 network
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If you implement the proxy server, note that all DCC-connected ONS 15454s on the same Ethernet 
segment must have the same gateway setting. Mixed values produce unpredictable results, and might 
leave some nodes unreachable through the shared Ethernet segment. 

If nodes become unreachable, correct the setting by performing one of the following:

• Disconnect the craft computer from the unreachable ONS 15454. Connect to the ONS 15454 
through another network ONS 15454 that has a DCC connection to the unreachable ONS 15454.

• Disconnect all DCCs to the node by disabling them on neighboring nodes. Connect a CTC computer 
directly to the ONS 15454 and change its provisioning.

20.2.8 Scenario 8: Dual GNEs on a Subnet
The ONS 15454 provides GNE load balancing, which allows CTC to reach ENEs over multiple GNEs 
without the ENEs being advertised over OSPF. This feature allows a network to quickly recover from 
the loss of GNE, even if the GNE is on a different subnet. If a GNE fails, all connections through that 
GNE fail. CTC disconnects from the failed GNE and from all ENEs for which the GNE was a proxy, and 
then reconnects through the remaining GNEs. GNE load balancing reduces the dependency on the launch 
GNE and DCC bandwidth, both of which enhance CTC performance. 

Note Dual GNEs do not need special provisioning

Figure 20-15 shows a network with dual GNEs on the same subnet.

Table 20-4 Proxy Server Firewall Filtering Rules When Packet Addressed to ONS 15454

Packets Arriving At Rejects

TCC2/TCC2P 
Ethernet interface

• UDP (User Datagram Protocol) 
packets addressed to the SNMP 
trap relay port (391)

DCC interface • TCP (Transmission Control 
Protocol) packets addressed to the 
proxy server port (1080)
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Figure 20-15 Scenario 8: Dual GNEs on the Same Subnet (ANSI and ETSI)
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Figure 20-16 shows a network with dual GNEs on different subnets.

Figure 20-16 Scenario 8: Dual GNEs on Different Subnets (ANSI and ETSI)

20.2.9 Scenario 9: IP Addressing with Secure Mode Enabled
TCC2P cards provide a secure mode option allowing you to provision two IP addresses for the 
ONS 15454. One IP address is provisioned for the ONS 15454 backplane LAN port. The other IP address 
is provisioned for the TCC2P TCP/IP craft port. The two IP addresses provide an additional layer of 
separation between the craft access port and the ONS 15454 LAN. If secure mode is enabled, the IP 
addresses provisioned for the TCC2P TCP/IP ports must follow general IP addressing guidelines. In 
addition, TCC2P IP addresses must reside on a different subnet from the ONS 15454 backplane port and 
ONS 15454 default router IP addresses.

The IP address assigned to the backplane LAN port becomes a private address, which is used to connect 
the ONS 15454 GNE to an OSS (Operations Support System) through a central office LAN or private 
enterprise network. In secure mode, the backplane's LAN IP address is not displayed on the CTC node 
view or to a technician directly connected to the node by default. This default can be changed to allow 
the backplane IP address to be viewed on CTC only by a Superuser.
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Figure 20-17 on page 20-21 shows an example of ONS 15454s on the same subnet with secure mode 
enabled. 

Note Secure mode is not available if TCC2 cards are installed, or if only one TCC2P card is installed.

Figure 20-17 Scenario 9: ONS 15454 GNE and ENEs on the Same Subnet with Secure Mode 

Enabled

Figure 20-18 shows an example of ONS 15454s connected to a router with secure mode enabled. In each 
example, TCC2P port addresses are on a different subnet from the node backplane addresses.
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Figure 20-18 Scenario 9: ONS 15454 GNE and ENEs on Different Subnets with Secure Mode 

Enabled

20.3 Provisionable Patchcords
A provisionable patchcord is a user-provisioned link that is advertised by OSPF throughout the network. 
Provisionable patchcords, also called virtual links, are needed in the following situations:

• An optical port is connected to a transponder or muxponder client port provisioned in transparent 
mode. 

• An optical ITU port is connected to a DWDM optical channel card.

• Two transponder or muxponder trunk ports are connected to a DWDM optical channel card and the 
generic control channel (GCC) is carried transparently through the ring. 

• Transponder or muxponder client and trunk ports are in a regenerator group, the cards are in 
transparent mode, and DCC/GCC termination is not available.

Provisionable patchcords are required on both ends of a physical link. The provisioning at each end 
includes a local patchcord ID, slot/port information, remote IP address, and remote patchcord ID. 
Patchcords appear as dashed lines in CTC network view.

Table 20-5 lists the supported card combinations for client and trunk ports in a provisionable patchcord.
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Note If the OCSM card is installed in Slot 8, provisionable patchcords from OC-N ports to the following cards 
are not supported on the same node: MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_2.5G_10E, TXP_MR_10E, 32MUX-O, 32DMX-O, 32WSS, or 32DMX.

Table 20-6 lists the supported card combinations for client-to-client ports in a patchcord. 

Table 20-7 lists the supported card combinations for trunk-to-trunk ports in a patchcord. 

Optical ports have the following requirements when used in a provisionable patchcord:

Table 20-5 Cisco ONS 15454 Client/Trunk Card Combinations for Provisionable Patchcords

Trunk Cards 

Client Cards

MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

32MUX-O
32DMX-O

32WSS/
32DMX AD-xC-xx.x 4MD-xx.x

MXP_2.5G_10G/
TXP_MR_10G

— — — Yes Yes Yes Yes

TXP_MR_2.5G/
TXPP_MR_2.5G

— — — Yes Yes Yes Yes

MXP_2.5G_10E/
TXP_MR_10E

— — — Yes Yes Yes Yes

MXP_MR_2.5G/
MXPP_MR_2.5G

— — — Yes Yes Yes Yes

OC-192 Yes — Yes — — — —

OC-48 Yes Yes Yes — — — —

OC-192 ITU — — — Yes Yes Yes Yes

OC-48 ITU — — — Yes Yes Yes Yes

Table 20-6 Cisco ONS 15454 Client/Client Card Combinations for Provisionable Patchcords

Client Cards
MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

MXP_2.5G_10G/TXP_MR_10G Yes — Yes

TXP_MR_2.5G/TXPP_MR_2.5G — Yes —

MXP_2.5G_10E/TXP_MR_10E Yes — Yes

Table 20-7 Cisco ONS 15454 Trunk/Trunk Card Combinations for Provisionable Patchcords

Trunk Cards
MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

MXP_2.5G_10G/TXP_MR_10G Yes — Yes

TXP_MR_2.5G/TXPP_MR_2.5G — Yes —

MXP_2.5G_10E/TXP_MR_10E Yes — Yes
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• An optical port connected to transponder/muxponder port or add/drop multiplexer or 
multiplexer/demultiplexer port requires section DCC/line DCC (SDCC/LDCC) termination. 

• If the optical port is the protection port in a 1+1 group, the working port must have SDCC/LDCC 
(ANSI) or RS-DCC/MS-DCC (ETSI) termination provisioned. 

• If the remote end of a patchcord is Y-cable protected or is an add/drop multiplexer or 
multiplexer/demultiplexer port, an optical port requires two patchcords.

Transponder and muxponder ports have the following requirements when used in a provisionable 
patchcord:

• Two patchcords are required when a transponder/muxponder port is connected to an add/drop 
multiplexer or multiplexer/demultiplexer port. CTC automatically prompts the user to set up the 
second patchcord.

• If a patchcord is on a client port in a regenerator group, the other end of the patchcord must be on 
the same node and on a port within the same regenerator group. 

• A patchcord is allowed on a client port only if the card is in transparent mode. 

DWDM cards support provisionable patchcords only on optical channel ports. Each DWDM optical 
channel port can have only one provisionable patchcord.

20.4 Routing Table
ONS 15454 routing information is displayed on the Maintenance > Routing Table tabs. The routing table 
provides the following information:

• Destination—Displays the IP address of the destination network or host.

• Mask—Displays the subnet mask used to reach the destination host or network.

• Gateway—Displays the IP address of the gateway used to reach the destination network or host.

• Usage—Shows the number of times the listed route has been used.

• Interface—Shows the ONS 15454 interface used to access the destination. Values are:

– motfcc0—The ONS 15454 Ethernet interface, that is, the RJ-45 jack on the TCC2/TCC2P and, 
for ANSI shelves, the LAN 1 pins on the backplane or, for ETSI shelves, the LAN connection 
on the MIC-C/T/P.

– pdcc0—An SDCC interface, that is, an OC-N trunk card identified as the SDCC termination.

– lo0—A loopback interface.

Table 20-8 shows sample routing entries for an ONS 15454.

Table 20-8 Sample Routing Table Entries

Entry Destination Mask Gateway Usage Interface

1 0.0.0.0 0.0.0.0 172.20.214.1 265103 motfcc0

2 172.20.214.0 255.255.255.0 172.20.214.92 0 motfcc0

3 172.20.214.92 255.255.255.255 127.0.0.1 54 lo0

4 172.20.214.93 255.255.255.255 0.0.0.0 16853 pdcc0

5 172.20.214.94 255.255.255.255 172.20.214.93 16853 pdcc0
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Entry 1 shows the following:

• Destination (0.0.0.0) is the default route entry. All undefined destination network or host entries on 
this routing table are mapped to the default route entry.

• Mask (0.0.0.0) is always 0 for the default route.

• Gateway (172.20.214.1) is the default gateway address. All outbound traffic that cannot be found in 
this routing table or is not on the node’s local subnet is sent to this gateway.

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 2 shows the following:

• Destination (172.20.214.0) is the destination network IP address.

• Mask (255.255.255.0) is a 24-bit mask, meaning all addresses within the 172.20.214.0 subnet can 
be a destination.

• Gateway (172.20.214.92) is the gateway address. All outbound traffic belonging to this network is 
sent to this gateway. 

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 3 shows the following:

• Destination (172.20.214.92) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.92 address is a destination.

• Gateway (127.0.0.1) is a loopback address. The host directs network traffic to itself using this 
address.

• Interface (lo0) indicates that the local loopback interface is used to reach the gateway. 

Entry 4 shows the following:

• Destination (172.20.214.93) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.93 address is a destination.

• Gateway (0.0.0.0) means the destination host is directly attached to the node.

• Interface (pdcc0) indicates that a DCC interface is used to reach the destination host.

Entry 5 shows a DCC-connected node that is accessible through a node that is not directly connected:

• Destination (172.20.214.94) is the destination host IP address.

• Mask (255.255.255.255) is a 32-bit mask, meaning only the 172.20.214.94 address is a destination.

• Gateway (172.20.214.93) indicates that the destination host is accessed through a node with IP 
address 172.20.214.93.

• Interface (pdcc0) indicates that a DCC interface is used to reach the gateway.

20.5 External Firewalls
This section provides sample access control lists for external firewalls. Table 20-9 lists the ports that are 
used by the TCC2/TCC2P. 
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The following access control list (ACL) example shows a firewall configuration when the proxy server 
gateway setting is not enabled. In the example, the CTC workstation's address is 192.168.10.10. and the 
ONS 15454 address is 10.10.10.100. The firewall is attached to the GNE, so inbound is CTC to the GNE 
and outbound is from the GNE to CTC. The CTC Common Object Request Broker Architecture 
(CORBA) Standard constant is 683 and the TCC CORBA Default is TCC Fixed (57790).

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with ONS 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 57790 
access-list 100 remark *** allows CTC communication with ONS 15454 GNE (port 57790) *** 
access-list 100 remark 

Table 20-9 Ports Used by the TCC2/TCC2P

Port Function Action1

1. D = deny, NA = not applicable, OK = do not deny

0 Never used D

20 FTP D

21 FTP control D

22 SSH D

23 Telnet D

80 HTTP D

111 SUNRPC NA

161 SNMP traps destinations D

162 SNMP traps destinations D

513 rlogin D

683 CORBA IIOP OK

1080 Proxy server (socks) D

2001-2017 I/O card Telnet D

2018 DCC processor on active TCC2/TCC2P D

2361 TL1 D

3082 Raw TL1 D

3083 TL1 D

5001 BLSR server port D

5002 BLSR client port D

7200 SNMP alarm input port D

9100 EQM port D

9401 TCC boot port D

9999 Flash manager D

10240-12287 Proxy client D

57790 Default TCC listener port OK
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access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 established 
access-list 100 remark *** allows ACKs back from CTC to ONS 15454 GNE *** 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 eq 683 
access-list 101 remark *** allows alarms etc., from the 15454 (random port) to the CTC 
workstation (port 683) *** 
access-list 100 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

The following ACL example shows a firewall configuration when the proxy server gateway setting is 
enabled. As with the first example, the CTC workstation address is 192.168.10.10 and the ONS 15454 
address is 10.10.10.100. The firewall is attached to the GNE, so inbound is CTC to the GNE and 
outbound is from the GNE to CTC. CTC CORBA Standard constant is 683 and TCC CORBA Default is 
TCC Fixed (57790).

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with the 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 1080
access-list 100 remark *** allows CTC communication with the 15454 GNE (port 1080) *** 
access-list 100 remark 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

20.6 Open GNE
The ONS 15454 can communicate with non-ONS nodes that do not support Point-to-Point Protocol 
(PPP) vendor extensions or OSPF type 10 opaque link-state advertisements (LSA), both of which are 
necessary for automatic node and link discovery. An open GNE configuration allows a GCC-based 
network to function as an IP network for non-ONS nodes. 

To configure an open GNE network, you can provision GCC terminations to include a far-end, non-ONS 
node using either the default IP address of 0.0.0.0 or a specified IP address. You provision a far-end, 
non-ONS node by checking the “Far End is Foreign” check box during GCC creation. The default 0.0.0.0 
IP address allows the far-end, non-ONS node to identify itself with any IP address; if you set an IP 
address other than 0.0.0.0, a link is established only if the far-end node identifies itself with that IP 
address, providing an extra level of security. 

By default, the proxy server only allows connections to discovered ONS peers and the firewall blocks 
all IP traffic between the GCC network and LAN. You can, however, provision proxy tunnels to allow 
up to 12 additional destinations for SOCKS version 5 connections to non-ONS nodes. You can also 
provision firewall tunnels to allow up to 12 additional destinations for direct IP connectivity between the 
GCC network and LAN. Proxy and firewall tunnels include both a source and destination subnet. The 
connection must originate within the source subnet and terminate within the destination subnet before 
either the SOCKS connection or IP packet flow is allowed. A proxy connection is allowed if the CTC 
client is in a source subnet and the requested destination is in the destination subnet. Firewall tunnels 
allow IP traffic to route between the node Ethernet and pdcc interfaces. A inbound Ethernet packet is 
allowed through the firewall if its source address matches a tunnel source and its destination matches a 
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tunnel destination. An inbound pdcc packet is allowed through the firewall if its source address matches 
a tunnel destination and its destination address matches a tunnel source. Tunnels only affect TCP and 
UDP packets.

The availability of proxy and/or firewall tunnels depends on the network access settings of the node:

• If the node is configured with the proxy server enabled in GNE or ENE mode, you must set up a 
proxy tunnel and/or a firewall tunnel. 

• If the node is configured with the proxy server enabled in proxy-only mode, you can set up proxy 
tunnels. Firewall tunnels are not allowed.

• If the node is configured with the proxy server disabled, neither proxy tunnels or firewall tunnels 
are allowed. 

Figure 20-19 shows an example of a foreign node connected to the GCC network. Proxy and firewall 
tunnels are useful in this example because the GNE would otherwise block IP access between the PC 
and the foreign node.

Figure 20-19 Proxy and Firewall Tunnels for Foreign Terminations

Figure 20-20 shows a remote node connected to an ENE Ethernet port. Proxy and firewall tunnels are 
useful in this example because the GNE would otherwise block IP access between the PC and foreign 
node. This configuration also requires a firewall tunnel on the ENE.
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Figure 20-20 Foreign Node Connection to an ENE Ethernet Port
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C H A P T E R 21

Alarm Management Reference

This chapter describes Cisco Transport Controller (CTC) alarm management. To troubleshoot specific 
alarms, refer to the Cisco ONS 15454 Troubleshooting Guide (for ANSI shelves) or the Cisco ONS 15454 
SDH Troubleshooting Guide (for ETSI shelves). 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 21.1 Overview, page 21-1

• 21.2 Alarm Counts on the LCD for a Node, Slot, or Port, page 21-2

• 21.3 Alarm Display, page 21-2

• 21.4 Alarm Severities, page 21-7

• 21.5 Alarm Profiles, page 21-7

• 21.6 Alarm Suppression, page 21-11

• 21.7 External Alarms and Controls, page 21-12

21.1 Overview
CTC detects and reports alarms generated by the Cisco ONS 15454 and the larger network. You can use 
CTC to monitor and manage alarms at the card, node, or network level. Default alarm severities conform 
to the Telcordia GR-253-CORE standard, but you can set alarm severities in customized alarm profiles 
or suppress CTC alarm reporting. For a detailed description of the standard Telcordia categories 
employed by Optical Networking System (ONS) nodes, refer to the 
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note ONS 15454 alarms can also be monitored and managed through Transaction Language One (TL1) or a 
network management system (NMS).
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21.2 Alarm Counts on the LCD for a Node, Slot, or Port
You can view node, slot, or port-level alarm counts and summaries using the buttons on the ONS 15454 
LCD panel. The Slot and Port buttons toggle between display types; the Slot button toggles between 
node display and slot display, and the Port button toggles between slot and port views. Pressing the 
Status button after you choose the display mode changes the display from alarm count to alarm summary.

The ONS 15454 has a one-button update for some commonly viewed alarm counts. If you press the Slot 
button once and then wait eight seconds, the display automatically changes from a slot alarm count to a 
slot alarm summary. If you press the Port button to toggle to port-level display, you can use the Port 
button to toggle to a specific slot and to view each port’s port-level alarm count. Figure 21-1 shows the 
LCD panel layout.

Figure 21-1 Shelf LCD Panel 

21.3 Alarm Display
In the card, node, or network CTC view, click the Alarms tab to display the alarms for that card, node, 
or network. The Alarms window shows alarms in compliance with Telcordia GR-253-CORE. This means 
that if a network problem causes two alarms, such as loss of frame (LOF) and loss of signal (LOS), CTC 
only shows the LOS alarm in this window because it supersedes the LOF and replaces it. 

The Path Width column in the Alarms and Conditions tabs expands on the alarmed object information 
contained in the access identifier (AID) string (such as “STS-4-1-3”) by giving the number of STSs 
contained in the alarmed path. For example, the Path Width tells you whether a critical alarm applies to 
an STS1 or an STS48c. The column reports the width as a 1, 3, 6, 12, 48,  etc. as appropriate, understood 
to be “STS-N.” 

Table 8-1 on page 8-6 lists the column headings and the information recorded in each column and 
Table 8-2 on page 8-7 provides the color codes for alarm and condition severities.

For a list of circuits with raised alarms, see the “NTP-G66 View Alarm-Affected Circuits” procedure on 
page 8-14.

21.3.1 Viewing Alarms by Time Zone
By default, alarms and conditions are displayed with the time stamp of the CTC workstation where you 
are viewing them. However, you can set the node to report alarms (and conditions) using the time zone 
where the node is located. See the “DLP-G118 Display Alarms and Conditions Using Time Zone” task 
on page 8-10 for instructions.
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21.3.2 Controlling Alarm Display
You can control the display of the alarms shown on the Alarms window. Table 21-1 shows the actions 
you can perform in the Alarms window.

21.3.3 Filtering Alarms
The alarm display can be filtered to prevent the display of alarms with certain severities or alarms that 
occurred between certain dates. You can set the filtering parameters by clicking the Filter button at the 
bottom-left of the Alarms window. You can turn the filter on or off by clicking the Filter tool at the 
bottom-right of the window. CTC retains your filter activation setting. For example, if you turn the filter 
on and then log out, CTC keeps the filter active the next time you log in.

See the “NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering” procedure on page 8-24.

21.3.4 Conditions Tab
The Conditions window displays retrieved fault conditions. A condition is a fault or status detected by 
ONS 15454 hardware or software. When a condition occurs and continues for a minimum period, CTC 
raises a condition, which is a flag showing that this particular condition currently exists on the 
ONS 15454. See the “DLP-G120 View Conditions” task on page 8-11.

The Conditions window shows all conditions that occur, including those that are superseded. For 
instance, if a network problem causes two alarms, such as LOF and LOS, CTC shows both the LOF and 
LOS conditions in this window (even though LOS supersedes LOF). Having all conditions visible can 

Table 21-1 Alarm Display

Button/Check Box/Tool Action

Filter button Allows you to change the display on the Alarms window to show only 
alarms that meet a certain severity level, occur in a specified time frame, or 
reflect specific conditions. For example, you can set the filter so that only 
critical alarms display in the window.

If you enable the Filter feature by clicking the Filter button in one CTC 
view, such as node view, it is enabled in the others as well (card view and 
network view).

Synchronize button Updates the alarm display. Although CTC displays alarms in real time, the 
Synchronize button allows you to verify the alarm display. This is 
particularly useful during provisioning or troubleshooting.

Delete Cleared Alarms 
button

Deletes alarms that have been cleared.

AutoDelete Cleared 
Alarms check box

If checked, CTC automatically deletes cleared alarms.

Filter tool Enables or disables alarm filtering in the card, node, or network view. When 
enabled or disabled, this state applies to other views for that node and for 
all other nodes in the network. For example, if the Filter tool is enabled in 
the node (default login) view Alarms window, the network view Alarms 
window and card view Alarms window also show the tool enabled. All other 
nodes in the network also show the tool enabled.
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be helpful when troubleshooting the ONS 15454. If you want to retrieve conditions that obey a 
root-cause hierarchy (that is, LOS supersedes and replaces LOF), you can exclude the same root causes 
by checking a check box in the window.

Fault conditions include reported alarms and Not Reported or Not Alarmed conditions. Refer to the 
trouble notifications information in the Cisco ONS 15454 Troubleshooting Guide or 
Cisco ONS 15454 SDH Troubleshooting Guide for more information about alarm and condition 
classifications.

21.3.5 Controlling the Conditions Display
You can control the display of the conditions on the Conditions window. Table 21-2 shows the actions 
you can perform in the window.

21.3.5.1 Retrieving and Displaying Conditions

The current set of all existing conditions maintained by the alarm manager can be seen when you click 
the Retrieve button. The set of conditions retrieved is relative to the CTC view. For example, if you click 
the button while displaying the node view, node-specific conditions appear. If you click the button while 
displaying the network view, all conditions for the network (including ONS 15454 nodes and other 
connected nodes) appear, and the card view shows only card-specific conditions.

You can also set a node to display conditions using the time zone where the node is located, rather than 
the time zone of the PC where they are being viewed. See the “DLP-G118 Display Alarms and 
Conditions Using Time Zone” task on page 8-10 for instructions.

21.3.5.2 Conditions Column Descriptions

Table 21-3 lists the Conditions window column headings and the information recorded in each column.

Table 21-2 Conditions Display

Button Action

Retrieve Retrieves the current set of all existing fault conditions, as maintained by 
the alarm manager, from the ONS 15454.

Filter Allows you to change the Conditions window display to only show the 
conditions that meet a certain severity level or occur in a specified time 
frame. For example, you can set the filter so that only critical conditions 
display on the window.

There is a Filter button on the lower-right of the window that allows you to 
enable or disable the filter feature.

Exclude Same Root 
Cause

Retrieves conditions that obey a root-cause hierarchy (LOS supersedes and 
replaces LOF).

Table 21-3 Conditions Column Description

Column Information Recorded

Date Date and time of the condition.

Object TL1 AID for the condition object. For an STSmon or VTmon, the object.
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21.3.5.3 Filtering Conditions

The condition display can be filtered to prevent display of conditions (including alarms) with certain 
severities or that occurred between certain dates. You can set the filtering parameters by clicking the 
Filter button at the bottom-left of the Conditions window. You can turn the filter on or off by clicking 
the Filter tool at the bottom-right of the window. CTC retains your filter activation setting. For example, 
if you turn the filter on and then log out, CTC keeps the filter active the next time your user ID is 
activated.

21.3.6 Viewing History
The History window displays historic alarm or condition data for the node or for your login session. You 
can chose to display only alarm history, only events, or both by checking check boxes in the History > 
Node window. You can view network-level alarm and condition history, such as for circuits, at that level. 
At the node level, you can see all port (facility), card, STS, and system-level history entries. For example, 
protection-switching events or performance-monitoring threshold crossings appear here. If you 
double-click a card, you can view all port, card, and STS alarm or condition history that directly affects 
the card. See the “DLP-G116 View Alarm or Event History” task on page 8-8.

The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 640 minor alarm 
messages, and 640 condition messages. When any of these limits is reached, the ONS 15454 discards 
the oldest events in that category.

Note In the Preference dialog General tab, the Maximum History Entries value only applies to the Session 
window.

Different views of CTC display different kinds of history:

Eqpt Type Card type in this slot.

Slot Slot where the condition occurred (appears only in network and node view).

Port Port where the condition occurred. For STSTerm and VTTerm, the port refers to the 
upstream card it is partnered with.

Path Width Width of the data path.

Sev1 Severity level: CR (Critical), MJ (Major), MN (Minor), NA (Not Alarmed), NR 
(Not Reported).

SA1 Indicates a service-affecting alarm (when checked).

Cond The error message/alarm name; these names are alphabetically defined in the 
Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454 SDH Troubleshooting 
Guide.

Description Description of the condition.

1. All alarms, their severities, and service-affecting statuses are also displayed in the Condition tab unless you choose to filter 
the alarm from the display using the Filter button.

Table 21-3 Conditions Column Description (continued)

Column Information Recorded
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• The History > Session window is shown in network view, node view, and card view. It shows alarms 
and conditions that occurred during the current user CTC session. 

• The History > Node window is only shown in node view. It shows the alarms and conditions that 
occurred on the node since CTC software was operated on the node. 

• The History > Card window is only shown in card view. It shows the alarms and conditions that 
occurred on the card since CTC software was installed on the node. 

Tip Double-click an alarm in the History window to display the corresponding view. For example, 
double-clicking a card alarm takes you to card view. In network view, double-clicking a node alarm takes 
you to node view.

If you check the History window Alarms check box, you display the node history of alarms. If you check 
the Events check box, you display the node history of Not Alarmed and transient events (conditions). If 
you check both check boxes, you retrieve node history for both. 

21.3.6.1 History Column Descriptions

Table 21-4 lists the History window column headings and the information recorded in each column.

Table 21-4 History Column Description

Column Information Recorded

Num Num (number) is the quantity of alarm messages received, and is incremented 
automatically as alarms occur to display the current total of received error messages. 
(The column is hidden by default; to view it, right-click a column and choose Show 
Column.) 

Ref Ref (reference) is a unique identification number assigned to each alarm to reference a 
specific alarm message that is displayed. (The column is hidden by default; to view it, 
right-click a column and choose Show Column.)

Date Date and time of the condition.

Object TL1 AID for the condition object. For an STSmon or VTmon, the object.

Slot Slot where the condition occurred (only displays in network view and node view).

Port Port where the condition occurred. For STSTerm and VTTerm, the port refers to the 
upstream card it is partnered with.

Path Width Width of the data path.

Sev Severity level: Critical (CR), Major (MJ), Minor (MN), Not Alarmed (NA), 
Not Reported (NR).

ST Status: raised (R), cleared (C), or transient (T).

SA Indicates a service-affecting alarm (when checked).

Cond Condition name.

Description Description of the condition.

Eqpt Type Card type in this slot.
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21.3.6.2 Retrieving and Displaying Alarm and Condition History

You can retrieve and view the history of alarms and conditions, including transient conditions (passing 
notifications of processes as they occur) in the CTC History window. The information in this window is 
specific to the view where it is shown (that is, network history in the network view, node history in the 
node view, and card history in the card view). 

The node and card history views are each divided into two tabs. In node view, when you click the 
Retrieve button, you can see the history of alarms, conditions, and transients that have occurred on the 
node in the History > Node window, and the history of alarms, conditions, and transients that have 
occurred on the node during your login session in the History > Session window. In the card-view history 
window, after you retrieve the card history, you can see the history of alarms, conditions, and transients 
on the card in the History > Card window, or a history of alarms, conditions, and transients that have 
occurred during your login session in the History > Session window. You can also filter the severities 
and occurrence period in these history windows.

21.4 Alarm Severities
ONS 15454 alarm severities follow the Telcordia GR-253-CORE standard, so a condition might be 
Alarmed (at a severity of Critical [CR], Major [MJ], or Minor [MN]), Not Alarmed (NA), or Not 
Reported (NR). These severities are reported in the CTC software Alarms, Conditions, and History 
windows at all levels: network, shelf, and card.

ONS equipment provides a standard profile named Default listing all alarms and conditions with severity 
settings based on Telcordia GR-253-CORE and other standards, but users can create their own profiles 
with different settings for some or all conditions and apply these wherever desired. (See the “21.5 Alarm 
Profiles” section on page 21-7.) For example, in a custom alarm profile, the default severity of a carrier 
loss (CARLOSS) alarm on an Ethernet port could be changed from major to critical. The profile allows 
setting to Not Reported or Not Alarmed, as well as the three alarmed severities.

Critical and Major severities are only used for service-affecting alarms. If a condition is set as Critical 
or Major by profile, it will raise as Minor alarm in the following situations: 

• In a protection group, if the alarm is on a standby entity (the side not carrying traffic)

• If the alarmed entity has no traffic provisioned on it, no service is lost

Because of this possibility of being raised at two different levels, the alarm profile pane shows Critical 
as CR / MN and Major as MJ / MN.

21.5 Alarm Profiles
The alarm profiles feature allows you to change default alarm severities by creating unique alarm profiles 
for individual ONS 15454 ports, cards, or nodes. A created alarm profile can be applied to any node on 
the network. Alarm profiles can be saved to a file and imported elsewhere in the network, but the profile 
must be stored locally on a node before it can be applied to the node, its cards, or its cards’ ports. 

CTC can store up to ten active alarm profiles at any time to apply to the node. Custom profiles can take 
eight of these active profile positions. Two other profiles, Default profile and Inherited profile, are 
reserved by the NE, and cannot be edited.The reserved Default profile contains Telcordia GR-253-CORE 
severities. The reserved Inherited profile allows port alarm severities to be governed by the card-level 
severities, or card alarm severities to be determined by the node-level severities.
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If one or more alarm profiles have been stored as files from elsewhere in the network onto the local PC 
or server hard drive where CTC resides, you can utilize as many profiles as you can physically store by 
deleting and replacing them locally in CTC so that only eight are active at any given time.

See the “NTP-G68 Create, Download, and Assign Alarm Severity Profiles” procedure on page 8-16.

21.5.1 Creating and Modifying Alarm Profiles
Alarm profiles are created in the network view using the Provisioning > Alarm Profiles tabs. Figure 21-2 
shows the default list of alarm severities. A default alarm severity following Telcordia GR-253-CORE 
standards is preprovisioned for every alarm. After loading the default profile or another profile on the 
node, you can clone a profile to create custom profiles. After the new profile is created, the Alarm 
Profiles window shows the original profile (frequently Default) and the new profile.

Figure 21-2 Network View Alarm Profiles Window

Note The alarm profile list contains a master list of alarms that is used for a mixed node network. Some of 
these alarms might not be used in all ONS nodes.

Note The Default alarm profile list contains alarm and condition severities that correspond when applicable 
to default values established in Telcordia GR-253-CORE.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to Minor 
(MN) in non-service-affecting situations as defined in Telcordia GR-474. 
21-8
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Chapter 21      Alarm Management Reference
Alarm Profiles
Tip To see the full list of profiles, including those available for loading or cloning, click the Available button. 
You must load a profile before you can clone it. 

Note Up to 10 profiles, including the two reserved profiles (Inherited and Default) can be stored in CTC.

Wherever it is applied, the Default alarm profile sets severities to standard Telcordia GR-253-CORE 
settings. In the Inherited profile, alarms inherit, or copy, severity from the next-highest level. For 
example, a card with an Inherited alarm profile copies the severities used by the node housing the card. 
If you choose the Inherited profile from the network view, the severities at the lower levels (node and 
card) are copied from this selection. 

You do not have to apply a single severity profile to the node-, card-, and port-level alarms. Different 
profiles can be applied at different levels. You could use the inherited or default profile on a node and 
on all cards and ports, but apply a custom profile that downgrades an alarm on one particular card. For 
example, you might choose to downgrade an OC-N unequipped path alarm (UNEQ-P) from Critical 
(CR) to Not Alarmed (NA) on an optical card because this alarm raises and then clears every time you 
create a circuit. UNEQ-P alarms for the card with the custom profile would not display on the Alarms 
tab (but they would still be recorded on the Conditions and History tabs.) 

When you modify severities in an alarm profile:

• All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to Minor (MN) 
in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

• Default severities are used for all alarms and conditions until you create a new profile and apply it. 

The Load and Store buttons are not available for Retrieve and Maintenance users.

The Delete and Store options will only display nodes to delete profiles from or store profiles to if the 
user has provisioning permission for those nodes. If the user does not have the proper permissions, CTC 
greys out the buttons and they are not available to the user.

21.5.2 Alarm Profile Buttons
The Alarm Profiles window displays six buttons at the bottom of the screen. Table 21-5 lists and 
describes each of the alarm profile buttons and their functions. 

Table 21-5 Alarm Profile Buttons

Button Description

New Creates a new profile.

Load Loads a profile to a node or a file.

Store Saves profiles on a node (or nodes) or in a file.

Delete Deletes profiles from a node.

Compare Displays differences between alarm profiles (for example, individual alarms that 
are not configured equivalently between profiles).

Available Displays all profiles available on each node.

Usage Displays all entities (nodes and alarm subjects) present in the network and which 
profiles contain the alarm. Can be printed.
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21.5.3 Alarm Profile Editing
Table 21-6 lists and describes the five profile-editing options available when you right-click an alarm 
item in the profile column (such as Default). 

21.5.4 Alarm Severity Options
To change or assign alarm severity, left-click the alarm severity you want to change in the alarm profile 
column. Seven severity levels appear for the alarm:

• Not Reported (NR)

• Not Alarmed (NA)

• Minor (MN)

• Major (MJ) 

• Critical (CR)

• Use Default

• Inherited

Inherited and Use Default severity levels only appear in alarm profiles. They do not appear when you 
view alarms, history, or conditions. 

21.5.5 Row Display Options
In the network or node view, the Alarm Profiles window (Alarm Profile Editor for Node view) displays 
three check boxes at the bottom of the window:

• Only show service-affecting severities—If unchecked, the editor shows severities in the format 
sev1/sev2 where sev1 is a service-affecting severity and sev2 is not service-affecting. If checked, the 
editor only shows sev1 alarms.

• Hide reference values—Highlights alarms with nondefault severities by clearing alarm cells with 
default severities.

• Hide identical rows—Hides rows of alarms that contain the same severity for each profile. 

Table 21-6 Alarm Profile Editing Options

Button Description

Store Saves a profile in a node or in a file.

Rename Changes a profile name.

Clone Creates a profile that contains the same alarm severity settings as the profile being cloned.

Reset Restores a profile to its previous state or to the original state (if it has not yet been applied).

Remove Removes a profile from the table editor.
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21.5.6 Applying Alarm Profiles
In CTC node view, the Alarm Behavior window displays alarm profiles for the node. In card view, the 
Alarm Behavior window displays the alarm profiles for the selected card. Alarm profiles form a 
hierarchy. A node-level alarm profile applies to all cards in the node except cards that have their own 
profiles. A card-level alarm profile applies to all ports on the card except ports that have their own 
profiles.

At the node level, you can apply profile changes on a card-by-card basis or set a profile for the entire 
node. At the card-level view, you can apply profile changes on a port-by-port basis or set alarm profiles 
for all ports on that card. Figure 21-3 shows alarm profiles for an OPT-BST card.

Figure 21-3 OPT-BST Card Alarm Profiles

21.6 Alarm Suppression
ONS 15454 nodes have an alarm suppression option that clears raised alarm messages for the node, 
chassis, one or more slots (cards), or one or more ports. After they are cleared, these alarms change 
appearance from their normal severity color to white and they can be cleared from the display by clicking 
Synchronize. Alarm suppression itself raises an alarm called AS-CMD that is shown in applicable 
Alarms windows. Node-level suppression is shown in the node view Alarms window, and card or 
port-level suppression is shown in all views. The AS-CMD alarm itself is not cleared by the suppress 
command. Each instance of this alarm indicates its object separately in the Object column.

A suppression command applied at a higher level does not supersede a command applied at a lower level. 
For example, applying a node-level alarm suppression command makes all raised alarms for the node 
appear to be cleared, but it does not cancel out card-level or port-level suppression. Each of these 
conditions can exist independently and must be cleared independently. 
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Suppression causes the entity alarm to behave like a Not Reported event. This means that the alarms, 
having been suppressed from view in the Alarms window, are now only shown in the Conditions window. 
The suppressed alarms are displayed with their usual visual characteristics (service-affecting status and 
color-coding) in the window. The alarms still appear in the History window.

See the “NTP-G70 Suppress Alarms or Discontinue Alarm Suppression” procedure on page 8-28.

Note Use alarm suppression with caution. If multiple CTC or TL1 sessions are open, suppressing the alarms 
in one session suppresses the alarms in all other open sessions.

21.7 External Alarms and Controls
External alarm inputs can be provisioned on the Alarm Interface Controller–International (AIC-I) card 
for external sensors such as an open door and flood sensors, temperature sensors, and other 
environmental conditions. External control outputs on these two cards allow you to drive external visual 
or audible devices such as bells and lights. They can control other devices such as generators, heaters, 
and fans.

Up to 12 external alarm inputs and four external controls are available with the AIC-I card. If you also 
provision the alarm extension panel (AEP), there are 32 inputs and 16 outputs. The AEP is compatible 
with the ONS 15454 ANSI shelf only. It is not compatible with the ONS 15454 ETSI shelf.

See the “NTP-G72 Provision External Alarms and Controls on the Alarm Interface 
Controller-International Card” procedure on page 8-31.

21.7.1 External Alarms
You can provision each alarm input separately. Provisionable characteristics of external alarm inputs 
include:

• Alarm Type—List of alarm types.

• Severity—CR, MJ, MN, NA, and NR.

• Virtual Wire—The virtual wire associated with the alarm.

• Raised When—Open means that the normal condition is no current flowing through the contact, and 
the alarm is generated when current does flow; closed means that normal condition is to have current 
flowing through the contact, and the alarm is generated when current stops flowing.

• Description—CTC alarm log description (up to 63 characters).

Note If you provision an external alarm to raise when a contact is open, and you have not attached the 
alarm cable, the alarm will remain raised until the alarm cable is connected. 

Note When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to 
the external alarm’s number, regardless of the name you assign.
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21.7.2 External Controls
You can provision each alarm output separately. Provisionable characteristics of alarm outputs include:

• Control type.

• Trigger type (alarm or virtual wire).

• Description for CTC display.

• Closure setting (manually or by trigger). If you provision the output closure to be triggered, the 
following characteristics can be used as triggers:

– Local NE alarm severity—A chosen alarm severity (for example, major) and any higher-severity 
alarm (in this case, critical) causes output closure.

– Remote NE alarm severity—Similar to local NE alarm severity trigger setting, but applies to 
remote alarms.

– Virtual wire entities—You can provision an alarm that is input to a virtual wire to trigger an 
external control output.

21.7.3 Virtual Wires
Provisioning the AIC and AIC-I card provides a “virtual wires” option used to route external alarms and 
controls from different nodes to one or more alarm collection centers. In Figure 21-4, smoke detectors 
at Nodes 1, 2, 3, and 4 are assigned to Virtual Wire #1, and Virtual Wire #1 is provisioned as the trigger 
for an external bell at Node 1. 
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Chapter 21      Alarm Management Reference
External Alarms and Controls
Figure 21-4 External Alarms and Controls Using a Virtual Wire

When using AIC virtual wires, you can:

• Assign different external devices to the same virtual wire.

• Assign virtual wires as the trigger type for different external controls.
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CTC Information and Shortcuts

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This appendix describes the Cisco Transport Controller (CTC) views, menus options, tool options, 
shortcuts, and table display options. This appendix also describes the shelf inventory data presented in 
CTC. For more information about CTC, see Chapter 18, “CTC Operation Reference.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Display Node, Card, and Network Views
CTC provides three views of the ONS 15454 and the ONS network:

• Node view appears when you first log into an ONS 15454. This view shows a graphic of the 
ONS 15454 shelf and provides access to tabs and subtabs that you use to manage the node.

• Card view provides access to individual ONS 15454 cards. This view provides a graphic of the card 
and provides access to tabs and subtabs that you use to manage the card.

• Network view shows all the nodes in a ring. A Superuser can set up this feature so each user will see 
the same network view, or the user can create a custom view with maps. This view provides access 
to tabs and subtabs that you use to manage the network.

Table A-1 lists different actions for changing CTC views.
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Display Node, Card, and Network Views
Node Icons on the Network View Map
Table A-2 lists the node icons on the network view map.

Table A-1 Change CTC Views

To Display Perform One of the Following

Node view • Log into a node; node view is the default view.

• In network view, double-click a node icon, or right-click the node and 
choose Open Node from the shortcut menu.

• In network view, single-click a node icon, then choose Go To Selected 
Object View from the View menu.

• From the View menu, choose Go To Other Node, then choose the node 
you want from the shortcut menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in network view, click a node, then click the down arrow.

Network view • In node view, click the up arrow or the Network View tool on the CTC 
toolbar.

• From the View menu, choose Go To Network View.

Card view • In node view, double-click a card or right-click the card and choose 
Open Card.

• In node view, single-click a card icon, then choose Go To Selected Object 
View from the View menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in node view, click a card, then click the down arrow.
A-2
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Appendix A      CTC Information and Shortcuts
Display Node, Card, and Network Views
Table A-2 Description of Node Icons on Network View Map

Node Name Icon Description

SONET

SDH

Hybrid OADM

Hybrid line amplifier

Hybrid terminal

Passive hybrid terminal

Amplified TDM 

A SONET, SDH, hybrid, or amplified time-division 
multiplexing (TDM) node icon is represented as a cylinder 
with crossed arrows. 

Note Release 4.7 is DWDM only. It does not support 
SONET, SDH, or hybrid nodes.

• A SONET or SDH node can include OC-N cards, 
electrical cards, cross-connects, and more. 

• A hybrid optical add/drop multiplexing (OADM) node 
contains at least one Channel OADM (AD-xC-xx.x) or 
one Band OADM (AD-xB-xx.x) card and two Advanced 
Timing, Communications, and Controller (TCC2/TCC2P) 
cards. TDM cards can be installed in any available slot.

• A hybrid line amplifier node contains amplifiers and both 
TDM and dense wavelength division multiplexing 
(DWDM) cards.

• A hybrid terminal node contains at least one 32-Channel 
Multiplexer (32MUX-O) card, one Double-Slot 
32-Channel Demultiplexer (32DMX-O) card, amplifiers, 
two TCC2/TCC2P cards, and TDM cards.

• A passive hybrid terminal node has the same equipment as 
the hybrid terminal node, but does not contain amplifiers.

• An amplified TDM node is a node that increases the span 
length between two ONS 15454 nodes that contain TDM 
cards and optical amplifiers. Amplified TDM nodes 
contain either Optical Booster (OPT-BST) amplifiers or 
AD-1C cards.

Hub A DWDM hub node icon is represented as a three-dimensional 
cylinder with amplifiers. A hub node contains at least two 
32DMX or 32DMX-O cards and two 32MUX-O. No OADM 
cards are provisioned.

OADM A DWDM OADM node icon is represented as a 
three-dimensional cylinder with arrows. An OADM node 
contains at least one AD-xC-xx.x or one AD-xB-xx.x. No 
32MUX-O, 32DMX-O, or 32DMX cards are provisioned.
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Manage the CTC Window
Different navigational methods are available within the CTC window to access views and perform 
management actions. You can double-click and right-click objects in the graphic area and move the 
mouse over nodes, cards, and ports to view popup status information.

ROADM A reconfigurable OADM (ROADM) node icon is represented 
as a three-dimensional cylinder with two amplifier symbols 
that have arrows between them. An ROADM node contains at 
least one 32-channel Wavelength Selective Switch (32WSS). 
A single-slot 32DMX or double-slot 32DMX-O can be 
installed, but is not required. Transponders (TXPs) and 
muxponders (MXPs) can be installed in Slots 6 and 12. If 
amplification is not used, TXPs or MXPs can be installed in 
Slots 1 and 17. If OPT-BSTs are not installed, Optical Service 
Channel and Combiner/Separator Module (OSC-CSM) cards 
are installed in Slots 2 and 16 and Slots 8 and 10 are empty.

Terminal (west) A terminal (west) node is represented as a three-dimensional 
cylinder with one amplifier on the west side of the icon.

• A terminal node contains one 32DMX or 32DMX-O and 
one 32-MUX-O. No OADM cards are provisioned.

• A flexible terminal node contains a series of OADM and 
amplifier cards.

Terminal (east) A terminal (east) node is represented as a three-dimensional 
square with one amplifier on the east side of the icon. 

• A terminal node contains one 32DMX or 32DMX-O and 
one 32MUX-O. No OADM cards are provisioned.

• A flexible terminal node contains a series of OADM and 
amplifier cards.

Line

OSC regeneration line 

Line and OSC regeneration line nodes are represented as a 
three-dimensional cylinder with one arrow pointing west and 
another arrow pointing east. 

• A line node has only Optical Preamplifier (OPT-PRE) or 
OPT-BST amplifiers provisioned.

• An optical service channel (OSC) regeneration line node 
contains two OSC-CSM cards. 

Unknown An unknown DWDM node icon is represented as a 
three-dimensional cylinder with one arrow pointing north. An 
unknown node means that the provisioned cards do not allow 
the node to fit any of the defined DWDM node categories.

Table A-2 Description of Node Icons on Network View Map (continued)

Node Name Icon Description
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CTC Menu and Toolbar Options
The CTC window menu bar and toolbar provide primary CTC functions. Table A-3 shows the actions 
that are available from the CTC menu and toolbar.

Table A-3 CTC Menu and Toolbar Options

Menu Menu Option Toolbar Description

File Add Node Adds a node to the current session. See the “DLP-G49 Add a Node to the Current 
Session or Login Group” task on page 2-29.

Delete Selected 
Node

Deletes a node from the current session. 

Lock CTC Locks CTC without closing the CTC session. A user name and password are 
required to open CTC.

Print Prints CTC data. See the “DLP-G113 Print CTC Data” task on page 8-2.

Export Exports CTC data. See the “DLP-G114 Export CTC Data” task on page 8-4.

Exit — Closes the CTC session. 

Edit Preferences Displays the Preferences dialog box, which shows the following tabs:

• General—Allows you to change event defaults and manage preferences.

• Login Node Groups—Allows you to create login node groups. See the 
“DLP-G48 Create Login Node Groups” task on page 2-28.

• Map—Allows you to customize the network view. See the “DLP-G168 
Change the Network View Background Color” task on page 10-16 and the 
“DLP-G170 Apply a Custom Network View Background Map” task on 
page 10-18.

• Circuit—Allows you to change the color of circuit spans. This task is not 
applicable on DWDM-only nodes.

• Firewall—Sets the Internet Inter-ORB Protocol (IIOP) listener ports for 
access to the ONS 15454 through a firewall. See the “NTP-G27 Set Up the 
ONS 15454 for Firewall Access” procedure on page 3-21.

• JRE—Allows you to select another Java Runtime Environment (JRE) 
version. See the “DLP-G52 Change the JRE Version” task on page 2-31.
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View Go To Previous View Displays the previous CTC view.

Go To Next View Displays the next CTC view. Available only after you navigate to a previous 
view. Go to Previous View and Go to Next View are similar to forward and 
backward navigation in a web browser.

Go To Parent View References the CTC view hierarchy: network view, node view, and card view. In 
card view, this command displays the node view; in node view, the command 
displays network view. Not available in network view.

Go To Selected 
Object View

Displays the object selected in the CTC window.

Go To Home View Displays the login node in node view.

Go To Network View Displays the network view.

Go To Other Node Displays a dialog box allowing you to type in the node name or IP address of a 
a network node that you want to view. 

Show Status Bar — Click this item to display or hide the status bar at the bottom of the CTC window.

Show Tool Bar — Click this item to display or hide the CTC toolbar.

— — Zooms out the network view area (toolbar only).

— — Zooms in the network view area (toolbar only).

— — Zooms in a selected network view area (toolbar only).

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Tools Circuits — Displays the following options:

• Repair Circuits—Repairs incomplete circuits following replacement of the 
ONS 15454 alarm interface panel (AIP). Refer to the Cisco ONS 15454 
SONET and DWDM Troubleshooting Guide for more information.

• Reconfigure Circuits—Allows you to reconfigure circuits. Not applicable to 
DWDM nodes.

• Set Path Selector Attributes—Allows you to edit path protection or 
subnetwork connection protection (SNCP) circuit path selector attributes. 
Not applicable on DWDM nodes.

• Set Circuit State—Allows you to change a circuit state. Not applicable on 
DWDM nodes.

• Roll Circuit—(ONS 15600 only.) Allows you to reroute live traffic without 
interrupting service. Refer to the Cisco ONS 15600 Procedure Guide.

• Delete Rolls —(ONS 15600 only.) Refer to the Cisco ONS 15600 Procedure 
Guide.

Overhead Circuits — Displays the Repair IP Tunnels option, which fixes circuits that are in the 
PARTIAL status as a result of node IP address changes. See the “DLP-G111 
Repair an IP Tunnel” task on page 7-21.

Topology Upgrade — Displays the following options:

• Convert UPSR (or SNCP) to BLSR (or MS-SPRing)—Converts a path 
protection to a bidirectional line switch ring (BLSR). Not applicable to 
DWDM nodes.

• Convert Unprotected to UPSR (or SNCP)—Converts a point-to-point or 
linear add/drop multiplexer (ADM) to path protection. Not applicable to 
DWDM nodes.

Manage VLANs — Displays a list of VLANs that have been created and allows you to delete 
VLANs. Not applicable to DWDM nodes.

Open TL1 
Connection

Displays the TL1 session dialog box so you can create a TL1 session to a 
specific node. Refer to the Cisco ONS SONET TL1 Command Guide and the 
Cisco ONS 15454 SDH TL1 Command Guide.

Open IOS 
Connection

Displays the Cisco IOS command line interface dialog box if a Cisco IOS 
capable card (ML1000-2 or ML100T-12) is installed in the node. Not applicable 
to DWDM nodes.

Help Contents and Index — Displays the online help window.

User Manuals — Displays the Cisco ONS 15454 documentation.

About CTC — Displays the software version and the nodes in the CTC session.

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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CTC Mouse Options
In addition to the CTC menu bar and toolbar, you can invoke actions by double-clicking CTC window 
items with your mouse, or by right-clicking an item and selecting actions from shortcut menus. 
Table A-4 lists the CTC window mouse shortcuts.

— Network Scope — Displays the selected network scope. The network scope drop-down list has 
three options: DWDM, TDM, or All. If you choose DWDM, DWDM and hybrid 
nodes appear on the network view map. If you choose TDM, TDM and hybrid 
nodes appear on the network view map. If you choose All, every node on the 
network appears on the network view map.

Note Release 4.7 is DWDM only. Hybrid configurations are not supported. 

— — Opens the CTC Alerts dialog box, which shows the status of certain CTC 
background tasks. When the CTC Alerts toolbar icon contains a red triangle, 
unread notifications exist. When there are no unread notifications, the CTC 
Alerts toolbar icon contains a gray triangle (see the icons in the Toolbar column 
for comparison). Notifications include:

• Network disconnection.

• Send-PDIP inconsistency—CTC discovers a new node that does not have a 
SEND-PDIP setting consistent with the login node.

• Circuit deletion status—Reports when the circuit deletion process 
completes if you chose “Notify when complete” as described in the 
“NTP-G61 Modify and Delete Overhead Circuits” procedure on page 7-20. 
The CTC Alerts window always reports circuit deletion errors. 

• Conditions retrieval error.

• Software download failure.

You can save a notification by clicking the Save button in the CTC Alerts dialog 
box and navigating to the directory where you want to save the text file. 

By default, the CTC Alerts dialog box appears automatically. To disable 
automatic popup, see the “DLP-G53 Configure the CTC Alerts Dialog Box for 
Automatic Popup” task on page 2-32. 

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Table A-4 CTC Window Mouse Shortcuts

Technique Description

Double-click • Node in network view—Displays the node view.

• Card in node view—Displays the card view.

• Alarm/Event—Displays the object that raised the alarm or event.

• Circuits—Displays the Edit Circuit window.

Right-click • Network view graphic area—Displays a menu that you can use to create a 
new domain; change the position and zoom level of the graphic image; save 
the map layout (if you have a Superuser security level); reset the default 
layout of the network view; set, change, or remove the background image 
and color; and save or reset the node position.

• Node in network view—Displays a menu that you can use to open the node, 
reset the node icon position to the longitude and latitude set on the 
Provisioning > General tab, delete the node, fix the node position for 
automatic layout, provision circuits, provision channels, and update circuits 
or channels with a new node.

• Span in network view—Displays a menu that you can use to view 
information about the span’s source and destination ports, the protection 
scheme, and the optical or electrical level. 

• Card in node view—Displays a menu that you can use to open, delete, reset, 
and change cards. The card that you choose determines the commands that 
appear.

• Card in card view—Displays a menu that you can use to reset the card, or 
go to the parent view (node view).

• Empty slot in node view—Displays a menu with cards that you can choose 
to preprovision the slot.

Move mouse cursor • Over node in network view—Displays a summary of node alarms and 
provides a warning if the node icon has been moved out of the map range.

• Over span in network view—Displays circuit (node, slot, port) bandwidth 
and protection information. For DWDM spans, the optical direction and 
optical ring ID appear. If the span terminates on the trunk port of a 
transponder card (TXP or MXP), the associated DWDM wavelength also 
appears.

• Over card in node view—Displays card type, card status, alarm profile 
status and, depending on the DWDM card type, number of bands or 
channels. 

• Over card port in node view—Displays card name, port state, and alarm 
profile status.

• Over card port in card view—Displays port state and alarm profile status. 
For DWDM cards, the port number is labeled as channel, band, or line 
depending on the card type along with the port state and alarm profile status.
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Node View Shortcuts
Table A-5 shows actions on ONS 15454 cards that you can perform by moving your mouse over the CTC 
window.

Network View Tasks
Right-click the network view graphic area or a node, span, or domain to display shortcut menus. 
Table A-6 lists the actions that are available from the network view.

Table A-5 Node View Card-Related Shortcuts

Action Shortcut

Display card 
information

In node view, move your mouse over cards in the graphic to display tool tips 
with the card type, card status (active or standby), the highest level of alarm (if 
any), and the alarm profile used by the card.

Open, reset, or delete 
a card

In node view, right-click a card. Choose Open Card to display the card in card 
view, Delete Card to delete it, or Reset Card to reset the card.

Preprovision a slot In node view, right-click an empty slot. Choose the card type for which you 
want to provision the slot from the shortcut menu.

Change a card In node view, right-click an OC-N card or a DS3 card, and choose 
Change Card. In the Change Card dialog box, choose the card type. 
Change Card retains all card provisioning, including data communications 
channel (DCC) terminations, protection, circuits, and ring.

Table A-6 Network Management Tasks in Network View

Action Task

Open a node Any of the following:

• Double-click a node icon.

• Right-click a node icon and choose Open Node from the shortcut menu.

• Click a node and choose Go To Selected Object View from the View 
menu.

• From the View menu, choose Go To Other Node. Choose a node from the 
Select Node dialog box.

• Double-click a node alarm or event in the Alarms or History tab.

Move a node icon Press the Ctrl key and the left mouse button simultaneously and drag the node 
icon to a new location.

Reset node icon 
position

Right-click a node and choose Reset Node Position from the shortcut menu. 
The node icon moves to the position defined by the longitude and latitude fields 
on the Provisioning > General tab in node view.

Provision a circuit Right-click a node. From the shortcut menu, choose Provision Circuit To and 
choose the node where you want to provision the circuit. For circuit creation 
procedures, see Chapter 7, “Create Channels and Circuits.”
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Table Display Options
Right-clicking a table column displays a menu. Table A-7 shows table display options, which include 
rearranging or hiding CTC table columns and sorting table columns by primary or secondary keys. 

Update circuits with 
new node

Right-click a node and choose Update Circuits With New Node from the 
shortcut menu. Use this command when you add a new node and want to pass 
circuits through it.

Display a link end 
point

Right-click a span. From the shortcut menu, choose Go To {<node> | <port> 
| <slot>} for the drop port you want to view. CTC displays the card in card 
view.

Display span 
properties

Do any of the following: 

• Move the mouse over a span; the properties appear near the span.

• Click a span; the properties appear in the upper left corner of the window.

• Right-click a span; the properties appear at the top of the shortcut menu.

Perform a path 
protection (ANSI) or 
SNCP (ETSI) 
protection switch for 
an entire span

Right-click a network span and click Circuits. In the Circuits on Span dialog 
box, switch options appear in the path protection (or SNCP) Span Switching 
field.

Display DWDM span 
properties

Right-click a DWDM network span and choose Circuits from the shortcut 
menu. The optical channel network connection (OCHNC), optical direction, 
and circuit appear.

Upgrade a span Right-click a span and choose Upgrade Span from the shortcut menu. Not 
applicable to DWDM nodes.

Table A-6 Network Management Tasks in Network View (continued)

Action Task

Table A-7 Table Display Options

Task Click Right-Click Shortcut Menu

Resize column Click while dragging the column 
separator to the right or left.

—

Rearrange column order Click while dragging the column 
header to the right or left.

—

Reset column order — Choose Reset Columns Order/Visibility.

Hide column — Choose Hide Column.

Show column — Choose Show Column > column_name.

Display all hidden 
columns

— Choose Reset Columns Order/Visibility.

Sort table (primary) Click a column header; each 
click changes sort order 
(ascending or descending).

Choose Sort Column.
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Equipment Inventory
In node view, the Inventory tab displays information about the ONS 15454 equipment, including:

• Delete button—After highlighting a card with your mouse, use this button to delete the card from 
node view.

• Reset button—After highlighting a card with your mouse, use this button to reset the card.

• Location—Identifies where the equipment is installed, either chassis or slot number.

• Eqpt Type—Displays the type of equipment but not the specific card name, for example, OC-12 or 
DS-1.

• Actual Eqpt Type—Displays the specific card name, for example, OC12 IR/STM4 SH 1310.

• Admin State—Changes the card service state unless network conditions prevent the change. For 
more information about card administrative states, see Appendix C, “DWDM Administrative and 
Service States.”

– IS (ANSI) or Unlocked (ETSI)—Places the card in the In-Service and Normal (IS-NR [ANSI]) 
or Unlocked-enabled (ETSI) service state.

– OOS,MA (ANSI) or Locked,maintenance (ETSI)—Places the card in the Out-of-Service and 
Autonomous, Maintenance (OOS-AU,MT [ANSI]) or Unlocked-disabled,maintenance (ETSI) 
service state.

• Service State—Displays the current card service state, which is an autonomously generated state 
that gives the overall condition of the card. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For more information about card service states, see 
Appendix C, “DWDM Administrative and Service States.” 

• HW Part #—Displays the hardware part number; this number is printed on the top of the card or 
equipment piece.

• HW Rev—Displays the hardware revision number.

• Serial #—Displays the equipment serial number; this number is unique to each card.

• CLEI Code—Displays the Common Language Equipment Identifier code.

• Firmware Rev—Displays the revision number of the software used by the application-specific 
integrated circuit (ASIC) chip installed on the ONS 15454 card.

• Product ID—Displays the manufacturing product identifier for a hardware component, such as a fan 
tray, chassis, or card. The Product ID column displays “N/A” for equipment existing before 
Software Release 4.6.

• Version ID—Displays the manufacturing version identifier for a fan tray, chassis, or card. The 
Version ID column displays “N/A” for equipment existing before Software Release 4.6.

Sort table (secondary 
sorting keys)

Press the Shift key and 
simultaneously click the column 
header.

Choose Sort Column (incremental).

Reset sorting — Choose Reset Sorting.

View table row count — View the number after “Row count=” (it is 
the last item on the shortcut menu).

Table A-7 Table Display Options (continued)

Task Click Right-Click Shortcut Menu
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Hardware Specifications

This appendix contains hardware and software specifications for the ONS 15454 ANSI and ETSI shelf 
assemblies and cards.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

B.1 Shelf Specifications
This section provides specifications for shelf bandwidth; a list of topologies; Cisco Transport Controller 
(CTC) specifications; the LAN, TL1, modem, and alarm specifications; timing, power, and 
environmental specifications; and shelf dimensions.

B.1.1 Bandwidth
The ONS 15454 has the following bandwidth specifications:

• Total bandwidth: 240 Gbps

• Data plane bandwidth: 160 Gbps

• SONET/SDH plane bandwidth: 80 Gbps

B.1.2 Configurations
The ONS 15454 can be configured for the following dense wavelength division multiplexing (DWDM) 
topologies:

• Hubbed rings 

• Multihubbed rings

• Point-to-point

• Linear

• Linear with optical add/drop multiplexing (OADM)
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B.1.3   Cisco Transport Controller
B.1.3 Cisco Transport Controller
CTC, the ONS 15454 craft interface software, has the following specifications: 

• 10BaseT 

• Advanced Timing, Communications, and Control (TCC2/TCC2P) card access: RJ-45 connector

• Backplane access: LAN pin field (ANSI only) 

• Front Mount Electrical Connection (FMEC) access: LAN connector on MIC-C/T/P faceplate (ETSI 
only)

B.1.4 External LAN Interface
The ONS 15454 external LAN interface has the following specifications: 

• 10BaseT Ethernet

• Backplane access: LAN pin field (ANSI only)

• FMEC access: LAN connector on MIC-C/T/P faceplate (ETSI only)

B.1.5 TL1 Craft Interface
The ONS 15454 TL1 craft interface has the following specifications: 

• Speed: 9600 bps

• TCC2/TCC2P access: EIA/TIA-232 DB-9 type connector

• Backplane access: CRAFT pin field (ANSI only)

B.1.6 Modem Interface
The ONS 15454 modem interface has the following specifications: 

• Hardware flow control

• TCC2/TCC2P: EIA/TIA-232 DB-9 type connector

B.1.7 Alarm Interface
The ONS 15454 alarm interface has the following specifications: 

• ETSI

– Visual: Critical, Major, Minor, Remote

– Audible: Critical, Major, Minor, Remote

– FMEC access: 62-Pin DB connector on MIC-A/P faceplate

– Alarm inputs: Common 32-VDC output for all alarm-inputs, closed contact limited to 2 mA

– Control outputs: Open contact maximum 60 VDC, closed contact maximum 100 mA

• ANSI
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B.1.8   EIA Interface (ANSI only)
– Visual: Critical, Major, Minor, Remote

– Audible: Critical, Major, Minor, Remote

– Backplane access: Alarm pin fields

– Alarm contacts: 0.045 mm, –48 V, 50 mA

B.1.8 EIA Interface (ANSI only)
The ONS 15454 electrical interface assembly (EIA) interface has the following specifications: 

• SMB: AMP #415504-3 75-ohm, 4-leg connectors

• BNC: Trompeter #UCBJ224 75-ohm 4 leg connector (King or ITT are also compatible)

• AMP Champ: AMP#552246-1 with #552562-2 bail locks

B.1.9 BITS Interface (ANSI only)
The ONS 15454 building integrated timing supply (BITS) interface has the following specifications: 

• 2 DS-1 BITS inputs

• 2 derived DS-1 outputs

• Backplane access: BITS pin field

B.1.10 System Timing
The ONS 15454 ANSI has the following system timing specifications: 

• Stratum 3 per Telcordia GR-253-CORE

• Free running accuracy: +/– 4.6 ppm

• Holdover stability: 3.7 x 10–7 per day, including temperature (< 255 slips in first 24 hours)

• Reference: External BITS, line, internal

The ONS 15454 ETSI has the following system timing specifications: 

• Stratum 3E, per ITU-T G.813

• Free running accuracy: +/– 4.6 ppm

• Holdover stability: 3.7 exp –7 per day, including temperature (< 255 slips in first 24 hours)

• Reference: External BITS, line, internal

B.1.11 System Power
The ONS 15454 ANSI has the following power specifications: 

• Input power: –48 VDC

• Power consumption: 55 W (fan tray only); 650 W (maximum draw with cards)

• Power requirements: –40.5 to –57 VDC

• Power terminals: #6 Lug
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B.1.12   System Environmental Specifications
• ANSI shelf: 100-A fuse panel (minimum 30 A fuse per shelf)
HD shelf: 100-A fuse panel (minimum 35 A fuse per shelf)

The ONS 15454 ETSI has the following power specifications: 

• Input voltage: –48 VDC

• Power consumption: Configuration dependent, 53 W for fan tray; 650 W (maximum draw with 
cards)

• Power requirements: 

– Nominal: –48 VDC

– Tolerance limits: –40.5 to –57.0 VDC

• Power terminals: 3WK3 Combo-D power cable connector (MIC-A/P and MIC-C/T/P faceplates)

• Fusing: 100 A fuse panel; minimum 30 A fuse per shelf

B.1.12 System Environmental Specifications
The ONS 15454 ANSI has the following environmental specifications: 

• Operating temperature: 32 to +131 degrees Farenheit (0 to +55 degrees Celsius); -40 to +139 degrees 
Farenheit (–40 to +65 degrees Celsius) with industrial temperature rated cards

• Operating humidity: 5 to 95 percent, noncondensing

The ONS 15454 ETSI has the following environmental specifications: 

• Operating temperature: 32 to 104 degrees Fahrenheit (0 to +40 degrees Celsius)

• Operating humidity: 5 to 95 percent, noncondensing

B.1.13 Dimensions
The ONS 15454 ANSI shelf assembly has the following dimensions: 

• Height: 18.5 in. (40.7 cm)

• Width: 19 or 23 in. (41.8 or 50.6 cm) with mounting ears attached

• Depth: 12 in. (26.4 cm) (5 in. or 12.7 cm projection from rack)

• Weight: 55 lb (24.947 kg) empty

The ONS 15454 ETSI shelf assembly has the following dimensions: 

• Height: 616.5 mm (24.27 in.)

• Width: 535 mm (17 in.) without mounting ears attached

• Depth: 280 mm (11.02 in.)

• Weight: 26 kg empty (57.3 lb)

B.2 General Card Specifications
This section provides power specifications and temperature ranges for all ONS 15454 cards. 
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B.2.1   Power
B.2.1 Power
Table B-1 provides power consumption information for the ONS 15454 cards.

Table B-1 Individual Card Power Requirements

Card Type Card Name Watts Amperes at –48 V BTU/Hr.

Common Control 
Cards

TCC2/TCC2P 19.20 0.4 66.8

AIC-I 4.8 0.1 15.3

AEP 3 (from +5 VDC 
from AIC-I)

10.2

MIC-A/P 0.13 via TCC2/TCC2P —

MIC-C/T/P 0.38 via TCC2/TCC2P —

DWDM Cards OSCM Nominal 23

Maximum 26

Nominal 0.48

Maximum 0.54

Nominal 78.48

Maximum 88.71

OSC-CSM Nominal 24

Maximum 27

Nominal 0.5

Maximum 0.56

Nominal 81.89

Maximum 92.12

OPT-PRE Minimum 25

Nominal 30

Maximum39

Minimum 0.52

Nominal 0.5

Maximum 0.81

Minimum 85.3

Nominal 102.36

Maximum 88.71

OPT-BST Nominal 30

Maximum 39

Nominal 0.63

Maximum 0.81

Nominal 102.36

Maximum 88.71

OPT-BST-E Nominal 30

Maximum 39

Nominal 0.63

Maximum 0.81

Nominal 102.36

Maximum 88.71

32MUX-O Nominal 16

Maximum 25

Nominal 0.33

Maximum 0.52

Nominal 54.59 

Maximum 85.3

32DMX-O Nominal 16

Maximum 25

Nominal 0.33

Maximum 0.52

Nominal 54.59 

Maximum 85.3

32DMX Nominal 15 

Maximum 25

Nominal 0.31

Maximum 0.52

Nominal 51.21

Maximum 85

4MD-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-1C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-2C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-4C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3
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B.2.2   Temperature
B.2.2 Temperature
Table B-2 provides temperature ranges and product names for ONS 15454 cards.

Note The I-Temp symbol is displayed on the faceplate of an I-Temp compliant card. A card without this 
symbol is C-Temp compliant.

DWDM Cards AD-1B-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-4B-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

32WSS Nominal 50

Maximum 65

Nominal 1.04

Maximum 1.35

Nominal 170

Maximum 221

Transponder and 
Muxponder 
Cards

TXP_MR_10G 35.001 0.73 119.5

TXP_MR_10E Nominal 40

Maximum 50

Nominal 1.11

Maximum 1.04

Nominal 136.6

Maximum 170.7

TXP_MR_2.5G 35.001 0.73 119.5

TXPP_MR_2.5G 501 1.04 170.5

MXP_2.5G_10G 501 1.04 170.7

MXP_2.5G_10E Nominal 40

Maximum 50

Nominal 1.11

Maximum 1.04

Nominal 136.6

Maximum 170.7

MXP_MR_2.5G Nominal 50

Maximum 60

Nominal 1.04

Maximum 1.25

Nominal 170.7

Maximum 204

MXPP_MR_2.5G Nominal 50

Maximum 60

Nominal 1.04

Maximum 1.25

Nominal 170.7

Maximum 204

1. Calculated power; measured power was not available at the time of publication.

Table B-1 Individual Card Power Requirements (continued)

Card Type Card Name Watts Amperes at –48 V BTU/Hr.

Table B-2 Card Temperature Ranges and Product Names

Card Type Card Name

C-Temp Product Name 
(32 to 131 degrees Fahrenheit, 
0 to +55 degrees Celsius)

I-Temp Product Name
(–40 to 149 degrees Fahrenheit, 
–40 to +65 degrees Celsius)

Common 
Control Cards

TCC2/TCC2P — 15454-TCC2/TCC2P

AIC-I — 15454-AIC-I

AEP — 15454-AEP

MIC-A/P 15454-MIC-A/P —

MIC-C/T/P 15454 MIC-C/T/P —
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B.3   Common Control Card Specifications
B.3 Common Control Card Specifications
This section provides specifications for the TCC2, TCC2P, AIC, and AIC-I cards, the alarm expansion 
panel (AEP), and the MIC-A/P and MIC-C/T/P FMECs.

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document.

B.3.1 TCC2 Card Specifications
The TCC2 card has the following specifications:

• CTC software

DWDM Cards OSCM 15454-OSCM —

OSC-CSM 15454-OSC-CSM —

OPT-PRE 15454-OPT-PRE —

OPT-BST 15454-OPT-BST —

OPT-BST-E 15454-OPT-BST-E —

32MUX-O 15454-32 MUX-O —

32DMX-O 15454-32 DMX-O —

32DMX 15454-32-DMX —

4MD-xx.x 15454-4MD-xx.x —

AD-1B-xx.x 15454-AD-1B-xx.x —

AD-4B-xx.x 15454-AD-4B-xx.x —

AD-1C-xx.x 15454-AD-1C-xx.x —

AD-2C-xx.x 15454-AD-2C-xx.x —

AD-4C-xx.x 15454-AD-4C-xx.x —

32WSS 15454-WSS —

Transponder 
and 
Muxponder 
Cards

TXP_MR_10G 15454-TXPMR10G —

TXP_MR_10E 15454-10EMRTXP —

TXP_MR_2.5G 15454-2.5GMRTXP —

TXPP_MR_2.5G 15454-2.5GMRTXP-P —

MXP_2.5G_10G 15454-MXP2.5G10G —

MXP_2.5G_10E 15454-4x2.5G10EMXP —

MXP_MR_2.5G 15454-Datamux2.5GDM —

MXPP_MR_2.5G 15454-Datamux2.5GDMP —

Table B-2 Card Temperature Ranges and Product Names (continued)

Card Type Card Name

C-Temp Product Name 
(32 to 131 degrees Fahrenheit, 
0 to +55 degrees Celsius)

I-Temp Product Name
(–40 to 149 degrees Fahrenheit, 
–40 to +65 degrees Celsius)
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B.3.2   TCC2P Card Specifications
– Interface: EIA/TIA-232 (local craft access, on TCC2 faceplate) 

– Interface: 10BaseT LAN (on TCC2 faceplate) 

– Interface: 10BaseT LAN (through the backplane)

• Synchronization

– Stratum 3, per Telcordia GR-253-CORE

– Free running access: Accuracy +/– 4.6 ppm

– Holdover stability: 3.7 x 10-7 per day including temperature (< 255 slips in first 24 hours)

– Reference: External BITS, line, internal

• Supply voltage monitoring 

– Both supply voltage inputs are monitored. 

– Normal operation: –40.5 to –56.7 V

– Undervoltage: Major alarm 

– Overvoltage: Major alarm 

• Environmental

– Operating temperature: –40 to +149 degrees Fahrenheit (–40 to +65 degrees Celsius) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 26.00 W, 0.54 A at –48 V, 88.8 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 235 mm (9.250 in.)

– Weight not including clam shell: 0.7 kg (1.5 lb) 

B.3.2 TCC2P Card Specifications
The TCC2P card has the following specifications:

• CTC software

– Interface: EIA/TIA-232 (local craft access, on TCC2P faceplate) 

– Interface: 10BaseT LAN (on TCC2P faceplate) 

– Interface: 10BaseT LAN (through the backplane)

• Synchronization

– Stratum 3, per Telcordia GR-253-CORE

– Free running access: Accuracy +/– 4.6 ppm

– Holdover stability: 3.7 * 10 exp – 7 per day including temperature (< 255 slips in first 24 hours)

– Reference: External BITS, line, internal

• Supply voltage monitoring 

– Both supply voltage inputs are monitored. 
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B.3.3   AIC-I Card Specifications
– Normal operation: –40.5 to –56.7 V (in –48 VDC systems)

– Undervoltage: Major alarm 

– Overvoltage: Major alarm 

• Environmental

– Operating temperature: –40 to +149 degrees Fahrenheit (–40 to +65 degrees Celsius) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 26.00 W, 0.54 A at –48 V, 88.8 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 1.5 lb (0.7 kg) 

B.3.3 AIC-I Card Specifications
The AIC-I card has the following specifications:

• Alarm inputs

– Number of inputs: 12 without AEP, 32 with AEP

– Opto-coupler isolated

– Label customer provisionable

– Severity customer provisionable

– Common 32 V output for all alarm inputs

– Each input limited to 2 mA

– Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Alarm outputs

– Number of outputs: 4 (user configurable as inputs) without AEP, 16 with AEP 

– Switched by opto MOS (metal oxide semiconductor) 

– Triggered by definable alarm condition

– Maximum allowed open circuit voltage: 60 VDC

– Maximum allowed closed circuit current: 100 mA

– Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Express orderwire/local orderwire (EOW/LOW)

– ITU-T G.711, ITU-T G.712, Telcordia GR-253-CORE 

– A-law, mu-law

Note Due to the nature of mixed coding, in a mixed-mode (A-law/mu-law) configuration, the 
orderwire is not ITU-T G.712 compliant.
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B.3.4   AEP Specifications (ANSI only)
– Orderwire party line 

– Dual tone, multifrequency (DTMF) signaling 

• User data channel (UDC)

– Bit rate: 64 kbps, codirectional

– ITU-T G.703 

– Input/output impedance: 120 ohm

– Termination: RJ-11 connectors

• Data communications channel (DCC)

– Bit rate: 576 kbps

– EIA/TIA-485/V11

– Input/output impedance: 120 ohm

– Termination: RJ-45 connectors

• ACC connection for additional alarm interfaces

– Connection to AEP

• Power monitoring alarming states: 

– Power failure (0 to –38 VDC)

– Undervoltage (–38 to –40.5 VDC)

– Overvoltage (beyond –56.7 VDC)

• Environmental

– Operating temperature: –40 to 149 degrees Fahrenheit (–40 to +65 degrees Celsius)

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption (including AEP, if used): 8.00 W, 0.17 A, 27.3 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Weight: 1.8 lb (0.82 kg)

B.3.4 AEP Specifications (ANSI only)
The AEP has the following specifications:

• Alarm inputs

– Number of inputs: 32

– Optocoupler isolated

– Label customer provisionable

– Severity customer provisionable

– Common 32 V output for all alarm inputs

– Each input limited to 2 mA
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B.3.5   MIC-A/P FMEC Specifications (ETSI only)
– Termination: 50-pin AMP champ connector

• Alarm outputs

– Number of outputs: 16

– Switched by opto MOS

– Triggered by definable alarm condition

– Maximum allowed open circuit voltage: 60 VDC

– Maximum allowed closed circuit current: 100 mA

– Termination: 50-pin AMP champ connector

• Environmental

– Overvoltage protection: as in ITU-T G.703 Annex B

– Operating temperature: –40 to +65 degrees Celsius (–40 to +149 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 3.00 W max., from +5 VDC from AIC-I, 10.2 BTU/hr max. 

• Dimensions of AEP board

– Height: 20 mm (0.79 in.) 

– Width: 330 mm (13.0 in.)

– Depth: 89 mm (3.5 in.) 

– Weight: 0.18 kg (0.4 lb) 

B.3.5 MIC-A/P FMEC Specifications (ETSI only)
The MIC-A/P FMEC card has the following specifications:

• Power supply input BATTERY B

– System supply voltage: Nominal –48 VDC
Tolerance limits: –40.5 to –57.0 VDC

– Connector: 3WK3 Combo-D power cable connector 

• Alarm outputs 

– Voltage (open contact): Maximum 60 VDC

– Current (closed contact): Maximum 250 mA

– Connector: 62-pin DB connector (common for inputs/outputs) 

• Alarm inputs 

– Voltage (open contact): Maximum 60 VDC

– Current (closed contact): Maximum 2 mA

– Connector: 62-pin DB connector (common for inputs/outputs) 

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 0.13 W (provided by +5 V from the TCC2/TCC2P card), 0.44 BTU/hr
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B.3.6   MIC-C/T/P FMEC Specifications (ETSI only)
• Dimensions

– Height: 182 mm (7.165 in.)

– Width: 32 mm (1.25 in.)

– Depth: 92 mm (3.62 in.)

– Depth with backplane connector: 98 mm (3.87 in.)

– Weight not including clam shell: 0.2 kg (0.5 lb) 

B.3.6 MIC-C/T/P FMEC Specifications (ETSI only)
The MIC-C/T/P FMEC card has the following specifications:

• Power supply input BATTERY A

– System supply voltage: Nominal –48 VDC
Tolerance limits: –40.5 to –57.0 VDC

– Connector: 3WK3 Combo-D power cable connector 

• Timing connector 

– Frequency: 2.048 MHz +/–10 ppm 

– Signal level: 0.75 to 1.5 V 

– Impedance: 75 ohms +/–5 percent (switchable by jumper to high impedance > 3 kohms)

Note 120 ohms balanced impedance is possible with external matching cable.

– Cable attenuation: Up to 6 dB at 2 MHz 

– Connectors: 1.0/2.3 miniature coax connector 

• System management serial port:

– System management serial port craft interface

– Modem port (for future use) 

– Connectors: 8-pin RJ-45

• System management LAN port connectors:

– Signal: IEEE 802.3 10BaseT

– Connectors: 8-pin RJ-45

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 0.38 W (provided by +5 V from the TCC2/TCC2P card), 1.37 BTU/hr

• Dimensions

– Height: 182 mm (7.165 in.)

– Width: 32 mm (1.25 in.)

– Depth: 92 mm (3.62 in.)

– Depth with backplane connector: 98 mm (3.87 in.)
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B.4   DWDM Card Specifications
– Weight not including clam shell: 0.2 kg (0.5 lb) 

B.4 DWDM Card Specifications
This section provides specifications for the OSCM, OSC-CSM, OPT-PRE amplifier, OPT-BST amplifier, 
OPT-BST-E amplifier, 32MUX-O, 32DMX-O, 32DMX, 4MD-xx.x, AD-IC-xx.x, AD-2C-xx.x, 
AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, and 32WSS cards. 

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document.

B.4.1 OSCM Card Specifications
The OSCM card has the following specifications:

• Line 

– Bit rate: 155 Mbps 

– Code: Scrambled non-return to zero (NRZ)

– Loopback modes: None

– Connector: Duplex LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.957

• Transmitter optical service channel (OSC) signal

– Maximum transmitter output power: –1 dBm

– Minimum transmitter output power: –5 dBm 

– Nominal wavelength: 1510-nm +/–10 nm

– Variable optical attenuator (VOA) necessary in the transmit path to adjust the in-fiber optical 
power level

• Receiver OSC signal

– Maximum receiver level: –8 dBm at 10–10 bit error rate (BER)

– Minimum receiver level: –40 dBm at 10–10 BER

– Span budget: 40-dB span budget (about 150 km assuming fiber path loss equals 0.25 dB/km)

– Jitter tolerance: Telcordia GR-253/G.823 compliant

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent, noncondensing

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)
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B.4.2   OSC-CSM Card Specifications
B.4.2 OSC-CSM Card Specifications
The OSC-CSM card has the following specifications:

• Line 

– Bit rate: 155 Mbps 

– Code: Scrambled NRZ

– Loopback modes: None

– Connector: Duplex LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.957

• Transmitter OSC signal

– Maximum transmitter output power: –2 dBm

– Minimum transmitter output power: –24 dBm 

– Nominal wavelength: 1510-nm +/–10 nm

– VOA is necessary in the transmit path to adjust the in-fiber optical power level

• Receiver OSC signal

– Maximum receiver level: –8 dBm at 10–10 BER

– Minimum receiver level: –40 dBm at 10–10 BER

– Span loss budget: 35-dB span budget (approximately 140 km assuming that the fiber path loss 
is equal to 0.25 dB/km)

– Jitter tolerance: Telcordia GR-253/G.823 compliant

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent, noncondensing

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.3 OPT-PRE Amplifier Card Specifications
The OPT-PRE amplifier card has the following specifications:

• Optical characteristics:

– Total operating wavelength range: 1530 to 1561.3 nm

– Gain ripple (peak to valley): 1.5 dB

– Mid-access loss (MAL) range (for dispersion compensation unit [DCU]): 3 to 9 dB

– Gain range: 5 to 38.5 dBm in constant power mode, 5 to 28 dBm in constant gain mode

– Minimum gain (standard range): 5.0 dBm
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B.4.4   OPT-BST Amplifier Card Specifications
Maximum gain (standard range with programmable gain tilt): 21 dBm 

Maximum gain (extended range with uncontrolled gain tilt): 38.5 dBm 

– Gain and power regulation over/undershoot: 0.5 dB

– Limited maximum output power: 17.5 dBm

– Maximum output power (with full channel load): 17 dB

– Minimum output power (with one channel): –1 dBm

– Input power (Pin) range at full channel load: –21.5 to 12 dBm

– Input power (Pin) range at single channel load: –39.5 to –6 dBm

– Noise figure at G3 21 dB = 6.5 dB

– OSC filter drop (channels) insertion loss maximum: 1 dB

– OSC filter drop (OSC) insertion loss maximum: 1.8 dB

– OSC filter add (OSC) insertion loss maximum: 1.3 dB

– Optical connectors: LC-UPC/2

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 85 percent, noncondensing

• Dimensions

– Height: 12.65 in. (332 mm)

– Width: 0.92 in. (24 mm)

– Depth: 9.00 in. (240 mm)

B.4.4 OPT-BST Amplifier Card Specifications
The OPT-BST amplifier card has the following specifications:

• Optical characteristics:

– Total operating wavelength range: 1530 to 1561.3 nm

– Gain ripple (peak to valley): 1.5 dB

– Gain range: 5 to 20 dBm with programmable gain tilt

– Gain and power regulation over/undershoot: 0.5 dB

– Limited maximum output power: 17.5 dBm

– Maximum output power (with full channel load): 17 dB

– Minimum output power (with one channel): –1 dBm

– Input power (Pin) range at full channel load: –3 to 12 dBm

– Input power (Pin) range at single channel load: –21 to –6 dBm

– Noise figure at G3 20 dB = 6 dB

– OSC filter drop (channels) insertion loss maximum: 1 dB

– OSC filter drop (OSC) insertion loss maximum: 1.8 dB
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B.4.5   OPT-BST-E Amplifier Card Specifications
– OSC filter add (OSC) insertion loss maximum: 1.3 dB

– Optical connectors: LC-UPC/2

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 85 percent, noncondensing

• Dimensions

– Height: 12.65 in. (332 mm)

– Width: 0.92 in. (24 mm)

– Depth: 9.00 in. (240 mm)

B.4.5 OPT-BST-E Amplifier Card Specifications
The OPT-BST-E amplifier card has the following specifications:

• Optical characteristics:

– Total operating wavelength range: 1530 to 1561.3 nm

– Gain ripple (peak to valley): 1.8 dB

– Gain range: 8 to 23 dB with programmable gain tilt

– Extended gain range: 23 to 26 dB with gain tilt uncontrolled

– Gain and power regulation over/undershoot: 0.5 dB

– Limited maximum output power: 20.5 dBm

– Maximum output power (with full channel load): 20 dB

– Minimum output power (with one channel): –1 dBm

– Input power (Pin) range at full channel load: –6 to 12 dBm

– Input power (Pin) range at single channel load: –26 to –8 dBm

– Noise figure at G3 23 dB = 6 dB

– OSC filter drop (channels) insertion loss maximum: 1 dB

– OSC filter drop (OSC) insertion loss maximum: 1.8 dB

– OSC filter add (OSC) insertion loss maximum: 1.3 dB

– Optical connectors: LC-UPC/2

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 85 percent, noncondensing

• Dimensions

– Height: 12.65 in. (332 mm)

– Width: 0.92 in. (24 mm)

– Depth: 9.00 in. (240 mm)
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Appendix B      Hardware Specifications
B.4.6   32MUX-O Card Specifications
B.4.6 32MUX-O Card Specifications
The 32 MUX-O card optical specifications are listed in Table B-3.

Note For power specifications, refer to the “15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 15-6.

The 32MUX-O card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent relative humidity (RH)

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.7 32DMX-O Card Specifications
The 32DMX-O card optical specifications are listed in Table B-4.

Note For power specifications, see the “15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 15-6.

Table B-3 32MUX-O Optical Specifications

Parameter Note Condition Min Max Unit

Tx filter shape (–1 dB 
bandwidth)

All standard operating 
procedures (SOP) and 
within whole operating 
temperature range

In 1/32—Out beginning 
of life (BOL)

+/–180 +/–300 pm

In 1/32—Out end of life 
(EOL)

+/–160 +/–300 pm

Insertion loss All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL 4 8.0 dB

In 1/32—Out EOL 4 8.5 dB

VOA dynamic range — — 25 — dB

Optical monitor 
tap-splitting ratio on 
monitor port

Optical monitor port 
with respect to output 
port in multiplexer 
only

— 19 21 dB

Maximum optical 
input power

— — 300 — mW
B-17
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Appendix B      Hardware Specifications
B.4.8   32DMX Card Specifications
The 32DMX-O card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.8 32DMX Card Specifications
The 32DMX card optical specifications are listed in Table B-5.

Note For power specifications, see the “15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 15-6.

Table B-4 32DMX-O Optical Specifications

Parameter Note Condition Min Max Unit

Rx filter shape 
(–1 dB bandwidth)

All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL +/–180 +/–300 pm

In 1/32—Out EOL +/–160 +/–300 pm

Insertion loss All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL 4 8.0 dB

In 1/32—Out EOL 4 8.5 dB

VOA dynamic range — — 25 — dB

Maximum optical 
input power

— — 300 — mW

Table B-5 32DMX Optical Specifications

Parameter Note Condition Min Typical Max Units

–1 dB 
bandwidth

All SOP and within whole 
operating temperature 
range, connectors included, 
and for maximum VOA 
operating attenuation.

COM RX => TX 1, 32 
(OUT)

+/–110 — — pm

–3 dB 
bandwidth

+/–200 — — pm

Insertion loss All SOP, and within whole 
operating temperature 
range, connectors included.

COM RX => TX 1, 32 — — 5.5 dB
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B.4.8   32DMX Card Specifications
The 32DMX channel plan is shown in Table B-6. All 32DMX client interfaces must comply with this 
plan. 

VOA 
dynamic 
range

— COM RX => TX 1, 32 25 — — dB

Maximum 
optical input 
power

— — 300 — — mW

Table B-5 32DMX Optical Specifications (continued)

Parameter Note Condition Min Typical Max Units

Table B-6 32DMX Channel Plan

Channel 
Number Band Channel ID Frequency (GHz) Wavelength (nm)

1 1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 2 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 3 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 4 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 5 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 6 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52
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B.4.9   4MD-xx.x Card Specifications
The 32DMX card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.9 4MD-xx.x Card Specifications
The 4MD-xx.x card optical specifications are listed in Table B-7.

Note For power specifications, see the “15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 15-6.

25 7 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 8 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

Table B-6 32DMX Channel Plan (continued)

Channel 
Number Band Channel ID Frequency (GHz) Wavelength (nm)
B-20
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Appendix B      Hardware Specifications
B.4.10   AD-1C-xx.x Card Specifications
The 4MD-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.10 AD-1C-xx.x Card Specifications
Table B-8 lists the AD-1C-xx.x optical specifications.

Table B-7 4MD-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

Trx filter shape 
(–0.5 dB bandwidth 
TrxBW2)

All SOP and within 
whole operating 
temperature range

COM Rx—xx.xx Tx

COM Rx—yy.yy Tx

COM Rx—zz.zz Tx

COM Rx—kk.kk Tx

+/–180 — pm

xx.xx Rx—COM Tx

yy.yy Rx—COM Tx

zz.zz Rx—COM Tx

kk.kk Rx—COM Tx

Insertion loss 
demultiplexer 
section

All SOP and within 
whole operating 
temperature range

COM Rx—xx.xx Tx — 1.9 dB

COM Rx—yy.yy Tx — 2.4 dB

COM Rx—zz.zz Tx — 2.8 dB

COM Rx—kk.kk Tx — 3.3 dB

Insertion loss 
multiplexer section

All SOP and within 
whole operating 
temperature range 
(two connectors 
included)

xx.xx Rx—COM Tx — 3.6 dB

yy.yy Rx—COM Tx — 3.2 dB

zz.zz Rx—COM Tx — 3.0 dB

kk.kk Rx—COM Tx — 2.6 dB

VOA dynamic range — — 25 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.11   AD-2C-xx.x Card Specifications
AD-1C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 15-3 on page 15-6 through Table 15-5 on page 15-8 for this 
information.

The AD-1C-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.11 AD-2C-xx.x Card Specifications
Table B-9 lists the AD-2C-xx.x optical specifications.

Table B-8 AD-1C-xx.x Card Optical Specifications

Parameter Note Condition Min Max Unit

Trx filter shape
(–0.5 dB bandwidth)
TrxBW2

All SOP and within whole 
operating temperature range

COM Rx—xx.xx Tx
xx.xx Rx—COM Tx

+/–180 — pm

Rfx filter shape
(–0.5 dB bandwidth)
RfxBW2

All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

+/–180 — pm

Insertion loss
(drop section)

All SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—xx.xx Tx — 2.0 dB

Insertion loss
(express section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—Exp Tx
Exp Rx—COM Tx

— 2.4 or 
1.2

dB

Insertion loss
(add section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

xx.xx Rx—COM Tx — 2.6 dB

VOA dynamic range — — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.12   AD-4C-xx.x Card Specifications
AD-2C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 15-3 on page 15-6 through Table 15-5 on page 15-8 for this 
information.

The AD-2C-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.12 AD-4C-xx.x Card Specifications
Table B-10 lists the AD-4C-xx.x optical specifications.

Table B-9 AD-2C-xx.x Card Optical Specifications

Parameter Note Condition Min Max Unit

Trx filter shape
(–0.5 dB bandwidth)
TrxBW2

All SOP and within whole 
operating temperature range

COM Rx—xx.xx Tx
COM Rx—yy.yy Tx

+/–180 — pm

xx.xx Rx—COM Tx
yy.yy Rx—COM Tx

+/–180 —

Rfx filter shape
(–0.5 dB bandwidth)
RfxBW2

All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

+/–180 — pm

Insertion loss
(drop section)

All SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—xx.xx Tx — 2.0 dB

COM Rx—yy.yy Tx — 2.4 dB

Insertion loss
(express section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—Exp Tx — 2.7 dB

Exp Rx—COM Tx — 1.6 dB

Insertion loss
(add section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

xx.xx Rx—COM Tx — 3.1 dB

yy.yy Rx—COM Tx — 2.7 dB

VOA dynamic range — — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.12   AD-4C-xx.x Card Specifications
AD-4C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 15-3 on page 15-6 through Table 15-5 on page 15-8 for this 
information.

The AD-4C-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

Table B-10 AD-4C-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

Channel grid See Table B-11. The channel 
plan for the AD-4C-xx.x card is 
identical to the channel plan for 
the AD-1B-xx.x card.

— — — —

Trx filter shape
(–0.5 dB 
bandwidth)
TrxBW2

All SOP and within whole 
operating temperature range

COM Rx—xx.xx Tx
COM Rx—yy.yy Tx
COM Rx—zz.zz Tx
COM Rx—kk.kk Tx
xx.xx Rx—COM Tx
yy.yy Rx—COM Tx

+/–180 — pm

Rfx filter shape
(–1 dB bandwidth)
RfxBW2

All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

— — pm

Insertion loss
(drop section)

All SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—xx.xx Tx — 5.5 dB

COM Rx—yy.yy Tx — 5.0 dB

COM Rx—zz.zz Tx — 4.5 dB

COM Rx—kk.kk Tx — 4.1 dB

Insertion loss
(express section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—Exp Tx — 2.7 dB

Exp Rx—COM Tx — 1.2 dB

Insertion loss
(add section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

xx.xx Rx—COM Tx — 3.9 dB

yy.yy Rx—COM Tx — 4.3 dB

zz.zz Rx—COM Tx — 4.5 dB

kk.kk Rx—COM Tx — 4.9 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.13   AD-1B-xx.x Card Specifications
– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.13 AD-1B-xx.x Card Specifications
Table B-11 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the 
eight versions of the AD-1B-xx.x card.

Table B-11 AD-1B-xx.x Channel Allocation Plan by Band

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)

AD-1B-30.3 B30.3 30.3 195.9 1530.33

30.7 195.85 1530.72

31.1 195.8 1531.12

31.5 195.75 1531.51

31.9 195.7 1531.90

32.2 195.65 1532.29

32.6 195.6 1532.68

33.3 195.55 1533.07

AD-1B-34.2 B34.2 34.2 195.4 1534.25

34.6 195.35 1534.64

35.0 195.3 1535.04

35.4 195.25 1535.43

35.8 195.2 1535.82

36.2 195.15 1536.22

36.6 195.1 1536.61

37.0 195.05 1537.00

AD-1B-38.1 B38.1 38.1 194.9 1538.19

38.5 194.85 1538.58

38.9 194.8 1538.98

39.3 194.75 1539.37

39.7 194.7 1539.77

40.1 194.65 1540.16

40.5 194.6 1540.56

40.9 194.55 1540.95
B-25
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Appendix B      Hardware Specifications
B.4.13   AD-1B-xx.x Card Specifications
AD-1B-42.2 B42.1 42.1 194.4 1542.14

42.5 194.35 1542.54

42.9 194.3 1542.94

43.3 194.25 1543.33

43.7 194.2 1543.73

44.1 194.15 1544.13

44.5 194.1 1544.53

44.9 194.05 1544.92

AD-1B-46.1 B46.1 46.1 193.9 1546.12

46.5 193.85 1546.52

46.9 193.8 1546.92

47.3 193.75 1547.32

47.7 193.7 1547.72

48.1 193.65 1548.11

48.5 193.6 1548.51

48.9 193.55 1548.91

AD-1B-50.1 B50.1 50.1 193.4 1550.12

50.5 193.35 1550.52

50.9 193.3 1550.92

51.3 193.25 1551.32

51.7 193.2 1551.72

52.1 193.15 1552.12

52.5 193.1 1552.52

52.9 193.05 1552.93

AD-1B-54.1 B54.1 54.1 192.9 1554.13

54.5 192.85 1554.54

54.9 192.8 1554.94

55.3 192.75 1555.34

55.7 192.7 1555.75

56.1 192.65 1556.15

56.5 192.6 1556.96

56.9 192.55 1556.96

Table B-11 AD-1B-xx.x Channel Allocation Plan by Band (continued)

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)
B-26
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Appendix B      Hardware Specifications
B.4.13   AD-1B-xx.x Card Specifications
Table B-12 lists AD-1B-xx.x optical specifications.

Table B-13 lists the range of wavelengths for the receive (express) band.

AD-1B-58.1 B58.1 58.1 192.4 1558.17

58.5 192.35 1558.58

58.9 192.3 1558.98

59.3 192.25 1559.39

59.7 192.2 1559.79

60.2 192.15 1560.20

60.6 192.1 1560.61

61.0 192.05 1561.01

Table B-11 AD-1B-xx.x Channel Allocation Plan by Band (continued)

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)

Table B-12 AD-1B-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

–1 dB bandwidth All SOP and within whole 
operating environmental range 

COM Rx—Band Tx
Band Rx—COM Tx

3.6 — nm

–1 dB bandwidth All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

Refer to 
Table B-13.

nm

Insertion loss
(drop section)

All SOP and within whole 
operating environmental range; 
two connectors included, VOA set 
at minimum attenuation

COM Rx—Band Tx — 3.0 dB

Insertion loss
(express section)

All SOP and within whole 
operating environmental range; 
two connectors included

Exp Rx—COM Tx — 1.6 dB

All SOP and within whole 
operating environmental range; 
two connectors included, VOA set 
at its minimum attenuation

COM Rx—Exp Tx — 2.2 dB

Insertion loss
(add section)

All SOP and within whole 
operating environmental range; 
two connectors included

Band Rx—COM Tx — 2.2 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.14   AD-4B-xx.x Card Specifications
AD-1B-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 15-3 on page 15-6 through Table 15-5 on page 15-8 for this 
information.

The AD-1B-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.14 AD-4B-xx.x Card Specifications
Table B-14 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the two 
versions of the card.

Table B-13 AD-1B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

B30.3 — Wavelengths 1533.825 or higher

B34.2 Wavelengths 1533.395 or lower Wavelengths 1537.765 or higher

B38.1 Wavelengths 1537.325 or lower Wavelengths 1541.715 or higher

42.1 Wavelengths 1541.275 or lower Wavelengths 1545.695 or higher

46.1 Wavelengths 1545.245 or lower Wavelengths 1549.695 or higher

50.1 Wavelengths 1549.235 or lower Wavelengths 1553.705 or higher

54.1 Wavelengths 1553.255 or lower Wavelengths 1557.745 or higher

58.1 Wavelengths 1557.285 or lower —
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B.4.14   AD-4B-xx.x Card Specifications
Table B-14 AD-4B-xx.x Channel Allocation Plan by Band

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)

AD-4B-30.3 B30.3 30.3 195.9 1530.33

30.7 195.85 1530.72

31.1 195.8 1531.12

31.5 195.75 1531.51

31.9 195.7 1531.90

32.2 195.65 1532.29

32.6 195.6 1532.68

33.3 195.55 1533.07

B34.2 34.2 195.4 1534.25

34.6 195.35 1534.64

35.0 195.3 1535.04

35.4 195.25 1535.43

35.8 195.2 1535.82

36.2 195.15 1536.22

36.6 195.1 1536.61

37.0 195.05 1537.00

B38.1 38.1 194.9 1538.19

38.5 194.85 1538.58

38.9 194.8 1538.98

39.3 194.75 1539.37

39.7 194.7 1539.77

40.1 194.65 1540.16

40.5 194.6 1540.56

40.9 194.55 1540.95

B42.1 42.1 194.4 1542.14

42.5 194.35 1542.54

42.9 194.3 1542.94

43.3 194.25 1543.33

43.7 194.2 1543.73

44.1 194.15 1544.13

44.5 194.1 1544.53

44.9 194.05 1544.92
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B.4.14   AD-4B-xx.x Card Specifications
Table B-15 lists AD-4B-xx.x optical specifications.

AD-4B-46.1 B46.1 46.1 193.9 1546.12

46.5 193.85 1546.52

46.9 193.8 1546.92

47.3 193.75 1547.32

47.7 193.7 1547.72

48.1 193.65 1548.11

48.5 193.6 1548.51

48.9 193.55 1548.91

B50.1 50.1 193.4 1550.12

50.5 193.35 1550.52

50.9 193.3 1550.92

51.3 193.25 1551.32

51.7 193.2 1551.72

52.1 193.15 1552.12

52.5 193.1 1552.52

52.9 193.05 1552.93

B54.1 54.1 192.9 1554.13

54.5 192.85 1554.54

54.9 192.8 1554.94

55.3 192.75 1555.34

55.7 192.7 1555.75

56.1 192.65 1556.15

56.5 192.6 1556.96

56.9 192.55 1556.96

B58.1 58.1 192.4 1558.17

58.5 192.35 1558.58

58.9 192.3 1558.98

59.3 192.25 1559.39

59.7 192.2 1559.79

60.2 192.15 1560.20

60.6 192.1 1560.61

61.0 192.05 1561.01

Table B-14 AD-4B-xx.x Channel Allocation Plan by Band (continued)

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)
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B.4.14   AD-4B-xx.x Card Specifications
Table B-16 lists the range of wavelengths for the receive (express) band.

Table B-15 AD-4B-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

–1 dB bandwidth All SOP and within whole operating 
environmental range 

COM Rx—Band Tx
Band Rx—COM Tx

3.6 — nm

–1 dB bandwidth All SOP and within whole operating 
temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

Refer to 
Table B-16.

nm

Insertion loss
(drop section)

All SOP and within whole operating 
environmental range; two connectors 
included, VOA set at minimum 
attenuation

COM Rx—Band Tx
30.3/46.1

— 2.9 dB

COM Rx—Band Tx
34.2/50.1

— 3.3 dB

COM Rx—Band Tx
38.1/54.1

— 3.8 dB

COM Rx—Band Tx
42.1/58.1

— 4.5 dB

Insertion loss
(express section)

All SOP and within whole operating 
environmental range; two connectors 
included

Exp Rx—COM Tx — 4.9 dB

All SOP and within whole operating 
environmental range; two connectors 
included, VOA set at its minimum 
attenuation

COM Rx—Exp Tx — 3 dB

Insertion loss
(add section)

All SOP and within whole operating 
environmental range; two connectors 
included

Band Rx 
30.3/46.1—COM Tx

— 3.5 dB

Band Rx 
34.2/50.1—COM Tx

— 2.8 dB

Band Rx 
38.1/54.1—COM Tx

— 2.3 dB

Band Rx 
42.1/58.1—COM Tx

— 1.8 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW

Table B-16 AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

B30.3 — Wavelengths 1533.825 or higher

B34.2 Wavelengths 1533.395 or lower Wavelengths 1537.765 or higher

B38.1 Wavelengths 1537.325 or lower Wavelengths 1541.715 or higher

B42.1 Wavelengths 1541.275 or lower Wavelengths 1545.695 or higher
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B.4.15   32WSS Card Specifications
AD-4B-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 15-3 on page 15-6 through Table 15-5 on page 15-8 for this 
information.

The AD-4B-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.15 32WSS Card Specifications
The 32WSS card optical specifications are listed in Table B-17.

Note For power specifications, see the “15.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 15-6.

B46.1 Wavelengths 1545.245 or lower Wavelengths 1549.695 or higher

B50.1 Wavelengths 1549.235 or lower Wavelengths 1553.705 or higher

B54.1 Wavelengths 1553.255 or lower Wavelengths 1557.745 or higher

B58.1 Wavelengths 1557.285 or lower —

Table B-16 AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges (continued)

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

Table B-17 32WSS Optical Specifications

Parameter Note Condition Min Typical Max Units

–0.25 dB bandwidth All SOP and within 
whole operating 
temperature range, 
connectors 
included, and for 
maximum VOA 
operating 
attenuation.

EXP RX => 
COM TX

+/–/95 — — pm

–0.5 dB bandwidth +/–115 — — pm

–1.0 dB bandwidth +/–135 — — pm

–0.25 dB bandwidth Add 1, 32 => 
COM TX

+/–115 — — pm

–0.5 dB bandwidth +/–135 — — pm

–1.0 dB bandwidth +/–160 — — pm
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B.4.15   32WSS Card Specifications
The 32WSS channel plan is shown in Table B-18. All 32WSS client interfaces must comply with this 
plan.

.

Insertion loss All SOP, any 
optical switch state, 
and within whole 
operating 
temperature range, 
connectors 
included.

EXP RX => 
COM TX

— — 11.3 dB

— COM RX => 
EXP TX

— — 1.5 dB

— Add 1, 32 => 
COM TX

— — 7.6 dB

— COM RX => 
DROP TX

6 — 8.5 dB

VOA dynamic range — EXP RX => 
COM TX

20 — — dB

— Add 1, 32 => 
COM TX

25 — — dB

Maximum optical 
input power

— — 300 — — mW

Table B-17 32WSS Optical Specifications (continued)

Parameter Note Condition Min Typical Max Units

Table B-18 32WSS Channel Plan

Channel 
Number Band Channel ID Frequency (GHz) Wavelength (nm)

1 1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 2 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 3 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56
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B.5   Transponder and Muxponder Card Specifications
The 32WSS card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95 percent RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

– Depth: 9.00 in. (228.6 mm)

B.5 Transponder and Muxponder Card Specifications
This section provides specifications for the TXP_MR_10G, MXP_2.5G_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10E, and TXP_MR_2.5G cards.

13 4 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 5 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 6 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 7 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 8 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

Table B-18 32WSS Channel Plan (continued)

Channel 
Number Band Channel ID Frequency (GHz) Wavelength (nm)
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B.5.1   TXP_MR_10G Card Specifications
For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document. 

B.5.1 TXP_MR_10G Card Specifications
The TXP_MR_10G card has the following specifications:

• Line (trunk side) 

– Bit rate: 

9.95328 Gbps for OC-192/STM-64

10.70923 Gbps with ITU-T G.709 Digital Wrapper/forward error correction (FEC)

10.3125 Gbps for 10 Gigabit Ethernet (GE) 

11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC over 10 GE

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 1000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G 
card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

– Connectors: LC 

– Compliance Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.691

• Transmitter (trunk side) 

– Maximum transmitter output power: +3.5 dBm 

– Minimum transmitter output power: +2.5 dBm 

– Transmitter: Lithium Niobate (LN) external modulator transmitter

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths and versions of TXP_MR_10G (16 card versions, each covering 
two wavelengths): 

– 1530.33 to 1531.12 nm (two wavelengths)

– 1531.90 to 1532.68 nm (two wavelengths)

– 1534.25 to 1535.04 nm (two wavelengths)

– 1535.82 to 1536.61 nm (two wavelengths)

– 1538.19 to 1538.98 nm (two wavelengths)

– 1539.77 to 1540.56 nm (two wavelengths)
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B.5.1   TXP_MR_10G Card Specifications
– 1542.14 to 1542.94 nm (two wavelengths)

– 1543.73 to 1544.53 nm (two wavelengths)

– 1546.12 to 1546.92 nm (two wavelengths)

– 1547.72 to 1548.51 nm (two wavelengths)

– 1550.12 to 1550.92 nm (two wavelengths)

– 1551.72 to 1552.52 nm (two wavelengths)

– 1554.13 to 1554.94 nm (two wavelengths)

– 1555.75 to 1556.55 nm (two wavelengths)

– 1558.17 to 1558.98 nm (two wavelengths)

– 1559.79 to 1560.61 nm (two wavelengths)

• Receiver (trunk side): 

– Receiver input power (no FEC, unamplified, 23 dB optical signal-to-noise ratio [OSNR], BER 
1 * 10 exp – 12): –8 to –21 dBm

– Receiver input power (no FEC, unamplified, 23 dB OSNR, at +/– 1000 ps/nm BER 1 * 10 
exp – 12): –8 to –19 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, at +/– 1000 ps/nm BER 1 * 10 
exp – 12):–8 to –18 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, BER 8 * 10 exp – 5): –8 to –24 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, at +/– 1000 ps/nm, BER 8 * 10 exp – 5): 
–8 to –22 dBm

– Receiver input power (FEC, amplified, 9 dB OSNR, BER 8 * 10 exp – 5): –8 to –18 dBm

– Receiver input power (FEC, unamplified, 11 dB OSNR, at +/– 800 ps/nm, BER 8 * 10 exp – 5): 
–8 to –18 dBm

• Line (client side) 

– Bit rate: 9.95328 Gbps or 10.3125 Gbps

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In 
the case of 10 GE, the allowance is up to 10 km of single-mode fiber (SMF) dispersion. 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.697, 10GEBase-LR

• Transmitter (client side)

– Maximum transmitter output power: –1 dBm 

– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

– Transmitter: Distributed feedback (DFB) laser 
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B.5.2   MXP_2.5G_10G Card Specifications
• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12 

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: avalanche photodiode (APD)

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.2 MXP_2.5G_10G Card Specifications
The MXP_2.5G_10G card has the following specifications:

• Line (trunk side) 

– Bit rate: 

9.95328 Gbps for OC-192/STM-64 

10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 1000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
MXP_2.5G_10G card. Using direct fiber loopbacks causes irreparable damage to the 
MXP_2.5G_10G card.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.691

• Transmitter (trunk side) 

– Maximum transmitter output power: +3.5 dBm 

– Minimum transmitter output power: +2.5 dBm 
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B.5.2   MXP_2.5G_10G Card Specifications
– Transmitter: LN external modulator transmitter

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths and versions of MXP_2.5G_10G (16 card versions, each covering 
two wavelengths): 

– 1530.33 to 1531.12 nm (two wavelengths)

– 1531.90 to 1532.68 nm (two wavelengths)

– 1534.25 to 1535.04 nm (two wavelengths)

– 1535.82 to 1536.61 nm (two wavelengths)

– 1538.19 to 1538.98 nm (two wavelengths)

– 1539.77 to 1540.56 nm (two wavelengths)

– 1542.14 to 1542.94 nm (two wavelengths)

– 1543.73 to 1544.53 nm (two wavelengths)

– 1546.12 to 1546.92 nm (two wavelengths)

– 1547.72 to 1548.51 nm (two wavelengths)

– 1550.12 to 1550.92 nm (two wavelengths)

– 1551.72 to 1552.52 nm (two wavelengths)

– 1554.13 to 1554.94 nm (two wavelengths)

– 1555.75 to 1556.55 nm (two wavelengths)

– 1558.17 to 1558.98 nm (two wavelengths)

– 1559.79 to 1560.61 nm (two wavelengths)

• Receiver (trunk side) 

– Receiver input power (no FEC, unamplified, 23 dB OSNR, BER 1 * 10 exp – 12): –8 to –21 dBm

– Receiver input power (no FEC, unamplified, 23 dB OSNR, at +/– 1000 ps/nm BER 1 * 10 
exp – 12): –8 to –19 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, at +/– 1000 ps/nm BER 1 * 10 
exp – 12):–8 to –18 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, BER 8 * 10 exp – 5): –8 to –24 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, at +/– 1000 ps/nm, BER 8 * 10 exp – 5): 
–8 to –22 dBm

– Receiver input power (FEC, amplified, 9 dB OSNR, BER 8 * 10 exp – 5): –8 to –18 dBm

– Receiver input power (FEC, unamplified, 11 dB OSNR, at +/– 800 ps/nm, BER 8 * 10 exp – 5): 
–8 to –18 dBm

• Line (client side) 

– Bit rate: 2.48832 Gbps

– Code: Scrambled NRZ 
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B.5.3   TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications
– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In 
the case of 10 GE, allowance is up to 10 km of SMF fiber of dispersion. 

– Loopback modes: Terminal and facility

– Connectors: LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side): Depends on the Small Form-factor Pluggable (SFP) that is used.

• Receiver (client side): Depends on the SFP that is used.

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 50.00 W, 1.04 A at –48 V, 170.7 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.3 TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications
The TXP_MR_2.5G and TXPP_MR_2.5G cards have the following specifications:

• Line (trunk side) 

– Bit rate: 

2.488 Gbps for OC-48/STM-16 

2.66 Gbps with ITU-T G.709 Digital Wrapper/FEC

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 5400 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G 
and TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks 
with the TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes 
irreparable damage to the TXP_MR_2.5G and TXPP_MR_2.5G cards.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (trunk side) 
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B.5.3   TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications
– Maximum transmitter output power: +1 dBm 

– Minimum transmitter output power: –4.5 dBm 

– Transmitter: Direct modulated laser

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths of TXP_MR_2.5G and TXPP_MR_2.5G (eight card versions): 

ITU grid blue band: 1530.334 to 1544.526 nm (four card versions covering four wavelengths each)

ITU grid red band: 1546.119 to 1560.606 nm (four card versions covering four wavelengths each)

• Receiver (trunk side) 

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm

• Line (client side) 

– Bit rate: 8 Mbps to 2.488 Gbps

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 1600 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

Table B-19 TXP_MR_2.5G/TXPP_MR_2.5G Receiver Trunk Side Specifications

OSNR1 FEC Type Pre-FEC BER Post-FEC BER
Input Power 
Sensitivity

Chromatic Dispersion 
Tolerance

15 dB Off - 2R <10 exp – 12 N/A  – 9 to  – 24 dBm  — 

15 dB Off - 2R <10 exp – 12 N/A  – 9 to  – 21 dBm +/–  3300ps/nm

14 dB Off - 3R <10 exp – 12 N/A  – 9 to  – 30 dBm  — 

15 dB Off - 3R <10 exp – 12 N/A  – 9 to  – 30 dBm +/–  1800ps/nm

16 dB Off - 3R <10 exp – 12 N/A  – 9 to  – 30 dBm +/–  5400ps/nm

5 dB Standard- 3R <10 exp – 5 <10 exp – 15  – 9 to  – 25 dBm  — 

5 dB Standard- 3R <10 exp – 5 <10 exp – 15  – 9 to  – 24 dBm +/–  1800ps/nm

5 dB Standard- 3R <10 exp – 5 <10 exp – 15  – 9 to  – 23 dBm +/–  5400ps/nm

14 dB Standard- 3R <10 exp – 5 <10 exp – 15  – 9 to  – 31 dBm  — 

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.5 nm Resolution Bandwidth (RBW)
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B.5.4   MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
– Maximum transmitter output power: –1 dBm 

– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

– Transmitter: DFB laser 

• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12 

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: APD

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
The MXP_MR_2.5G and MXPP_MR_2.5G cards have the following specifications:

• Payload configuration

– FC1G—Fiber Channel 1.06 Gbps

– FC2G—Fiber Channel 2.125 Gbps

– FICON1G—Fiber CON 1.06 Gbps (IBM signal)

– FICON2G—Fiber CON 2.125 Gbps (IBM signal)

– ONE_GE—One Gigabit Ethernet 1.125 Gbps

– Mixed configurations up to maximum line rate (for example, if you have a port configured for 
2G FC, you cannot use another port at the same time)

• Client ports: 8x SFP

• Performance monitoring (PM) for all interfaces

• Buffer-to-buffer credit management for distance extension

• Line (trunk side) 

– Bit rate: 2.488 Gbps for OC-48/STM-16
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B.5.4   MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 6000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G 
and MXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks 
with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes 
irreparable damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, Telcordia GR-2918-CORE, Issue 2, ITU-T G.957, and 
ITU-T 100-GHz grid standard G.692

• Transmitter (trunk side) 

– Transmit power: +3 +/– 1 dBm with MXP_MR_2.5G card, and +/– 1 dBm with 
MXPP_MR_2.5G card

– 50-GHz DWDM migration ready (the wavelength deviation is less than +/– 0.040 nm through 
wavelocker deployment)

– Four-channel wavelength tunability at 100-GHz spacing

– Transmitter maximum return reflectance: –27 dB

– Chromatic dispersion allowance: 5400 ps/nm, giving an optical power penalty < 2.0 dB

– Minimum side mode suppression ratio: 30 dB

– Transmitter is a direct modulated laser

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths of the TXP_MR_2.5G and TXPP_MR_2.5G cards (eight card 
versions): 

ITU grid blue band: 1530.334 to 1544.526 nm (four card versions, four wavelengths each)

ITU grid red band: 1546.119 to 1560.606 nm (four card versions, four wavelengths each)

• Receiver (trunk side) 

Table B-20 MXP_MR_2.5G/MXPP_MR_2.5G Receiver Trunk Side Specifications

OSNR1 FEC Type Pre-FEC BER Post-FEC BER
Input Power 
Sensitivity

Chromatic Dispersion 
Tolerance

10 dB N/A <10 exp – 12 N/A –  9 to –  23 dBm — 

10 dB N/A <10 exp – 12 N/A –  9 to –  22 dBm +/– 1800 ps/nm

10 dB N/A <10 exp – 12 N/A –  9 to –  21 dBm +/– 5400 ps/nm

11 dB N/A <10 exp – 12 N/A –  9 to –  23 dBm +/– 1800 ps/nm

12 dB N/A <10 exp – 12 N/A –  9 to –  23 dBm +/– 5400 ps/nm
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B.5.4   MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
– Receiver sensitivity –28 dBm, BER 1 * 10 exp – 12

– Receiver overload is equal to or exceeds –8 dBm

– Receiver maximum reflectance of –27 dB

• Line (client side) 

– Bit rate: 1.06 Gbps to 2.125 Gbps per client

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode or 850-nm multimode

– Maximum chromatic dispersion allowance: 1600 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

– Maximum transmitter output power: –1 dBm 

– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

– Transmitter: DFB laser 

• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12 

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: APD

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +40 degrees Celsius (+23 to +104 degrees Fahrenheit) 

– Operating humidity: 5 to 85 percent, noncondensing

– Power consumption (maximum): 60 W, 1.25 A at –48 V, 204 BTU/hr

• Dimensions

14 dB N/A <10 exp – 12 N/A –  9 to –  30 dBm — 

14 dB N/A <10 exp – 12 N/A –  9 to –  29 dBm +/– 1800 ps/nm

14 dB N/A <10 exp – 12 N/A –  9 to –  28 dBm +/– 5400 ps/nm

15 dB N/A <10 exp – 12 N/A –  9 to –  30dBm +/–   1800 ps/nm

16 dB N/A <10 exp – 12 N/A –  9 to –  30dBm +/–   5400 ps/nm

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.5 nm Resolution Bandwidth (RBW)

Table B-20 MXP_MR_2.5G/MXPP_MR_2.5G Receiver Trunk Side Specifications (continued)

OSNR1 FEC Type Pre-FEC BER Post-FEC BER
Input Power 
Sensitivity

Chromatic Dispersion 
Tolerance
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B.5.5   MXP_2.5G_10E Card Specifications
– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 2.25 lb (1.02 kg) 

B.5.5 MXP_2.5G_10E Card Specifications 
The MXP_2.5G_10E card has the following specifications:

• Line (trunk side) 

– Bit rate: 10.70923 Gbps (in ITU-T G.709 Digital Wrapper/FEC mode)

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: +/– 1200 ps/nm (specified penalty) 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10E card. Using 
direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10E card.

– Connectors: LC 

– Compliance: ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE

• Transmitter (trunk side) 

– Maximum transmitter output power: +6 dBm 

– Minimum transmitter output power: +3 dBm 

– Transmitter: LN external modulator transmitter

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths and versions of MXP_2.5G_10E (eight card versions): 

ITU grid blue band:

– 1530.33 to 1533.07 nm (four channels)

– 1534.25 to 1537.00 nm (four channels)

– 1538.19 to 1540.95 nm (four channels)

– 1542.14 to 1544.92 nm (four channels)

ITU grid red band:

– 1546.12 to 1548.92 nm (four channels)

– 1550.12 to 1552.93 nm (four channels)
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B.5.5   MXP_2.5G_10E Card Specifications

n 
– 1554.13 to 1556.96 nm (four channels)

– 1558.17 to 1561.01 nm (four channels)

• Receiver (trunk side) 

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm

• Line (client side) 

– Bit rate: 2.5 Gbps per port (OC-48/STM-16)

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 12 ps/nm (SR SFP version) 

– Loopback modes: Terminal and facility

– Connectors: LC (optical)

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side): Depends on the SFP that is used.

• Receiver (client side): Depends on the SFP that is used.

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

Table B-21 MXP_2.5G_10E Receiver Trunk Side Specifications

OSNR1 FEC Type Pre-FEC BER Post-FEC BER
Input Power 
Sensitivity

Chromatic Dispersio
Tolerance

23 dB Off <10 exp – 12 N/A  – 8 to  – 20 dBm +/– 1200 ps/nm

19 dB Off <10 exp – 12 N/A  – 8 to  – 20 dBm +/– 1000 ps/nm

19 dB Off <10 exp – 12 N/A  – 8 to  – 22 dBm  —

10 dB Standard <10 exp – 5 <10 exp – 15  – 8 to  – 18 dBm +/– 800 ps/nm

8 dB Standard <10 exp – 5 <10 exp – 15  – 8 to  – 18 dBm —

8 dB Enhanced <7 x 10 exp – 4 <10 exp – 15  – 8 to  – 18 dBm +/– 800 ps/nm

7 dB Enhanced <7 x 10 exp – 4 <10 exp – 15  – 8 to  – 18 dBm  —

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.5 nm Resolution Bandwidth (RBW)
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B.5.6   TXP_MR_10E Card Specifications
– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.6 TXP_MR_10E Card Specifications
The TXP_MR_10E card has the following specifications:

• Line (trunk side) 

– Bit rate: OC-192/STM-64 (9.95328 Gbps), OTU2 (10.70923 Gbps), 10GE (10.3125 Gbps), 
10GE into OTU2 (non-standard 11.0957 Gbps), 10G FC (10.51875 Gbps), or 10G FC into 
OTU2 (non-standard 11.31764 Gbps)

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode

– Maximum chromatic dispersion allowance: +/– 1200 ps/nm (specified penalty) 

– Loopback modes: Terminal and facility

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E 
card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957, and ITU-T G.709 

• Transmitter (trunk side) 

– Maximum transmitter output power: +6 dBm 

– Minimum transmitter output power: +3 dBm for C-band and +2 dBm for L-band

– Transmitter: LN external modulator transmitter

– Wavelength stability (drift): +/– 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/– 25 pm.

• Currently available wavelengths and versions of TXP_MR_10E: 

C-band frequency plan (eight card versions, each with four tunable channels on the ITU 100-GHz 
grid):

– 1530.33 to 1533.07 nm (four channels)

– 1534.25 to 1537.00 nm (four channels)

– 1538.19 to 1540.95 nm (four channels)

– 1542.14 to 1544.92 nm (four channels)

– 1546.12 to 1548.92 nm (four channels)

– 1550.12 to 1552.93 nm (four channels)

– 1554.13 to 1556.96 nm (four channels)

– 1558.17 to 1561.01 nm (four channels)
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L-band frequency plan (five card versions, each with eight tunable channels on the ITU 50-GHz 
grid):

– 1577.44 to 1580.35 nm (eight channels)

– 1580.77 to 1583.69 nm (eight channels)

– 1584.11 to 1587.04 nm (eight channels)

– 1587.46 to 1590.41 nm (eight channels)

– 1590.83 to 1593.79 nm (eight channels)

• Receiver (trunk side)

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm

• Line (client side): 

– 10-Gigabit Small Form-factor Pluggable (XFP)-based SR

– Bit rate: 10GE (10.3125 Gbps), 10G FC (10.51875 Gbps), or STM-64/OC-192

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 6.6 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957, ITU-T G.691

• Transmitter (client side)

– Maximum transmitter output power: –1 dBm 

– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

Table B-22 TXP_MR_10E Receiver Trunk Side Specifications

OSNR1 FEC Type Pre-FEC BER Post-FEC BER
Input Power 
Sensitivity2

Chromatic Dispersion 
Tolerance

23 dB Off <10 exp – 12 N/A  – 8 to – 20 dBm +/– 1200 ps/nm

19 dB Off <10 exp – 12 N/A  – 8 to – 20 dBm + – 1000 ps/nm

19 dB Off <10 exp – 12 N/A  – 8 to – 22 dBm —

10 dB Standard <10 exp – 5 <10 exp – 15  – 8 to – 18 dBm +/– 800 ps/nm

8 dB Standard <10 exp – 5 <10 exp – 15  – 8 to – 18 dBm —

8 dB Enhanced <7 x 10 exp – 4 <10 exp – 15  – 8 to – 18 dBm +/– 800 ps/nm

7 dB Enhanced <7 x 10 exp – 4 <10 exp – 15  – 8 to – 18 dBm —

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.5 nm Resolution Bandwidth (RBW)

2. Receiver filter bandwidth greater than or equal to 180 pm (at - 3 dBm)
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– Transmitter: DFB laser 

• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: APD

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95 percent, noncondensing

– Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.6 SFP Specifications
Table B-23 lists the specifications for available SFPs. 

Table B-23 SFP Specifications

SFP Product ID Interface
Transmitter Output 
Power Min/Max (dBm)

Receiver Input Power 
Min/Max (dBm)

15454-SFP3-1-IR= OC-3 –15 to –8 –23 to –8

15454E-SFP-L.1.1= STM-1 –15 to –8 –34 to –10

15454-SFP12-4-IR= OC-12, D1 Video –15 to –8 –28 to –7

15454E-SFP-L.4.1= STM-4, D1 Video –15 to –8 –28 to –8

15454-SFP-OC48-IR= OC-48, DV6000 (C-Cor) –5 to +0 –18 to +0

ONS-SE-2G-S1= OC-48, STM-16 –10 to –3 –18 to –3

15454E-SFP-L.16.1= STM-16, DV6000 
(C-Cor)

–5 to +0 –18 to 0

15454-SFP-200/
15454E-SFP-200

ESCON1 –20.5 to –15 –29 to –4

15454-SFP-GEFC-SX=/
15454E-SFP-GEFC-S=

Fibre Channel 
(1 and 2 Gbps), FICON2, 
GE

–10 to –3.5 –17 to 0 (1FC and 1GE)

–15 to 0 (2FC)
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B.6   SFP Specifications
SFP Port Cabling Specifications
Table B-24 provides cabling specifications for the single-mode fiber (SMF) SFPs and Table B-25 
provides cabling specifications for multimode fiber (MMF) SFPs that you install into Ethernet cards. The 
ports of the listed SFPs have LC-type connectors.

15454-SFP-GE+-LX=/
15454E-SFP-GE+-LX=

Fibre Channel
(1 and 2 Gbps), FICON, 
GE, HDTV3

–9.5 to –3.0 –20 to –3 (1FC, 1GE, 
and 2FC)

ONS-SE-2G-L2 OC-48, STM-16 –2 to 3 –28 to –9

ONS-SE-GE-ZX Fibre Channel 
(1 and 2 Gbps), FICON, 
GE

0 to 5 –25 to 0

1. ESCON = Enterprise System Connection

2. FICON = fiber connectivity

3. HDTV = high-definition television

Table B-23 SFP Specifications (continued)

SFP Product ID Interface
Transmitter Output 
Power Min/Max (dBm)

Receiver Input Power 
Min/Max (dBm)

Table B-24 Single-Mode Fiber SFP Port Cabling Specifications

SFP Product ID Wavelength1

1. Typical loss on a 1310 nm wavelength is 0.6 dB/km.

Fiber Type Cable Distance

15454-SFP3-1-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

15454E-SFP-L.1.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP12-4-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

15454E-SFP-L.4.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP-OC48-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

ONS-SE-2G-S1=
Short Reach

1310 nm 9 micron SMF 2 km (1.2 miles)

15454E-SFP-L.16.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP-GE+-LX=/
15454E-SFP-GE+-LX=
Long Reach

1310 nm 9 micron SMF 10 km (6.2 miles) for FC 1G, 
FC 2G, and GE
5 km (3.1 miles) for HDTV
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B.7 XFP Specifications
Table B-26 lists the specifications for available XFPs. 

B.7.1 XFP Port Cabling Specifications
Table B-27 provides cabling specifications for the SMF XFPs. The ports of the listed XFPs have LC-type 
connectors.

Table B-25 Multimode Fiber SFP Port Cabling Specifications

SFP Product ID Wavelength Fiber Type Cable Distance

15454-SFP-200/
15454E-SFP-200
Long Reach

1310 nm 62.5 micron MMF 2 km (1.2 miles)

15454-SFP-GEFC-SX/
15454E-SFP-GEFC-S
Short Reach

850 nm 62.5 micron MMF 300 m (984 ft) for FC 1 Gbps 
and 1.2 Gbps GE
150 m (492 ft) for FC 2 Gbps

50.0 micron MMF 550 m (1804 ft) for FC 1 Gbps 
and 1.2 Gbps GE
300 m (984 ft) for FC 2 Gbps

Table B-26 XFP Specifications

XFP Product ID Interface
Transmitter Output 
Power Min/Max (dBm)

Receiver Input Power 
Min/Max (dBm)

ONS-XC-10G-S1 10 Gigabit Ethernet, 
OC-192, STM-64, 
10Gbps Fibre Channel

-1 to -11 0.5 

Table B-27 Single-Mode Fiber XFP Port Cabling Specifications

XFP Product ID Wavelength1

1. Typical loss on a 1310 nm wavelength is 0.6 dB/km.

Fiber Type Cable Distance

ONS-XC-10G-S1 1310 nm SMF 10 km (6.2 miles)
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A P P E N D I X C

DWDM Administrative and Service States

This appendix describes the administrative and service states for Cisco ONS 15454 dense wavelength 
division multiplexing (DWDM) cards, optical payload ports, out-of-band optical supervision channel 
(OSC) ports, optical channel network connections (OCHNC), and transponder/muxponder cards and 
ports. Software Release 5.0 states are based on the generic state model defined in 
Telcordia GR-1093-Core, Issue 2 and ITU-T X.731. 

C.1 Service States
Service states include a Primary State (PST), a Primary State Qualifier (PSTQ), and one or more 
Secondary States (SST). Table C-1 lists the ANSI and ETSI service state PSTs and PSTQs supported by 
the ONS 15454.

Table C-2 defines the ANSI and ETSI SSTs supported by the ONS 15454.

Table C-1 ONS 15454 Service State Primary States and Primary State Qualifiers

ANSI Primary State, Primary 
State Qualifier

ETSI Primary State, Primary 
State Qualifier Definition

IS-NR (In-Service and Normal) Unlocked-enabled The entity is fully operational and will perform as 
provisioned.

OOS-AU (Out-of-Service and 
Autonomous)

Unlocked-disabled The entity is not operational because of an autonomous 
event.

OOS-AUMA (Out-of-Service 
and Autonomous Management)

Locked-disabled The entity is not operational because of an autonomous 
event and has also been manually removed from service.

OOS-MA (Out-of-Service and 
Management) 

Locked-enabled The entity has been manually removed from service.
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C.2 Administrative States
Administrative states are used to manage service states. Administrative states consist of a PST and an 
SST. Table C-3 lists the ANSI and ETSI administrative states supported by the ONS 15454. See 
Table C-2 for SST definitions. 

Note A change in the administrative state of an entity does not change the service state of supporting or 
supported entities. 

Table C-2 ONS 15454 Secondary States

ANSI Secondary 
State ETSI Secondary State Definition

AINS automaticInService The entity is delayed before transitioning to the 
IS-NR (ANSI)/Unlocked-enabled (ETSI) service state. The transition to 
IS-NR/Unlocked-enabled depends on correction of conditions. Alarm 
reporting is suppressed, but traffic is carried. Raised fault conditions, 
whether or not their alarms are reported, can be retrieved on the CTC 
Conditions tab or by using the TL1 RTRV-COND command.

DSBLD disabled The entity was manually removed from service and does not provide its 
provisioned functions. All services are disrupted; unable to carry traffic.

MEA mismatchOfEquipment An improper card is installed. For example, an installed card is not 
compatible with the card pre-provisioning or the slot. This SST applies 
only to cards.

MT maintenance The entity has been manually removed from service for a maintenance 
activity but still performs its provisioned functions. Alarm reporting is 
suppressed, but traffic is carried. Raised fault conditions, whether or not 
their alarms are reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command.

SWDL softwareDownload The card is involved in a software and database download. This SST 
applies only to cards.

UAS unassigned The card is not provisioned in the database. This SST applies only to cards.

UEQ 
(Unequipped)

notInstalled The card is not physically present (that is, an empty slot). This SST applies 
only to cards.

Table C-3 ONS 15454 Administrative States

ANSI Administrative 
State (PST,SST)

ETSI Administrative State 
(PST,SST) Definition

IS Unlocked Puts the entity in-service.

IS,AINS Unlocked,automaticInService Puts the entity in automatic in-service.

OOS,DSBLD Locked,disabled Removes the entity from service and disables it.

OOS,MT Locked,maintenance Removes the entity from service for maintenance.
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C.3 Service State Transitions
This section describes the transition from one service state to the next state for DWDM cards, optical 
payload ports, OSC ports, OCHNCs, and transponder/muxponder cards and ports. A service state 
transition is based on the action performed on the entity and any autonomous activity.

C.3.1 DWDM Card Service State Transitions 

Table C-4 lists ANSI and ETSI service state transitions for AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, 
AD-2C-xx.x, AD-4C-xx.x, OSC-CSM, OSCM, OPT-BST, OPT-PRE, 4MD-xx.x, 32WSS, 32MUX-O, 
and 32DMX-O cards.

Table C-4 ONS 15454 Optical Unit Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Reset the card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI)

• Locked-disabled,unassigned (ETSI)

If the card is invalid: 

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)
C-3
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Appendix C      DWDM Administrative and Service States
Service State Transitions
OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment 
(ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid: 

• OOS-AUMA,MEA & UAS (ANSI)

• Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload 
(ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

Provision the card. OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Table C-4 ONS 15454 Optical Unit Service State Transitions (continued)

Current Service State Action Next Service State
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C.3.2 Optical Payload Port Service State Transitions
Table C-5 lists the ANSI and ETSI optical payload port service state transitions. 

OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Restart completed. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment & 
maintenance (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled (ETSI)

OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

Provision an invalid 
card.

OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Provision a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pre-provision a card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Table C-4 ONS 15454 Optical Unit Service State Transitions (continued)

Current Service State Action Next Service State

Table C-5 ONS 15454 Optical Payload Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,DSBLD 
administrative state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

The OCHNC end-to-end path no 
longer exists.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)
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C.3.3 OSC Port Service State Transitions
Table C-6 lists the ANSI and ETSI OSC port service state transitions. 

C.3.4 OCHNC Service State Transitions
Table C-7 lists the ANSI and ETSI OCHNC service state transitions. 

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

All required OCHNC 
connections exist.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the OOS,DSBLD. OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,MT. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,DSBLD 
administrative state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Table C-5 ONS 15454 Optical Payload Port Service State Transitions (continued)

Current Service State Action Next Service State

Table C-6 ONS 15454 OSC Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the OSC. OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Create the OSC. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)
C-6
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Appendix C      DWDM Administrative and Service States
Service State Transitions
C.3.5 Transponder/Muxponder Card Service State Transitions
Table C-8 lists ANSI and ETSI transponder and muxponder card service state transitions.

Table C-7 ONS 15454 OCHNC Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the connection in the 
OOS,MT administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the connection in the 
IS,AINS administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the connection in the IS 
administrative state.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the connection in the 
IS,AINS administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Change the administrative state 
to OOS,MT.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Reset the card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload 
(ETSI)
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OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment & 
maintenance (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Delete the card. If the card is valid:

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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OOS-AU,MEA (ANSI) Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI)

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload 
(ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment 
& maintenance (ETSI)

Change the administrative state 
to IS.

OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Delete the card. If the card is valid:

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI)

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Provision the card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Restart completed. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & 
notInstalled (ETSI)

Change the administrative state 
to IS.

OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment & 
maintenance (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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C.3.6 Transponder/Muxponder Port Service State Transitions
Table C-9 lists the ANSI and ETSI transponder and muxponder port service state transitions. 

OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Provision an invalid card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Provision a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pre-provision a card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Change the administrative state 
to IS.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Reset the card. OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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Table C-9 ONS 15454 Transponder/Muxponder Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the OOS,DSBLD 
administrative state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the IS 
administrative state.

IS-NR1 (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the OOS,DSBLD. OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the port in the IS 
administrative state.

IS-NR1 (ANSI)

Unlocked-enabled (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,MT. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,LPBK & MT (ANSI)

Locked-enabled,loopback & maintenance 
(ETSI)

Release the loopback. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)
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OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the IS 
administrative state.

IS-NR1

Unlocked-enabled (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,DSBLD. OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the port in loopback. OOS-MA,LPBK & MT2 3 (ANSI)

Locked-enabled,loopback & maintenance 
(ETSI)

1. The transponder and muxponder cards have both client and trunk ports. To bring up service, it is not necessary that both the client side and trunk side 
have to be in the IS-NR (ANSI)/Unlocked-enabled (ETSI) service state.

2. In a client-side facility loopback, the client port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state 
and the remaining client and trunk ports can be in any other service state. In a client-side terminal loopback on transponder cards, the client port is in 
the OOS-MA,LPBK & MT service state and the trunk ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI). For client-side terminal loopbacks on 
muxponder cards, the client port is in the OOS-MA,LPBK & MT service state and remaining client and trunk ports can be in any service state.

3. In a trunk-side facility loopback, the trunk port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state 
and the remaining client and trunk ports can be in any other service state. In a trunk-side terminal loopback, the trunk port is in the OOS-MA,LPBK & 
MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state and the client ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI) for 
complete loopback functionality. This type of loopback affects all client ports because it is performed on the aggregate signal.

Table C-9 ONS 15454 Transponder/Muxponder Port Service State Transitions (continued)

Current Service State Action Next Service State
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A P P E N D I X D

Network Element Defaults

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This appendix describes the factory-configured (default) network element (NE) settings for the Cisco 
ONS 15454. It includes descriptions of card default settings and node default settings. To import, export, 
or edit the settings, refer to Chapter 12, “Maintain the Node.” Cards supported by this platform that are 
not listed in this appendix are not supported by factory-configured NE default settings.

To change card settings individually (that is, without changing the defaults), refer to Chapter 11, 
“Change DWDM Card Settings.” To change node settings, refer to Chapter 10, “Manage the Node.”

Note Unless otherwise specified, in this appendix “ONS 15454” refers to both ANSI (ONS 15454 SONET) 
and ETSI (ONS 15454 SDH) shelf assemblies.

D.1 Network Element Defaults Description
The NE defaults are pre-installed on each Cisco ONS 15454 TCC2/TCC2P card. They also ship as a file 
called 15454-defaults.txt (ANSI shelves) or 15454SDH-defaults.txt (ETSI shelves) on the CTC software 
CD in the event you want to import the defaults onto existing TCC2/TCC2P cards. The NE defaults 
include card-level, CTC, and node-level defaults.

Changes made manually using Change Card Settings procedures in Chapter 11, “Change DWDM Card 
Settings” override default settings. If you use the Defaults Editor or import a new defaults file, the 
default changes do not change the settings for cards that are currently installed or slots that are 
pre-provisioned for cards. 

Changes made manually to most node-level default settings (either when you initially turn up a node or 
change node settings later) override the current settings, whether default or provisioned. If you change 
the default settings, using either the Defaults Editor or by importing a new defaults file, the new defaults 
take effect immediately for all settings except those relating to protection (1+1 bidirectional switching, 
1+1 reversion time, 1+1 revertive, BLSR/MS-SPRing reversion time, BLSR/MS-SPRing ring revertive, 
BLSR/MS-SPRing span reversion time, BLSR/MS-SPRingnp span revertive). 
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Note Changing the IIOP listener port in the NE defaults requires a reboot of the node in order for the 
default change to occur. Use caution when changing this default setting.

D.2 ANSI Platform Defaults
The following sections give the NE defaults for the 15454 ANSI platform. To see defaults for the 15454 
ETSI platform, refer to the “D.3 ETSI Platform Defaults” section on page D-43.

D.2.1 ANSI Card Default Settings
The tables in this section list the default settings for each DWDM, TXP, and MXP card. For all other 
cards, including electrical, optical, Ethernet, and fibre channel, refer to the Cisco ONS 15454 Reference 
Manual. 

Cisco provides settings that are pre-provisioned for the Cisco ONS 15454 cards, including:

• Soak Time (all cards) is the length of time that elapses between an AINS port receiving a valid signal 
and when it automatically changes to in-service status. 

• Port State (all cards) sets the port to one of the four available states (IS, OOS, OOS_MT, or 
OOS_AINS), depending on whether you need ports in or out of service.

• SF BER Level (TXP and MXP cards) defines the signal fail bit error rate.

• SD BER Level (TXP and MXP cards) defines the signal degrade bit error rate.

• Enable Sync Messages (MXP cards) enables synchronization status messages (S1 byte), which 
allow the node to choose the best timing source. 

• Send Do Not Use (TXP and MXP cards) sends a DUS message on the S1 byte when enabled. 

• Payload Type (TXP and MXP cards) defines the type of client signal.

• Termination Mode (TXP and MXP cards) defines the type of termination (line, section, or 
transparent).

• ALS Mode (TXP and MXP cards) sets the automatic laser shutdown feature to one of four available 
states (disabled, auto restart, manual restart, manual restart for test).

• ALS Recovery Interval (TXP and MXP cards) sets the automatic laser shutdown recovery time 
interval.

• ALS Recovery Pulse Width (TXP and MXP cards) set the automatic laser shutdown recovery pulse 
signal width.

• FEC (TXP and MXP cards) enables or disables the FEC monitoring on the optical transport network.

• G.709 OTN (TXP and MXP cards) enables or disables the G.709 monitoring on the optical transport 
network.

• FEC Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
FEC performance data and detecting problems early.

• Optical Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
physical optics performance data and detecting problems early.

• OTN Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
OTN trunk-side performance data and detecting problems early.
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• PM Threshold Settings (all cards) set the performance monitoring parameters for gathering 
performance data and detecting problems early.

Note For more information about the performance monitoring parameters, refer to Chapter 9, “Monitor 
Performance.”

D.2.1.1 MXP-2.5G-10E Card Default Settings

Table D-1 lists the MXP-2.5G-10E card default settings.

Table D-1 MXP-2.5G-10E Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

MXP-2_5G-10E.config.client.AINSSoakTime 08:00

(hours:mins)

MXP-2_5G-10E.config.client.AisSquelchMode Squelch

MXP-2_5G-10E.config.client.AlsMode Disabled

MXP-2_5G-10E.config.client.AlsRecoveryPulseDuration 2

MXP-2_5G-10E.config.client.AlsRecoveryPulseInterval 100 100 2000

MXP-2_5G-10E.config.client.SDBER 1e-007

MXP-2_5G-10E.config.client.SFBER 0.0001

MXP-2_5G-10E.config.client.SendDoNotUse FALSE

MXP-2_5G-10E.config.client.SyncMsgIn TRUE

MXP-2_5G-10E.config.client.TerminationMode Transparent

MXP-2_5G-10E.config.client.ppmPortAssignment OC48_PORT

MXP-2_5G-10E.config.client.ppmSlotAssignment UNASSIGNED

MXP-2_5G-10E.config.trunk.AINSSoakTime 0.33333333333

MXP-2_5G-10E.config.trunk.AlsMode Disabled

MXP-2_5G-10E.config.trunk.AlsRecoveryPulseDuration 100

MXP-2_5G-10E.config.trunk.AlsRecoveryPulseInterval 300 200 2000

MXP-2_5G-10E.opticalthresholds.client.alarm.HighLaserBias 90

MXP-2_5G-10E.opticalthresholds.client.alarm.HighRxPower 3

MXP-2_5G-10E.opticalthresholds.client.alarm.HighTxPower 3

MXP-2_5G-10E.opticalthresholds.client.alarm.LowRxPower -21

MXP-2_5G-10E.opticalthresholds.client.alarm.LowTxPower -8

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighLaserBias 81

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighRxPower 2

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowTxPower -7
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MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighLaserBias 98

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighTxPower 8

MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowTxPower 1

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighLaserBias 95

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighTxPower 7

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowTxPower 2

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighLaserBias 96

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighTxPower 7

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowTxPower 2

MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected 903330 0 9033621811200

MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.UncorrectableWord
s

5 0 4724697600

MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected 86719680 0 8672276938752
00

MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords 480 0 453570969600

MXP-2_5G-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811200

MXP-2_5G-10E.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

MXP-2_5G-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 8672276938752
00

MXP-2_5G-10E.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.ES 87 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.SES 1 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

Table D-1 MXP-2.5G-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.ES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.SES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

MXP-2_5G-10E.otn.otnLines.AsynchSynchMapping ODU Multiplex

MXP-2_5G-10E.otn.otnLines.FEC Standard

Table D-1 MXP-2.5G-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.2 MXP-2.5G-10G Card Default Settings

Table D-2 lists the MXP-2.5G-10G card default settings.

MXP-2_5G-10E.otn.otnLines.G709OTN TRUE

MXP-2_5G-10E.otn.otnLines.SDBER 1e-007

MXP-2_5G-10E.pmthresholds.client.line.farend.15min.CV 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.line.farend.15min.ES 87 0 900

MXP-2_5G-10E.pmthresholds.client.line.farend.15min.FC 10 0 72

MXP-2_5G-10E.pmthresholds.client.line.farend.15min.SES 1 0 900

MXP-2_5G-10E.pmthresholds.client.line.farend.15min.UAS 3 0 900

MXP-2_5G-10E.pmthresholds.client.line.farend.1day.CV 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.line.farend.1day.ES 864 0 86400

MXP-2_5G-10E.pmthresholds.client.line.farend.1day.FC 40 0 6912

MXP-2_5G-10E.pmthresholds.client.line.farend.1day.SES 4 0 86400

MXP-2_5G-10E.pmthresholds.client.line.farend.1day.UAS 10 0 86400

MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.CV 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.ES 87 0 900

MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.FC 10 0 72

MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.SES 1 0 900

MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.UAS 3 0 900

MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.CV 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.ES 864 0 86400

MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.FC 40 0 6912

MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.SES 4 0 86400

MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.UAS 10 0 86400

MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.CV 10000 0 2151900

MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.ES 500 0 900

MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.SEFS 500 0 900

MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.SES 500 0 900

MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.CV 100000 0 206582400

MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.ES 5000 0 86400

MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.SEFS 5000 0 86400

MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.SES 5000 0 86400

Table D-1 MXP-2.5G-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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Table D-2 MXP-2.5G-10G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

MXP-2_5G-10G.config.client.AINSSoakTime 0.3333333333
3

MXP-2_5G-10G.config.client.AlsMode Disabled

MXP-2_5G-10G.config.client.AlsRecoveryPulseDuration 4

MXP-2_5G-10G.config.client.AlsRecoveryPulseInterval 100 60 300

MXP-2_5G-10G.config.client.SDBER 1e-007

MXP-2_5G-10G.config.client.SFBER 0.0001

MXP-2_5G-10G.config.client.SendDoNotUse FALSE

MXP-2_5G-10G.config.client.SyncMsgIn TRUE

MXP-2_5G-10G.config.client.TerminationMode Transparent

MXP-2_5G-10G.config.client.ppmPortAssignment OC48_PORT

MXP-2_5G-10G.config.client.ppmSlotAssignment UNASSIGNE
D

MXP-2_5G-10G.config.trunk.AINSSoakTime 0.3333333333
3

MXP-2_5G-10G.config.trunk.AlsMode Disabled

MXP-2_5G-10G.config.trunk.AlsRecoveryPulseDuration 4

MXP-2_5G-10G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXP-2_5G-10G.opticalthresholds.client.alarm.HighLaserBias 90

MXP-2_5G-10G.opticalthresholds.client.alarm.HighRxPower 3

MXP-2_5G-10G.opticalthresholds.client.alarm.HighTxPower 3

MXP-2_5G-10G.opticalthresholds.client.alarm.LowRxPower -21

MXP-2_5G-10G.opticalthresholds.client.alarm.LowTxPower -8

MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighLaserBias 81

MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighRxPower 2

MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowTxPower -7

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighLaserBias 90

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighTxPower 4
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MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowTxPower 2

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighLaserBias 81

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighTxPower 3.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowTxPower 2.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighLaserBias 85.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.7

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowTxPower 2.3

MXP-2_5G-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811200

MXP-2_5G-10G.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

MXP-2_5G-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 86722769387520
0

MXP-2_5G-10G.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

Table D-2 MXP-2.5G-10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

MXP-2_5G-10G.otn.otnLines.FEC Standard

MXP-2_5G-10G.otn.otnLines.G709OTN TRUE

MXP-2_5G-10G.otn.otnLines.SDBER 1e-007

MXP-2_5G-10G.pmthresholds.client.line.farend.15min.CV 21260 0 2212200

MXP-2_5G-10G.pmthresholds.client.line.farend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.client.line.farend.15min.FC 10 0 72

MXP-2_5G-10G.pmthresholds.client.line.farend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.client.line.farend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.client.line.farend.1day.CV 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.line.farend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.client.line.farend.1day.FC 40 0 6912

MXP-2_5G-10G.pmthresholds.client.line.farend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.client.line.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.CV 21260 0 2212200

MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.ES 87 0 900

Table D-2 MXP-2.5G-10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.FC 10 0 72

MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.CV 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.CV 10000 0 2151900

MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.ES 500 0 900

MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.SEFS 500 0 900

MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.SES 500 0 900

MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.CV 100000 0 206582400

MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.SEFS 5000 0 86400

MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.SES 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.CV 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.FC 10 0 72

MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.CV 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.FC 40 0 6912

MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.CV 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.FC 10 0 72

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.1day.CV 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.trunk.line.nearend.1day.UAS 10 0 86400

Table D-2 MXP-2.5G-10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.3 MXP-MR-2.5G Card Default Settings

Table D-3 lists the MXP-MR-2.5G card default settings.

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.15min.CV 10000 0 7967700

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.15min.ES 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.15min.SEFS 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.15min.SES 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.1day.CV 100000 0 764899200

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.1day.SEFS 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.section.nearend.1day.SES 5000 0 86400

Table D-2 MXP-2.5G-10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum

Table D-3 MXP-MR-2.5G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

MXP-MR-2_5G.config.client.AlsMode Disabled

MXP-MR-2_5G.config.client.AlsRecoveryPulseDuration 4

MXP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

MXP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

MXP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

MXP-MR-2_5G.config.fc.distanceExtension.AutoDetect TRUE

MXP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThr
eshold

TRUE

MXP-MR-2_5G.config.fc.distanceExtension.Enabled TRUE

MXP-MR-2_5G.config.fc.distanceExtension.NumCredits 32 2 256

MXP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers 16

MXP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize 2148

MXP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

MXP-MR-2_5G.config.trunk.AlsMode Disabled

MXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 4

MXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXP-MR-2_5G.config.trunk.SDBER 1e-007

MXP-MR-2_5G.config.trunk.SFBER 0.0001

MXP-MR-2_5G.config.trunk.SendDoNotUse FALSE

MXP-MR-2_5G.config.trunk.SyncMsgIn TRUE

MXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

MXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3
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MXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

MXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

MXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -8

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBia
s

81

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower -40

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower -40

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower -40

MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.CV 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.ES 87 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.FC 10 0 72

MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.SES 1 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.UAS 3 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.CV 212600 0 212371200

MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.ES 864 0 86400

Table D-3 MXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.4 MXPP-MR-2.5G Card Default Settings

Table D-4 lists the MXPP-MR-2.5G card default settings.

MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.FC 40 0 6912

MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.SES 4 0 86400

MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.UAS 10 0 86400

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.CV 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.ES 87 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.FC 10 0 72

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.SES 1 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.UAS 3 0 900

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.CV 212600 0 212371200

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.ES 864 0 86400

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.FC 40 0 6912

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.SES 4 0 86400

MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.UAS 10 0 86400

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.CV 10000 0 2151900

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.ES 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SEFS 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SES 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.CV 100000 0 206582400

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.ES 5000 0 86400

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.SEFS 5000 0 86400

MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.SES 5000 0 86400

Table D-3 MXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum

Table D-4 MXPP-MR-2.5G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

MXPP-MR-2_5G.config.client.AlsMode Disabled

MXPP-MR-2_5G.config.client.AlsRecoveryPulseDuration 4

MXPP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

MXPP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

MXPP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

MXPP-MR-2_5G.config.fc.distanceExtension.AutoDetect TRUE

MXPP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThres
hold

TRUE

MXPP-MR-2_5G.config.fc.distanceExtension.Enabled TRUE
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MXPP-MR-2_5G.config.fc.distanceExtension.NumCredits 32 2 256

MXPP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers 16

MXPP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize 2148

MXPP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

MXPP-MR-2_5G.config.trunk.AlsMode Disabled

MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 4

MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXPP-MR-2_5G.config.trunk.SDBER 1e-007

MXPP-MR-2_5G.config.trunk.SFBER 0.0001

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

MXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

MXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -8

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias 81

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower 30

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower -40

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower 30

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower -40

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

Table D-4 MXPP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.5 TXP-MR-10E Card Default Settings

Table D-5 lists the TXP-MR-10E card default settings.

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower 30

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower -40

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.CV 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.ES 87 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.FC 10 0 72

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.SES 1 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.UAS 3 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.1day.CV 212600 0 212371200

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.1day.ES 864 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.1day.FC 40 0 6912

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.1day.SES 4 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.line.farend.1day.UAS 10 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.CV 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.ES 87 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.FC 10 0 72

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.SES 1 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.UAS 3 0 900

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.CV 212600 0 212371200

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.ES 864 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.FC 40 0 6912

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.SES 4 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.UAS 10 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.CV 10000 0 2151900

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.ES 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SEFS 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SES 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.CV 100000 0 206582400

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.ES 5000 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.SEFS 5000 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.SES 5000 0 86400

Table D-4 MXPP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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Table D-5 TXP-MR-10E Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

TXP-MR-10E.config.client.AINSSoakTime 0.33333333333

TXP-MR-10E.config.client.AisSquelchMode Squelch

TXP-MR-10E.config.client.AlsMode Disabled

TXP-MR-10E.config.client.AlsRecoveryPulseDuration 2

TXP-MR-10E.config.client.AlsRecoveryPulseInterval 100 100 2000

TXP-MR-10E.config.client.SDBER 1e-007

TXP-MR-10E.config.client.SFBER 0.0001

TXP-MR-10E.config.client.SendDoNotUse FALSE

TXP-MR-10E.config.client.SyncMsgIn TRUE

TXP-MR-10E.config.client.TerminationMode Transparent

TXP-MR-10E.config.client.ppmPortAssignment UNASSIGNED

TXP-MR-10E.config.client.ppmSlotAssignment UNASSIGNED

TXP-MR-10E.config.trunk.AINSSoakTime 0.33333333333

TXP-MR-10E.config.trunk.AlsMode Disabled

TXP-MR-10E.config.trunk.AlsRecoveryPulseDuration 100

TXP-MR-10E.config.trunk.AlsRecoveryPulseInterval 300 200 2000

TXP-MR-10E.config.trunk.SDBER 1e-007

TXP-MR-10E.config.trunk.SFBER 0.0001

TXP-MR-10E.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-10E.opticalthresholds.client.alarm.HighRxPower 2

TXP-MR-10E.opticalthresholds.client.alarm.HighTxPower 2

TXP-MR-10E.opticalthresholds.client.alarm.LowRxPower -17

TXP-MR-10E.opticalthresholds.client.alarm.LowTxPower -9

TXP-MR-10E.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-10E.opticalthresholds.client.warning.15min.HighRxPower 1

TXP-MR-10E.opticalthresholds.client.warning.15min.HighTxPower 1

TXP-MR-10E.opticalthresholds.client.warning.15min.LowRxPower -16

TXP-MR-10E.opticalthresholds.client.warning.15min.LowTxPower -8

TXP-MR-10E.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-10E.opticalthresholds.client.warning.1day.HighRxPower 1.5

TXP-MR-10E.opticalthresholds.client.warning.1day.HighTxPower 1.5

TXP-MR-10E.opticalthresholds.client.warning.1day.LowRxPower -16.5

TXP-MR-10E.opticalthresholds.client.warning.1day.LowTxPower -8.5

TXP-MR-10E.opticalthresholds.trunk.alarm.HighLaserBias 98

TXP-MR-10E.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-10E.opticalthresholds.trunk.alarm.HighTxPower 8
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TXP-MR-10E.opticalthresholds.trunk.alarm.LowRxPower -25

TXP-MR-10E.opticalthresholds.trunk.alarm.LowTxPower 1

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighTxPower 7

TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowTxPower 2

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighTxPower 7

TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowTxPower 2

TXP-MR-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected 903330 0 9033621811200

TXP-MR-10E.otn.fecthresholds.enhanced.15min.UncorrectableWord
s

5 0 4724697600

TXP-MR-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected 86719680 0 86722769387520
0

TXP-MR-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords 480 0 453570969600

TXP-MR-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811200

TXP-MR-10E.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

TXP-MR-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 86722769387520
0

TXP-MR-10E.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

Table D-5 TXP-MR-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-10E.otn.otnLines.AsynchSynchMapping Synch Mapping

TXP-MR-10E.otn.otnLines.FEC Standard

TXP-MR-10E.otn.otnLines.G709OTN TRUE

TXP-MR-10E.otn.otnLines.SDBER 1e-007

TXP-MR-10E.pmthresholds.client.line.farend.15min.CV 85040 0 8850600

TXP-MR-10E.pmthresholds.client.line.farend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.client.line.farend.15min.FC 10 0 72

TXP-MR-10E.pmthresholds.client.line.farend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.client.line.farend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.client.line.farend.1day.CV 850400 0 849657600

Table D-5 TXP-MR-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10E.pmthresholds.client.line.farend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.client.line.farend.1day.FC 40 0 6912

TXP-MR-10E.pmthresholds.client.line.farend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.client.line.farend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.client.line.nearend.15min.CV 85040 0 8850600

TXP-MR-10E.pmthresholds.client.line.nearend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.client.line.nearend.15min.FC 10 0 72

TXP-MR-10E.pmthresholds.client.line.nearend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.client.line.nearend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.client.line.nearend.1day.CV 850400 0 849657600

TXP-MR-10E.pmthresholds.client.line.nearend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.client.line.nearend.1day.FC 40 0 6912

TXP-MR-10E.pmthresholds.client.line.nearend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.client.line.nearend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.client.section.nearend.15min.CV 10000 0 7967700

TXP-MR-10E.pmthresholds.client.section.nearend.15min.ES 500 0 900

TXP-MR-10E.pmthresholds.client.section.nearend.15min.SEFS 500 0 900

TXP-MR-10E.pmthresholds.client.section.nearend.15min.SES 500 0 900

TXP-MR-10E.pmthresholds.client.section.nearend.1day.CV 100000 0 764899200

TXP-MR-10E.pmthresholds.client.section.nearend.1day.ES 5000 0 86400

TXP-MR-10E.pmthresholds.client.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-10E.pmthresholds.client.section.nearend.1day.SES 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.line.farend.15min.CV 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.line.farend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.trunk.line.farend.15min.FC 10 0 72

TXP-MR-10E.pmthresholds.trunk.line.farend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.trunk.line.farend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.trunk.line.farend.1day.CV 850400 0 849657600

TXP-MR-10E.pmthresholds.trunk.line.farend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.trunk.line.farend.1day.FC 40 0 6912

TXP-MR-10E.pmthresholds.trunk.line.farend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.trunk.line.farend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.CV 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.FC 10 0 72

TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.SES 1 0 900

Table D-5 TXP-MR-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.6 TXP_MR_10G Card Default Settings

Table D-6 lists the TXP_MR_10G card default settings.

TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.trunk.line.nearend.1day.CV 850400 0 849657600

TXP-MR-10E.pmthresholds.trunk.line.nearend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.trunk.line.nearend.1day.FC 40 0 6912

TXP-MR-10E.pmthresholds.trunk.line.nearend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.trunk.line.nearend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.trunk.section.nearend.15min.CV 10000 0 7967700

TXP-MR-10E.pmthresholds.trunk.section.nearend.15min.ES 500 0 900

TXP-MR-10E.pmthresholds.trunk.section.nearend.15min.SEFS 500 0 900

TXP-MR-10E.pmthresholds.trunk.section.nearend.15min.SES 500 0 900

TXP-MR-10E.pmthresholds.trunk.section.nearend.1day.CV 100000 0 764899200

TXP-MR-10E.pmthresholds.trunk.section.nearend.1day.ES 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.section.nearend.1day.SES 5000 0 86400

Table D-5 TXP-MR-10E Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum

Table D-6 TXP_MR_10G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

TXP-MR-10G.config.client.AINSSoakTime 0.33333333333

TXP-MR-10G.config.client.AlsMode Disabled

TXP-MR-10G.config.client.AlsRecoveryPulseDuration 4

TXP-MR-10G.config.client.AlsRecoveryPulseInterval 100 60 300

TXP-MR-10G.config.client.SDBER 1e-007

TXP-MR-10G.config.client.SFBER 0.0001

TXP-MR-10G.config.client.TerminationMode Transparent

TXP-MR-10G.config.client.mrPortAssignment UNASSIGNED

TXP-MR-10G.config.trunk.AINSSoakTime 0.33333333333

TXP-MR-10G.config.trunk.AlsMode Disabled

TXP-MR-10G.config.trunk.AlsRecoveryPulseDuration 4

TXP-MR-10G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXP-MR-10G.config.trunk.SDBER 1e-007

TXP-MR-10G.config.trunk.SFBER 0.0001

TXP-MR-10G.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-10G.opticalthresholds.client.alarm.HighRxPower 2
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TXP-MR-10G.opticalthresholds.client.alarm.HighTxPower 2

TXP-MR-10G.opticalthresholds.client.alarm.LowRxPower -17

TXP-MR-10G.opticalthresholds.client.alarm.LowTxPower -9

TXP-MR-10G.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-10G.opticalthresholds.client.warning.15min.HighRxPower 1

TXP-MR-10G.opticalthresholds.client.warning.15min.HighTxPower 1

TXP-MR-10G.opticalthresholds.client.warning.15min.LowRxPower -16

TXP-MR-10G.opticalthresholds.client.warning.15min.LowTxPower -8

TXP-MR-10G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-10G.opticalthresholds.client.warning.1day.HighRxPower 1.5

TXP-MR-10G.opticalthresholds.client.warning.1day.HighTxPower 1.5

TXP-MR-10G.opticalthresholds.client.warning.1day.LowRxPower -16.5

TXP-MR-10G.opticalthresholds.client.warning.1day.LowTxPower -8.5

TXP-MR-10G.opticalthresholds.trunk.alarm.HighLaserBias 90

TXP-MR-10G.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-10G.opticalthresholds.trunk.alarm.HighTxPower 4

TXP-MR-10G.opticalthresholds.trunk.alarm.LowRxPower -25

TXP-MR-10G.opticalthresholds.trunk.alarm.LowTxPower 2

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighLaserBias 81

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighTxPower 3.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowTxPower 2.5

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighLaserBias 85.5

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.7

TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowTxPower 2.3

TXP-MR-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811200

TXP-MR-10G.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

TXP-MR-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 8672276938752
00

TXP-MR-10G.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

Table D-6 TXP_MR_10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

Table D-6 TXP_MR_10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-10G.otn.otnLines.FEC Enable

TXP-MR-10G.otn.otnLines.G709OTN TRUE

TXP-MR-10G.otn.otnLines.SDBER 1e-007

TXP-MR-10G.pmthresholds.client.line.farend.15min.CV 85040 0 8850600

TXP-MR-10G.pmthresholds.client.line.farend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.client.line.farend.15min.FC 10 0 72

TXP-MR-10G.pmthresholds.client.line.farend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.client.line.farend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.client.line.farend.1day.CV 850400 0 849657600

TXP-MR-10G.pmthresholds.client.line.farend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.client.line.farend.1day.FC 40 0 6912

TXP-MR-10G.pmthresholds.client.line.farend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.client.line.farend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.client.line.nearend.15min.CV 85040 0 8850600

TXP-MR-10G.pmthresholds.client.line.nearend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.client.line.nearend.15min.FC 10 0 72

TXP-MR-10G.pmthresholds.client.line.nearend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.client.line.nearend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.client.line.nearend.1day.CV 850400 0 849657600

TXP-MR-10G.pmthresholds.client.line.nearend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.client.line.nearend.1day.FC 40 0 6912

TXP-MR-10G.pmthresholds.client.line.nearend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.client.line.nearend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.client.section.nearend.15min.CV 10000 0 7967700

TXP-MR-10G.pmthresholds.client.section.nearend.15min.ES 500 0 900

TXP-MR-10G.pmthresholds.client.section.nearend.15min.SEFS 500 0 900

TXP-MR-10G.pmthresholds.client.section.nearend.15min.SES 500 0 900

TXP-MR-10G.pmthresholds.client.section.nearend.1day.CV 100000 0 764899200

TXP-MR-10G.pmthresholds.client.section.nearend.1day.ES 5000 0 86400

TXP-MR-10G.pmthresholds.client.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-10G.pmthresholds.client.section.nearend.1day.SES 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.line.farend.15min.CV 85040 0 8850600

TXP-MR-10G.pmthresholds.trunk.line.farend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.trunk.line.farend.15min.FC 10 0 72

TXP-MR-10G.pmthresholds.trunk.line.farend.15min.SES 1 0 900

Table D-6 TXP_MR_10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.7 TXP-MR-2.5G Card Default Settings

Table D-7 lists the TXP-MR-2.5G card default settings.

TXP-MR-10G.pmthresholds.trunk.line.farend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.trunk.line.farend.1day.CV 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.line.farend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.trunk.line.farend.1day.FC 40 0 6912

TXP-MR-10G.pmthresholds.trunk.line.farend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.trunk.line.farend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.CV 85040 0 8850600

TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.FC 10 0 72

TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.CV 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.FC 40 0 6912

TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.CV 10000 0 7967700

TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.ES 500 0 900

TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.SEFS 500 0 900

TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.SES 500 0 900

TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.CV 100000 0 764899200

TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.ES 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SES 5000 0 86400

Table D-6 TXP_MR_10G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

TXP-MR-2_5G.config.client.AINSSoakTime 0.3333333333
3

TXP-MR-2_5G.config.client.AlsMode Disabled

TXP-MR-2_5G.config.client.AlsRecoveryPulseDuration 40

TXP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

TXP-MR-2_5G.config.client.SDBER 1e-007
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TXP-MR-2_5G.config.client.SFBER 0.0001

TXP-MR-2_5G.config.client.TerminationMode Transparent

TXP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNE
D

TXP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNE
D

TXP-MR-2_5G.config.trunk.AINSSoakTime 0.3333333333
3

TXP-MR-2_5G.config.trunk.AlsMode Disabled

TXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 40

TXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXP-MR-2_5G.config.trunk.SDBER 1e-007

TXP-MR-2_5G.config.trunk.SFBER 0.0001

TXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

TXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

TXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

TXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -15

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrected 112500 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected 10800000 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorrecte
d

90000 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.UncorrectableWor
ds

1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrected 8640000 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected 90000 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected 8640000 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorrecte
d

180900 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.UncorrectableWor
ds

1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrected 17366400 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected 180900 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected 17366400 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.oc12.15min.BitErrorsCorrected 56457 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.oc12.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.oc12.1day.BitErrorsCorrected 5419872 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.oc12.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.oc3.15min.BitErrorsCorrected 15012 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.oc3.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.oc3.1day.BitErrorsCorrected 1441152 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.oc3.1day.UncorrectableWords 96 0 453570969600

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.otn.fecthresholds.oc48.15min.BitErrorsCorrected 225837 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.oc48.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.oc48.1day.BitErrorsCorrected 21680352 0 8672276938752
00

TXP-MR-2_5G.otn.fecthresholds.oc48.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE 21260 0 8850600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE 212600 0 849657600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE 21260 0 8850600

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE 212600 0 849657600

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-2_5G.otn.otnLines.FEC Enable

TXP-MR-2_5G.otn.otnLines.G709OTN TRUE

TXP-MR-2_5G.otn.otnLines.SDBER 1e-007

TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.CV 5315 0 552600

TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.CV 53150 0 53049600

TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.FC 40 0 72

TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.CV 5315 0 552600

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.CV 53150 0 53049600

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.CV 10000 0 553500

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SEFS 500 0 900

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SES 500 0 900

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.CV 100000 0 53136000

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.CV 1312 0 137700

TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.CV 13120 0 13219200

TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.FC 40 0 6912

TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.CV 1312 0 137700

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.CV 13120 0 13219200

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.CV 10000 0 138600

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SEFS 500 0 900

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SES 500 0 900

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.CV 100000 0 13305600

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.CV 21260 0 2212200

TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.SES 1 0 900

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.8 TXPP-MR-2.5G Card Default Settings

Table D-8 lists the TTXPP-MR-2.5G card default settings.

TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.CV 212600 0 212371200

TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.FC 40 0 6912

TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.CV 21260 0 2212200

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.FC 10 0 72

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.CV 212600 0 212371200

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.CV 10000 0 2151900

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SEFS 500 0 900

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SES 500 0 900

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.CV 100000 0 206582400

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SEFS 5000 0 86400

TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SES 5000 0 86400

Table D-7 TXP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

TXPP-MR-2_5G.config.client.AINSSoakTime 0.33333333333

TXPP-MR-2_5G.config.client.AlsMode Disabled

TXPP-MR-2_5G.config.client.AlsRecoveryPulseDuration 40

TXPP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

TXPP-MR-2_5G.config.client.SDBER 1e-007

TXPP-MR-2_5G.config.client.SFBER 0.0001
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TXPP-MR-2_5G.config.client.TerminationMode Transparent

TXPP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

TXPP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

TXPP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

TXPP-MR-2_5G.config.trunk.AlsMode Disabled

TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 40

TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXPP-MR-2_5G.config.trunk.SDBER 1e-007

TXPP-MR-2_5G.config.trunk.SFBER 0.0001

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

TXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

TXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -15

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBia
s

81

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrecte
d

112500 0 903362181120
0

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWor
ds

1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected 10800000 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWord
s

96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorr
ected

90000 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.Uncorrectable
Words

1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorre
cted

8640000 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.Uncorrectable
Words

96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected 90000 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected 8640000 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords 96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorr
ected

180900 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.Uncorrectable
Words

1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorre
cted

17366400 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.Uncorrectable
Words

96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected 180900 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected 17366400 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords 96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.oc12.15min.BitErrorsCorrected 56457 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.oc12.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.oc12.1day.BitErrorsCorrected 5419872 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.oc12.1day.UncorrectableWords 96 0 453570969600

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.otn.fecthresholds.oc3.15min.BitErrorsCorrected 15012 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.oc3.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.oc3.1day.BitErrorsCorrected 1441152 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.oc3.1day.UncorrectableWords 96 0 453570969600

TXPP-MR-2_5G.otn.fecthresholds.oc48.15min.BitErrorsCorrected 225837 0 903362181120
0

TXPP-MR-2_5G.otn.fecthresholds.oc48.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.oc48.1day.BitErrorsCorrected 21680352 0 867227693875
200

TXPP-MR-2_5G.otn.fecthresholds.oc48.1day.UncorrectableWords 96 0 453570969600

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE 21260 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE 212600 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE 21260 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE 212600 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)
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TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.otn.otnLines.FEC Enable

TXPP-MR-2_5G.otn.otnLines.G709OTN TRUE

TXPP-MR-2_5G.otn.otnLines.SDBER 1e-007

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.CV 5315 0 552600

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.CV 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.FC 40 0 72

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.CV 5315 0 552600

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.CV 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.FC 40 0 6912

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)
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TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.CV 10000 0 553500

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SEFS 500 0 900

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.CV 100000 0 53136000

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SEFS 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.CV 1312 0 137700

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.CV 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.FC 40 0 6912

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.CV 1312 0 137700

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.CV 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.CV 10000 0 138600

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SEFS 500 0 900

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.CV 100000 0 13305600

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.ES 5000 0 86400

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.1.9 OSCM Card Default Settings

Table D-9 lists the OSCM card default settings.

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SEFS 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.CV 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.1day.CV 212600 0 212371200

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.1day.FC 40 0 6912

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.CV 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.CV 212600 0 212371200

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.CV 10000 0 2151900

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SEFS 500 0 900

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.CV 100000 0 206582400

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SEFS 5000 0 86400

TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SES 5000 0 86400

Table D-8 TXPP-MR-2.5G Card Default Settings (ANSI) (continued)
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D.2.1.10 OSC-CSM Card Default Settings

Table D-10 lists the OSC-CSM card default settings

Table D-9 OSCM Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

OSCM.pmthresholds.line.farend.15min.CV 1312 0 137700

OSCM.pmthresholds.line.farend.15min.ES 87 0 900

OSCM.pmthresholds.line.farend.15min.FC 10 0 72

OSCM.pmthresholds.line.farend.15min.SES 1 0 900

OSCM.pmthresholds.line.farend.15min.UAS 3 0 900

OSCM.pmthresholds.line.farend.1day.CV 13120 0 13219200

OSCM.pmthresholds.line.farend.1day.ES 864 0 86400

OSCM.pmthresholds.line.farend.1day.FC 40 0 6912

OSCM.pmthresholds.line.farend.1day.SES 4 0 86400

OSCM.pmthresholds.line.farend.1day.UAS 10 0 86400

OSCM.pmthresholds.line.nearend.15min.CV 1312 0 137700

OSCM.pmthresholds.line.nearend.15min.ES 87 0 900

OSCM.pmthresholds.line.nearend.15min.FC 10 0 72

OSCM.pmthresholds.line.nearend.15min.SES 1 0 900

OSCM.pmthresholds.line.nearend.15min.UAS 3 0 900

OSCM.pmthresholds.line.nearend.1day.CV 13120 0 13219200

OSCM.pmthresholds.line.nearend.1day.ES 864 0 86400

OSCM.pmthresholds.line.nearend.1day.FC 40 0 6912

OSCM.pmthresholds.line.nearend.1day.SES 4 0 86400

OSCM.pmthresholds.line.nearend.1day.UAS 10 0 86400

OSCM.pmthresholds.section.nearend.15min.CV 10000 0 138600

OSCM.pmthresholds.section.nearend.15min.ES 500 0 900

OSCM.pmthresholds.section.nearend.15min.SEFS 500 0 900

OSCM.pmthresholds.section.nearend.15min.SES 500 0 900

OSCM.pmthresholds.section.nearend.1day.CV 100000 0 13305600

OSCM.pmthresholds.section.nearend.1day.ES 5000 0 86400

OSCM.pmthresholds.section.nearend.1day.SEFS 5000 0 86400

OSCM.pmthresholds.section.nearend.1day.SES 5000 0 86400
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D.2.2 ANSI Node Default Settings
Table D-11 lists the node-level default settings for the Cisco ONS 15454. Cisco provides the following 
types of settings preprovisioned for each Cisco ONS 15454 node:

• Create TL1-Like instructs the node to create only cross-connects, allowing the resulting circuits to 
be in an upgradable state.

• Insert AIS-V on SDP instructs the node to insert AIS-V in each VT whenever the carrying STS 
crosses the signal degrade path BER threshold.

Table D-10 OSC-CSM Card Default Settings (ANSI)

Default Name Default Value Minimum Maximum

OSC_CSM.pmthresholds.line.farend.15min.CV 1312 0 137700

OSC_CSM.pmthresholds.line.farend.15min.ES 87 0 900

OSC_CSM.pmthresholds.line.farend.15min.FC 10 0 72

OSC_CSM.pmthresholds.line.farend.15min.SES 1 0 900

OSC_CSM.pmthresholds.line.farend.15min.UAS 3 0 900

OSC_CSM.pmthresholds.line.farend.1day.CV 13120 0 13219200

OSC_CSM.pmthresholds.line.farend.1day.ES 864 0 86400

OSC_CSM.pmthresholds.line.farend.1day.FC 40 0 6912

OSC_CSM.pmthresholds.line.farend.1day.SES 4 0 86400

OSC_CSM.pmthresholds.line.farend.1day.UAS 10 0 86400

OSC_CSM.pmthresholds.line.nearend.15min.CV 1312 0 137700

OSC_CSM.pmthresholds.line.nearend.15min.ES 87 0 900

OSC_CSM.pmthresholds.line.nearend.15min.FC 10 0 72

OSC_CSM.pmthresholds.line.nearend.15min.SES 1 0 900

OSC_CSM.pmthresholds.line.nearend.15min.UAS 3 0 900

OSC_CSM.pmthresholds.line.nearend.1day.CV 13120 0 13219200

OSC_CSM.pmthresholds.line.nearend.1day.ES 864 0 86400

OSC_CSM.pmthresholds.line.nearend.1day.FC 40 0 6912

OSC_CSM.pmthresholds.line.nearend.1day.SES 4 0 86400

OSC_CSM.pmthresholds.line.nearend.1day.UAS 10 0 86400

OSC_CSM.pmthresholds.section.nearend.15min.CV 10000 0 138600

OSC_CSM.pmthresholds.section.nearend.15min.ES 500 0 900

OSC_CSM.pmthresholds.section.nearend.15min.SEFS 500 0 900

OSC_CSM.pmthresholds.section.nearend.15min.SES 500 0 900

OSC_CSM.pmthresholds.section.nearend.1day.CV 100000 0 13305600

OSC_CSM.pmthresholds.section.nearend.1day.ES 5000 0 86400

OSC_CSM.pmthresholds.section.nearend.1day.SEFS 5000 0 86400

OSC_CSM.pmthresholds.section.nearend.1day.SES 5000 0 86400
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• SDP BER defines the node signal degrade path bit error rate.

• Path protection settings determine whether path protection circuits have switching on PDIP enabled, 
have SD BER and SF BER monitoring enabled, are revertive, and what the reversion time is.

• Craft Access Only allows CTC connectivity to the node only through the craft access port.

• CTC IP Display Suppression prevents display of node IP addresses in CTC.

• Defaults Description lists the current defaults file on the node.

• Enable Firewall enables or disables the use of a firewall for accessing the node.

• Enable Proxy enables or disables the use of a proxy server with the node.

• IIOP Listener Port sets the IIOP listener port number.

• LCD IP Setting sets the node LCD screen to display the node IP address and use the buttons on the 
LCD panel, only display the IP address, or suppress display of the IP address.

• Login Warning Message warns users at the login screen about the possible legal or contractual 
ramifications of accessing equipment, systems, or networks without authorization. 

• NTP SNTP Server sets the IP address of the NTP SNTP server to be used with the node.

• Time Zone sets the time zone where the node is located.

• Use DST enables or disables the use of Daylight Savings Time.

• Use NTP SNTP Server enables or disables the use of the specified NTP SNTP server with the node.

• 1+1 protection settings determine whether or not 1+1 protected circuits have bidirectional 
switching, are revertive, and what the reversion time is. 

• BLSR Protection Settings determine whether BLSR-protected circuits are revertive and what the 
reversion time is at both the ring and span levels.

• Y Cable Protection Settings determine whether Y-Cable protected circuits have bidirectional 
switching, are revertive, and what the reversion time is.

• Security Policy settings determine the failed logins before lockout, idle user timeout for each user 
level, lockout duration, manual unlock user level enabled, password reuse timeout and threshold, 
and single session per user for the node security.

• BITS Timing settings determine the AIS threshold, coding, and framing for BITS1 and BITS2 
timing.

• General Timing settings determine the mode (internal or external), quality of RES, revertive, 
reversion time, and SSM message set for node timing.

Table D-11 Node Default Settings (ANSI)

Default Name Default Value Minimum Maximum

NODE.circuits.SendPDIP TRUE

NODE.circuits.State IS,AINS

NODE.circuits.upsr.ReversionTime 5

NODE.circuits.upsr.Revertive FALSE

NODE.circuits.upsr.STS_SDBER 1e-006

NODE.circuits.upsr.STS_SFBER 0.0001

NODE.circuits.upsr.SwitchOnPDIP FALSE

NODE.circuits.upsr.VT_SDBER 1e-005
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NODE.circuits.upsr.VT_SFBER 0.001

NODE.general.DefaultsDescription Factory Defaults

NODE.general.IIOPListenerPort 57790 0 65535

NODE.general.InsertAISVOnSDP FALSE

NODE.general.NtpSntpServer 0.0.0.0

NODE.general.SDPBER 1e-006

NODE.general.TimeZone (GMT-08:00) Pacific Time (US 
& Canada), Tijuana

NODE.general.UseDST TRUE

NODE.network.general.AlarmMissingBackplaneLAN FALSE

NODE.network.general.CtcIpDisplaySuppression FALSE

NODE.network.general.GatewaySettings None

NODE.network.general.LcdIpSetting Allow Configuration

NODE.powerMonitor.EHIBATVG -56.5

NODE.powerMonitor.ELWBATVG -40.5

NODE.powerMonitor.HIBATVG -54

NODE.powerMonitor.LWBATVG -44

NODE.protection.1+1.BidirectionalSwitching FALSE

NODE.protection.1+1.DetectionGuardTimer 1

NODE.protection.1+1.RecoveryGuardTimer 1

NODE.protection.1+1.ReversionTime 5

NODE.protection.1+1.Revertive FALSE

NODE.protection.1+1.VerifyGuardTimer 0.5

NODE.protection.blsr.RingReversionTime 5

NODE.protection.blsr.RingRevertive TRUE

NODE.protection.blsr.SpanReversionTime 5

NODE.protection.blsr.SpanRevertive TRUE

NODE.protection.splitter.ReversionTime 5

NODE.protection.splitter.Revertive FALSE

NODE.protection.ycable.ReversionTime 5

NODE.protection.ycable.Revertive FALSE

NODE.security.access.LANAccess Front & Backplane

NODE.security.access.RestoreTimeout 5

NODE.security.dataComm.CtcBackplaneIpDisplaySuppression FALSE

NODE.security.dataComm.DefaultTCCEthernetIP 10.10.0.1

NODE.security.dataComm.DefaultTCCEthernetIPNetmask 24

Table D-11 Node Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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NODE.security.dataComm.LcdBackplaneIpSetting Suppress Display

NODE.security.dataComm.SecureModeLocked FALSE

NODE.security.dataComm.SecureModeOn FALSE

NODE.security.idleUserTimeout.Maintenance 0.041666666667

NODE.security.idleUserTimeout.Provisioning 0.020833333333

NODE.security.idleUserTimeout.Retrieve 0

NODE.security.idleUserTimeout.Superuser 0.010416666667

NODE.security.legalDisclaimer.LoginWarningMessage <center><b>WARNING</b></c
enter>This system is restricted to 
authorized users for business 
purposes. 
Unauthorized<p>access is a 
violation of the law. This service 
may be monitored for 
administrative<p>and security 
reasons. By proceeding, you 
consent to this monitoring.

NODE.security.other.DisableInactiveUser FALSE

NODE.security.other.InactiveDuration 45 20 90

NODE.security.other.PMClearingPrivilege Provisioning

NODE.security.other.SingleSessionPerUser FALSE

NODE.security.passwordAging.EnforcePasswordAging FALSE

NODE.security.passwordAging.maintenance.AgingPeriod 45 20 90

NODE.security.passwordAging.maintenance.WarningPeriod 5 2 20

NODE.security.passwordAging.provisioning.AgingPeriod 45 20 90

NODE.security.passwordAging.provisioning.WarningPeriod 5 2 20

NODE.security.passwordAging.retrieve.AgingPeriod 45 20 90

NODE.security.passwordAging.retrieve.WarningPeriod 5 2 20

NODE.security.passwordAging.superuser.AgingPeriod 45 20 90

NODE.security.passwordAging.superuser.WarningPeriod 5 2 20

NODE.security.passwordChange.CannotChangeNewPassword FALSE

NODE.security.passwordChange.CannotChangeNewPasswordFo
rNDays

20 20 95

NODE.security.passwordChange.PreventReusingLastNPassword
s

1 1 10

NODE.security.passwordChange.RequirePasswordChangeOnFir
stLoginToNewAccount

FALSE

NODE.security.shellAccess.EnableShellPassword FALSE

NODE.security.shellAccess.SSH FALSE

Table D-11 Node Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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D.2.3 ANSI CTC Default Settings
Table D-12 lists the CTC-level default settings for the Cisco ONS 15454. Cisco provides the following 
types of settings preprovisioned for CTC.

• Create circuits with the Auto route check box selected by default.

NODE.security.shellAccess.TelnetPort 23 23 9999

NODE.security.userLockout.FailedLoginsBeforeLockout 5 0 10

NODE.security.userLockout.LockoutDuration 0.020833333333

NODE.security.userLockout.ManualUnlockBySuperuser FALSE

NODE.timing.bits-1.AISThreshold SMC

NODE.timing.bits-1.AdminSSMIn STU

NODE.timing.bits-1.Coding B8ZS

NODE.timing.bits-1.CodingOut B8ZS

NODE.timing.bits-1.FacilityType DS1

NODE.timing.bits-1.FacilityTypeOut DS1

NODE.timing.bits-1.Framing ESF

NODE.timing.bits-1.FramingOut ESF

NODE.timing.bits-1.LBO 0-133

NODE.timing.bits-1.State IS

NODE.timing.bits-1.StateOut IS

NODE.timing.bits-2.AISThreshold SMC

NODE.timing.bits-2.AdminSSMIn STU

NODE.timing.bits-2.Coding B8ZS

NODE.timing.bits-2.CodingOut B8ZS

NODE.timing.bits-2.FacilityType DS1

NODE.timing.bits-2.FacilityTypeOut DS1

NODE.timing.bits-2.Framing ESF

NODE.timing.bits-2.FramingOut ESF

NODE.timing.bits-2.LBO 0-133

NODE.timing.bits-2.State IS

NODE.timing.bits-2.StateOut IS

NODE.timing.general.Mode External

NODE.timing.general.QualityOfRES RES=DUS

NODE.timing.general.ReversionTime 5

NODE.timing.general.Revertive FALSE

NODE.timing.general.SSMMessageSet Generation 1

Table D-11 Node Default Settings (ANSI) (continued)

Default Name Default Value Minimum Maximum
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• Create TL1-like circuits—instructs the node to create only cross-connects, allowing the resulting 
circuits to be in an upgradable state.

• Choose a default network map (which country).

D.3 ETSI Platform Defaults
The following sections give the NE defaults for the 15454 ETSI platform. To see defaults for the 15454 
ANSI platform, refer to the “D.2 ANSI Platform Defaults” section on page D-2.

D.3.1 ETSI Card Default Settings
The tables in this section list the default settings for each DWDM, TXP, and MXP card. For all other 
cards, including optical, electrical, Ethernet, and fibre channel, refer to the Cisco ONS 15454 SDH 
Reference Manual.

Cisco provides settings that are pre-provisioned for the Cisco ONS 15454 cards, including:

• Soak Time (all cards) is the length of time that elapses between an AINS port receiving a valid signal 
and when it automatically changes to in-service status. 

• Port State (all cards) sets the port to one of the four available states (IS, OOS, OOS_MT, or 
OOS_AINS), depending on whether you need ports in or out of service.

• SF BER Level (TXP and MXP cards) defines the signal fail bit error rate.

• SD BER Level (TXP and MXP cards) defines the signal degrade bit error rate.

• Enable Sync Messages (MXP cards) enables synchronization status messages (S1 byte), which 
allow the node to choose the best timing source. 

• Send Do Not Use (TXP and MXP cards) sends a DUS message on the S1 byte when enabled. 

• Payload Type (TXP and MXP cards) defines the type of client signal.

• Termination Mode (TXP and MXP cards) defines the type of termination (line, section, or 
transparent).

• ALS Mode (TXP and MXP cards) sets the automatic laser shutdown feature to one of four available 
states (disabled, auto restart, manual restart, manual restart for test).

• ALS Recovery Interval (TXP and MXP cards) sets the automatic laser shutdown recovery time 
interval.

• ALS Recovery Pulse Width (TXP and MXP cards) set the automatic laser shutdown recovery pulse 
signal width.

• FEC (TXP and MXP cards) enables or disables the FEC monitoring on the optical transport network.

• G.709 OTN (TXP and MXP cards) enables or disables the G.709 monitoring on the optical transport 
network.

Table D-12 CTC Default Settings (ANSI)

Default Name Default Value

CTC.circuits.AutoRoute TRUE

CTC.circuits.CreateLikeTL1 FALSE

CTC.network.Map United States
D-43
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Appendix D      Network Element Defaults
ETSI Platform Defaults
• FEC Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
FEC performance data and detecting problems early.

• Optical Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
physical optics performance data and detecting problems early.

• OTN Thresholds (TXP and MXP cards) set the performance monitoring parameters for gathering 
OTN trunk-side performance data and detecting problems early.

• PM Threshold Settings (all cards) set the performance monitoring parameters for gathering 
performance data and detecting problems early.

Note For more information about the performance monitoring parameters, refer to the Chapter 9, “Monitor 
Performance.”

D.3.1.1 MXP_2.5G_10G Card Default Settings

Table D-13 lists the MXP_2.5G_10G card default settings.

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

MXP-2_5G-10G.config.client.AINSSoakTime 0.33333333333

MXP-2_5G-10G.config.client.AlsMode Disabled

MXP-2_5G-10G.config.client.AlsRecoveryPulseDuration 4

MXP-2_5G-10G.config.client.AlsRecoveryPulseInterval 100 60 300

MXP-2_5G-10G.config.client.ppmPortAssignment STM16_PORT

MXP-2_5G-10G.config.client.ppmSlotAssignment UNASSIGNED

MXP-2_5G-10G.config.client.SDBER 1e-007

MXP-2_5G-10G.config.client.SendDoNotUse FALSE

MXP-2_5G-10G.config.client.SFBER 0.0001

MXP-2_5G-10G.config.client.SyncMsgIn TRUE

MXP-2_5G-10G.config.client.TerminationMode Transparent

MXP-2_5G-10G.config.trunk.AINSSoakTime 0.33333333333

MXP-2_5G-10G.config.trunk.AlsMode Disabled

MXP-2_5G-10G.config.trunk.AlsRecoveryPulseDuration 4

MXP-2_5G-10G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXP-2_5G-10G.opticalthresholds.client.alarm.HighLaserBias 90

MXP-2_5G-10G.opticalthresholds.client.alarm.HighRxPower 3

MXP-2_5G-10G.opticalthresholds.client.alarm.HighTxPower 3

MXP-2_5G-10G.opticalthresholds.client.alarm.LowRxPower -21

MXP-2_5G-10G.opticalthresholds.client.alarm.LowTxPower -8

MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighLaserBias 81

MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighRxPower 2
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MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowTxPower -7

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighLaserBias 90

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighTxPower 4

MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowTxPower 2

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighLaserBias 81

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighTxPower 3.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowTxPower 2.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighLaserBias 85.5

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.7

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowTxPower 2.3

MXP-2_5G-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811200

MXP-2_5G-10G.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

MXP-2_5G-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 867227693875200

MXP-2_5G-10G.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

MXP-2_5G-10G.otn.otnLines.FEC Standard

MXP-2_5G-10G.otn.otnLines.G709OTN TRUE

MXP-2_5G-10G.otn.otnLines.SDBER 1e-007

MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.BBE 21260 0 2212200

MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.EB 21260 0 2212200

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.BBE 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.EB 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.BBE 21260 0 2212200

MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.EB 21260 0 2212200

MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.BBE 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.EB 212600 0 212371200

MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.BBE 10000 0 2212200

MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.EB 10000 0 2151900

MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.ES 500 0 900

MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.SES 500 0 900

MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.UAS 500 0 900

MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.BBE 100000 0 212371200

MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.EB 100000 0 206582400

MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.SES 5000 0 86400

MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.UAS 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.EB 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.EB 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.ES 864 0 86400

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.2 MXP_2.5G_10E Card Default Settings

Table D-14 lists the MXP_2.5G_10E card default settings.

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.BBE 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.EB 85040 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.ES 87 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.SES 1 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.UAS 3 0 900

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.BBE 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.EB 850400 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.ES 864 0 86400

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.SES 4 0 86400

MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.UAS 10 0 86400

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.BBE 10000 0 8850600

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.EB 10000 0 7967700

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.ES 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.SES 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.UAS 500 0 900

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.BBE 100000 0 849657600

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.EB 100000 0 764899200

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.ES 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.SES 5000 0 86400

MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.UAS 5000 0 86400

Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

MXP-2_5G-10E.config.client.AINSSoakTime 0.33333333333

MXP-2_5G-10E.config.client.AisSquelchMode Squelch

MXP-2_5G-10E.config.client.AlsMode Disabled

MXP-2_5G-10E.config.client.AlsRecoveryPulseDuration 2

MXP-2_5G-10E.config.client.AlsRecoveryPulseInterval 100 100 2000

MXP-2_5G-10E.config.client.ppmPortAssignment STM16_PORT

MXP-2_5G-10E.config.client.ppmSlotAssignment UNASSIGNED

MXP-2_5G-10E.config.client.SDBER 1e-007
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MXP-2_5G-10E.config.client.SendDoNotUse FALSE

MXP-2_5G-10E.config.client.SFBER 0.0001

MXP-2_5G-10E.config.client.SyncMsgIn TRUE

MXP-2_5G-10E.config.client.TerminationMode Transparent

MXP-2_5G-10E.config.trunk.AINSSoakTime 0.33333333333

MXP-2_5G-10E.config.trunk.AlsMode Disabled

MXP-2_5G-10E.config.trunk.AlsRecoveryPulseDuration 100

MXP-2_5G-10E.config.trunk.AlsRecoveryPulseInterval 300 200 2000

MXP-2_5G-10E.opticalthresholds.client.alarm.HighLaserBias 90

MXP-2_5G-10E.opticalthresholds.client.alarm.HighRxPower 3

MXP-2_5G-10E.opticalthresholds.client.alarm.HighTxPower 3

MXP-2_5G-10E.opticalthresholds.client.alarm.LowRxPower -21

MXP-2_5G-10E.opticalthresholds.client.alarm.LowTxPower -8

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighLaserBias 81

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighRxPower 2

MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowTxPower -7

MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighLaserBias 98

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighTxPower 8

MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowTxPower 1

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighLaserBias 95

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighTxPower 7

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowTxPower 2

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighLaserBias 96

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighTxPower 7

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowTxPower 2

MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected 903330 0 90336218112
00

MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords 5 0 4724697600

MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected 86719680 0 86722769387
5200

MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords 480 0 45357096960
0

MXP-2_5G-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 90336218112
00

MXP-2_5G-10E.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

MXP-2_5G-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 86722769387
5200

MXP-2_5G-10E.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 45357096960
0

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.ES 87 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.SES 1 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.ES 500 0 900

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.SES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

MXP-2_5G-10E.otn.otnLines.AsynchSynchMapping ODU Multiplex

MXP-2_5G-10E.otn.otnLines.FEC Standard

MXP-2_5G-10E.otn.otnLines.G709OTN TRUE

MXP-2_5G-10E.otn.otnLines.SDBER 1e-007

MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.BBE 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.EB 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.ES 87 0 900

MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.SES 1 0 900

MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.UAS 3 0 900

MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.BBE 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.EB 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.ES 864 0 86400

MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.SES 4 0 86400

MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.UAS 10 0 86400

MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.BBE 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.EB 21260 0 2212200

MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.ES 87 0 900

MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.SES 1 0 900

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.3 MXP_MR_2.5G Card Default Settings

Table D-15 lists the MXP_MR_2.5G card default settings.

MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.UAS 3 0 900

MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.BBE 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.EB 212600 0 212371200

MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.ES 864 0 86400

MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.SES 4 0 86400

MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.UAS 10 0 86400

MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.BBE 10000 0 2212200

MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.EB 10000 0 2151900

MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.ES 500 0 900

MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.SES 500 0 900

MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.UAS 500 0 900

MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.BBE 100000 0 212371200

MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.EB 100000 0 206582400

MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.ES 5000 0 86400

MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.SES 5000 0 86400

MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.UAS 5000 0 86400

Table D-14 MXP_2.5G_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-15 MXP_MR_2.5G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

MXP-MR-2_5G.config.client.AlsMode Disabled

MXP-MR-2_5G.config.client.AlsRecoveryPulseDuration 4

MXP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

MXP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

MXP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

MXP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThr
eshold

TRUE

MXP-MR-2_5G.config.fc.distanceExtension.AutoDetect TRUE

MXP-MR-2_5G.config.fc.distanceExtension.Enabled TRUE

MXP-MR-2_5G.config.fc.distanceExtension.NumCredits 32 2 256

MXP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers 16

MXP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize 2148

MXP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

MXP-MR-2_5G.config.trunk.AlsMode Disabled
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MXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 4

MXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXP-MR-2_5G.config.trunk.SDBER 1e-007

MXP-MR-2_5G.config.trunk.SendDoNotUse FALSE

MXP-MR-2_5G.config.trunk.SFBER 0.0001

MXP-MR-2_5G.config.trunk.SyncMsgIn TRUE

MXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

MXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

MXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

MXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

MXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -8

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBia
s

81

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower -40

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower -40

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower 30

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

Table D-15 MXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.4 MXPP_MR_2.5G Card Default Settings

Table D-16 lists the MXPP_MR_2.5G card default settings.

MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower -40

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.BBE 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.EB 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.ES 87 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.SES 1 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.UAS 3 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.BBE 212600 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.EB 212600 0 212371200

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.ES 864 0 86400

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.SES 4 0 86400

MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.UAS 10 0 86400

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.BBE 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.EB 21260 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.ES 87 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.SES 1 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.UAS 3 0 900

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.BBE 212600 0 2212200

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.EB 212600 0 212371200

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.ES 864 0 86400

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.SES 4 0 86400

MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.UAS 10 0 86400

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.BBE 10000 0 2151900

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.EB 10000 0 2151900

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.ES 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.SES 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.UAS 500 0 900

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.BBE 100000 0 206582400

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.EB 100000 0 206582400

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.ES 5000 0 86400

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.SES 5000 0 86400

MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.UAS 5000 0 86400

Table D-15 MXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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Table D-16 MXPP_MR_2.5G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

MXPP-MR-2_5G.config.client.AlsMode Disabled

MXPP-MR-2_5G.config.client.AlsRecoveryPulseDuration 4

MXPP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

MXPP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

MXPP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

MXPP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPB
ufferThreshold

TRUE

MXPP-MR-2_5G.config.fc.distanceExtension.AutoDetect TRUE

MXPP-MR-2_5G.config.fc.distanceExtension.Enabled TRUE

MXPP-MR-2_5G.config.fc.distanceExtension.NumCredits 32 2 256

MXPP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers 16

MXPP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFr
ameSize

2148

MXPP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

MXPP-MR-2_5G.config.trunk.AlsMode Disabled

MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 4

MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

MXPP-MR-2_5G.config.trunk.SDBER 1e-007

MXPP-MR-2_5G.config.trunk.SFBER 0.0001

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

MXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

MXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

MXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -8

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighL
aserBias

81

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighR
xPower

2

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighT
xPower

2

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowR
xPower

-20

MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowT
xPower

-7

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLa
serBias

85.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRx
Power

2.5
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MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTx
Power

2.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRx
Power

-20.5

MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTx
Power

-7.5

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower 30

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower -40

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighL
aserBias

95

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighR
xPower

-7.5

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighT
xPower

30

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowR
xPower

-24.5

MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowT
xPower

-40

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLas
erBias

96

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRx
Power

-7.3

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTx
Power

30

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxP
ower

-24.7

MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxP
ower

-40

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.BBE 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.EB 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.ES 87 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.SES 1 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.UAS 3 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.BBE 212600 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.EB 212600 0 212371200

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.ES 864 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.SES 4 0 86400

Table D-16 MXPP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.5 TXP_MR_10E Card Default Settings

Table D-17 lists the TXP_MR_10E card default settings.

MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.UAS 10 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.BBE 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.EB 21260 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.ES 87 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.SES 1 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.UAS 3 0 900

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.BBE 212600 0 2212200

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.EB 212600 0 212371200

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.ES 864 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.SES 4 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.UAS 10 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.BBE 10000 0 2151900

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.EB 10000 0 2151900

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.ES 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.SES 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.UAS 500 0 900

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.BBE 100000 0 206582400

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.EB 100000 0 206582400

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.ES 5000 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.SES 5000 0 86400

MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.UAS 5000 0 86400

Table D-16 MXPP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-17 TXP_MR_10E Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

TXP-MR-10E.config.client.AINSSoakTime 0.333333333
33

TXP-MR-10E.config.client.AisSquelchMode Squelch

TXP-MR-10E.config.client.AlsMode Disabled

TXP-MR-10E.config.client.AlsRecoveryPulseDuration 2

TXP-MR-10E.config.client.AlsRecoveryPulseInterval 100 100 2000

TXP-MR-10E.config.client.ppmPortAssignment UNASSIGN
ED

TXP-MR-10E.config.client.ppmSlotAssignment UNASSIGN
ED
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TXP-MR-10E.config.client.SDBER 1e-007

TXP-MR-10E.config.client.SendDoNotUse FALSE

TXP-MR-10E.config.client.SFBER 0.0001

TXP-MR-10E.config.client.SyncMsgIn TRUE

TXP-MR-10E.config.client.TerminationMode Transparent

TXP-MR-10E.config.trunk.AINSSoakTime 0.333333333
33

TXP-MR-10E.config.trunk.AlsMode Disabled

TXP-MR-10E.config.trunk.AlsRecoveryPulseDuration 100

TXP-MR-10E.config.trunk.AlsRecoveryPulseInterval 300 200 2000

TXP-MR-10E.config.trunk.SDBER 1e-007

TXP-MR-10E.config.trunk.SFBER 0.0001

TXP-MR-10E.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-10E.opticalthresholds.client.alarm.HighRxPower 2

TXP-MR-10E.opticalthresholds.client.alarm.HighTxPower 2

TXP-MR-10E.opticalthresholds.client.alarm.LowRxPower -17

TXP-MR-10E.opticalthresholds.client.alarm.LowTxPower -9

TXP-MR-10E.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-10E.opticalthresholds.client.warning.15min.HighRxPower 1

TXP-MR-10E.opticalthresholds.client.warning.15min.HighTxPower 1

TXP-MR-10E.opticalthresholds.client.warning.15min.LowRxPower -16

TXP-MR-10E.opticalthresholds.client.warning.15min.LowTxPower -8

TXP-MR-10E.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-10E.opticalthresholds.client.warning.1day.HighRxPower 1.5

TXP-MR-10E.opticalthresholds.client.warning.1day.HighTxPower 1.5

TXP-MR-10E.opticalthresholds.client.warning.1day.LowRxPower -16.5

TXP-MR-10E.opticalthresholds.client.warning.1day.LowTxPower -8.5

TXP-MR-10E.opticalthresholds.trunk.alarm.HighLaserBias 98

TXP-MR-10E.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-10E.opticalthresholds.trunk.alarm.HighTxPower 8

TXP-MR-10E.opticalthresholds.trunk.alarm.LowRxPower -25

TXP-MR-10E.opticalthresholds.trunk.alarm.LowTxPower 1

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighTxPower 7

TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowTxPower 2

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighTxPower 7

TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowTxPower 2

TXP-MR-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected 903330 0 903362181120
0

TXP-MR-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords 5 0 4724697600

TXP-MR-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected 86719680 0 867227693875
200

TXP-MR-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords 480 0 453570969600

TXP-MR-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 903362181120
0

TXP-MR-10E.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

TXP-MR-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 867227693875
200

TXP-MR-10E.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 453570969600

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-10E.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-10E.otn.otnLines.AsynchSynchMapping Synch 
Mapping

TXP-MR-10E.otn.otnLines.FEC Standard

TXP-MR-10E.otn.otnLines.G709OTN TRUE

TXP-MR-10E.otn.otnLines.SDBER 1e-007

TXP-MR-10E.pmthresholds.client.ms.farend.15min.BBE 85040 0 8850600

TXP-MR-10E.pmthresholds.client.ms.farend.15min.EB 85040 0 8850600

TXP-MR-10E.pmthresholds.client.ms.farend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.client.ms.farend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.client.ms.farend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.client.ms.farend.1day.BBE 850400 0 849657600

TXP-MR-10E.pmthresholds.client.ms.farend.1day.EB 850400 0 849657600

TXP-MR-10E.pmthresholds.client.ms.farend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.client.ms.farend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.client.ms.farend.1day.UAS 10 0 86400

Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10E.pmthresholds.client.ms.nearend.15min.BBE 85040 0 8850600

TXP-MR-10E.pmthresholds.client.ms.nearend.15min.EB 85040 0 8850600

TXP-MR-10E.pmthresholds.client.ms.nearend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.client.ms.nearend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.client.ms.nearend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.client.ms.nearend.1day.BBE 850400 0 849657600

TXP-MR-10E.pmthresholds.client.ms.nearend.1day.EB 850400 0 849657600

TXP-MR-10E.pmthresholds.client.ms.nearend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.client.ms.nearend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.client.ms.nearend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.client.rs.nearend.15min.BBE 10000 0 8850600

TXP-MR-10E.pmthresholds.client.rs.nearend.15min.EB 10000 0 7967700

TXP-MR-10E.pmthresholds.client.rs.nearend.15min.ES 500 0 900

TXP-MR-10E.pmthresholds.client.rs.nearend.15min.SES 500 0 900

TXP-MR-10E.pmthresholds.client.rs.nearend.15min.UAS 500 0 900

TXP-MR-10E.pmthresholds.client.rs.nearend.1day.BBE 100000 0 849657600

TXP-MR-10E.pmthresholds.client.rs.nearend.1day.EB 100000 0 764899200

TXP-MR-10E.pmthresholds.client.rs.nearend.1day.ES 5000 0 86400

TXP-MR-10E.pmthresholds.client.rs.nearend.1day.SES 5000 0 86400

TXP-MR-10E.pmthresholds.client.rs.nearend.1day.UAS 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.BBE 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.EB 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.BBE 850400 0 849657600

TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.EB 850400 0 849657600

TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.BBE 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.EB 85040 0 8850600

TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.ES 87 0 900

TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.SES 1 0 900

TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.UAS 3 0 900

TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.BBE 850400 0 849657600

Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.6 TXP_MR_10G Card Default Settings

Table D-18 lists the TXP_MR_10G card default settings.

TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.EB 850400 0 849657600

TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.ES 864 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.SES 4 0 86400

TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.UAS 10 0 86400

TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.BBE 10000 0 8850600

TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.EB 10000 0 7967700

TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.ES 500 0 900

TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.SES 500 0 900

TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.UAS 500 0 900

TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.BBE 100000 0 849657600

TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.EB 100000 0 764899200

TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.ES 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.SES 5000 0 86400

TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.UAS 5000 0 86400

Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-18 TXP_MR_10G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

TXP-MR-10G.config.client.AINSSoakTime 0.33333333333

TXP-MR-10G.config.client.AlsMode Disabled

TXP-MR-10G.config.client.AlsRecoveryPulseDuration 4

TXP-MR-10G.config.client.AlsRecoveryPulseInterval 100 100 300

TXP-MR-10G.config.client.mrPortAssignment UNASSIGNED

TXP-MR-10G.config.client.SDBER 1e-007

TXP-MR-10G.config.client.SFBER 0.0001

TXP-MR-10G.config.client.TerminationMode Transparent

TXP-MR-10G.config.trunk.AINSSoakTime 0.33333333333

TXP-MR-10G.config.trunk.AlsMode Disabled

TXP-MR-10G.config.trunk.AlsRecoveryPulseDuration 4

TXP-MR-10G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXP-MR-10G.config.trunk.SDBER 1e-007

TXP-MR-10G.config.trunk.SFBER 0.0001

TXP-MR-10G.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-10G.opticalthresholds.client.alarm.HighRxPower 2
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TXP-MR-10G.opticalthresholds.client.alarm.HighTxPower 2

TXP-MR-10G.opticalthresholds.client.alarm.LowRxPower -17

TXP-MR-10G.opticalthresholds.client.alarm.LowTxPower -9

TXP-MR-10G.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-10G.opticalthresholds.client.warning.15min.HighRxPower 1

TXP-MR-10G.opticalthresholds.client.warning.15min.HighTxPower 1

TXP-MR-10G.opticalthresholds.client.warning.15min.LowRxPower -16

TXP-MR-10G.opticalthresholds.client.warning.15min.LowTxPower -8

TXP-MR-10G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-10G.opticalthresholds.client.warning.1day.HighRxPower 1.5

TXP-MR-10G.opticalthresholds.client.warning.1day.HighTxPower 1.5

TXP-MR-10G.opticalthresholds.client.warning.1day.LowRxPower -16.5

TXP-MR-10G.opticalthresholds.client.warning.1day.LowTxPower -8.5

TXP-MR-10G.opticalthresholds.trunk.alarm.HighLaserBias 90

TXP-MR-10G.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-10G.opticalthresholds.trunk.alarm.HighTxPower 4

TXP-MR-10G.opticalthresholds.trunk.alarm.LowRxPower -25

TXP-MR-10G.opticalthresholds.trunk.alarm.LowTxPower 2

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighLaserBias 81

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighTxPower 3.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowTxPower 2.5

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighLaserBias 85.5

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.7

TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowTxPower 2.3

TXP-MR-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected 903330 0 9033621811
200

TXP-MR-10G.otn.fecthresholds.standard.15min.UncorrectableWords 5 0 4724697600

TXP-MR-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected 86719680 0 8672276938
75200

TXP-MR-10G.otn.fecthresholds.standard.1day.UncorrectableWords 480 0 4535709696
00

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.BBE 85040 0 8850600

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-10G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.BBE 850400 0 849657600

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-10G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.BBE 85040 0 8850600

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.BBE 850400 0 849657600

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-10G.otn.otnLines.FEC Enable

TXP-MR-10G.otn.otnLines.G709OTN TRUE

TXP-MR-10G.otn.otnLines.SDBER 1e-007

TXP-MR-10G.pmthresholds.client.ms.farend.15min.BBE 85040 0 8850600

TXP-MR-10G.pmthresholds.client.ms.farend.15min.EB 85040 0 8850600

TXP-MR-10G.pmthresholds.client.ms.farend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.client.ms.farend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.client.ms.farend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.client.ms.farend.1day.BBE 850400 0 849657600

TXP-MR-10G.pmthresholds.client.ms.farend.1day.EB 850400 0 849657600

TXP-MR-10G.pmthresholds.client.ms.farend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.client.ms.farend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.client.ms.farend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.client.ms.nearend.15min.BBE 85040 0 8850600

TXP-MR-10G.pmthresholds.client.ms.nearend.15min.EB 85040 0 8850600

TXP-MR-10G.pmthresholds.client.ms.nearend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.client.ms.nearend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.client.ms.nearend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.client.ms.nearend.1day.BBE 850400 0 849657600

TXP-MR-10G.pmthresholds.client.ms.nearend.1day.EB 850400 0 849657600

TXP-MR-10G.pmthresholds.client.ms.nearend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.client.ms.nearend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.client.ms.nearend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.client.rs.nearend.15min.BBE 10000 0 8850600

TXP-MR-10G.pmthresholds.client.rs.nearend.15min.EB 10000 0 7967700

TXP-MR-10G.pmthresholds.client.rs.nearend.15min.ES 500 0 900

TXP-MR-10G.pmthresholds.client.rs.nearend.15min.SES 500 0 900

TXP-MR-10G.pmthresholds.client.rs.nearend.15min.UAS 500 0 900

TXP-MR-10G.pmthresholds.client.rs.nearend.1day.BBE 100000 0 849657600

TXP-MR-10G.pmthresholds.client.rs.nearend.1day.EB 100000 0 764899200

TXP-MR-10G.pmthresholds.client.rs.nearend.1day.ES 5000 0 86400

TXP-MR-10G.pmthresholds.client.rs.nearend.1day.SES 5000 0 86400

TXP-MR-10G.pmthresholds.client.rs.nearend.1day.UAS 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.BBE 85040 0 8850600

Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.EB 85040 0 8850600

TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.BBE 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.EB 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.BBE 85040 0 8850600

TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.EB 85040 0 8850600

TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.ES 87 0 900

TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.SES 1 0 900

TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.UAS 3 0 900

TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.BBE 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.EB 850400 0 849657600

TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.ES 864 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.SES 4 0 86400

TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.UAS 10 0 86400

TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.BBE 10000 0 8850600

TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.EB 10000 0 7967700

TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.ES 500 0 900

TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.SES 500 0 900

TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.UAS 500 0 900

TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.BBE 100000 0 849657600

TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.EB 100000 0 764899200

TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.ES 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.SES 5000 0 86400

TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.UAS 5000 0 86400

Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)
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D.3.1.7 TXP_MR_2.5G Card Default Settings

Table D-19 lists the TXP_MR_2.5G card default settings.

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

TXP-MR-2_5G.config.client.AINSSoakTime 0.33333333333

TXP-MR-2_5G.config.client.AlsMode Disabled

TXP-MR-2_5G.config.client.AlsRecoveryPulseDuration 40

TXP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

TXP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNED

TXP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNED

TXP-MR-2_5G.config.client.SDBER 1e-007

TXP-MR-2_5G.config.client.SFBER 0.0001

TXP-MR-2_5G.config.client.TerminationMode Transparent

TXP-MR-2_5G.config.trunk.AINSSoakTime 0.33333333333

TXP-MR-2_5G.config.trunk.AlsMode Disabled

TXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 40

TXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXP-MR-2_5G.config.trunk.SDBER 1e-007

TXP-MR-2_5G.config.trunk.SFBER 0.0001

TXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

TXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

TXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

TXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

TXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -15

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias 81

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

TXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25
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TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrecte
d

112500 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWor
ds

1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected 10800000 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorr
ected

90000 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.Uncorrectable
Words

1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrec
ted

8640000 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.Uncorrectable
Words

96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected 90000 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected 8640000 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorr
ected

180900 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.Uncorrectable
Words

1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrec
ted

17366400 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.Uncorrectable
Words

96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected 180900 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected 17366400 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.stm1.15min.BitErrorsCorrected 15012 0 9033621811200

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.otn.fecthresholds.stm1.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.stm1.1day.BitErrorsCorrected 1441152 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.stm1.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.stm16.15min.BitErrorsCorrected 225837 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.stm16.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.stm16.1day.BitErrorsCorrected 21680352 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.stm16.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.fecthresholds.stm4.15min.BitErrorsCorrected 56457 0 9033621811200

TXP-MR-2_5G.otn.fecthresholds.stm4.15min.UncorrectableWords 1 0 4724697600

TXP-MR-2_5G.otn.fecthresholds.stm4.1day.BitErrorsCorrected 5419872 0 86722769387520
0

TXP-MR-2_5G.otn.fecthresholds.stm4.1day.UncorrectableWords 96 0 453570969600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE 21260 0 8850600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE 212600 0 849657600

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE 21260 0 8850600

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE 212600 0 849657600

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)
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TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXP-MR-2_5G.otn.otnLines.FEC Enable

TXP-MR-2_5G.otn.otnLines.G709OTN TRUE

TXP-MR-2_5G.otn.otnLines.SDBER 1e-007

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.BBE 1312 0 137700

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.EB 1312 0 137700

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.BBE 13120 0 13219200

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.EB 13120 0 13219200

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.BBE 1312 0 137700

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.EB 1312 0 137700

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.BBE 13120 0 13219200

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.EB 13120 0 13219200

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.BBE 10000 0 138600

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.EB 10000 0 138600

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.SES 500 0 900

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.UAS 500 0 900

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.BBE 10000 0 13305600

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.EB 100000 0 13305600

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.UAS 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.BBE 21260 0 2212200

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.EB 21260 0 2212200

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.BBE 212600 0 212371200

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.EB 212600 0 212371200

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.ES 864 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.BBE 21260 0 2212200

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.EB 21260 0 2212200

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.BBE 212600 0 212371200

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.EB 212600 0 212371200

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.BBE 10000 0 2151900

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.EB 10000 0 2151900

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.SES 500 0 900

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.UAS 500 0 900

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.BBE 10000 0 206582400

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.EB 100000 0 206582400

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.ES 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.UAS 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.BBE 5315 0 552600

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.EB 5315 0 552600

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.BBE 53150 0 53049600

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.EB 53150 0 53049600

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.BBE 5315 0 552600

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.EB 5315 0 552600

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.ES 87 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.SES 1 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.UAS 3 0 900

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.BBE 53150 0 53049600

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.EB 53150 0 53049600

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.ES 864 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.SES 4 0 86400

TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.UAS 10 0 86400

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.BBE 10000 0 553500

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.EB 10000 0 553500

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.ES 500 0 900

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.SES 500 0 900

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.UAS 500 0 900

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.BBE 10000 0 53136000

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.EB 100000 0 53136000

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.ES 5000 0 86400

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.8 TXPP_MR_10G Card Default Settings

Table D-20 lists the TXPP_MR_10G card default settings.

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.SES 5000 0 86400

TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.UAS 5000 0 86400

Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-20 TXPP_MR_10G Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

TXPP-MR-2_5G.config.client.AINSSoakTime 0.3333333333
3

TXPP-MR-2_5G.config.client.AlsMode Disabled

TXPP-MR-2_5G.config.client.AlsRecoveryPulseDuration 40

TXPP-MR-2_5G.config.client.AlsRecoveryPulseInterval 100 60 300

TXPP-MR-2_5G.config.client.ppmPortAssignment UNASSIGNE
D

TXPP-MR-2_5G.config.client.ppmSlotAssignment UNASSIGNE
D

TXPP-MR-2_5G.config.client.SDBER 1e-007

TXPP-MR-2_5G.config.client.SFBER 0.0001

TXPP-MR-2_5G.config.client.TerminationMode Transparent

TXPP-MR-2_5G.config.trunk.AINSSoakTime 0.3333333333
3

TXPP-MR-2_5G.config.trunk.AlsMode Disabled

TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration 40

TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval 100 60 300

TXPP-MR-2_5G.config.trunk.SDBER 1e-007

TXPP-MR-2_5G.config.trunk.SFBER 0.0001

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias 90

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower 3

TXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower 3

TXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower -21

TXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower -15

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias 81

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower 2

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower 2

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower -20

TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower -7
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TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias 85.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower 2.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower 2.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower -20.5

TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower -7.5

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias 98

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower -7

TXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower -25

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias 95

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower -7.5

TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower -24.5

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias 96

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower -7.3

TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower -24.7

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrected 112500 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected 10800000 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorrected 90000 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrected 8640000 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected 90000 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected 8640000 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorrected 180900 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.UncorrectableWords 1 0 4724697600

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrected 17366400 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected 180900 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected 17366400 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.stm1.15min.BitErrorsCorrected 15012 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.stm1.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.stm1.1day.BitErrorsCorrected 1441152 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.stm1.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.stm16.15min.BitErrorsCorrected 225837 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.stm16.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.stm16.1day.BitErrorsCorrected 21680352 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.stm16.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.fecthresholds.stm4.15min.BitErrorsCorrected 56457 0 9033621811
200

TXPP-MR-2_5G.otn.fecthresholds.stm4.15min.UncorrectableWords 1 0 4724697600

TXPP-MR-2_5G.otn.fecthresholds.stm4.1day.BitErrorsCorrected 5419872 0 8672276938
75200

TXPP-MR-2_5G.otn.fecthresholds.stm4.1day.UncorrectableWords 96 0 4535709696
00

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE 21260 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES 87 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES 1 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE 212600 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC 40 0 6912

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE 21260 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE 212600 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE 10000 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE 100000 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE 10000 0 8850600

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC 10 0 72

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS 500 0 900

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE 100000 0 849657600

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC 40 0 6912

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.otn.otnLines.FEC Enable

TXPP-MR-2_5G.otn.otnLines.G709OTN TRUE

TXPP-MR-2_5G.otn.otnLines.SDBER 1e-007

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.BBE 1312 0 137700

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.EB 1312 0 137700

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.BBE 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.EB 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.BBE 1312 0 137700

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.EB 1312 0 137700

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.BBE 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.EB 13120 0 13219200

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.BBE 10000 0 138600

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.EB 10000 0 138600

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.UAS 500 0 900

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.BBE 10000 0 13305600

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.EB 100000 0 13305600

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.BBE 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.EB 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.BBE 212600 0 212371200

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.EB 212600 0 212371200

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.ES 864 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.BBE 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.EB 21260 0 2212200

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.BBE 212600 0 212371200

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.EB 212600 0 212371200

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.BBE 10000 0 2151900

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.EB 10000 0 2151900

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.UAS 500 0 900

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.BBE 10000 0 206582400

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.EB 100000 0 206582400

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.UAS 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.BBE 5315 0 552600

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.EB 5315 0 552600

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.ES 87 0 900

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.BBE 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.EB 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.farend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.BBE 5315 0 552600

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.EB 5315 0 552600

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.ES 87 0 900

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.1.9 OSCM Card Default Settings

Table D-21 lists the OSCM card default settings.

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.SES 1 0 900

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.UAS 3 0 900

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.BBE 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.EB 53150 0 53049600

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.ES 864 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.SES 4 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.UAS 10 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.BBE 10000 0 553500

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.EB 10000 0 553500

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.ES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.SES 500 0 900

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.UAS 500 0 900

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.BBE 10000 0 53136000

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.EB 100000 0 53136000

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.ES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.SES 5000 0 86400

TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.UAS 5000 0 86400

Table D-20 TXPP_MR_10G Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-21 OSCM Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

OSCM.pmthresholds.ms.farend.15min.BBE 1312 0 137700

OSCM.pmthresholds.ms.farend.15min.EB 1312 0 137700

OSCM.pmthresholds.ms.farend.15min.ES 87 0 900

OSCM.pmthresholds.ms.farend.15min.SES 1 0 900

OSCM.pmthresholds.ms.farend.15min.UAS 3 0 900

OSCM.pmthresholds.ms.farend.1day.BBE 13120 0 13219200

OSCM.pmthresholds.ms.farend.1day.EB 13120 0 13219200

OSCM.pmthresholds.ms.farend.1day.ES 864 0 86400

OSCM.pmthresholds.ms.farend.1day.SES 4 0 86400

OSCM.pmthresholds.ms.farend.1day.UAS 10 0 86400

OSCM.pmthresholds.ms.nearend.15min.BBE 1312 0 137700

OSCM.pmthresholds.ms.nearend.15min.EB 1312 0 137700

OSCM.pmthresholds.ms.nearend.15min.ES 87 0 900
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D.3.1.10 OSC-CSM Card Default Settings

Table D-22 lists the OSC-CSM card default settings.

OSCM.pmthresholds.ms.nearend.15min.SES 1 0 900

OSCM.pmthresholds.ms.nearend.15min.UAS 3 0 900

OSCM.pmthresholds.ms.nearend.1day.BBE 13120 0 13219200

OSCM.pmthresholds.ms.nearend.1day.EB 13120 0 13219200

OSCM.pmthresholds.ms.nearend.1day.ES 864 0 86400

OSCM.pmthresholds.ms.nearend.1day.SES 4 0 86400

OSCM.pmthresholds.ms.nearend.1day.UAS 10 0 86400

OSCM.pmthresholds.rs.nearend.15min.BBE 10000 0 138600

OSCM.pmthresholds.rs.nearend.15min.EB 10000 0 138600

OSCM.pmthresholds.rs.nearend.15min.ES 500 0 900

OSCM.pmthresholds.rs.nearend.15min.SES 500 0 900

OSCM.pmthresholds.rs.nearend.1day.BBE 100000 0 13305600

OSCM.pmthresholds.rs.nearend.1day.EB 100000 0 13305600

OSCM.pmthresholds.rs.nearend.1day.ES 5000 0 86400

OSCM.pmthresholds.rs.nearend.1day.SES 5000 0 86400

Table D-21 OSCM Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum

Table D-22 OSC-CSM Card Default Settings (ETSI)

Default Name Default Value Minimum Maximum

OSC_CSM.pmthresholds.ms.farend.15min.BBE 1312 0 137700

OSC_CSM.pmthresholds.ms.farend.15min.EB 1312 0 137700

OSC_CSM.pmthresholds.ms.farend.15min.ES 87 0 900

OSC_CSM.pmthresholds.ms.farend.15min.SES 1 0 900

OSC_CSM.pmthresholds.ms.farend.15min.UAS 3 0 900

OSC_CSM.pmthresholds.ms.farend.1day.BBE 13120 0 13219200

OSC_CSM.pmthresholds.ms.farend.1day.EB 13120 0 13219200

OSC_CSM.pmthresholds.ms.farend.1day.ES 864 0 86400

OSC_CSM.pmthresholds.ms.farend.1day.SES 4 0 86400

OSC_CSM.pmthresholds.ms.farend.1day.UAS 10 0 86400

OSC_CSM.pmthresholds.ms.nearend.15min.BBE 1312 0 137700

OSC_CSM.pmthresholds.ms.nearend.15min.EB 1312 0 137700

OSC_CSM.pmthresholds.ms.nearend.15min.ES 87 0 900

OSC_CSM.pmthresholds.ms.nearend.15min.SES 1 0 900

OSC_CSM.pmthresholds.ms.nearend.15min.UAS 3 0 900
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D.3.2 ETSI Node Default Settings
Table D-23 lists the Cisco ONS 15454 node-level default settings for the Cisco ONS 15454. Cisco 
provides the following types of settings pre provisioned for each Cisco ONS 15454 node:

• SNCP settings determine whether SNCP circuits have SD BER and SF BER monitoring enabled, are 
revertive, and what the reversion time is.

• Craft Access Only allows CTC connectivity to the node only through the craft access port.

• CTC IP Display Suppression prevents display of node IP addresses in CTC.

• Defaults Description lists the current defaults file on the node.

• Enable Firewall enables or disables the use of a firewall for accessing the node.

• Enable Proxy enables or disables the use of a proxy server with the node.

• IIOP Listener Port sets the IIOP listener port number.

• LCD IP Setting sets the node LCD screen to display the node IP address and use the buttons on the 
LCD panel, only display the IP address, or suppress display of the IP address.

• Login Warning Message warns users at the login screen about the possible legal or contractual 
ramifications of accessing equipment, systems, or networks without authorization. 

• NTP SNTP Server sets the IP address of the NTP SNTP server to be used with the node.

• Time Zone sets the time zone where the node is located.

• Use DST enables or disables the use of Daylight Savings Time.

• Use NTP SNTP Server enables or disables the use of the specified NTP SNTP server with the node.

• LMSP protection settings determine whether or not LMSP-protected circuits have bidirectional 
switching, are revertive, and what the reversion time is. 

• MS-SPRing Protection Settings determine whether MS-SPRing-protected circuits are revertive and 
what the reversion time is at both the ring and span levels.

OSC_CSM.pmthresholds.ms.nearend.1day.BBE 13120 0 13219200

OSC_CSM.pmthresholds.ms.nearend.1day.EB 13120 0 13219200

OSC_CSM.pmthresholds.ms.nearend.1day.ES 864 0 86400

OSC_CSM.pmthresholds.ms.nearend.1day.SES 4 0 86400

OSC_CSM.pmthresholds.ms.nearend.1day.UAS 10 0 86400

OSC_CSM.pmthresholds.rs.nearend.15min.BBE 10000 0 138600

OSC_CSM.pmthresholds.rs.nearend.15min.EB 10000 0 138600

OSC_CSM.pmthresholds.rs.nearend.15min.ES 500 0 900

OSC_CSM.pmthresholds.rs.nearend.15min.SES 500 0 900

OSC_CSM.pmthresholds.rs.nearend.1day.BBE 100000 0 13305600

OSC_CSM.pmthresholds.rs.nearend.1day.EB 100000 0 13305600

OSC_CSM.pmthresholds.rs.nearend.1day.ES 5000 0 86400

OSC_CSM.pmthresholds.rs.nearend.1day.SES 5000 0 86400

Table D-22 OSC-CSM Card Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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• Y Cable Protection Settings determine whether Y-Cable protected circuits have bidirectional 
switching, are revertive, and what the reversion time is.

• Security Policy settings determine the failed logins before lockout, idle user timeout for each user 
level, lockout duration, manual unlock user level enabled, password reuse timeout and threshold, 
and single session per user for the node security.

• BITS Timing settings determine the AIS threshold, coding, and framing for BITS1 and BITS2 
timing.

• General Timing settings determine the mode (internal or external), quality of RES, revertive, 
reversion time, and SSM message set for node timing.

Table D-23 Node Default Settings (ETSI)

Default Name Default Value Minimum Maximum

NODE.circuits.sncp.HO_SDBER 1e-006

NODE.circuits.sncp.HO_SFBER 0.0001

NODE.circuits.sncp.LO_SDBER 1e-005

NODE.circuits.sncp.LO_SFBER 0.001

NODE.circuits.sncp.ReversionTime 5

NODE.circuits.sncp.Revertive FALSE

NODE.circuits.State unlocked, automaticInService

NODE.general.DefaultsDescription Factory Defaults

NODE.general.IIOPListenerPort 57790 0 65535

NODE.general.NtpSntpServer 0.0.0.0

NODE.general.TimeZone (GMT-08:00) Pacific Time (US 
& Canada), Tijuana

NODE.general.UseDST TRUE

NODE.network.general.AlarmMissingBackplaneLAN FALSE

NODE.network.general.CtcIpDisplaySuppression FALSE

NODE.network.general.GatewaySettings None

NODE.network.general.LcdIpSetting Allow Configuration

NODE.powerMonitor.EHIBATVG_48V -56.5

NODE.powerMonitor.EHIBATVG_60V -72

NODE.powerMonitor.ELWBATVG_48V -40.5

NODE.powerMonitor.ELWBATVG_60V -50

NODE.protection.lmsp.BidirectionalSwitching FALSE

NODE.protection.lmsp.ReversionTime 5

NODE.protection.lmsp.Revertive FALSE

NODE.protection.msspr.RingReversionTime 5

NODE.protection.msspr.RingRevertive TRUE

NODE.protection.msspr.SpanReversionTime 5

NODE.protection.msspr.SpanRevertive TRUE
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NODE.protection.splitter.ReversionTime 5

NODE.protection.splitter.Revertive FALSE

NODE.protection.ycable.ReversionTime 5

NODE.protection.ycable.Revertive FALSE

NODE.security.access.LANAccess Front & Backplane

NODE.security.access.RestoreTimeout 5 0 60

NODE.security.dataComm.CtcBackplaneIpDisplaySuppressio
n

TRUE

NODE.security.dataComm.DefaultTCCEthernetIP 10.10.0.1

NODE.security.dataComm.DefaultTCCEthernetIPNetmask 24

NODE.security.dataComm.LcdBackplaneIpSetting Display Only

NODE.security.dataComm.SecureModeLocked FALSE

NODE.security.dataComm.SecureModeOn FALSE

NODE.security.idleUserTimeout.Maintenance 0.041666666667

NODE.security.idleUserTimeout.Provisioning 0.020833333333

NODE.security.idleUserTimeout.Retrieve 0

NODE.security.idleUserTimeout.Superuser 0.010416666667

NODE.security.legalDisclaimer.LoginWarningMessage <center><b>WARNING</b></c
enter>This system is restricted to 
authorized users for business 
purposes. 
Unauthorized<p>access is a 
violation of the law. This service 
may be monitored for 
administrative<p>and security 
reasons. By proceeding, you 
consent to this monitoring.

NODE.security.other.DisableInactiveUser FALSE

NODE.security.other.InactiveDuration 45 20 90

NODE.security.other.PMClearingPrivilege Provisioning

NODE.security.other.SingleSessionPerUser FALSE

NODE.security.passwordAging.EnforcePasswordAging FALSE

NODE.security.passwordAging.maintenance.AgingPeriod 45 20 90

NODE.security.passwordAging.maintenance.WarningPeriod 5 2 20

NODE.security.passwordAging.provisioning.AgingPeriod 45 20 90

NODE.security.passwordAging.provisioning.WarningPeriod 5 2 20

NODE.security.passwordAging.retrieve.AgingPeriod 45 20 90

NODE.security.passwordAging.retrieve.WarningPeriod 5 2 20

NODE.security.passwordAging.superuser.AgingPeriod 45 20 90

Table D-23 Node Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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NODE.security.passwordAging.superuser.WarningPeriod 5 2 20

NODE.security.passwordChange.CannotChangeNewPassword FALSE

NODE.security.passwordChange.CannotChangeNewPassword
ForNDays

20 20 95

NODE.security.passwordChange.PreventReusingLastNPasswo
rds

1 1 10

NODE.security.passwordChange.RequirePasswordChangeOn
FirstLoginToNewAccount

FALSE

NODE.security.shellAccess.EnableShellPassword FALSE

NODE.security.shellAccess.SSH FALSE

NODE.security.shellAccess.TelnetPort 23 23 9999

NODE.security.userLockout.FailedLoginsBeforeLockout 5 0 10

NODE.security.userLockout.LockoutDuration 0.020833333333 0 600

NODE.security.userLockout.ManualUnlockBySuperuser FALSE

NODE.timing.bits-1.AdminSSMIn STU

NODE.timing.bits-1.AISThreshold G812L

NODE.timing.bits-1.Coding HDB3

NODE.timing.bits-1.CodingOut HDB3

NODE.timing.bits-1.FacilityType E1

NODE.timing.bits-1.FacilityTypeOut E1

NODE.timing.bits-1.Framing FAS+CAS+CRC

NODE.timing.bits-1.FramingOut FAS+CAS+CRC

NODE.timing.bits-1.Sa bit 4

NODE.timing.bits-1.State unlocked

NODE.timing.bits-1.StateOut unlocked

NODE.timing.bits-2.AdminSSMIn STU

NODE.timing.bits-2.AISThreshold G812L

NODE.timing.bits-2.Coding HDB3

NODE.timing.bits-2.CodingOut HDB3

NODE.timing.bits-2.FacilityType E1

NODE.timing.bits-2.FacilityTypeOut E1

NODE.timing.bits-2.Framing FAS+CAS+CRC

NODE.timing.bits-2.FramingOut FAS+CAS+CRC

NODE.timing.bits-2.Sa bit 4

NODE.timing.bits-2.State unlocked

NODE.timing.bits-2.StateOut unlocked

NODE.timing.general.Mode External

Table D-23 Node Default Settings (ETSI) (continued)

Default Name Default Value Minimum Maximum
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D.3.3 ETSI CTC Default Settings
Table D-24 lists the CTC-level default settings for the Cisco ONS 15454. Cisco provides the following 
types of settings preprovisioned for CTC.

• Create circuits with the Auto route check box selected by default

• Create TL1-like circuits—instructs the node to create only cross-connects, allowing the resulting 
circuits to be in an upgradable state.

• Choose a default network map (which country)

Table D-24 CTC Default Settings (ETSI)

Default Name Default Value

CTC.circuits.AutoRoute TRUE

CTC.circuits.CreateLikeTL1 FALSE

CTC.network.Map United States
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G L O S S A R Y
Numerics

1:1 protection A electrical card protection scheme that pairs a working card with a protect card of the same type in 
an adjacent slot. If the working card fails, the traffic from the working card switches to the protect 
card. When the failure on the working card is resolved, traffic reverts back to the working card if this 
option is set. This protection scheme is specific to electrical cards.

1+1 protection An optical card protection scheme that pairs a single working card with a single dedicated protect 
card. A term specific to optical cards.

1:N protection An electrical card protection scheme that allows a single protect card to provide protection for several 
working cards. If a working card fails, the traffic from the working card switches to the protect 
card.When the failure on the working card is resolved, traffic reverts to the working card. 

10BaseT Standard 10-Mbps local area network over unshielded twisted pair copper wire.

100BaseT Standard 100-Mbps local Ethernet network.

100BaseTX Specification of 100BaseT that supports full duplex operation.

A

access drop Point where network devices can access the network.

access identifier See AID.

ACO alarm cutoff.

active card A card that is working or carrying traffic. A card provisioned as working can be an active card or, after 
a protection switch, a protect card can be an active card.

ACT/STBY Active/Standby.

add/drop 

multiplexer

See ADM.

address mask Bit combination used to describe the portion of an IP address that refers to the network or subnet and 
the portion that refers to the host. Sometimes referred to as mask. See also subnet mask.

ADM add/drop multiplexer. ADMs aggregate or groom SONET traffic at various speeds. An ADM has three 
or more nodes.
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agent 1. Generally, software that processes queries and returns replies on behalf of an application.

2. In a network management system, a process that resides in all managed devices and reports the 
values of specified variables to management stations.

AEP Alarm Expansion Panel.

AID access identifier. An access code used in TL1 messaging that identifies and addresses specific objects 
within the ONS 15454. These objects include individual pieces of equipment, transport spans, access 
tributaries, and others. See also TID.

AIP alarm interface panel.

ALS Automatic laser shutdown. A protocol that, in the event a remote link is broken, automatically reduces 
the optical output power of remote transmitters.

alternate mark 

inversions

See AMI.

ANS automatic node setup.

AMI alternate mark inversion. Line-code format used on T1 circuits that transmits ones by alternate 
positive and negative pulses. Zeros are represented by 01 during each bit cell and ones are represented 
by 11 or 00, alternately, during each bit cell. AMI requires that the sending device maintain ones 
density. Ones density is not maintained independently of the data stream. Sometimes called 
binary-coded alternate mark inversion.

AMP Champ Short name for the backplane electrical interface assembly equipped with AMP Champ connectors.

ANSI American National Standards Institute.

AOTF Acoustic-Optic Tunable Filter. Wavelength filter used to add/drop specific channels within the MSTP 
under software control. 

APC automatic power control.

APD avalanche photodiode.

APS automatic protection switching. SONET switching mechanism that routes traffic from working lines 
to protect lines if a line card failure or fiber cut occurs.

APSB alarm protection switching byte.

ARP Address Resolution Protocol.

ASIC application-specific integrated circuit.

Asynchronous 

Transfer Mode

See ATM.

ATAG autonomous message tag. Sequential number generated by the system tat is used for TL1 message 
sequencing. See also CTAG.
GL-2
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



 

Glossary
ATM Asynchronous Transfer Mode. The international standard for cell relay, in which multiple service 
types (such as voice, video, or data) are conveyed in fixed-length (53-byte) cells. Fixed-length cells 
allow cell processing to occur in hardware, thereby reducing transit delays. ATM is designed to take 
advantage of high-speed transmission media such as E3, SONET, and T3.

attenuation The decrease in signal strength in an optical fiber caused by absorption and scattering. Attenuation 
can be calculated to express the signal loss between two points, or the total signal loss of a 
telecommunications system or segment.

automatic laser 

shutdown

See ALS.

automatic 

protection 

switching

See APS.

autonomous 

message tag

See ATAG.

AWG American Wire Gauge, or arrayed waveguide grating

B

B8ZS binary 8-zero substitution. A line-code type, used on T1 circuits, that substitutes a special code 
whenever eight consecutive zeros are sent over the link. This code is then interpreted at the remote 
end of the connection. This technique guarantees ones density independent of the data stream. 
Sometimes called bipolar 8-zero substitution.

backbone The part of the network that carries the heaviest traffic or joins LANs together.

BER bit error rate. Ratio of received bits that contain errors.

bidirectional line 

switched ring

See BLSR.

binary-coded 

alternate mark 

inversion

See AMI.

binary 8-zero 

substitution

See B8ZS.

BIP bit interleaved parity. In ATM, a method used to monitor errors on a link. A check bit or word is sent 
in the link overhead for the previous block or frame. Bit errors in the payload can then be detected and 
reported as maintenance information.

bit error rate See BER.

bit interleaved 

parity

See BIP.

bit rate Speed at which bits are transmitted, usually expressed in bits per second.
GL-3
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

September 2005



Glossary
BITS building integrated timing supply. A single building master timing supply that minimizes the number 
of synchronization links entering an office. 

BLSR bidirectional line switched ring. A SONET ring architecture that provides working and protection 
fibers between nodes. If the working fiber between nodes is cut, traffic is automatically routed onto 
the protection fiber. Compare with path protection.

blue band Dense wavelength division multiplexing (DWDM) wavelengths are broken into two distinct bands: 
red and blue. DWDM cards for the ONS 15454 operate on wavelengths between 1530.33 nm and 
1542.94 nm in the blue band. The blue band is the lower frequency band.

BNC Bayonet Neill-Concelman (coaxial cable bayonet-locking connector).

BPDU bridge protocol data unit.

bridge Device that connects and passes packets between two network segments that use the same 
communications protocol. In general, a bridge will filter, forward, or flood an incoming frame based 
on the MAC address of that frame. See also MAC address.

broadcast Data packet that will be sent to all nodes on a network. Broadcasts are identified by a broadcast 
address. Compare with multicast and unicast. See also broadcast address.

broadcast address Special address reserved for sending a message to all stations. Generally, a broadcast address is a 
MAC destination address of all ones. See also MAC address.

broadcast storm Undesirable network event in which many broadcasts are sent simultaneously across all network 
segments. A broadcast storm uses substantial network bandwidth and, typically, causes network 
timeouts.

building integrated 

timing supply

See BITS.

bus Common physical signal path composed of wires or other media across which signals can be sent from 
one part of a computer to another.

C

C2 byte The C2 byte is the signal label byte in the synchronous transport signal (STS) path overhead. This byte 
tells the equipment what the SONET payload envelope contains and how it is constructed. See also 
SONET.

CAT-5 Category 5 (cabling).

C-Band conventional band. In optical networks, a range of wavelengths between 1535 nm and 1565 nm.

CCITT Comité Consultatif International Télégraphique et Téléphoniques. Formerly ITU.

CEV Controlled Environment Vaults.

Cisco Transport 

Controller

See CTC.
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Cisco Transport 

Manager

See CTM.

CLEI Common Language Equipment Identification code.

CLNP Connectionless Network Protocol.

cm centimeter.

CMIP Common Management Information Protocol.

COE Central Office Environment.

collision In Ethernet, the result of two nodes transmitting simultaneously. The frames from each device impact 
and are damaged when they meet on the physical media.

concatenation A mechanism for allocating contiguous bandwidth for payload transport. Through the use of 
concatenation pointers, multiple OC-1s can be linked together to provide contiguous bandwidth 
through the network, from end to end.

Coordinated 

Universal Time

See UTC.

CORBA Common Object Request Broker Architecture.

correlation tag See CTAG.

CPE Customer Premise Equipment.

crosspoint A set of physical or logical contacts that operate together to extend the speech and signal channels in 
a switching network.

CTAG correlation tag. A unique identifier given to each input command by the TL1 operator. When the 
ONS 15454 system responds to a specific command, it includes the command’s CTAG in the reply. 
This eliminates discrepancies about which response corresponds to which command. See also ATAG.

CTC Cisco Transport Controller. A Java-based graphical user interface (GUI) that allows operation, 
administration, maintenance, and provisioning (OAM&P) of the ONS 15454 using an Internet 
browser.

CTM Cisco Transport Manager. A Java-based network management tool used to support large Cisco 
15000-class networks.

D

data 

communications 

channel

See DCC.

data 

communications 

network

See DCN.
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DCC data communications channel. Used to transport information about OAM&P over a SONET interface. 
DCC can be located in SDCC or LDCC. See also LDCC and SDCC.

DCN data communications network. An out-of-band network that provides connectivity between network 
elements and their respective operations support systems (OSS).

DCS Distributed Communications System.

DCU dispersion compensation unit.

default router If the ONS 15454 must communicate with a device on a network to which the ONS 15454 is not 
connected, packets are sent to this router to be distributed.

demultiplex To separate multiple multiplexed input streams from a common physical signal back into multiple 
output streams. Compare with multiplex.

demultiplexer A device used to demultiplex signals.

demux An abbreviation used for demultiplex or demultiplexer.

dense wavelength 

division 

multiplexing

See DWDM.

destination The endpoint where traffic exits an ONS 15454 network. Endpoints can be paths (STS or STS/VT for 
optical card endpoints), ports (for electrical circuits, such as DS1, VT, DS3, STS), or cards (for 
circuits on DS1 and Ethernet cards). See also STS and VT.

DHCP Dynamic Host Configuration Protocol.

Digital Signal 

Cross-Connect 

Frame

See DSX.

DNS Domain Name Service.

DRAM dynamic random-access memory.

drop See destination.

DS-1 digital signal level 1. A framing specification used in transmitting digital signals at 1.544-Mbps on a 
T1 facility (in the United States) or at 2.108-Mbps on an E1 facility (in Europe).

DS-3 digital signal level 3. Framing specification used for transmitting digital signals at 44.736 Mbps on a 
T3 facility. 

DSX (Digital Signal Cross-Connect Frame). A manual bay or panel where different electrical signals are 
wired. A DSX permits cross-connections by patchcords and plugs.

DWDM dense wavelength division multiplexing. A technology that increases the information carrying 
capacity of existing fiber optic infrastructure by transmitting and receiving data on different light 
wavelengths. Many of these wavelengths can be combined on a single strand of fiber.

DWDM node An ONS 15454 running Software Release 4.5, or later. Compare with non-DWDM node.
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E

EDFA erbium doped fiber amplifier. A type of fiber optical amplifier that transmits a light signal through a 
section of erbium-doped fiber and amplifies the signal with a laser pump diode. EDFA is used in 
transmitter booster amplifiers, in-line repeating amplifiers, and receiver preamplifiers.

EFCA Electrical Facility Connection Assembly.

EFT Electrical Fast Transient/Burst.

EIA electrical interface assembly. Provides backplane connection points for the DS-1, DS-3, and EC-1 
cards.

EIA/TIA-232 Electronic Industries Association/Telecommunications Industry Association Recommended Standard 
No. 232.

electrical interface 

assembly

See EIA.

electromagnetic 

interference

See EMI.

ELR Extended Long Reach.

EMC electromagnetic compatibility.

EMI electromagnetic interference. Interference by electromagnetic signals that can cause reduced data 
integrity and increased error rates on transmission channels.

EML Element Manager Layer.

EMS Element Management System.

ENE end network element.

envelope The part of messaging that varies in composition from one transmittal step to another. It identifies the 
message originator and potential recipients, documents its past, directs its subsequent movement by 
the Message Transfer System (MTS), and characterizes its content.

EOW express orderwire. A permanently connected voice circuit between selected stations for technical 
control purposes.

erbium doped fiber 

amplifier

See EDFA.

ERDI Enhanced Remote Defect Indicator.

ES errored seconds.

ESD electrostatic discharge.

ESH End System Hello.

ESF Extended Super Frame.
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Ethernet switch A type of Ethernet LAN device that increases aggregate LAN bandwidth by allowing simultaneous 
switching of packets between switch ports. Ethernet switches subdivide previously shared LAN 
segments into multiple networks with fewer stations per network.

ETSI European Telecommunications Standards Institute.

express orderwire See EOW.

extended SNCP extended subnetwork connection protection). Extends the protection scheme of a subnetwork 
connection protection ring (SNCP) beyond the basic ring configuration to the meshed architecture of 
several interconnecting rings. See also SNCP.

external timing 

reference

A timing reference obtained from a source external to the communications system, such as one of the 
navigation systems. Many external timing references are referenced to Coordinated Universal Time 
(UTC).

F

falling threshold A falling threshold is the counterpart to a rising threshold. When the number of occurrences drops 
below a falling threshold, this triggers an event to reset the rising threshold. See also rising threshold.

FC Failure count.

FDDI Fiber Distributed Data Interface. A LAN standard, defined by ANSI X3T9.5, specifying a 100-Mbps 
token-passing network using fiber optic cable, with transmission distances of up to 2 km. FDDI uses 
a dual-ring architecture to provide redundancy.

FE Frame Bit Errors.

FEC forward error correction.

FG1 Frame Ground #1 (pins are labeled “FG1,” “FG2,” etc.)

Fiber Distributed 

Data Interface

See FDDI.

FMEC Front Mount Electrical Connection.

frame Logical grouping of information sent as a data link layer unit over a transmission medium. Often refers 
to the header and trailer, used for synchronization and error control that surrounds the user data 
contained in the unit.

FSB Field Service Bulletin.

G

gateway An electronic repeater device that intercepts and steers electrical signals from one network to another. 

GBIC Gigabit Interface Converter. A hot-swappable input/output device that plugs into a Gigabit Ethernet 
port to link the port with the fiber-optic network. 

Gbps gigabits per second.
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GBps gigabytes per second.

GCC generic communications channel.

Gigabit Interface 

Converter

See GBIC.

GNE gateway network element.

GR-253-CORE Telcordia General Requirements #253 Council of Registrars.

GR-1089 Telcordia General Requirement 1089, Electromagnetic Compatibility and Electrical Safety - Generic 
Criteria for Network Telecommunications Equipment.

GUI graphical user interface.

H

hard reset The physical removal and insertion of a TCC2/TCC2P card, also known as reseating a card or 
performing a card pull.

HDLC high-level data link control. Bit-oriented, synchronous, data-link layer protocol developed by the 
International Standards Organization (ISO). HDLC specifies a data encapsulation method on 
synchronous serial links using frame characters and checksums.

high-level data link 

control

See HDLC.

hop A hop is a way to quantify the “length” of a network route to decide which redundant route is selected. 
Typically, each path segment through a routing network device is considered one hop. For example, if 
an ENE is connected to a GNE that is connected to a router, the ENE has two hops to the router—one 
from itself to the GNE and a second from the GNE to the router. To ensure that a certain route is used 
only when all other routes are exhausted, assign it an unusually high hop count.

host number The part of an IP address used to address an individual host within the network or subnetwork.

hot swap The process of replacing a failed component while the rest of the system continues to function 
normally.

I

IEC 1. InterExchange Carrier.

2. International Electrotechnical Commission.

IEEE Institute of Electrical and Electronics Engineers.

IETF Internet Engineering Task Force.

Internet protocol See IP.

I/O input/output.
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IP Internet protocol. Network layer protocol in the TCP/IP stack offering a connectionless internetwork 
service. IP provides features for addressing, type-of-service specification, fragmentation and 
reassembly, and security.

IPPM intermediate-path performance monitoring.

IP address A 32-bit address assigned to a host using TCP/IP. An IP address belongs to one of five classes (A, B, 
C, D, or E) and is written as 4 octets separated by periods (dotted decimal format). Each address 
consists of a network number, an optional subnetwork number, and a host number. 

ITU-T International Telecommunication Union–Telecommunication Standards Sector.

J

JRE Java Runtime Environment.

K

K byte Automatic protection-switching byte located in the SONET line overhead and monitored by 
equipment for an indication to switch to protection.

L

LAN local area network. High-speed, low-error, data network covering a relatively small geographic area. 
LANs connect workstations, peripherals, terminals, and other devices in a single building or other 
geographically limited area. Ethernet, FDDI, and Token Ring are widely used LAN technologies.

LBO line build out. The distance between an external timing device connected to the BITS Out pins and the 
ONS 15454.

LCD (Liquid Crystal Display). An alphanumeric display using liquid crystal sealed between two pieces of 
glass. LCDs conserve electricity.

LDCC Line data communications channel.

Line Alarm 

Indication Signal

See AIS-L.

line build out See LBO.

line layer Refers to the segment between two SONET devices in the circuit. The line layer deals with SONET 
payload transport, and its functions include multiplexing and synchronization. Sometimes called a 
maintenance span.

line terminating 

equipment

See LTE.

line timing mode A node that derives its clock from the SONET lines.
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link budget The difference between the output power and receiver power of an optical signal expressed in decibels 
(dB). Link refers to an optical connection and all of its component parts (optical transmitters, 
repeaters, receivers, and cables).

link integrity The network communications channel has link integrity if it is intact.

Liquid Crystal 

Display

See LCD.

local area network See LAN.

local orderwire See LOW.

lockout A method of switching traffic from one card to another, or one span to another (BLSRs), that prevents 
traffic from reverting to the card or span where the lockout is applied. The lockout overrides other 
manual switching connections (Force, Manual, and Exercise).

loopback test Test that sends signals, and then directs them back toward their source from some point along the 
communications path. Loopback tests are often used to test network interface usability.

LOW local orderwire. A communications circuit between a technical control center and selected terminal or 
repeater locations.

LTE line terminating equipment. Refers to line cards that terminate the line signal in the ONS 15454.

LVDS Low-Voltage Differential Signal.

M

MAC Media Access Control.

MAC address Standardized data link layer address that is required for every port or device that connects to a LAN. 
Other devices in the network use these addresses to locate specific ports in the network and to create 
and update routing tables and data structures. MAC addresses are six bytes long and are controlled by 
the IEEE. Also known as the hardware address, MAC-layer address, and physical address.

ISH Intermediate System Hello.

Maintenance user A security level that limits user access to maintenance options only. Compare with Superuser, 
Provisioning user, and Retrieve user.

managed device A network node that contains a Subnetwork Management Protocol (SNMP) agent and resides on a 
managed network. Managed devices include routers, access servers, switches, bridges, hubs, 
computer hosts, and printers.

managed object In network management, a network device that can be managed by a network management protocol. 
Sometimes called an MIB object.

Management 

Information Base

See MIB.

mapping A logical association between one set of values, such as addresses on one network, with quantities or 
values of another set, such as devices on another network.
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Mbps megabits per second.

MBps megabytes per second.

MetroPlanner Cisco MetroPlanner is a network design tool that provides a means to construct and test wavelength 
division multiplexing (WDM) optical networks in a modeled graphical environment. 

MHz megahertz.

MIB Management Information Base. Database of network management information that is used and 
maintained by a network management protocol such as SNMP or Common Management Information 
Protocol (CMIP). The value of a MIB object can be changed or retrieved using SNMP or CMIP 
commands, usually through a GUI network management system. MIB objects are organized in a tree 
structure that includes public (standard) and private (proprietary) branches.

MIME Multipurpose Internet Mail Extensions.

MPO Multifiber Push-On (connector).

MS multiplex section.

MS-FERF multiplex section far-end receive failure.

MSP Multiplex Section Protection.

MS-SPRing multiplex section-shared protection ring. SDH ring architecture that provides working and protection 
fibers between nodes. If the working fiber between nodes is cut, traffic is automatically rerouted onto 
the protection fiber.

MTS Message Transfer System

multicast Single packets copied by the network and sent to a specific subset of network addresses. Compare with 
unicast and broadcast.

multiplex payload Generates section and line overhead, and converts electrical/optical signals when the electrical/optical 
card is transmitting.

multiplex 

section-shared 

protection ring

See MS-SPRing.

multiplex To combine multiple signals so that they can be transmitted simultaneously across a single physical 
channel. Compare demultiplex.

multiplexer A device used to multiplex signals.

mux An abbreviation used for multiplex or multiplexer. 

muxed multiplexed. See multiplex.

N

NE network element. In an Operations Support System (OSS), a single piece of telecommunications 
equipment used to perform a function or service integral to the underlying network.
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NEBS Network Equipment Building Systems.

NEL Network Element Layer.

network 

management 

system

See NMS.

network number Part of an IP address that specifies the network where the host belongs.

NIC network interface card

NML Network Management Layer.

NMS network management system. System that executes applications that monitor and control managed 
devices. NMSs provide the bulk of the processing and memory resources required for network 
management.

node In this manual, the term “node” usually refers to an ONS 15454. A node is the endpoint of a network 
connection or a junction common to two or more lines in a network. Nodes can be processors, 
controllers, or workstations. Nodes, which vary in routing and other functional capabilities, can be 
interconnected by links, and serve as control points in the network. Node is sometimes used 
generically to refer to any entity that can access a network. 

non-DWDM node An ONS 15454 running Software Release 4.1 or earlier. Compare with DWDM node.

NSAP Network Service Access Point.

NSP Node Service Protocol.

NTD Node Topology Discovery.

O

OADM optical add/drop multiplexer

OAM&P operation, administration, maintenance, and provisioning. Provides the facilities and personnel 
required to manage a network.

OC optical carrier.

OCHNC optical channel network connection.

OOS AS Out of Service Assigned.

operation, 

administration, 

maintenance, and 

provisioning

See OAM&P.

optical amplifier A device that amplifies an optical signal without converting the signal from optical to electrical and 
back again to optical energy.
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optical receiver An opto-electric circuit that detects incoming lightwave signals and converts them to the appropriate 
signal for processing by the receiving device.

orderwire Equipment that establishes voice contact between a central office and carrier repeater locations. 
See also EOW and LOW.

OSCM Optical Service Channel Module.

OSI Open Systems Interconnection.

OSNR optical signal-to-noise ratio

OSPF Open Shortest Path First.

OSS Operations Support System.

OTN optical transport network

output contacts 

(controls)

Triggers that drive visual or audible devices such as bells and lights. Output contacts can control other 
devices such as generators, heaters, and fans.

P

passive devices Components that do not require external power to manipulate or react to electronic output. Passive 
devices include capacitors, resisters, and coils. 

Path layer The segment between the originating equipment and the terminating equipment. This path segment 
might encompass several consecutive line segments or segments between two SONET devices.

Path-Protected 

Mesh Network

See PPMN.

Path Protection Path-switched SONET rings that employ redundant, fiber- optic transmission facilities in a pair 
configuration. One fiber transmits in one direction and the backup fiber transmits in the other. If the 
primary ring fails, the backup takes over. Compare with BLSR.

payload Portion of a cell, frame, or packet that contains upper-layer information (data).

PCM pulse code modulation.

PCMCIA Personal Computer Memory Card International Association.

PCN Product Change Notice.

PDI-P STS Payload Defect Indication–Path.

ping packet Internet grouper. Internet Control Message Protocol (ICMP) echo message and its reply. Often 
used in IP networks to test the reachability of a network device.

pointer justification In SONET, the mechanism used to compensate for frequency and phase variations. Pointer 
justification counts indicate timing errors on SONET networks.

POP point of presence.
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PM performance monitoring.

PPM pluggable port module.

PPMN Path-Protected Mesh Network. Extends the protection scheme of a path protection beyond the basic 
ring configuration to the meshed architecture of several interconnecting rings.

priority queuing Routing feature that divides data packets into two queues: one low-priority and one high-priority.

protect card A card in a protection pair or scheme that is provisioned as a protect card to the working card. If the 
working card fails, the protect card becomes active. See also working card.

Provisioning user A security level that allows the user to access only provisioning and maintenance options in CTC. 
See also Superuser, Maintenance user, and Retrieve user.

PSC Protection Switching Count.

PSD Protection Switching Duration.

PTE path-terminating equipment.

Q

queue In routing, a backlog of packets waiting to be forwarded over a router interface.

R

RAM random-access memory.

RDI-L Remote Defect Indication–Line.

red band DWDM wavelengths are broken into two distinct bands: red and blue. The red band is the higher 
frequency band. The red band DWDM cards for the ONS 15454 operate on wavelengths between 
1547.72 nm and 1560.61 nm. 

RES reserved.

Retrieve user A security level that allows the user to retrieve and view CTC information but not set or modify 
parameters. Compare with Superuser, Maintenance user, and Provisioning user.

revertive switching A process that sends electrical interfaces (traffic) back to the original working card after the card 
comes back online.

ring Connection of two or more nodes in a logically circular topology. Information is passed sequentially 
between active nodes. See also switching, ring.

rising threshold The number of occurrences (collisions) that must be exceeded to trigger an event.

RJ-45 Registered Jack #45 (8-pin).

RMA Return Materials Authorization.
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RMON (remote monitoring). Allows network operators to monitor the health of the network with an NMS. 
RMON watches several variables, such as Ethernet collisions, and triggers an event when a variable 
crosses a threshold in the specified time interval.

RS-232 See EIA/TIA-232.

Rx receive.

S

SC Fiber connector, push-pull type.

SCI Serial Communication Interface.

SCL System Communications Link.

SCSI Small Computer System Interface.

SDCC Section data communications channel.

SDH Synchronous Digital Hierarchy. European standard that defines a set of rate and format standards that 
are transmitted using optical signals over fiber. SDH is similar to SONET, with a basic SDH rate of 
155.52 Mbps. Compare with SONET.

SEF Severely Errored Frame.

SELV Safety Extra-Low Voltage.

SES Severely Errored Seconds.

SF Super Frame.

SFP small form factor plugle

Simple Network 

Management 

Protocol

See SNMP.

Simple Network 

Time Protocol

See SNTP.

SML Service Management Layer.

SMF single-mode fiber.

SNCP Subnetwork Connection Protection. Path-switched SDH rings that employ redundant, fiber-optic 
transmission facilities in a pair configuration. One fiber transmits in one direction and the backup fiber 
transmits in the other. If the primary ring fails, the backup takes over. 

SNMP Simple Network Management Protocol. Network management protocol used almost exclusively in 
TCP/IP networks. SNMP monitors and controls network devices and manages configurations, 
statistics collection, performance, and security.
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SNTP Simple Network Time Protocol. Using an SNTP server ensures that all ONS 15454 network nodes use 
the same date and time reference. The server synchronizes alarm timing during power outages or 
software upgrades.

soft reset A soft reset reloads the operating system, application software, etc., and reboots the TCC2/TCC2P 
card. It does not initialize the ONS 15454 application-specific integrated circuit (ASIC) hardware.

SONET Synchronous Optical Network. High-speed synchronous network specification developed by 
Telcordia Technologies, Inc. and designed to run on optical fiber. STS-1 is the basic building block of 
SONET. Approved as an international standard in 1988.

source The endpoint where traffic enters an ONS 15454 network. Endpoints can be a path (STS or STS/VT 
for optical card endpoints), port (for electrical circuits, such as DS1, VT, DS3, or STS), or card (for 
circuits on DS1 and Ethernet cards). See also STS and VT.

span An optical path between two nodes. See also switching, span.

spanning tree A loop-free subset of a network topology. See also STA and STP.

spanning-tree 

algorithm

See STA.

Spanning Tree 

Protocol

See STP.

SPE synchronous payload envelope. A SONET term describing the envelope that carries the user data or 
payload.

SRB source-route bridging.

SSM synchronization status messaging. A SONET protocol that communicates information about the 
quality of the timing source using the S1 byte of the line overhead.

STA spanning-tree algorithm. An algorithm used by the Spanning Tree Protocol (STP) to create a spanning 
tree. See also spanning tree and STP.

standby card A card that is not active or carrying traffic. A standby card can be a protect card or, after a protection 
switch, a working card can be a standby card.

static route A route that is manually entered into a routing table. Static routes take precedence over routes chosen 
by all dynamic routing protocols.

STP 1. shielded twisted-pair.

2. Spanning Tree Protocol. Bridge protocol that uses the spanning-tree algorithm to enable a learning 
bridge to dynamically work around loops in a network topology by creating a spanning tree. See also 
spanning tree and STA.

STS Synchronous Transport Signal. Used generically when speaking of SONET signals.

STS-1 Synchronous Transport Signal level 1. Basic building block signal of SONET, operating at 
51.84 Mbps for transmission over OC-1 fiber. Faster SONET rates are defined as STS-n, where n is a 
multiple of 51.84 Mbps. See also SONET.
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subnet mask A 32-bit address mask used in IP to indicate the bits of an IP address that are used for the subnet 
address. Sometimes referred to simply as mask. See also IP address.

subnetwork In IP networks, a network confined to a particular subnet address. Subnetworks are networks 
segmented by a network administrator in order to provide a multilevel, hierarchical routing structure 
while shielding the subnetwork from the addressing complexity of attached networks. Sometimes 
called a subnet.

Subnetwork 

Connection 

Protection

See SNCP.

subtending rings SONET rings that incorporate nodes that are also part of an adjacent SONET ring.

Superuser A security level that can perform all of the functions of the other security levels as well as set names, 
passwords, and security levels for other users. A Superuser is usually the network element 
administrator. Compare with Retrieve user, Maintenance user, and Provisioning user.

switching, span Span switching occurs when a working span fails. Traffic switches to the protect fibers between the 
nodes and then returns to the working fibers. Multiple span switches can occur at the same time.

switching, ring Ring switching occurs when a span switch cannot recover traffic, such as when both the working and 
protect fibers fail on the same span. In a ring switch, traffic is routed to the protect fibers throughout 
the full ring.

SWS SONET WAN switch.

SXC SONET Cross Connect ASIC.

synchronization 

status messaging

See SSM.

Synchronous Digital 

Hierarchy

See SDH.

Synchronous 

Optical Network

See SONET.

synchronous 

payload envelope

See SPE.

Synchronous 

Transport Signal

See STS.

T

T1 T1 transmits DS-1-formatted data at 1.544 Mbps through the telephone-switching network using AMI 
or B8ZS coding. See also AMI, B8ZS, and DS-1.

TAC Cisco Technical Assistance Center.

target identifier See TID.

TBOS Telemetry Byte Oriented Serial protocol.
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TCA threshold crossing alert.

TCC+ Timing Communications and Control + Card.

TCP/IP Transmission Control Protocol/Internet Protocol.

TDM time-division multiplexing. Allocates bandwidth on a single wire for information from multiple 
channels based on preassigned time slots. Bandwidth is allocated to each channel regardless of 
whether the station has data to transmit.

TDS time-division switching.

Telcordia Telcordia Technologies, Inc., formerly named Bellcore. Eighty percent of the U.S. 
telecommunications network depends on software invented, developed, implemented, or maintained 
by Telcordia.

TID target identifier. Identifies the particular network element (in this case, the ONS 15454) where each 
TL1 command is directed. The TID is a unique name given to each system at installation. See also 
AID.

time-division 

multiplexing

See TDM.

TL1 Transaction Language 1.

TLS transparent LAN services. Provides private network services across a SONET backbone. 

TMN Telecommunication Management Network.

transponder Optional device in a DWDM system that provides the conversion of one optical wavelength to a 
precision narrow band wavelength. See also DWDM.

trap Message sent by an SNMP agent to an NMS (CTM), console, or terminal to indicate the occurrence 
of a significant event, such as an exceeded threshold. See also CTM.

tributary The lower-rate signal directed into a multiplexer for combination (multiplexing) with other low rate 
signals to form an aggregate higher rate level.

trunk Network traffic travels across this physical and logical connection between two switches. A backbone 
is composed of a number of trunks. See also backbone.

TSA time-slot assignment.

TSI time-slot interchange.

tunnel Secure communication path between two peers, such as two nodes.

tunneling Architecture that is designed to provide the services necessary to implement any standard 
point-to-point encapsulation scheme.

Tx transmit.
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U

UAS Unavailable Seconds.

UBIC-H Universal Backplane Interface Connector-Horizontal. The UBIC-H EIAs provide up to 112 transmit 
and receive connections through 16 SCSI connectors per side (A and B). The UBIC-H EIAs are 
designed to support DS-1, DS-3, and EC-1 signals.

UBIC-V Universal Backplane Interface Connector-Vertical. The UBIC-V EIAs provide up to 112 transmit and 
receive connections through 16 SCSI connectors per side (A and B). The UBIC-V EIAs are designed 
to support DS-1, DS-3, and EC-1 signals. 

UDC user data channel.

UDP/IP User Datagram Protocol/Internet Protocol.

UID user identifier.

unicast The communication of a single source to a single destination. Compare with broadcast and multicast.

Universal Backplane 

Interface Connector- 

Horizontal

See UBIC-H.

Universal Backplane 

Interface Connector- 

Vertical

See UBIC-V.

UPC Ultra Physical Contact.

upstream Set of frequencies used to send data from a subscriber to the head end.

UTC Coordinated Universal Time. Time zone at zero degrees longitude. Formerly called Greenwich Mean 
Time (GMT) and Zulu time. 

UTP unshielded twisted-pair.

V

VDC volts direct current.

virtual fiber A fiber that carries signals at different rates and uses the same fiber-optic cable.

virtual ring Entity in a source-route bridging (SRB) network that logically connects two or more physical rings 
together either locally or remotely. The concept of virtual rings can be expanded across router 
boundaries.

virtual wire Routes external alarms to one or more alarm collection centers across the SONET transport network.

VLAN virtual LAN. Group of devices located on a number of different LAN segments that are configured 
(using management software) to communicate as if they were attached to the same wire. Because 
VLANs are based on logical instead of physical connections, they are extremely flexible.

VOA variable optical attenuator.
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VPN Virtual Private Network. Enables IP traffic to travel securely over a public TCP/IP network by 
encrypting all traffic from one network to another. A VPN uses “tunneling” to encrypt all information 
at the IP level. See also tunneling.

VT Virtual Tributary. A structure designed for the transport and switching of sub-DS3 payloads. See also 
tributary.

VT1.5 A Virtual Tributary that equals 1.544 Mbps.

VT layer The VT layer, or electrical layer, occurs when the SONET signal is broken down into an electrical 
signal.

VT tunnel Allows electrical circuits to pass through ONS 15454 nodes without using ONS 15454 cross-connect 
card capacity.

W

W watt.

WAN wide area network.

working card A card that is provisioned as an active, primary card. Traffic cards in a protection pair are provisioned 
as working or protect. See also protect card.

WPP Wavelength Path Provisioning.

X

X.25 Protocol providing devices with direct connections to a packet-switched network.

Y

Y-cable protection Two cards connected together with a Y cable to form a protection group.
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Numerics

1+1 optical card protection

summary GL-1

1:1 electrical card protection

description GL-1

1:N electrical card protection

description GL-1

100 Base T GL-1

100 Base TX GL-1

10 Base T GL-1

32DMX card

block diagrams 15-54

change administrative state 11-23, 11-27

change optical channel settings 11-26

change optical channel thresholds 11-29

change optical line settings 11-23

change optical line thresholds 11-25

description 15-52

faceplate 15-53

input power class 15-6

LEDs 15-55

modify line settings and PM thresholds 11-22

monitor performance 9-12

port calibration 15-55

power monitoring 15-55

power requirements B-5

reset 12-10

ROADM 15-54

specifications B-18

temperature range B-7

terminal node acceptance test 4-5

verify power 4-41
32DMX-O card

block diagrams 15-51

change administrative state 11-23, 11-27

change optical channel settings 11-26

change optical channel thresholds 11-29

change optical line settings 11-23

change optical line thresholds 11-25

description 15-49

faceplate 15-50

fiber clip 3-44, 3-47, 3-48, 3-58, 3-62

input power class 15-6

install 3-27

LEDs 15-52

modify line settings and change PM thresholds 11-22

port calibration 15-51

power monitoring 15-51

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-17

temperature range B-7

terminal and hub node acceptance test 4-2

verify power 4-40

32MUX-O card

block diagrams 15-47

change administrative state 11-23, 11-27

change optical channel settings 11-26

change optical channel thresholds 11-29

change optical line settings 11-23

change optical line thresholds 11-25

channel plan 15-47

description 15-45

faceplate 15-46
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fiber clip 3-44, 3-47, 3-48, 3-58, 3-62

install 3-27

LEDs 15-49

modify line settings and change PM thresholds 11-22

port calibration 15-49

power monitoring 15-49

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-17

temperature range B-7

terminal and hub node acceptance test 4-2

verify power 4-39

32WSS card

block diagrams 15-79

change administrative state 11-33, 11-38

change optical channel parameters 11-32

change optical channel thresholds 11-35

change optical line parameters 11-37

change optical line thresholds 11-39

description 15-76

faceplate 15-78

install 3-27

LEDs 15-81

modify line settings and PM thresholds 11-31

port calibration 15-81

power monitoring 15-81

power requirements B-6

reset 12-10

service state transitions C-3

specifications B-32

temperature range B-7

terminal node acceptance test 4-5

4MD-xx.x card

block diagram 15-57

change administrative state 11-23, 11-27

change optical channel settings 11-26

change optical channel thresholds 11-29

change optical line settings 11-23
IN-2
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change optical line thresholds 11-25

description 15-55

faceplate 15-56

input power 15-6

install 3-27

LEDs 15-58

modify line settings and PM thresholds 11-22

monitor performance 9-14

port calibration 15-58

power monitoring 15-58

power requirements B-5

service state transitions C-3

specifications B-20

temperature range B-7

verify pass-through connection power 4-50

wavelength pairs 15-58

A

acceptance tests

ANSI-ASE hub node 4-20

asymmetric line node with OSC-CSM and OSCM 
cards 4-30

ROADM node 4-8, 4-12, 4-16, 4-18

shelf connections 1-75

shelf installation acceptance test 1-74

symmetric line node with OSC-CSM cards 4-26

symmetric line node with OSCM cards 4-23

symmetric OADM node with OSC-CSM cards 4-35

symmetric OADM node with OSCM cards 4-33

symmetric passive OADM node with OSC-CSM 
cards 4-37

terminal and hub node with 32MUX-O and 32DMX-O 
cards 4-2

terminal node with 32WSS and 32DMX cards 4-5

access drop GL-1

access identifier (TL1) GL-2

ACO 14-46

active (definition) GL-1
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AD-1B-xx.x card

block diagrams 15-72

description 15-70

faceplate 15-71

install 3-27

LEDs 15-73

monitor performance 9-17

port calibration 15-72

power monitoring 15-72

power requirements B-6

reset 12-10

service state transition C-3

specifications B-25

temperature range B-7

verify output express power 4-45

verify pass-through connection power 4-48

AD-1C-xx.x card

block diagrams 15-61

description 15-59

faceplate 15-60

input power 15-6

install 3-27

LEDs 15-62

monitor performance 9-15

port calibration 15-61

power monitoring 15-61

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-21

temperature range B-7

verify output express power 4-46

verify pass-through connection 4-49

AD-2C-xx.x card

block diagrams 15-64

description 15-62

faceplate 15-63

input power 15-6

install 3-27
Cisc
September 2005
LEDs 15-65

monitor performance 9-15

port calibration 15-65

power monitoring 15-65

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-22

temperature range B-7

verify output express power 4-46

verify pass-through connection 4-49

wavelength pairs 15-64

AD-4B-xx.x card

block diagrams 15-75

description 15-73

faceplate 15-74

install 3-27

LEDs 15-76

monitor performance 9-17

port calibration 15-76

power monitoring 15-75

power requirements B-6

reset 12-10

service state transitions C-3

specifications B-28

temperature range B-7

verify output express power 4-45

verify pass-through connection power 4-48

AD-4C-xx.x card

block diagram 15-68

description 15-66

faceplate 15-67

input power 15-6

install 3-27

LEDs 15-69

monitor performance 9-15

port calibration 15-69

power monitoring 15-69

power requirements B-5
IN-3
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reset 12-10

service state transitions C-3

specifications B-23

temperature range B-7

verify output express power 4-46

verify pass-through connection 4-49

wavelength pairs 15-68

administrative states A-12

administrative states see service states

AEP

see also AIC-I card

connect external wire-wrap panel 1-57

description 14-30

install on backplane 1-43

I-Temp B-6

pin assignments 1-46, 14-32

power requirements B-5

printed circuit board assembly 14-31

specifications B-10

wire-wrap connections 1-45

agent GL-2

AIC-I card

see also external alarms, external controls

see also pin assignments

description 15-16

faceplate and block diagram (illustration) 15-17

install 1-73

LEDs 15-17

modify settings 11-41

power requirements B-5

specifications B-9

temperature range B-6

virtual wires 20-13

AID GL-2

AINS Soak

32WSS card 11-34, 11-39

MXP_2.5G_10G and MXP_2.5G_10E cards 5-29

MXP_MR_2.5G and MXPP_MR_2.5G cards 5-59

OSCM and OSC-CSM cards 11-5
IN-4
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TXP_MR_10G and TXP_MR_10E cards 5-11

TXP_MR_2.5G and TXPP_MR_2.5G cards 5-32, 5-43

AIP

description 14-29

location 14-27

replace 12-32, 14-29

air filter

description 14-43

inspect, clean, and replace 12-19

install external brackets 1-11

install filter 1-11

location 1-40

requirement 1-40

air ramp

ANSI placement overview 14-3

ETSI placement overview 14-6

install 1-19

typical site layout 14-18

AIS 6-6

alarm expansion panel see AEP

alarm filtering

description 20-3

disable 8-27

enable 8-25

filter tool 20-3

modify 8-25

alarm indication signal see AIS

alarm interface panel see AIP

alarm profiles

apply 20-11

apply to cards and nodes 8-22

apply to ports 8-20

button definitions 20-9

change row display 20-10

create 8-16, 20-8

delete 8-22

description 20-7

edit 20-10

modify 20-8
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alarms

alarm contact connections 14-45

change default severities see alarm profiles

change time zone 8-10, 20-2

delete cleared alarms from display 8-13, 20-3

entries in session 20-5

filtering  see alarm filtering

history 8-8, 8-9, 20-5

history, column descriptions 20-6

history, retrieve 20-7

incompatibility alarms 12-28

interface specifications B-2

overview 20-1

provision for MXP_2.5G_10G and MXP_2.5G_10E 
card client ports 5-35

provision for MXP_2.5G_10G and MXP_2.5G_10E 
card trunk ports 5-34

provision for TXP_MR_2.5G and TXPP_MR_2.5G card 
client ports 5-48

provision for TXP_MR_2.5G and TXPP_MR_2.5G card 
trunk ports 5-47

provision MXP_MR_2.5G and MXPP_MR_2.5G client 
port thresholds 5-65

provision MXP_MR_2.5G and MXPP_MR_2.5G trunk 
port thresholds 5-64

provision on TXP_MR_10G and TXP_MR_10E client 
ports 5-20

provision on TXP_MR_10G and TXP_MR_10E trunk 
ports 5-19

raise (unsuppress) 8-30

suppress 8-28, 20-11

synchronize 8-11, 20-3

troubleshoot see Cisco ONS 15454 Troubleshooting 
Guide

view 8-5, 8-6, 20-2

view alarm counts on LCD 8-14, 20-2

alarm severities

change see alarm profiles

description 20-7

options in alarm profiles 20-10

alerts 2-32, A-8
Cisc
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AMI 6-6, GL-2

AMP champ 1-58

amplified TDM node

description 16-26

amplifier cards

see OPT-BST card

see OPT-BST-E card

see OPT-PRE card

anti-ASE

acceptance test 4-20

description 16-10

any-to-any rings 17-3

APC see automatic power control

ARP sniffing see automatic host detection

ATM GL-3

audit trail

off-load records 12-13

security description 19-6

view records 12-11

automatic host detection 2-16

automatic laser shutdown

change maintenance settings 11-10, 11-21

description 17-24

MXP_2.5G_10E card 15-105

MXP_2.5G_10G card 15-98

MXP_MR_2.5G and MXPP_MR_2.5G cards 15-111

OSC-CSM 15-29

TXP_MR_10E card 15-87

TXP_MR_10G card 15-83

TXP_MR_2.5G and TXPP_MR_2.5G cards 15-93

automatic node setup

description 16-29

parameters 16-31

parameters by node type 16-36

provision parameters 16-33

run 3-73

view parameters 16-33

automatic power control

at the amplifier card level 17-18
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o ONS 15454 DWDM Installation and Operations Guide, R5.0



Index
at the node and network levels 17-19

description 17-17

disable 10-4

enable 10-4

interval 6-8

manage 10-3, 17-20

refresh 10-5

automatic protection switching

definition GL-2

B

B8ZS 6-6, GL-3

backbone GL-3

backplane

AEP connections 1-45

alarm wire connections 1-52

connection overview 14-44

covers, overview 14-26

IP address see secure mode

LAN wire connections 1-55

lower cover, description 14-27

lower cover, remove 1-26, 12-33

lower cover, replace 12-36

rear cover, description 14-28

rear cover, install 1-62

sheet metal cover, remove 1-27

timing wire connections 1-54

TL1 craft interface connections 1-56

band filter OADM cards

see AD-1B-xx.x card

see AD-4B-xx.x cards

bandwidth B-1

battery termination 1-38

bay assembly 14-6

BER 6-9

definition GL-3

bit error rate see BER GL-3

BITS
IN-6
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ANSI interface specifications B-3

BITS Out references 6-5, 10-34

definition GL-4

external node timing source 19-7

external timing pin assignments 1-54

facilities 6-5, 10-34

pin field assignments 14-46

timing setup 6-4

blade see card

BLSR

definition GL-4

bottom brackets see air filter, external brackets

bridge GL-4

broadcast

address GL-4

storm GL-4

browsers

see also Internet Explorer

see also Netscape Navigator

installation overview 18-3

register with the Java plug-in 2-5, 2-8

required versions 2-2

bus GL-4

C

C2 byte GL-4

cabinet compartment see front door

cables

calculate cable connections 3-70

clean fiber connectors 12-22, 12-23

fiber management 14-37, 14-39

install fiber on DWDM cards 3-39

routing and management 14-36

specifications for XFP ports B-50

tie-down bar 14-40

card protection

see splitter protection

see Y-cable protection
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cards

active GL-1

colors in node view 18-7

compatibility 15-5

install muxponder 3-31

install transponder 3-31

interface classes 15-6

part number A-12

protection see splitter protection

protection see Y-cable protection

put ports in⁄ out of service 7-17

replacement 14-50

reseat GL-9

reset using CTC 12-9

revision number A-12

serial number A-12

slot requirements 14-49

slots see slots

standby GL-17

symbol and slot correspondence 14-50

working GL-21

card view

change views A-2

description 18-12, A-1

list of tabs 18-13

CAT-5 cable see LAN cable

channel allocation plan 15-8

channel filter OADM cards

see AD-1C-xx.x card

see AD-2C-xx.x card

see AD-4C-xx.x card

circuits

see also overhead circuits

destination GL-6

disable circuit discovery 2-27

DWDM see OCHNC

effect of a node name change 12-5

source (definition) GL-17

states see service states
Cisc
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CISCO15 2-26

Cisco MetroPlanner see MetroPlanner

Cisco Transport Controller see CTC

CLEI code A-12

CLETOP 12-23

clock

change time 10-7

reset 1-37

set time 3-9

collision GL-5

colors

cards 18-7, 18-9

FMECs 18-8

nodes 18-12

common control cards

see AIC-I card

see TCC2 card

see TCC2P card

compatibility

card 15-5

JRE 18-4

SFP 15-118

computer see PC setup

concatenation GL-5

conditions

change time zone 8-10, 20-2

column descriptions 20-4

control display of 20-4

description 20-3

display 20-4

filter 20-5

history 20-7

retrieve 20-4

view 8-11

connected rings 17-4

CORBA 3-23

corporate LAN connection

description 18-6

provision 2-21
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cost 3-18, 3-19, 10-14, 20-9

covers

see backplane

see FMEC cover

craft connection

automatic host detection 2-16

choose type 2-9

description 18-6

DHCP 2-13

static IP addresses 2-11

crimp tool 1-38

crosspoint GL-5

CTAG GL-5

CTC

see also PC setup

toolbar icons see toolbar icons

alerts 2-32

back up 12-2

change network access 10-9

computer requirements 18-4

determine version 2-25

document existing provisioning 8-2

export data 8-4

firewall access 3-21

incompatibility alarm 2-25

installation overview 18-3

install CD-ROM 2-3

log in 2-24

node setup 3-8

print data 8-2

reset cards 12-9

revert to earlier load 18-15

set up network access 3-10

specifications B-2

verify software release 1-72

version mismatch among multiple nodes 2-25

views see network view, node view, card view

C-Temp ranges B-6

CTM GL-5
IN-8
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database

back up 12-2

description 18-15

MAC address 14-29

parameters that are not backed up 12-2

parameters that are not restored 12-5

restore 12-3

restore node and card defaults 12-4

revert 18-15

data communications channel see DCC

datagrams 20-4

date

change setting 10-7

default 1-36

provision 3-9

daylight savings time 3-9

DCC

AIC-I compatibility 15-21

disable autodiscovery 2-27

metric (OSPF) 3-19

OSPF Area ID 3-19

pin assignments 15-21

terminations, definition GL-6

viewing connections 18-11

DCU

hub node 16-2

install DCU chassis 1-65

install DCUs 3-30

OPT-PRE card 15-35

overview 15-2

typical rack layout 14-16

default router

change 10-10

change using LCD 3-14

definition GL-6

enter IP address 3-12

initially provision 3-11
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modify in secure mode 10-12

demultiplex GL-6

dense wavelength division multiplexing see DWDM

destination GL-6

host 20-4

routing table 20-24

DHCP

change request recipient 10-10

configuration note 2-13

enable 3-12

provision 2-13

provision server 3-11

scenario 20-3

diagnostics, offload 12-13

dialog box, do not display 10-20

disaster recovery 12-4

dispersion compensating unit see DCU

DNS configuration 2-11, 2-14, 2-17, 2-21

documentation

of CTC provisioning 8-2

domains

add a node 10-19

create 10-18

manage 10-19

move 10-19

rename 10-19

drops

access drop GL-1

definition GL-6

DWDM

see also DWDM cards

blue band GL-4

calculate cable connections 3-70

create connections 3-71

definition GL-6

delete connections 3-72

EDFA GL-7

fiber tray 14-39

hybrid nodes 16-14
Cisc
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monitor performance 9-8 to 9-18

nodes 16-1

optional hardware 1-64

provision a network 6-7

rack layouts 14-16

topologies 17-1 to 17-17, B-1

transponder GL-19

TXP_MR_10E card trunk interface 15-86

DWDM cards

see also 32DMX card

see also 32DMX-O card

see also 32MUX-O card

see also 32WSS card

see also 4MD-xx.x card

see also AD-1B-xx.x card

see also AD-1C-xx.x card

see also AD-2C-xx.x card

see also AD-4B-xx.x card

see also AD-4C-xx.x card

see also OPT-BST card

see also OPT-BST-E card

see also OPT-PRE card

see also OSC-CSM card

see also OSCM card

channel allocation plan 15-8

fibering 3-39

install 3-27

LED behavior during install 3-29

power requirements B-5

reset 12-10

service state transitions C-3

dynamic host configuration protocol see DHCP

E

E-FEC 15-87, 15-100, 15-103, 15-104

EIA interface specifications B-3

electrical codes 14-2

EMI GL-7
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o ONS 15454 DWDM Installation and Operations Guide, R5.0



Index
enhanced forward error correction see E-FEC

enterprise LAN see corporate LAN

environmental specifications B-4

equipment

DWDM 1-64

inventory A-12

supplied by Cisco (ANSI) 1-3

supplied by Cisco (ETSI) 1-4

user-supplied (ANSI) 1-3

user-supplied (ETSI) 1-5

ESD plug input 1-20

Ethernet

switch (definition) GL-8

ETR_CLO service

verify topologies for 5-6

events

see alarms

see conditions

express channel connections 4-43, 4-44

express orderwire see orderwire

external alarms

see also AIC-I card

change 11-41

description 15-18

overview 20-12

pin assigments using external wire-wrap panel 1-58

pin assignments with AEP 14-33

pin assignments without AEP 1-48

provision 8-31, 20-12

wiring 1-47, 1-52

wiring description 14-46

external controls

see also AIC-I card

change 11-42

description 15-18

overview 20-12

pin assignments with AEP 14-34

pin assignments without AEP 1-48

provision 8-31, 20-13
IN-10
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wiring 1-47, 1-52

wiring description 14-46

external firewall 20-25

external LAN interface B-2

external network element 3-12, 3-17, 10-13

external switching commands

apply a Force Y-cable or splitter protection 
switch 10-25

apply a lock-on 10-26

apply a lockout 10-27

apply a Manual Y-cable or splitter protection 
switch 10-25

clear a lock-on or lockout 10-28

clear a Y-cable or splitter protection switch 10-26

external timing reference see timing

external timing see timing

external wire-wrap panel 1-57

F

factory configuration, restore 12-4

falling threshold GL-8

fan-tray air filter see air filter

fan-tray assembly

description 14-41

fan failure 14-43

fan speed 14-42

install 1-40

power cable 12-34

remove to replace air filter 12-20

replace 12-27

far-end laser control see FELC

FEC 15-87, 15-104

FELC 15-116

ferrites 1-74, 14-50

fiber

capacity 14-38

clean adapters 12-24

clips 3-44, 3-47, 3-48, 3-51, 3-53, 3-58, 3-62
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management 14-37

patch panel 1-65

storage shelf 1-66

filler cards

description 14-35

faceplate (illustration) 14-36

install 3-35

filtering, alarm see alarm filtering

filter stopper 1-12

firewall

change IIOP listener port 10-10

external firewall description 20-25

provision access 3-11

provision IIOP listener port 3-23

set up 3-21

shortcut A-5

SNMP 3-25

firewall tunnels

add a tunnel 7-15

delete a tunnel 10-15

flange 1-12, 14-5

FlexLayer

see also Y-cable protection

block diagram 14-11

hardware part numbers 1-67

install modules 1-67

install shelf 1-66

install Y-cable modules in FlexLayer chassis 1-69

modules 14-10

system description 14-9

two-channel drop component connector mapping 14-12

FMEC

see FMEC cover

see MIC-A/P FMEC

see MIC-C/T/P FMEC

FMEC cover

install and close 1-61

open 1-24

overview 14-2
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remove 1-25

Force switch see external switching commands

foreign node settings

change GCC 10-29

open GNE 20-27

provision a proxy tunnel 7-14

provision GCC terminations 7-13

specify IP address 10-30

forward error correction see FEC

frame-ground pin 1-56

framing 6-6, 10-34

front door

description 14-19

label 14-23

open 1-20

remove 1-21, 12-19

replace 12-25

front mount electrical connection see FMEC

fuse and alarm panel

100 amp 1-13, 1-15, 1-17, 1-31, 1-39

80 amp 1-13, 1-15, 1-17, 1-31, 1-39

description 14-2

location 14-5, 14-8

measure and cut cables 1-37

G

G.709 see OTN

gateway GL-8

default 20-7

on routing table 20-24

returning MAC address 20-4

gateway network element 3-12, 3-17, 10-13

gateway settings see proxy server

GCC

change GCC terminations 10-29

delete GCC terminations 10-30

foreign termination 7-14, 7-15

OSPF Area ID 3-19
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provision GCC terminations 7-13

Y-cable protection 15-83, 15-87, 15-93

generic communications channel see GCC

glossary GL-1

GNE

dual GNEs 20-18

load balancing 20-18

open GNE 20-27

see also gateway network element

ground

see also office ground

connect to ANSI shelf 1-33

connect to ETSI shelf 1-32

description 14-43

ground posts 14-44

install 1-30

ground strap

avoid interference with cards 12-26

detach 1-22

illustration 14-21

H

hard reset GL-9, GL-10

hello interval 3-19, 3-20

hop 3-18, 10-14, 20-9

hubbed rings 17-2

hub node

ANS parameters 16-36

convert pass-through connections 10-32

CTC icon A-3

description 16-1

install fiber 3-45

hybrid node, convert from DWDM 10-43

I

idle time 3-6
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idle user timeout 19-5

IIOP listener port

change 10-10

provision on the node 3-23

provision on the PC 3-23

select while provisioning IP settings 3-12

installation

see also rack

see also shelf assembly

acceptance test 1-74

air ramp see air ramp

alarm expansion panel see AEP

CTC installation overview 18-3

DCU see DCU

DWDM hardware 1-64

fan-tray assembly see fan-tray assembly

fiber patch panel shelf 1-65

fiber storage shelf 1-66

FlexLayer modules 1-67

FlexLayer shelf 1-66

install Y-cable protection modules 1-69

list of procedures 1-1

overview 14-2

power and ground 1-30, 14-43

required tools (ANSI) 1-3

required tools (ETSI) 1-4

wires see wires

Internet Explorer

see also browser

disable proxy service 2-22

log in 2-25

Internet protocol see IP

inventory 18-14, A-12

IP

see also IP address

change settings 10-10

create IP-encapsulated tunnel 7-16

environments 20-1

provision IP settings 3-11
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requirements 20-2

subnetting 20-1

IP address

change using LCD 3-14

enable dual-IP address capability 3-16

host number GL-9

lock secure mode (dual IP addresses) 10-11

log in 2-25

modify backplane IP settings 10-11

NMS 3-24

repair 7-21

scenarios 20-2 to 20-22

select IP address for log in 2-26

set up network information 3-11

static IP addresses 2-11

suppress display 10-10

IP-encapsulated tunnel

create 7-16

delete 7-21

repair 7-21

ISC service

verify topologies for 5-6

I-Temp ranges B-6

J

J0 section trace 7-22

Java plug-in security warning 2-26, 2-27

jitter 15-105, 15-116

JRE

overview 18-4

change version 2-31

install 2-3, 2-6

reinitialization requirement 12-4

requirements 18-5
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K

K byte GL-10

Kepnut 1-22

L

LAN

connection points 14-47

definition GL-10

modems 2-23

OSPF activity 3-19

pin assignments 14-47

wires 1-51, 1-55

LAN cable

connect computer to corporate LAN port 2-21

connect computer to ONS 15454 2-10

connect modem to TCC2/TCC2P card, backplane, or 
FMEC 2-23

connect to backplane 1-55

connect to MIC-C/T/P 1-28, 1-51

connect to TCC2/TCC2P card 2-10

crimp 2-10

description 18-5

laser warning 14-25, 14-26

latitude 3-8

LCD

change default router 3-14

change IP address 3-14

change network mask 3-14

provision network settings 3-10

verify software version 1-72

view alarm counts 8-14, 20-2

line amplifier node

ANS parameters 16-38

CTC icon A-3

description 16-11

hybrid 16-24

install fiber 3-49
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linear ADM

definition GL-1

linear configurations

description 17-5

optical performance 17-8, 17-10, 17-12

line timing see timing

link budget GL-11

listener port see IIOP listener port

lock-on see external switching commands

lockout see external switching commands

lock washer 12-25

log in 2-24

login legal disclaimer 10-8

login node groups

add a node to current session 2-29

create 2-28

delete a node 2-30

delete from a specified group 2-30

shortcut A-5

view 2-27, 18-11

longitude 3-8

loopback

definition GL-11

M

MAC address

AIP 14-29

clear table 19-3

definition GL-11

proxy ARP 20-4

retrieve table 19-3

view 3-12

maintenance user see security

managed device GL-11

managed object GL-11

management, tilt and gain 17-28

management information base see MIB

Manual switch see external switching commands
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map see network view

meshed rings 17-4

MetroPlanner

import a configuration file 3-72

installation parameters 17-33

internal connections 3-40

provision a network 6-8

requirement 1-65, 3-1

MIB GL-12

Ethernet RMON 9-32

SNMP 3-25

MIC-A/P FMEC

block diagram 15-22

description 15-21

faceplate 15-22

install 1-28

install alarm wires 1-47

pinouts 15-22 to 15-24

power requirements B-5

specifications B-11

temperature range B-6

MIC-C/T/P FMEC

description 15-24

install 1-28

install LAN wires 1-51

install timing wires 1-50

power requirements B-5

specifications B-12

temperature range B-6

modem interface B-2

module see card

mounting brackets

description 14-4

mount rear cover 1-63

reverse 1-10

multicast GL-12

multi-hubbed rings 17-2

multiplex GL-12

multiplexer and demultiplexer cards
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see 32DMX card

see 32DMX-O card

see 32MUX-O card

see 4MD-xx.x card

muxed see multiplex

muxponder cards

see MXP_2.5G_10E card

see MXP_2.5G_10G card

see MXP_MR_2.5G card

see MXPP_MR_2.5G card

MXP_2.5G_10E card

see also PPMs

see also SFPs

ALS 15-105

block diagram 15-102

change administrative state 5-28, 5-32

change card settings 5-26

change line OTN settings 5-36

change line settings 5-28

change line threshold settings 5-33

change section trace settings 5-30

change trunk settings 5-31

client interface monitoring 15-104

client interfaces 15-102

create RMON thresholds 9-32

create Y-cable protection 3-36

description 15-99

DWDM interface 15-102

E-FEC 15-100, 15-103

faceplate 15-101

features 15-100

install 3-31

jitter 15-105

lamp test 15-106

LEDs 15-106

modify line settings and PM thresholds 5-25

monitor performance 9-18

multiplexing function 15-102

onboard traffic generation 15-106
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port-level LEDs 15-106

port state transitions C-11

power requirements B-6

provision client port alarm 5-35

provision TCA thresholds 5-34, 5-35

provision trunk port alarm 5-34

reset 12-10

service state transitions C-7

SONET/SDH overhead byte processing 15-104

specifications B-44

temperature range B-7

timing 6-5

timing synchronization 15-103

trunk wavelengths 15-104

view optics parameters 9-21

wavelength identification 15-104

Y-cable protection 15-103

MXP_2.5G_10G card

see also PPMs

see also SFPs

ALS 15-98

block diagram 15-98

change administrative state 5-28, 5-32

change card settings 5-26

change line OTN settings 5-36

change line settings 5-28

change line threshold settings 5-33

change section trace settings 5-30

change trunk settings 5-31

create RMON thresholds 9-32

create Y-cable protection 3-36, 6-5

description 15-95

faceplate 15-97

GCC terminations 7-13

install 3-31

LEDs 15-99

modify line settings and PM thresholds 5-25

monitor performance 9-18

port-level LEDs 15-99
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port state transitions C-11

power requirements B-6

provision client port alarm 5-35

provision TCA thresholds 5-34, 5-35

provision trunk port alarm 5-34

reset 12-10

service state transitions C-7

specifications B-37

temperature range B-7

timing synchronization 15-98

view optics parameters 9-21

Y-cable description 15-114

Y-cable protection 15-98

MXP_MR_2.5G and MXPP_MR_2.5G cards

ALS 15-111

MXP_MR_2.5G card

block diagram 15-111

change administrative state 5-56, 5-59

change card settings 5-54

change distance extension settings 5-57

change line settings 5-55

change line threshold settings 5-61

change OC-48/STM-16 settings 5-58

change section trace settings 5-60

client interface data rates 15-108

create RMON thresholds (MIBs) 9-32

create Y-cable protection 3-36

description 15-106

faceplate 15-110

install 3-31

LEDs 15-113

modify line settings and PM thresholds 5-53

monitor performance 9-18

port-level LEDs 15-113

port state transitions C-11

power requirements B-6

provision a UDC circuit 7-19

provision client port alarm 5-65

provision TCA thresholds 5-64, 5-65
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provision trunk port alarm 5-64

reset 12-10

safety labels 15-111

service state transitions C-7

specifications B-41

temperature range B-7

timing 6-5

versions 15-107

view optics parameters 9-21

Y-cable description 15-114

MXPP_MR_2.5G card

see also splitter protection

block diagram 15-111

change administrative state 5-56, 5-59

change card settings 5-54

change distance extension settings 5-57

change line settings 5-55

change line threshold settings 5-61

change OC-48/STM-16 settings 5-58

change section trace settings 5-60

client interface data rates 15-108

create RMON thresholds (MIBs) 9-32

create Y-cable protection 3-36

description 15-106

faceplate 15-110

install 3-31

LEDs 15-113

modify line settings and PM thresholds 5-53

monitor performance 9-18

port-level LEDs 15-113

port state transitions C-11

power requirements B-6

provision a UDC circuit 7-19

provision client port alarm 5-65

provision TCA thresholds 5-64, 5-65

provision trunk port alarm 5-64

reset 12-10

safety labels 15-111

service state transitions C-7
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specifications B-41

temperature range B-7

timing 6-5

versions 15-107

view optics parameters 9-21

N

NE defaults

description D-1

ANSI card default settings D-2

ANSI CTC default settings D-42

ANSI node default settings D-38

edit 12-38

ETSI card default settings D-43

ETSI CTC default settings D-85

ETSI node default settings D-81

export 12-40

import 12-39

restore 12-4

Netscape Navigator

see also browser

disable proxy service 2-22

log in 2-25

test connection during UNIX setup 2-20

network element

definition GL-12

see node

network element defaults see NE defaults

networks

automatic power control 17-19

building circuits 7-1

convert connections during upgrade 10-32

DWDM topologies 17-1 to 17-17

gain tilt compensation (without ROADM nodes) 17-31

gain tilt compensation (with ROADM nodes) 17-33

optical performance 17-6

optical safety 17-24

set up basic information 3-11
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set up CTC network access 3-10

timing example 19-7

network time protocol 3-8

network view

description 18-11

add nodes to map see domains

apply a custom background image (map) 10-18

change the background color 10-16

change the default network map 10-17

change views A-2

create a customized network view 6-14

delete users 10-41

description A-1

node icons A-2

node status (icon colors) 18-12

security levels per tab 19-4

switch between TDM and DWDM network views 10-21

tasks A-10

node

1+1 protected flexible terminal 16-14

add to current session 2-29

amplified TDM 16-26

automatic power control 17-19

change access 10-38

change contact information 10-7

change date 10-7

change management information 10-6

change name 10-7

change time 10-7

definition GL-13

delete from current session 2-30

hybrid 16-14

hybrid line amplifier 16-24

hybrid OADM 16-23

hybrid terminal 16-21

icons A-3

lock secure mode (dual IP addresses) 10-11

remove power 13-1

scalable terminal 16-18
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security mode 3-16

set up name, date, time, and contact information 3-8

verify connections 6-3

verify turn-up 6-1

node services protocol 17-1

node view

change views A-2

description 18-7, A-1

security levels per tab 19-1

shortcuts A-10

non-ONS node see foreign node settings

NSP 17-1

NTP server 3-8

O

OADM node

acceptance test 4-33, 4-35, 4-37

ANS parameters 16-38

check power values 6-9

convert pass-through connections 10-32

CTC icon A-3

description 16-4

hybrid 16-23

install fiber 3-54

optical performance 17-8

verify add and drop connections 4-51, 4-54

verify express channel connections 4-43, 4-44

verify OSC-CSM power 4-42

verify pass-through channel connections 4-47

OAM&P access 18-6

OC-48/STM-16 settings, change for MXP_MR_2.5G and 
MXPP_MR_2.5G cards 5-58

OCHNC

circuit status 7-5

create 7-9

delete 7-9, 7-12

filter 7-6

locate and view 7-2
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provision 7-10

search 7-2

service state transitions C-6

view 7-3

view alarms on OCHNCs 8-14

view on a span 7-8

office ground

connect to ANSI shelf 1-33

connect to ETSI shelf 1-32

office power

connect to ANSI shelf 1-36

connect to ETSI shelf 1-35

turn on and verify 1-39

open GNE

description 20-27

Open Shortest Path First see OSPF

OPT-BST card

alarm profiles 20-11

automatic laser shutdown 17-24

automatic power control 17-18

block diagram 15-40

change administrative state 11-13, 11-16

change ALS settings 11-21

change optical amplifier line settings 11-15

change optical channel threshold settings 11-17

change optical line settings 11-12

change optical line thresholds 11-14

description 15-38

faceplate 15-39

fiber clip 3-44, 3-47, 3-48, 3-53, 3-58, 3-62

gain tilt control 17-29

install 3-27

LEDs 15-41

modify line settings and PM thresholds 11-11

monitor performance 9-11

port calibration 15-40

power monitoring 15-40

power requirements B-5

reset 12-10
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service state transitions C-3

specifications B-15, B-16

temperature range B-7

verify laser and power 4-39

OPT-BST-E card

automatic laser shutdown 17-24

block diagrams 15-44

description 15-41

faceplate 15-43

gain tilt control 17-29

LEDs 15-45

port calibration 15-44

power monitoring 15-44

optical add/drop multiplexer

see 32WSS card

see AD-1B-xx.x card

see AD-1C-xx.x card

see AD-2C-xx.x card

see AD-4B-xx.x card

see AD-4C-xx.x card

see OADM node

optical amplifier cards

see OPT-BST card

see OPT-BST-E card

see OPT-PRE card

optical channel network connections see OCHNC

optical performance 17-6

optical service channel cards

see OSC-CSM card

see OSCM card

optical service channel see OSC

OPT-PRE card

automatic power control 17-18

block diagrams 15-37

change administrative state 11-13, 11-16

change optical amplifier line settings 11-15

change optical channel threshold settings 11-17

change optical line settings 11-12

change optical line thresholds 11-14
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description 15-35

faceplate 15-36

fiber clip 3-44, 3-47, 3-48, 3-53, 3-58, 3-62

gain tilt control 17-29

install 3-27

LEDs 15-38

modify line settings and PM thresholds 11-11

monitor performance 9-11

port calibration 15-37

power monitoring 15-37

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-14

temperature range B-7

verify laser and power 4-40

orderwire

change settings 11-43

delete 7-21

description 15-19

EOW (definition) GL-7

OSCM and OSC-CSM cards 15-25

pin assignments 15-20

provision 7-18

OSC

delete OSC terminations 10-30

description 15-25

install fiber for OSC link terminations 3-42

OSC port service state transitions C-6

provision terminations 3-74

OSC-CSM card

asymmetric line node acceptance test 4-30

automatic laser shutdown 17-26

block diagram 15-32

change administrative state 11-4, 11-7

change ALS settings 11-10

change optical line parameters 11-6

change OSC settings 11-2

change OSC thresholds 11-5
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description 15-29

faceplate 15-31

install 3-27

LEDs 15-34

monitor performance 9-9

power monitoring 15-33

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-14

symmetric line node acceptance test 4-26

symmetric OADM node acceptance test 4-35

symmetric passive OADM node acceptance test 4-37

temperature range B-7

verify add and drop connections 4-54

verify incoming power 4-42

verify power 4-41, 4-42

verify transmit power 3-76

OSCM card

asymmetric line node acceptance test 4-30

block diagrams 15-28

change administrative state 11-4, 11-7

change ALS settings 11-10

change optical line parameters 11-6

change OSC settings 11-2

change OSC thresholds 11-5

description 15-26

faceplate 15-27

fiber clip 3-44, 3-47, 3-48, 3-53, 3-58, 3-62

install 3-27

LEDs 15-29

monitor performance 9-9

power monitoring 15-28

power requirements B-5

reset 12-10

service state transitions C-3

specifications B-13

symmetric line node acceptance test 4-23

symmetric OADM node acceptance test 4-33
IN-20
Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0
temperature range B-7

verify add and drop connections 4-51

verify transmit power 3-76

OSC regeneration node

CTC icon A-4

description 16-12

install fiber 3-51

OSNR

network applications 17-1

verify 6-11

OSPF

alternative to static routes 20-8

disable 10-14

IP addressing scenario 20-10

IP networking overview 20-2

provisionable patchcords 20-22

set up or change 3-18

OTDR 17-23

OTN

change OTN settings (ITU-T G.709, FEC, Trail 
Trace) 5-36, 5-51

change settings for TXP_MR_10G and TXP_MR_10E 
cards 5-22

enable ITU-T G.709 performance monitoring 9-19

enable OTN FEC performance monitoring 9-20

MXP_2.5G_10E card in termination mode 5-27

trunk bit rates with ITU-T G.709 enabled 15-89

view PMs 9-24

output contacts see AIC card, external controls

overhead circuits

see also IP-encapsulated tunnel

see also orderwire

see also user data channel

create 7-13

delete 7-20, 7-21

modify 7-20

shortcut A-7
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P

pass-through channel connections 4-47

passwords

change 10-39, 10-40

change security 10-36, 10-37

create new user 3-6, 3-7

login 2-26

path layer GL-14

path see spans

PCM 7-18, 15-19

PC setup

see also craft connection

connect PC to ONS 15454 2-1

corporate LAN connection 2-21

disable proxy service 2-22

install browser 2-2

local craft connection 2-9

remote (modem) access 2-23

requirements 2-3, 18-4

run the CTC installation wizard 2-3, 2-6

performance, optical 17-6

performance monitoring

see also individual cards

clear current (displayed) counts 9-5

clear stored counts 9-6

PM clearing privilege 10-38

refresh 15-minute intervals 9-2

refresh counts, different port 9-8

refresh one-day intervals 9-3

set auto-refresh interval 9-7

threshold crossing alert see TCA

view far-end counts 9-5

view near-end counts 9-4

pin assignments

AEP 1-46, 14-32

alarms, ANSI 1-53

alarms, ETSI 1-48

craft 1-57
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LAN, ANSI 1-56

LAN, ETSI 1-51

overview (ANSI) 14-44

timing, ANSI 1-54

timing, ETSI 1-50

wire-wrap panel on the AEP 1-58, 1-59

ping 20-2, GL-14

pinned hex (Allen) key 1-20

plug-in unit see card

pointer justification GL-14

popup data 18-10

ports

listener port see IIOP listener port

assign name 7-9

default UDP port for SNMP 10-47

put optical ports in⁄ out of service 7-17

TL1 port 18-4

UDP 3-24

power

see also office power

BAT1 backplane power terminal 1-38

coat bare conductors 1-38

connect office power to ANSI shelf 1-36

connect office power to ETSI shelf 1-35

fan-tray assembly requirements 14-42

measure voltage 1-76

OSCM and OSC-CSM transmit power 3-76, 3-77, 3-78

RET2 backplane power terminal 1-38

set power monitor thresholds 3-9

specifications B-3

supply 1-30, 14-43

verify 32DMX-O power 4-40

verify 32DMX power 4-41

verify 32MUX-O power 4-39

power monitoring 15-20

PPMs

see also SFPs

delete provisioning 5-7

preprovision 3-33
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provision a multirate PPM 5-2, 5-3

provision the optical line rate 5-3

priority queuing GL-15

protection, card

see splitter protection

see Y-cable protection

protocols

DHCP 3-12

IP 20-1

NTP 3-8

Proxy ARP see Proxy ARP

SNTP 3-8

SSM 19-8

provisionable patchcord

create 6-10

delete 10-31

description 20-22

provisioning user see security

Proxy ARP

description 20-1

enable an ONS 15454 gateway 20-4

use with static routes 20-6

proxy server

gateway settings, change 10-10

gateway settings, description 20-13

gateway settings, provision 3-12

provision settings 3-11

proxy service

disable using Internet Explorer 2-22

disable using Netscape 2-22

proxy tunnels

add a tunnel 7-14

delete a tunnel 10-15

PST C-1

PSTQ C-1

public-key security certificate 2-26, 2-27

pulse code modulation 7-18
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queue GL-15

R

rack

bay assembly 14-6

installation overview 14-3, 14-6

mount a single node 1-13, 1-15, 14-5, 14-7

mount multiple nodes 1-16, 14-5, 14-8

reversible mounting bracket 1-10, 14-4

RAM

PC requirements for CTC 2-3

UNIX requirements for CTC 2-6

rear cover 14-28

reinitialization tool

overview 12-4

UNIX 12-7

Windows 12-5

remote access

description 18-6

set up connection to the ONS 15454 2-23

remote monitoring see RMON

remote network monitoring GL-16

retrieve user see security

revert 18-15

revertive switching 3-38

revertive timing 6-4

rings

any-to-any 17-3

hubbed rings 17-2

meshed DWDM 17-4

multihubbed 17-2

optical performance for ROADM rings 17-12

RIP 3-20

rising threshold GL-15

RJ-11 connector 15-20

RMON GL-16
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see also SNMP

create alarm thresholds 9-32

delete alarm thresholds 9-34

ROADM

32DMX card 15-54

32WSS card 15-76

ANS parameters 16-39

card requirements 15-54

CTC node icons A-4

gain tilt control 17-31, 17-33

install fiber 3-59

MXP_2.5G_10E card 15-102

node acceptance test 4-8, 4-12, 4-16, 4-18

node-type description 16-8

power equalization 17-22

view ROADM node power equilization 10-5

routing information protocol see RIP

routing table 20-24

S

section trace

change MXP_2.5G_10G and MXP_2.5G_10E card 
settings 5-30

change settings for MXP_MR_2.5G and 
MXPP_MR_2.5G cards 5-60

change settings for TXP_MR_2.5G and 
TXPP_MR_2.5G cards 5-43

change TXP_MR_10G settings 5-13

create J0 7-22

secure mode

disable 10-12

enable 3-16

IP addressing scenario 20-20

lock 10-11

modify backplane IP settings 10-11

secure shell 19-6

security

see also audit trail
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assign user levels 3-6, 3-7

change policy 10-35, 10-37

change security level 10-39, 10-40

enable secure mode 3-16

idle times 3-6

idle user timeout 19-5

lock secure mode (dual IP addresses) 10-11

modify settings 10-35

policies 19-5

requirements 19-1

set up 3-5

superuser privileges 19-5, 19-6

tasks per tab 19-2, 19-4

user level definitions 19-1

viewing 18-7

service states

administrative state description C-2

card state list A-12

card state transitions C-3

change administrative states 5-28, 5-32, 5-42, 5-56, 5-59, 
11-4, 11-7, 11-13, 11-16, 11-23, 11-27, 11-33, 11-38

change card service state 11-44

change port service state 7-17

circuit states list 7-5

description C-1

equipment A-12

ports 18-8

SFPs

see also PPMs

compatibility 15-118

delete provisioning 5-7

description 15-118, 15-119

install 3-34

preprovision 3-33

remove 3-34

specifications 15-119, B-48

XFP specifications B-50

shelf assembly

see also installation
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specifications B-1

ANSI, bay assembly 14-6

ANSI, description 14-3

ANSI, dimensions 14-4, B-4

ETSI, description 14-6

ETSI, dimensions 14-7, B-4

ETSI, mounting 14-7

inspect 1-7

install 1-8

unpack and inspect 1-6

verify 1-6

shell access 10-38

 shutdown, automatic laser see automatic laser shutdown

simple network time protocol see SNTP

single-span link

description 17-6

optical performance 17-16

slots

AIC-I card 3-5

fiber management 14-37

FMEC slots 14-30

overview 14-48

preprovision 3-26

requirements 14-49

unused slots 14-1

Small Form-factor Pluggables see SFPs

SNMP

change settings 10-46

delete trap destination 10-47

modify trap destination 10-46

set up 3-24

SNTP 3-8

SOCKS see proxy server

software

see also CTC

verify software version 1-72

Solaris see UNIX

span loss

description 17-19
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optical 10-2

verify 10-2, 17-23

spanning tree GL-17

spans

definition GL-17

splitter protection

definition 3-37

description 15-115

modify 10-23

TXP_MR_2.5G and TXPP_MR_2.5G cards 15-93

SSH 19-6

SSM

enable 6-6, 10-34

enable for OSCM and OSC-CSM cards 11-3

message set 6-4, 10-33

SST C-1

ST3 clock 19-7

standard constant 3-23

standoff kit 1-12

state see service state

static route

create 3-17

delete 10-14

IP addressing scenario 20-8

modify 10-13

RIP prerequisite 3-20

straight-through cable see LAN cable

subnet

CTC and nodes on different subnets 20-3

CTC and nodes on same subnet 20-2

multiple subnets on the network 20-7

using static routes 20-8

with Proxy ARP 20-4, 20-5

subnet mask GL-18

24-bit 20-25

32-bit 20-25

change 10-10

description 20-9

modify in secure mode 10-12
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OSPF area range table 3-20

provision 3-11

provision in a static route 3-18

provision subnet mask length 3-12

routing table 20-24

Windows setup 2-12, 2-13

superuser see security

switch

see external switching commands

see timing

synchronization status messaging see SSM

T

tables

see also List of Tables

change format A-11

display hidden columns A-11

print data 8-2

resize columns A-11

sort A-11

tabs

overview 18-7

card view 18-14

Alarms 18-13

Circuits 18-13

Conditions 18-13

History 18-13

Maintenance 18-14

Performance 18-14

Provisioning 18-14

network view

Alarms 18-12, 19-4

Circuits 18-12, 19-4

Conditions 18-12, 19-4

History 18-12, 19-4

Maintenance 18-12, 19-5

Provisioning 18-12, 19-5

node view
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Alarms 18-10, 19-2

Circuits 18-10, 19-2

Conditions 18-10, 19-2

History 18-10, 19-2

Inventory 18-10, 19-3

Maintenance 18-10, 19-3

Provisioning 18-10, 19-2

TCA 5-19, 5-20, 5-34, 5-35, 5-47, 5-48, 5-64, 5-65, 9-3

TCC2 card

card-level indicators 15-12

clear the database for disaster recovery 12-4

craft wires vs. EIA/TIA-232 port 1-57

database back up 12-2, 18-15

description 15-10

functionality 15-11

install 1-70

LAN port 2-10, 2-23

modem interface B-2

network-level indicators 15-12

power requirements B-5

reboot behavior 3-13

redundant installation 15-12

restore the database 12-3

soft reset 12-9, 18-14

software installation overview 18-1

specifications B-7

temperature range B-6

TL1 craft interface B-2

verify installation 3-4

TCC2P card

see also secure mode

clear the database for disaster recovery 12-4

database back up 12-2, 18-15

description 15-13

faceplate (figure) 15-14

functionality 15-15

LAN port 2-10, 2-23, 3-16, 10-12

LEDs 15-16

modem interface B-2
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network-level LEDs 15-16

power requirements B-5

reboot behavior 3-13

restore the database 12-3

soft reset 12-9, 18-14

software installation overview 18-1

specifications B-8

temperature range B-6

TL1 craft interface B-2

verify installation 3-4

TCP/IP 2-11, 2-12, 2-13, 2-14, 2-15, 2-17, 2-18

TDM GL-19

TDM node, amplified 16-26

terminal lug 12-25, 12-26

terminal node

1+1 protected flexible 16-14

ANS parameters 16-37

CTC icons A-4

description 16-3

hybrid 16-21

install fiber 3-47

scalable 16-18

termination modes 15-117

test equipment

required for ANSI installation 1-4

required for ETSI installation 1-6

third-party equipment 14-2

time division multiplexing GL-19

timed out see idle time

time zone

display alarms and conditions using time zone 8-10

provision 3-9

timing

BITS see BITS

change node timing parameters 10-33

change node timing reference 12-14

clear a Manual or Force switch 12-15

connections 14-46

external, set up 6-4
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external timing (definition) GL-8

internal, set up 6-6

line, set up 6-4

mode 6-5

NE reference 6-5

network timing example 19-7

node timing description 19-6

set node clock 3-9

set up 6-3

specifications B-3

SSM 19-8

switch a node timing reference 12-15

synchronization for the MXP_2.5G_10E card 15-103

synchronization for the MXP_2.5G_10G card 15-98

view timing report 12-16

TL1

AID definition GL-2

AID in CTC 20-6

ATAG GL-2

commands 18-4

connection 18-6

craft interface connection 1-56, 14-47

interface specifications B-2

pin assignments 1-57

TCC2 EIA/TIA-232 port connection 1-56

toolbar icon A-7

toolbar icons

add node A-5

delete selected node A-5

export A-5

go to home view A-6

go to network view A-6

go to next view A-6

go to other node A-6

go to parent view A-6

go to previous view A-6

go to selected object view A-6

lock node A-5

open TL1 connection A-7
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preferences A-5

print A-5

zoom in A-6

zoom in selected area A-6

tools

required for ANSI installation 1-3, 1-4

required for ETSI installation 1-5

trace route 2-11, 2-16

traffic routing 20-24

transponder cards

see TXP_MR_10E card

see TXP_MR_10G card

see TXP_MR_2.5G card

see TXPP_MR_2.5G card

trap 3-25, GL-19

tributary GL-19

trunk GL-19

TXP_MR_10E card

ALS 15-87

block diagram 15-85

change card settings 5-9

change line settings 5-10

change line threshold settings 5-15, 5-16, 5-46, 5-62

change OTN settings 5-22

client interface 15-86

client-to-trunk mapping 15-87

create RMON thresholds 9-32

create Y-cable protection 3-36

description 15-84

DWDM trunk interface 15-86

E-FEC 15-87

faceplate 15-85

features 15-85

install 3-31

LEDs 15-88

modify line settings and PM thresholds 5-8

monitor performance 9-18

port-level LEDs 15-88

port state transitions C-11
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power requirements B-6

provision client port alarm 5-20

provision TCA thresholds 5-19, 5-20

provision trunk port alarm 5-19

reset 12-10

service state transitions C-7

specifications B-46

temperature range B-7

view optics parameters 9-21

Y-cable protection 15-86

TXP_MR_10G card

block diagram 15-83

change card settings 5-9

change line settings 5-10

change line threshold settings 5-15, 5-16, 5-46, 5-62

change OTN settings 5-22

change section trace settings 5-13

create RMON thresholds 9-32

create Y-cable protection 3-36

description 15-82

faceplate 15-83

GCC terminations 7-13

install 3-31

LEDs 15-84

modify line settings and PM thresholds 5-8

monitor performance 9-18

port-level LEDs 15-84

port state transitions C-11

power requirements B-6

PPM caveat 5-5

provision client port alarm 5-20

provision TCA thresholds 5-19, 5-20

provision trunk port alarm 5-19

reset 12-10

service state transitions C-7

specifications B-35

temperature range B-7

view optics parameters 9-21

Y-cable description 15-114
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Y-cable protection 15-83

TXP_MR_2.5G and TXPP_MR_2.5G cards

ALS 15-93

TXP_MR_2.5G card

block diagram 15-92

change administrative state 5-42

change line settings 5-42

change line threshold settings 5-45

change OTN settings 5-51

change section trace settings 5-43

create RMON thresholds (MIBs) 9-32

create Y-cable protection 3-36

description 15-88

faceplate 15-90

GCC terminations 7-13

install 3-31

ITU-T G.709 15-89

LEDs 15-94

modify line settings and PM thresholds 5-39

monitor performance 9-18

port-level LEDs 15-95

port state transitions C-11

power requirements B-6

provision client port alarm 5-48

provision for acceptance testing 4-4

provision TCA thresholds 5-47, 5-48

provision trunk port alarm 5-47

reset 12-10

safety labels 15-93

service state transitions C-7

specifications B-39

splitter protection 15-93

temperature range B-7

view optics parameters 9-21

Y-cable description 15-114

Y-cable protection 15-92

TXP_MRG_10G card

ALS 15-83

TXPP_MR_2.5G card
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see also splitter protection

block diagram 15-92

change administrative state 5-42

change line settings 5-42

change line threshold settings 5-45

change OTN settings 5-51

change section trace settings 5-43

create RMON thresholds (MIBs) 9-32

description 15-88

faceplate 15-90

GCC terminations 7-13

install 3-31

ITU-T G.709 15-89

LEDs 15-94

modify line settings and PM thresholds 5-39

monitor performance 9-18

port-level LEDs 15-95

port state transitions C-11

power requirements B-6

provision client port alarm 5-48

provision TCA thresholds 5-47, 5-48

provision trunk port alarm 5-47

reset 12-10

safety labels 15-93

service state transitions C-7

specifications B-39

splitter protection 15-93

temperature range B-7

view optics parameters 9-21

Y-cable protection 15-92

U

UNIX

connect cable to ONS 15454 2-10

connect LAN cable from workstation to corporate LAN 
port 2-21

disable proxy service 2-22

restore factory parameters (NE defaults) 12-7
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run the CTC installation wizard 2-6

set up craft connection to ONS 15454 2-19

software installation description 18-3

workstation requirements 2-6, 18-4

unpack 1-6

user data channel

create 7-19

delete 7-21

description 15-20

user-defined alarms

see external alarms

see external controls

users

see also security

change password or security settings 10-39, 10-40

create new user on a single node 3-6

create new users on multiple nodes 3-6

delete 10-40, 10-41

log out 10-42

security level definitions 19-1

set up 3-5

V

variable optical attenuator see VOA

views

see card view

see network view

see node view

virtual links see provisionable patchcords

virtual link table (OSPF) 3-20

virtual wires 20-13

VOA

see also automatic node setup

adjusting with automatic node setup 16-29

change for 32WSS card 11-33

change for multiplexer cards 11-27

change for OSCM and OSC-CSM cards 11-7

correct with APC 17-19
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degrade or fail alarm 17-20

gain tilt control 17-29

in the OSCM card 15-28

voltage, measure 1-76

voltmeter 1-39, 1-76

W

WAN 20-2

warnings

Java plug-in security 2-26, 2-27

labels on MXP_MR_2.5G and MXPP_MR_2.5G 
cards 15-112

laser 14-25, 14-26, 15-93

WDM-ANS provisioning 16-34

WINS configuration 2-11, 2-14, 2-17, 2-21

wires

install alarm wires 1-47, 1-52

install LAN wires 1-51, 1-55

install timing wires 1-50, 1-54

install TL1 craft interface wires 1-56

wire-wrap panel, external 1-57

working card GL-21

X

XFPs see SFPs

Y

Y-cable modules

install cables 3-69

Y-cable protection

block diagram 14-14

connector mapping and labeling 14-15

delete 10-23

description 14-9, 15-114

install FlexLayer modules 1-67

install FlexLayer shelf 1-66
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modify 10-22

module configuration 14-13

MXP_2.5G_10E card 15-103

MXP_2.5G_10G card 15-98

port mapping 14-15, 14-16

TXP_MR_10E card 15-86

TXP_MR_10G card 15-83

TXP_MR_2.5G and TXPP_MR_2.5G cards 15-92

Y-cable protection modules 1-69
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